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What's New in Smoke

Welcome to Smoke 2013 Extension 1. This release includes support for Blackmagic Design (page 1) as well as a Trim View
(page 2).

Following is a complete list of all the new features and updates in this release.

Blackmagic Design Support

New in this release, Smoke now supports the following Blackmagic Design devices:
■ DeckLink (PCIe video boards)

■ UltraStudio (Thunderbolt boxes)

Use a supported Blackmagic Design device to:

■ Output to a broadcast monitor connected by SDI or HDMI for video preview for SD and HD material (regular or single
link stereoscopic (anaglyph or interlaced)).

■ Capture material (SD to HD) using File ➤ Capture from VTR....

■ Output material (SD to HD) using File ➤ Output to VTR....

NOTE The supported features depend on the card connected to your Mac, but generally includes SDI capture, SDI playout, and
SDI / HDMI preview. For the Intensity series, only the HDMI preview is available.

There are some limitations tied to the use of a Blackmagic Design device:

■ 1080 @ 50p, 59p, and 60p are not supported.

■ 3G-SDI is not supported.

■ Headroom in input, output, and preview is not supported. This means that video going through the BMD device always
has luminance in legal range.

■ SD timings support 4:2:2 only.

■ HD timings support 4:2:2 and 4:4:4.

1
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New Trim View

A new Trim View, familiar to editors, is available to help you trim video or audio clips (with or without effects), cuts, and
transitions on the timeline.

You can now trim using the Trim View, with keyboard shortcuts, or gesturally on the timeline (or any combination of
these methods, depending on your editing style). In Trim mode, the Trim View displays the last (outgoing) and first
(incoming) frame above the timeline from the two clips you are trimming, allowing you to visualize your trimming
operation. In Slip or Slide mode, the Trim View changes to a four frame display, which, in addition to the incoming and
outgoing frames of the clip you are slipping or sliding, also displays the outgoing frame of the preceding clip and the
incoming frame of the subsequent clip on the timeline.

See Trimming Clips (page 231).

MediaHub Performance Improvements

■ You can now resize the thumbnails displayed in the MediaHub. The thumbnails are now displayed in 16:9.

■ Navigation through folders is more responsive.

■ The contents of large folders are displayed faster than before; in some cases, what would take minutes to display now
takes seconds.
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■ Clips are displayed progressively in folders and you can start interacting with them as they appear (for example, you
can drag and drop to import).

■ The MediaHub continues to load media if you change tabs.

■ A new column, File Size, can now be displayed in the List View of the MediaHub. It is hidden by default because file
size calculations impact significantly MediaHub performances.

■ Clear messages indicate whether the displayed folder is read-only or not.

■ When restoring media from an archive, the clips you dragged from the archive to the Media Library now appear in
the Media Library. They are greyed out to indicate that they have not been restored yet, and remain so until you click
Restore.

■ User feedback, in the form of better messaging, has been improved when importing AAF, XML, and EDL sequences,
as well as when exporting clips.

■ You no longer can rename a folder in the MediaHub by simply double-clicking its name. You must now use the
contextual menu.

Updated Support for RED Import

■ Support for REDCODE SDK 4.4

■ Support for RED EPIC-M MONOCHROME R3D files

NOTE Currently, the RED Rocket card cannot decode R3D monochrome files. Unfortunately, this means that the application
displays greyed clips when browsing MONOCHROME R3D media on a RED Rocket-equipped workstation. You can still import
the media in the application: first enable Cache Source Media, and then import the MONOCHROME R3D media.

■ Updates to DRX processing

IMPORTANT Changes to the SDK affect how the DRX setting is computed for all R3D clips, and thus can impact the look of
come clips. It impacts previously imported clips.

The clips affected are the ones that have a DRX setting other than 0. To check for this, from the timeline, open the
Pre-Processing Editor and look for DRX under Basic ➤ Image.

If DRX is not 0, then your media is impacted by the change. How much of an impact is hard to predict, but since DRX
(Dynamic Range Extension) is used to reconstruct clipped colour channels, verify for clips with dangerous highlights
and for HDRx material.

■ Support for DRX processing via RED Rocket

The DRX setting is now processed by the RED Rocket card, when present. The following driver and firmware must be
installed:

■ RED Rocket driver 1.4.32.0

■ RED Rocket firmware 1.1.16.11 or later

■ RED Rocket Breakout Box firmware 1.0.2.0 or later

Updated Support for SonyRAW Import

■ Support for files generated by Sony F5 and F55 lines of cameras, joining the already supported F65.

NOTE Only the F65 camera supports resolution higher than 4K. For example, selecting 6K for a F5 clip results in a checkerboard,
which you can solve by switching to a supported debayering resolution.

■ Support for orientation changes (flip/flop).

■ Debayering quality now offers 2 settings, Standard and High.

■ New debayering resolutions are now available and have been added to the debayering options.
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■ Debayering options have been renamed to reflect what is used in other applications
■ 0.25K (previously named Sixteenth)

■ 0.5K (previously named Eighth)

■ 1K (previously named Quarter)

■ HD (1920)

■ 2K (previously named Half)

■ QFHD (3480)

■ 4K (previously named Full)

■ 6K

■ UHDTV (7680)

■ 8K

NOTE The colour space options--Rec709 primaries, ACES (daylight illuminant), ACES (tungsten illuminant)--have been updated
to solve an issue with black levels. This update impacts previously imported SonyRAW media used in current projects: the black
levels will not match. Make sure to update the Format Options from the timeline to reapply.

Updated Support for ARRI Import

IMPORTANT The timecode of some ARRIRAW files was not correctly read in previous releases. This version of Smoke fixes this
issue. If you use ARRIRAW clips imported in a previous release, loading this content in this new version shows the same visual
result but the source timecode will be updated. This also ensures that both the ProRes and the ARRIRAW files have the same
timecode, making it easier to offline in ProRes and relink to the raw media.

■ Support for ARRIRAW 4.4.

■ Support for MXF (DNxHD 145 and 220x as OP1a) files generated by the Alexa camera.

■ The debayering settings reflect changes to the ARRIRAW SDK and allow you to use either the original camera image
resolution (2880 pixels wide) or the same resolution as the ProRes file generated in camera (2868-pixel wide).
■ SD from 2880px

■ HD from 2880px

■ 2K from 2868px

■ 2K from 2880px

■ Native 2868px

■ Native 2880px

NOTE Half and Third debayering options are no longer available. This means that if you restore material archived at Half or
Third debayering, you will get a checkerboard upon restore. Use the Format Options from the timeline to select a valid
debayering setting.

■ New debayering modes are now available:
■ Proxy (new): Produces a low-quality debayering.

■ ADA-1 HW (was Camera): Visually reproduces the hardware-optimised debayering that is realised in cameras.

■ ADA-2 SW (was AMC-1): More efficient debayering than ADA-1.

■ ADA-3 HW (new): Visually matches the hardware-optimised debayering realised in cameras with ARRI SUP 7.0. A
more complex debayering than ADA-1, with extended edge and color handling.

■ ADA-3 SW (new): Advanced software debayering provided by the ARRI SDK.
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NOTE The HW refers to the method ARRI cameras use to decode RAW media. It does not mean that the application is
performing hardware optimized debayering.

■ New Colour Rendering: ACES (Scene Linear) gives you direct access to 16-bit floating point images. You no longer have
to apply a colour transformation to get 16-bit floating point images.

Avid Intermediates

Updated support for Avid Intermediate (transcoded) MXF media files.
■ Support now includes intermediates encoded with XDCam HD and XDCam EX codecs.

■ The following list shows all supported transcoded intermediates generated by Avid Media Composer:
■ AVC-Intra 50

■ AVC-Intra 100

■ DNxHD

■ XDCam EX

■ XDCam HD

■ The following is a list of Avid Media Composer intermediate formats not supported by Smoke:
■ J2K MXF

■ 1:1 MXF

■ 1:1p 10b MXF

■ Apple ProRes Proxy MXF

■ Apple ProRes LT MXF

■ Apple ProRes MXF

■ Apple ProRes HQ MXF

Support for Single-channel DPX Files

Monochromatic DPX files from the following film scanners have been validated.
■ FilmLight Northlight (10 & 16-bit)

■ DigitalFilmTechnology SCANITY™ (10 & 16-bit)

■ Imagica (8, 10 & 16-bit)

Miscellaneous Media Import Updates

■ Audio: WAVE-Extensible format can now be imported, but the spatial information of the tracks is discarded.

■ Audio: WAVE-Broadcast support now includes the RF64 standard. This means you can now import and export BWF
files larger than 4 GB.

■ Video: A clip with an alpha channel can now be imported as: a clip plus a standalone matte clip, a matte container
storing both the clip and its matte, or only the clip without any matte. Use the Alpha Channel Processing box in
MediaHub ➤ Browse for Files ➤ General.

■ Video: MXF OpAtom files generated by Avid Media Composer through importing, transcoding, and exporting AAF
files are now imported via MediaHub with their original audio channel, instead of defaulting to audio channel 1 as
before.

This means that when browsing these files through MediaHub, you see a single audio channel file (A1) but when
imported, the track shows the original channel. This improves file-based conform with media already imported in the
Media Library.
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Updated SDI Preview with Kona 3G

Monitoring in Smoke can now be done through the Kona 3G with the following rasters.
■ 1920x1080 @ 50p

■ 1920x1080 @ 5994p

■ 1920x1080 @ 60p

PCM in QuickTime Export

You can now export QuickTime movies with PCM audio and select an audio encoding profile to define both bit depth
and bit ordering. The following profiles are available:
■ 16-bit (LE)

■ 16-bit (BE)

■ 24-bit (LE)

■ 24-bit (BE)

■ 32-bit fp (LE)

■ 32-bit fp (BE)

LE: little endian; BE: big endian. Endianness has no impact on performance, and little endian should work in most cases.
Output in big endian mode if you expect compatibility issues with the target application or operating system.

Miscellaneous Media Export Updates

■ You can now specify Academy Density Exchange as the Transfer Type for DPX files. A new Colour Type box has also
been added to the same DPX format, allowing you to specify Colorimetric Encoding information. As before, Transfer
Type and Colour Type do not modify the output media: they are metadata fields that can be interpreted by third party
applications.

■ You can now export an uncompressed OpenEXR.

■ When exporting a QuickTime in MXF file, the Audio Sampling Rate export is always set to Same As Source.

■ You can now use the contextual menu to export a folder. The resulting export maintains the original organization
and hierarchy by creating a similar folder structure.

■ Codec profiles are now sorted alphabetically.

What's New in Conform

■ Conform now benefits from a more accurate timewarp translation (constant and animated) when conforming Apple
Final Cut Pro XML and Avid AAF files. Specifically, animated timewarps from Avid Media Composer are more precisely
translated. All unsupported transitions from Media Composer 6.5 AAF are now converted into a Dissolve and a Cut
Mark that displays the name of the original transition.

■ Apple added support for ARRI Alexa ProRes files in FCP 10.0.8, and now the XML referencing these media files can be
conformed in Smoke.

■ For this release, XML from FCP 10.0.4 and 10.0.5 no longer import in Smoke the segments that were Multicam clips
in FCP. Apple modified the MultiCam representation in FCP 10.0.6 and it is not possible to support legacy MultiCam
content. But XML files from 10.0.6 import just fine: Smoke displays MultiCam clips as segments just like before.
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What's New in the Timeline

■ Link functionality for timeline groups has been moved from the Timeline Gear menu to its own button (next to the
Ripple button). Performing a trim respects selections that are linked.

■ It is now possible to open multiple sequences simultaneously from the Media panel and the Viewing panel. You can
also close multiple sequences directly from the Timeline.

■ In the Timeline Options menu, the new Selection Includes Gaps setting allows you to select whether empty gaps are
included, when performing a selection on the timeline.

■ You can now edit a Gain Animation curve directly on a timeline audio clip, if Show Gain Animation is enabled in the
Timeline options menu. In this case, a Gain Timeline FX is automatically applied when you modify the Gain curve.

■ You can now drag and drop to copy Format Options (format specific settings such as debayering settings or timecode
selection) and Pre-processing Options (resize on import and LUT) between timeline segments.

■ While the positioner is over a cut or transition on the timeline, you are now able to set a Mark Out with the keyboard
shortcut.

What's New in the Player

■ You can now change the behaviour of the Play button. Click and hold the Play button, select the command you want
to apply to the Play button from the menu (such as Loop). That behaviour is now assigned to the Play button until
you change it again.

■ As you drag in the Mark In and Mark Out fields to change values, the image displayed in the Player now updates.

■ When working in the Viewing panel, image window viewing settings (such as contrast and image data type) are now
persistent by timeline tab type (Source or Sequence), instead of by Player view.
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What's New in ConnectFX

■ You can now disable or enable the automatic insertion of a node when it is dragged between two connected nodes:
ConnectFX Preferences menu, under Preferences ➤ Schematic ➤ Auto Insert. When the preference is disabled,
you can still press Shift to auto insert.

■ Use a new preference to set the default ConnectFX viewport as 1-Up or 2-Up: Preferences ➤ Timeline FX / CFX
➤ Viewport Settings.

■ The name of the last saved CFX setup is displayed in the Name field when exiting and re-entering the same CFX.

■ The Offset field for setting the number of frames by which a ConnectFX clip is offset is now available from the Timing
view as well as the Clip settings.

■ Render options are now available as a contextual option when right-clicking a clip node (in addition to the Timing
View Render box).

■ The UI has been cleaned up slightly to provide consistency. For example, the Node Load and Save buttons are now
always available when a node is selected in schematic.

■ The MUX node includes the Freeze Current Frame button, used to output the image of the currently selected frame
for the duration of the clip.

■ Clips added by dragging to the CFX Sources folder in the Workspace Media panel now appear close to the last selected
node in the schematic. If no nodes are selected in the schematic, clips are added in the centre of the schematic.

■ You are now able to replace a clip in ConnectFX by dragging a source clip from the Workspace Media panel over a clip
in the schematic.
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What's New in Action

■ Smoke now supports the import of Alembic (.abc) cameras in Action. The Camera FBX node is renamed to Camera 3D
node.

■ Performance in Action is improved thanks to optimizations in the handling of 3D objects, shaders, and texture transfer
speed.

■ When accessing the Modular Keyer from Action, if the Action back clip is of a different resolution than the front clip,
a Resize node is now added to the Back pipeline.

What's New in Colour Management

■ You can import other transform file formats wherever a Colour Transform (.ctf) file may be loaded. Supported formats
include:
■ Autodesk legacy 1D LUT: .lut

■ Autodesk legacy 3D LUT: .3dl

■ ASC color decision list: .cdl

■ ASC color correction collection: .ccc (uses the first .cdl in the file)

■ Cinespace: .csp

■ ICC monitor profiles: .icc, .icm, .pf (uses the PCS-to-monitor-RGB transform)

■ Iridas Cube: .cube

■ Iridas itx: .itx

■ Iridas Look: .look (partial support)

■ Nuke: .vf

■ Imageworks 1D LUT: .spi1d

■ Imageworks 3D LUT: .spi3d

■ Imageworks matrix: .spimtx

■ Pandora: .m3d, .mga

■ You can now define a Look transform in LUT preferences, and toggle it on and off from the viewer heads-up display.
You can use any supported file format. In addition, you can reference the defaultLook alias in your own custom
transform files.
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■ The graphics-monitor transforms have been replaced by current-monitor transforms. For example,
ACES_to_graphics-monitor.ctf has been replaced with ACES_to_current-monitor.ctf. The current-monitor transforms
make use of the currentMonitor alias, which gets resolved to the display profile set in LUT Preferences for either the
Broadcast Monitor Transform or Graphics Monitor Transform depending on which display the image is being drawn
to. In addition, you can reference the currentMonitor alias in your own custom transform files.

■ You do not need to re-import viewer transforms after changing the Graphics Monitor Transform, Broadcast Monitor
Transform, or Default Look Transform in LUT Preferences.

■ New ASC_CDL operator for representing an ASC color decision list in the CTF file format.

■ New Log operator for applying a logarithmic or anti-logarithmic function to convert between linear and Cineon-style
encodings.

■ You can now use the Matrix operator in a custom .ctf file to modify the alpha channel.

■ New Sync with OS option in LUT Preferences synchronizes the Graphics Monitor Transform with the ICC profile
currently assigned in MacOS System Preferences.

New Feedback Mechanisms

■ A new console displays messages about the status of tasks being performed by the application. To open, click the arrow
button on the lower left corner of the UI.

■ An updated Background Tasks view shows status for various tasks, including caching, media import and export, and
Burn. To open the Background Task view, open the Console. Then click View All in the Background Tasks section of
the Console. From the Background Tasks view, you can restart, delete, suspend, or resume a task using the buttons or
from the right-click menu. You can also sort and re-order the columns in the list.

■ A dialog box displays the render progress.

Project Conversion and Deletion at Startup

With this version of Smoke, you can now convert projects created in Smoke 2013 to the current version, from the Startup
screen. You do not have to first archive the project or go through MediaHub ➤ Projects. You can also delete old projects.

To convert a project to the current version of Smoke:

1 From the Startup screen, set the Versions filter to All Versions.

2 Select the project to convert from the Project box.

3 Click Start.

IMPORTANT The conversion is one way: once you convert the project, you cannot open it again in an older version of Smoke.

To delete a project from a previous version:

1 From the Startup screen, set the Versions filter to All Versions.

2 Select the project to convert from the Project box.

3 Click Edit to open the Edit Project window.

4 From the Project Edit box, select Delete Project.

5 Click Delete.

Smoke now deletes the project and all the related files.

10 | Chapter 1    What's New in Smoke



Background Processes Detection

■ Now Smoke detects at launch if the Wiretap background services are running and compatible with the application
version. If the background services are not running, or if there is a compatibility mismatch, the application asks you
how to proceed.

■ If you need to restart your local Wiretap Gateway from the Preferences: Preferences ➤ Storage ➤ Local Gateway.

Build 2013-05-21
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Getting Started with Smoke

Create a Project, Create a User, and Click Start!

After you double-click the Smoke icon to get started, the Smoke start-up screen appears.

Look at those Project and User fields. If they say "Click the New button", it means you must you must create a project
and/or user before you can start.

To create a project and user, and then start Smoke:

1 Click the New Projet button. A dialog box with project settings appears. There are a lot of options in this dialog box.
Just set up a basic HD project to get started. From the Resolution box, select 1920 X 1080 HD and click Create.

You land back on the Smoke start-up screen.

2 Click the New User button. A dialog box with user settings appear. Just type your name in the Name field and click
Create. The rest of the default settings are fine for getting started.

You land back on the Smoke start-up screen again.

3 Click Start to open up Smoke.

This time you land on the Smoke workspace.

Get Familiar with the Smoke Workspace

The workspace is where you accomplish all of your project tasks. The workspace consists of three main panels:
■ The Media panel

■ The Viewing panel

■ The Editing panel

Each panel has its own menu bar with commands specific to the tasks you can perform in that space.

2
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Drag and Drop Media to the Media Library

Now that you understand how the workspace is laid out, simply navigate to the location of your media, using the Finder
and drag and drop it to the Media Library.

If you have any problems, check out the Supported Media File Formats (page 51) to make sure the media you want to
import is supported.

Get Creative

Explore the editing and effects capabilities of the software.

We have designed learning content to help you on your way.
■ To get started editing, learn how to create your first edit in Smoke (page 225).

■ To get started with effects, learn how to make new sources using the tools in the Tools tab (page 289).

■ Then build on your effects knowledge and learn how to build procedural composites in ConnectFX (page 291).

■ Consult the Effects and Tools Reference (page 887) for a comprehensive list of all the effects you can build in Smoke.
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Smoke Interface Overview

The workspace is where you accomplish all of your project tasks. The workspace consists of three main panels:
■ The Media panel

■ The Viewing panel

■ The Editing panel

Each panel has its own menu bar with commands specific to the tasks you can perform in that space.

At the bottom of the user interface is a series of four tabs. Each tab gives you access to different views within the application.
Regardless of which view you are in, you remain in the same environment.

3
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NOTE To hide the top menu bar and use the application in full screen, you must specify this setting in the Smoke Setup utility,
which is found in the Smoke <version> folder. In the Smoke Setup utility, under the General tab, set the Menu Bar option to no.
When you hide the top menu bar, certain options, exclusive to the top menu bar appear at the bottom right of the screen. You
must restart Smoke after making the change for it to take effect.

About the Media Panel
The Media panel is the centralized location where you organize all of your project media.

NOTE  When you launch Flame for the first time, the Media panel is not displayed. To display it, from the Media
panel View Mode box, deselect Hidden.

Description:Section:

Project Name: The name of your current project is displayed at the top.

Conform Media: Any conform media imported in the application is displayed in the
Conform Media section. This section is only displayed while in Conform view.

CFX Sources: Any media used in ConnectFX is displayed in the CFX Sources section. This
section is only displayed while in ConnectFX view.

Workspace Library: All media and folders reside in a Library. Within Libraries, you can
create folders to organize your media.
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Description:Section:

Search Field: Perform name based searches for media in the Media panel. Search results
are displayed in alphabetical order. The search results list is always the last entry in the
panel.

Media Icons and Selection Reference
Media Thumbnail Icons

The Media panel displays icons next to the media so you can assess its contents at a glance.

Media:Icon:

ClipNo Icon

Sequence

Effects Clip

Opened Sequence (Timeline)

Selected Clip

Selected Sequence

Selected Effects Clip

Media Selection Colour Coding

Clips in the Viewing panel are displayed with a coloured border based on the type of selection and the media
type.

Selection:Border:

Unselected clip. No border.
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Selection:Border:

Primary/secondary selection. A yellow border is displayed on the primary selection
and a grey border on the secondary selection(s). The last selected clip becomes
the primary selection.

Active sequence. A red border is displayed when an active sequence is selected.

Active source. A green border is displayed on the currently open source when an
active sequence is selected.

Last rendered clip. A blue border is displayed on the last rendered clip.
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Selection:Border:

Ganged clips. The clip information displayed on the thumbnails of ganged clips
turns green when selected. Otherwise, the clip information on ganged clips is yellow.

NOTE When the selection is made from the Media panel, the yellow border appears in the Media panel selection
and the clip in the Viewing panel is bordered in grey, regardless of the media type.

Timeline Colour Coding

On the timeline, different colours indicate different states of elements:

State:Element:

A selected video segment.

An unselected video segment.

An audio segment.

A container.
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State:Element:

A segment with a CFX applied.

A segment with unlinked video.
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Managing Projects and Users

Projects and users define your working environment in Smoke.
■ Projects define the display environment.

■ Projects provide settings for project resolution, aspect ratio, bit depth, scan mode, etc

You typically create a project for each job you work on.

For each person working on your system, you can also create a user.

A user is a profile that maintains the following preferences:
■ User interface settings

■ Pen and tablet preferences

■ Keyboard shortcuts

Working with Projects
To create a project:

1 To create a project on start-up, click New from the Project panel.

2 To create a project in the middle of a session, from the File menu, select Project And User Settings.
■ The Project and User Settings dialog box appears.

■ From the Project panel, click New.

■ The Create New Project dialog box appears.

3 In the Name field, enter a name for the new project. Names can be up to 120 characters long.

4 If you have multiple volumes on your system, you can select the volume you want to work with from
the Volume field. If you only have one volume, the volume name is displayed.

NOTE Projects are tied to the volume they were created on and cannot be accessed from a different volume.
To access the content from a project on a different volume, you can wire the clips and sequences from that
project to a project on the current volume.

5 Set the setup directory for the project.

6 Set the setup mode for the project.

7 Set the default resolution for the project.

4
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The default project configuration template is automatically loaded. You can manually select a different
project configuration template if you like. This can be useful if your monitor does not natively support
the resolution of your project. See About the Project Configuration Template (page 24).

8 Set the aspect ratio for the project.

9 Select the bit depth for the project.

10 Set the scan mode for the project.

11 Select the graphics rendering bit depth for the project. For best results, leave the default option of
16-bit FP Graphics.

12 Set the Cache and Renders settings.

13 Set the Proxy Settings.

14 When you are satisfied with project settings, click Create.

TIP
■ If you create a project in the middle of a session, you must load it by clicking Load in the Project

panel.

■ To reset project settings, click Reset. You can edit a project's settings at any time.

■ You can exit the Create Project dialog box at any time without creating a project, by clicking Cancel.

To edit a project:

1 From the File menu, select Project And User Settings. The Project and User Settings dialog box appears.

2 From the Project box, select the project you want to edit.

3 Click Edit. The Edit Project dialog box appears.

4 Modify the settings.

5 Click Done and then Confirm.

The modifications are applied to your project.

To delete a project:

1 From the File menu, select Project And User Settings. The Project and User Settings dialog box appears.

2 From the Project box, select the project you want to delete.

NOTE You cannot delete the current project.

3 Click Edit. The Edit Project dialog box appears.

4 Click the Project Edit box and select Delete Project.

5 Click Done and then Confirm.

You are prompted to confirm the deletion of the clips contained in the project.

6 Click Confirm.

You are prompted to confirm the deletion of the setups contained in the project.

7 Click Confirm.

The project is deleted.

NOTE When you delete a project, all its associated clips and setups are deleted with the project.

NOTE You cannot open a project created in Smoke 2013Smoke without first converting it.
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To open a project created in Smoke 2013:

1 From the Startup screen, in the Projects section, set the Versions filter to All Versions.

2 Select the project to convert from the Project box.

The version of Smoke used to create it appears in brackets.

3 Click Start. Smoke converts and opens the project.

IMPORTANT The conversion is one way: once you convert the project, you cannot open it again in an older
version of Smoke.

To open a project created in Smoke before Smoke 2013, use one of the following options.
■ Create an archive in that older version and Smoke and restore that archive in the newer version.

■ OpenMediaHub ➤ Browse for Projects and browse to project to restore. You can then import those
files in the new Smoke.

About the Project Setup Directory

Setups are file-based resources such as effects settings, EDLs, and LUTs and are managed in a set of
subdirectories in the project's setup directory.

When you create a project, the project's setup directory appears in the Setup Directory box.

You are not restricted to these directories when you load or save setups. You can use the file browser to
locate a different directory, or use project shortcuts to browse the setup directories of other projects on the
same system.

Sharing a Setup Directory with an Existing Project

You can share the project home directory with an existing project, allowing you to share setups between
the two projects.

To share the project home directory with an existing project:

1 From the Setup Directory box, select the existing project's home directory that you want to share.

Any setups already saved to the existing project are made available to the new project.

Copying Setups from an Existing Project:

To copy setups from an existing project:

1 From the Setup Mode box, select Copy From.

2 From the Projects box that appears to the right of the Setup Mode box, select the existing project from
which you want to copy the setups.

About the Graphics Rendering Bit Depth

Depending on your system, you can specify the bit depth for images rendered by the graphics card. The bit
depth affects the quality of the resulting clip. The images can be rendered with 8-bit or 16-bit FP precision.

As a rule, if you are working with mixed resolutions and some clips are higher than 8-bit, you should select
16-bit FP graphics display. Even if you work only with 8-bit images, you can get better rendered results with
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16-bit FP graphics rendering when transparencies, blending, and gradients are part of your effect. 16-bit FP
graphics rendering produces better results but takes longer.

Also, if your output is ultimately an 8-bit format, having the best possible quality immediately prior to
output produces the best results.

About the Project Configuration Template

Each project has a project configuration file. When you load a project, its project configuration file is read.
Information in the project configuration file determines settings such as graphics monitor refresh rate,
default timecode, and default frame rate for playback.

A project's configuration file is created based on a project configuration file template. The template specifies
project settings typically associated with the project's default resolution.

When you select a resolution, a project configuration template appears in the Configuration Template box.
The project configuration file primarily defines the display environment, and in no way restricts you from
working with clips of another resolution.

Setting the Proxy Management Options

Proxies are low-resolution copies of high-resolution clips. Using proxies enables you to get a higher level of
playback performance and responsiveness, especially when working with large files. Set proxy management
options to specify how and when proxies are generated for clips used in the project. The default setting is
Proxies Off.

To set proxy management options:

1 From the Proxy Management option box, select an option.

TIP To change proxy management options for a current project, you must access the Project and User
Settings dialog box.

To display:Select:

Proxies for all clips larger than the proxy width you set for all proxies.Proxies On

Proxies only for clips that meet conditional criteria, for example, clips that exceed a
width of 4000 pixels.

Conditional

2 Specify the proxy size by doing one of the following:
■ Select Fixed Width from the Proxy Size box and then enter a value in the Proxy Width field beside

the Proxy Size box. For example, enter 720 to create and store proxies 720 pixels wide. Proxy height
is determined by the clip's aspect ratio.
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NOTE
■ If the proxy resolution and bit depth settings are the same as the as the full resolution clip, proxies

are not generated.

■ If the proxy resolution is the same as the full resolution clip, but their bit depth is different, proxies
are generated.

■ Select Frame Percentage from the Proxy Size box and then enter a value in the Scale field. For
example, enter 0.50 to create and store proxies that are 50% of the clip resolution.

Proxies always have the same aspect ratio as the full-resolution clip. The width of proxies for clips with
the default resolution corresponding to the scale value you set is displayed in the Width field.

3 If you selected Proxies Conditional, set your conditional criteria.

■ To store proxies for all clips of a certain width and greater, enable Frame Width > and then enter
a value in the adjacent field. For example, enter 4000 to store proxies for all clips wider than 4000
pixels.

■ To store proxies only for 10-bit, 12-bit, or 12-bit unpacked clips, enable Depth > 8-bit.

4 From the Proxy Quality box, set the quality of the proxy image for viewing purposes.
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Proxy quality affects rendering and proxy generation duration since lower qualities are faster to calculate.
However, the quality does not affect the amount disk space required for proxies.

To specify:Select:

Excellent and sharp results. Recommended for upscale and downscale. Expensive to
compute.

Lanczos

Excellent and sharp results. Results are sharper than Lanczos in small details. Recom-
mended for upscale and downscale. Expensive to compute.

Shannon

Medium quality and softer results.Gaussian

Medium quality and softer results.Quadratic

High-quality results, but not as sharp as Shannon. Use for both upscale and downscale.Bicubic

High-quality results, but not as sharp as Shannon. Use for both upscale and downscale.Mitchell

Low quality results that are fast to compute. Use for downscale.Triangle

Very low quality results that are fast to compute. Use for downscale.Impulse

The lowest possible quality. This is the quality used when proxies are generated auto-
matically following video I/O.

Draft

5 From the Proxy Bit Depth box, select the bit depth for proxies.

To set:Select:

The proxy bit depth to 8 bits.Depth: 8-bit
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To set:Select:

The proxy bit depth to be the same bit depth as that of the clip.Depth: Full Res

Setting Cache and Renders Format

Set the default media format for your project under the Cache and Renders tab.

When rendering, media is rendered to the format specified in the Cache and Renders tab.

When importing media with Cache Source Media enabled, the media is transcoded to the format specified
in the Cache and Renders tab. Media imported with Cache Source Media disabled is not transcoded and
keeps its original format.

To set the Cache and Renders format:

1 Click the Cache and Renders tab.

2 Select the media format from the Cache and Renders Preferred Format box.

NOTE Preferred Formats are all available in RAW and non-RAW flavours. Use RAW flavours in most cases, and
non-RAW ones if you plan on exporting OpenEXR in linked publish.

The Format Restrictions for the selected format are displayed in a table to the right of the drop down menu.

Description:Format Restriction:

Displays the maximum width of a frame for it to use the Preferred Format. A frame
wider than this is written using one of the Alternate Formats.

Maximum Width

Displays the maximum height of a frame for it to use the Preferred Format. Any
frame bigger than this is written using one of the Alternate Formats.

Maximum Height

Displays the maximum bit depth of a frame for it to use the Preferred Format. Any
frame at a bit depth higher than this is written using one of the Alternate Formats.

Depths

Displays the fallback formats used to write frames that do not fit within the parameters
defined by Maximum Width, Maximum Height, and Maximum Bit Depth.
The application follows a specific fallback strategy, based on the bit depth of the
frame and the displayed formats:

Alternate Formats

■ DPX, OpenEXR, RAW: DPX for 8-, 10-, and 12-bit frames. OpenEXR for 16-bit
floating point frames, RAW for 12-bit packed ones.

■ DPX, RAW: DPX for 8-, 10-, and 12-bit frames. RAW for 12-bit packed, 16-bit
floating point, and higher.
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Working with Users
Creating a User

You can create a user:
■ On start-up from the Project panel.

■ During a session, by selecting Project and User Settings from the File menu.

When you create a user, you have the option of copying preferences from an existing user. If the user whose
preferences you want to copy was created on the same version of the application, you can copy all preferences.
If the user was created on an older version of the application, you can only copy shortcut preferences.

To create a user:

1 If you are creating a user on start-up, select New under User on the startup screen. (If you are starting
Smoke for the first time, New is the only option).

2 If you are creating a user in the middle of a session, from the File menu, select Project And User Settings.

The Project and User Settings dialog box appears.

3 Under User, click New.

The Create New User Profile dialogue box appears.

4 Under User, click New.

5 In the Name field, enter a name for the new user.

6 Set your Preferences Directory.

If you are connected to a network with multiple hosts, you can select a remote host to store your user
preferences. The default option is Local Host.

7 Select your Keyboard Shortcuts scheme. Options are:
■ Smoke (FCP 7)

■ Flame

■ Smoke Classic

8 If you do not want to copy user preferences from an existing user, select New Prefs and click Create.

The user is created. The dialog box closes and you can begin working.

9 If you want to copy user preferences from an existing user, select Copy From.

10 From the Files box, select the type of files to copy. Options are:
■ All

■ Shortcuts

NOTE If the user you want to copy the settings from was created on an older version of the application, you
can only copy shortcut preferences.

11 From the Host box, select the host on which the user is saved.

12 From the Version box, select the software version used to create the user.

13 From the User box, select the user from which you want to copy the preferences.

14 Click Create.

The user is created. The dialog box closes and you can begin working.

NOTE If you create a user in the middle of a session, you must load it by clicking Load in the User panel.
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Editing a User

You can edit a user after it has been created.

To edit a user:

1 From the File menu, select Project And User Settings. The Project and User Settings dialog box appears.

2 From the User box, select the user you want to edit.

3 Click Edit. The Edit User Profile dialogue box appears.

4 Modify the appropriate settings.

5 Click Done and Confirm.

The modifications are applied to your user.

Deleting a User

To delete a user:

1 From the File menu, select Project And User Settings. The Project and User Settings dialog box appears.

2 From the User box, select the user you want to delete.

3 Click Edit. The Edit User Profile dialogue box appears.

4 Click the User Edit box and select Delete User.

5 Click Done and Confirm.

The user is deleted.

Working with Users | 29



30



Organizing Media in the Workspace

Displaying and Hiding the Media Panel

The Media Library is the centralized location to which you import all of your media. The Media Library organizes your
media into Libraries which contain your clips. Within a Library, you can create as many folder as you like to organize
your clips. Libraries can be opened and closed. Closing the Libraries releases them from memory and makes their content
inaccessible. You open and close Libraries from the contextual menu.

The Media panel is persistent throughout the application. You can toggle the display of the Media panel by using the 1
+ Back Arrow keyboard shortcut.

TIP You can view the clips in the Media panel as large thumbnails by Alt + clicking them.

Protecting Media from Editing in the Media Library

You can protect clips in the Media Library from editing, by enabling the Protect from Editing button under the General
tab in the Preferences. When this preference is enabled, the following operations cannot be performed on clips in the
Media Library:
■ Editing of a source clip (Trim, Slip, Cut, etc.)

■ Timeline FX operations (Add, Delete, Modify, etc.)

■ ConnectFX operations

■ Opening a clip as a sequence

5
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Clips CFXSources area can still be edited with the Protect from Editing preference enabled.

Changing Your View of the Smoke Workspace
The Viewing panel gives you different visual representations of the clips in the Media panel.

From the View mode box, you can select from the following views:
■ Thumbnails: Displays the clips within the selected Media panel folder as thumbnails.

■ Player: Displays and plays back the selected clip in a Player.

■ Source - Sequence: Displays and plays back the selected source clip and sequence in two side-by-side
players.

■ Triptych Player: Displays and plays back one or multiple clips in three side by side players. This can
be useful for colour matching, for example.

■ Trim View: Displays the last (outgoing) and first (incoming) frame above the Timeline from the two
clips you are trimming.

TIP Double-clicking a clip in the Media panel, displays it in the Player.

Generating Clips
You can generate the following generic video and audio clips and use them as would any other media:

■ Colour Source

■ Colour Bars

■ Noise

■ Gradient

■ Audio Tone

To generate a clip:

1 From the File menu, select New.

2 Select the type of clip you want to generate.

3 Set the options in the dialog box that appears.

4 Click Create.

Once created, a clip is displayed as a source in the timeline, the Media panel and the Viewing panel.

Displaying Media Metadata
By default, basic metadata is displayed on each corner of a thumbnail, such as current timecode, video and
audio tracks, duration and clip or sequence name. You can also view detailed metadata for each clip or
sequence in the Viewing panel.

There are two ways you can display detailed clip information:

To display clip information on a thumbnail:

1 Make sure you are in Thumbnail view.
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2 Press the Alt key and click a thumbnail.

To display detailed clip information in the Media panel:

1 From the View mode box, select Details.

Displaying Media Metadata | 33



Creating and Opening Sequences
A sequence is an edited clip that can contain multiple sources. When you edit a clip, it becomes a sequence.
When you create a new project, an empty sequence is created within the project. You can create new
sequences from the Media panel.

Creating an Empty Sequence

1 From the Media Panel Gear menu, select  New ➤ Sequence.

The New Sequence dialog appears.

2 Specify the settings for your sequence.

3 Press Create.

An empty sequence is created. It is displayed in the Timeline, the Media panel, and the Viewing panel.

Opening a Source as a Sequence

1 Select a source from the Viewing panel or the Media panel.

2 From the contextual menu, select Open as Sequence.

A new sequence is created from the selected source. It is displayed in the Timeline, the Media panel,
and the Viewing panel.

NOTE When opening a source as a sequence, the sequence is created using the original media. When you
add a source to an existing sequence, a copy of that source is added to the sequence, leaving the original
source intact.

Opening Multiple Sequences Simultaneously

1 Select folders or Libraries in the Viewing panel or the Media panel.
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2 From the contextual menu, select Open All as Sequences.

All the clips and sequences within the folder or Library are opened as individual sequences.

TIP This can also be achieved by dragging the folder or Library to the timeline.

Opening Multiple Clips as One Sequence

1 Create an empty sequence.

2 Select the clips to load and join as one sequence from the Media panel or the Viewing panel.

3 Drag the selected clips to the empty sequence at the desired timecode.

The selected clips are inserted in the sequence, in the order in which they were selected.

Closing All Sequences Simultaneously

1 Mouse over an open sequence tab in the Editing panel.

2 From the contextual menu, select Close All Sequences.

TIP This can also be achieved with the Shift + C keyboard shortcut.

Working in Thumbnails View

Organizing the Thumbnails in the Viewing Panel

The Thumbnails view displays the clips in the selected folder as thumbnails.

Arranging the Thumbnails

When in Thumbnails view, you can arrange the displayed thumbnails in a number of ways. To arrange the
thumbnails, do one of the following:

To:From the contextual menu, select:

Tile the thumbnails across the Viewing panel.Arrange ➤ Clean Up All

Tile the thumbnails across the Viewing panel at the highest possible resolution while fitting all the thumbnails within the Viewing panel.Arrange ➤ Fit All

Arrange the selected thumbnails as cascading stacks.Arrange ➤ Cascade Selection

Displaying a Snap Grid

Use the grid to snap thumbnails into position when moved.

To display a snap grid in the Thumbnails view:

1 Make sure the Viewing panel is set to Thumbnail view.

2 From the menu bar, select Autodesk Smoke ➤ Preferences.

3 Under the User Interface tab, in the Thumbnails view section, enable Snap To Grid.

4 Set your preferred grid size.
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5 Set your preferred proxy height.

6 Click Close to close the Preferences dialog box.

The Viewing panel displays a grid of the specified size.

Ganging Clips in the Viewing Panel

You can gang clips and sequences together in the Viewing panel so that when you jog one, they are all
jogged. This is useful for multicam setups. When you play a clip that is part of a gang, the current frame of
all other ganged clips is updated once playback has stopped.

To gang clips in the Viewing panel:

1 From the View Mode box, select Thumbnail view.

2 In the Viewing panel, locate all the clips or sequences you want to gang, and move their positioners
to the timecode you want to lock.

TIP Each clip or sequence can have its own timecode offset, but if you are working with a multicam setup,
make sure all positioners are parked at the same location.

3 Hold the Ctrl key and select the clips or sequences you want to gang.

4 While the cursor is over one of the clips to be ganged, from the contextual menu, select Gang.

All selected clips are ganged and the clip information turns green.

NOTE The clip information of ganged clips turns yellow when a non-ganged clip is selected.

5 Jog the positioner of one of the ganged clips.

All ganged clips or sequences are jogged.

To select all clips in a gang:

1 Select any clip or sequence that is part of a gang.

2 From the contextual menu, select Gang ➤ Select Gang.

All ganged clips or sequences are selected.

To remove a clip from a gang:

1 Select the clip(s) or sequence(s) you want to remove from the group.

2 From the contextual menu, select Gang ➤ Ungang.

All selected clips or sequences are unganged.

Undo and Redo
From the Edit menu, you can access the Undo and Redo options, as well as a list of the last 10 operations
that were performed. Selecting an operation from the list undoes all operations performed after the selected
operation (including the selected operation). The undo / redo operations are specific to each tab.

TIP You can set the Undo levels anywhere between 2 and 50, under the General tab in the Preferences. It is set
to 10 by default.
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NOTE  While in ConnectFX, you have access to all of your undo levels. Once you exit ConnectFX and return to
the timeline, all operations performed in ConnectFX are considered one undo level. This means that even if you
performed 7 different operations in ConnectFX, when you return to the timeline you can only undo all the
ConnectFX operations at once, not each individual operation.

Undo and Redo | 37



38



Importing and Exporting Media

Importing File-Based Media

TIP To work in a manner similar to offline editing suites, enable MediaHub ➤ General tab ➤ Cache Source
Media. This creates local, transcoded, and managed versions of your media. To work online, disable Cache Source
Media: the clips remain linked to the original media, and are not transcoded.

To import media using the MediaHub:

1 Click the MediaHub tab.

2 Using the MediaHub file browser, navigate to the file to import.

3 Review and edit as necessary the resolution, the bit depth and scan mode, and the LUT options. See
Colour Management (page 1161).

4 Click Import.

To import media from the Finder:

1 From Smoke, switch to the Finder.

2 Open a Finder window and navigate to the file to import.

3 Drag the file from the browser to the Media Library.

Importing File-Based Media Tips

■ Drag and drop a folder in the Media Library. Smoke imports all the media files and folders contained
therein. Note that only supported media files and folders are imported: other file types are ignored.

■ Drag and drop multiple files in one operation: hold Ctrl to select the files to import before dragging them
over to the Media Library.

■ Before importing the media, review it using the Previewer.

■ Use the Previewer's tabs to display the clip information and additional metadata.

■ For large media, use the Previewer to set In and Out points and import only a subclip.

6
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■ If the media file to import is located on a network drive, and if you plan on using referenced media
instead of project media, make sure that the network connection is at at least 1 GB ethernet to have
decent playback.

■ If the media file to import is located on a removable media such as a USB drive, and you plan to remove
the drive before the end of your project, import with Project Media enabled. This way Smoke creates
natively managed media out of the original, removing the need for the connected drive.

■ A folder in the Media Library is the same as a bin in Avid Media Composer or Apple Final Cut Pro.

■ From the Media Library, right-click > Import... to import media to that location.

■ The files to import cannot contain any hyphen (-) or square brackets ( [ ] ).

NOTE Getting clips with checkerboards instead of images? Check if your workstation is still connected to the
volume you used to store your media; if not, reconnecting the volume to the workstation should do the trick.

Exporting Media to Files
To export a clip:

1 Right-click the clip to export and select Export.

In the MediaHub, you can also drag-and-drop the file from the Media panel to a location displayed in
the MediaHub browser.

2 Navigate to the clip's destination, using the Media Export window.

3 Select an Export type and a Format Preset.

4 Click Export.

Smoke takes a few instants to prepare the export job. Once that preparation is done, the rest of export
happens in the background and frees up Smoke for your use.

TIP Select multiple clips (CTRL+Click or Shift+Click) to export multiple clips in one operation. You can also export
a folder and its structure. Note that some timings are incompatible with some codecs, such as exporting a 30fps
clip to XDCAM HD 422 (which accepts only 25fps source clips). In such cases, clips using incompatible timings
are not exported.

NOTE Smoke exports OP1A MXF files. Avid only supports OP-Atom MXF files. Use AMA MXF plug-in to bring the
files into an Avid application, like you would for QuickTime files.

Publishing A Sequence as an EDL With Media

To publish a sequence as an EDL with transitions but flattened tracks:

1 Right-click the clip to export and select Export.

In the MediaHub, you can also drag-and-drop the file from the Media panel to a location displayed in
the MediaHub browser.

2 Navigate to the clip's destination, using the Media Export window.

3 Set Export Type to Sequence Publish.

4 Set Format Preset to one of the EDL presets.

5 Click Export.

Smoke takes a few instants to prepare the export job. Once that preparation is done, the rest of export
happens in the background and frees up Smoke for your use.
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NOTE An EDL can only describe one video track, so your exported sequence will be flattened.

Publishing a Sequence as a Custom EDL

To publish custom EDL without any media:

1 Right-click the sequence to export and select Export.

In the MediaHub, you can also drag-and-drop the file from the Media panel to a location displayed in
the MediaHub browser.

2 Navigate to the EDL destination, using the Media Export window.

3 Set Export Type to Sequence Publish.

4 Set Format Preset to one of the EDL presets.

5 Click Show Advanced Options.

6 Click Sequence Options ➤ Custom EDL Export.

7 Set the EDL options as required.

8 Click Export, and then click Save Generated EDL.

About the Custom EDL Export Window

EDL Event Combination box Select an option to indicate how events with the same source timecodes,
record timecodes, and tape ID are combined when the EDL is generated.

To use:Select:

A single entry for all video and audio events.Combine All Events

One entry for audio events and a separate entry for video events.Combine Audio Events

A separate entry for each video and audio event.Never Combine Events

EDL Format box Select the format of the generated EDL. You can save EDLs in any of the following formats:

■ CMX 3600■ CMX 340

■ ■CMX OMNI GVG 4

■■ SONY 900GVG 4 Plus (GVG v4.1 or higher)

■ ■SONY 910 SONY 5000

■■ SONY 9000 Plus (v2.21or higher)SONY 9000

■ SONY 9100

Segment Comments button Enable to allow comments added to the timeline to be included in the generated
EDL.

Clip Name Comments button Enable to allow clip name comments to be included in the generated EDL.

2:3 Insertion Mode button Enable to convert the framerate of a 24p clip from 23.97 fps to 29.97 fps, and
maintain 2:3 pulldown information for all in and out points (including cuts, wipes, dissolves, and timewarps).
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2:3 pulldown data is important when master tapes are sent out for hardware-based tape-to-tape colour
correction.

The EDL file will include explicit notification of hybrid splices as punctuation marks in the record in and
out data.

Indicates a:A:

Regular splice record-in point for 29.97 fps non-drop frame timecode tapes.period (.)

Regular splice record-in point for 29.97 fps drop frame timecode tapes.comma (,)

Hybrid splice record-in point for 29.97 fps non-drop frame timecode tapes.colon (:)

Hybrid splice record-in point for 29.97 fps drop frame timecode tapes.semi-colon (;)

This button is enabled by default when a 24p template is selected at project creation.

Frame Code Mode box Select the drop frame mode for the output material. Select DF (drop frame) or NDF
(non-drop frame) format.

Use Delayed Dissolves button When enabled, delayed dissolves are included in the generated EDL.

Default Tape field Enter a tape name to override the default tape ID when saving an EDL. Source clips are
assigned tape IDs when loaded using the Input Clip or Import EDL menu. For example, an edit that uses a
clip created with the Colour Corrector does not have a tape ID. When the EDL is generated, the clip is given
the tape ID in the Default Tape field.

Audio Patch Comments button Enable to allow clip audio patching comments to be included in the
generated EDL.

Use Tape Name Extension button Enable to add a list to the end of the EDL that shows the relationship
between the short tape name (8 characters, maximum) used in the EDL and the long tape name (52 characters,
maximum) that you can set in the Import EDL menu.

Media Export Window Overview

Basic Options

Export Type box  Select the type of export to use with the selected files.

Preset Selection box  Select the export preset to apply to the exported files. Autodesk presets are built-in
presets that you can still modify using the Advanced Options. An asterisk indicates that the preset's advanced
options were modified.

Exported File Name field Name given to the exported file, as defined in the Advanced Options. Editable
when exporting a single clip.

Advanced Options button  Enable to display the advanced export options. You should not have to edit
these settings, unless the pre-configured presets cannot meet your needs.

Create Export Format Preset Dialog Box

Preset Scope box  Select Shared to have this new preset available across users and projects. Select This Project
Only to make it available to the current project only.
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Sequence Options Tab

Sequence Format box  Select the format of the sequence. Media Only exports the segments of the sequence
as individual clips, but does not export the sequence itself.

Include Video button  Enable to include in the published sequence the video tracks information. Required
to export video.

Include Audio button  Enable to include in the published sequence the audio tracks information. Required
to export audio.

Sequence Filename field Displays the sequence filename based on the Pattern field. Each type of exported
file has its own filename defined in the relevant tabs. Non-editable.

Sequence Filename Pattern field  Displays how to name the exported media files. Build a dynamic naming
scheme using Add Token, or characters normally allowed in a file name. Create folder structure using / . The
extension for the file format is automatically appended. Frame identifiers are automatically added to image
sequence files. Editable.

Add Token box  Inserts in the Pattern field a token to build a dynamic filename. Note: date is the current
date, formatted as YYYY_MM_DD.

Definition:To insert the token:Select:

The clip's name<name>Clip Name

The current date ( YYYY_MM_DD)<date>Date

The name of the workstation, as displayed in the Host

Computer field in File ➤ Project and User Settings.

<workstation>Workstation

The name of the project, as displayed in File ➤ Project

and User Settings.

<project>Project

The user name, as displayed in File ➤ Project and User

Settings.

<user>User

The clip's height, after resize if applicable.<height>Clip Height

The clip's width, after resize if applicable.<width>Clip Width

The clip's tape name<tape>Tape/Reel/Source

The time, formatted HH:MM:SS.<time>Time

Export Video button  Enable to export the segments of the sequence as files of the type specified in Video
Format.

Video Format box  Select the type of video file to create. For movie, you select the wrapper and codec in
the Movie Options tab. For file sequence, you select the file type in the Video Options tab.

Media Source box  Select Use Original Media to export the original source referred by the exported sequence,
without any modifications. Select Use Media with FX to export the rendered media.
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Video Tracks and Transitions box Select Keep All Tracks to export a clip for each segment of the sequence.
Select Flatten Tracks to export commit every transition and flatten the sequence. Select Flatten with Transitions
to flatten the sequence and commit every transition except dissolves, creating a single clip.

Include Video Handles button  Enable to add head and tail frames to exported segments.

Video Handles field  Display the amount of head and tail frames.

Export Audio button  Enable to export the audio files the sequence will link to.

Audio Source Selection box  Select Use Original Media to export the original source referred by the exported
sequence, without any modifications. Select Use Media with FX to export the rendered media.

Audio Track State box  Select Flatten Tracks to commit all transitions and create one audio clip per track.
Select Flatten Tracks with Transitions to create an audio clip per track but keep live transitions. Select Keep
All Tracks to export one audio clip per audio segment.

Include Audio Handles button  Enable to add head and tail frames to exported segments.

Audio Handles field  Enable to export the audio files the sequence will link to.

Movie Options tab

Container Format box  Select the container for the exported file.

YUV Headroom Disable to export a YUV headroom compliant clip (also known as valid- or legal-range). As
a general rule, should be enabled when deliverable is for broadcast. Enable to export a standard, full-range,
clip.

Include Audio button  Enable to include audio tracks within the exported file. Available only Export Type
is Movie.

Video Options tab

Video Format field Select the format for the exported media.

Compression box  Select the image compression to apply to the exported file. The available compressions
depend on the selection in File Format.

Codec Profile box Select a pre-defined video compression codec profile when exporting QuickTime files
using the H.264 or MPEG-4 codecs.

LUT Activation button Enable to apply the LUT displayed in Applied LUT to the clip .

LUT Type box Select the type of LUT to apply to the clip.

Applied LUT field Displays the type of conversion LUT applied to the clip, either imported using Import,
or edited using Edit.

Import button Use to browse and select a LUT.

LUT Editor Access button Click to open the LUT editor.

Link Original Media button Enable to hard link the published files to the original files if both the original
and exported files are located on the same filesystem. If not, the application creates soft links back to the
originals. Available for file sequences only.

This option saves disk space on export as files that remain unchanged by the export are not duplicated.
Unchanged in this context means they were not rendered not resized in anyway. For example, a file sequence
of 20 dpx are imported in Smoke. Of those 20, 12 are modified in some fashion. With Link Original Media
enabled, of the sequence of 20 dpx, only the modified 12 are actually created at export; the other 8 dpx are
just linked to from the export folder.
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Frame Padding field  Define the padding of the frame identifiers appended to each file of an image sequences.
This ensures that the images are listed and stored in the correct order. Only used with image sequences.

For example, a frame pad of 6 indicates that each frames's file name has its frame identifier padded with a
number of zeroes required to make it a 6-digit number: frame 1 is written as 000001, frame 22 as 000022,
frame 55555 as 055555, and so on.

Use Timecode button  Enable to base the start number of the exported sequence of numbered images on
the timecode read from the clip file.

Start Frame field  Enter the start number to be used in the exported sequence of numbered image files.
Disabled when Use Clip TC Names is enabled.

Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

DPX Transfer Characteristics box Select an option to identify the attributes associated with a particular
film or video format, such as resolution, frame rate, or colour space. Available when Video Format is set to
DPX.

When exporting DPX files, you can choose a DPX Transfer Characteristic. A DPX Transfer Characteristic is
information that is stored in the DPX image file header. It identifies the attributes associated with a particular
film or video format, such as resolution, frame rate.

Setting a Transfer Characteristic in no way changes the image information stored in the DPX file. The Transfer
Characteristic simply indicates the attributes of the DPX file read by another device or application. Some
devices or applications may take advantage of this information to improve workflow. For example, selecting
Logarithmic can allow a film recorder to adjust its parameters to print film-originated DPX files with the
correct densities.

For:Select:

Images that you want to identify as one of these types. Although the SMPTE

274M standard defines these DPX Transfer Characteristics, it does not provide

Z depth homogeneous, Z depth linear, PAL,

NTSC, CCIR 601 (525), CCIR 601 (625), CCIR

709-4, SMPTE 274M usage specifications for them. As a result, these Transfer Characteristics are

not generally used in the industry.

Images where the format is not specified.Unspecified

Negative film scanners recording status M densities.Logarithmic

Video images which have built-in gamma correction. This refers to images

having a true linear quantization scheme (such as CG-originated material).

Linear

Negative film scans which use the SMPTE Printing Density settings. SMPTE

Printing Densities use status M density measurements with a higher gain in

the red component.

Printing Density

Images at 10- and 16-bit film density encoding, in which colour information

is encoded using a logarithmic scale. Usually used in the context of an Image

Interchange Format workflow.

Academy Density Exchange (ADX)

DPX Colorimetric Specification box Select an option to identify the colorimetric specifications used to
encode the DPX files. Available when Video Format is set to DPX.

Setting a Colorimetric Specification in no way changes the image information stored in the DPX file. The
Colorimetric Specification simply indicates the attributes of the DPX file read by another device or application.
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Some devices or applications may take advantage of this information to improve workflow. For example,
selecting Academy Density Exchange (ADX) can allow a film recorder to adjust its parameters to print
film-originated DPX files with the correct densities.

JPEG Quality field Specifies the degree of quality versus compression. A value of 0 gives the lowest quality
(and highest compression), while a value of 100 gives the best quality (but applies no compression). Available
when File Format is set to JPEG.

Frame Width field Displays the frame width of the selected clip. By clicking it you activate the field, allowing
you to enter the frame width value that you want to use on export.

Frame Height field Displays the frame height of the selected clip. By clicking it you activate the field,
allowing you to enter the frame height value that you want to use on export.

Bit Depth box Select a bit depth to be used on export. Some file formats support multiple bit depths. Bit
Depth is active only when Resize is enabled.

Fit Method box Select a fit method option to be applied to the exported clip.

To:Select:

Fit the source image, centred, over the destination frame. If the source is larger than the

destination, it is cropped. If the source is smaller than the destination, it is surrounded by

a black border.

Centre/Crop

Fit one edge of the source into the destination frame without stretching or squashing the

frame. Excess parts of the source frame after resizing are cropped. If the source—after the

Crop Edges

one edge is resized—is wider than the destination, its overhanging left and right edges

are cropped. If the source is taller than the destination, the upper and lower edges are

cropped.

Fit the source, width, and height, into the destination frame. If the source and destination

frames do not have the same aspect ratio, the image can become distorted.

Fill

Fit the source to the destination frame without squashing or stretching it, and without

cropping the source. If the source is wider than the destination, black bars fill the top and

Letterbox

bottom of the destination frame. If the source is narrower than the destination, black bars

fill the right and left sides of the frame. In all cases, the entire source frame is contained

within the destination frame.

Resize Filter box Select the filter option to determine the quality of the interpolated resize result. The Resize
Filter box is active only if Fit Method is set to Crop Edges, Fill, or Letterbox.

To get:Select:

Quick, low-quality results.Impulse

Moderate results with little processing overhead.Triangle

Best results when resizing a clip to a higher resolution.Mitchell

Very good results for resizing soft-looking images. Use to sharpen the image.Bicubic
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To get:Select:

Good results for resizing simple images with straight edges. Similar to Gaussian but with

more blurring. Use to soften the image.

Quadratic

Excellent results when resizing a clip with no patterns and alot of straight edges to a lower

resolution. Useful for softening some detail.

Gaussian

Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but

results are a little softer.

Shannon

Best results when resizing a clip containing a variety of patterns and elements to a lower

resolution. It is the most complex with the longest processing time.

Lanczos

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the aspect ratio defined by Aspect Ratio Presets. Editable.

Scan Mode box Select an option to set the order in which the fields of interlaced material are scanned.

For interlaced material, you can specify whether the resize needs to be done from both fields or just from
one of the two. In the latter case, the result is a progressive clip made from the same two fields.

To resize:Select:

Using the scan mode of the source clip.From Clip

A frame-based clip to another frame-based clip.Progressive

A clip by drawing Field 1 followed by Field 2.Field 1

A clip by drawing Field 2 followed by Field 1.Field 2

Audio Options Tab

Audio Format box  Select the audio format of the exported audio tracks. If Export Type is Movie, the audio
is embedded within the video file. Any other Export Type outputs a separate audio file.

Audio Bit Depth box  Select the bit depth of the exported audio file.

Audio Compression field Select the compression for the exported audio file. The available options depends
on the Audio Format.

Audio Sample Rate box  Select the sample rate of the exported audio.

Audio Mixdown box  Select a mixdown to apply to the audio tracks, if any are included with the source
clip.

To mix down:Select:

NothingNo Mixdown
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To mix down:Select:

With the current output strip assignments.Mixdown As Is

To four tracks. The output strips are assigned sequentially in fours to the mixed-

down channels (where M1 goes to 1, M2 to 2, M3 to 3, M4 to 4, M5 to 1, and

so on).

Mixdown To 4 tracks

To one stereo track. The output strips are assigned sequentially in twos to the

mixed-down channels (where M1 goes to 1, M2 to 2, M3 to 1, M4 to 2, and so

on).

Mixdown To Stereo

To one mono track.Mixdown To Mono

Clip Options Tab

Create Clip in Media Library button  Enable to automatically create an unmanaged copy of the exported
media in the Media panel, linked to the exported files. Available when performing a Sequence Publish with
a File Sequence, without any resize or bit depth change. This is similar to importing back the exported media
with Create Source Cache disabled.

Setting Default Format Presets

The default preset is the one that appears first in the Presets drop-down list, knowing that the list is sorted
by category, and then alphabetically within each category. So if you have the following presets available to
the File Sequence export:
■ Project

■ Shared

Alias for grading

JPEG

Tiff

■ Autodesk

Alias (8-bit RLE)

Cineon (10-bit)

...

The default preset for File Sequence is Alias for grading. A new preset named DPX for grading in the Project
section will become the new default for File Sequence. The same preset but in the Shared section means that
Alias for grading remains the default for File Sequence.

You can have one default preset per Export Type.

To set a default format preset:

1 Right-click a clip and select Export.

2 Select the Export Type for which you want to define a default preset.

3 Select the Format Preset to use as the default.

You will create a renamed copy of this preset in the step below.
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4 Click Save.

5 In the Save Export Format Preset dialogue box, do the following:
■ Rename the preset.

■ Set the visibility to Shared or This Project Only.

This creates a renamed copy of the preset. Make sure it name and category makes it appear at the top
of the Format Preset drop-down list.

6 Click Save to save the preset.

You have just renamed the original preset and copied it to the Shared or Project section.

7 Click Cancel to close the Media Export dialogue box.

H.264 Codec Export Profiles

When exporting a clip as an H.264 in QuickTime, you can use one of the pre-configured H.264 codec profiles.

NOTE The H.264 codec profiles are xml files stored in
/usr/discreet/mediaconverter/2013.../profiles/Quicktime/video/H264.

The Suggested Clip Resolution guides you in the selection of a target resolution for the output. Using a
different resolution can provide you with unexpected results.

Bit RateSuggested Clip Resolu-
tion

DescriptionProfile

384 Kb/s352x288 or 352x240H264_CIF, Baseline profileBaseline_1SEG_384Kbits

256 Kb/s352x288H264_3GP 3GP, Baseline
profile

Baseline_3GP_256Kbits

600 Kb/s320x240H264_BASELINE, Baseline
profile

Baseline_600Kbits

300 Kb/s320x240H264_FLASH_LOWRES,
Baseline profile

Baseline_Adobe_300Kbits

1.5 Mb/s320x240H264_iPOD Apple iPod,
Baseline profile

Baseline_Apple_1_5Mbits

400 Kb/s320x240H264_iPOD Apple iPod,
Baseline profile

Baseline_Apple_400Kbits

600 Kb/s320x240H264_iPOD Apple iPod,
Baseline profile

Baseline_Apple_600Kbits

970 Kb/s320x240H264_iPOD Apple iPod,
Baseline profile

Baseline_Apple_970Kbits

600 Kb/s352x288 or 352x240H264_CIF at, Baseline
profile

Baseline_CIF_600Kbits
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Bit RateSuggested Clip Resolu-
tion

DescriptionProfile

12 Mb/s1920x1080H264_BASELINE, Baseline
profile

Baseline_RIM_12Mbits

20 Mb/s1920x1080H264_BASELINE, Baseline
profile

Baseline_RIM_20Mbits

4 Mb/s1920x1080H264_BASELINE, Baseline
profile

Baseline_RIM_4Mbits

10 Mb/s1920x1080H264_HDTV_1080i, High
profile, interlaced

HDTV_1080i_10Mbits

8 Mb/s1280x720H264_HDTV_720p, High
profile

HDTV_720p_8Mbits

6 Mb/s1920x1080H264_HIGH, High profile,
interlaced

High_1080i_6Mbits

20 Mb/s1920x1080H264_AVCHD AVCHD,
High profile, interlaced

High_AVC_HD_20Mbits

111 Mb/s1920x1080H264_INTRA_CLASS_100
AVC Intra Class 100, High
10 profile, interlaced

High_AVC_Intra_111Mbits

54 Mb/s1440x1080H264_INTRA_CLASS_50
AVC Intra Class 50, High
10 profile, interlaced

High_AVC_Intra_54Mbits

20 Mb/s1920x1080H264_BD_HDMV Blu-ray
HD, High profile, inter-
laced

High_Blu_Ray_20Mbits

8 Mb/s720x576 or 720x480H264_BD Blu-ray SD,
High profile, interlaced

High_Blu_Ray_8Mbits

2 Mb/s1920x1080H264_DIVX DivX+, High
profile

High_Divx_2Mbits

3 Mb/s720x576 or 720x480H264_DVD, High profile,
interlaced

High_DVD_3Mbits

20 Mb/s1920x1080H264_HD_DVD, High
profile, interlaced

High_HD_DVD_20Mbits
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Bit RateSuggested Clip Resolu-
tion

DescriptionProfile

10 Mb/s1920x1080H264_SILVERLIGHT Mi-
crosoft Silverlight, High
profile

High_Microsoft_10Mbits

500 Kb/s640x480H264_SILVERLIGHT Mi-
crosoft Silverlight, High
profile

High_Microsoft_500Kbits

3 Mb/s704x576 or 704x480H264_MAIN, Main profileMain_3Mbits

670 Kb/s640x480H264_FLASH_HIGHRES,
Main profile

Main_Adobe_670Kbits

1.8 Mb/s1024x576H264_MAIN, Main profileMain_Apple_1_8Mbits

4.5 Mb/s1280x720H264_MAIN, Main profileMain_Apple_4_5Mbits

3 Mb/s720x576 or 720x480H264_D1, Main profile,
interlaced

Main_D1_3Mbits

2 Mb/s640x480H264_PSP_640x480 Sony
PSP Level 3, Main profile

Main_Sony_2Mbits

700 Kb/s320x240H264_PSP Sony PSP,
Main profile

Main_Sony_700Kbits

900 Kb/s480x272H264_PSP_480x270 Sony
PSP Level 2, Main profile

Main_Sony_900Kbits

1.15 Mb/s480x576 or 480x480H264_SVCD, Main pro-
file, interlaced

Main_SVCD_1_15Mbits

Supported Media File Formats
Tables in this topic:

■ Image Sequence (page 51)

■ QuickTime (page 53)

■ MXF (page 55)

■ MPEG 4 (page 56)

■ Other Streaming Codecs (page 56)

■ Audio File Formats (page 57)

Image Sequence
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DepthExportImportExtensionFormat

8 bitsyesyes  (page 102).alsAlias®

12 bits—yes  (page 92).ariARRIRAW

NOTE Always presented as a clip, never as a sequence of RAW images. Supports material shot on camera
using ARRI SUP 7 or earlier, and features from version 4.4 of the ARRIRAW SDK.

10 bitsyesyes  (page 102).cinCineon®

8, 10, 12, 16 bits and ADX encoding.yesyes  (page 98).dpxDPX

See Note.—yes  (page 98).dpxDPX - Single chan-
nel

NOTE Monochromatic DPX files from the following film scanners have been validated:

■ FilmLight Northlight (10 & 16-bit)

■ DigitalFilmTechnology SCANITY™ (10 & 16-bit)

■ Imagica (8, 10 & 16-bit)

n/a—yes  (page 100).clipGateway

32 bits—yes  (page 100).hdrHDR

8 bitsyesyes  (page 102).jpgJPEG

8, 10, 12u, 12, 16 fp, or 32 fp bitsyesyes  (page 106).exrOpenEXR

NOTE Export is 16-bit only.

8 bitsyesyes  (page 102).pictPict (Macintosh®)

8 bitsyesyes  (page 102).picioPixar

8 or 16 bits—yes  (page 111).pngPortable Network
Graphics

NOTE Supports alpha.

8, 10, 12u, 12, 16 fp, or 32 fp bits—yes  (page 112).precompPrecomp

8 or 16 bitsyesyes  (page 102).sgiSGI®

8 bitsyesyes  (page 102).picSoftimage®
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DepthExportImportExtensionFormat

8 bitsyesyes  (page 102).tgaTARGA®

8 or 16 bits—yes  (page 102).iffTdi/Maya®

8 or 16 bitsyesyes  (page 102).tifTiff

8 or 16 bitsyesyes  (page 102).rlaWavefront®

QuickTime

DepthExportImportExtensionFormat

yesyes  (page 113).mov8-bit Packed YUV
4:2:2

NOTE Lossy codec. Avoid using for intermediates.

yes—.mov10-bit Packed YUV
4:2:2

NOTE Lossy codec. Avoid using for intermediates.

with alpha—yes  (page 113).movApple Animation

—yes  (page 113).movApple Graphics

—yes  (page 113).movApple® Video

—yes  (page 113).movCinepak

8-bit planar—yes  (page 113).movComponent Y’Cb-
Cr 8-bit 4:4:4

8-bit planar—yes  (page 113).movComponent Y’Cb-
CrA 8-bit 4:4:4:4

10-bit packed—yes  (page 113).movComponent Y’Cb-
Cr 10-bit 4:4:4

10-bit packed—yes  (page 113).movComponent Y’Cb-
Cr 10-bit 4:2:2

8-bit packed—yes  (page 113).movComponent Video

NOTE 4:2:2 format

yesyes  (page 113).movDV 25 NTSC
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DepthExportImportExtensionFormat

NOTE NTSC & PAL

Although the specifications allow the DV format to be field 1 or 2, the industry standard is "bottom
first". Thus, before exporting to Smoke, ensure that the clip is Field 2. Reformat, if necessary.

yesyes  (page 113).movDVCPRO 50

NOTE NTSC & PAL

yesyes  (page 113).movDVCPRO HD

8 bits: 36, 145, 220 (and variants)
10 bits: 220x (and variants)

yesyes  (page 113).movDNxHD

NOTE 36, 145, 220, 220x @ export

yesyes  (page 113).movH.264

yesyes  (page 113).movIMX

NOTE Includes support for IMX 30, 40, and 50.

yesyes  (page 113).movMJPEG

NOTE JPEG compatible

—yes  (page 113).movMPEG-1

yesyes  (page 113).movMPEG-4

—yes  (page 113).movMSMpeg 4v3 (Di-
vX)

—yes  (page 113).movPhotoJPEG

NOTE RT PhotoJPEG compatible

without alphayesyes  (page 113).movPNG

with alphayesyes  (page 113).movPNGA

12-bityesyes  (page 113).movProRes 4444

10-bityesyes  (page 113).movProRes 422 (HQ)
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DepthExportImportExtensionFormat

10-bityesyes  (page 113).movProRes 422

10-bityesyes  (page 113).movProRes 422 (LT)

10-bityesyes  (page 113).movProRes 422 (Proxy)

—yes  (page 113).movQuicktime Planar
RGB

without alphayesyes  (page 113).movRGB Uncom-
pressed

with alphayesyes  (page 113).movRGBA Uncom-
pressed

—yes  (page 113).movTGA

NOTE TARGA

MXF

DepthExportImportExtensionFormat

yesyes  (page 105).mxfAVC-Intra 50

NOTE Panasonic P2

yesyes  (page 105).mxfAVC-Intra 100

NOTE Panasonic P2

yesyes  (page 105).mxfDNxHD

NOTE Includes support for formats: 36, 60, 75, 90, 90x, 110, 110x, 115, 145, 175, 175x, 185, 185x,
220, 220x

DNxHD from ARRI ALEXA cameras (145 and 220x as OP1a) are supported.

In MXF Op-Atom files generated by Avid Media Composer, audio tracks appear in the MediaHub
as a single audio channel file (A1). But once imported, the tracks display the original channels.

—yes  (page 105).mxfDV 25

NOTE Panasonic P2

yesyes  (page 105).mxfDVCPRO

Supported Media File Formats | 55



DepthExportImportExtensionFormat

NOTE Panasonic P2

yesyes  (page 105).mxfDVCPRO 50

NOTE Panasonic P2 (PAL & NTSC)

yesyes  (page 105).mxfDVCPRO HD

NOTE Panasonic P2. Available in 1080p@25/50, 1080p@24/30/60, 720p@25/50, and 720p@24/30/60.

—yes  (page 118).mxfSonyRAW

NOTE Includes support for Sony F65, F55, and F5 camera outputs.

—yes  (page 105).mxfXDCAM MPEG-2
IMX

NOTE 30, 40, and 50

yesyes  (page 105).mxfXDCAM HD
MPEG-2 long-GOP

NOTE Import: 4:2:0 and 4:2:2. Export: 4:2:2.

NOTE Smoke exports MXF as OP-1a files (including the timecode) encoded with audio encoded as PCM, 16-Bit
or 24-Bit.

MPEG 4

DepthExportImportExtensionFormat

—yes  (page 103).mp4H.264

—yes  (page 122).mp4XDCAM EX

NOTE MPEG-2 long-GOP

Other Streaming Codecs

DepthExportImportExtensionFormat

—yes  (page 97).mts or .m2tsAVCHD

NOTE Only linear PCM audio is supported. Some cameras can record AC-3 audio, but this format is not
supported. Only the video portion of AVCHD media with AC-3 audio content is accessible from Smoke.
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DepthExportImportExtensionFormat

RAW—yes  (page 114).r3dR3D

NOTE RECODE RAW 2 and 3. Supports RED SDK version 4.4, including media from the EPIC MONO-
CHROME camera. If you are using a RED ROCKET, it must use the RED ROCKET driver 1.4.32.0 (or later)
and the RED ROCKET firmware 1.1.16.11 (or later).

In Smoke 2013 Extension 1, changes to the RED SDK affect how the DRX setting is computed for all
R3D clips, and can impact clips imported before these changes. See the DRX setting in  NO LABEL  (page
117).

Audio File Formats

DepthExportImportExtensionFormat

16 or 24yesyes.aiffAIFF

16, 24, 32 (float)yesyes.aifcAIFF-C

16yesyes.avrAudio Visual Re-
search

16yesyes.bsfBerkeley/IR-
CAM/CARL Sound
(BISCF)

16yesyes.mp3MP3

16, 24, 32 (float)yesyes.auNextsnd

16, 24, 32 (float)yes.wavWAVE

16, 24, 32 (float)yesyes.wavWAVE - Broadcast

NOTE Includes support for RF64 files (BWF-compatible format that supports files larger than 4 GB).

16, 24, 32 (float)—yes.wavWAVE - Extensible

NOTE Audio tracks are imported as regular audio tracks, without mapping the channels to spatial loca-
tions.

NOTE Files of any sample rate can be imported, but they are all resampled to 48 kHz.
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Supported QuickTime Audio

The table below lists the audio codecs supported in .mov files, as audio-video and audio-only files.

ExportImportAudio CODEC

yesyes16-bit PCM

NOTE Export supports both big and small endian.

yes—24-bit PCM

NOTE Export supports both big and small endian.

yes—32-bit floating point PCM

NOTE Export supports both big and small endian.

yes—32-bit float

yesyesA-law 2:1

—yesADPCM ima WAV

—yesAdvanced Audio Codec (AAC)

NOTE Supported in mp4 and m4v files.

—yesApple lossless

yesyesIMA 4:1

yesyesLinear PCM (QT 7)

yesyesMPEG-2 Layer 2 Audio

—yesMS ADPCM

—yesOgg Vorbis (qt4l compatible)

—yesOgg Vorbis (qtcomponents compat-
ible)

—yesQDM2 Audio

—yesRaw 8-bit audio
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ExportImportAudio CODEC

yesyesSowt

NOTE 16-bit PCM (Little Endian)

yesyesTwos

NOTE 16-bit PCM (Big Endian)

yesyesUlaw

Importing a Final Cut Pro XML Sequence
Smoke supports both FCP 7 and FCP X file formats.

NOTE To simplify the conform process, create the FCP XML project on the workstation running Smoke. And when
exporting the FCP XML, save the FCP XML to the root of the media used in that timeline: the media should either
be with the FCP XML, or within a folder alongside the FCP XML.

To import a sequence using the MediaHub:

1 Click the MediaHub tab.

2 Review the Sequence Import Options. Pay attention to the following options:
■ Preferred Media: If offline intermediates were used during the offline editing, decide now whether

you wish to relink to the original media or to those offline intermediates.

■ Search and Import Files: Enable if you want to import the linked media.

■ Use Filename: For the best results, enable only this option. Disable Use Timecode, Use Tape, Use
UMID, Use Resolution, and Use Framerate.

3 Using the file browser, navigate to the FCP XML sequence to import.

4 Drag the file from the browser to the Media Library.

Smoke converts the FCP XML to its timeline format, and imports the linked media using the Search
Options as match criteria. The media itself is imported using the option file format options defined in
the Format Specific Options tab.

FCP 7 Sequence Import: Supported Transitions and Effects

Sections in this topic:

■ Supported Data (page 60)

■ Animation Interpolation (page 61)

■ Motion (page 61)

■ Video Transitions (page 62)

■ Video Filters (page 68)

■ Video Generators (page 73)
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■ Audio (page 75)

■ Composite Modes (page 76)

Supported Data

Smoke allows you to import multi-track compositions from Apple Final Cut Pro (FCP). Smoke reads XML
exported from FCP (up to version 7.x of FCP, exported as XML version 2.0) and recreates a timeline
accordingly.

The following tables describe the data that is output from FCP and input into Smoke.

General Data

FCP composition(s) data maps to Smoke timeline data.

SmokeFinal Cut Pro

NameName

FramerateFramerate

DurationDuration

Editorial Data

FCP Source media data and Record side data maps to Autodesk clip data.

SmokeFinal Cut Pro

Source clips:Source media data:

■ Tape name■ Tape name

■ ■Source TC in/out Source TC in/out

■■ KeycodeEdge code

■ ■Log notes Elements comments

■■ Aspect ratioAspect ratio

■ ■Comments Elements Comments

Record clip:Record side data:

■ Segment■ In/Out

■ ■Transition type Cut/Dissolve/Wipe/Axis

■■ Video layersNumber of video tracks

■ ■Number of audio tracks Audio tracks

■■ Track marksMarker

■ ■In/Out marker In/Out marks
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Effect Data

FCP transitions map to Smoke transitions, while FCP Filter effects and FX Script data map to Smoke Timeline
effects.

SmokeFinal Cut Pro

Timeline effectsFilter effects

TransitionsTransitions

Animation Interpolation

FCP animation interpolation maps to Autodesk interpolation.

SmokeFinal Cut Pro

LinearCorner

HermiteSmooth

Motion

The following table describes how motion from FCP is mapped to Smoke Axis Timeline effect parameters.

SmokeFinal Cut Pro

Axis AxisBasic Motion

Axis EdgesCrop

Axis SurfaceDistort

Axis Transparency (partially supported)Opacity

Axis ShadowDrop Shadow

Not supportedMotion Blur

Timewarp (see below)Time Remap

About Time Remap to Timewarp

To make sure the conform is accurate with the creative editorial decisions from Final Cut Pro 7, the conformed
timewarp speed value seen in Smoke timewarp editor can be slightly different from the one seen in FCP7.
But the actual Timewarp effect will be visually similar to the expected result, and be frame and keyframe
accurate. There are exceptions:
■ Frame blending used with this effect is not translated.

■ Negative constant timewarp speeds are not applied to the audio tracks of the segment being timewarped.

■ Variable timewarps are not applied to the audio tracks of the segment being timewarped.
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Video Transitions

The names of FCP transitions are preserved in Smoke and are visible in the timeline.

3D Simulation

SmokeFinal Cut Pro

Dissolve (partially supported)Cross Zoom

Dissolve (partially supported)Cube Spin

Axis transition (partially supported)Spin 3D

Not supported; replaced by DissolveSpinback 3D

Axis transition (partially supported)Swing

Axis transition (partially supported)Zoom

Dissolve

SmokeFinal Cut Pro

Not supported; replaced by DissolveAdditive Dissolve

Dissolve AdditiveCross Dissolve

Dissolve To/From colour (partially supported)Dip to colour Dissolve

Not supported; replaced by DissolveDither Dissolve

Dissolve To/From Black (partially supported)Fade in/fade out Dissolve

Dissolve Non-AdditiveNon-Additive Dissolve

Not supported; replaced by DissolveRipple Dissolve

Iris

SmokeFinal Cut Pro

SMPTE 007 (partially supported)Cross Iris

SMPTE 102 (partially supported)Diamond Iris

SMPTE 119, 120, or 121 (partially supported)Oval Iris
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SmokeFinal Cut Pro

SMPTE 047 (partially supported)Point Iris

SMPTE 101 (partially supported)Rectangle Iris

SMPTE 127, 128, or 129 (partially supported)Star Iris

Map

SmokeFinal Cut Pro

Not supported; replaced by DissolveChannel Map

Not supported; replaced by DissolveLuminance Map

Page Peel

SmokeFinal Cut Pro

Not supported; replaced by DissolvePage Peel

QuickTime

SmokeFinal Cut Pro

Not supported; replaced by DissolveChannel Compositor

Not supported; replaced by DissolveChroma Key

Not supported; replaced by DissolveExplode

Not supported; replaced by SMPTE 002 without SoftnessGradient Wipe

Not supported; replaced by Axis transitionImplode

SMPTE Wipes (partially supported):Iris

■ Rectangle = SMPTE 101

■ Diamond = SMPTE 102

■ Triangle = SMPTE 103

■ Triangle Right = SMPTE 104

■ Triangle Upside Down = SMPTE 105

■ Triangle Left = SMPTE 106

■ Arrowhead = SMPTE 107

■ Arrowhead Right = SMPTE 108

■ Arrowhead Upside Down = SMPTE 109
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SmokeFinal Cut Pro

■ Arrowhead Left = SMPTE 110

■ Pentagon = SMPTE 111

■ Pentagon Upside Down = SMPTE 112

■ Hexagon = SMPTE 113

■ Hexagon Side= SMPTE 114

■ Circle = SMPTE 119

■ Oval = SMPTE 120

■ Oval Side = SMPTE 121

■ Cat Eye = SMPTE 122

■ Cat Eye Side = SMPTE 123

■ Round Rect = SMPTE 124

■ Round Rect Side = SMPTE 125

■ 4 Point Star = SMPTE 127

■ 5 Point Star = SMPTE 128

■ 6 Point Star = SMPTE 129

■ Heart = SMPTE 130

■ Keyhole = SMPTE 131

Not supported; replaced by SPMTE 001 with a comment indicating the type
of FCP Matrix Wipe that had been at this mark

Matrix Wipe

Not supported; replaced by DissolvePush

SMPTE Wipes (partially supported):Radial

■ Rotating Top = SMPTE 201

■ Rotating Right = SMPTE 202

■ Rotating Bottom = SMPTE 203

■ Rotating Left = SMPTE 204

■ Rotating Left Bottom = SMPTE 205

■ Rotating Left Right = SMPTE206

■ Rotating Quadrant = SMPTE 207

■ Top to Bottom 180 degree = SMPTE 211

■ Right to Left 180 degree= SMPTE 212

■ Top to Bottom 90 degree= SMPTE 213

■ Right to Left 90 degree = SMPTE 214

■ Top 180 Degree = SMPTE 221

■ Right 180 Degree = SMPTE 222

■ Bottom 180 Degree = SMPTE 223

■ Left 180 Degree = SMPTE 224

■ Counter Rotating Top Bottom = SMPTE 225

■ Counter Rotating Left Right = SMPTE 226
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■ Double Rotating Top Bottom = SMPTE 227

■ Double Rotating Left Right = SMPTE 228

■ V Open Top = SMPTE 231

■ V Open Right = SMPTE 232

■ V Open Bottom = SMPTE 233

■ V Open Left = SMPTE 234

■ V Open Top Bottom = not supported; replaced by SMPTE 001

■ V Open Left Right = not supported; replaced by SMPTE 001

■ Rotating Top Left = SMPTE 241

■ Rotating Bottom Left = SMPTE 242

■ Rotating Bottom Right = SMPTE 243

■ Rotating Top Right = SMPTE 244

■ Rotating Top Left Bottom Right = SMPTE 245

■ Rotating Bottom Left to Top Right = SMPTE 246

■ Rotating Top Left Right = SMPTE 251

■ Rotating Left Top Bottom = SMPTE 252

■ Rotating Bottom Left Right = SMPTE 253

■ Rotating Right Top Bottom = SMPTE 254

■ Rotating Double Center Right = not supported; replaced by SMPTE 001

■ Rotating Double Center Top = not supported; replaced by SMPTE 001

■ Rotating Double Center Top Bottom = not supported; replaced by SMPTE
001)

■ Rotating Double Center Left Right = not supported; replaced by SMPTE
001

Axis transitionSlide

SMPTE Wipes (various partially supported):Wipe

■ Slide Horizontal = SMPTE 001

■ Slide Vertical = SMPTE 002

■ Top Left = SMPTE 003

■ Top Right = SMPTE 004

■ Bottom Right = SMPTE 005

■ Bottom Left = SMPTE 006

■ Four Corner = SMPTE 007

■ Four Box = SMPTE 008

■ Barn Vertical = SMPTE 021

■ Barn Horizontal = SMPTE 022

■ Top Center = SMPTE 023

■ Right Center = SMPTE 024

■ Bottom Center = SMPTE 025
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■ Left Center = SMPTE 026

■ Diagonal Left Down = SMPTE 041

■ Diagonal Right Down = SMPTE 042

■ Vertical Bow Tie = SMPTE 043

■ Horizontal Bow Tie = SMPTE 044

■ Diagonal Left Out = SMPTE 045

■ Diagonal Right Out = SMPTE 046

■ Diagonal Cross = SMPTE 047

■ Diagonal Box = SMPTE 048

■ Filled V = SMPTE 061

■ Filled V Right = SMPTE 062

■ Filled V Bottom = SMPTE 063

■ Filled V Left = SMPTE =064

■ Hollow V = SMPTE 065

■ Hollow V Right = SMPTE 066

■ Hollow V Bottom = SMPTE 067

■ Hollow V Left = SMPTE 068

■ Vertical Zig Zag = SMPTE 071

■ Horizontal Zig Zag = SMPTE 072

■ Vertical Barn Zig Zag = SMPTE 073

■ Horizontal Barn Zig Zag = SMPTE 074

Axis transition (partially supported)Zoom

Slide

SmokeFinal Cut Pro

Not supported; replaced by DissolveBand Slide

Not supported; replaced by DissolveBox Slide

Not supported; replaced by DissolveCenter Split Slide

Not supported; replaced by DissolveMulti Spin Slide

Not supported; replaced by DissolvePush Slide

Not supported; replaced by DissolveSpin Slide

Not supported; replaced by DissolveSplit Slide
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Not supported; replaced by DissolveSwap Slide

Stretch

SmokeFinal Cut Pro

Not supported; replaced by DissolveCross Stretch

Axis transition (partially supported)Squeeze

Not supported; replaced by Axis TransitionSqueeze and Stretch

Axis transition (partially supported)Stretch

Wipe

SmokeFinal Cut Pro

Not supportedBand

SMPTE 021 (partially supported)Center Wipe

Not supportedChecker Wipe

Not supportedCheckerboard Wipe

SMPTE 201 (partially supported)Clock Wipe

SMPTE 001 (partially supported)Edge Wipe

Not supportedGradient Wipe

Inset Wipe ■ Upper Left = SMPTE 003 (partially supported)

■ Top = SMPTE 023

■ Upper Right = SMPTE 004

■ Right = SMPTE 024

■ Lower Right = SMPTE 005 (reverse)

■ Bottom = SMPTE 025

■ Lower Left = SMPTE 006 (reverse)

■ Left = SMPTE 026

SMPTE 073 (partially supported, FCP's is smaller than Smoke's)Jaws Wipe
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Not supported; replaced by Wipe 001 transitionRandom Edge Wipe

V Wipe ■ Right = SMPTE 064 (partially supported)

■ Down = SMPTE 61

■ Left = SMPTE 62

■ Up = SMPTE 63

Not supported; replaced by SMPTE 001Venetian Blind Wipe

Not supported; replaced by SMPTE 001Wrap Wipe

Not supported; replaced by SMPTE 001Zig-Zag Wipe

Video Filters

Blur

SmokeFinal Cut Pro

Axis Surface + Axis (partially supported)Gaussian Blur

Not supportedRadial Blur

Not supportedWind Blur

Not supportedZoom Blur

Border

SmokeFinal Cut Pro

Timeline ResizeBasic Border

Not supportedBevel

Channel

SmokeFinal Cut Pro

Not supportedArithmetic

Not supportedChannel Blur

Not supportedChannel Offset
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Timeline CC (partially supported)Colour Offset

Not supportedCompound Arithmetic

Timeline CC Basics (partially supported)Invert

Colour Correction

SmokeFinal Cut Pro

Not supportedBroadcast Safe

Not supported; replaced by Timeline CCColour Correction

Not supported; replaced by Timeline CCColour Correction 3-way

Not supportedDesaturate Highlights

Not supportedDesaturate Lows

Not supported; replaced by Timeline CCRGB Balance

Distort

SmokeFinal Cut Pro

Not supportedBumpmap

Not supportedCylinder

Not supportedDisplace

Not supportedFisheye

Not supportedPond Ripple

Not supportedRipple

Not supportedWave

Not supportedWhirlpool
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SmokeFinal Cut Pro

Not supported; replaced by Timeline CWBrightness & Contrast (Bezier)

Not supported; replaced by Timeline CCColour Balance

Timeline CCDesaturate

Not supported; replaced by Timeline CWGamma Correction

Not supportedLevels

Not supported; replaced by Timeline CCProc Amp

Not supported; replaced by Timeline CCSepia

Not supportedTint

Key

SmokeFinal Cut Pro

Not supportedBlue and Green screen

Not supported; replaced by Timeline AxisChroma Keyer

Not supportedColour Smoothing 4:1:1

Not supportedColour Smoothing 4:2:2

Not supported; replaced by Timeline AxisColour Key

Not supportedDifference Matte

Not supportedLuma Key

Not supported; replaced by Timeline AxisSpill Suppressor - Blue

Not supported; replaced by Timeline AxisSpill Suppressor - Green

Matte

SmokeFinal Cut Pro

Not supported; replaced by Timeline Axis8-Point Garbage Mask
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Not supportedExtract

Not supported; replaced by Timeline Axis4-Point Garbage Mask

Not supported; replaced by Timeline AxisImage Mask

Not supportedMask Feather

Timeline Axis (partially supported)Mask Shape

Not supported; replaced by Timeline AxisMatte Choker

Not supported; replaced by Timeline AxisSoft Edges

Timeline Resize (partially supported)Widescreen

Perspective

SmokeFinal Cut Pro

Timeline Axis Axis (partially supported)Basic 3D

Not supportedCurl

Timeline Axis AxisFlop

Not supportedMirror

Timeline Axis AxisRotate

QuickTime

SmokeFinal Cut Pro

Timeline Axis AxisGaussian Blur

Not supported; replaced by Timeline CCBrightness/Contrast

Not supportedColour Style

Timeline CC (partially supported)Colour Tint

Not supportedColour Sync

Not supportedEdge Detection

Importing a Final Cut Pro XML Sequence | 71



SmokeFinal Cut Pro

Not supportedEmboss

Not supportedGeneral Convolution

Not supported; replaced by Timeline CCHSL Balance

Not supportedLens Flare

Not supported; replaced by Timeline CCRGB Balance

Not supportedSharpen

Sharpen

SmokeFinal Cut Pro

Not supportedSharpen

Not supportedUnsharp Mask

Stylize

SmokeFinal Cut Pro

Not supportedAnti-Alias

Not supportedDiffuse

Not supportedEmboss

Not supportedFind Edges

Not supportedPosterize

Not supportedReplicate

Not supportedSolarize

Video

SmokeFinal Cut Pro

Timeline AxisBlink

Timeline Resize (partially supported)De-Interlace
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Not supportedFlicker Filter

Not supported; replaced by Axis StabilizerImage Stabilizer

Not supportedStop Motion Blur

Timewarp StrobeStrobe

Not supportedTimecode Generator

Not supportedTimecode Reader

Not supportedViewfinder

Video Generators

The following tables describe generated effects that are translated into equivalent effects in Smoke.

Once imported into Smoke, effects created with the FCP video generator use the project's default resolution,
regardless of their original resolution in FCP. This matches the behaviour of FCP: XML files with these effects
that are reimported into FCP projects with different resolutions similarly inherit the project's resolution.

Video Generator

SmokeFinal Cut Pro

Colour Source SMPTE Bars (partially supported)Bars and Tone HD108060i

Colour Source SMPTE Bars (partially supported)Bars and Tone HD720p60

Colour Source SMPTE Bars (partially supported)Bars and Tone (NTSC)

Colour Source SMPTE Bars (partially supported)Bars and Tone (PAL)

Black colour Source SMPTE Bars (partially supported)Slug

Matte

SmokeFinal Cut Pro

Colour Source (Fill Colour):Colour

■ R = 0-255

■ G = 0-255

■ B = 0-255
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Others

SmokeFinal Cut Pro

Not supportedMore Bars and Signals

Render

SmokeFinal Cut Pro

Not supportedCustom Gradient

Not supportedGradient

Not supportedHighlight

Colour Source NoiseNoise

Not supportedParticle Noise

Shapes

SmokeFinal Cut Pro

Not supportedCircle

Not supportedOval

Not supportedRectangle

Not supportedSquare

Text

SmokeFinal Cut Pro

Timeline Text (partially supported)Crawl

Timeline Text (partially supported)Lower 3rd

Timeline Text (partially supported)Outline Text

Timeline Text (partially supported)Scrolling Text

Timeline Text (partially supported)Text

Not supported; replaced by Colour SourceTypewriter
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Audio

Some FCP audio elements are mapped to Smoke equivalents. Audio keyframes are not supported.

Audio Transitions

SmokeFinal Cut Pro

Audio fade (partially supported)Cross Fade (0dB)

Not supported; replaced by Audio FadeCross Fade (+3dB)

Audio Controls

SmokeFinal Cut Pro

Audio Gain (partially supported)Stereo

Apple

SmokeFinal Cut Pro

Not supportedAuBandPass

Not supportedAuDelay

Not supportedAuDynamicProcessor

Not supportedAuGraphicsEQ

Not supportedAuHighShelfFilter

Not supportedAuHighPass

Not supportedAuLowPass

Not supportedAuLowShelfFilter

Not supportedAuMultibandCompress

Not supportedAuParametricEQ

Not supportedAuPeakLimiter
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SmokeFinal Cut Pro

Not supported3 Band Equalizer

Not supportedBand Pass Filter

Not supportedCompressor/Limiter

Not supportedDC Notch

Not supportedEcho

Not supportedExpander/Noise Gate

Not supportedHigh Pass Filter

Not supportedHigh Shelf Filter

Not supportedHum Remover

Not supportedLow Pass Filter

Not supportedLow Shelf Filter

Not supportedNotch Filter

Not supportedParametric Equalizer

Not supportedReverberation

Not supportedVocal DeEsser

Not supportedVocal DePopper

Composite Modes

Some FCP composite modes are mapped to Smoke Axis surface blend modes.

SmokeFinal Cut Pro

Modify ■ Add = Add (partially supported)

■ Subtract = Subtract

■ Difference = Negate

■ Multiply = Multiply

■ Screen = Screen

76 | Chapter 6   Importing and Exporting Media



SmokeFinal Cut Pro

■ Overlay = not supported

■ Hard Light = not supported

■ Soft Light = not supported

■ Darken = Min

■ Lighten = Max

■ Travel Matte - Alpha = not supported

■ Travel Matte - Luma = not supported

■ Normal = not supported

FCP X Sequence Import: Supported Transitions and Effects

Sections in this topic:

■ Supported Data (page 77)

■ Transitions (page 78)

■ Retime Effects (page 79)

■ Title Effects (page 79)

■ Audio (page 79)

Supported Data

Smoke supports Final Cut Pro X (10.0.8) XML export, including ones referencing directly R3D, MXF, and
ARRI Alexa ProRes files.

NOTE XML sequences from FCP 10.0.4 and 10.0.5 no longer import correctly in Smoke the segments that were
Multicam clips in FCP. Starting with FCP 10.0.6, the way MultiCam clips are represented in the XML changed,
and it is not possible to support legacy MultiCam content. XML files from 10.0.6 and later import correctly: Smoke
displays MultiCam clips as regular segments just like before.

Due to the limited information written to the XML file by Final Cut Pro X, the conform in Smoke can look
different from the sequence created in Final Cut Pro X: Smoke cannot set parameters or recreate effects for
which there is no information.

To see how the timeline will look in Smoke, export in Final Cut Pro X the timeline to XML, and then import
it back in Final Cut Pro X.

The following general limitations apply to Final Cut Pro X XML imports in Smoke:
■ Compounded (nested) clips are not supported. As a workaround, remove any compound clip before

exporting the sequence from FCP.

■ All transitions and supported effects are reset to default values.

■ Only transitions, retime and title effects, and a subset of audio effects are supported. Other clip effects
such as Color are not supported, due either to lack of information within the XML, or to the complexity
of the effect.

NOTE When working with .R3D files, Color settings are supported as RMD settings in Smoke. See Regarding
Support for RED in FCP (page 79).
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Transitions

In cases where the video and audio are imported and treated as a single entity in the Final Cut Pro X sequence,
applying a video transition affects both video and audio and is translated in Smoke as follows:
■ Dissolve transition: Smoke applies a dissolve to video and audio.

■ Wipe transition: Smoke applies a matching wipe to video, and a dissolve transition to audio.

■ DVE transition: Smoke applies a dissolve to video and audio.

Translation in SmokeApple Final Cut Pro X Transition

DissolveBlur (any)

Dissolve except:Dissolve

■ Cross Dissolve changes to Dissolve (no keyframes)

■ Fade to Colour changes to Fade To/From Black (no key-
frames)

DissolveLights

DissolveMovements

DissolveObjects

DissolveReplicator/Clones

DissolveStylized

Translation in SmokeApple Final Cut Pro X Wipes

SMPTE Wipe 001 + cue markBands

SupportedCenter

SMPTE Wipe 001 + cue markChecker

SupportedCircle

SupportedClock

Dissolve + cue markGradient Image

SupportedInset Wipe

SupportedLetter X

SupportedWipe
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A clip retime is translated to a Soft Timewarp with matching speed up or down.

NOTE To make sure the conform is accurate with the creative editorial decisions from Final Cut Pro X, the conformed
timewarp speed value seen in Smoke timewarp editor can be slightly different from the one seen in FCPX. But the
actual Timewarp effect will be visually similar to the expected result, and be frame and keyframe accurate.

Translation in SmokeFinal Cut Pro X Retime

Slower than real-time linear timewarp, at same speed as in
Final Cut Pro X

Slow

Faster than real-time linear timewarp, at same speed as in Final
Cut Pro X

Fast

Not TimewarpNormal 100%

0% Soft Timewarp, using same frame as the one defined in
Final Cut Pro X

Hold

Reverse speed linear timewarp, at same speed as in Final Cut
Pro X

Reverse

Animated speed ramp timewarpSpeed Ramp (to 0% / from 0%)

Animated speed ramp timewarpRewind (1x / 2x / 4x)

Title Effects

Text effects parameters are not saved to the Final Cut Pro X XML, only the text strings are imported.

All text effects are set to:

■ Colour: White

■ Font: Discreet

■ Size: 50

■ Alignment: Centered

Audio

Only audio fades are supported. Audio keyframes are not supported.

Smoke correctly imports FCP X XML using multi-track audio.

Regarding Support for RED in FCP

NOTE The following only applies when using Final Cut Pro X 10.0.8.

With Final Cut Pro, you can work directly with R3D files, created by RED cameras, instead of using the
QuickTime files. This means that when you import a FCP X XML sequence in Smoke, you can relink the
sequence to the R3D files, providing you with the best image quality.
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Another benefit of using the R3D files is the RAW parameters set in Final Cut Pro X are saved by FCP as an
RMD file. This file can be read by Smoke on import.

To read FCP X Color settings for R3D files, you have to select an RMD option from MediaHub ➤ Browse
for Files ➤ Format Specific Options ➤ Colour Settings box for R3D files.

Importing an AAF Sequence

NOTE To simplify the conform process, create the AAF project on the workstation running Smoke. And when
exporting the AAF, save the AAF to the root of the media used in that timeline: the media should either be with
the AAF, or within a folder alongside the AAF.

To import a sequence using the MediaHub:

1 Click the MediaHub tab.

2 Review the Sequence Import Options. Pay attention to the following options:
■ Preferred Media: If offline intermediates were used during the offline editing, decide now whether

you wish to relink to the original media or to those offline intermediates.

■ Search and Import Files: Enable if you want to import the linked media.

■ Use Filename: For the best results, enable only this option. Disable Use Timecode, Use Tape, Use
UMID, Use Resolution, and Use Framerate.

3 Using the file browser, navigate to the AAF sequence to import.

4 Drag the file from the browser to the Media Library.

Smoke converts the AAF to its timeline format, and imports the linked media using the Search Options
as match criteria. The media itself is imported using the option file format options defined in the
Format Specific Options tab.

Importing an AAF Sequence: Supported Transitions and Effects

Smoke supports intermediates encoded with XDCam HD and XDCam EX codecs.

Supported transcoded intermediates generated by Avid Media Composer:

■ AVC-Intra 50

■ AVC-Intra 100

■ DNxHD
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■ XDCam EX

■ XDCam HD

Unsupported transcoded intermediates generated by Avid Media Composer:

■ -J2K MXF

■ 1:1 MXF

■ 1:1p 10b MXF

■ Apple ProRes Proxy MXF

■ Apple ProRes LT MXF

■ Apple ProRes MXF

■ Apple ProRes HQ MXF

NOTE In MXF Op-Atom files generated by Avid Media Composer, audio tracks appear in the MediaHub as a single
audio channel file (A1). But once imported, the tracks display the original channels.

Sections in this topic:

■ Video and Audio Effects (page 81)

■ Video and Audio Transitions (page 84)

Video and Audio Effects

The following tables describe how effects are supported in Smoke.

Blend

SmokeAvid

SupportedPicture-in-picture

Translated to Soft Axis (transparency value is translated)Superimpose

Film

SmokeAvid

Supported; bkg is black, horizontal position ignored1.66 mask

Supported; bkg is black, horizontal position ignored1.85 mask

Supported; bkg is black, horizontal position ignored16:9 mask

Supported; bkg is black, horizontal position ignoredAnamorphic mask

Supported; bkg is black, horizontal position ignoredMask
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AVX Plugin

SmokeAvid

Not supported; replaced by Cue markIllusion FX

Not supported; replaced by Cue markAVX Plugins

Image

SmokeAvid

Not supported; replaced by Cue markAvid Pan and Zoom

Not supported; replaced by Cue markBlur effect

Converted to Soft CC (empty) + cue markcolour Correction

Converted to Soft CC (empty) + cue markcolour Effect

Converted to Soft Axis (Flip effect)Flip

Converted to Soft Axis (Flip-flop effect)Flip-flop

Converted to Soft Axis (Flop effect)Flop

Supported; bkg is black, no mask, horizontal position offMask

Supported; background is black, no left and right croppingResize

Not supported; replaced by Cue markScratch removal

Converted to ContainerSubmaster

Reformat

SmokeAvid

Not supported; replaced by Soft Axis + Cue mark14:9 Letterbox

Not supported; replaced by Soft Axis + Cue mark16:9 Letterbox

Not supported; replaced by Soft Axis + Cue mark4:3 Sidebar

Not supported; replaced by Soft Axis + Cue markPan and Scan

82 | Chapter 6   Importing and Exporting Media



Titles

SmokeAvid

Converted to Soft Text; only text string is available (white Discreet font, size
50)

Classic Title

Converted to Soft Text; only text string is available (white Discreet font, size
50)

Marquee Text

Key

SmokeAvid

Not supported; replaced by Cue markAnimatte

Converted to Soft Axis (empty) + cue markLuma key

Converted to Soft Axis (empty) + cue markMatte key

Converted to Soft Axis (empty) + cue markRGB keyer

Converted to Soft Axis (empty) + cue markSpectra Matte

Miscellaneous

NOTE To make sure the conform is accurate with the creative editorial decisions from the Avid editor, the conformed
timewarp speed value seen in Smoke timewarp editor can be slightly different from the one seen in the Avid
application. But the actual Timewarp effect will be visually similar to the expected result, and be frame and keyframe
accurate.

SmokeAvid

Converted to Soft TW; recreate the curve typeTimewarp

Translated to Soft TW (Constant speed, no strobe effect)Motion Effect

Translated to Soft Axis (Position / Scaling, ISO, Softness / Crop) + cue mark3D PIP

Not supported; cue markPeel

Not supported; cue markPush

Not supported; cue markSpin

Not supported; cue markSqueeze

Video gapVideo gap
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Video gapVideo filler

Match frameVideo match frame edit

General Audio

Audio keyframes are not supported.

SmokeAvid

Audio gainAudio level

Audio dissolveAudio dissolve

Audio dissolveAudio fade in

Audio dissolveAudio fade out

Audio gapAudio gap

Audio gapAudio filler

Match frame spliceAudio match frame edit

Audio Effects

Smoke does not support any of the RATS Audio Effects. Every RATS Audio Effect is replaced with a cue mark.

Video and Audio Transitions

The following tables describe how AAF transitions are supported in Smoke.

Transitions marked with an * are also supported with the “Inverse” option set.

Blend

SmokeAvid

Converted to Dissolve (linear animation)Dip to colour

Converted to Dissolve (linear animation)Dissolve

Supported; background is black only, reset manuallyFade from colour

Supported; background is black only, reset manuallyFade to colour

Converted to Dissolve + cue markPicture-in-picture

84 | Chapter 6   Importing and Exporting Media



Film

SmokeAvid

Converted to Dissolve (bezier animation)Film dissolve

Converted to Dissolve (linear animation)Film fade

Box wipe

SmokeAvid

Converted to SMPTE 025; softness not supportedBottom box*

Converted to SMPTE 006; softness not supportedBottom left to top right*

Converted to SMPTE 005; softness not supportedBottom right to top left*

Converted to SMPTE 026; softness not supportedLeft box*

Converted to SMPTE 024; softness not supportedRight box*

Converted to SMPTE 023; softness not supportedTop box*

Converted to SMPTE 003; softness not supportedTop left to bottom right*

Converted to SMPTE 004; softness not supportedTop right to bottom left*

Edge Wipe

SmokeAvid

Converted to SMPTE 001; softness not supportedHorizontal*

Converted to SMPTE 021; softness not supportedHorz open*

Converted to SMPTE 042; animation is inverted, softness not supportedBottom left diagonal*

Converted to SMPTE 041; animation is inverted, softness not supportedBottom right diagonal*

Converted to SMPTE 041; softness not supportedUpper left diagonal*

Converted to SMPTE 042; softness not supportedUpper right diagonal*

Converted to SMPTE 022; softness not supportedVert open*

Converted to SMPTE 002; softness not supportedVertical*
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Shape Wipe

SmokeAvid

Converted to SMPTE 007; softness not supported4 corners*

Converted to Dissolve + cue markHorizontal bands

Converted to Dissolve + cue markHorizontal blinds

Converted to Dissolve + cue markVertical blinds

Converted to SMPTE 101; softness not supportedCenter box*

Converted to SMPTE 119; softness not supportedCircle*

Converted to SMPTE 120; softness not supportedEllipse*

Converted to SMPTE 201; softness not supportedClock*

Converted to SMPTE 102; softness not supportedDiamond*

Sawtooth Wipe

SmokeAvid

Converted to SMPTE 071; softness not supportedHorizontal sawtooth*

Converted to SMPTE 073; softness not supportedHorz open sawtooth*

Converted to SMPTE 074; softness not supportedVert open sawtooth*

Converted to SMPTE 072; softness not supportedVertical sawtooth*

Matrix Wipe

SmokeAvid

Not supported; replaced by SMPTE 008Grid*

Not supported; replaced by SMPTE 001One-way row

Not supported; replaced by SMPTE 001Speckle

Not supported; replaced by SMPTE 001Spiral

Not supported; replaced by SMPTE 001Zig-zag
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Xpress 3D Effect

SmokeAvid

Converted to Dissolve (linear) + cue mark3D ball

Converted to Dissolve (linear) + cue mark3D page fold

Converted to Dissolve (linear) + cue mark3D slats

Translated to Soft Axis (Position / Scaling, ISO, Softness / Crop) + cue mark3D PIP

Miscellaneous

SmokeAvid

Converted to Soft Axis (bottom left to top right); softness not supportedConceal

Converted to Soft Axis (bottom left to top right); softness not supportedL-Conceal

Converted to Soft Axis (bottom centered); softness not supportedSqueeze

Converted to Dissolve + cue markPeel

Converted to Dissolve + cue markPush

Converted to Dissolve + cue markSpin

Video gapVideo gap

Video gapVideo filler

About Avid Stereoscopic Sequences

Smoke can import Media Composer 6 stereoscopic timelines; an Avid Stereo3D timeline is imported as a
stereoscopic timeline with Left and Right tracks, with the following limits.

Avid Stereoscopic Sequence Limitations:

■ Segments with multiple nested effects may not be translated as expected.

■ The Avid stereoscopic sequence cannot contain S3D master clips with frame compatible contributors
(clips with side-by-side or top-bottom stereoscopic media), it can only contain full resolution contributors.

Supported Avid S3D Effects and Transitions:

■ S3D Vergence Effect: Translated as a Soft Axis with an equivalent Convergence value.

■ S3D Floating Window Effect: Translated as a Soft Axis with a Crop.

■ S3D Spatial Alignment Effect: Translated as a Soft Axis with a subset of the original parameters.
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■ S3D Depth Transition: Not supported.

■ Clips with non-stereo effects on top of stereo effects are seen as mono.

MediaHub Reference: Browsing for Files
The MediaHub consists of two panels: the browser and the MediaHub tabs. Use the browser to locate the
files to import, or the location where to export your clips. Use the MediaHub tabs to set you media and
sequence import options.
■ MediaHub Browser (page 88)

■ General Tab (page 88)

■ Format Specific Options (page 90)

■ Sequence Import Options (page 90)

■ Jobs (page 91)

MediaHub Browser

The MediaHub file browser displays two sections:
■ The Autodesk Network lists other Smoke, Flame, or Lustre workstations on the network, and can be used

to import files from those workstations.

■ The Local Devices displays the hard disks, external disks, and other storage devices that appear under
the Devices category in the Finder. Use the Local Devices to access local storage.

TIP Network volumes connected to your workstation appear in Local Device.

General Tab

Cache Source Media button  Enable to create a managed copy of the media in the application storage; this
copy is a transcoded version of the original media, using the Cached Media Compression Format as the
transcode target. Disable to link to the media of the imported clip, without transcoding or copying the
media.

Enabling Cache Source Media ensures that the application is the sole owner of the media, preventing the
media from being modified by an external source. With Cache Source Media disabled, the application decodes
the clip on-the-fly and there is no transcoding.

You can always change your mind after importing a clip: right-click the clip and select Media ➤ Cache
Source Media to transcode the media and copy it to your local storage. Right-click and select Media ➤

Flush Source Media Cache to get rid of the transcoded copy and refer back to the original media.

Alpha Channel Processing box Select how alpha channels of RGBA media is processed on import: discard
alpha channel information, create a matte container for the clip and its alpha channel, or create an RGB
clip and another clip for its matte.

Cached Media Compression Format field Displays the compression format applied to clips imported with
Cache Source Media enabled. Defined for the project, in the Cache and Renders tab of the Project dialogue
box.

You acces your project's settings in File ➤ Project and User Settings.

Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.
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Fill box Select a fit method to be applied to the selected clip.

To fit:Select:

The source image, centred, over the destination resolution frame. If the source is larger

than the destination, it is cropped. If the source is smaller than the destination, it is surroun-

ded by a black border.

Centre/Crop

One edge of the source into the destination resolution frame without stretching or

squashing the frame. Excess parts of the source frame after resizing are cropped.

If the source—after the one edge is resized—is wider than the destination, its overhanging

left and right edges are cropped. If the source is taller than the destination, the upper and

lower edges are cropped.

Crop Edges

The source, width, and height, into the destination resolution frame. This process, if the

source and destination resolutions do not have the same aspect ratio, can distort the image.

Fill

The source to the destination resolution frame without squashing or stretching it, and

without cropping the source.

If the source is wider than the destination, black bars fill the top and bottom of the destin-

ation frame. If the source is narrower than the destination, black bars fill the right and left

sides of the frame. In all cases, the entire source frame is fit into the destination frame.

Letterbox

Resize Filter box Select the resize filter to apply to the clip; all but the Impulse filter are rendered using the
GPU. This box does not appear if you select the Centre/Crop fit.

For:Select:

Excellent and sharp results. Recommended for upscale and downscale. Expensive to com-

pute.

Lanczos

Excellent and sharp results. Results are sharper than Lanczos in small details. Recommended

for upscale and downscale. Expensive to compute.

Shannon

Medium quality and softer results.Gaussian

Medium quality and softer results.Quadratic

High-quality results, but not as sharp as Shannon. Use for both upscale and downscale.Bicubic

High-quality results, but not as sharp as Shannon. Use for both upscale and downscale.Mitchell

Low quality results that are fast to compute. Use for downscale.Triangle

Very low quality results that are fast to compute. Use for downscale.Impulse

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.
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Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Frame Depth box Select the render/output frame depth of clips.

Scan Mode box Select the scan mode of clips.

Use LUT button Enable to apply the LUT displayed in the Applied LUT field to the clip.

LUT Format box Select the type of LUTto apply to the clip.

Applied LUT field Displays the type of conversion LUT applied to the clip, either imported using Import,
or edited using Edit.

Conversion LUT Type box Select a basic LUT type, EXR Display, PhotoMap, or Gamma correction.

LUT Editor Access button Click to open the LUT editor.

Format Specific Options

Show All Formats button Disable to display only the format of the file selected in the MediaHub browser.
Enable to view or edit import options for any of the available file formats.

File Format box With Show All Formats disabled, File Format displays the format of the file selected in the
browser; if more than one file is selected, File Format displays the formats of the selected files. With Show
All Formats enabled, select the file format to view or edit its import options.

Options Category box Select the set of options to view or edit.

Sequence Import Options

Media Options

Link to Files button Enable to create a sequence with track segments that link to the original media. Disable
to import an empty shell showing only the structure of the sequence, without references to files.

Preferred Media button Select which, of either offline intermediates or original sources, to import when
both are found by the application. Only used when importing AAF sequences.

Consolidate on Import button Enable to import only the segments of the sources used by the imported
sequence. Enabled when Use Timecode is enabled.

Maximum Handles field Displays the maximum number of handles (head and tail) allowed for each event
in the sequence. If the sequence also sets the amount of handles, the application imports the sources using
the lowest number of handles set between Maximum Handles and the sequence. Editable.

Relative Search Options

Search and Import Files button Enable to locate and import the media listed in the sequence, using the
selected Search Criteria options but not the filepaths the sequence might contain. The media found is
imported as segments of the sequence. Enabled if Link to Files is enabled.

Directories Up field Use to expand the search to parent directories. The application searches for media to
match by going down any folder structure, starting with the directory from where the sequence file is
imported.

NOTE When setting the Directories Up field, keep in mind that the application navigates through the whole
directory structure. This means that the higher up you go in the folder structure, the longer the conform takes.
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Save Sources Separately button Enable to also import each source referred to in the sequence. The application
imports the sources in the same folder as the imported sequence, in the Media Library.

Use Filename button Enable to use the filename specified in the sequence as a match criteria.

Use Timecode button Enable to use the source timecode specified in the sequence as a match criteria.
Enables Consolidate on Import.

Use Tape button Enable to use the tape name specified in the sequence as a match criteria.

Use UMID button Enable to use the starting SMPTE UMID in the sequence as a match criteria. This is only
used with MXF files and is ignored in all other cases.

Use Resolution button Enable to use the resolution specified in the sequence as a match criteria. If this
option is disabled, the application soft-resizes the media found to the resolution specified in the imported
sequence, if required.

Use Framerate button Enable to use the frame rate specified in the sequence as a match criteria. Disable to
disregard the frame rate; try slipping the clip and using a timewarp in the timeline after loading the timeline
to correct any frame rate discrepancy.

Be careful when using the Use Framerate search option with FCP XML files, especially if the FCP sequence
is using multiple frame rates. With Use Framerate enabled, Smoke uses the frame rate of the sequence's edits
as a match criteria to relink to the correct sources: if the frame rate of the considered source is 24fps while
the edit is at 30fps, that source is not a potential candidate. Whether or not Smoke relinks the considered
source to the edit has nothing to do with the frame rate of the sequence.

But, if you are importing an FCP sequence, Smoke timewarps the edits so that they match the frame rate of
the imported sequence. For example, an FCP sequence @60fps contains edits @50fps: Smoke timewarps the
edits to 60fps as it imports the sequence. Whether or not edits are relinked to their sources has nothing to
do with this: if Use Framerate is enabled, Smoke only relinks the above edits if the sources are matching the
edits' original frame rate, in this case 50fps.

Jobs

The Jobs tab displays ongoing and completed background processes. Use the Jobs tab to monitor the import
and export processes.

Actions box Select from the list an action to perform on the selected job. Note: any frames already processed
are retained. For example, if the Status column reads 20 of 44 when you click Abort, you will have 20 of the
44 frames of the clip.

Customizing your File Imports Options

Smoke includes pre-defined import options for each available file format. While these presets should answer
most of your needs, there are times you might want a different debayering settings for .r3d files, or rename
a clip on import.

To customize the import options of a selected file:

1 In the MediaHub, click the Format Options tab.

2 In the file browser, navigate to, and double-click the media file to import.

The Selected Format field displays the format of the selected file.

3 From the Options box, select a category of options to edit.

4 Edit the options as needed.

The import options are saved automatically; no need for a manual save. Smoke will import media of
that format using the new options.
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5 Drag and drop the media file from the browser to the Media Library. A new clip is created, using the
new import options.

To customize the import options at any time:

1 Click the MediaHub tab.

2 In the MediaHub menu, click the Format Options tab.

3 Enable Show All Formats.

4 From the Selected Format box, select the media format to edit.

5 From the Options box, select the category of options to change.

6 Edit the options as needed.

The import options are saved automatically; no need for a manual save. From now on, media of that
format are imported using the options you have set.

ARRIRAW Format Settings - Import

IMPORTANT The timecode of some ARRIRAW files was not correctly read in versions of Smoke prior to Smoke
2013 Extension 1. This issue is now fixed. But be careful if you use ARRIRAW clips that were imported in a previous
release. Loading that material in the fixed version shows the same visual results, but the source timecode is
automatically updated. This ensures that both the ProRes and the the ARRIRAW files have the same timecode,
making it easier to offline in ProRes and relink to the ARRIRAW files.

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.
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Timecode box Select an option to specify which of the available timecodes to use as ARRIRAW clips can
contain multiple timecodes. If the selected timecode is not availablein the selecte clip, it displays 00:00:00
for timecode.

ARRIRAW DefinitionSelection:

Internally generated timecode.Master TC

Longitudinal Time Code from an external sync.External LTC

Vertically Integrated Time Code from an external sync.External VITC

Internally generated free run timecode starting at time of day.Time of Day

Internally generated free run timecode starting at a time defined by the user.Free Run

Internally generated timecode frame count increasing with each new media.Edge Code

Internally generated timecode frame count increasing with each new take.Clip Code

Internally generated record run timecode starting at a value defined by the user.Record Run

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Resolution Settings

Debayering box Select the resolution of the imported media. ARRIRAW decoding provides for using the
original camera image resolution (2880x1620), or the resolution of the ProRes files (2868x1614). SD, HD,
and 2K resolutions are not downscaled from the original image, but different debayering resolutions.

NOTE Prior to Smoke 2013 Extension 1, the debayering options were named Full, Draft, Half... This naming
scheme is no longer in use. Additionally, Half and Third cannot be translated into one of the new debayering
setting. If you restore material archived at Half or Third debayering, you get a checkerboard upon restore. Open
the clip on the Timeline, and use the Format Options from the Timeline to select a valid debayering setting.
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Debayering Mode box Select the debayer algorithm to use when importing ARRIRAW files. HW/SW refers
to the method ARRI cameras use to decode RAW media. It does not mean that the application is performing
hardware optimized debayering. All debayering is done software.

Description:Option:

Reproduces the hardware optimised debayering that is realised in cameras. Previously

named Camera option.

ADA-1 HW

A more efficient debayering algorithm than ADA-1. Previously named AMC-1 option.ADA-2 SW

Visually matches the hardware optimised debayering realised in cameras with ARRI

SUP 7.0: more complex debayering than ADA-1, with extended edge and color

handling.

ADA-3 HW

Advanced software debayering provided by the ARRI SDK.ADA-3 SW

A low quality debayering mode designed for performance over quality.Proxy

Crispness field Set the cutoff steepness value of the downscaler.

Aspect Ratio box Set the aspect ratio used when importing the clips, or have Smoke use the information
stored in the file header to set automatically the aspect ratio.

Colour Settings

NOTE Some combinations of Source Camera, Colour Space, and Colour Rendering are not supported.

Colour Settings box Select how Smoke uses the colour information stored within an ARRIRAW file.

To import ARRIRAW clips using:Select:

The options you set in the Colour, Processing, and Image menus.User

The look created on the ARRI camera and stored in the ARRIRAW file.

This option disables the Processing and Image menus, as well as the Colour Rendering

box.

Camera

Save as User Settings button Enable to make the Colour, Processing, and Image menus editable in the
Import History. Save as User Settings is implicitly enabled when the Colour Settings box is set to User.

Look Selection box Select from where Smoke reads the Look information, when available.

Version 4 of the ALEXA Software Update Packet enables a look creation workflow. In this workflow, a look
is created in the ARRI Look Creator application and either embedded in the source files during the shoot,
or saved to a look file. This look information is accessible by Smoke.

When working with Look information, set the Colour Rendering to Rec709 or DCI P3 option. If the Colour
Rendering is set to LogC, Smoke displays a checkerboard instead of the media as ARRI Look Creator does
not support images encoded in LogC.
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NOTE When used, the Look file must be placed in the folder containing the source material and named look.xml.

To:Select:

Not apply any Look information.Do not apply Look

Apply Look information contained in the ARRIRAW file header.From File Header

Apply Look information contained in an XML Look file located in the same

folder as the media to import.

From Look File

Apply Look information from the header of the media to import. If none is

present, use the information from an XML Look file located in the same folder

as the file to import.

Header or Look File

Apply Look information from an XML Look file located in the same folder as

the file to import. If none is present, use the information from the header of

the file to import.

Look File or Header

Apply Look LUT button  Enable to use the LUT stored with the Look information read by Smoke from the
location determined by the Look Selection box.

Colour Rendering box Select one of the preset combinations of colour spaces and encoding to apply to all
imported clips, or select From File Header to read that colour space and encoding information from the file.
Select Custom to create your own combination using the Colour Space and Colour Encoding boxes.

ACES (Scene Linear) gives you direct access to 16-bit floating point images, so you do not have to apply a
colour transformation to get 16-bit floating point images.

Colour Space box Select the colour space used to read the clips. Available when Colour Rendering is set to
Custom. Some combinations of Colour Space and Colour Encoding are invalid and display a checkboard
instead of a clip. Change either settings to display a valid clip.

An invalid combination would be ACES + Encoding Video since ACES colour space requires 16-bit fp Scene
Linear encoding.

Colour Encoding box Select the value of the output gamma curve applied to imported clips. Available when
Colour Rendering is set to Custom. Some combinations of Colour Space and Colour Encoding are invalid
and display a checkboard instead of a clip. Change either settings to display a valid clip.

Processing Settings

Processing Version box Select the version of the colour science used to process the file, or use From File
Header to have Smoke read the version of the colour science from the header of the imported file. Use From
File Header unless you are trying to recreate a look based on a specific colour science.

Source Camera box Select the camera that created the file, or have Smoke read from the file header the
camera used. Leave at Camera from File Header unless you are troubleshooting a file.

Image Settings

Exposure box Select how the file's exposure is set. Select Exposure From File to use the camera settings burnt
in the clip.

ISO Select the value of the linear gain operation.
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White Balance box Select how the white balance is defined. Select White Balance From File to use the
camera settings burnt in the clip.

NOTE To determine if white balance information is already present in a clip, look at White bal burnt in in the
Metadata tab of the Previewer. If it displays true, there is white balance camera settings present in the clip.

Kelvin field Set the perceptual colour temperature of the imported clip. Only available if White Balance is
set to Set Temperature.

Green/Magenta Tint field Set the green and magenta tint balance. Only available if White Balance is set
to Set Temperature.

RGB Gain fields Set the RGB gains of the imported clip. Only available if White Balance is set to Set RGB
White Balance.

Audio File Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name
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Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

AVCHD Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Read the clip name from the header of the imported file.Clip Name from Header
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To:Select:

Use the clip name listed in the XML file accompanying the XDCAM media. (XDCAM

only)

Clip Name from XML

Use the clip name inferred from the directory structure of the P2 or XDCAM clip. (P2

and XDCAM only)

Clip Name from Essence

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

DPX Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header
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Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Sequence Detection box Select how Smoke displays image sequences. An image sequence consists of image
files, such as .psd, named identically except for a numeric suffix.
■ myPhotoshopFile_version_001.psd

■ myPhotoshopFile_version_002.psd

■ myPhotoshopFile_version_003.psd

■ myPhotoshopFile_version_004.psd

To display and process the related images:Select:

As a single clip made of all these related images.Sequence
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To display and process the related images:Select:

As independent images.Frames

Keycode Settings

NOTE The keycode supplied here is only used for information purporses. In case of a discrepancy between the
information supplied in the Metadata menu and the Keycode menu, the former is used to determine the timecode
and frame rate used.

Keycode Scan Mode box Select an option to determine how keycode data is applied to the imported clip.

To:Select:

Use the keycode information embedded in the image file header.File Header Keycode

Not use the keycode information.No Keycode

Keycode Fcm box Select the frame code mode of the tape. Set to File FCM to read the frame code mode
from the file.

Film Gauge box Select a film gauge for the keycode.

Gateway Clip Format Settings - Import

Gateway clips do not have any available import options.

HDR Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.
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Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Read the clip name from the header of the imported file.Clip Name from Header

Use the clip name listed in the XML file accompanying the XDCAM media. (XDCAM

only)

Clip Name from XML

Use the clip name inferred from the directory structure of the P2 or XDCAM clip. (P2

and XDCAM only)

Clip Name from Essence

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Exposure Adjustement field Set the exposure of the HDR file. In units of stops.
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Image Sequences Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name
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To:Select:

Use the name of the imported file as the clip name.Clip Name from File Name

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Sequence Detection box Select how Smoke displays image sequences. An image sequence consists of image
files, such as .psd, named identically except for a numeric suffix.
■ myPhotshopFile_version_001.psd

■ myPhotshopFile_version_002.psd

■ myPhotshopFile_version_003.psd

■ myPhotshopFile_version_004.psd

To display and process the related images:Select:

As a single clip made of all these related images.Sequence

As independant images.Frames

MP4 Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.
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Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Read the clip name from the header of the imported file.Clip Name from Header

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.
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Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

MXF Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name
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To:Select:

Use the name of the imported file as the clip name.Clip Name from File Name

Read the clip name from the header of the imported file.Clip Name from Header

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Scale to Full HD button Enable Scale to Full HD to have media with a 1280x1080 or 1440x1080 resolution
appear in the Player at a standard 1920x1080 resolution. Disable Scale to Full HD to display the media at its
native (1280x1080 or 1440x1080) resolution in the Player. Available to P2, XDCAM, and MXF.

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

OpenEXR Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory
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Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Names box Channels are imported as clips in Smoke. Select how to name, at import, the clips thus
created.

To:Select:

Use the filename of the container for all the imported channels.Filename

Use the channel name as the clip name.Channel

Combine the channel name and the filename of the container to form the clip

name.

Channel + Filename

Combine the filename of the container and the channel name to form the clip

name.

Filename + Channel

Sequence Detection box Select how Smoke displays image sequences. An image sequence consists of image
files, such as .psd, named identically except for a numeric suffix.
■ myFile_version_001.psd

■ myFile_version_002.psd

■ myFile_version_003.psd
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■ myFile_version_004.psd

To display and process the related images:Select:

As a single clip made of all these related images.Sequence

As independent images.Frames

P2 Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape Name

Use the name of the imported file as the tape name.Tape Name from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape Name from Directory

Use the tape name inferred from the directory structure of the P2 clip.Tape Name from Essence

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name
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Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Use the clip name inferred from the directory structure of the P2 clip.Clip Name from Essence

Use the clip name listed in the XML file accompanying the P2 media.Clip Name from XML

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Scale to Full HD button Enable Scale to Full HD to have media with a 1280x1080 or 1440x1080 resolution
appear in the Player at a standard 1920x1080 resolution. Disable Scale to Full HD to display the media at its
native (1280x1080 or 1440x1080) resolution in the Player. Available to P2, XDCAM, and MXF.

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

Browsing Settings

Essence Mode button Enable to browse the directory structure of P2 media. This option allows you to import
specific audio or video files contained within a P2 directory structure.
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Photoshop Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Clip Settings

Clip Names box Layers are imported as clips in Smoke. Select how to name, at import, the clips thus created.

To:Select (PSD):

Use the filename of the container for all the imported layers.Filename

Use the layer name as the clip name.Layer

Combine the layer name and the filename of the container to form the clip name.Layer + Filename

Combine the filename of the container and the layer name to form the clip name.Filename + Layer

Sequence Detection box Select how Smoke displays image sequences. An image sequence consists of image
files, such as .psd, named identically except for a numeric suffix.
■ myFile_version_001.psd

■ myFile_version_002.psd

■ myFile_version_003.psd
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■ myFile_version_004.psd

To display and process the related images:Select:

As a single clip made of all these related images.Sequence

As independent images.Frames

Layers Settings

Resolution box Select how Smoke sets the resolution of .psd clips.

To:Select:

Import the layers using the same resolution as the background layer.Background

Import the layers at their original resolution.Native

PNG Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header
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To:Select:

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Sequence Detection box Select how Smoke displays image sequences. An image sequence consists of image
files, such as .psd, named identically except for a numeric suffix.
■ myFile_version_001.psd

■ myFile_version_002.psd

■ myFile_version_003.psd

■ myFile_version_004.psd

To display and process the related images:Select:

As a single clip made of all these related images.Sequence

As independent images.Frames

Precomp Format Settings - Import

Precomp clips do not have any available import options.
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QuickTime Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.

Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.
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Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Read the clip name from the header of the imported file.Clip Name from Header

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

R3D Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename
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To:Select:

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from File Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Orientation box Select to flip (vertical) or flop (horizontal) the media of the imported clip. Camera uses
the orientation transformation defined during the shoot; Disable Flip keeps the orientation of the image as
it was shot.

Timecode box Select which timecode to use as RED camera records both edge code (run record) and
time-of-day (free run) timecodes during a shoot. Or Use Primary to use the timecode defined during the
shoot.

Debayering Settings

Debayering box Select the level of quality required from the debayering algorithm. Higher resolutions are
significantly more processing intensive.

NOTE The debayering setting is the most resource-intensive setting. Try using the level of debayering the most
appropriate for your work.

Bit Depth box Set the bit depth of the imported image. If you set Debayering > HDRx box to High Dynamic
Range, HDRx footage is always imported as a 16-bit floating point clip, even if Bit Depth is set to 12bit
Integer.

Detail box Select the level of detail extraction required.

Denoise box Select the level of noise reduction applied to the debayered clip.

OLPF Compensation box Select the level of Optical Low Pass Filter (OLPF) compensation to use. OLPF is a
type of sharpening used to compensate for the optical anti-aliasing filter, which can induce softening of the
image during recording.

Colour Settings

Colour Settings box Select how Smoke uses the colour information stored within a R3D file.

To have:Select:

Smoke import RED clips using the options you set in the Image, Gain, and Curve
menus.

User
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To have:Select:

Smoke import RED clips using the look created on the RED camera and stored
in the RED clip.
Disables the Image, Gain, and Curve menu options.

Camera

Smoke import RED clips using the RMD look created in REDCINE-X, or fall back
on the camera settings if there is no RMD settings.
Disables the Image, Gain, and Curve menu options.

RMD/Camera

Smoke import RED clips using the RSX look created in RED Alert!. The RSX file
of a clip must reside in the same directory as the R3D file of that clip. Disables
the Image, Gain, and Curve menu options.
With this option selected, only clips with an RSX profile can be imported. Clips
without an RSX profile appear to be missing media.

RSX Only

Smoke import RED clips using the RSX look. If a clip has no RSX file, Smoke im-
ports it using the RMD look created in REDCINE-X, or fall back on the camera
settings if there is no RMD settings.
Disables the Image, Gain, and Curve menu options.

RSX or RMD/Camera

Smoke imports RED clips using the RSX look. If a clip has no RSX file, Smoke
imports it using the options you set in the Image, Gain, and Curve menus.
Enables the Image, Gain, and Curve menu options.

RSX or User

Save as User Settings button Enable to make the Colour, Image, Advanced, and Curve menus editable in
the Import History. Save as User Settings is implicitly enabled when the Colour Settings box is set to User,
or RSX or User.

Colour Science box Set the version of the RED codec to use. Using the version 3 of the codec gives you
access to the FLUT and the Shadow options in the Image menu, as well as version 3-only colour spaces and
gamma curves.

NOTE As a rule, always set Colour Science to Codec 3.x, unless you are working with a footage shot using a RED
camera with firmware 30, and that file was imported in Smoke prior to version 2011.

Colour Space box Set the colour space of the imported clips.

Gamma Curve box Set the value of the output gamma curve that is applied to the imported clips. If you
select Scene Linear, the Bit Depth of imported clips are always set to 16-bit floating point. If you set Debayering
> HDRx box to High Dynamic Range, HDRx footage is always imported as Scene Linear, even if Gamma
Curve is set to something else.

HDRx Settings box Select which track of a RED HDRx file to import, or how to merge the two tracks together.
A RED HDRx media file is made of two tracks, track A (the main exposure) and track X (the highlight
protection exposure). Use HDRx Settings to set how you want to use those two tracks.

To have:Select:

Only the main exposure (A track).Primary Exposure

Only the highlight protection exposure (X track).Highlight Exposure
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To have:Select:

A single clip resulting from blending together the Primary and Highlight tracks.

Blend Exposures behaves similarly to the option of the same name found in

REDCINE-X by RED.

Use the Blend field to set the blend value to use.

Blend Exposures

A single clip resulting from the merge of the Primary and Highlight tracks using

an algorithm provided and developed by RED. This algorithm tries to match

and blend together the motion blurs of the two tracks.

Magic Motion

A single clip resulting from the merge of the Primary and Highlight tracks using

an HDR merging algorithm developed by Autodesk. It converts the two exposures

into a single 16-bit float image.

Importing an HDRx clip as High Dynamic Range forces the Bit Depth of the im-

ported clip to 16-bit floating point, and the Gamma Curve to Scene Linear.

High Dynamic Range

Use the Blend, Highlight Threshold, and Exposure Offset fields to refine the

blend.

A clip using blending options read from the RMD file. If there is no RMD file,

the Smoke loads the main exposure (A track).

RMD

Blend field Set how to blend the two exposures of a RED HDRx clip.

With HDRx Settings set to Blend Exposures, this field behaves like the blend in REDCINE-X; the blend also
attenuates the artifacts created by the scene operation, which is a blend of the two exposures: -1 shows only
the Highlight (X frame), 1 only the Primary (A Frame), and 0 a 50-50 mix.

With HDRx Settings set to High Dynamic Range, Blend also attenuates the artifacts created by scene motions;
set to 1 unless you are troubleshooting motion artifacts.

Highlight Threshold field Set the threshold when pixels from the Highlight exposure are used instead of
the over-exposed pixels from the Primary exposure. Only available when HDRx Settings box is set to High
Dynamic Range. Set Highlight Threshold last because import options such as ISO or FLUT lighten or darken
the image. Too high and you get clipping (often including a magenta-coloured cast), too low and the midtones
and shadows have noise leaking in from the Highlight track.

Exposure Offset field Set how much greater the Primary exposure was when compared to the Highlight
exposure, in units of stops. Only available when HDRx Settings box is set to High Dynamic Range. The
Exposure Offset should be set to match the setting on the camera for how many stops separate the Primary
and Highlight tracks. This is typically 2 or 3 stops.

Offset From File button Enable to use the Exposure Offset read from the R3D file. Enabled when HDRx
Settings is set to High Dynamic Range.

Image Settings

ISO Select the value of the linear gain operation.

Saturation Set the saturation value.

DRX Set the Dynamix Range Extension, which sets how much pixel data is copied from non-saturated
channels into saturated channels.
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IMPORTANT In Smoke 2013 Extension 1, changes to the RED SDK 4.4 affect how the DRX setting is computed
for all R3D clips, and can impact clips imported before these changes.

■ Changes to DRX processing

The clips affected are the ones which have a DRX setting different from 0. To check for this, open, from
the Timeline, the Pre-Processing Editor, and look for DRX under Basic ➤ Image.

If DRX is not 0, then your media is impacted by the change. How much of an impact is hard to predict,
but since DRX (Dynamic Range Extension) is used to reconstruct clipped colour channels, watch out
especially for clips with dangerous highlights and for HDRx material.

■ Support for DRX processing via RED Rocket

The DRX setting is now processed by the RED Rocket card, when present. The following driver and
firmwares must be installed:

■ RED Rocket driver 1.4.32.0

■ RED Rocket firmware 1.1.16.11 or later

■ RED Rocket Breakout Box firmware 1.0.2.0 or later

Tint Set the tint value.

FLUT Set the FLUT to refine of the ISO level. As FLUT units are in stops, a +1 FLUT value is the same as
doubling the ISO.

Exposure Set the exposure value, an equivalent to f-stops.

Brightness Set the brightness value.

Contrast Set the contrast value.

Kelvin Set the perceptual colour temperature of the image, in Kelvin.

Shadow Set the Shadow level.

Advanced Colour Settings

Use the Advanced Colour menu to set the RGB Lift, Gamma, and Gain of RED clips.

Use the Legacy Gain options if you import clips shot with a RED codec that uses a pre-3.0 Colour Science.

NOTE We recommend that you do not change the default settings unless you have prior experience with colour
management.

Colour Curves Settings

Use this menu to set the RGB and Luma curves for RED clips.

NOTE We recommend that you do not change the default settings unless you have prior experience with colour
management.

SonyMXF Format Settings - Import

You can import Sony F5, F55, and F65 RAW MXF files in Smoke with a default Scene Linear transformation
applied to convert the 16-bit media to 16-bit half-float.
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Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Read the tape name from the header of the imported file.Tape from Header

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Orientation box Select to flip (vertical) or flop (horizontal) the media of the imported clip. Camera uses
the orientation defined on the camera during the shoot. Disable Flip to use the true orientation of the image,
as it was shot.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Resolution Settings

Debayering box Select the resolution at which the media is imported. Higher resolutions require more
processing and impact real-time playback. Other resolutions offer better performance at the cost of lower
image resolution.

Only the F65 supports resolutions higher than 4K. Using a higher setting for material shot by other cameras
prevents the media from being displayed: an error message also appears in the Previewer (Cannot initiliaze
codec). Select 4K or lower to display the media correctly.
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Debayering options have been renamed to reflect what is used in other applications. The table below
highlights the changes.

Old option:Option in Smoke 2013 Extension 1:

Sixteenth0.25K

Eighth0.5K

Quarter1K

HD (1920)

Half2K

QFHD (3480)

Full4K

6K

UHDTV (7680)

8K

Quality box Select one of two qualities for the decoding of SonyRAW footage. While debayering resolution
result in lower resolution clips, Quality affects the quality of the fully debayered pixels. Depending on your
system configuration, Standard provides better decoding performance at the cost of lower image quality
compared to High quality. The actual image degradation depends on the footage being decoded, but because
of the Bayer pattern, expect to see differences in the red and blue channels. The Quality box is not available
for some of the Debayering resolutions.

Colour Settings

Colour Encoding box Select Scene Linear to apply a colour transformation to convert the 16-bit media to
16-bit half-float. Select Native to disable this transformation and work with the RAW media.

NOTE The colour space options —Rec709 primaries, ACES (daylight illuminant), ACES (tungsten illuminant)—
were updated in Smoke 2013 Extension 1 to solve an issue with black levels. This impacts SonyRAW media imported
before the update: the black levels will not match SonyRAW media imported after the update. To fix this, view
the older clips on the Timeline, and in the Format Options Editor, select Basic ➤ Colour, and then set the correct
colour space.
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XDCAM Format Settings - Import

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Use the tape name inferred from the directory structure of the XDCAM clip.Tape Name from Essence

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Use the clip name listed in the XML file accompanying the XDCAM media.Clip Name from XML
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To:Select:

Use the clip name inferred from the directory structure of the XDCAM clip.Clip Name from Essence

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Scale to Full HD button Enable Scale to Full HD to have media with a 1280x1080 or 1440x1080 resolution
appear in the Player at a standard 1920x1080 resolution. Disable Scale to Full HD to display the media at its
native (1280x1080 or 1440x1080) resolution in the Player. Available to P2, XDCAM, and MXF.

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

Browsing Settings

Essence Mode button Enable to browse the directory structure of XDCAM media. This option allows you
to import specific audio or video files contained within a XDCAM directory structure.

XDCAM EX Format Settings - Import

About XDCAM EX

Support for Sony XDCam EX media includes support for clips recorded as multiple segments on single SxS
card (split clips) or multiple cards (span clips). Smoke imports as a single clip a serie of split & span segments.

NOTE Clips spanning two card only become available in Smoke when browsing the card that contains the last
segment.

To ensure that Smoke is able to see the clips organisation, copy the full folder structure from the SxS cards
to a single folder on your local storage.

For example, with two SxS cards (named Card1 and Card2), create the following structure:
■ storage

■ folder
■ Card1

■ Card2
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IMPORTANT Do not modify the file structure inside the cards folders. For example, copying only the media files
(.mp4) instead of the whole card structure will prevent Smoke from recreating the correct clip structure.

AAF Conform

You can conform AAF files referencing XDCam EX content inSmoke. Make sure to import the XDCam EX
clips in Avid products through AMA (the Avid Media Architecture). If you prefer to work with transcoded
media in Avid products, but still want to conform with the original media fils, enable in Smoke the Use
Original Media option when importing the AAF file. That way, the conform will use the original media,
instead of the transcoded MXF generated by the Avid products.

Metadata Settings

Tape Name box Select an option to determine how the tape name is set for the imported clips.

To:Select:

Activate the Tape Name field so that you can manually enter the tape name. When

selecting multiple files for import, this tape name is used for all imported files.

Enter Tape

Use the name of the imported file as the tape name.Tape from Filename

Determine the tape name from the detected directory structure. A Level field appears

below the Tape Name box. Use this to configure the relative path to the directory from

which the tape name can be determined.

Tape from Directory

Use the tape name inferred from the directory structure of the XDCAM EX clip.Tape Name from Essence

Level field Select an option to set the relative file path to the directory from which the tape name can be
determined. Although it is available for all file types, the Level field is specifically designed to work with the
directory structures that are output by film scanners. A typical file structure would look like:
./<tape>/<resolution>/clip.######.dpx. In this case, selecting Up 2 Levels in the Level field identifies the
directory that corresponds to the tape name (./<tape>). Enabled if Tape Name is set to Tape From Directory.

Tape Name field Set the name to use as the tape name of the imported clip. Enabled if Tape Name is set to
Enter Tape.

Timecode box Select an option to specify how the timecode information for the clip is set.

To:Select:

Set the source timecode of the imported clip based on the timecode information in

the image file header.

Timecode from Header

Use a numerical filename (for instance, 100000.dpx) and translate it into timecode for

the resulting clip (based on the selected framerate ). This is useful when working with

files that do not have embedded timecode.

Timecode from File Name

Rate box Select how the framerate is determined. Select Auto to use the framerate specified by the imported
clip; if the clip specifies no framerate, it uses the one of the project. Select Select rate to set the framerate
using the Framerate box.

Framerate box Select the frame rate of the imported clip. Enabled if the Rate box is set to Select rate.
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Drop Frame button Enable to have use a drop frame mode. Disable to use non-drop frame mode. Enabled
if the Rate box is set to Select rate.

Clip Settings

Clip Name box Select how the clip is named when the file is imported.

To:Select:

Activate the Clip Name field so that you can manually enter the clip name. When se-

lecting multiple files for import, this name is used for all imported files.

Enter Clip Name

Use the name of the imported file as the clip name.Clip Name from File Name

Use the clip name inferred from the directory structure of the XDCAM EX clip.Clip Name from Essence

Clip Name field Enter the name to use when importing the clip. Enabled if Name is set to Enter Clip Name.

Image Settings

Include YUV Headroom Enable to keep the YUV headroom information during clip import. Only applies
to 10-bit YCbCr-material found in some mp4 and QuickTime files. Disabling this option for clips that use
the headroom (usually clips from cameras) results in clips with clamped black and whites. Enabling this
option for clips that do not use the headroom (usually clips from Final Cut Pro) results in an imported clip
with lowered contrast.

Aspect Ratio box Select the aspect ratio of the frames used to import the file and override the aspect ratio
stored in the file as specified. You might need to change the aspect ratio as many applications erroneously
write a pixel aspect ratio of 1 (a square pixel), even for formats that have non-square pixels (NTSC, PAL).

Viewing the clip in the Player with the specified aspect ratio requires that you enable Options ➤ Show
Viewing Settings ➤ Use Ratio. The Previewer in the MediaHub always displays clips with the specified
aspect ratio.

Note that the application internally uses a frame ratio, not a pixel ratio. To specify a pixel ratio, you must
select either Square Pixels or Enter Pixel Aspect Ratio; Aspect Ratio from Resolution and Aspect Ratio from
Header are interpreted as frame ratios.

Aspect Ratio field Set the ratio used to define the frame or pixel aspect. Affects the frame aspect if the Aspect
Ratio box is set to Enter Frame Aspect Ratio. Affects the pixel aspect if it is set to Enter Pixel Aspect Ratio.

Browsing Settings

Essence Mode button Enable to browse the directory structure of XDCAM EX media. This option allows
you to import specific audio or video files contained within a XDCAM EX directory structure.

About Pixel Aspect Ratio

Some video and film formats use rectangular instead of square pixels. This explains why NTSC and PAL
video formats have a different frame dimension in terms of pixels, but are ultimately broadcast to the same
4:3 aspect ratio screen.
■ NTSC pixels are narrower than they are high, which allows for the 720x486 (1.481) aspect ratio frame

to fit into a 4:3 (1.333) aspect ratio broadcast screen.
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■ PAL pixels are wider than they are high, which allows for 720x576 (1.25) aspect ratio frame to fit into a
4:3 (1.333) aspect ratio broadcast screen.

When you capture video or import film frames that use rectangular pixels into Smoke, the pixels become
square because computer graphics work only with square pixels. This is why the NTSC and PAL frames appear
as though they are different size—displayed with square pixels, they are.

You can set the image window to display clips originating from rectangular pixel formats using filters to
simulate the use of rectangular pixels. This provides a display that corresponds with the delivery format.

Using the aspect ratio display affects system performance, so if you are using the aspect ratio filter and notice
a performance slowdown, you can disable the option and return to square-pixel display.

NOTE Many HD video formats such as 1920x1080 and 1280x720 use square pixels, so enabling this option has
no effect. One HD video format that does use “slightly” rectangular pixels is 1920x1035.

Modifying Import Options After Import
1 Select the Timeline tab.

2 In the timeline, select the segment or clip to edit.

3 In the FX Processing Pipeline, select the thumbnail of the clip and click Edit Pre-Processing.

Working with Others
Smoke offers you two methods to work in collaboration with other users of Flame or Smoke.

The first one is the Projects browser in the MediaHub. Use it to transfer clips between your project and
another one. This other project can be a local, such as a previous project you worked on, or a remote project,
such as a shot being worked on in Flame. Or use Projects to transfer clips from a project created with an
older version of the software. But if you want to work on the same shots, clips, sequences, use Shared Folders.
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Sharing Clips Between Users

Clips placed in a special folder, called Shared Folder, becomes accessible to remote workstations that connect
to the project. Shared folders enable different Creative Finishing workstations to quickly and conveniently
share media.

Placing media in a shared folder automatically grants read access to any workstation connected to the project.
The remote operator can then access the media and start working immediately after connecting to the
project. Once finished, the remote operator needs to save the resulting media back to the shared folder. To
do this he must acquire write access.

Write access locks the folder so that only the user having acquired write access can modify the folder contents
(i.e. write to the folder). Read access is still available to other remote workstations connected to the project.
Once the media is saved, the user can disable write access, enabling other remote workstations to obtain
write access and modify the content.

NOTE Clips stored in Shared Folders are archived when you archive a project.

To acquire write access:

1 Select the top level shared folder you want to acquire write access to in the Media panel.

2 From the contextual menu, select Acquire Write Access.

To disable write access:

1 Select the top level shared folder you want to acquire write access to in the Media panel.

2 From the contextual menu, select Release Write Access.

To enable or disable shared folders:

1 Select the top level shared folder you want to enable or disable in the Media panel.

2 From the contextual menu, select Enable or Disable.

To manually refresh the content of shared folders:

1 Select the top level shared folder you want to refresh in the Media panel.

2 From the contextual menu, select Refresh.

The content of the shared folders is updated.

Transferring Material Between Projects

Elements you can transfer when browsing for Projects:

■ Clips

■ Folders

■ Reels (from a Flame)

You can only transfer an item to the same type of location. One exception is Reels, which can be transferred
to the Media Library; this makes it easier to transfer media from a Flame to a Smoke, since Smoke does not
have Reels.
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To transfer material between your project and one located on another workstation:

1 Select MediaHub ➤ Browse for Projects.

2 In the Autodesk Network list, double-click the workstation where the project is located.

This displays the list of projects hosted by that workstation.

3 Double-click the project to open it.

This opens the project and displays its Workspaces.

4 Navigate the project to find what you want to transfer.

5 Drag-and-drop from the Projects browser to the Media panel. Or from the Media panel to the Projects
browser: you can import or export between projects.

To transfer material between local projects:

1 Select MediaHub ➤ Browse for Projects.

2 In the Local Projects list, double-click the project to open it.

This opens the project and displays its Workspaces.

3 Navigate the project to find what you want to transfer.

4 Drag-and-drop from the Projects browser to the Media panel. Or from the Media panel to the Projects
browser: you can import or export between projects.

NOTE Proxies are only transferred when both projects have identical proxy settings, as defined in the Projects
settings window.

Troubleshooting

Read Only (In use by...)

Appears in one of two cases:
■ When the workspace of the project you are browsing is opened and used by the user listed in the Read

Only message.

■ When someone else is browsing that workspace with the button Exclusive Write Access enabled.

You can still copy items from a Read Only workspace. If you absolutely need to write to the workspace, you
will need to locate the user and ask him to switch to another project.

Owned by...

The workspace you are trying to write to is owned by another Flame, Smoke, or Flare. Enable Administrator
mode to write to the workspace.

Unmanaged media contained in selection. Cache media on Wire?

When transferring media from a remote project, you can get the following message: "Unmanaged media
contained in selection. Cache media on Wire?"

This means that the clip you are importing from the remote project has no media cached. Answer Yes to
cache the media during the transfer of the clip. Answer No to only keep a reference to the media.

In fact, answering Yes is identical to importing media with the Cache Source Media enabled, and answering
No is identical to importing media without Cache Source Media.
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MediaHub Reference: Browsing for Projects

Exclusive Write Access button  Enable to get exclusive write permission to the Workspace you are browsing,
preventing others from modifying the contents of that Workspace. Other users can still read and copy clips
of that Workspace.

Administrator Mode button  Enable to modify workspaces created by others. You do not need to enable
this option only to read clips from other projects.

Workstation Processing box Select which workstation processes the transferred media using to the Wire
options set; has an impact on the overall performance of the selected workstation.

Background Wire button Enable to perform the Wire tasks in the background so that you can continue
working in the application. Disable to perform the Wire tasks in the foreground, which is faster but prevents
you from using the application.

Using Subtitles Files
With Smoke, you can load a subtitle file to quickly add subtitles to a sequence. This is the most effective
method as it allows a third party to create subtitles without requiring access to a Smoke.

The format of this file is described in Subtitle XML Elements (page 130), with a sample provided in  Subtitle
XML Sample (page 134).

Other methods for subtitling include creating Text Timeline FX on the sequence's segments, or adding a
new layer to create the subtitles in Gap effects.

Importing Subtitles to a Timeline Sequence

The procedure below adds subtitles from an imported xml file to an opened sequence.

1 From the MediaHub tab, import the subtitle file to the Media Library. There are no Specific Import
Options to set.

The subtitle XML file is imported as a single-track clip, where the subtitles are editable Text Timeline
FX applied to Gap effects.

NOTE The subtitle clip is renamed to the name defined by the <name> element in the file. It also takes the
timing and resolution defined for the project.

2 From the Timeline tab, right-click the sequence that requires subtitles and select Open or Open as
a Sequence.

3 Add a track to the opened sequence.

4 Drag and drop the subtitle clip to the new top track.

Each text element appears as a editable Text Timeline FX, at the timecode and length specified in the
xml file.

TIP  You can add multiple subtitle clips to a sequence, then mute all but the track you want to process. With this
method you can quickly version a clip with different captions.

Defining Subtitles Looks Using Text Setup Files

A text setup file can be referenced from the subtitle XML file. The text setup file overrides the font style and
position parameters indicated in the current <title> element.
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Using a text setup file allows you to apply your preferred text setup to the subtitles in the file, or even have
a different text setup for each subtitle.

To create the text setup file:

1 In a Text tool, create a text setup.

2 Click Save.

3 In the Save menu, select Selected Layers from the Save box.

4 Choose the directory into which you want to save the file.

5 Type a name for the file and press Enter or click the Save button.

The file is saved and you return to the Text tool.

To associate the text setup file to each subtitle element:

1 Open the subtitle XML file in a text editor.

TIP Consider using a text editor with syntax coloring for XML elements. It makes for easier navigation of
files.

2 Within each <title> element, indicate the path to the text setup file in the <setup> element.

The parameters in the text setup file override the following text parameters within the <title> element
of the subtitle: font, size, font colour, vertical, and horizontal.

Once you import the subtitle file in Smoke, you can see the impact of the text setups on the imported
subtitles. Changes to the text setup do not propagate to an imported subtitle file: if you modify the saved
text setup after importing a subtitle file, you need to re-import that same file to update the subtitles referencing
that setup.

Search for subtitles that are not properly linked to a setup file:

1 Place the positioner on the subtitle track.

2 Click the magnifying glass icon at the bottom right side of the timeline.

The Find and Select in Timeline window appears.

3 Enable
■ Gaps

■ Every Criteria Below

■ Comments. Also enter in the Comments field *Unable* (make sure to enter the asterisk wildcards).

4 Click Select on Current Track.

The Find and Select in Timeline windows closes, and subtitles not properly linked to a text setup are
highlighted. You need to fix the subtitles file to use the correct text setup path, and then import the
file again.
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Subtitle XML Elements

Subtitle XML files are text files that use the following elements. Use the following syntax to work with
Subtitle XML files external to the Smoke workstation.

In Smoke-compliant subtitle XML file, the <!DOCTYPE> is subtitle.

<name></name>

An element that defines the name of the Subtitle XML file. This name appears as the name
of the clip created when importing the subtitle XML file.

Description

noneAttributes

<name>French version: Day at the Races</name>Sample

<rate></rate>

A format element that describes the framerate of the Subtitle XML clip that appears in
Smoke after importing the Subtitle XML file.
The frame rate must be that of the target sequence or the subtitles might slip timecode.

Description

noneAttributes

<rate>59.94 NDF</rate>Sample

<resolution></resolution>

A unique element that wraps around all of the attributes determining the format of the
clip when importing a Subtitle XML file. This clip can then be resized within Smoke like
any other clip, if necessary.
If any of these values differ from the target sequence, Smoke will apply Resize Timeline FX
to the subtitles.

Description

<width></width> The width of the imported Subtitle XML clip. An integer.Mandatory children

<height></height> The height of the imported Subtitle XML clip. An integer.

<depth></depth> The bit depth of the imported Subtitle XML clip.

<aspect></aspect> The aspect ratio of the imported Subtitle XML clip.

<scanformat></scanformat> The scanformat of the imported Subtitle XML
clip.

<resolution>
<width>1920</width>

Sample

<height>1080</height>
<depth>8</depth>
<aspect>1.778</aspect>
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<scanformat>default</scanformat>
</resolution>

<timecode></timecode>

An element that defines the timecode in and out points during which the subtitles occur.
All the titles in the Subtitle XML file will occur during the timecode indicated here, with
each title also having its own start and end point indicated within the title elements.

Description

<start></start> The start timecode of the subtitle sequence.Mandatory children

<end></end> The end timecode of the subtitle sequence.

<timecode>
<start>01:00:00;00</start>

Sample

<end>01:00:08;00</end>
</timecode>

<video></video>

The <video> element wraps around all of the <title> elements, which in turn contain the
text and attributes of individual subtitles.

Description

<title></title> The <title> element wraps around each subtitle, with its asso-
ciated start and end time, text, and font style and position parameters.

Mandatory children

<video>
<title>

Sample

<start>01:00:01;00</start>
<end>01:00:02;00</end>
<text>This is a subtitle string</text>
<font>Garamond</font>
<size>20</size>
<fontcolor>
<alpha>255</alpha>
<red>255</red>
<green>255</green>
<blue>255</blue>

</fontcolor>
<vertical>0</vertical>
<horizontal>0</horizontal>
<setup>/usr/discreet/project/test/text/paz.ttg</setup>

</title>
</video>

<title></title>

Each <title></title> element defines a single subtitle which will appear as a Text Timeline FX applied to a
gap once imported into Smoke, and added to a sequence.
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The font style, colour, size, and position parameters are overridden if a valid text setup file is referenced
within the <title> element.

<start></start>

The start timecode of the current subtitleDescription

noneAttributes

<start>01:00:01;00</start>Sample

<end></end>

The end timecode of the current subtitleDescription

noneAttributes

<end>01:00:02;00</end>Sample

<text></text>

The text of the current subtitle
To insert a carriage return, add <&#13;> (without the brackets) to the text.

Description

noneAttributes

<text>This is a&#13; subtitle string</text>Sample

<font></font>

The font of the current subtitle. This value is overridden if a text setup file is referenced in
the <setup> element.

Description

noneAttributes

<font>Garamond</font>Sample

<size></size>

The font size of the current subtitle. This value is overridden if a text setup file is referenced
in the <setup> element.

Description

noneAttributes

<size>20</size>Sample
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<fontcolor></fontcolor>

This element wraps around the font colour elements (<alpha>, <red>, <blue>, <green>)
of the current subtitle. These values are overridden if a valid text setup file is referenced in
the <setup> element.

Description

<alpha></alpha> The <alpha> colour component of the font of the current
subtitle.

Mandatory children

<red></red> The <red> colour component of the font of the current subtitle.

<green></green> The <green> colour component of the font of the current
subtitle.

<blue></blue> The <blue> colour component of the font of the current
subtitle.

<fontcolor>
<alpha>255</alpha>

Sample

<red>255</red>
<green>255</green>
<blue>255</blue>

</fontcolor>

<vertical></vertical>

The vertical text position of the current subtitle. This value is overridden if a text setup file
is referenced in the <setup> element.

Description

noneAttributes

<vertical>0</vertical>Sample

<horizontal></horizontal>

The horizontal text position of the current subtitle. This value is overridden if a text setup
file is referenced in the <setup> element.

Description

noneAttributes

<horizontal>0</horizontal>Sample

<setup></setup>

The <setup> element can point to a text setup file from which font style and position
parameters will be used. The parameters from the text setup file override the formatting
elements of the current <title> element.
Leave empty when not using a text setup file.

Description
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noneAttributes

<setup>/usr/discreet/project/test/text/paz.ttg</setup>Sample

Subtitle XML Sample

Use the following XML sample as a starting point for your own subtitle XML files.

The following is an example of Subtitle XML which creates three Text soft effects applied to gaps at these
timecodes:
■ 01:00:01;00 until 01:00:02;00

■ 01:00:03;00 until 01:00:04;00

■ 01:00:05;00 until 01:00:06;02

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE subtitle>
<subtitle version="1">
<name>SampleSubtitles</name>
<!-- Rate should be one of : -->
<!-- -->
<!-- * '23.976'-->
<!-- * '24'-->
<!-- * '25'-->
<!-- * '29.97 DF'-->
<!-- * '29.97 NDF' -->
<!-- * '30'-->
<!-- * '59.94 DF'-->
<!-- * '59.94 NDF' -->
<rate>24</rate>
<!-- Set width and height to default -->
<!-- if you want project default res -->
<!-- depth should be : -->
<!-- -->
<!-- * '8', '10' or '12'.-->
<!-- * default : for project default depth -->
<!-- aspect should be : -->
<!---->
<!-- * '1.77777'-->
<!-- * '1.333'-->
<!-- * default-->
<!-- scanformat should be : -->
<!---->
<!-- * 'f1' -->
<!-- * 'f2' -->
<!-- * default-->
<resolution>
<width>1920</width>
<height>1080</height>
<depth>8</depth>
<aspect>1.778</aspect>
<scanformat>default</scanformat>
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</resolution>
<timecode>
<start>01:00:00;00</start>
<end>01:00:08;00</end>

</timecode>
<video>
<title>
<start>01:00:01;00</start>
<end>01:00:02;00</end>
<text>This is a subtitle string</text>
<font>Garamond</font>
<size>20</size>
<fontcolor>
<alpha>255</alpha>
<red>255</red>
<green>255</green>
<blue>255</blue>

</fontcolor>
<vertical>0</vertical>
<horizontal>0</horizontal>
<setup>/usr/discreet/project/test/text/paz.ttg</setup>

</title>
<title>
<start>01:00:03;00</start>
<end>01:00:04;00</end>
<text>This is another subtitle string</text>
<font>Garamond</font>
<size>20</size>
<fontcolor>
<alpha>255</alpha>
<red>255</red>
<green>255</green>
<blue>255</blue>

</fontcolor>
<vertical>100</vertical>
<horizontal>100</horizontal>
<setup>/usr/discreet/project/test/text/paz.ttg</setup>

</title>
<title>
<start>01:00:05;00</start>
<end>01:00:06;02</end>
<text>This is a third subtitle string</text>
<font>Garamond</font>
<size>20</size>
<fontcolor>
<alpha>255</alpha>
<red>255</red>
<green>255</green>
<blue>255</blue>

</fontcolor>
<vertical>-100</vertical>
<horizontal>-200</horizontal>
<setup>/usr/discreet/project/test/text/paz.ttg</setup>

</title>
</video>

</subtitle>
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Conform Tab Overview
Use the Conform tab to troubleshoot imported timelines and to relink segments to sources.

Event List Displays the events that make up the sequence displayed in the Timeline section. Clicking an
event in the list also selects it in the Timeline. You can sort the list using by clicking the column headers.
Linked events are usually displayed, but if you are only interested in unlinked events, you can hide the
linked events from the Display Options box. If the Event list displays the message All Sources Linked, the
selected sequence is already conformed.

Every column, other than Status, Matches, and Media, is a potential match criteria used to find the correct
source from the Potential Matches, displayed at the bottom of the Media panel. The data displayed in the
Event list is always one of the following colours:

Red This information is used as a match criteria, and the Potential Matches contain no source that matches
this criteria.

Yellow This information is used as a match criteria, and the Potential Matches contain more than one source
that matches this criteria.

White This information is used as a match criteria, and the Potential Matches contain only once source that
matches this criteria.

Grey This information is not used as a match criteria.

Potential Matches The Potential Matches display all the information about the sources found when using
Set Search Directory or Set as Conform Search Location, from the contextual menu. From all the potential
sources, Smoke uses the criteria you set using the Match Criteria box to filter in potential matches. From
there, you can select the right source and link it to the selected event.

NOTE  If you select an event with no matches, it shows the full list, in order to allow for force linking.

Disable Display Options > Filter Potential Matches to show all the sources.

Timeline The Timeline displays an open sequence, with controls similar to the ones found in the Timeline
tab. Unlinked events are boxed in red.
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Conform Gear menu Use to import an AAF, an XML, or an EDL. If connected to a VTR, select Capture... to
send the selected events to the VTR queue and enter the VTR Recapture module.

Linking combo box Select Link Selected to link a selected source to the selected event. Select Link Matched
Sources to relink every event marked as Match to its found source.

Match Criteria box Select from the list the criteria used to match sources to events. In the Event list, grey
indicates unused criterion, white is matched criteria, yellow indicates multiple sources match the criteria,
and red indicates no match was found in the Conform Media section.

Display Options box Select display options for Source and Event lists.

Strict Matching button Enable to force exact matching between source and event. When disabled, matching
occurs when source and event have in common a string of at least 7 characters. Only applies to Name and
File Name criteria.

Preview button Enable to display the Preview panel. The Source Player displays the source selected in the
Conform Media section of the Media Panel.

Hide Linked button Enable to filter out, from the Event list, the events that are relinked.

Set Search Location button Displays a browser to locate the source files, to relink to the events from the
Event list.

Adding Sources for Relink

TIP To use clips from the Workspace or Workspace Library as conform sources, drag-and-drop them to the Conform
Media folder. Or right-click a folder or a library and select Set as Conform Search Location.

To locate the directory that contains the sources:

1 In the Conform tab, click Set Search Directory.
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2 Using the Set Directory window, select the directory where the sources are located.

3 Click Set.

Smoke clears previous sources from the Conform Media folder, and then displays all the media files
from the selected location, including any media files located in sub-directories.

Notes

■ Smoke only loads files it can use in a conform, so do not worry about non-media files being loaded to
the Conform Media folder.

■ Use the options found in the General and Format Specific Options tabs of the Set Directory window to
modify the characteristics of the source files found: edit their resolution, bit depth, debayering settings,
etc. Keep in mind that this will either facilitate or hamper the relink, depending on the settings and
match criteria you set during the conform.

■ When you load sources using the Set Search Location button, Smoke does not import the media files at
that time: it creates only a list of references to the clips. This means that:
■ Even if proxies are enabled for the project, Smoke does not create proxies for media files loaded in

the Conform Media folder. Proxies are only generated when you link an event to its source.

■ Smoke does not cache source media loaded to the Conform Media folder until you actually link an
event to its source.

Conforming an EDL

To conform an EDL using file-based media:

1 In the Conform tab, right-click the Event list and select Load new EDL.

2 From the window that appears, locate and select the EDL to import, and then click Load.

The EDL is loaded and opened as a sequence in the timeline view of the Conform tab.

3 Click Set Search Location to locate the directory where Smoke can find the media files you want to use
for sources.

You now have two lists: the Event lists, displaying all the events making up the sequence, and the
Conform Media lists displaying all the source media Smoke found at the location you set using the Set
Search Directory button.

4 With Options > Filter Potential Matches selected, click an event to view, in the Sources list, the sources
that Smoke determined to be a potential match.

5 What you do next depends on the Status column of each event.

Match Select Link Found Sources from the Linking combo box. Link Found Sources links all events
with the Match status to their unique sources. Match indicates that Smoke found only one source from
the Sources list that fit the selected Match Criteria.

Multiple Matches  Select the event and the source to relink, and then select Link Selected from the
Linking combo box. If there are too many sources to choose from, you can set additional criteria using
the Match Criteria drop-down menu; by trial and error you reduce the number of filtered sources. Make
sure Options > Filter Potential Matches is enabled, to display only the filtered souces.

No Match Found Either add more sources to the Media folder or modify the criteria selected in the
Match Criteria drop-down box. Not Found indicates that either the criteria are too restrictive for Smoke
to find a match, or that the source is simply not there.

Unlinked Add sources to the Media folder. Unlinked indicates that the event is not linked to any
source. It appears only when no sources are available in the Media folder, and the Conform section of
the Media panel displays 0 clips available.
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Linked Don't do anything: the event is already linked to an event. A Linked event only appears if
Options > Hide Linked is not selected.

6 Once all the events are linked to sources, you can leave the Conform tab.

About the Load EDL Menu

Use the Load EDL menu to set a variety of options when loading EDLs.

Exit Load EDL button Exits the Load EDL menu.

EDL Type box Select an EDL type to load. Available options are: ALE, FLX, ATN, TLC, EDM, R23, ETL, and
OMF.

File Extension field Displays the file extension for the associated file type. Click to enter a new one.

EDL Conversion button Enable to convert the EDL to another frame rate.

2:3 Removal Mode button Enable to remove pulldown when loading the EDL.

Varicam button Enable if the EDL is used to capture material shot with Varicam.

Fix TW Match Frames button Enable to fix match frame errors. When you import an EDL that contains
dissolves or timewarps, a match frame error may occur. This can cause an unwanted cut at the point where
the timewarp begins in your EDL. Match frame errors occur when the in point of the second edit in a dissolve
is not the same timecode as the out point of the previous shot. This feature is enabled by default.

EDL Frame Rate box Displays the framerate of the current EDL. Click to select another one.

Conversion option box Select the option that corresponds to the type of conversion that you want to apply
to the EDL. The conversion scripts that appear in this list depend on the frame rate of the EDL you are
loading.

Frame Code Mode box Select the option (29.97 fps or 30 fps) that corresponds to the EDLs that you are
loading. If you are loading multiple EDLs, the same Frame Code Mode is used for all of them.

Varicam Frame Rate box Select the Varicam frame rate.

Editing an EDL

Once you import an EDL, you can edit any value except the event number. This includes:
■ The tape name for single or multiple events

■ The audio patching information

■ The transition duration and speed value of dissolves

■ A cut to a dissolve or wipe

■ The source and record timecodes of events

These tasks are described in the following sections. You can open multiple EDLs and copy and paste events
between them. You can also use Auto Edit mode to quickly make changes to the entries you specify.

About the Import EDL Menu

Use the Import EDL menu to create, import, edit, auto-capture, assemble, and save EDLs.
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EDL List

The EDL list is divided into 12 columns.

Event # The event number, followed by a capture indicator.

Tape The name of the tape containing the source clip.

A. Patch The Audio Patch information.

Tracks The track for the edit (shown as a combination of: V, 1, 2, 3, 4, 5, 6, 7, 8).

Transition The type of transition between the clips: C for cuts, D <duration> for dissolves, and W <wipe
code> <duration> for SMPTE wipes.

Source In The starting timecode of the element in the source clip.

Source Out The ending timecode of the element in the source clip. (Ctrl-click the heading to view Source
duration.)

Keycode In The starting keycode of the element in the source clip.

Keycode Out The ending keycode of the element in the source clip.

Speed The speed at which the source clip is timewarped in the edit. The value is preceded by a negative sign
if the effect is a reverse. The column is blank if the speed value is 100% (no timewarp).

Record In The starting timecode of the element in the result clip.

Record Out The ending timecode of the element in the result clip. (Ctrl-click the heading to view Record
duration.)

Operations Group

The Operations group contains the commands that allow you to import an EDL.

(a) File Name field

File Name box Select a previously loaded EDL file to display in the EDL work area.

Load button Opens the Load EDL menu where you set options for loading EDLs.

Save button Opens the Save EDL menu where you set options for saving EDLs.

Capture button Opens the Auto-Capture menu where you capture media from a VTR using an EDL.

Close box Select Close to close the currently displayed EDL file, or Close All to close all EDL files.
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Assemble box Select Assemble to combine the captured or imported material into a clip on a destination
library reel. Select M-Assemble to combine multiple EDLs into a multitrack clip.

Assembly Options Menu

The Assembly Options menu contains options that you can set that affect EDL assembly.

(a) Dissolve Curves box (b) Dissolve Type box (c) Transitions Alignment box (d) Timewarp Mix field (e) Transition
Render Option box (f) Timewarp Render Option box (g) Increment field

Dissolve Curves box Select the type of interpolation to use for all dissolves.

To:Select:

Use the interpolation mode set in the Preferences menu.Dissolve Curves as in Prefs

Create dissolves with linear interpolation curves.Dissolve Curves Linear

Create dissolves with Bézier interpolation curves.Dissolve Curves Bézier

Dissolve Type box Select a rendering option for dissolves during EDL assembly.

To:Select:

Render dissolves as additive.Dissolve Additive

Render dissolves as non additive.Dissolve Non Additive

Render dissolves as inverse non additive.Dissolve Inv Non Additive

Transitions Alignment box Select an option for the placement of transitions in assembled EDLs.

To:Select:

Align transitions after the cut.Transitions From Cut

Centre transitions on the cut.Transitions Centred
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To:Select:

Align transitions before the cut.Transitions Up To Cut

Transition Render Option box Select the rendering mode for transitions in assembled EDLs.

To:Select:

Override the Preferences settings and render transitions in Interlaced mode.Interlaced Transitions

Override the Preferences settings and render transitions in Progressive mode.Progressive Transitions

Use the Preferences settings.Render Trans. as in Prefs

Timewarp Render Option box Select an option for the rendering mode for timewarps in assembled EDL.

To:Select:

Override the Preferences settings and render timewarps in Progressive mode.Progressive Timewarps

Override the Preferences settings and render timewarps in Interlaced mode
with no interpolation.

Interlaced TW, No Interp

Override the Preferences settings and render timewarps in Interlaced mode
with half interpolation.

Interlaced TW, Half Interp

Override the Preferences settings and render timewarps in Interlaced mode
with full interpolation.

Interlaced TW, Full Interp

Use the Preferences settings.Render TW as in Prefs

Timewarp Mix field Enter the mix value for assembled timewarps. You can enter any value from 0.00 to
1000.00.

Auto Render Assembly button Enable to render transitions and timewarps when you assemble the final
clip.

Sync Elements Assembly button Enable to automatically create Edit Sync groups for video and audio tracks
that share the same timecode.

Create Unlinked Media button Enable to assemble an EDL, even if you do not have all the sources and,
later, use the Recapture/Relink media feature to bring the missing media into your work-in-progress timeline
clip.

When you disable this option, you get virtual sources with no indication of source timecode and tape name
for the events when no recapture media exists for an event.

Increment Name button Enable to increment the assembled clip name (when assembling the same clip
multiple times).

Increment field Enter a number by which the name is incremented. Active only when the Increment Name
button is enabled.
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(a) Frame Depth box (b) Aspect Ratio Presets box (c) Frame Width field (d) Resolution Presets box (e) Fit Method box
(f) Frame Height field (g) Aspect Ratio field (h) Scan Mode box

Override Project Resolution button Enable to assemble pre-captured material of a different resolution than
your project's default resolution. Additional controls become active that you use to specify the resolution
options for assembly.

During assembly, the system searches the specified library reel for matching media. For media to match an
event during EDL assembly, all the specified parameters must be the same (including frame rate, resolution,
bit depth, and so on). When a match occurs for an event, the event is marked as captured.

By default, Override Project Resolution is disabled and the project's default resolution is used when matching
EDL events to pre-captured media.

NOTE If an EDL refers to a clip that has the same tape name and timecode but is of a different resolution than
the default resolution or that of the first matched event, the clip will not be marked as captured. For example, if
you are assembling an NTSC EDL and the EDL refers to a captured HD clip with the same tape name and timecode,
the HD clip will not be marked as captured.

Resolution Presets box Select one of many standard resolutions, as well as a Custom option that you can
use to specify non-standard resolutions.

Auto Soft Resize button Enable to apply a soft resize when assembling any clip that was captured at a
resolution that differs from the native project resolution. Options become active that allow you to specify
how the soft resize should be applied.

Fit Method box Select a fit method option to be applied to the imported clip.

To:Select:

Fit the source image, centred, over the destination frame. If the source is larger than the
destination, it is cropped. If the source is smaller than the destination, it is surrounded by
a black border.

Centre/Crop

Fit one edge of the source into the destination frame without stretching or squashing the
frame. Excess parts of the source frame after resizing are cropped. If the source—after the

Crop Edges

one edge is resized—is wider than the destination, its overhanging left and right edges
are cropped. If the source is taller than the destination, the upper and lower edges are
cropped.

Fit the source, width and height, into the destination frame. If the source and destination
frames do not have the same aspect ratio, the image can become distorted.

Fill

Fit the source to the destination frame without squashing or stretching it, and without
cropping the source. If the source is wider than the destination, black bars fill the top and

Letterbox
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To:Select:

bottom of the destination frame. If the source is narrower than the destination, black bars
fill the right and left sides of the frame. In all cases, the entire source frame is contained
within the destination frame.

Frame Width field Displays the frame width of the selected resolution preset. If Resolution Presets is set to
Custom then this field is active, allowing you to enter the frame width value that you want to use.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Frame Depth box Select from one of five frame depth options: 8-bit, 10-bit, 12-bit, 12-bit u, or 16-bit fp.

Frame Height field Displays the frame height of the selected resolution preset. If Resolution Presets is set
to Custom then this field is active, allowing you to enter the frame height value that you want to use.

Aspect Ratio field Displays the aspect ratio of the imported clip. When Aspect Ratio Presets is set to Custom,
this field becomes active so that you can enter a custom frame aspect ratio.

Scan Mode box Select an option to determine the order in which the fields of interlaced material are scanned.

To:Select:

Scan a frame-based clip with no interlacing.Progressive

Scan Field 1 first, followed by Field 2.Field 1

Scan Field 2 first, followed by Field 1.Field 2

Preferences Menu

Use the options in the Preferences menu to specify your EDL preferences.

Beep on Assembly Complete button Enable to hear an audible tone when the EDL is assembled.

Allow Zero-Length Transitions button Enable to allow zero-length wipes and dissolves. If this option is
disabled and you change a transition duration to zero, the transition automatically becomes a cut.

Keep Cursor In View Area button Enable to keep the cursor from leaving the window when you scroll an
EDL. When you scroll an EDL, the cursor will stop at the first or last event on the EDL page.

Compare Tape Names Search button Disable to ignore tape names during assembly.
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Clip Name Comments Capture button If your events contain clip names in their comments, enable this
option to use those names during capture. If this option is disabled, the event number is used as the captured
shot's name.

Use Hotkey For Add Selection button Use to change the functionality of selecting events. When this option
is disabled, you add to your selection range by clicking the events. When this option is enabled, you must
hold the Ctrl key or the pen button while clicking events to add them to your selection range.

Auto Disable Slip Tape button By default, the Slip Tape option remains enabled after you slip sources.
Enable this option to disable the Slip Tape option automatically after you slip sources.

Clip Name Comments Assembly button If your events contain clip names in their comments, enable this
option to use those names during assembly. If this option is disabled, the EDL title is used as the assembled
clip's name.

Keep System Comments button Use the Keep System Comments option to protect system comments.
When enabled, you can only delete user comments.

(a) Max TW Capture Handles field

Import As Soft Import button Enable to soft-import files with a file-based EDL that are located on a standard
filesystem. If you disable this option, the files are hard-imported.

Import Background Proxies button Enable to allow proxies to be generated in the background.

Include VTR Preroll button Enable to capture the events in one pass and store them as individual clips in
the clip library. By default, if events in an EDL are separated by a shorter duration than the VTR preroll and
more than 10 frames, they are captured in a single pass.

Capture Proxy Only button Use this option in HD projects to auto-capture proxies only when conforming
an EDL. This option does not appear in SD projects.

Max TW Capture Handles field You can set the maximum number of handles to be captured for source
clips that are part of timewarped events. On timewarped events, the capture handles value is equal to the
capture handles value multiplied by the speed of the timewarp. For example, for an EDL event with an
increased speed of 500% (in NTSC), if the capture handles are set to 30 frames, 150 frames are captured as
handles (30 frames multiplied by 5).

Standard handles may not be enough in the case of high-speed timewarps.

Capture Creates One Clip Per Event button Enable to create a clip in the clip library for every event in the
EDL. When disabled, a single clip is created in the library for each group of events captured during the same
pass. You can assemble the montage regardless of which option you chose to store EDL events in the clip
library.

To reduce the size of clip libraries, you should disable this feature. However, if you need to reference back
to individual shots, they may be easier to find if you enable the option and generate a clip for every event.

Auto Save After Each Tape button When this option is enabled, the system performs an AutoSave between
each tape when auto-capturing.

Conform Tab Overview | 145



Search Events Menu

Use the Search Events menu to search entries for text or timecode in an EDL. When you search the EDL,
you need to specify the item you want to search, the filter type you want to use, and the criteria for which
you want to search.

(a) Select Item box (b) Search Item box (c) Filter Type box (d) Search Criteria field

Select Matches button Highlight all items that match the search criteria.

Unselect Matches button Remove the highlight from all items that match the search criteria.

Select Item box Select the option that you want to search for.

To highlight:Select:

All events that match the search criteria.Select Events

All edits that match the search criteria.Select Edits

Search Item box Specify the item that you want to search for in the EDL.

To search for:Select:

Event numbers.Event Number

Tape names.Tape

A specific transition duration.Transition Length

A source in timecode.Source In

A source out timecode.Source Out

A specific timewarp speed.Speed

A record in timecode.Record In

A record out timecode.Record Out
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To search for:Select:

A comment or text within a comment.Comment

A track.Track

Previous button Move the cursor to the previous item that matches the search criteria.

Next button Move the cursor to the next item that matches the search criteria.

Filter Type box Specify the filter type. The filter type will differ depending on the item you are searching.
For numerical searches, select one of the following options from the Filter Type box.

To find:Select:

All event numbers that match your search criteria.Is Equal to

All event numbers that do not match your search criteria.Is Not Equal to

All event numbers that are less than your search criteria.Is Less Than

All event numbers that are greater than your search criteria.Is Greater Than

For alphabetical searches, select one of the following options from the Filter Type box.

To search:Select:

For all tapes that match your search criteria.Matches

For all tapes that do not match your search criteria.Does Not Match

For all tapes that contain your search criteria.Contains

For all tapes that do not contain your search criteria.Does Not Contain

For all tapes lexicographically less than your search criteria.Is Less Than

For all tapes lexicographically greater than your search criteria.Is Greater Than

Alphabetical searches are performed on Tape and Comment items by default. To perform a numeric search
on these items, enable Treat As Numeric. To match results by case, enable Case Sensitive.

Search Criteria field Enter the search criteria.

Renumber Events Menu

Use the options in the Renumber Events menu to specify the value by which events are renumbered.
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(a) Next Event field

Renumber Events button Renumbers the selected events according to the value specified in the Next Event
field.

Next Event field Enter a value for the next event.

2:3 Pulldown Options Menu

Use the 2:3 Pulldown Options menu to set the parameters for 2:3 pulldown insertion upon import.

(a) Reference Frame field (b) Reference Frame Type box (c) Default Reference Frame box (d) Mix field

Reference Frame field Enter the timecode for the reference frame. This is only required for clips stored as
files, and not for material on tapes.

Reference Frame Type box Set the reference frame type: AA or BB, corresponding to the timecode value
entered in the Reference Frame field.

Auto-Fill Black Frames button Enable to fill black frames with the last frame of the outgoing event. By
default, gaps occuring between EDL events are filled with black frames.

Default Reference Frame box Select AA or BB.

Show Black Frames button Enable to highlight the places in the currently loaded EDLs where gaps of black
frames occur.

Timewarp Fit button Enable to automatically apply a timewarp to material on tapes referenced by EDLs
where 2:3 pulldown removal was disabled (for example, when a tape contains native 30 fps interlaced video
material), so that it can be easily integrated with 24 fps material.

Mix field Enter the number of frames to ensure that match frames on timewarped elements are maintained.
This field is active when Timewarp Fit is enabled.

148 | Chapter 6   Importing and Exporting Media



(a) EDL work area (b) Work area column headers (c) EDL Player (d) Load button (e) Import EDL menus (f) EDL editing
tools

About EDL Editing Commands

Events Group

Use the commands in the Events group to cut or copy single or multiple events and paste them to a new
location in any open EDL. You can also use special paste functions and selection tools for events.

Insert Event button Inserts a new event into the EDL.

Cut Event button Cuts the selected event. May be used with Paste Event button.

Copy Event button Copies the selected event. May be used with Paste Event button.

Paste Event button Pastes the previously cut or copied event to the selected location.
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Paste: Fix Record button Enable to change Record In of the first pasted event to start at Record Out of the
previous event. All pasted events are then rippled by the same amount.

Paste: Renumber button Enable to automatically renumber all events according to the Next Event value
in the Renumber Events menu. If this option is disabled, the pasted events retain their original event numbers.

Select All button Click to select all events for capture.

Unselect All button Click to unselect all events.

Auto-Paste button Enable to quickly cut events from multiple EDLs and automatically paste them to a single
EDL. For a selected EDL, when clicking the Paste button, any events that are cut or copied are automatically
pasted to the first EDL.

Comments Group

You can add or delete comments from events using the commands in the Comments group of the EDL
menu. Comments can contain up to 256 alphanumeric characters. You can also toggle comments on or off.

EDL comments become part of the source clip when assembling the EDL. Multiple comment lines are merged
into one timeline comment line.

Insert Comment button Add a comment to the event selected in the EDL work area. You can add multiple
comments to an event. To edit a comment, double-click it and enter the new comment.

Delete Comment button Delete a comment selected in the EDL work area.

Hide button When enabled, will hide all comments in the EDL work area.

Clean button Removes asterisks from comments.

Titles Group

You can add or delete a title from an EDL using commands in the Titles group of the Import EDL menu.

Insert Title button Enter a new title in the Titles area of the EDL work area. You can add multiple titles. To
edit a title, double-click it and enter the new title.

Delete Title button Delete a title in the EDL work area.
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Capture Group

You can mark events for capture or select only the uncaptured ones for recapture.

Mark button Click to mark the selected events for recapture with an “X”. This allows you to keep track of
events that you want to recapture. Events that have already been captured are marked with a lower case x.
Therefore, when you mark a captured event for recapture, a lower and upper case x appear (x X) to the right
of the event number.

(a) Capture mark (b) Recapture mark

Unmark button Click to remove a recapture mark from the selected events.

Select Uncaptured button Click to select all uncaptured events in the EDL. The next time you click
Auto-Capture, only the selected events are captured.

Update Capture Marks button Click to update the list of captured events.

Transitions Group

Use the commands in the Transitions group to change any transition to a cut, dissolve, or standard SMPTE
wipe.

Cut button Changes the transition type to a cut for the selected transition, or range of transitions.

Dissolve button Changes the transition type to a dissolve for the selected transition, or range of transitions.
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Wipe button Changes the transition type to a wipe for the selected transition, or range of transitions. The
wipe type is set to SMPTE 001.

Choose button Opens the Choose Wipe menu from which you can select from a variety of standard SMPTE
wipe types.

EDL Group

You can use any of these options in the EDL group when using EDLs to capture media.

(a) Sort box (b) Show Timecode box (c) Sort Mode box

BRoll Detect button Enable to detect BRolls. BRolls appear as the original tape. You are not prompted for
the tape containing the BRoll when you capture the clips. When disabled, BRolls are indicated with a “B”
following the tape name in the Tape entry.

Show Timecode box Select the type of timecode to display.

To:Select:

Display EDL timecode.Show EDL

Display Varicam timecode.Show VC

Sort box Click Sort to sort the current EDL, or click Sort All to sort all the EDLs. EDLs are sorted according
to the sort order specified in the Sort Mode box. You can change the way an EDL is sorted.

Auto-Edit button Enable to quickly modify only the entries in the selected columns of the EDL. Click the
column headers of the columns that you want to auto-edit. Starting with the first entry that you edit, press
Enter to move automatically to the next entry. If no further entries exist, a new event is added.

Sort Mode box Select the appropriate sort order.

To sort the EDL:Select:

By Record In timecode. If you want to view the EDL in the order of the final assembly,
sort the EDL in A Mode.

A Mode

By Tape and Record In timecode.B Mode

By tape number and Source In timecode. If you want to view the EDL in the order the
clips are captured, sort the EDL in C Mode. EDLs are always captured in C Mode, regard-
less of the sort mode you selected.

C Mode
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To sort the EDL:Select:

By Source In timecode, regardless of tape number. This sort mode is useful for multi-
camera real-time EDLs.

S Mode

By event number.by Event#

By tracks. In this sort mode, video tracks are placed at the bottom of the list, and the
highest audio track is placed at the top of the list.

by Tracks

By placing all uncaptured events at the top of the list.by Uncaptured

Select Invalid Frame button Click to select a frames of 0 length.

Editing Group

When you modify an entry in an EDL, several options control how other entries are affected. Make sure
these options are either enabled or disabled, depending on how you want to edit the EDL.

Slip Tape button Enable to slip all source clips on the tape, or all record clips in the EDL list. All the in and
out points of all source or record clips change without affecting their duration.

Lock Speed button Enable to edit the timecode without changing the speed value for the event.

Slip button Enable to slip a source or record clip in a single event. The in and out points of the selected clip
change without affecting its duration.

Ripple Rec button Enable to move all Record entries, following an edited or pasted Record Out entry, forward
or backward accordingly. This is useful when you want to edit the Record Out of an event without overwriting
or creating a gap between the following shots.

Affect Sel button Enable to affect only the selected events.

Affect Tape button Enable to affect every relevant entry on the same tape when you modify a single entry.

View Sel button Enable to view only the selected events.

Display Group

The Display group contains options for modifying the display of events in the EDL list.

Conform Tab Overview | 153



(a) Show TC/KC box (b) Speed box (c)  EDL Display box

Show TC/KC box Select whether to display keycode or timecode.

To:Select:

Display timecode.Show TC

Display keycode.Show KC

Speed box Select a mode to display the speed change for timewarps.

To:Select:

Display the speed change as a percentage.Speed %

Display the speed change in frames per second.Speed FPS

EDL Display box Select a display mode for EDLs, Tape List view, or Undo List view.

To:Select:

Display timecode.EDL

View all modifications (up to the number of undo levels specified in the Preferences
menu) that you made in the current session, and undo a single or series of commands.

Undo List

Click the item in the undo list that you want to undo. All operations are undone up
to and including that modification. All operations prior to the highlighted modification
are redone.

Display the Tape List view, showing the last selected EDL.Tape List

Display the Tape List view, showing all selected EDLs.Tape List (All EDLs)

Undo List View

Use the Undo List to view all modifications (up to the number of undo levels specified in the Preferences
menu)that you made in the current session and undo a single or series of commands.

Click the item in the Undo List that you want to undo. All operations are undone up to and including that
modification. All operations prior to the highlighted modification are redone.

154 | Chapter 6   Importing and Exporting Media



Tape List View

You can use the tape list to modify information pertaining to events for a given tape.

As well, each tape's entry can be expanded in Tape List view to show keycode and 2:3 pulldown information
associated with the source timecode.

Click the column header to sort the tape list in descending order using that column. Click the column
heading again to sort the tape list in ascending order.
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The work area of the Tape List view is divided into nine columns, and two sections for each tape.

The upper fields of each tape entry contain the following columns.

Tape The name of the tape that contains the source footage. To change the tape name, click and enter a
new name.

Capture The capture flag for the tape. When set to On, the tape is captured during an auto-capture session.
To set the capture flag for a given tape to On or Off, click the item under the Capture column and drag left
or right to set it On or Off.

FCM The frame code mode for the tape. If the frame code mode is 29.97, you can drag over the item in this
column to switch between DF/NDF modes.

Tracks The number and type of tracks that will be captured for the tape.

Start The starting timecode for the first event to be captured on the given tape.

Capture Time The duration of the material to capture for the given tape.

Telecine Indicates the telecine log associated with the tape.

Final Telecine Indicates the final telecine log associated with the tape.

Events The number of events to capture for the given tape. You cannot modify this value in Tape List view.

The lower fields of each tape entry contain the following columns.

TC Start Start timecode for each keycode sequence.

TC Duration Duration of time for the keycode sequence.

Film FCM Film frame code mode indicating the speed of the telecine when it scanned the film frames.
Change the film FCM by clicking the Keycode field to access the calculator.

Keycode Keycode for the first frame of the sequence.

Removal Whether to apply 2:3 pulldown to the sequence.

Ref Frame Timecode of the reference frame.

Ref Type Type of reference frame.

DF Ref Frame Timecode of the drop frame reference frame.

EDL View

An EDL contains events, edits, and entries. An event is a complete element in the EDL such as a shot, dissolve,
or wipe. An edit is an individual component that makes up an event, such as an outgoing shot or an incoming
shot. An entry is an individual value for any variable in the edit, such as dissolve length, Source In, or Speed.
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(a) Edits (b) EDL events (c) EDL entries

Every event has a different event number. Some events, such as dissolves and wipes, consist of two edits.
The two edits in a dissolve (outgoing and incoming shots) have the same event number.

Editing a Tape Name

You can change a single event's tape name, or the tape name for all events on the same tape. This is useful
if the events you want to capture are on a different tape than that listed in the EDL.

Tape names can be up to 56 characters long. The EDL Editor displays only the first eight characters, but the
clips maintain the original tape name.

To edit a tape name:

1 In the Import EDL menu, do one of the following:
■ To change the tape name for all events on the same tape, enable Affect Tape.

■ To change only the selected tape name, disable Affect Tape.

2 Click the Tape entry in the event you want to edit and enter the new name:
■ If the Affect Tape option is enabled, the tape name for all events on the same tape changes

automatically.

■ If the Affect Tape option is disabled, only the tape name for the selected event changes.

■ If the Affect Selection option is enabled, only the tape names for selected events change.

Audio Patching

If you want to capture audio from a different track than that specified in the EDL, you can change the audio
patching for a single event, selected events, or all events on the same tape. For example, if an edit specifies
the audio tracks as 1 and 2, but you want to capture the audio from tracks 3 and 4, use the Audio Patching
menu to reroute the audio during auto-capture.

To change audio patching:

1 In the EDL work area, select the events that you want to modify.

2 Click an Audio Patch field.
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The Audio Patching menu appears.

(a) Audio Patch boxes (b) Source audio track (c) Destination audio track

You can edit the source audio tracks. Each one of the eight available source audio tracks can be patched
to one of the eight available destination audio tracks. You can patch the same source audio track to
multiple destination audio tracks.

3 Enable or disable the Affect Tape and Affect Selection buttons.

4 Reroute the audio in the Audio Patch boxes by doing one of the following:
■ Drag in an Audio Patch box to cycle through source audio tracks one through eight.

■ Click an Audio Patch box to access the calculator, then type a value one through eight indicating
the source audio track.

5 Click Return.

To exit the Audio Patching menu without changing the patching information, click Cancel.

The source tracks that have been patched to different audio tracks than the defaults are indicated in
the affected event's Audio Patch Field. Dashes in the Audio Patch Field indicate the track is patched to
its default. Comments are also added which indicate the name of audio tracks and their patching
information.

When clips are captured, audio tracks are patched as indicated.
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(a) Comments indicate patching information (b) Source 1 and 2 patched to destinations 5 and 6

Editing Tracks

You can edit the tracks of an event in the EDL. Editing tracks is useful if you want to modify the tracks
captured when you auto-capture or assemble the EDL.

For example, if the Track entry for an event is V1 and you want to capture only the video track (V), change
the Track entry to V.

To edit the tracks for an event:

1 In the EDL work area, select the Track entries in the event that you want to edit from the EDL.

The Track menu appears.

(a) Track Edit Mode box

2 Enable the tracks that you want to edit.

3 Enable or disable the Affect Tape and Affect Selection buttons.

4 From the Track Edit Mode box, select the mode that you want to use.

To:Select:

Replace tracks in the event with tracks you specified in the Track menu.Change To

Add the tracks you specified in the Track menu to the tracks in the event.Add

Conform Tab Overview | 159



To:Select:

Keep only the tracks you specified in the Track menu. For example, if an event is “V12”
and you specify “V1,” audio track 2 is filtered out, and the resulting event has “V1.”

Filter

Reverse the status of tracks you specified in the Track menu. For example, if an event
is “V23” and you specify “V34,” the resulting event has “V24.”

Flip

5 Click Return to confirm the change or Cancel to exit back to the EDL module without making any
modifications.

Editing Transitions in EDLs

You can change any transition to a cut, dissolve, or SMPTE wipe. If the effect of an event is a dissolve, you
can edit its duration (Transition Duration). If the effect of an event is a wipe, you can also select the type of
wipe in the SMPTE Wipe library.

You can add or modify transitions based on a selection range.

You can also change a cut to a dissolve by clicking the Transition entry of the cut. You can change a dissolve
to a cut by setting the Transition Duration to 0, as long as the Allow Zero-Length Transitions option is
disabled in the EDL preferences.

Dissolves in EDLs

Dissolves are represented in the EDL by two consecutive edits with the same event number. The first edit
represents the outgoing shot of the dissolve and the second edit represents the incoming shot of the dissolve.
The dissolve is listed in the Transition column of the second edit as D n (where n is the transition duration).

The Transition duration appears in the Transition entry of the second edit in the dissolve. The Start Location
for the dissolve is also indicated in the Transition entry.

If the EDL was exported from Smoke, the dissolve can be Centred, From Cut, or Up To Cut. The start location
for the dissolve appears beside the Transition duration.

The following illustration is a typical dissolve in an EDL.

(a) Outgoing shot (b) Incoming shot (c) Transition duration

If you change the Transition duration of a dissolve, the Source Out of the incoming shot changes by the
same duration automatically.

Wipes in EDLs

Wipes are represented in the EDL by two consecutive edits with the same event number. The first edit
represents the outgoing shot of the wipe and the second edit represents the incoming shot of the wipe. The
wipe is listed in the Transition column of the second edit as W n m (where n is the wipe code and m is the
wipe duration).
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The SMPTE wipe number appears in the Transition entry of the second edit in the wipe. The Start Location
for the wipe is also indicated in the Transition entry. A wipe can be Centred, From Cut, or Up To Cut. The
start location for the wipe appears beside the Transition duration. The following illustration is a typical wipe
in an EDL.

(a) Outgoing shot (b) Transition duration (c) Incoming shot (d) SMPTE wipe number

If you add 500 to the SMPTE wipe number, the wipe is inverted during assembly. For example:

Wipe 502Wipe 002

If you change the Transition duration of a wipe, the Source Out of the incoming shot automatically changes
by the same duration.

Editing Timecode

If you want to capture different material than what appears in the EDL, you can slip or trim the edits to
specify the correct material for your final assembly. You can change any source or record timecode in the
EDL.

You can also edit timecode and keycode in the Tape List.

To edit timecode:

1 If you want to edit source timecode, and keycode in and out values are displayed, toggle the Show
Timecode/Show Keycode box to Timecode.

2 Do one of the following:
■ Click the source or record timecode entry you want to modify and drag right to increase the value

or drag left to decrease the value. You can use hotkeys to change the values in varying increments.

To:Use:

Jump by seconds.Shift-drag

Jump by minutes.Ctrl-drag
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To:Use:

Jump by hours.Alt-drag

■ Double-click the source or record timecode you want to modify to get the calculator, and then enter
a new timecode. If the source or record timecode is already selected, click it again to get the calculator.

When you edit source timecode, the corresponding keycode changes to reflect the new frames to be
captured. Toggle the Show Timecode/Show Keycode button to see the edited keycode in and out values.
You cannot edit the keycode for events in the EDL work area.

NOTE Other entries in the same edit affected by your modifications become highlighted as you edit an
entry.

Editing Tape List Timecode and Keycode

In Tape List view, you can slip all the start timecode values for a given tape. This is useful when you need
to modify the start timecode of a tape that is used in multiple EDLs, because you edit the value only once.

You can also slip keycode and its associated start timecode and duration. This is similarly useful to alter
keycode values correlated to the timecode for given sequences on the tapes.

To slip the start timecode value for a given tape:

1 In the Import EDL menu, from the Display group, enable View Tape List.

2 Do one of the following:
■ Click the start timecode entry you want to modify and drag right to increase the value or drag left

to decrease the value. You can use hotkeys to change the values in varying increments.

To:Use:

Jump by seconds.Shift-drag

Jump by minutes.Ctrl-drag

Jump by hours.Alt-drag

■ Click the start timecode entry you want to modify to get the calculator, then enter a new timecode.
See inferno flamesmoke.

To slip the keycode for a given tape:

1 In the Import EDL menu, from the Display group, enable View Tape List.

2 If necessary, click the triangle on the left of the tape entry to expand its contents.

Sequences of timecode on the tape are associated to keycode values. If no keycode is available from
the telecine log(s) you loaded, N/A (not available) appears for the sequence.
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(a) Timecode start and duration defines sequence, with corresponding keycode (b) Timecode without corresponding
keycode

3 To edit the keycode for a sequence, do one of the following:
■ Drag the keycode entry you want to modify to the right to increase the value or to the left to decrease

the value.

■ Click the keycode entry you want to modify to get the keycode calculator, and then enter a new
keycode.

The keycode values associated to the timecode sequence (defined by the values in TC Start and TC
Duration fields) are altered.

If you change the frame rate in the keycode calculator, it is reflected in the Film FCM field.

Editing and Creating Timewarps

You can edit an existing timewarp or create a timewarp in your EDL. When you edit a timecode entry of an
event with the Lock Speed option disabled, no other entries are affected. This results in a speed change
because the source duration differs from the record duration.

For example, if you increase the Source In entry of an event by 5 seconds, the record clip of the same event
is 5 seconds shorter than the source clip. The result clip is timewarped when assembled. No other entries
are affected.

Timewarps are represented in the Speed column of the EDL. If the Speed value is blank, the event is not
timewarped. If there is a Speed value, the event is timewarped.

(a) Speed value

To edit or create a timewarp:

1 In the Import EDL menu, from the Editing group, disable Lock Speed.

2 In the EDL, click the source or record timecode entry for the event that you want to edit and enter the
new value.
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The value of the timewarp appears in the Speed entry. You may also click directly in the Speed box to
change the entry. If the event is already a timewarp, editing any timecode of that event changes its
speed value.

You can view the speed value in either percentage or frames per second. Select the View mode in the EDL
Preferences menu.

Conforming an EDL with VTR Recapture

NOTE The following requires that the workstation is connected to a VTR.

1 In the Conform tab, right-click the Event list and select Load New EDL.

2 From the window that appears, locate and select the EDL to import, and then click Load.

The EDL is loaded and opened as a sequence in the timeline view of the Conform tab.

3 Right-click the event list, and select Capture All From VTR.

The VTR module opens and cues the VTR.

4 Proceed with the recapture of the cued events.

5 Once back to the Conform tab, continue with the conform process as you would with a file-based
sequence.

Conforming an Avid AAF

1 In the Conform tab, right-click the Event list and select Load new FCP XML/AAF.

Or if you already imported the AAF using the MediaHub, open it on the Timeline and switch to the
Conform tab.

2 From the window that appears, locate and select the AAF to import, and then click Load.

NOTE When conforming file based media, Smoke automatically searches for and links the matching media.
The AAF is then loaded and opened as a sequence in the timeline view of the Conform tab, whether or not
all your sources are fuond and relinked. This is the default behavior of the application. You can change this
behavior by disabling Link to Media Files and Search and Import Files the in the Sequence Import Options,
from the Media Import window. If Smoke does not find all of your associated media, proceed as follows.

3 Click Set Search Directory to locate the directory where Smoke can find the media files you want to
use for sources.

You now have two lists: the Event lists, displaying all the events making up the sequence, and the
Sources lists, displaying all the source media Smoke found at the location you set using the Set Search
Directory button.

4 With Options > Filter Potential Matches selected, click an event to view, in the Sources list, the sources
that Smoke determined to be a potential match.

5 What you do next depends on the Status column of each event.

Match Select Link Found Sources from the Linking combo box. Link Found Sources links all events
with the Match status to their unique sources. Match indicates that Smoke found only one source from
the Sources list that fit the selected Match Criteria.

Multiple Matches  Select the event and the source to relink, and then select Link Selected from the
Linking combo box. If there are too many sources to choose from, you can set additional criteria using
the Match Criteria drop-down menu; by trial and error you reduce the number of filtered sources. Make
sure Options > Filter Potential Matches is enabled, to display only the filtered souces.
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No Match Found Either add more sources to the Media folder or modify the criteria selected in the
Match Criteria drop-down box. Not Found indicates that either the criteria are too restrictive for Smoke
to find a match, or that the source is simply not there.

Unlinked Add sources to the Media folder. Unlinked indicates that the event is not linked to any
source. It appears only when no sources are available in the Media folder, and the Conform section of
the Media panel displays 0 clips available.

Linked Don't do anything: the event is already linked to an event. A Linked event only appears if
Options > Hide Linked is not selected.

6 Once there all the events are linked to sources, you can leave the Conform tab.

Conforming an Final Cut Pro XML

1 In the Conform tab, right-click the Event list and select Load new FCP XML/AAF.

Or if you already imported the XML using the MediaHub, open it on the Timeline and switch to the
Conform tab.

2 From the window that appears, locate and select the XML to import, and then click Load.

The XML is loaded and opened as a sequence in the timeline view of the Conform tab.

3 Click Set Search Directory to locate the directory where Smoke can find the media files you want to
use for sources.

You now have two lists: the Event lists, displaying all the events making up the sequence, and the
Sources lists, displaying all the source media Smoke found at the location you set using the Set Search
Directory button.

4 With Options > Filter Potential Matches selected, click an event to view, in the Sources list, the sources
that Smoke determined to be a potential match.

5 What you do next depends on the Status column of each event.

Match Select Link Found Sources from the Linking combo box. Link Found Sources links all events
with the Match status to their unique sources. Match indicates that Smoke found only one source from
the Sources list that fit the selected Match Criteria.

Multiple Matches  Select the event and the source to relink, and then select Link Selected from the
Linking combo box. If there are too many sources to choose from, you can set additional criteria using
the Match Criteria drop-down menu; by trial and error you reduce the number of filtered sources. Make
sure Options > Filter Potential Matches is enabled, to display only the filtered souces.

No Match Found Either add more sources to the Media folder or modify the criteria selected in the
Match Criteria drop-down box. Not Found indicates that either the criteria are too restrictive for Smoke
to find a match, or that the source is simply not there.

Unlinked Add sources to the Media folder. Unlinked indicates that the event is not linked to any
source. It appears only when no sources are available in the Media folder, and the Conform section of
the Media panel displays 0 clips available.

Linked Don't do anything: the event is already linked to an event. A Linked event only appears if
Options > Hide Linked is not selected.

6 Once there all the events are linked to sources, you can leave the Conform tab.
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Clip Input/Output Using a VTR
Smoke allows you to perform numerous VTR-based clip input and output operations. You can capture
individual clips or frames, or log clips for capture using an EDL. Similarly, the application allows you to
output single clips or frames, as well as multiple clips to a VTR device.

Clip input and output general workflow:

1 Make sure all hardware devices involved in the clip input and output process are properly configured.
If not, the VTR Input and VTR Output menu options are disabled.

2 Run the Smoke Setup application to ensure the proper devices and settings are initialized on application
start-up.

3 Do one of the following:
■ Input clips.

■ Output clips.

Configuring Hardware For Clip Input and Output Using a VTR

When preparing for a VTR session, confirm the following:
■ Audio and video outputs of the VTR are connected to the audio and video inputs of the Smoke system.

Audio and video inputs of the VTR are connected to the audio and video outputs of the Smoke system.

■ The VTR is connected, using an RS-422 video I/O control cable, to a serial port of your workstation to
enable remote control of the device.

■ A video sync signal is connected to the sync input of the video device to ensure frame-accurate capture.
If there is a separate audio device, an audio sync signal must be connected to it as well.

Your Mac must be equipped with either an AJA or a Blackmagic Design device to connect to a VTR.

Supported AJA devices:

■ Kona 3G

■ Io XT

Supported Blackmagic Design devices:

■ DeckLink (PCIe video boards)

■ UltraStudio (Thunderbolt boxes)

The actual supported features depend on the device used, but generally includes SDI Capture, SDI Playout,
and SDI / HDMI Preview. For the Intensity series, only the HDMI preview is available.

Configuring Software For Clip Input and Output Using a VTR

Software configuration in preparation for clip input and output session involves using the Smoke Setup,
found in the Finder in Applications ➤ Autodesk ➤ Smoke ➤ Utilities.

In the Smoke Setup application, in the VTR tab, enable every VTR you plan on using with Smoke. Also verify
the Preview tab for the timings you want to make available to your projects. If you do not have a sync
connected to your workstation, you might want to define for your project some free run timings. They are
turned off by default.
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NOTE When working in HD projects and capturing material from a Varicam (variable frame rate 720p material),
ensure that the following VTR are enabled: VTR DVCProHD 720 59p, SERIAL1, 1280x720_5994P and VTR
DVCProHD 720 60p, SERIAL1, 1280x720_60p.

Inputting Clips From a VTR

Once you have set up your hardware devices and configured the software initialization file, you are ready
to perform clip input and output. The VTR Input module contains various controls to help you perform
operations, such as capturing a single frame, capturing a single clip, capturing and logging multiple clips.

Accessing the VTR Input Module

1 Select a folder from the Media Library. This is where the captured clips will be created.

2 Select File ➤ Capture from VTR...or press F9.

The VTR Input module appears.

If VTR Input is not available, connect your workstation to a VTR, and configure Smoke to use the VTR.

Capturing Single Clips

You can capture a single clip from a VTR. You can capture on the fly with your in and out points determined
by mouse clicks during playback, or be more precise by setting in and out points in the corresponding fields.

To capture a single clip:

1 Cue up the tape to the frame at which you want to begin capturing.

2 Do one of the following:
■ From the Capture Method box, select Start On Pen/Stop On Pen.

■ Enter clip input in and out points in the In and Out fields. See Setting Input and Output In and
Out Points (page 180).

3 To begin capturing, click Process.

The timecode field turns green, indicating that capture is in progress. Depending on your hardware
configuration, the preview window may go black during capture.

4 To end the capture at any time, click the cursor anywhere over the preview window.

Depending on your project proxy settings, a post-process may occur, generating proxies for each
captured frame. You can see a notification on the process that is taking place in the message bar.

Once all capture-related processes are complete, the clip is saved to the Workspace location that you
selected before you entered the VTR Input module.

Capturing Single Frames

A single frame capture, or a frame grab, is the simplest clip input operation. This is useful for extracting
snapshot frames for a preview or promotion piece.
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To capture a single frame:

1 Cue up to the frame you want to capture using the VTR Transport controls or by scrubbing the preview
window.

2 Click Grab.

The captured frame is saved in the Workspace.

3 Click EXIT Input Clip to view the captured frame.

4 If you want to compare the captured frame against the frame in the preview window, load the clip
into the VTR Input module and enable split-screen view. See Monitoring Video During Clip Output
(page 179).

VTR Input Menu Options

The basic VTR Input controls are described as follows.

(a) Device Name box (b) Aspect Ratio box (c) Aspect Ratio field (d) EDL button (e) Current Timecode field (f) Proxy
Quality box  (g) Bit Depth box  (h) Scan mode box (i) Tape Name field (j) Clip Name field (k) Increment Name field
(l) Tape Type box

Device Name box Select the VTR and timing combination to use to capture clips.

Engineering button Opens the engineering menu.

Aspect Ratio box Select the aspect ratio of the clip to capture.

Aspect Ratio field Displays the aspect ratio of the clip to capture. Editable.

Bit Depth box Select the bit depth used to capture the clip.

Scan Mode box Selects how to flag the captured clip: Progressive, Field 1 dominant, or Field 2 dominant.
The flag is only there as a reminder; for example, setting Field 2 does not prevent you from de-interlacing
on Field 1. In most cases, select the option that matches the format you are capturing.

Proxy Only button Enable to capture proxies only. In this case, the high-resolution media is captured,
proxies are generated, but the high-resolution media is discarded. As a result, much storage space is required.

Only available if the current project is configured to use proxies. If your proxies are set to be generated as a
post process in the Engineering menu, you can see an estimated time required for proxies generation in the
message bar. You can abort this process at any time by clicking anywhere on the screen. When you click
the screen, a message appears asking you to confirm the operation. Only the captured media that corresponds
to completed proxy generation is preserved. Any captured frames for which no proxies have been generated
are purged.

Proxy Quality box Proxies generated during capture are always of draft quality. Using the Proxy Quality
box, you can set the default quality for proxy generation after capture. Results vary depending on the type
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of clips involved, so it is a good idea to try different settings. Only available if the current project is configured
to use proxies.

To get:Select:

Quick, low-quality results.Impulse

Moderate results with little processing overhead.Triangle

Best results when resizing a clip to a higher resolution.Mitchell

Very good results for resizing soft-looking images. Use to sharpen the image.Bicubic

Good results for resizing simple images with straight edges. Similar to Gaussian but with

more blurring. Use to soften the image.

Quadratic

Excellent results when resizing a clip with no patterns and alot of straight edges to a lower

resolution. Useful for softening some detail.

Gaussian

Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but

results are a little softer.

Shannon

Best results when resizing a clip containing a variety of patterns and elements to a lower

resolution. It is the most complex with the longest processing time.

Lanczos

Capture button Starts the capture.

Grab button Grabs the current frame.

Input Type box Select the type of footage found on the tape. Use Standard for regular capture. 2X can only
be used with HDCAM SR. Dual Image is for stereo footage recorded side-by-side on the tape; use Slice to
create a single Stereoscopic clip on capture, but with half the horizontal resolution; use Scale to create a
single Stereoscopic clip, but resized to full horizontal resolution. With Scale, use Engineering > Dual Image
Resizing Filter to select the quality of the resize.

Not available if your VTR is connected using a Blackmagic Design device.

EDL Log button Logs the clip to the EDL.

EDL button Opens the EDL menu where you can capture and edit EDLs.

Log On Out button Enable to log EDL events every time you enter an out point.

Tape Name field Displays the name of the tape from which you are capturing. This name is important for
EDL assembly and media recapture procedures. Editable.

Clip Name field Displays the name to use for the clip to capture. Editable.

Increment field Displays the number automatically appended to the clip name. Active when Increment is
enabled.

Increment button Enable to append numerical increments to the clip name automatically. For example,
enter “My_Clip” in the Clip Name field and then enable Increment Name. The first clip you capture is named
“My_Clip-1”, the second is named “My_Clip-2”, and so on.
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Start Mode box Determines the start mode for clip input.

To:Select:

Capture starting from the currently displayed frame on the tape. Click Process to
activate the start-on-pen trigger.

Start On Pen

Capture starting from the timecode you enter in the In field. Click Process to start
the clip input process.

Start On Timecode

Stop Mode box Determines the stop mode for clip input.

To capture until:Select:

You click anywhere on the screen.Stop On Pen

A specific number of frames have been captured. When you select this option, a
field appears in which you enter the number of frames you want to capture.

Stop After Frames

A timecode on the tape has been reached (entered in the Out Timecode field).Stop On Timecode

Current Timecode field Indicates the current timecode of the tape in the VTR.

The following controls are found on the right side of the menu (not shown in preceding illustration).

In Timecode field Displays the timecode on the tape at which point the clip input begins. Editable.

Out Timecode field Displays the timecode on the tape at which point the clip input process ends. Editable.

Duration field Displays the duration, in timecode, between the clip in point and out point. Editable.

Tape EE button Click to toggles E-to-E on and off. When lit, indicates that the VTR is in E-to-E mode
(electronic to electronic). This means that the VTR output is showing its input signal.

Standby button When lit, the VTR is in standby mode. Click to toggle between standby modes.

Cue In button Cues the VTR to the value of the In Timecode field.

In button Sets the In Timecode field to the current VTR timecode.

Cue Out button Cues the VTR to the value of the Out Timecode field.

Out button Sets the Out Timecode field to the current VTR timecode.

Toggle Audio Tracks button Switch between audio banks of 4 audio tracks.The actual number of tracks
depends on your capture device.

Video Track button Enable to capture the video track.

VTR Status display Indicates the current status of the VTR.

Selecting a VTR Device For Input

The VTR devices available depend on the VTR keyword lines uncommented in the software initialisation
configuration file. Make sure the VTR you select is appropriately connected using the corresponding audio,
video, and RS-422 connections.

In certain situations, Smoke pre-selects a VTR with appropriate timing for you.
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To select the VTR device for input:

1 From the Device Name box, select an option corresponding to your VTR device.

2 Make sure that the selected device is in Remote mode.

Naming Tapes and Clips

Proper media management is an essential part of the clip input and output process. One of the elements of
efficient media management is methodical and consistent naming of the clips you capture and the tapes
from which they originate. Before capturing a clip, assign a name to the tape and the resulting clip. This
assignment makes it easier to organize your clips, trace them back to the source tape, and, when necessary,
recapture them.

To name a tape and clip:

1 In the Tape field, enter the tape name.

The tape name is stored with the clip. In the Workspace, you can Alt-click the clip to view its
information, including the tape name.

2 In the Clip field, enter a clip name.

3 Enable Increment to use the same name for multiple clips captured in sequence. This appends a
numerical tag at the end of each clip so you can differentiate them.

4 To change the number of the numerical tag for the next captured clip, enter a number in the Clip
Index field. By default, the increment begins at 1.

Selecting Tracks and Channels to Capture

Whether you are inputting single frames, single clips, multiple clips or conforming EDLs, you must select
the tracks and channels you want to capture from the VTR.

To select the tracks and channels to capture:

1 To capture the video track, enable V.

2 To switch between audio tracks banks, use the Toggle Audio Tracks button.

3 To capture audio channels, enable the corresponding channel selection buttons.

Clip Input/Output Using a VTR | 171



(a) Video track enabled for capture (b) Toggle Audio Tracks button (c) Audio channels 1 and 2 enabled for capture

Audio meters display the gain level being captured. You cannot change this level during capture. You
can modify the gain of a clip once capture is complete.

HDCAM SR Double-Speed and Stereo Tape Capture (AJA-only)

Using an HDCAM SR connected to an AJA device, you can capture material from specially formatted
double-speed and stereoscopic tapes.

Double-speed tapes allows you to capture material twice as fast. Stereoscopic tapes essentially stores in an
interlaced timing two progressive clips; a 60i (50i) “clip” contains two 30p(25p) clips.

This feature does have the following limitations:
■ To use this feature, you must use specially formatted tapes. If you insert a regular tape in the HDCAM

SR and try to capture it as double-speed or stereoscopic material, the capture fails.

■ Audio monitoring is not available during capture.

■ When capturing stereo tapes, only audio channels 1 through 8 are available.

To capture material recorded at double-speed:

1 Ensure that the HDCAM SR is connected to the AJA card using a dual-link.

2 Set the HDCAM SR VTR to DBL 422.

3 From the Device Name box, select the HDCAM SR VTR.

4 From the Input Type box, select 2x-DOUBLE.

NOTE If the player displays the clip with some colour bias, it is because the player falsely interprets the 4:2:2
signal from the VTR as a 4:4:4 signal. This does not impact the capture; the stereoscopic clip will be captured
without that bias. To remove this bias, go to the Engineering menu and set the Input Connection box to
Serial 1 4:2:2.

5 Capture the clip. See Capturing Single Clips (page 167).

To capture material recorded on stereoscopic tapes:

1 Ensure that the HDCAM SR is connected to the AJA card using a dual-link.

2 Set the HDCAM SR VTR to the stereoscopic setting.

3 From the VTR Input menu, select the HDCAM SR VTR from the Device Name box.
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4 From the Input Type box, select 2x-STEREO.

NOTE If the player displays the clip with some colour bias, it is because the player falsely interprets the 4:2:2
signal from the VTR as a 4:4:4 signal. This does not impact the capture; the stereoscopic clip will be captured
without that bias. To remove this bias, go to the Engineering menu and set the Input Connection box to
Serial 1 4:2:2.

5 Capture the clip. See Capturing Single Clips (page 167).

The stereoscopic material is captured as a single, regular stereoscopic clip, with two layers, one for each
eye.

Outputting Clips To a VTR

Once you have clips that are ready for output to tape, use the VTR Output module to perform this operation.
Like capturing, you can output single clips or multiple clips, and enable a split view to preview the clip you
want to output alongside the media on the tape simultaneously.

Another way to output multiple clips is to generate an EDL and then output the clips using the EDL.

Most of the procedures in this section assume that you have already blacked your tape. However, if necessary,
you can output in assemble mode, which allows you to perform clip output to a tape that was only partially
blacked. See Outputting Clips in Assemble Mode (page 178).

Accessing the VTR Output Module

1 Select File ➤ Output to VTR... or press Shift+F9.

2 Select the clip to output from the Media Library, Ctrl+click to select multiple clips. You can also
select a folder if you wish to output multiple clips in one session.

The VTR Output module appears.

If VTR Output is not available, connect your workstation to a VTR, and configure Smoke to use the VTR.

VTR Output Menu Options

You can view the VTR Output menu in large or small format depending on which tab is selected.

When one of the Output, Audio, or Engineering tabs is selected, both the large and small formats are available.
To toggle between the large and small formats, Command-swipe the bottom of the screen.

If you are using the large Output menu with an HD clip, the menu automatically switches to the smaller
format during clip output, and then switches back when output is complete. This gives you an unobstructed
view of the clip during output.

Small VTR Output module (left portion):
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Large VTR Output module (broken into three parts):

(a) Device Name box (b) Navigation tabs (c) Video Layer field (d) Output list

(e) Current Timecode field (f) Output box

(g) Audio controls

In this documentation, the large menu is described. Differences present in the small menu are noted where
applicable.
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Device Name box Displays the options for each uncommented VTR keyword line in the software initialisation
configuration file. Select the option corresponding to the VTR to which you want to output clips.

Navigation tabs Switch between different VTR Output tabs.

To:Select:

Configure the output settings described in this section. This is the default menu.Output

Set Audio preferences. Changes are reflected in the Audio section of the Preferences
menu, and vice versa.

Audio

View the VTR Output module Engineering menu.Engineering

Output list Displays information about the clip selected for output. If there are multiple clips, you can sort
them by clicking the column headings. This changes the output sequence order. You can also edit the
Timecode field in this list.

Video Layer field Indicates the track to output in a multi-track clip. Drag the field to browse through the
video tracks and versions. This field is red when the selected track is not the top track of the selected video
version; this does not prevent output.

Emulator button Enable to use a VTR emulator.

Tape EE button When lit, indicates that the VTR is in E-to-E mode (electronic to electronic). This means
that the VTR output is showing its input signal. When E-to-E is off, the VTR shows the contents of the tape
it contains. Click this button to toggle E-to-E on and off.

Standby button When lit, indicates that the VTR is in standby mode. Click this button to toggle between
on and off.

VTR Status display Indicates the current status of the VTR.

Current Timecode field Indicates the current timecode of the tape in the VTR.

Output box Switch between insert or assemble mode. Click to perform the selected action.

Preview button Triggers a simulation of the output process. The VTR behaves as if it is inserting material,
however no material is recorded to tape.

Split View button Enable to simultaneously monitor the clip selected for output and the contents of the
tape.

Start On Timecode field A locked field indicating that clip output begins at the timecode entered in the In
Timecode field.

Stop Mode box Determines the stop mode for clip output.

To output the current clip until:Select:

A timecode on the tape is reached (indicated in the Out Timecode field).Stop On Timecode

A specified number of frames is output. When you select this option, a field appears
in which you enter the number of frames to output.

Stop After Frames

In Timecode field Indicates the timecode on the tape at which point the clip output process begins.

Out Timecode field Indicates the timecode on the tape at which point the clip output process ends.
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Duration field Indicates the duration, in timecode, between the clip output in and out points.

Offset field Indicates the offset, in timecode, by which the selected clip is output. For example, an offset of
00:00:00:05 indicates that the first five frames of the clip to be output are skipped. The first frame to be
output is frame 5 of the clip (counting frames from 0).

In/Out Point controls Use to enter, adjust, and cue the in and out points.

All Audio button Enable to output all audio channels for monitoring, even if only some audio channels
are enabled for recording to tape.

Audio Channel buttons Enable and control audio output signals.

Selecting a VTR Device For Output

The VTR devices available depend on the VTR keyword lines uncommented in the software initialisation
configuration file. Make sure the VTR you select is appropriately connected using the corresponding audio,
video, and RS-422 connections.

Smoke pre-selects a VTR with appropriate timing when entering the Output clip module.

To select the VTR device for output:

1 From the Device Name box, select a VTR device.

2 Make sure that the selected device is in Remote mode.

Outputting a Single Clip

To output a clip to a VTR, load a clip into the VTR Output module and then set the in and out points for
clip output. If necessary, enable the options to offset the start frame for output and to apply a letterbox
overlay. See VTR Output Menu Options (page 173).

If the duration marked by the in and out points that you set for output is greater than the duration of the
clip you are outputting, black frames fill the gap between the end of the clip and the out point of the clip.
For example, if you set an in point at 01:00:00:00 and an out point at 01:01:00:00, the clip output process
has a duration of one minute. If the clip you are outputting is 30 seconds long, the last 30 seconds of the
output result on tape are filled with black frames.

To output a single clip to a VTR:

1 Load the clip that you want to output into the VTR Output module. See Accessing the VTR Output
Module (page 173).

2 Make sure that the correct video track and audio channel buttons are enabled so that the corresponding
video track and audio channels are output to tape.
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(a) Video track enabled for output (b) Audio channels 1 and 2 enabled for output

3 Enable or disable All Audio in the Clip Output menu (to the left of the audio controls).

When All Audio is enabled, all audio channels are sent to the audio converter, not just the ones you
enabled in the previous step.

This means you can monitor all audio, even though you are only recording one or two tracks to the
VTR. You can also route the other audio channels to a mixer or any other device capable of capturing
an audio signal.

4 Make sure the appropriate VTR is selected in the Device Name box. See Selecting a VTR Device For
Output (page 176).

The preview window displays the contents of the tape currently in the selected VTR.

5 To preview the clip before outputting, click Preview.

6 To preview the clip you are outputting against the contents on the tape, enable Split View. See Monit-
oring Video During Clip Output (page 179).

7 To output the selected clip starting at any frame other than the first one, enter the start timecode in
the Start Offset field.

8 Set the in and out points for clip output. See Setting Input and Output In and Out Points (page 180).

9 To output the clip to the VTR, select Insert from the Output box.

The clips with Status selected are output to tape. During output, the Status column is updated to reflect
the status of each clip:

■ Pending: the clip is waiting to be output to tape.

■ Output: the clip is being output to ape.

■ Done: the clip has been ouput to tape.

10 After the transfer is complete, verify that it was successful by playing the transferred clip. To do so, cue
to the in timecode and click the Play button in the VTR Transport controls.

11 When you are done, click EXIT.

Outputting Multiple Clips

You can output more than one clip to a VTR in a single pass. When you load multiple clips into the VTR
Output module, you must define in and out points (and any other output options) for each clip before
starting the clip output process.
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When multiple clips in the same session are selected for output, the application performs a validation check
to determine if certain parameters match the project settings and whether or not the video device is capable
of outputting these clips. The following outcomes are possible:
■ If the clips have mixed timing settings, you are prompted to select which timing you want to use. Clips

having timings different from the one you select are discarded.

■ Clips with field dominance mismatch are discarded or kept, depending on your selection.

■ Clips exceeding the maximum bit depth are discarded from the selection. A selection containing 8- and
10-bit clips can be output.

■ If all the clips are discarded from the selection after the validation check, a message appears allowing
you to confirm.

If some of the clips have overlapping timecodes, their timecodes are highlighted in red in the clip list. To
fix overlapping timecodes, edit the timecodes in the clip list, or use the timecode fields in the Output tab.

To output multiple clips to VTR:

1 Load the clips that you want to output into the VTR Output module. See Accessing the VTR Output
Module (page 173).

2 If the clips have conflicting timings, you are prompted to select the timing you want to use.

Clips that do not match this timing are discarded.

3 To ouput a clip, its status field must have the selected indicator. Click the Status field to alternate
between the selected indicator and an empty field.

4 Set output options for each clip.

5 Optional: Click the column headers to sort the list. This changes the order of the output sequence.

6 To output the clip to the VTR, select Insert from the Output box.

The clips with Status selected are output to tape. During output, the Status column is updated to reflect
the status of each clip:

■ Pending: the clip is waiting to be output to tape.

■ Output: the clip is being output to tape.

■ Done: the clip has been ouput to tape.

7 After the transfer is complete, verify that it was successful by playing the transferred clips: cue to the
in timecodes and click the Play button in the VTR Transport controls. Clips that have been output are
highlighted in the clip list of the large VTR Output module.

8 When finished, click EXIT.

When outputting multiple clips with the small VTR Output module, note the following differences:
■ Use the Previous and Next buttons to navigate the clip list.

■ Once output options have been set for each clip, make sure you are viewing the first clip you want to
output.

■ When you select Insert in the Output box, the clip you are viewing, and all subsequent clips, are output
to tape. Clips that precede the clip you are viewing are not output to tape.

Outputting Clips in Assemble Mode

If you do not have time to black an entire tape, you can black a small portion of the tape and output clips
to the tape in assemble mode. In this mode, the timecode on the tape is generated by the VTR as part of the
recording process. Make sure that timecode regeneration is properly configured on the VTR. The standing
recommendation is blacking one minute at the beginning of the tape.
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If outputting a clip in assemble mode, extend the duration of the output to avoid problems when you need
to recapture the segment. For example, this can be done by adding 5 to 10 seconds of black at the beginning
and at the end of the clip, before entering the output clip module.

To output a clip in assemble mode:

1 On the VTR, set the TC generator switch to Internal and Regen to make the VTR generate the timecode.
Refer to your VTR manual for instructions on setting the TC generator.

TIP If you have just added black to your tape, the VTR should already have these settings.

2 Set clip output options. See Outputting a Single Clip (page 176).

3 With the clip you want to output in the VTR Output module, set the clip output in and out points.
See Setting Input and Output In and Out Points (page 180).

4 If black was not added at the end of the clip, make sure the out point exceeds the duration of the clip
by five to ten seconds.

5 Select the Assemble option from the Output box.

6 Click Assemble to output the clip in assemble mode.

HDCAM SR Stereo Tape Output (AJA-only)

Using an HDCAM SR connected to an AJA video device, you can output material to specially formatted
stereoscopic tapes. Stereoscopic tapes essentially stores in an interlaced timing two progressive clips; a 60i
(50i) “clip” contains two 30p(25p) clips.

To output stereoscopic material to stereoscopic tape:

1 Ensure that the HDCAM SR is connected to the output device using a dual-link.

IMPORTANT If you use an NVIDIA SDI card to output the stereoscopic material, the NVIDIA card downconverts
the material to 8-bit.

2 Set the HDCAM SR VTR to the stereoscopic setting and insert a stereoscopic tape.

3 In the application, enter the VTR Output module with a stereoscopic clip. The presence of an S in the
bottom right corner of a proxy indicates a stereoscopic clip.

NOTE You can output only clips at 23, 24, 50 or 59 fps, with a 1080i or 1080PsF resolution.

4 Output the clip. See Outputting a Single Clip (page 176).

The player in the VTR Output module displays only the left-eye layer, but the application outputs both
right- and left-eye tracks, in a 4:2:2 colour space.

Monitoring Video During Clip Output

When you output a clip to a tape that already has media on it, you can enable a split view to compare a clip
with a portion of tape, in much the same way as split view allows to compare two video segments in the
player. This can be especially useful if you are outputting a clip to seamlessly overwrite a section on the tape.

To use the split view preview option:

1 In the Output tab of the VTR Output module, enable Split.
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The Split View controls are enabled and you can view the clip that is currently set for output alongside
the content on the tape.

2 Set Split View preview options:
■ In the Split field, enter a value to set the relative position of the split.

■ From the Current Clip Display box, select an option to set the location of the current clip display.

■ From the Split Orientation box, select Horizontal Split or Vertical Split to set the Split View
orientation.

3 With Split View enabled, you can scrub the VTR to locate the frame that matches the frame of the
current clip.

4 Set the In point to the timecode of the frame on tape that corresponds to the first frame of the clip.

5 Cue to the In point. The first frame of the clip and matching frame on tape are displayed in Split View.

6 Click Play to play the tape and the clip simultaneously in Split View.

7 Click Stop, and disable Split View when you are finished.

Setting Input and Output In and Out Points

You can enter timecode values directly in the In, Out, and Dur fields to set in and out points for clip input
and output. However, there are other methods of setting the in and out points that are more convenient if
you are scrubbing the tape in the VTR to locate reference frames for clip input and output. For example, if
you output a clip to overwrite a segment on a tape, you scrub the tape to locate the frame that matches the
first frame of the clip you are outputting.

Besides the described methods of entering timecodes in the In, Out, and Dur fields, you can modify clip in
and out points or cue the VTR to these points using the following controls on the right side of the Input or
Output menu.

In button Click to set the In field to the VTR's current timecode.
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Out button Click to set the Out field to the VTR's current timecode.

+ and - buttons Click to frame-step the In or Out timecodes forward or backward. If Stop After Frames is
selected from the Stop Mode box, both the in and out points move because the duration between them is
locked.

Cue buttons Click to cue the VTR to the in or out point.

Inputting and Outputting a Live Video Signal

In the Smoke Setup application, in the VTR tab, if you enable the lines with live NTSC or live PAL, you
can capture a live video signal or crash-record a clip using the pen to start and stop the clip input or output
process.

On input, use the Live NTSC or PAL option to capture directly from a camera, VCR, or any other device that
does not support remote control via RS-422. You can also feed a live video signal from satellite or any other
broadcast source.

On output, use the Live Video option to output clips to a device that does not support remote control via
RS-422.

To input a live video signal:

1 Enter the VTR Input module.

2 From the VTR Device box, select Live NTSC or Live PAL.

The incoming live video signal appears in the preview window. The Start Mode box is unavailable.
With Live Video capture, you must use Start On Pen mode. You can use Stop On Pen or Stop On Frames
to end the capture.

NOTE When Stop On Pen is selected as the preferred capture stop mode, the out point and the duration
timecode fields are updated to reflect the longest possible duration corresponding to the full capacity of a
framestore. The capture stops either when you click anywhere on the screen or the timecode indicated is
reached, meaning that the framestore is full.

3 Set input options. For example, enter the clip name and enable the video tracks and audio channels
that you want to capture. See Inputting Clips From a VTR (page 167).

4 Make sure you are receiving the live video signal.

5 If you are capturing from a device that does not support remote control, press Play (allowing enough
time to click Process in Smoke).

6 To begin capturing, click Process.

After a moment, you are prompted to click anywhere to begin the output process.

7 Click anywhere on the screen.

8 To end capturing in Stop On Pen mode, click anywhere on the screen.

To output a live video signal:

1 Load a clip into the VTR Output module.

2 From the VTR Device box, select Live NTSC or Live PAL.
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The Start Mode box is unavailable. With Live Video output, you must use Start On Pen mode. You can
use Stop On Pen or Stop On Frames to end the output.

3 Set output options. For example, enter the clip name and enable the video tracks and audio channels
that you want to capture. See Outputting Clips To a VTR (page 173).

4 If you are outputting to a device, click Record, or take any action required to enable the device and
capture the signal being output from Smoke.

5 To begin capturing, click Process.

After a moment, you are prompted to click anywhere to begin the output process.

6 Click anywhere on the screen.

7 To end capturing in Stop On Pen mode, click anywhere on the screen.

Supported Timings and Resolutions for Video I/O

Blackmagic Design

In addition to SD timings, the following HD formats are supported by Smoke when using a Blackmagic
Design device.

NOTE Headroom in input, output, and preview, is not supported. This means that video going through the BMD
device always has luminance in legal range.

AJA

In addition to SD timings, the following HD formats are supported by Smoke. The supported input and
output formats actually available depend on the video device connected to your workstation.

Supported Frame RatesScanningResolutionFormat

50, 59.94, and 60 Fps, HzProgressive1280 x 720720p

25, 29.97, and 30 Fps, HzInterlaced1920 x 10801080i

23.976, 24, 25, 29.97, 30, 50, 59.94, and
60 Fps, Hz

Progressive1920 x 10801080p

23.976, 24, 25, 29.97, and 30 Fps, HzProgressive1920 x 10801080PsF

Generating Proxies from VTR Input

With sufficient processing power, proxies are generated in real time. Otherwise, this occurs as a post-process.
To achieve better performance, or to use higher quality proxy types, you might want to perform clip input
without proxy generation, then edit project settings to generate proxies overnight.

The following guidelines refer to working on projects set to generate proxies.

You may create projects with proxy management options set to generate proxies for HD clips. If your hardware
configuration supports on-the-fly proxy generation, your clips are captured and proxies are generated as
part of the real-time input process. Otherwise, you may be required to wait for proxy generation once the
capture process itself is complete.
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If you are capturing many clips one-at-a-time, you may want to turn off proxy generation for you project.
That way, you can capture your clips without having to wait for proxy generation.

Once you have completed the capture process, turn proxy generation back on. If you have captured many
clips, this process could take a long time. You may want to do this when you can leave the workstation
unattended, for example, overnight.

Capturing Material with Variable Frame Rate

To perform frame-accurate video input and output using Panasonic® variable frame rate VTR decks, you
must use the following firmware versions:
■ AJ-HD3700H D5-HD deck:

SYSCON: 1.04 or later

AV: 0.21 or later

FRONT: 0.13 or later

■ AJ-HD1200A DVCPRO HD deck:

SYSIF: 1.30 or later

AVDV: 1.39 or later

SERVO: 1.22 or later

Regular video input and output is not affected by a firmware version.

NOTE Refer to your Panasonic documentation for information on verifying the firmware version.

To capture material from a Varicam device:

1 Ensure your devices are properly connected and the corresponding VTR keywords are enabled in the
software initialization configuration file. See Configuring Software For Clip Input and Output Using a
VTR (page 166).

2 Open the VTR Input module. See Accessing the VTR Input Module (page 167).

3 From the Device Name box, select a video device, supporting variable frame rate (for example, one of
the following options: VTR DVCProHD 720 59p or VTR DVCProHD 720 60p).

4 Enter the Engineering menu and enable Varicam (on the right side).

5 Make sure the Video Input Delay is set to zero or a positive value (negative video input delay is not
supported on Varicam capture).

6 From the Timecode Mode box, select the required timecode.

Clip Input/Output Using a VTR | 183



7 Exit the Engineering menu and click Process.

Smoke removes the redundant frames so that the frame rate of the captured clip corresponds to the
frame rate of the project. You can monitor the process using the VTR Status display. The Current Frame
Rate field is updated depending on the frame rate of the captured material.

(a) Current Frame Rate field

NOTE When performing operations in Varicam mode, audio/video synchronization largely depends on frame rate
compatibility and can be guaranteed only if the following conditions are observed: (1) Material shot at 24 fps and
captured into a 24 fps project (2) Material shot at 30 fps and captured into a 30 fps project (3) Material shot at
60 fps and captured into a 60 fps project.

Controlling a VTR

The RS-422 serial connection between the VTR and your workstation enables full remote control of the
device from Smoke. Connected VTR devices send their current status to Smoke, and this status is displayed
in the VTR Input and VTR Output modules.

Verifying the VTR Status

The following illustration shows a VTR status display.

(a) VTR Status (b) VTR Timing (c) Colour Space (d) Bit Precision (e) Control Mode (f) Audio Sample Rate (g) Audio
Input/Output Type

Other VTR status values include.

Indicates:VTR field:

Play, Play Lock, Stop, Jog, Fast Forward (FFW), Rewind (RWD), 3x, 4x, 8x, 15x, 30x.
When the field is blank the VTR is disengaged.

VTR Status

The video timing currently configured on the video device.VTR Timing

The colour space conversion method for both input and output of clips.Colour Space

184 | Chapter 6   Importing and Exporting Media



Indicates:VTR field:

Whether the VTR is in Local or Remote control mode. Local appears in yellow when the
VTR is in Local mode. In Local mode, the VTR cannot be controlled from Smoke. You

Control Mode (LOCAL, REMOTE,
or REC INHIBIT)

can switch the VTR between Local and Remote mode only on the VTR. Rec Inhibit implies
REMOTE mode, but you cannot output to the tape.

The audio sampling rate when you input or output from the VTR.Audio Sample Rate

The source audio interface type when inputting and the destination audio interface
type when outputting.

Audio Input/Output Type

The accuracy used (SDI bit depth) when transferring data. This cannot be changed.Bit Precision

Using the VTR Transport Controls

The current frame on the cassette in the VTR appears in the image window and the Current Timecode field
(the uppermost timecode field in the Clip Input and Output menus) displays the timecode of the current
frame.

(a) Current Timecode field

Use the following VTR Transport controls to play the VTR.

NOTE The VTR must be in Remote mode to use the VTR Transport controls.

Hotkey:To:Click:

Shift+CRewind the tape.

CPlay the tape backward.

left arrow key (down arrow key for
-10 frames)

Move backward one frame. Hold down to slowly jog
backward.

spacebarStop the tape.

right arrow key (up arrow key for
+10 frames)

Move forward one frame. Hold down to slowly jog
forward.

VPlay the tape forward.
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Hotkey:To:Click:

Shift+VFast-forward the tape.

noneEject the tape.

You can also shuttle the VTR by dragging the cursor in the image window. Place the cursor on the image,
press the pen or mouse button, and drag the cursor to the right to shuttle forward and to the left to shuttle
backward. The farther away you move the cursor horizontally from the middle of the image, the faster the
speed.

You can also change the reverse or forward playback speed by pressing the Up or DownarrowKeys on your
keyboard. Each press reduces or increases the speed by two.

Audio Gain Adjustment Settings

Audio gain adjustment is a part of the clip output process only. The clips you are outputting are unaffected
by audio gain adjustments made using the VTR Output module.

On output, you can adjust the audio gain, for example, to restore the levels you had monitored on capture.

(a) Audio Tracks Toggle button (b) Channel Selection buttons and indicators (c) Audio Level fields (d) Fader Lock buttons

All Audio button When enabled, outputs to the audio monitor every audio channels. When disabled,
outputs only the enabled audio channels to the audio monitor. The All Audio button has no impact on the
audio tracks recorded by the VTR.

Audio Tracks Toggle button Toggles the Channel Selection buttons and indicators between audio tracks
1-8 and 9-16.

Channel Selection buttons and indicators Controls and displays which audio channels are recorded by
the VTR. The black boxes with the green LEDs indicate video tracks and audio channels that are part of the
clip that you want to output. The red buttons indicate the tracks and channels the VTR records on output.

Audio Level fields Displays the audio gain, in decibels. Adjust using the faders. In the small VTR Output
module, increase or decrease the gain by dragging left or right on the fields. By default, audio gain is 0 db.

Fader Lock buttons When enabled, locks the faders for the corresponding pair of audio channels together.
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Adjusting Audio Gain on Clip Output

To adjust the audio gain on output clip:

1 Enable the Fader Lock buttons (so that they are light grey) if you want to apply the identical value to
pairs of audio channels.

2 Slide the faders to adjust the audio gain before you start processing. Use the All Audio button to monitor
all the audio tracks that are output, regardless of what audio tracks the VTR records.

3 In the VTR Output module, enable Output All Audio.

4 Select or deselect channels for output by clicking the Channel Selection button for each channel as
needed.

NOTE In a multiple clip selection, channel selection is independent for each clip but the gain levels set with
the faders are the same for all clips.

5 Process the clip.

Selected channels are output.

Setting Video Input and Output Engineering Menu Controls

Clip input and output engineering options include video I/O settings such as pre-roll, post-roll, play delay,
colour space conversion, and settings that define the process by which YUV video material on a tape is
converted to the RGB format used by Smoke, and vice-versa.

To change the default Engineering menu settings for a VTR device, edit the VTR configuration files using
the provided Smoke Setup utility available in the folder Applications ➤ Autodesk ➤ Smoke ➤ Utilities.

When you start Smoke and set the video I/O timing for your project, enabled VTR devices are initialized,
and the settings in the Engineering menu are populated accordingly. However, if necessary, you can modify
these settings on a session-to-session basis.

To open the Engineering menu:

1 From the VTR Input module, click Eng, or from the VTR Output module, click the Engineering tab, to
open the Engineering menu.

Engineering Menu Options

Consult the following illustration (broken into three parts) and explanations of the options in the Engineering
menu. These illustrations are of the VTR Input Engineering menu. The VTR Clip Engineering menu contains
a subset of these controls.
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(a) Device Name box (b) Video I/O Timing box (c) Precision box (d) Timecode Source box (e) Input and Output
Connection boxes (f) Colour Space box (g) Output Sync box (h) VTR Current Timecode field (i) PreRoll/PostRoll fields
(j) Cue Up box (k) Error Retry field (l) Proxy Box

Device name box The Device Name box differentiates between 3G and non-3G capable VTR and provides
an option for each enabled VTR in the Smoke Setup application. To modify settings for a specific VTR device,
select the corresponding option from this box.

Video I/O Timing box Provides video timing options (resolution and frame rate) corresponding to different
video formats supported by the video input/output board of the system.

Precision box Determines the video interface precision, or SDI bit depth used. This value cannot be changed.

Audio Preferences button Click to view the Audio Preferences menu.

Timecode Source box Determines which type of timecode is obtained from the VTR device. Timecode VITC
& LTC is the default, and recommended option. You should only have to switch to Timecode VITC or
Timecode LTC if one of the timecode tracks is corrupted.

To obtain:Select:

Vertical interval timecode (VITC).Timecode VITC

Longitudinal timecode (LTC).Timecode LTC

Both types of timecode. At normal playback speed, Smoke obtains LTC, but switched

to VITC when the tape is rewinding, fast-forwarding, or otherwise moving at a non-

playback speed.

Timecode VITC & LTC

Input and Output Connection boxes These boxes determine the connection by which the video signal is
transferred. This box is automatically set to reflect the selected VTR. 3G is only supported with AJA devices.
■ In Serial 1 3G / Out serial 1 3G: The video signal is transferred through one SDI 3G link. This is the only

available option when you use a 3G VTR. The VTR Status field indicates any conversion that might
happen because of the sampling used, 4:2:2 (conversion YCbCr <-> RGB) or 4:4:4 (no conversion RGB
<-> RGB).
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■ In serial Dual 444 / Out serial Dual 444: The video signal is transferred through dual SDI links; one video
field is sent through one SDI cable, the other field through the other cable.

■ In Serial 1 4:2:2 / Out serial 422: Traditional VTR, single-SDI connection.

Colour Space box Determines the YCrCb colour space conversion method. Headroom is only supported
with AJA devices.

To perform clip I/O with:Select:

A standard YCrCb-RGB conversion process that clips superblack and superwhite luma

(Y). Use this option for typical clip I/O processes with VTR devices.

YCrCb->RGB

A YCrCb-RGB conversion process that preserves superblack and superwhite colour in-

formation. Use this option when inputting or outputting greyscale mattes or other

clips where preserving extremes in the luma channel is required.

YCrCb->RGB + Headroom

This is available when using dual link for RGB input and output. Video black and white

levels on the SDI stream are mapped to black and white values in RGB on the

framestore.

Use this option in conjunction with 4:2:2 input and output connections to input and

output 4:4:4 video using dual-links (4:2:2 and 0:2:2).

No Conversion

Also available when using dual link for RGB input and output. This mode uses all levels

available and preserves all but a few RGB values.

Use this option with the 4:4:4 input and output connections to input clips from and

output clips to a Telecine.

No Conversion + Headroom

Output Sync box Determines the output sync reference source. The reference signal may originate from
several different sources. Select the source you are using from this box according to the following table.

Description:Available on:Source type

A centralized analogue reference signal, originating from a

sync generator, sent to the genlock port on the video board

or VBOB.

All systemsHouse

Same as Digital, except you can choose between two inputs:

Digital 1 or Digital 2. On the HP 8400 with the AJA SD (OEM-

LH) video board, only Digital 1 is available.

Most HP® 8400s and all HP 8600s

and 9400s

Digital 1 and Digital 2

The reference signal generated internally by the Smoke

workstation.

All systemsStandalone

PreRoll field Indicates the pre-roll, in frames.

PostRoll field Indicates the post-roll, in frames.

Video Input Delay field Indicates the video delay on input, in frames. If this value is incorrect, the result
clip when you click Frame Grab in the VTR Input module does not match the frame you see in the preview
window.
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Video Output Delay field Indicates the video delay on output, in frames. If this value is incorrect, the clip
you output does not get recorded to the proper place on the tape.

Audio Input Delay field Indicates the video delay on input, in frames.

Audio Output Delay field Indicates the video delay on output, in frames.

Stop VTR on EXIT button When enabled, sends a stop command to the VTR when you exit the Input Clip,
Output Clip, Auto-Capture, or Archiving menu. For example, if the VTR is playing a clip, or if it is cueing
to an in point, the transport operation in-progress is interrupted.

Cue Up box Determines the speed of the cueing process.

To cue up the VTR:Select:

Using the internal cueing algorithm of the VTR.Cue Up VTR

Using Smoke. Use this option if Cue Up VTR is too slow for far cue points, such as

on the betacam SP.

Cue Up Fast Forward

Error Retry field Indicates the number of times Smoke retries failed input or output processes.

2:3 Removal/Insertion button Enables automatic, real-time 2:3 removal on output and insertion on input.
This is only available when the VTR is set to 29.97i or 59.94i.

Edit Sync Creation button Automatically create edit sync groups for clips with audio channels on input.

Proxy box Determines proxy management when inputting clips.

To generate:Select:

Proxies as a post-processing stepProxy in Post

Proxies during captureProxy on Capture

Generating proxy during capture is the quickest method. Depending on hardware configuration of your
system, capture may be performed in real time with playback. Some extra required processing, however,
may prevent the graphics board from updating the image window and broadcast monitor in real time, so
you may not be able to view the clip being played as it is captured.

Monitor box Set this to Monitor VTR or Monitor Output. In Monitor VTR mode, the signal coming back
from the VTR is displayed, and video may be appear to be late compared to the audio. In Monitor Output
mode, the signal being output to tape is displayed, and the video and audio should be in sync.

Dual Image Resizing Filter box Select the resize algorithm used to scale back to full resolution clips captured
using the Dual Image - Scale resolution. Ordered from lowest quality (Triangle) to highest (Lanczos). On
some lower-end workstation, you might need to select a lower quality algorithm to capture every frame.

Inputting and Outputting with Headroom

NOTE Headroom in input, output, and preview, is not supported on Blackmagic Design devices, on on AJA ones.
This means that video going through the BMD device always has luminance in legal range.

With 4:2:2 serial digital interface (SDI) input and output connections, the colour components of video
signals are Y (luma), Cb (blue colour difference), and Cr (red colour difference). For standard video signals
in 10 bits, black has a luma value of 64 and white has a luma value of 940. When performing standard

190 | Chapter 6   Importing and Exporting Media



captures to RGB values on Smoke systems, black YCbCr (64,512,512) maps to RGB (0,0,0) and white YCbCr
(940,512,512) maps to RGB (1023,1023,1023). SDI values 0 to 3 and 1020 to 1023 are reserved values for
synchronization purposes.

Some cameras record shadow details below the video luma black value of 64 and white detail above the
video luma white value of 940. These details are called super blacks and super whites. These are also referred
to as “headroom” and “footroom.” Under normal circumstances, headroom is not converted during capture,
and the super black and super white details are lost, as described in the following illustration:

Using the YCbCr<->RGB with headroom colour space option during input on Smoke systems, it is possible
to capture these super black and super white values. In this case, video black YCbCr (64,512,512) maps to
RGB (64,64,64) in 10 bits, and video white YCbCr (940,512,512) maps to RGB (940,940,940). YCbCr Luma
values between 4 and 64 and between 940 and 1019 are converted to RGB on capture. While this gives you
the advantage of being able to capture super black and super white values, it also means that video black
will not map to full black in RGB, and video white will not map to full white in RGB. The following image
illustrates this:
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For 4:4:4 RGB standard input and output, a similar explanation applies. On capture using the No Conversion
setting, RGB 4:4:4 SDI video black at value (64,64,64) maps to RGB (0,0,0), and RGB 4:4:4 SDI video white
at value (940,940,940) maps to RGB (1023,1023,1023).

With the No Conversion with Headroom option, the maximum possible SDI value range is used. RGB 4:4:4
SDI values ranging from (4,4,4) to (1019,1019,1019) map to the same RGB range on capture.

Enabling Colour Space Conversion on Clip Input

Although the preceding descriptions relate to capture from SDI to the framestore, the reverse applies when
outputting from the framestore to SDI.

To enable colour space conversion on clip input:

1 In the VTR Input module, click Engineering.

The Engineering menu appears.

(a) Input Connection box (b) Colour Space box

2 From the Input Connection box, select the input connection.

3 From the Colour Space box, select YCbCr->RGB+Headroom.

4 Capture the material.

Material is captured with headroom and footroom.
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To enable colour space conversion on clip output:

1 Open the clip library with the clip(s) you want to output.

2 Click Output Clip and prepare output clip settings. See Outputting Clips To a VTR (page 173).

3 In the VTR Output module, click Engineering.

4 In the Engineering menu, select the output connection from the Output Connection box.

5 From the Colour Space box, select YCbCr->RGB+Headroom.

6 Output the material.

Material is output with headroom and footroom.

Capturing 60i Material with 2:3 Pulldown Removal

Using the VTR Input module, you can capture 30 fps film-based material and convert it to 24 fps material
in real-time as you capture. The procedure for enabling automatic 2:3 removal differs depending on whether
your tape uses non-drop or drop 60i timecode.

To capture 60i material with 2:3 pulldown removal:

1 Set up your capture.

2 In the VTR Input module, click Eng.

The Engineering menu appears. It contains options for removing 2:3 pulldown in real time while
capturing.

(a) 2:3 Removal button (b) 24>DF Reference field (c) AA Reference field

3 Enable 2:3 Removal.

4 In the AA Reference field, enter a timecode that corresponds with an AA frame on the tape that is
currently in the VTR.

TIP To determine an AA frame, frame-step (Right arrow) the tape and look closely at each frame. In 2:3
pulldown, two jitter frames with field artefacts are followed by three normal frames. The second frame after
the two jitter frames is an AA frame.

5 When you capture material from a tape that uses 30 fps drop-frame timecode with 2:3 removal enabled,
a slight discrepancy between timecodes is introduced due to the reference timecode used to determine
the 30 drop frame to 24 timecode conversion. To optimize correspondence between the timecodes,
enter the timecode in the 24 >DF Reference field that matches the start reel timecode for the tape.

TIP The start clip timecode can be deduced from the hour-mark of the timecode used by your clips. For
example, 1;00;00;00 drop-frame would require a 1;00;00;00 value in the 24p>DF reference field to get a
clip starting at 01;00;00+00.

6 Make sure the project's field dominance is set to field1. If the project's field dominance is set to field
2, you must switch the field dominance back to field 1.
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7 Click EXIT to return to the VTR Input module.

8 Using the In and Out timecode fields, set the in and out points for the capture session.

(a) In and Out timecode fields (b) 2:3 In and Out pulldown display

With the in and out timecodes set, the corresponding 2:3 pulldown frame is indicated in the In and
Out 2:3 pulldown display. Use the 2:3 Pulldown display to determine the 24 fps result in and out
frames.

24 fps Result Frame2:3 Pulldown Frame

In/Out AIn/Out AA

In/Out BIn/Out BB

In/Out DIn/Out DD

In CIn BC

In DIn CD

Out COut CD

9 Click Process to capture the material with 2:3 pulldown removal.
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Archiving in Smoke

Archiving in Smoke saves your media and project setups on external storage devices or in a filesystem. This frees up space
for new projects. It is also a convenient way to store your projects offline in a fully restorable form.

A project archive includes all of a project's Media panel content, including the Media library.

Or you can archive individual clips from the Media panel.

Choosing a Medium for Archiving

Choosing a medium or device for your archiving needs largely depends on your technical resources and overall needs.
There are certain advantages and disadvantages to using each medium/device.

Flame can read and write archives from the following devices: file systems, VTRs, and tape drives.

Smoke can read and write archives from filesystems. While Smoke can read VTR archives, it cannot write to them.

Filesystem Archive

A filesystem archive is an archive stored on a hard disk drive, such as external USB/FireWire® (IEEE 1394) hard drives
offers, or networked storage such as a SAN. The device can use any of the formats supported by your workstation, usually
ext2 or ext3 for Linux, and HFS+ for Mac. NTFS is not supported.

Using a filesystem to archive your material provides the quickest method of archiving and restoring your material, and
offers full support for mixed-resolution projects.

VTRs

NOTE Smoke only reads VTR archives.

You can use a VTR to archive your material. However, they do have limitations. As a long-term archiving medium, VTR
tapes are subject to physical deterioration and format obsolescence. Also, the following clips cannot be archived to a VTR:
■ Clips with a colour depth higher than 10-bit

■ Clips referencing media, either directly or through clip history, with a resolution that does not match that of the VTR

You can use the following VTRs for archiving your material in Smoke:
■ Uncompressed SD VTRs such as D-1 or lightly compressed SD VTRs such as Digital Betacam

■ Uncompressed HD VTRs or lightly compressed HD VTRs such as Sony HDCAM SR or Panasonic HD D5

■ Compressed HD VTRs such as Sony HDCAM (using "HDCAM" rather than "VTR" as the archive device type)

7
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Archiving a Project to a File-based Archive
Archiving a project to a file archive (as opposed to a VTR tape archive) consists of opening an existing archive
file, or creating a new archive file, on storage such as an external hard drive.

To archive a project to a new archive:

1 In the MediaHub, enable Browse for Archives.

2 In the Local Devices list, navigate to the location where you want to store the archive.

This can be a local or remote location.

3 Click New Archive.

4 In the New Archive Creation, enter the required information and click Create.

Smoke creates and opens the archive. You can now archive the project.

5 Set as required the options displayed in the Archive Options tab.

6 Click Archive Project.

Smoke starts archiving the project. The actual duration of the archive process depends on the size of
the project and on the options you enabled or disabled. To cancel the process, click anywhere on the
screen; you cannot use the application for anything else while Smoke archives your project.

7 Click Close Archive to finalize the archive.

To add a project to an existing archive:

1 In the MediaHub, enable Browse for Archives.

2 In the Archives list, double-click the archive to open.

3 Set as required the options displayed in the Archive Options tab.

4 Click Archive Project.

Smoke starts archiving the project. The actual duration of the archive process depends on the size of
the project and on the options you enabled or disabled. You can cancel the process at any time by
clicking anywhere on the screen; you cannot use the application for anything else while Smoke archives
your project.

5 Click Close Archive to finalize the archive.

Restoring a Project from a File-based Archive
You can only perform the complete project restoration described below if the project to restore does not
already exist on the workstation. You can see a list of all the projects in MediaHub ➤ Projects ➤ Local
Projects.

You can delete projects from File ➤ Project and User Settings.

And even if the project exists on your workstation, you can always restore manually selected clips from the
project archive.

To restore a project from a file archive:

1 In the MediaHub, enable Browse for Archives.

2 From the Archives list, double-click the archive to open it.

3 Navigate the archive, and select the project to restore. Projects are usually created at the root of an
archive file.
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4 Click Restore Project.

Smoke starts restoring the project. The actual duration of the archive process depends on the size of
the project. You can cancel the process at any time by clicking anywhere on the screen: you cannot
use the application for anything else while Smoke restores your project. Once restored, you can access
the project through File ➤ Project and User Settings.

Archiving Clips to a File-based Archive
Archiving clips to a file archive (as opposed to a VTR tape archive) consists of opening an existing archive
file, or creating a new archive file, on storage such as an external hard drive.

To create a new archive and archive material:

1 In the MediaHub, enable Browse for Archive.

2 In the Local Devices list, navigate to the location where you want to store the archive.

3 Click New Archive, and enter the required information.

4 Click Create.

Smoke creates and opens the archive, ready for you to use.

5 Set as required the Archive Options.

6 Drag and drop clips and folders to archive from the Media panel to the archive.

NOTE What you add to the archive appears greyed out in the archive, indicating that it is yet to be committed
to the archive: ready to be archived, but not yet copied to the archive. The Pending Archive folder can also
be used as a summary of what is being archived.

7 Click Archive to start the archiving process.

The actual duration of the archive process depends on the size of the material being archived and on
the options you enabled. You cannot use the application for anything else while Smoke archives the
material. Cancel the process at any time by clicking anywhere on the screen.

To add material to an existing archive:

1 In the MediaHub, enable Browse for Archive.

2 In the Archives list, double-click the archive to use for archiving.

3 Drag and drop clips and folders to archive from the Media panel to the archive.

NOTE What you add to the archive appears greyed out in the archive, indicating that it is yet to be committed
to the archive: ready to be archived, but not yet copied to the archive. The Pending Archive folder can also
be used as a summary of what is being archived.

4 Click Archive to start the archiving process.

The actual duration of the archive process depends on the size of the material being archived and on
the options you enabled. You cannot use the application for anything else while Smoke archives the
material. Cancel the process at any time by clicking anywhere on the screen.

Restoring Material from a File-based Archive
To restore material from an archive:

1 In the MediaHub, enable Browse for Archive.
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2 In the Archives list, double-click the archive that contains the material to restore.

3 Drag and drop clips and folders from the archive to the Media panel.

NOTE Material you drag and drop does not appear in the Media panel until you click Restore. Use the
Pending Restore folder to view what will get restored.

4 Click Restore.

The length of the restoration process depends on the size of the material being restored. You cannot
use the application for anything else while Smoke restores the material. Cancel the process at any time
by clicking anywhere in the MediaHub.

Tips for Organizing Archives
Although the way you organize your archives is a matter of personal preference, the following guidelines
may be helpful:
■ After you have processed a clip, remove any material that you are no longer using before you create your

archive.

■ Try to keep your libraries clean at all times. Remove clips that are no longer being used or earlier unused
versions of your work.

■ Use a consistent and clear naming technique so that you can easily find your material when you want
to create or open an archive.

■ Consolidate clips before archiving in order to save space.

About VTR Archives

NOTE Smoke can only read VTR archives, it cannot create nor write to VTR archives.

You can create a VTR archive for clips of any resolution supported by your video board and VTR device. To
archive and restore from a VTR archive, your clips FPS, resolution and bit depth need to match your VTR
tape device settings.

When you change projects without exiting Smoke, the video timing selected at start-up applies to the project
you are switching to.

Header Information Slate

All VTR archives contain a Header Info Slate, which is a single frame providing information about the archive.
Located in the archive before the table of contents, the Header Info Slate provides information such as:
■ Name of the archive

■ Name of the Online Table of Contents (OTOC)

■ Name of the workstation where the archive was created and name and version of the Autodesk application
used for archive creation

■ Start timecode

■ Creation date and time

■ Modification date and time

■ Minimum size of the clip library buffer (in MB) required to restore the archive
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(a) Header Info Slate example

Configuring a VTR for Archiving

Before you start archiving to a VTR, configure both the hardware and the software.

Also make sure that the video hardware and application match the FPS, resolution, and bit depth of the
clips, or project, you are archiving.

Hardware Configuration

■ Your VTR device is properly connected to video and audio sources and RS-422.

■ The sync is properly set up.

Software Configuration

To enable Smoke to read VTR archives:

1 With Smoke closed, open the Smoke Setup application.

Finder ➤ Applications ➤ Autodesk ➤ Smoke ➤ Utilities

2 Open the VTR tab.

3 Enable every VTR you plan on using with Smoke.

4 Set VTR Archive Restore Device to VTR unless you plan on using an HDCAM VTR to restore archives,
in which case you would select HDCAM. For HDCAM SR, you must select VTR.

NOTE You can only restore an HDCAM-created archive by using an HDCAM VTR.

5 Click Apply.

You can now restart Smoke and read archives from the connected VTR. Remember: Smoke cannot
archive to a VTR.

About Using an HDCAM SR for Archiving

The HDCAM SR device supports 4:2:2 and 4:4:4 archiving. The options required in the Engineering menu
are as follows.

ColourspaceInput and Output Connection

YCrCb-->RGBIn Serial 4:2:2 / Out Serial 4:2:2

No ConversionIn Serial Dual 4:4:4 / Out serial Dual 4:4:4
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When you switch between 4:2:2 and 4:4:4 options, the Colourspace option changes automatically to ensure
the proper settings.

Restoring Material from a VTR Archive

NOTE Smoke can only read VTR archives.

NOTE When you open a VTR archive in read/write mode, Smoke performs an auto-test. The auto-test involves
checking whether it can write, read, and verify the integrity of the archived material. This auto-test also scans
binary and play/record delay information to verify the quality and accuracy of the video signal.

1 Insert the archive tape in the VTR.

2 In Smoke, select MediaHub ➤ Browse for Arcives.

3 Select the VTR from the list of Local Devices.

4 Select the start timecode by doing one of the following:
■ Select Autostart if you selected this option when you created the archive (the archive rewinds the

tape to find the correct start timecode).

■ Select Manual Start and enter the appropriate timecode if you selected this option when you created
the archive.

5 Do one of the following:
■ Click Open Archive. Select Open Read/Write or Open Read Only from the Open Mode box.

NOTE When you try to open a VTR archive in read/write mode, Smoke checks for machine errors (for
example, dirty heads). If a problem is detected, the archive does not open. If the tape is write-protected,
the archive opens in read-only mode.

■ Click the Open Using OTOC button and select the OTOC in the file browser. You are given the
option to read slates from the tape. Answer 'Y' if you wish to see clip proxies.

The Smoke cues the VTR. Once it's done reading the archive, displays its contents in the MediaHub.

6 Restore clips one by one using drag and drop, or click Restore Project to restore a full project.

7 Click Close Archive once you are done.

Archiving to Multiple Volumes
If the items you select for archiving exceed the capacity of the archiving device, Smoke splits the archive
across multiple devices of the same type. The splitting of archives is seamless and virtually transparent to
the archiving process.

The procedure for creating a multiple tape archive (an archive that is too large for a single tape) is almost
the same as for creating an archive on a single tape. If the entries selected for archiving exceed the capacity
of the tape, a message appears indicating that the archive requires multiple tapes. The archiving process
begins for the first tape. When the first tape is full, you are prompted to insert a second tape. Insert and
format this tape and continue with the archiving. This process continues for as many tapes as are required.

Opening Multi-Tape Archives

NOTE Smoke for Mac OS X only restore VTR archives.
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When creating large archives, you can use multiple volumes to store one archive. By splitting the contents
of one archive onto separate tapes, you can keep similar types of material together in the same archive.

You can open material on any tape in a multiple tape archive but you need the last tape in the multiple
tape archive sequence. The last tape contains necessary header information for locating the material you
want to restore.

To open material from a multi-tape archive:

1 Insert the last tape in the VTR.

2 In the MediaHub, browse for Archives.

3 Select the VTR from the list of Local Devices.

4 Click Open Archive.

5 Follow the instruction.

You can now restore a project or any part of the archived material.

Supplementing Archives with System Drive Backups
The recommended backup strategy for your Smoke workstation is to archive project media and setups to an
archive that can be saved to a remote file server or storage device. Do this as often as necessary to protect
your media from storage or system failure.

The archiving approach, however, does not protect the data contained on your workstation's system drive.
The system drive should not contain any media data, but it does include important project management
data. In the event of hardware failure without a system drive backup, you will need to recreate this project
data for each archive you restore. This can be a time-consuming and frustrating process, and is a significant
issue in large SAN environments, where large quantities of media files are referenced from a shared standard
FS volume. In such environments, consider using the data backup method of your choice to save key system
drive information. This will facilitate restoration of multiple project archives.

Even with a system drive backup, you will still need to reinstall your software and restore archived projects
in the event of a system drive failure.

There are several methods and commercial tools available for backing up system drives. Choose the method
and tool that is right for you. Autodesk does not recommend any particular method or tool, and only presents
the directories of note that you should consider backing up. Depending on your requirements and available
tools, you may decide to back up your full system drive or only the following critical files or directories.

Consequence of failure if system drive is
not backed up

PurposeFile/directory

Metadata will have to be recreated for each valid
archive that is restored.

Contains all clip metadata./usr/discreet/clip

Project settings will have to be recreated for each
valid archive that is restored.

Contains full project structures, including
settings such as names, resolutions, user
information, and so on.

/usr/discreet/project

Media on a shared SAN volume will have to be
re-imported.

Contains the standard FS links database./usr/discreet/sw/swdb
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Consequence of failure if system drive is
not backed up

PurposeFile/directory

Storage and Wire settings will have to be recon-
figured after installation.

Contains all Stone® and Wire software
and configuration files, including the
preceding directory, swdb.

/usr/discreet/sw

See consequences for all previous items. Back up
this directory if you want to be sure to restore

Contains your product software, as well
as all other directories described in this
table.

/usr/discreet

all critical data, and do not mind including some
superfluous files (such as old unused versions of
the application.)

Browsing an Archive Offline

Each archive includes a header file, which is located at the beginning of the archive and contains the metadata
necessary for properly restoring the archive. When you create an archive, two versions of the same table of
contents are created: one as an ASCII file, and another as an HTML one. Created by default in
/usr/discreet/archive, and displayed in the list of Archives in MediaHub ➤ Browse for Archives,
they can be used in cases where the header information becomes corrupted.

You can view the table of contents with the ASCII or HTML TOC.

To view the contents of an archive using its HTML TOC:

1 Open MediaHub ➤ Browse for Archives.

2 Select the archive you want to view from the the Archives list.

3 Click View Content.

A Web browser opens the HTML TOC, allowing you to browse the contents of the archive without
actually opeing it.

To view contents of an archive using its ASCII TOC:

1 Open the ASCII version of the table of contents using a text editor to view the contents of an archive
without opening it. ASCII TOC filenames have the following format:

<archive name>_<creation date>.atoc

MeaningCode

ProjectP

Project setupsS

Workspace or Shared folderW

Desktop snapshotsX

FolderL

ReelR
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MeaningCode

ClipC

Source clipE

Media libraryM

Batch snapshotsB

Snapshot folderF

DesktopD

Online Tables of Contents

The table of contents lists the contents of the archive, as well as information such as the order in which
clips are assembled on the archive, clip IDs, transitions, and timecodes. When you restore an archive with
the table of contents, Smoke uses this information to restore the material.

A copy of the table of contents is saved in the filesystem. This copy is referred to as the Online Table of
Contents (OTOC). You can open an archive in read-only mode using the OTOC. In read-only mode, you
can load but not save or delete entries from the archive. With VTR archives, you can open an archive in
read-write mode using the OTOC, and save and delete entries from the archive.

The OTOC is useful for:
■ Recovering material in an archive when the table of contents on the medium is corrupted.

■ Viewing the contents of an archive without opening it, which is often faster than actually opening the
archive.

When an OTOC is created, Smoke creates an ASCII text copy of it (ATOC) as well as an HTML and XML
copy. Use the ASCII and HTML copies to view the contents of an archive without opening it. For example,
use them to view the contents of a VTR archive without connecting to the VTR.

Use the XML TOC to easily populate a database with information about your archives.

The OTOC, ATOC, HTML, and XML table of contents are saved by default to /usr/discreet/archive. Or
define the location by adding the following token to the init.cfg file:

ArchiveLibrary<directory>

where <directory> is the location for storing your archives.

The OTOC is updated each time you close the archive.
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Deleting Tables of Contents

To prevent the loss of important data, Smoke never overwrites the previously created tables of contents. If
the archive becomes obsolete or if you are sure that older versions of an archive OTOCs are obsolete, you
can delete tables of contents. The following name formats are used for the tables of contents.

FormatType

<archive name>_<creation date>.otoc
<archive name>_<creation date>.otocx

Online (two files)

<archive name>_<creation date>.atocASCII

<archive name>_<creation_date>.xmlXML

<archive name>_<creation_date>.html
<archive name>_<creation_date>/*

HTML (two or more files)

where <archive name> is the name that you type in the Name field when you create the archive.

Recovering a Corrupted Archive

If the table of contents of an archive on tape is corrupted, Smoke may not be able to read it. If this happens,
open the archive using the OTOC.

Once you open the archive, you can restore the entire contents of the archive and save it to a new tape. Do
this, for example, if the tape has been damaged.

For VTR archives, you can also overwrite the corrupted table of contents by saving a single frame to the
archive. If the table of contents is successfully overwritten, you can open the archive using the Open button.

To restore the archive:

1 Open the archive.

If the table of contents is corrupted, the following message appears:

CLIP MGT: Warning! Cannot read archive header. Select online TOC?

2 Click Confirm to open the OTOC.

The file browser appears.

3 Select the OTOC for the archive you are trying to open and click Confirm.

4 If the archive is on a VTR, a prompt asks if you wish to retrieve the slates (proxies).

After a moment, the archive appears.

NOTE When you open an archive with the OTOC, proxies only appear if the archive is on a VTR, and you
answered Yes to the prompt. For all other types of archives, proxies appear as black images.

5 Select the entire contents of the archive. Make sure you have sufficient space on your storage for the
contents of the archive.

6 Click Restore.

7 When the restore is complete, click Close.

The restored clips appear in the selected clip library.
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8 Re-archive the material onto a new tape.

Restoring Legacy Archives
In earlier versions of Inferno, Flame, and Smoke, archives did not include all the metadata that the current
version needs to restore archives with the correct scan mode and aspect ratio. The Default Resolutions menu
makes it possible to assign the scan mode and aspect ratio preferences to older archives. The information
you need to assign depends on the software version in which the archive was created. Assign the information
using the Default Resolutions menu. Use the following table to determine which information you need to
assign to your old archive.

Information you must assign:Archived clips prior to:

Scan modeSmoke 6.0, Fire® 6.0, Inferno 5.5, Flame 8.5, Flint 8.5, and Backdraft
5.5

Scan mode and aspect ratioSmoke 5.2, Fire 5.2, Inferno 5.0, Flame 8.0, Flint 8.0, and Backdraft
5.0

The parameters listed in the Default Resolutions menu act as default values for all listed resolutions. For
example, if you want to change the default values for PAL clips, you must change the values for the PAL
entry, which is the entry that has a width value of 720 and a height value of 576. If you are working with
a PAL archive created in an earlier version, the aspect ratio would have automatically been set to 1.3333,
but you may want to restore all your PAL archives with 16:9 aspect ratio. You can change this setting by
changing the aspect ratio to 16:9 for the PAL entry.

NOTE You should only restore an old clip at its original resolution. If you restore versions of the same clip at
different resolutions, you may encounter problems with the clip.

To add a default resolution:

1 In the MediaHub, browse for Archives and click Default Resolutions.

The Default Resolutions list and menu are displayed.

(a) Add Resolution box (b) Apply Changes button (c) Width and Height fields
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(d) Aspect Ratio field (e) Aspect Ratio box (f) Scan Mode box (g) Framerate box

2 Add new preferences to correspond to a specific clip resolution contained in the archive that you plan
to open.

3 Click Add Resolution.

4 Click Apply Changes.

The new archive preference is added to the list. The next time you restore an archive missing either
Scan mode or aspect ratio, Smoke knows how to process that material.

Deleting Content from an Archive
To ensure data integrity and prevent archive corruption, you cannot delete entries from an archive.

MediaHub Reference: Browsing for Archives
Archives Buttons

With No Opened Archive

New Archive button Creates a new archive in the location displayed in the file browser. Opens the New
Archive Creation dialogue box.

View Content button Displays basic information about the contents of the selected archive, in a web
browser. This does not open the archive.

Open Archive button Opens the selected archive or device.

With an Opened Archive

Close Archive button Closes the archive and returns to the file browser.

Archive Project button Adds the current project to the archive; this includes every Workspace of the project,
Shared Folders; also includes all the setups.

Clear Pending Tasks button Clears the Pending Archive or Pending Restore folders. This does not delete
any material in the archive or in the Media panel, it only clears out the queue.

Archive/Restore button Commits the Pending folders, either to archive or restore material clips. Nothing
is archived or restored until you click this button.

The folder Pending Restore displays all that will be restored. The folder Pending Archive displays all that
will be archived. Only one operation is permitted at any given time: you either restore or archive, you cannot
do both simultaneously.

Archive/Restore Setups button Click to archive or restore all of the application's modules setups. You must
be at the root of the archive to archive setups. You must select a Projects Setup folder to restore setups.
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File-based Archive Options

Linked Archive Option box Select how archive paths are treated when restoring an archive. Use Archived
Path is best used when you are restoring the archive on the workstation used to create the archive. Select
Convert to Local Path in other cases.

Archive Verification box Verify Source Media checks the integrity of the source media before adding it to
the archive. In case of missing source media, the archive proceeds without the clip. Verify Archived Data
checks the integrity of the data as it is being written to the archive: archiving stops as soon as it detects an
error.

Verify Source Media validates all the media, which can be time consuming.

Media Options box Select Cache Source Media to copy the media to the archive, using the Cache and
Renders settings defined at the creation of the project; this ensures that your archive is self-contained, but
requires the caching of everything that was not cached at import. Select Archive Links Only to only archive
paths to the media; this option requires less space, but does not create a self-contained archive.

Cache Source Media The media is automatically written to the archive and becomes managed. This ensures
that material will not be overwritten accidentally in the shared storage when you restore the media. When
you restore the media, the clips will reside on the local storage as managed frames.

Archive Links Only Only the path to the media is archived. You can later restore the clip in the original
form as unmanaged media, provided the media resides at the original paths saved with the archive. If the
source clip is not found at restore time, it is displayed as a checkerboard pattern image. Archiving files using
the linked option significantly reduces the amount of space required for your archived clips. It also alleviates
bandwidth when archiving to a VTR. Using Archive Links Only, you can archive both video and audio files.

Default Resolutions button Legacy option. Opens the Default Resolutions List menu, used by the application
to restore legacy archives from Smoke 6.0 and Flame 8.5 (or earlier).

These versions did not store resolutions and associated pixel aspect ratios, and the Default Resolutions table
fills that gap.

VTR Device Options

Auto/Manual Start box Select Auto Start to have the application rewind the tape and then go forward to
try and discover the location of an archive. Select Manual to enter the start timecode and get to the archive
faster.

Timecode field Displays the start timecode. Editable.

Rewind On Close button Rewinds the tape after when the archive is closed.

Open Mode box Select whether to open in read only mode or in read/write mode.

New Archive Creation Options

Limit File Size button Disable to create an open-ended, one-segment archive file. Enable to partition the
archive into manageable segments of the size specified by the Segment Size box. If the archive ends up being
larger than what you entered in the Segment Size field, its content is split across multiple archive segments.

Segment Size box Select a pre-defined segment size, or define a custom one. Make sure to use a segment
size small enough to fit in the specified destination. Enabled when Limit File Size button is enabled.
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Playing Back Media

Playback

Playing Back Clips in the Full Screen Player

To play back clips in the full screen player:

1 Click the Timeline tab.

2 Do one of the following to select the Player:
■ Click the Layout button and select Player.

■ If you've enabled Layout Selection Overlay in the preferences, swipe the right swipe bar, then select
Player.

■ Double-click on the clip in the media library.

The clip appears in the Player viewer.

3 Click the Full Screen button.

The player displays as a full screen.

To return to the previous display size, click the Full Screen button.

NOTE While in the Full Screen Player, the Player Option Box lists Show Play Reel. This is the only viewer that
provides this option. Selecting this option will open up a scrolling clip list of available clips under the control bar.

Jogging and Panning a Clip

You can pan and zoom in the player, tryptich and source sequence viewport. By selecting the Viewing Mode
button you can select the Zoom or Pan pointers.

■ The Zoom pointer increases the zoom of the clip with a left-to-right motion, and will decrease the zoom
in a right-to-left motion.

■ The Pan pointer lets you grab the clip and move it around the viewer.
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NOTE The pan and zoom values of the players are kept until a clip from a different resolution is loaded; you can
change the clip selection without losing the pan and zoom values as long as the clip resolution is maintained. If
changing to a clip of a different resolution, the clip will be resized into the viewer.

To jog through a clip:

1 You can jog through a clip by doing one of the following:
■ Drag the positioner along the timebar.

When you jog through an edit sequence (a series of clips edited together), you can constrain the
jogging to the current clip in the sequence by holding down Command while jogging.

■ Use the arrow keys on your keyboard.

By default, pressing the left arrow and right arrow keys steps frame-by-frame.

■ Place the pointer in the viewer, above the control bar.

The cursor will change to indicate it can jog/shuttle the clip. The further from the center of the
clip the cursor is placed, the faster the shuttling.

Switching the Playback Focus between the Source and Sequence
Clips

You can switch the focus between the source and sequence viewers by clicking on either of the
Source-Sequence viewers, by selecting a track on the timeline, or by selecting the green (source) or red
(sequence) tabs above the Player, Source-Sequence, or Triptych viewers.

Clicking the Lock icon that appears when the pointer is hovering over the source-or-sequence tab will lock
the focus on that tab. Clicking again unlocks the viewer.

NOTE Changing the focus through the timeline will also switch the focus between the Source and Sequence
viewers. Changing the focus through the Source-Sequence viewer, however, will not change the focus in the
timeline. In other words, the player doesn't drive the timeline, but the timeline drives the player.

To switch the playback focus between the source and sequence clips in the Source-Sequence Player:

1 Click the Timeline tab.

2 Do one of the following to select the Source-Sequence Player:
■ Click the Layout button and select Source-Sequence Player.

■ If you've enabled swipe in the preferences, swipe the right swipe bar, then select Source-Sequence
Player.

3 Switch viewers by clicking in either the Source or Sequence viewer, or on the green (Source) or red
(Sequence) tab.

The viewer with the focus has a white outline.

Comparing Three Shots in the Triptych Player

The triptych player provides three players, side-by-side, which you can use to simultaneously view the same
clip in different contexts. For example, you can set the middle player to play the clip, the left player to show
the clip's incoming frame of the current element in the timeline, and the right player to show the clip's
outgoing frame.
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To compare three shots in the triptych player:

1 Click the Timeline tab.

2 Do one of the following to select the Triptych Player:
■ Click the Layout button and select Triptych Player.

■ If you've enabled swipe in the preferences, swipe the right swipe bar, then select Triptych Player.

3 Select a clip from the Media Library.

The clip appears in the triptych player in all three viewers.

The default positions for the positioner is the start of the clip for the first viewer, the middle of the clip for
the middle viewer, and the end of the clip for the last viewer. You can scrub each of the viewers independently
of each other.

Play Back Speed Indicators

As you play clips, the positioner in the image window time bar changes colours if frames are dropped. The
colours indicate the following:

Indicates:Colour:

Real-time playback with no dropped frames.Yellow

Real-time playback with no dropped frames of soft-imported clips.Orange

Alternating dropped frames. Green indicates the first and subsequent alternating dropped
frame.

Green/Blue

Alternating occurrences of dropped audio. Red indicates the first occurrence.Red/White

Comparing Tracks in Split Screen

Use the split screen to compare two tracks, such as an online and offline version. Generally this is used to
compare a rough cut to the final assembly. By merging both tracks into a single image, you can compare
the two for editing synchronization, color matching, etc.

The split screen compares versions as well as video tracks.

To compare tracks in split screen:

1 Click the Timeline tab.

2 Set the Primary and Secondary tracks. (page 241)

3 In the View Area menu bar, select Options.

4 Select Show Viewing Settings.

5 Select the split you will use to compare the two clips in the Compare Mode/Stereo section.

Depending on the split, you will have different attributes available to change the partition between
the two clips. Modify the values in these attributes to provide the best comparison.

You can now compare the two tracks on the split-screen.
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Creating a Subclip in the Player

You can create subclips anywhere that you have access to the source clip (i.e. Thumbnail, Player, Triptych
and Source-Sequence viewers).

NOTE Remember you will need handles for trimming and effects that you apply later. It is recommended to cue
the tape a couple of seconds before the desired footage starts.

To create a subclip in the player:

1 Click the Timeline tab.

2 Set the positioner to the in point.

3 Click the In button.

The start of the sub-clip is marked.

4 Set the positioner to the end point.

5 Click the Out button.

The end of the sub-clip is marked.

The section of the clip that is between the In and Out marks is the sub-clip.

6 From the Clip menu, select Create Subclip.

The subclip is created as a new clip in the Media library. It has the original name and append
("_Subclip_") with an incremented number, starting with ("001").

Accessing Clip Information

Any viewer contains the following information located at the bottom right corner of the viewer:
■ Name of the viewer OR name of the clip,

■ Resolution and aspect ratio of the clip,

■ LUT information of the clip (if LUT has been set).

Also, by alt-clicking on a clip proxy you will see additional clip information detail

Cue Marks

Adding Cue Marks

Cue marks are displayed in the player timebar, as well as the timeline.

To add a cue mark:

1 In the timebar, do one of the following:

■ Drag the yellow positioner to the desired frame, or

■ Click on the desired frame on the time bar.

2 Click the Cue Mark button.

A cue mark is placed in the player timebar, as well as the timeline, to indicate the marked frame. You
can change the colour of a cue mark by clicking the colour pot.
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To delete a cue mark:

1 Click the Timeline tab.

2 Select the specific cue mark to be deleted.

3 From the Timeline Gear menu, select Marks ➤ Delete Selected Markers.

Adding In and Out Marks

In and out marks are displayed in the player timebar, as well as the timeline.

To add in and out marks in the player:

1 In the timebar, do one of the following:

■ Drag the yellow positioner to the desired frame, or

■ Click on the desired frame on the timebar.

2 Click the In or Out button.

TIP Press Ctrl and click the In or Out button to delete the mark.

Navigating between Marks in the Clip

To navigate between marks in the clip:

1 Click the Timeline tab.

2 From the Timeline Gear menu, select a Go To option:
■ In Mark or Out Mark

■ For a cue mark, select the mark's label from the Mark list.

The positioner is set to the mark.

Changing the Color of Cue Marks in the Clip

You can set the color of the current Player cue mark to one of your preference.

NOTE To cancel the color selection, click on the Close (x) button in the Color Picker window.

The Color Picker window will close and the color swath will revert to the previous color.

To change the color of cue marks:

1 Click the Timeline tab.

2 On the View Area menu bar, click on the color swatch to the right of the Mark button.

A Color Picker window appears.

3 Do one of the following:

■ Click the Pick button.

The cursor changes to a color picker, which you can use to select a color from one of the three color
columns.

■ Drag the colour sliders.
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4 Click Ok to apply the color to this and any future cue marks.

The color swatch changes to reflect the color selected.

Playback Options

Setting up the Image Display Viewer in the Tools

To set up the image display viewer in the tools:

1 Click the View button.

2 Modify the display attributes.

The viewer updates the display with your changes.

Setting up the Image Display Viewer in the Player

You can change the display of an image based on the exposure and contrast settings, as well as the type of
image data you are working with. By default, all images are displayed in RGB mode with a transformation
for video images. You can apply transformations to the image to display an optimal view of logarithmic and
linear images.

By modifying the display attributes in Viewing Settings, you can change the way the clip is displayed in the
player. Settings are persistent throughout different Player modes, depending on the timeline tab type (Source
or Sequence).

NOTE In the case of the Triptych Player, the middle image window shares this persistency; while the left and right
image windows each can have their own settings.

To set up the image display viewer in the player:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Show Viewing Settings.

5 Modify the display attributes.

The viewer updates the display with your changes.

Viewing Image Overlays in the Tools

To view image overlays in the Tools:

1 Click the Grid button.

2 Set your preference for overlay attributes.

The new overlay attributes are set.
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Viewing Image Overlays in the Player

To view image overlays in the player:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Show Overlays.

5 Set your preference for overlay attributes.

The new overlay attributes are set.

Modifying Exposure and Contrast in the Image Display

You can modify the overall brightness of images displayed on the workstation or broadcast monitor, as well
as the contrast between light and dark colours. Note that these settings affect only the display, and do not
modify the underlying colour values of the clips.

To modify exposure and contrast interactively in an image window

1 Click in an image window to make it active.

2 Do any of the following:
■ Press and hold Shift+E while clicking and dragging the mouse to modify the exposure offset (overall

brightness). Dragging to the right increases values and dragging to the left decreases them.

■ Press and hold Shift+C while clicking and dragging the mouse to modify the contrast between light
and dark colours.

■ Click Reset to restore the default values.

To modify exposure and contrast using the Image Display settings

1 Access the Image Display Viewer settings.

2 Do either of the following:
■ Edit the Exposure slider to modify overall brightness.

■ Edit the Contrast slider to modify the contrast between light and dark colours.

NOTE If you have applied a colour transform to the display, then you cannot modify the exposure and contrast
unless there is a dynamic ExposureContrast operator in the CTF file.

Enabling Aspect Ratio Display in the Player

When you work with clips that have a resolution that does not use square pixels, such as NTSC or PAL, you
can adjust the display so that it appears with the correct aspect ratio. By default, the adjusted image is sent
to the broadcast monitor. You can switch the adjusted display from the broadcast monitor to the Player.
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To enable the aspect ratio display in the Player:

1 Click the Timeline tab.

2 In the View Area menu bar, select Options.

3 Select Show Viewing Settings.

4 Enable the Use Ratio button.

NOTE The Use Ratio button is only active if you are viewing a clip with a resolution that does not use square
pixels.

The original aspect ratio of the clip is applied to the clip.

Changing Playback Scan Mode Options in the Player

Use the playback scan mode option to define how you want the clip to play and display. By default, everything
will be automatically set to the correct scan mode.

To set playback mode in the Player:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Edit Viewing Settings.

5 Click on the Scan Mode button.

NOTE The default choice is the clip's native scan mode.

6 Adjust the display to the desired scan mode format.

7 Click Done.

The player displays the clip in that scan mode.

Displaying a Clip in the Broadcast Monitor

To set broadcast monitoring preferences:

1 Click the Timeline tab.

2 In the View Area menu bar, select Options.

3 Select Show Viewing Settings.

4 Enter the preferences for the broadcast monitor in the Broadcast Monitor, Broadcast Multiview and
Broadcast LUT boxes.

Your preferences will be set for broadcast monitoring.

The broadcast monitor outputs a complete image or a selected viewport.

Use the Show Selected Item option in the Broadcast Monitor box to display the clip you selected in the
broadcast monitor. Use the Broadcast Monitor buttons to resize and set the proportions of the clip. If the
clip is zoomed in on the application monitor, the clip is still displayed in its entirety on the broadcast
monitor.

When you select multiple clips, the broadcast monitor displays the first clip in a selection.

When the Show Selected Item option is selected, you can manage additional preferences.
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Color and Light Levels

Accessing the Vectorscope

To access the Vectorscope:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Show Vectorscope.

The Vectorscope is displayed.

Changing the Settings in the Vectorscope

To change the settings in the Vectorscope:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Show Vectorscope.

5 Click the Vectorscope Display button.

6 Select Vectorscope Settings.

The Vectorscope Settings window opens.

Scaling the Vectorscope

To scale the Vectorscope:

1 Click the Timeline tab.

2 Select the Player.

3 In the View Area menu bar, select Options.

4 Select Show Vectorscope.

5 Click the Vectorscope Display button.

6 Select Vectorscope > Colour 2D.

7 Shift + drag in the Vectorscope.

The scale in the Vectorscope scales to a new size.
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Preview options
To access the preview options below, select the Options box in the View menu bar.

Indicates:Colour:

Render all timeline effects on-the-fly. If the timeline effects cannot be rendered in real time,
frames are dropped.

Preview Effects

Render only those timeline effects that can be rendered in real time.View Effects in Real-Time

Displays the source clips without any rendered effects.Hide Effects

Play back the full-resolution clip.Full Resolution

Play back using the clip's proxies.Proxy Resolution

Play back using the current Real-Time Deliverable.Deliverables

Preview Effects

Preview FX mode processes all timeline effects to create a preview for the current frame. It is useful for
viewing timeline effects (stacked or not) in context. Every time you use the frame advance controls or jog
the positioner, the image in the Player is updated with all the processed timeline effects. This allows you to
make changes to the vertical edit and immediately see your changes. However, when you play the version
or clip, the functionality temporarily returns to Realtime mode (until play is stopped). If you create complex
timeline effects and find that unrendered black sources appear in some or all your timeline effects when
playing in Realtime mode, switch to Preview FX mode to immediately see the results of your changes on
the current frame.

Preview FX mode is also useful if you have many unrendered timeline effects, or transitions that use an
unrendered timeline effect as an outgoing or incoming clip. Use this mode while you make changes to
complex vertical edits, and return to Realtime mode to view the rendered result.

If you are working in an HD project, you should enable the Proxy-Size Player option before using Preview
FX mode for faster display of the image. If you have a complicated vertical edit with many timeline effects,
you may notice that the Player slows down when jogging or advancing frames. This is normal. Preview FX
mode processes the entire vertical edit for the current frame as you jog, which may take more time as you
add more timeline effects. It is recommended to use this mode when changing the timing of a layer, such
as slipping or sliding, so that you can immediately see the result for the current frame, and then use Realtime
mode to view the processed result.

NOTE In Preview FX mode, the Axis, Blend, Text, and Wipe timeline effects are unavailable for preview in the
broadcast monitor.

View Effects in Real-Time

Realtime mode plays clips and versions in real time, allowing you to view your timeline effects. It is
recommended that you do most of your timeline work in Realtime mode. However, if your clip has more
than one timeline effect, the Player may drop frames or display black frames during playback. In this case,
process the timeline effects to get real-time playback. This is true especially if you have stacked timeline
effects on many layers. Also, when playing a version with multiple tracks containing unprocessed timeline
effects in Realtime mode, you only see the focus track (with its timeline effects).
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Changing Playback Scan Mode Options
To set playback mode in the Player:

1 Click the View button.

2 Click on the Scan Mode button.

NOTE The default choice is the clip's native scan mode.

3 Select a scan mode.

4 Click Done.

The player displays the clip in that scan mode.

Enabling the Aspect Ratio Display
To enable the aspect ratio display:

1 Click the View button.

2 Enable the Use Ratio button.

NOTE The Use Ratio button is only active if you are viewing a clip with a resolution that does not use square
pixels.

The original aspect ratio of the clip is applied to the clip.

Setting up the Image Display Viewer in the Tools
To set up the image display viewer in the tools:

1 Click the View button.

2 Modify the display attributes.

The viewer updates the display with your changes.

Displaying the Reference Area
In the image window of the tools that support multiple viewports, you can view the reference area with the
currently displayed clip. A split bar divides the view between the current clip display (above the bar) and
the reference area. The reference area can either display one of the current tool's working clips (for example,
front, back, or matte), or one of the reference frames that you grab on-the-fly.

Using the Split Bar

To turn on the split bar, enable Compare in the Reference Buffer section of the View menu (also available
below the viewports in ConnectFX). When the split bar is on, by default it lies along the lower edge of the
image window.

The split bar has a pivot point (indicated by a small box) around which the split bar can be rotated, or from
which the split bar can be moved. The letter R next to the pivot box indicates the side of the bar where the
reference clip is displayed.
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(a) Pivot point (b) Split bar (c) Current display (d) Reference display
(a) Pivot point (b) Split bar (c) Current display (d) Reference display

Rotate and move the split bar using these techniques:
■ To rotate the split bar around its pivot point, drag the split bar.

■ To move the split bar, drag the pivot point. You can also Ctrl+Alt-click the image to place the pivot
point under the cursor, and then drag over the image to move the split bar.

■ To restore the split bar to its default position, Ctrl-click the pivot point.

Showing and Hiding the Split Bar

When the split bar is on, you can show or hide it in the image window.

To show or hide the split bar:

1 Ctrl-click the split bar.

When the split bar is hidden, it is still active. The letter R is displayed indicating the location of the
reference clip.

Loading a Clip into the Reference Area

You can display one of the tool's clip views in the reference area. For example, turn on the split bar to show
the reference area, and then display the matte of a Colour Corrector clip while working on its result.
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To load a clip into the reference area:

1 Select an option from the Reference box.

Storing Reference Frames in the Reference Buffer

You can grab any number of reference frames in the reference area, limited only by framestore space.

To store reference frames in the reference area:

1 Display the frame you want to grab in the viewport.

2 In the Reference Buffer section of the View menu of a tool, click Grab.

The current frame appears in the reference area.

3 To grab another frame, display it in the viewport (or make the changes to the current frame) and then
do one of the following:
■ Press Ctrl+G to replace the current reference frame.

■ Press Ctrl+Shift+G to append the new frame to all existing reference frames.

Cycling Through Multiple Reference Frames

When you work with several frames stored in the reference buffer, you can cycle their display in the reference
area.

To cycle through multiple reference frames:

1 With the split bar on and the reference area showing, click the Prev and Next buttons in the View
menu.

To cycle through multiple reference frames using the reference overlay:

1 Press and hold Ctrl+NUM5 to display the reference overlay.

2 While holding Ctrl, press NUM4 and NUM6 to cycle backwards and forwards through all stored reference
frames.

Displaying Multiple Views
You can display up to four viewports at a time in the image window of most tools. Multiple viewports are
convenient for setting channel values, working in Schematic view, and previewing your results all at the
same time without having to switch views.

NOTE The Resize tool supports two viewports; other tools support up to four viewports.

You can apply a different 3D LUT to each viewport.
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To view multiple viewports:

1 In a tool that supports multiple viewports, click View.

2 Select an option from the Viewport Layout box.

To view:Select:

A single viewport (Alt+1).1-up

Two viewports, side-by-side (Alt+2).2-up

Three viewports, two side-by-side, and one on top (Alt+3).3-up split

Three viewports, side-by-side (Alt+3).3-up

Four viewports, two up and two down (Alt+4).4-up

To display views in multiple viewports:

1 Do one of the following:
■ Place the cursor over the applicable viewport and press its associated keyboard shortcut.

■ Click a viewport to select it and then select an option from the View box.

Displaying Widgets in Selected Viewports

If you are working in multiple viewports, you can display widgets such as icons, crop boxes, and 3D scope
in all viewports or in a selected viewport.

To display widgets in selected viewports:

1 In a tool that supports multiple views, click View.

2 From the Widget Display box, select Widget Sel to display widgets in the selected viewport, or select
Widget All to display widgets in all viewports.
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Changing the Multiview Layout

When you select a multiple viewport layout, a default layout appears, and each viewport is set to display a
default view. You can change both the default layout and the views in each viewport to suit your needs.

To change the default viewport layout:

1 Do one or more of the following:
■ Hold the cursor over the lines dividing the image window and Ctrl-drag. The current zoom/pan

settings automatically change so the frame matches its viewport's width.

■ Select the viewport to make it current (a yellow border indicates the current viewport) and then
select a view option (for example, Front) or press a hotkey (for example, F1).

2 To restore the default settings, select an option from the Reset box.

To:Select:

Restore the default layout for the current viewport layout option. You can also Alt-click
a viewport border.

Reset Layout

Restore the default layout for all viewport layout options.Reset All

Synchronizing Current Frame Display Across All Viewports

By default, when you scrub or jog a clip, only the current viewport (a yellow border indicates the current
viewport) is updated. The other viewports continue to display the last frame at which they were parked until
you release the cursor. However, you can set all viewports to be updated in sync with the current viewport.

To synchronize the current frame display across all viewports:

1 Display the View menu.

2 Select an option from the Viewport Update box.

To:Select:

Update all viewports to display the same frame as the current viewport.Update All
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To:Select:

Update only the current viewport. Other viewports continue to display the last frame
at which they were parked only once you release the cursor.

Update Sel
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Editing Clips and Sequences

Adding Your First Clips to the Timeline

The following procedures list a few methods to add clips quickly to a timeline after starting Smoke for the first time. These
methods are certainly not the only way to edit, but should give you a start in familiarizing yourself with editing in Smoke.

When first starting Smoke with a new project, you are presented with a workspace including a Source-Sequence player
and an empty sequence on the timeline. Once you have loaded some media into the Media Library using the MediaHub,
you are ready to add clips to the timeline. You can also create new sequences from the Workspace Media panel, or right-click
a clip and select Open as Sequence.

To insert a first clip on the timeline:

1 Select a clip in the Media panel to display it in the source player.

2 Drag the positioner in the timebar to the frame where you want your clip to start, then click In.

3 Drag the positioner in the timebar to the frame where you want your clip to end, then click Out.

4 Click the Insert button.

The clip is added to the timeline. Extra frames outside of your selected In and Out points remain as handles.

To insert a second clip on the timeline:

1 Select another clip in the Media panel to display it in the source player viewer.

2 Drag the positioner in the timebar to the frame where you want your clip to start, then click In.

3 Drag the positioner in the timebar to the frame where you want your clip to end, then click Out.

4 Click the Insert button.

The clip is added to the timeline starting at the positioner location. If you hadn't moved the positioner after inserting
the first clip, the positioner was located at the last frame.

To overwrite a clip on the timeline:

1 Move the timeline positioner to the first frame of the second clip that you inserted on the timeline.

9
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2 Select another clip in the Media panel to display it in the source player.

3 Drag the positioner in the timebar to the frame where you want your clip to start, then click In.

4 Drag the positioner in the timebar to the frame where you want your clip to end, then click Out.

5 Click the Overwrite button.

Depending where the positioner was placed and the length of the second and third clips, existing material is
overwritten, but the overall length of the timeline sequence does not change.

Continue adding clips to your sequence, as needed. At this point, you are ready to fine-tune your edit sequence by trimming
clips, adding tracks for compositing, adding effects to your timeline clips, and using other Smoke timeline and editing
tools.

Inserting a Clip on the Timeline
To insert a clip to the timeline using the Insert button:

1 Move the timeline positioner to the frame that you want to use as the beginning of the insert.

2 From the workspace, select the clip that you want to insert.

3 Add In and Out points, if needed.

4 Click the Insert button.

Depending where the positioner is placed, the clip is inserted, and the overall length of the timeline
sequence is changed. The following example shows a New Clip inserted at the transition between Clip
A and Clip B. Everything after the transition is moved ahead in order to make room for New Clip.

This example demonstrates the result of inserting New Clip at a frame in the middle of Clip B. Every
frame after the edit point is moved ahead to accommodate New Clip.
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NOTE You can also perform three-point or four-point insert edits with In and Out points on the source and
timeline clips.

To insert a clip to the timeline gesturally:

1 Enable Ripple.

2 From the Workspace Media panel or Viewing panel, select the clip that you want to insert.

3 Add In and Out points, if needed.

4 Drag the clip towards the timeline.

As you hover over the timeline with your clip, you see a phantom visual guide as to the space on the
track or tracks your clip will take when dropped.

5 Release the clip on the timeline.

TIP You can also drag and drop a clip to the timeline from the source tab of the Player.

Overwriting a Clip on the Timeline
To overwrite a clip to the timeline using the Overwrite button:

1 Move the timeline positioner to the frame that you want to use as the beginning of the overwrite.

2 From the workspace, select the clip that you want to overwrite.

3 Add In and Out points, if needed.

4 Click the Overwrite button.

Depending where the positioner is placed, existing material is overwritten, and the overall length of
the timeline sequence does not change. In the following illustration, New Clip is edited into the
sequence at a frame in Clip A. Frames after the insertion point are overwritten by New Clip. All of Clip
B and some of Clip C are overwritten.
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NOTE You can also perform three-point or four-point overwrite edits with In and Out points on the source
and timeline clips. In the case of a four-point edit, a Timewarp may be applied if the number of frames differs
between the source and timeline clips. You can enable of disable Auto Timewarp in the Timeline section of
the Preferences menu.

To overwrite a clip to the timeline gesturally:

1 Disable Ripple.

2 From the Workspace Media panel or Viewing panel, select the clip that you want to overwrite.

3 Add In and Out points, if needed.

4 Drag the clip to the timeline.

As you hover over the timeline with your clip, you see a phantom visual guide as to the space on the
track or tracks your clip will take when dropped.

5 Release the clip on the timeline.

TIP You can also drag and drop a clip to the timeline from the source tab of the Player.

Replacing a Clip on the Timeline
To replace a clip on the timeline using the Replace button:

1 Do one of the following:
■ Move the timeline positioner over the clip that you want to replace.

■ Select a clip or multiple clips on the timeline that you want to replace.

2 From the workspace, select the clip that you want to use as the replacement clip.

3 Click the Replace button.

The overall length of the sequence does not change. The replace clip must be of equal length or longer
than each clip it is replacing. If longer, extra frames are loaded as tail frames.

Other Editing Operations
While insert, overwrite, and replace are the editing operations you use most often, there are other editing
options available. For each of these operations, you select your source clip in the same manner as for an
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insert, overwrite, or replace edit. Then you select the appropriate editing operation from the Secondary Edit
box.

Aligned Edit

An Aligned Edit is usually performed on two tracks. You set the positioner on the timeline to an point you
want to align to, then move the focus point of the positioner to a different track. Set the positioner of the
source track to the point you want aligned. The source clip is added to the track, and both points are aligned.

Append

Append applies an edit that adds your source clip to the end of the edit sequence on the timeline.

Prepend

Prepend applies an edit that adds your source clip to the beginning of the edit sequence on the timeline.

Ripple Replace

Ripple Replace functions as a combination of an insert and replace edit. The source clip replaces the selected
clip on the timeline, and the all of the clips to the right ripple to accommodate the length of the new clip.

Replace Media

Replace Media performs a replace edit but retains any effects applied to the replaced clip or clips on the
timeline.

Fit To Fill

A Fit To Fill edit functions as a replace edit, but instead of adding tail frames to a longer source clip, a
Timewarp is added to the replaced clip so that it fits the same space occupied by the clip it is replacing.

Timeline Editing Settings
The settings you use for editing to and on the timeline can be found to the right and above the timeline.
Most of these settings also have a keyboard shortcut associated with them.

Editing Operations

Insert Edit button Click to insert the selected source into the timeline at the positioner. The overall length
of the timeline may change.

Overwrite Edit button Click to overwrite material in the timeline (at the positioner) with the selected
source. The overall length of the timeline does not change.
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Replace Edit button Click to replace the selected timeline clip or clips with the selected source clip. The
overall length of the timeline sequence does not change. The replacement clip must be of equal length or
longer than each clip it is replacing. If longer, extra frames are added as tail frames.

Secondary Edit box Select an editing operation to apply to the selected source clip.

To apply:Select:

An edit aligning a point on the timeline with a point on the source clip.Aligned Edit

An insert edit that adds your source clip to the end of the edit sequence on the

timeline.

Append

An insert edit that adds your source clip to the beginning of the edit sequence on

the timeline.

Prepend

A combination of an insert and replace edit; where the source clip replaces the selec-

ted clip on the timeline, and the all of the clips to the right ripple to accommodate

the length of the new clip.

Ripple Replace

A replace edit that retains any effects applied to the replaced clip or clips on the

timeline.

Replace Media

A replace edit; but instead of adding tail frames to a longer source clip, a timewarp

is added to the replacement clip so that it fits the same duration occupied by the

clip it is replacing.

Fit To Fill

Trimming Operations

Editorial Mode box Choose an editorial mode for working with clips on the timeline.

To:Select:

Select or move a timeline element,

without performing any trim operations.

Select

Set Trim mode to perform general trim

(or roll) operations on a clip.

Trim

Set Slip mode, a trimming mode that

offsets the frames in a clip without trim-

ming the clips before or after it.

Slip

Set Slide mode, a trimming mode that

trims the clips before and after the clip

Slide

without changing the frames used in it.
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To:Select:

The state of the Ripple button has an

effect on this mode.

Set Slide Cuts mode, a trimming mode

that trims the clips before and after it,

Slide Cuts

while also changing the frames used in

a clip. The state of the Ripple button has

an effect on this mode.

Set Slide Keyframes mode, a trimming

mode that slides only animation key-

frames on a clip.

Slide Keyframes

NOTE Trim, Slide, and Slide Cuts modes are affected by the state of the Ripple button. The icons display as yellow
when ripple is enabled, and red when ripple is disabled.

Link button Enable to select and link all elements in an editorial group. This is useful if you want to trim
all clips in a group by the same number of frames, for example. You can invert the Link mode on-the-fly
during manipulation, with the Invert Group Selection keyboard shortcut.

Ripple button When gesturally adding material into an edit sequence, enable to perform an insert edit,
disable to perform an overwrite edit. When moving (or trimming) clips on the timeline, enable to fill the
gap left by the removed clip or frames, disable to leave the gap.

Snap button Enable to snap to the closest transition, positioner, or mark to help gesturally align edits on
the timeline. Press Shift to invert the snap mode during manipulation.

Keyframe Move Modes box Select how the animation channel is affected when you trim elements with
animated effects.

To:Select:

Resize the channel as you trim. The animation channel is scaled to fit into the timeline

element. This option has no effect when you slip or slide.

Reposition Proportionally

Link the keyframes to their original frame numbers. The animation channel moves

to follow the original frames as you trim.

Shift With Media

Unlink the keyframes from their original frame number. The animation channel re-

mains with the timeline element as you trim.

Pin To Segment Start

Trimming Clips
Use the trimming tools to fine-tune your rough edits. You can trim video or audio clips (with or without
effects), cuts, and transitions on the timeline. You can trim multiple tracks or segments at the same time.
Smoke keeps track of the source material that goes into trimmed shots, so you can go back and reintroduce
material you had previously trimmed out.

You can trim using the Trim View, with keyboard shortcuts, or gesturally on the timeline. You can also trim
by any combination of these methods, depending on your editing style. In Trim mode, the Trim View
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displays the last (outgoing) and first (incoming) frame above the timeline from the two clips you are trimming,
allowing you to visualize your trimming operation. In Slip or Slide mode, the Trim View changes to a four
frame display, which, in addition to the incoming and outgoing frames of the clip you are slipping or sliding,
also displays the outgoing frame of the preceding clip and the incoming frame of the subsequent clip on
the timeline.

The state of the Ripple button has an effect on some trimming operations. You can set the ripple state
explicitly before trimming, or on-the-fly by pressing Alt while you are trimming.

Audio tracks are divided into sub-frames. There are 100 sub-frames of audio for every frame of video. When
trimming audio tracks, you can trim on a sub-frame level by holding down the Shift key while you trim.

NOTE You cannot trim on a sub-frame level when simultaneously trimming audio and video tracks.

Trimming Quickstart

Use the following procedure to quickly start trimming. This method is certainly not the only way to trim,
but should give you a start in familiarizing yourself with trimming in Smoke. For more detailed explanations
of the various trimming modes, see the related topics below.

1 Double-click a cut between two clips on the timeline. The positioner moves to this location, and a
yellow or red highlight appears on either side of the cut (depending if Ripple is enabled or not).

The Trim View also opens, (provided that Auto-Toggle Trim View is enabled in Preferences ➤ General
➤ Player) displaying the outgoing and incoming frame of the two clips.

TIP You can also access Trim View from the View mode box. In this case, the closest cut on the timeline is
automatically selected. You can use the Previous or Next Transition buttons to select a different cut.

2 From the Editorial Mode box, select Trim.

3 Drag the Outgoing or Incoming Trim Offset fields to your desired trim offset value (in frames). The
corresponding view (incoming, outgoing, or both), and the timeline clips are updated.

Notice that the offset fields have the same colour borders as the highlight on the timeline cut (yellow
when Ripple is enabled, or red when Ripple is disabled).

4 Use the loop option of the Play button to loop around your trim with a number of preroll and postroll
frames to preview your trim.
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Performing a Trim

Performing a Trim or Roll

Trim (or roll) a clip to add frames to, or remove frames from, a clip's head or tail.

To trim (or roll) a clip or transition on the timeline:

1 From the Editorial Mode box, select Trim.

2 Position the cursor near the head or tail of a clip or transition on the timeline.

The cursor turns to a trim cursor (a yellow arrow and line if ripple is enabled, or a red arrow and line
if ripple is disabled). If you want to trim a cut, position the cursor over the cut, and notice that the
trim cursor becomes a double arrow with a line.

3 Drag left or right to remove the number of frames that you need.

You can see the head or tail number on the clip change as you trim.

TIP Enable Focus On Trim in the Timeline Options menu to snap the timeline positioner to the transition
while trimming, allowing you to view the frames you are trimming in the Player, or switch to Trim View to
see your incoming and outgoing frames.

To trim (or roll) a clip or transition using Trim View:

1 Double-click a cut between two clips on the timeline, or select Trim View from the View Mode box.

Trim View appears in the Viewing panel, displaying the last (outgoing) and first (incoming) frame from
the two clips you are trimming.

2 Use any of the following techniques to trim your clips to the desired frames:
■ Click and drag directly in the left or right Trim View window. You can see the trim icon as you

drag. The icon is displayed in yellow or red, depending on the state of the Ripple button.

■ Click and drag toward the middle of the two Trim View windows. Notice that the trim icon appears
as a double-sided arrow, indicating that you are trimming the cut between the two clips.

■ Click any of the timecode or duration fields at the top of Trim View windows to enter specific
values. If a timecode or duration field is not enabled, click the corresponding Trim View window
or offset field to enable it.

■ Click and drag the outgoing or incoming Trim Offset field to specify the number of frames offset
in the clip. You can also click the minus or plus buttons to offset by those amounts.

■ You can also trim on the timeline, and use the Trim View as a viewing aid.

Trimming Keyframes

If you set animation keyframes on timeline effects, you have different options as to their behaviour while
trimming. Use the Keyframe Move Modes box to select how the animation channel is affected when you
trim elements with animated effects.

To:Select:

Resize the channel as you trim. The animation channel is scaled to fit into the timeline
element. This option has no effect when you slip or slide.

Reposition Proportionally

Link the keyframes to their original frame numbers. The animation channel moves
to follow the original frames as you trim.

Shift With Media
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To:Select:

Unlink the keyframes from their original frame number. The animation channel re-
mains with the timeline element as you trim.

Pin To Segment Start

In the Editorial Mode box, you can also select Slide Keyframes mode, which allows you to slide all of the
keyframes of a specific timeline effect on a clip. For example, you can slide all of the Axis keyframes on a
clip.

Performing a Slip

Performing a Slip

Slip a clip to offset the frames in a clip (by trimming head and tail frames of the clip) without trimming the
clips before or after it. The state of the Ripple button has no effect on slip operations.

To slip a clip on the timeline:

1 From the Editorial Mode box, select Slip.

2 Position the cursor in the middle of a clip on the timeline.

The cursor turns to a slip cursor.

3 Drag left or right.

You can see the head and tail numbers on the clip change as you slip.

To slip a clip in Trim View:

1 Select the clip you want to slip on the timeline.

2 From the Editorial Mode box, select Slip.

3 Double-click the clip you want to slip, or select Trim View from the View Mode box.

In Slip mode, the Trim View displays four panels. In addition to the incoming and outgoing frames of
the clip you are slipping, you can see the outgoing frame of the preceding clip and the incoming frame
of the subsequent clip on the timeline.

4 Use any of the following techniques to slip your clip:
■ Click and drag left or right directly in the Trim View window. You can see the slip icon as you drag.

■ Click any of the timecode fields at the top of Trim View windows to enter specific values.

■ Click the minus or plus buttons to offset by those amounts.

■ You can also slip on the timeline, and use the Trim View as a viewing aid.

NOTE In Slip mode, the Duration and Offset fields of the Trim View update as you slip, but are non-editable.

Performing a Slide

Performing a Slide

Sliding changes a clip's position in the edit sequence. It simultaneously slides the clip under the cursor and
trims the head and tail of the surrounding clips. The state of the Ripple button has an effect on slide
operations.
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NOTE Instead of using Slide mode, you can select Slide Cuts from the Editorial Mode box, a modified Slide mode
that trims the clips before and after it, while also changing the frames used in a clip.

To slide a clip on the timeline:

1 From the Editorial Mode box, select Slide.

2 Position the cursor in the middle of a clip on the timeline.

The cursor turns to a slide cursor (a white square with yellow arrows if ripple is enabled, or a white
square with red arrows if ripple is disabled).

3 Drag left or right.

The position of the clip changes, and surrounding clips' head and tails are trimmed.

To slide a clip in Trim View:

1 Select the clip you want to slide on the timeline.

2 From the Editorial Mode box, select Slide.

3 Double-click the clip you want to slide, or select Trim View from the View Mode box.

In Slide mode, the Trim View displays four panels. In addition to the incoming and outgoing frames
of the clip you are sliding, you can see the outgoing frame of the preceding clip and the incoming
frame of the subsequent clip on the timeline.

4 Use any of the following techniques to slide your clip:
■ Click and drag left or right directly in the Trim View window. You can see the slide icon as you

drag.

■ Click any of the timecode fields at the top of Trim View windows to enter specific values.

■ Click the minus or plus buttons to offset by those amounts.

■ You can also slide on the timeline, and use the Trim View as a viewing aid.

NOTE In Slide mode, the Duration and Offset fields of the Trim View update as you slide, but are non-editable.

Trimming with Keyboard Shortcuts and the Calculator

You can use selection-based keyboard shortcuts to perform your trim, slip, or slide operations (depending
on the mode selected in the Editorial Mode box).

1 On the timeline, select the segment that you want to trim.

2 From the Editorial Mode box, select the trim mode that you want to perform (for example, Slip).

TIP Specific keyboard shortcuts are available to switch to each trim mode (Trim, Slip, Slide, Slide Cuts, and
Slide Keyframes). See the Keyboard Shortcut editor for more information.

3 Use the keyboard shortcut appropriate to the action you want to perform (in the descriptions below,
Trim refers to the selected trim mode).

Flame ShortcutSmoke Classic ShortcutSmoke (FCP 7) ShortcutDescription

. (period)N. (period)Trim 1 Frame Forward

, (comma)B, (comma)Trim 1 Frame Backward
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Flame ShortcutSmoke Classic ShortcutSmoke (FCP 7) ShortcutDescription

Shift+. (period)Shift+NShift+. (period)Trim <n> Frames Forward

Shift+, (comma)Shift+BShift+, (comma)Trim <n> Frames Backward

Shift+[Ctrl+BCtrl+ITrim to In Mark

Shift+]Ctrl+NCtrl+OTrim to Out Mark

Shift+PCtrl+PETrim to Positioner

Trimming with the Keypad and Calculator

If you know the amount of frames by which you want to trim, a quick way to perform the trim is by using
the keypad to enter the amount into the calculator.

1 On the timeline, select the clip or cut you want to trim.

2 On the keyboard keypad, enter the number of frames by which you want to trim (positive or negative).

3 Press Enter.

NOTE If there is no explicit selection on the timeline, trim operations are not performed using this method.
Instead, the positioner is moved by the number of frames that you enter.

Dynamic Trimming

In Trim View, you can use key combinations to dynamically trim while your outgoing and incoming clips
are playing.

To trim with the J-K-L keys:

1 In Trim View, select either the incoming, outgoing, or both clips.

2 Use one of the following J-K-L key combinations to trim:
■ Press the J or L key once to play backward or forward, then press K to stop and perform the trim

at the desired frame. You can also press J or L multiple times to play faster before pressing K. This
method works for Trim mode only.

■ Press and hold K, then press J to trim one frame backward or L to trim one frame forward. This
method works for Trim, Slip, and Slide modes.

The trim viewports and the timeline update as you perform your trim. While pressing J or L, you can
see a phantom positioner moving along the timeline to help you see where you want to trim.

To trim during playback:

1 In Trim View (with Trim, Slip, or Slide mode selected), select a playback option from the Play button
(such as Loop), and click Play.

2 While your selection is playing (with the desired number of preroll and postroll frames), you can use
the Trim 1 Frame Forward, Trim 1 Frame Backward, Trim <n> Frames Forward, and Trim <n> Frames
Backward keyboard shortcuts.
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Trim View Settings

In Trim mode, the Trim View displays the last (outgoing) and first (incoming) frame from the two clips you
are trimming (as seen in the example, above). In Slip or Slide mode, the Trim View changes to a four frame
display, which, in addition to the incoming and outgoing frames of the clip you are slipping or sliding, also
displays the outgoing frame of the preceding clip and the incoming frame of the subsequent clip on the
timeline.

Use these settings while working in Trim View. Most of the settings are available for all Trim View modes;
exceptions are noted below.

Tail Source Timecode field Displays the tail source timecode of the outgoing segment. Non-editable if the
outgoing trim offset is not selected.

Outgoing Duration field Displays the duration of the outgoing clip. Non-editable if the outgoing trim offset
is not selected. Available in Trim mode only.

Incoming Duration field Displays the duration of the incoming clip. Non-editable if the incoming trim
offset is not selected. Available in Trim mode only.

Head Source Timecode field Displays the head source timecode of the incoming segment. Non-editable if
the incoming trim offset is not selected.

Duration field Displays the duration of the selected segment. Non-editable. Available in Slip and Slide mode.
(Not shown)

Timecode field Displays the current timecode of the focus clip (green signifies a source clip, while red
signifies a sequence clip). Editable.

View Mode box  Select a view mode for the Viewing panel layout.

Previous Transition button Click to select the previous transition on the selected track.

Next Transition button Click to select the next transition on the selected track.

Outgoing Trim Offset field Displays the number of frames offset in the outgoing clip. Click to select the
offset, and drag to change the offset value. A selected offset has a yellow border if Ripple is enabled, and a
red border if Ripple is disabled. Available in Trim mode only.
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Incoming Trim Offset field Displays the number of frames offset in the incoming clip. Click to select the
offset, and drag to change the offset value. A selected offset has a yellow border if Ripple is enabled, and a
red border if Ripple is disabled. Available in Trim mode only.

Trim Offset field Displays the number of frames offset as the result of the slip or slide operation performed
on the selection. Non-editable. (Not shown)

-5 button Click to trim the selection five frames to the left.

-1 button Click to trim the selection one frame to the left.

+1 button Click to trim the selection one frame to the right.

+5 button Click to trim the selection five frames to the right.

Preroll field Displays the number of preroll frames when playing a clip. Editable.

Play button Click to activate the current play behaviour selected for this button. Click and hold to list a
selection of playback types. The Play button will change to display the current play status; Once, Loop, or
Back and Forth.

Postroll field Displays the number of postroll frames when playing a clip. Editable.

Player Options box  Select an option for working in the player. Available options differ depending on the
view selected.

About Timeline Tracks and Versions
Different areas on the timeline form a hierarchy that allows you the flexibility to composite on multiple
tracks while maintaining different video streams or versions of your work.

Think of a version as a single stream of video on the timeline. Each version can have multiple tracks. While
you can also use sequences on the timeline to accomplish similar results, use versions for the following:
■ Compare two streams, such as an offline and online version. You can use the player in a split view to

compare versions.

■ Create matte containers with an Axis timeline effect, to help you key using a separate fill and matte, for
example.

■ Create different versions of a track or tracks, to try out different effects without affecting each other.

Tracks on the timeline are stacked vertically within a version to help you composite.

Track Indicators and Tools

On the left side of the timeline, in the Patch Panel area, you can find indicators and other tools for working
with tracks and versions.

In the example above, the upper track (version 1 track 2) is highlighted, and therefore selected. The track
indicators and tools for this track are (from left to right):

Grab area  Grab the handle area of the track to move and reorder a track or group of tracks. As you are
dragging, a red message gives you an indication as to the operation being performed.
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Track Collapse/Expand arrow Click to collapse or expand all tracks within a version. You can collapse
tracks to remove clutter from your timeline.

Patch Identifier (Source track)  Indicates which source track is patched to the track (in green).

Track Identifier (Destination or Sequence track)  Displays the version and track number (in dark grey).

Track Visibility icon  Displays or hides the track.

Track Lock icon  Enable track lock to prevent editing operations from being performed on the track. A
locked track displays grey diagonal lines.

Sync Lock icon  Enable to maintain sequence sync on a track or tracks.

Video Track indicator  Indicates if a track is the primary or secondary track. The primary track can also be
set by moving the focus point on the positioner.

Adding Tracks and Versions

To add a new video track:

1 On the timeline, select the version you want to add a track to.

2 On the bottom left of the timeline, click Track+, or from the Timeline Gear menu, select New ➤ Video
Track.

A new track is added to the version above the last existing track. If you want the track to be added
below the last existing track, press Ctrl while clicking Track+. You can re-order your tracks, or even
move a track to a different version by dragging the track from the handle at the left of the track.

To add a new audio track:

1 On the bottom left of the timeline, click Audio+ for a mono track or Alt+Audio+ for a stereo track, or
from the Timeline Gear menu, select New ➤ Mono Audio Track or New ➤ Stereo Audio Track.

A new audio track is added to the timeline below the last existing audio track.

To add a new version:

1 On the bottom left of the timeline, click Version+ for a mono version or Alt+Version+ for a stereo
version, or from the Timeline Gear menu, select New ➤ Mono Version or New ➤ Stereo Version.

A new version is added to the timeline above the last existing version. If you want the version to be
added below the last existing version, press Ctrl while clicking Version+.

TIP To add multiple versions or tracks, you can use the keyboard to enter the number of versions or tracks you
want to add, before using one of the above methods.

Moving, Resizing, and Deleting Tracks

To move a track:

1 Select the track or tracks that you want to move.

2 Grab the selected track from the left end of the Patch Panel area, and drag up or down to the desired
location.

A red message appears while dragging to help guide while dragging the track.

3 Let go of the track to perform the move.
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NOTE You cannot move a video track to the audio track area and vice-versa.

To resize a track:

1 Place the cursor at the bottom of the Patch Panel area for the track that you want to resize. Notice that
the cursor becomes a line with a double-headed arrow.

2 Drag down to increase the height of the track (to see more information on the tracks clips, for example),
or drag up to decrease the height of the track.

TIP To increase or decrease the height of all tracks, drag left or right on the vertical scroll bar to the right
of the timeline.

To delete a track:

1 Right-click on the Patch Panel area of the track you want to delete.

2 Click Delete Track.

About Timeline Patching
When you record a source clip to a sequence, you must decide what source clip channels you want to use,
and to which tracks you want to record them. To connect the source channels to the destination timeline
tracks, you use patching. When you select the source clip, green patch identifiers indicate what channels
you can record from the source to the timeline.

In the above example, the top track (V1.3) is patched, but no source is assigned. The middle track (V1.2) is
not patched and no source is assigned. The bottom track (V1.1) is not patched, but a source is assigned. If
you click the source patch or destination identifier on the bottom track, the track becomes patched, identified
by the green patch.

With the patch identifiers, patching information is kept with the sequence clip. If you patch a source clip
and then add a new track to the timeline, the source clip follows the track to which it was originally patched.

240 | Chapter 9   Editing Clips and Sequences



This allows for a natural workflow of setting up the patch for a source clip, adding a new track, then setting
up the patching for another source clip.

Patching on the Timeline

To patch a source channel to a sequence track:

1 Select a source in the workspace.

Source track patch identifiers appear in the Patch Panel area for each channel in the source.

2 Create the patch:
■ If the track is patched but no source is assigned, drag on the grey patch identifier until the source

channel that you want to use appears.

■ If the track is not patched and no source is assigned, drag on the grey patch identifier until the
source channel that you want to use appears and then click the patch identifier.

■ If the track is not patched but a source is assigned, click the grey source channel number on the
patch identifier.

The patch identifier turns green and its source channel number indicates what source you have recorded
to the track.

Navigating and Searching the Timeline
Although you can search for elements by scrolling the timeline and displaying information about each
element, the Find and Select in Timeline options make it easier to find specific elements. You can also refine
your search when searching specifically on segments. Once your search is complete, or if you have multiple
segments selected on the timeline, you can easily navigate through them.

Navigating with the Positioner

The frame directly beneath the positioner is displayed in the Player or is the current location for an edit
such as a dissolve or cut. Drag the positioner to the desired frame on your timeline.

In the timecode area below the tracks, a lighter yellow box attached to the positioner indicates the length
of the current frame, at the timeline zoom level. Click and drag this yellow box to move the positioner, so
as not to accidentally move clips on the timeline.

If you know the amount of frames by which you want to move, a quick way to navigate the timeline is by
using the keypad to enter the amount into the calculator.

1 On the timeline, make sure that there is no explicit selection of a clip or cut (in this case, a trim may
be performed).

2 On the keyboard keypad, do one of the following:
■ Enter the number of frames by which you want to move the positioner (for example, +10 or -10).
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■ Enter a number (without a + or -) to navigate to the closest timecode value that finishes with the
value entered (for example, enter 10 to move the positioner to the closest timecode value that
finishes by :10)

3 Press Enter.

TIP Use the timeline scroll bars to zoom timeline, if needed. Click Home in the Timeline Layout combo box to
reset the timeline view.

Searching the Timeline

1 Click the magnifying glass icon at the bottom right side of the timeline.

The Find and Select in Timeline window opens.

2 Enable a button or multiple buttons to set your search criteria. For example, you can enable Dissolve
in the Video Transitions area to search for all dissolves.

TIP You can enable Get Information From Current Element to automatically fill in information from the
selected element into the search criteria.

3 Choose whether to search segments, containers, gaps, cue marks, or segment marks. You can select
more than one or all of these options.

4 Set the strictness of the search by enabling Every Criteria Below or Any Criteria Below.

5 Click Select on Current Track or Select on All Tracks to perform the search.

The Find and Select in Timeline windows closes, and results are highlighted on the timeline.

Navigating Selected Elements on the Timeline

If you have multiple segments selected on the timeline (as the result of a search, or as a manual selection),
you can easily navigate through them with keyboard shortcuts or with these procedures.

To navigate on the timeline in a linear manner:

1 In the Player, select and hold the Go To Next button to display more options.

2 Click Selected Element.

3 Use the Go To Previous and Go To Next buttons to scroll through the selected timeline elements.

To navigate to a specific selected timeline segment:

1 In the FX pipeline above the timeline, click the arrow beside the segment thumbnail.

You can see a list of all selected segments.

2 From the list, select the element you want to navigate to.

The timeline positioner moves to the selected segment.

Using Reveal to Locate Clips or Segments

To help you locate timeline clips or segments in the Workspace Media panel, you can use the reveal options.
To locate a clip, you can double-click the timeline tab, or right-click the clip on the timeline, and select
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Reveal ➤ Clip in Media Panel. You can also locate a specific clip segment by right-clicking it on the
timeline, and selecting Reveal ➤ Segment in Media Panel. The clip or segment is then highlighted in
the Workspace Media panel, and the Thumbnail view, if displayed.

Using Markers on the Timeline
Use cue marks or segment marks to mark frames of interest on a clip. You can then quickly go to the marked
frames. These marks are for reference purposes only; they do not affect the clip and are not used in any
editing operations. You can add a mark to all tracks (cue mark) or to a single track or version (segment mark)
on the timeline. Segment marks move on the timeline as you trim, slip, or slide a clip whereas cue marks
stay at the same position on the timeline.

You can also add In and Out marks on timeline clips, as you can in the player.

To add marks on the timeline:

1 Go to the frame where you want to insert the mark.

2 From the Timeline Gear menu, in the Marks section, select an option to add an In, Out, Cue, or Segment
mark.

3 If you added a cue or segment mark, you can change the name and colour of the mark to help you
identify it more easily.

NOTE The Marks section of the Timeline Gear menu offers other options for clearing or deleting marks. The Go
To section of the Timeline Gear menu offers navigation aids for existing marks.

About Timeline Containers
Containers are a convenient way to remove clutter from the timeline by grouping or nesting elements
together. The elements, which can come from different tracks or versions, are treated as one unit yet remain
individually editable. Containers behave like any other element but they appear in a separate timeline tab
when you enter their editor. You can also add containers within a container.

Containers can also be used to take a clip and matte that are separate and add them to the timeline as a
single element.

NOTE You cannot contain audio across tracks, but you can contain adjacent audio elements.

Creating a Timeline Container

To create a container:

1 Select all the elements on tracks or versions on the timeline that you want to collapse into the same
container.

NOTE The bottom track is always trimmed out so that you can dissolve from an element to a container.

2 From the Timeline Gear menu, select Contain Selection.

All the selected elements are collapsed into a container and the element changes to a dark blue. You
can add effects or perform other timeline operations to the contained element.

3 To edit the contents of the container individually, double-click the container, or click Open in the
Container quick menu.
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The elements that make up the container appear in their own timeline tab (the tab has a blue line).
Yellow marks indicate the duration of the container. From this view, you can add effects, tracks,
versions, or any other timeline operation.

To remove a container:

1 Select the container in the sequence where it was created.

2 From the Container quick menu, click Uncontain.

The container is removed and its contents are restored to the sequence.

About Timeline Gaps
Gaps are spaces on a track that do not contain media. You can use gaps to see through one layer to another
or to apply effects to the tracks below the gap. If a gap exists on a track, the next track that contains video
media is included in the edit as long as it is also below the focus track.

Since timeline gaps are independent of all media, they are useful for applying Timeline FX or ConnectFX
(as an Adjustment Segment) that affect all tracks under the gap.

By default, empty gaps are transparent. However, you can make an empty gap opaque if you do not want
to see through to the next track. To do so, select the gap on the timeline, then click Opaque in the Gap
quick menu.

While editing on the timeline, you can also quickly remove a gap between elements by right-clicking the
gap, and choosing Close Gap.

When selecting elements on the timeline with a rectangle selection (that is, when drawing a bounding box
around them), you can choose whether to include gaps by enabling or disabling Selection Includes Gaps in
the Timeline Options menu.

Playing the Timeline
You can control how the timeline plays back. For example, frame-step through a shot to isolate a frame or
jump to the start of an element to play a specific shot. The image window updates as the positioner moves
on the timeline. While you can play your timeline in any of the Viewing panel's View modes, if the Player
is displayed, you can also use any of the playback controls to move through the timeline. The Player also
offers compare modes, where you can set up a split view to play primary and secondary versions or tracks
at the same time.

To play the timeline:

1 Press L to play forward.

2 Press J to play backward.

3 Press K to stop playback.

TIP Press J or L multiple times to play faster. Press Shift along with J or L to play slower.

To scrub the timeline:

1 Drag the positioner, or the scrub area at the bottom of the timeline, left or right.
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When scrubbing in the Source tab, you cannot navigate past the first or last frame of the clip.

To jump to a particular location:

1 Do one of the following:
■ Click the scrub area at a particular location.

■ Enter a value in the Current Timecode field.

TIP To enter a frame number instead of timecode, click the field to bring up the numeric keypad. Click
TC to change to FRM, and then enter a frame number.

To frame-step the timeline:

1 Press the left or right arrow key.

TIP To frame-step a specific number of frames, enter a number in the numeric keypad and then press the
left or right arrow key.

Cutting Clips on the Timeline
When you splice clips together, the location at which one clip changes to another is called a cut. A cut is
useful when you want to extract part of an element or end a shot at a given frame.

You can make a cut at any point on a segment. A cut creates a transition with a head equivalent to the
duration of the segment before the cut and a tail equivalent to the duration after the cut. For example, if
you make a cut after the 5th frame in a 10-frame clip, the cut has a tail of 5 frames and a head of 5 frames.

In a match frame cut, the outgoing and incoming shots are from the same source and the outgoing and
incoming frames are consecutive. Match frame cuts are indicated by an “=” on the cut point.

To add a cut on the timeline:

1 Move the positioner over the frame where you want to add a cut. Make sure:
■ The element is explicitly selected (light blue) or implicitly selected (surrounded by a white bounding

box). If the element is neither light blue nor surrounded by a white bounding box, another element,
cut, or transition is selected on the timeline and the cut will not occur at the positioner location.

■ The focus point is over the appropriate track.

2 Select Cut from the Timeline Gear menu.

A match frame cut is added at the specified location.

TIP You can also add cuts while the clip is playing by pressing the cut keyboard shortcut.

To remove a match frame cut:

1 Select the cut on the timeline.

2 Right-click and choose Remove Match Cut.

The cut is removed and the two elements are joined together.
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Swapping Timeline Elements
You can quickly swap elements on the timeline. If segments contain timeline effects, they are swapped as
well.

You can swap the following elements:
■ Video segments or containers

■ Audio segments or containers

■ Tracks

■ Versions

■ Contiguous sequences of elements

■ Video transitions (unless they start or end a contiguous sequence of elements)

■ Audio transitions

■ Gap effects

Elements must be compatible to be swapped. Compatible elements are:
■ Video segments, video containers, gap effects

■ Audio segments and audio containers

■ Video transitions

■ Audio transitions

■ Tracks and versions

The following elements cannot be swapped:
■ Gaps (unless they are between elements in a contiguous sequence)

■ Cuts

■ Cue marks

■ Individual timeline effects

To swap timeline elements:

1 Select two elements belonging to the same family.

A contiguous sequence of elements is treated as a single element as long as the transition between the
elements is selected. A gap can be part of a contiguous element as long as it is not at the beginning or
end of the sequence.

2 Press Shift+'.

The elements are swapped according to the ripple setting. If the segments contain any timeline effects,
they are swapped as well.

If Ripple is disabled, the segments are timewarped using a Constant Fit-to-Fill timewarp to fill each
other's location. If there is already a timewarp on the segment, the timewarp is replaced by the Constant
Fit-to-Fill timewarp. Gap effects, Matte containers, and contiguous sequences ripple regardless of Ripple
status because they cannot be timewarped.

Transitions keep their alignment but their duration changes based on the head and tail frames of the
destination segments.
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Removing Elements From the Timeline
When you remove an element from an edit sequence gesturally, the effect depends on whether Ripple is on
or off. When Ripple is off, you lift an element, leaving a gap in place of the lifted element.

When Ripple is on, you extract an element, and the edit sequence collapses to fill the gap left by the extracted
element. This is also called a ripple delete.

You can lift or extract elements from the timeline independently of the Ripple mode using the contextual
menu or keyboard shortcuts.

To lift or extract an element from using the contextual menu:

1 Select the element you want to lift or extract or mark in and out points around the material.

2 Right-click the element and select one of the following:
■ Select Lift to lift the element from the timeline, leaving a gap in place of the lifted element.

■ Select Ripple Delete to extract the element from the timeline and ripple the remainder of the
timeline to fill the gap.

To gesturally remove an element from an edit sequence:

1 Do one of the following:
■ Turn off Ripple to lift.

■ Turn on Ripple to extract.

2 Select the element that you want to lift or extract and drag it out of the timeline.

NOTE You can also lift or extract gaps on the timeline.
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Matching Clips with Their Sources
Matched sources are the original, untrimmed clips with their original names and timecode information.
There are numerous ways to match clips with their sources:
■ Match Frame: Displays the source and matches the frame and the In / Out markers of the selected clip.

■ Match Source: Displays the source of the selected clip while retaining its original markers, if any.

■ Match Source and Keep Handles: As above while retaining the handles.

■ Match Content: Displays the sources of clips contained within transitions, containers, matte containers
and ConnectFX clips.

■ Match Content and Keep Handles: As above while retaining the handles.

NOTE The Match Content options can also be performed on timeline clips.

■ Match All Sources: Displays all the sources within a selected sequence.

■ Match All Sources and Keep Handles: As above while retaining the handles.

To match a frame:

1 Select a clip in the thumbnails view and place the cursor at the frame you want to match.

2 From the contextual menu, select Match ➤ Frame.

The source is displayed in the thumbnails view at the appropriate frame.

To match a source:

1 Select a clip in the thumbnails view.

2 From the contextual menu, select Match ➤ Source .

The source is displayed in the thumbnails view at the appropriate frame.

To match content:

1 Select a transition, container, matte container, or ConnectFX clip in the thumbnails view, or a timeline
clip.

2 From the contextual menu, select Match ➤ Content.

The sources are displayed in the thumbnails view at the appropriate frame.

To match all sources within a sequence:

1 Select multiple clips from the thumbnails view.

2 From the contextual menu, select Match ➤ All Sources.

The sources are displayed in the thumbnails view at the appropriate frame.

Grouping and Syncing Elements on the Timeline
You can create editorial groups to preserve the relationship between timeline elements in a vertical
composition. For example, if you have a video clip with two tracks of audio overlapping on the timeline,
you can create a group for them. When you edit one segment that is part of a group, all segments in the
group are edited in the same way. If your group becomes out of sync, a visual cue is displayed on the timeline,
and tools are available to help you resync the elements.
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To create an editorial group:

1 On the timeline, select the overlapping video or audio elements to include in the group.

2 From the Timeline Gear menu, select Group ➤ Group.

NOTE You can also right-click your selection, and choose Group from the contextual menu. If Group is
unavailable in the contextual menu or the Timeline Gear menu, the selection is not able to be grouped.

Once a group is created, file names on the elements are underlined to indicate group status.

3 Enable Link to allow elements in the group to be edited together (you can use the keyboard shortcut
for Invert Group Selection to temporarily change the status of the Link button during manipulation).

TIP If you cut a segment that is part of a linked group, all elements in the group are cut at the positioner
location, and two separate groups are created from the cut segments.

Resetting Sync

If an editing operation removes the sync for a track in a group, a red plus (+) or minus (-) symbol appears
in the element with the amount of frames that are out of sync to the left (-) or right (+).

You can attempt to manually fix the sync issue by editing the out-of-sync element. In this case, make sure
that Link is disabled. Once you have resynced, you can enable Link again.

You can either resync the elements or reset the offsets, creating a new sync relationship based on the current
position of the segments.

To regain sync:

1 Select the element that is out of sync.

2 Right-click the element, and select Resync.

The element is resynced, if possible, and the out-of-sync symbol disappears.

To reset sync offsets:

1 Select any element in the edit sync group.

2 Right-click the element, and select Reset.

The segments remain in their current positions. The sync offsets are removed creating a new edit sync
group.

Deleting and Disabling Editorial Groups

When you delete an editorial group, the sync is removed from all elements that were part of the group. You
can also temporarily disable an editorial group.

To delete an editorial group:

1 Select one of the elements that make up the group.

2 From the Timeline Gear menu, select Group ➤ Ungroup.
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NOTE You can also right-click your selection, and choose Ungroup from the contextual menu.

To remove sync temporarily:

1 Select one of the elements that make up the group.

2 Disable Link.

3 Edit an element of the group.

No other elements in the edit sync group are affected. A red plus (+) or minus (-) symbol appears on
every element that is out of sync.

TIP You can change the Link mode temporarily on-the-fly by using the keyboard shortcut for Invert Group
Selection.

Syncing Tracks and Versions

You can use the track and version-based sync locks to decide the behaviour of tracks or versions when
performing editing operations, such as trimming or an insert edit. In this case, you do not have to select
individual elements on tracks.

The contents of a track set to Sync can ripple even when nothing is selected for the edit on it. This is to keep
segments in sync throughout many tracks and versions. For example, performing an insert edit on a track
can have the effect of a gap of the same length as the inserted material being created on another synced
track.

To turn on or off syncing for tracks or versions, click the sync lock icon in the Patch Panel area. In the
following example, sync is enabled for tracks V1.1 and V1.3, and disabled for track V1.2.

You can also right-click a sync lock icon and select to sync or remove sync from all tracks or versions.

Affected Editorial Operations

The state of the track or version sync lock is taken into account when performing the following operations:

■ Insert

■ Extract

■ Delete*

■ Trim*

■ Move*

■ Slide*

*Ripple must be enabled.

These editing operations ignore sync lock:

■ Aligned Edit
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■ Overwrite

■ Replace

■ Append

■ Prepend

■ Lift

■ Slip

Timeline Reference
Use these settings to help you navigate and perform tasks on the timeline. You can also right-click anywhere
on the timeline to display a contextual menu of relevant operations for the type of element selected.

Navigation

Positioner The “playhead” for playing the clip, displayed as a vertical yellow bar. The frame directly beneath
the positioner is displayed in the Player or is the current location for an edit such as a dissolve or cut.

In the timecode area below the tracks, a lighter yellow box attached to the positioner indicates the length
of the current frame, at the timeline zoom level. Click and drag this yellow box to move the positioner, so
as not to accidentally move clips on the timeline.

Focus point A horizontal yellow line on the positioner indicating the current track.

Back button Click to move back one page in the timeline window.

Horizontal scroll bar To pan, drag left or right. To zoom the timeline, drag up or down.

Forward button Click to move forward one page in the timeline window.

Current Timecode field Displays the timecode of the current position. Editable.

- button Click to expand track height.

+ button Click to decrease track height.

Vertical scroll bar To pan, drag up or down. To zoom the timeline, drag left or right.

Timeline Search button Click to open the Find and Select in Timeline window to search the timeline using
many different criteria.

Timeline Layout combo box Select an option to display the timeline.

To:Select:

Reset the view of the timeline.Home

Reset the height of the tracks in the timeline.Reset Height

Reset the horizontal scale of the timeline.Fit to Width

Centre the timeline on the selected element.Fit Selection
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Rendering

Rendering combo box Select an option to render timeline effects. You can edit effects after rendering.

To:Select:

Render the selected elements. This is the default option.Render

Force a render on a timeline effect that needs to be refreshed. Use this to force a

render on a locked element, or when Smoke fails to recognize that a processed clip

Force Render

is no longer valid. For example, if you change a track in a complex vertical edit, you

may need to force a render to update all the tracks in the stack.

Render proxies only, not the corresponding high-resolution images. An amber outline

appears on the timeline segment to indicate the state of the rendering.

Render Proxy

Force the rendering of a proxy on a timeline effect that needs to be refreshed.Force Proxy

NOTE If Burn is present, additional options are available.

Depending on how a clip is rendered, you can see a visual representation on the render bar at the top of the
clip on the timeline:

State:Render Bar:

Unrendered.

Rendered.

Partially rendered.

Proxy rendered.

Proxy partially rendered.
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State:Render Bar:

Sent to Burn.

Viewing

Timeline View Mode box Select a viewing mode for working in the timeline.

To Display:Select:

Video and audio tracks in a timeline format with a positioner at the location of the

current frame.

Timeline

A collapsed view (only the current frame of each sequence). Shuttle through the

sequence by dragging the cursor across the bottom of the frame.

Reel

TIP In Reel view, you can drag sequences to reorder them. If you switch back to Timeline view, the new order of
sequences is maintained.

Timeline Tasks

Timeline Gear menu Select a task to perform on the timeline. Some of the options have sub-menus with
more options.

To:Select:

Add new tracks or versions to the timeline.New

Perform various element or timeline editing operations.Edit

Rename the selected timeline element.Rename

Rename the selected track.Rename Track

Break the link between an element's metadata and media or high-resolution media.Media

Select all elements in the timeline.Select All

Deselect all elements in the timeline.Deselect All

Work with containers on the timeline.Container

Create an edit sync group for selected timeline elements.Group

Navigate to various areas of the sequence.Go To
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To:Select:

Work with In and Out, Cue, or Segment marks.Marks

Work with stereo tracks on the timeline.Stereo

Add a cut to the selected element at the positioner location.Cut

Add a cut to all tracks at the positioner location.Cut All Tracks

Merge timeline tracks into a single track.Merge Tracks

Copy timeline effects between clips.Swap Effects

Remove the selected element from the edit sequence, and leave a gap in its place.Lift

Remove the selected element from the edit sequence, and close the gap.Ripple Delete

Remove a gap and collapse the elements to fill the gap.Close Gap

Manage your timeline to simplify or save space.Commit

Manage render options for the timeline.Render

Other Options

Timeline Options menu Select an option for working on the timeline.

There are a number of audio options in this menu:

To:Select:

Enable scrubbing audio while dragging the positioner.Scrub Audio

Display the animatable Segment Gain level.Show Gain Animation

Display waveforms after an effect is applied to an audio segment.Show Waveforms With Effects

Display waveforms before an effect is applied to an audio segment.Show Waveforms Without Effects

Not display waveforms.Hide Waveforms

Zoom in on the waveform.Increase Waveform Range

Zoom out on the waveform.Decrease Waveform Range
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Use the Rectangle Selection options to select how timeline elements are included in a selection when drawing
a bounding box around them.

To select:Select:

All elements that are partially or entirely included in the bounding box.Inclusive

Only the portions of the elements that fall within the bounding box. Audio is selected on

a sub-frame basis if Sub-frame Positioner is selected in the Timeline section of the Preferences

menu.

Partial

Only the portions of the elements that fall within the bounding box. Audio is selected on

a frame basis even if Sub-frame Positioner is selected in the Timeline section of the Prefer-

ences menu.

Partial A/V

Only elements that are fully in the bounding box.Bounded

Enable Selection Includes Gaps to include empty gaps when performing a timeline selection.

Enable one or both snap options to include in the timeline snap criteria:
■ Snap To Positioner on Gestural Insert

■ Snap Includes Marks

Enable Focus on Trim if you want the timeline positioner to snap to the transition while trimming, allowing
you to view frames in the player.

Timeline Media Management Options

The Commit area of the Timeline Gear menu offers a number of options to help you clean up your timeline
or save space when archiving a project.

Commit Options

When you commit an edit sequence, it becomes one continuous clip. The soft properties of the sequence
such as transitions, head and tail frames, and timewarp data are removed. The visual effects of the transitions
and timewarps remain but you cannot edit them.

You can commit any selection of elements or tracks, or the entire timeline. Commit a portion of an edited
sequence to simplify a timeline that is too complex or to recoup disk space.

You cannot recapture or reimport committed clips.

The following rules apply to hard commits:
■ Hard commits are permanent; however, they can be undone using the Undo button (as long as undos

remain in the undo buffer). If you want to consolidate elements but have the ability to make changes at
a later time, use containers.

■ Hard commits cannot be restored—the commit is permanent.

■ Hard commits force a render on the selected elements.

You can also choose to only commit Timeline FX or ConnectFX segments on the timeline.
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Consolidate Handles

If you have video or audio elements on the timeline that have excessive handles, use the Consolidate option
to remove head and tail frames. Consolidate your clip before archiving a project to avoid archiving a large
number of unused frames. You can keep a specified number of head and tail frames when you consolidate
(the calculator appears when you select Consolidate for you to enter the number of handles you want to
keep). You can consolidate a single element or a selection of elements.
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Audio

You can perform many of the same editing operations on audio that you use to edit video, such as cutting, trimming,
adding fades, and creating stereo tracks. A comprehensive set of audio effects tools is available in the timeline and Audio
Desk for mixing and mastering your audio.

When working with audio you can:
■ In the MediaHub, import and export audio files using a variety of formats.

■ In the timeline, synchronize audio with video, and apply audio fades. You can edit these on the fly while the clip is
playing. You can also assign input strips to output strips. You can also assign audio tracks to Audio Desk input strips.

■ In the Audio Desk, adjust Gain, Pan, Mute, Phase Shift, and Solo settings for up to 32 individual input strips. You can
apply these on the fly while the clip is playing. You can also assign input strips to output strips.

■ In the EQ Desk, apply and adjust High Shelf, Mid Notch, Mid Presence, and Low Shelf filters to input strips.

■ In the Auxiliary Effects Desk, adjust global settings for the Modulation, Delay, and Reverb Auxiliary Effects.

■ In the Audio Desk, adjust the output Gain and Limiting for output strips.

NOTE You can only see the Audio Desk in the single player.

Accessing the Audio Desk
The Audio Desk components are split into two panels; the patch panel will display to the left of the viewer,
while the EQ Desk and the Auxiliary Effects Desk will display to the right of the viewer.

NOTE The Audio Desk is accessible from the Player.

To access the Audio Desk:

1 From the Player view, select the Options drop down.

2 Click Show Audio Desk.

The Audio Desk panels are split to either side of the viewer.

3 Click the Audio Desk Panel button to switch between the Auxiliary Effects Desk and the Eq Desk panels.

10

257



Importing Audio Files
To import an audio file:

1 Click the MediaHub tab.

2 Enable Browse for: Files.

3 Browse to the location of the audio file.

The audio file thumbnail appears in the browser display.

4 Drag and drop the audio file from the browser into a media panel folder.

Adding an Audio Effect on a Segment
To add an audio effect on a segment:

1 Select the audio segment.

2 Right-click on the segment and select Add Effects.

3 Enable one of the audio effects.

4 Adjust the parameters for the audio effect on the Effects Ribbon.

Adjusting the Audio Levels on Part of an Audio Segment
To adjust the audio level on part of an audio segment:

1 Select an audio segment.

2 Set the positioner to the relevant part of the segment.

3 Right-click on the segment and select Add Effect.

The Effects Ribbon for audio effects is displayed.

4 Select Gain Audio effects.

The toolbar displays the Gain features.

5 Enable Edit and Auto Key.

6 Right-click on the Gain slider and set Key frame.

7 Move the positioner down the sequence.

8 Adjust the Gain slider.

Another key frame is automatically created at the gain level selected.

The audio level is adjusted to the new gain.

You can click and drag the keyframes in the segment to adjust the audio level. Holding Shift + dragging
constrains the adjustment vertically or horizontally. Setting the gain slider to zero brings the audio level
back to the segment default.

Cross-fading Two Audio Segments Together
To cross-fade two audio segments together:

1 Move the vertical focus point inline with the relevant audio track.
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2 Navigate to the cut point of the two audio segments with the positioner.

3 Click the Transition button.

4 In the Audio Transitions tab, enable Fade.

An audio transition is applied to the cut point of the two audio segments.

5 Adjust the length of the fade.

The audio cross-fades between the two audio segments.

Fading Audio Into or Out of a Clip
To fade audio into or out of a clip:

1 Move the vertical focus point inline with the relevant audio track.

2 Navigate to the beginning (or end) of the segment.

3 Click the Transition button.

4 In the Audio Transitions tab, enable Fade.

An audio transition is applied to the audio segment.

5 Adjust the length of the fade.

The audio is now fading into (or out of) the clip.

Scaling the Size of the Waveform
To scale the size of the waveform:

1 Do one of the following:

■ Drag the audio track to increase or decrease the track size, or

■ From the Audio pull down menu in the Timeline Menu Bar, choose Increase Wave Form (or to
decrease it, Decrease Wave Form).

Displaying Audio Waveforms
To turn audio waveforms on:

1 From the Timeline Menu Bar at the bottom of the screen, select Audio > Show Waveforms With Effects.

The Waveform display for all audio segments is turned on.

To turn audio waveforms off:

1 From the Timeline Menu Bar, select Audio > Hide Waveforms.

The Waveform display for all audio segments is turned off.

To show audio waveforms without effects:

1 From the Timeline Menu Bar, select Audio > Show Waveforms Without Effects.

All Waveforms from the source are displayed and any audio timeline effects modifications are not
reflected in the Waveforms.
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Muting Audio Tracks
To mute an audio track in the timeline:

1 Locate the track you want to mute.

2 Click the speaker icon in the track identifier strip.

The speaker icon displays as a crossed-out icon to indicate the track is muted.

To mute an input strip:

1 In the Audio Desk, enable the Mute button for the input strip that you want to mute.

The strip is muted. In the case of a stereo audio track, both strips are muted.

Mapping Audio Tracks to Audio Desk Input Strips
In the patch panel each audio track has a small square box with a number. That number is the audio input
that is matched to the numbers at the bottom of each audio strip at the bottom of the audio desk.

To map audio tracks:

1 Click on the audio input channel box in the patch panel.

2 Drag right or left and choose the audio input strip into the audio desk you would like this particular
audio track to be patched too.

An audio track input is selected.

If the input channel box is empty, the audio track is not patched to an audio desk input. You will not hear
audio segments for that track.

Normally all these mappings are automated. It is important to understand these outputs are either the audio
channel outputs for your hardware or discrete channel outputs for files exported to the application.

Converting Audio from Stereo to Mono or Mono to Stereo
To convert a stereo audio track to two mono audio tracks:

1 Select the stereo track by clicking on the audio channel strip.

2 From the Timeline Gear menu, select Stereo ➤ Split Stereo Track.

To convert mono audio to stereo audio:

1 Select two mono tracks by control-clicking on the audio channel strips.

2 From the Timeline Gear menu, select Stereo ➤ Merge Into Stereo Track.
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Timeline Transitions

Timeline transitions are effects you apply directly to the transitions between clips. As such, they accelerate the process of
creating and modifying effects because you don't have to enter the editor to apply them.

In order to access the Timeline transitions, you must move the positioner directly over a transition in the timeline or
explicitly select it. There are separate video and audio transitions, depending on what type of clip you want to apply effects
to.

The Timeline video transitions are:

■ Dissolve

■ Wipe

■ Axis.

The Timeline audio transitions are:

■ Fade
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Adding Timeline Transitions
To add Timeline transitions to the timeline:

1 Select a transition in the timeline to enable the Transitions button. A proxy of the last frame of the
left-hand segment, and the first frame of the right-hand segment, with a cut between the two segments,
appears next to the Transition button.

2 Click the Transition button to display the Effects menu, and select the effect you want to apply. You
can also right-click one of the proxies or the cut between the proxies and select one of the effects. Once
you have selected an effect, a proxy of the effect replaces the cut between the left and right segment
proxies.

3 You can adjust the effect's settings using the quick menu, or click the Enter Editor button to enter the
full editor of the effect.

NOTE Only one Timeline transition effect can be applied at a time. Each time you apply a new effect, only
the proxy of the last effect you applied will appear between the segment proxies, and you will only be able
to modify the settings of the latest effect applied.

Copying, Moving and Removing Timeline Transitions
To copy, move or remove Timeline Transitions, follow the steps below.

To copy Timeline Transitions:

1 Select a Timeline Transition.

2 Right-click the Timeline Transition and choose Copy or press Ctrl+C.

3 Select another transition in the timeline and either Right-click and select Paste or press Ctrl+P.

NOTE Copying a Timeline Transition on to another Timeline Transition overwrites the one that was originally
there.

To move Timeline Transitions:

1 Select a Timeline Transition.

2 Drag the Timeline Transition to another transition and release the cursor.

To Remove Timeline Transitions from the timeline:

1 Select a Timeline Transition.

2 Either Right-click on it and select Delete or press Alt+Click. You can also drag it to the bottom of the
screen and release the cursor.

Adding Dissolve Timeline Transition
Use the Dissolve Timeline Transition to blend transitions between timeline elements in which the first clip
fades out at the same time as the second clip fades in.

NOTE To create a transition, you must have enough head and tail frames in the outgoing and incoming shots.
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To apply the Dissolve Timeline Transition:

1 Move the positioner between the two video clips where you want to add the transition.

2 Click the Transitions button to display the Effects menu and select the Dissolve button or right-click
the positioner and select Add Dissolve.

3 The settings for the Disslove Transition appear on the Effects menu.

4 Adjust the settings for the transition. You can also click the Enter Editor button to access the full editor
for the transition.

You can also create a fade to black (fade-out) by adding a dissolve at the end of the last segment or at the
end of a segment followed by a gap.

Additionally, instead of fading to or from black, you can specify a colour for the dissolve. You can use the
custom colour for fade-ins, fade-outs, and crossfades.

Select the dissolve you want to modify.

Depending on the type of dissolve you selected, one of the following custom colour buttons appears in the
Effects menu:

1 If you selected a fade-in, a From Colour button appears.

2 If you selected a fade-out, a To Colour button appears.

3 If you selected a crossfade, a To/From Colour button appears.

4 Click the custom colour button.

5 Select a colour from the colour picker. The custom colour dissolve is created.

NOTE If you selected a dissolve that is between two elements (not a fade-in or fade-out), the dissolve is split
into a fade-out for the outgoing shot and a fade-in for the incoming shot.

Adding Wipe Timeline Transition
Wipe Timeline Transitions are non-blending transitions. Use them to enable masks that hide or reveal the
outgoing or incoming shots.

NOTE To create a transition, you must have enough head and tail frames in the outgoing and incoming shots.

To apply the Wipe Timeline Transition:

1 Move the positioner between the two video clips where you want to add the transition.

2 Click the Transitions button to display the Effects menu and select the Wipe button or right-click the
positioner and select Add Wipe.

3 The settings for the Wipe Transition appear on the Effects menu.

4 Adjust the settings for the transition. You can also click the Enter Editor button or click on the Wipe
button in the Effects pipeline to access the full editor for the transition.

NOTE You can enter the Stabilizer from the Wipe Editor by selecting a vertex and then clicking the Stabilizer
button.
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Accessing the Wipe Schematic

Axis and Geom nodes are added to the schematic when you create a garbage mask. Axis nodes are used to
control a mask's position, rotation, and scaling, for example. Geom nodes contain information about how
the mask will affect the image (softness, opacity, alpha, and axis offset).

To access the Wipe schematic:

1 Add a Wipe Timeline transition to the timeline.

2 Double-click the Wipe button in the Effects pipeline or click the Enter Editor button.

3 Click the World View box and select Schematic.

NOTE Once you are in the Schematic view, you can click the Node box to add either geometry or an Axis
node to the schematic.

Adjusting Preset SMPTE and Custom Wipes

Templates are included with the preset SMPTE wipes that come with your application. If you modify the
start position or increase the duration for a SMPTE wipe, the interpolation for the transition may not be as
even as it should be. For example, if you load a preset SMPTE pattern and change its default start position
by a large number of frames, the transition may appear to jump at the last frame. Or, if you increase the
duration of the transition by a large number of frames, the interpolation may also appear to jump between
some frames. Use Adjust to fix this problem.

With custom wipes, you may need to create a template if:

■ You intend to change the default start position for the wipe by using the X and Y Position fields in the
Wipe Effects menu.

■ You intend to increase the duration of the transition by a large amount.

■ You intend to use the custom wipe often.

■ The custom wipe has no tracking data.

When you create a template, you must specify the default start position and then define an End Bias for all
nine possible end positions. Once you create the template, you must enable the blue light on the Template
button to make the Adjust option available.

To adjust a preset SMPTE wipe:

1 Click the Wipe icon on the timeline or click the Wipe Timeline Transition button in the Effects pipeline
to display its settings on the Effects menu.

2 Click Pattern, and then select a wipe pattern in the file browser.

3 Move the positioner to the first frame of the transition.

4 Select Position from the Global Axis box, and then change the start position of the transition of the
wipe using the X and Y Position fields.

If you scrub the transition, you should see the wipe make a large jump at the last frame.

5 If the Adjust button is not greyed out, enable it.

NOTE If the Adjust button is greyed out, a template does not exist for the wipe and you must select a
different pattern in order to use the Adjust feature.

The jump in the wipe should be gone and the interpolation for the wipe should be fairly even.
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To start, end and adjust custom wipes, follow the instructions below.

To set the start position for a custom wipe:

1 Create your wipe. See Creating Customized Wipes with Garbage Masks (page 660).

2 Select the transition on the timeline and click Pattern. The File browser appears.

3 Select Custom in the SMPTE wipes box to view saved custom transitions.

4 Select the custom transition you want to use. Your custom wipe is applied to the transition icon on
the timeline.

5 Click the Enter Editor button or double-click the Wipe Timleine Transition button in the Effect pipeline
to enter the Wipe Editor.

6 Click Template to display the Template menu.

7 Enable the Template Mode button to view the template in the image window.

8 Click Start Position.

9 Set the default start position by enabling a Start Position button, for example, Top Left.

To set the end bias for a transition:

1 Click End Bias.

The positioner goes to the last frame of the wipe.

2 Set the value in the currently enabled End Bias box to 0. (The currently enabled End Bias box should
be the same as the default start position.)

On the last frame, the point closest to the centre of the axis should be just outside the image. This
ensures that the mask fully covers the incoming image. If it does not, click the Mask button and
proportionately increase the scale of the mask.

3 Set an End Bias for every End Bias position:
■ Click each End Bias box and drag the value until the mask is just large enough to encompass the

entire image.

To set the end bias for a transition:

1 Click End Bias.

The positioner goes to the last frame of the wipe.

2 Set the value in the currently enabled End Bias box to 0. (The currently enabled End Bias box should
be the same as the default start position.)

On the last frame, the point closest to the centre of the axis should be just outside the image. This
ensures that the mask fully covers the incoming image. If it does not, click the Mask button and
proportionately increase the scale of the mask.

3 Set an End Bias for every End Bias position:
■ Click each End Bias box and drag the value until the mask is just large enough to encompass the

entire image.

To adjust the custom wipe:

1 Enable Template.

2 Exit the Wipe Editor.

3 Change the X and Y position for the wipe in the Wipe quick menu, or increase the duration of the
transition.

Notice how the interpolation causes the last frame of the wipe to jump.
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4 Enable Adjust in the Wipe quick menu. The interpolation of the transition should be much smoother.

Creating Customized Wipes with Masks

Use masks on the incoming clip to create a customized transition that wipes into the outgoing clip.

Before you create a mask, set how the points of the mask are drawn.

To set the drawing options:

1 From the Wipe Editor, click Setup.

2 Specify the setup options.

To:Enable:

Create tangents for every new point you set.Auto Tangents

View the border defined in the Offset field of the Shape menu. The colour pot next
to the Show Border button defines the colour of the border.

Show Border

Reverse your wipe. For instance, if you originally create an expanding box wipe,
enabling Invert creates a shrinking box.

Invert

Allow animation of points on the mask.Spline Keyframing

3 To change the colour of the mask's wireframe, colour points, or offset border, click a colour pot and
pick a new colour.

An Axis node contains all the rotation, scaling, and position data for the mask. You can change all this
information in the Mask menu. The Axis controls are identical to those in the Action Axis menu.

You can animate the following mask properties:

■ The characteristics of the camera in the scene

■ The position, rotation, scaling, and shearing

■ The mask shape

■ The offset, border offset, border alpha, colour, and opacity

To display the Animation menu, click the Animation button.

Creating a Mask

To create a mask, you must enter the full editor for the Wipe effect.

NOTE When you create a mask, an Axis node and a Geom node are added to the Wipe schematic.

To create a wipe mask:

1 From the Wipe Editor, click Mask.

2 Select Geometry from the Node box.
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(a) Add button (b) Node box (c) Edit Mode box

3 Click Add, or select Create from the Edit Mode box.

TIP You may want to display the outgoing or incoming clip while drawing the mask since the composite is
created in Result mode.

4 Click the image to create the first point.

NOTE If you are drawing a mask freehand, press Shift and then press down on the cursor to draw the
mask. When you release the cursor, the mask closes automatically.

5 Click again to draw the second point.

(a) Tangent (b) Vertex

NOTE If you are not in Auto Tangents mode, you can still create a tangent while setting a point by clicking
and dragging the cursor.

6 To close the mask, click Close or click the first point.

Modifying a Mask's Shape

You can manipulate points on a mask while displaying the incoming or outgoing clip.

Select points using the Select option in the Edit Mode box. You can select individual points, individual
tangents, or a group of points:

1 To select a point or tangent, click it.

2 To select additional points, press Shift and click the point. You can also press Shift+Ctrl and drag
across a series of points.

3 To select multiple points, press Ctrl and drag the selection box over a series of points.

Adding Wipe Timeline Transition | 267



You can break or modify a tangent using the Break option in the Edit Mode box:

1 Click a point to remove any tangents connected to that point.

2 Click a tangent and hold down the cursor to edit it separately from its opposite tangent. You can also
select the Move option to edit the tangent without editing its continuity. Click the tangent again and
hold down the cursor to edit the continuity of the tangent. Click the tangent again and hold down
the cursor to edit the continuity of both tangents.

3 Click a point to remove any tangents connected to that point.

You can use the Auto option in the Edit Mode box to calculate the tangent for a point according to the curve
the point is on. Select the Auto option and click a tangent.

Controlling a Mask's Effects

You can control a mask's effect in the Mask menu.

NOTE The Geom node contains all the information about how a mask affects the final transition.

To control a mask's effect:

1 Select Matte or Result.

2 Select the mask in the image window.

3 Click Mask.

4 Set the mask opacity in the Opacity field.

The Opacity field defines the effect the mask has on the matte. A value of 100% means the inside of
the mask is completely opaque. A value of 50% means the inside of the mask is 50% transparent. A
value of 0% has no effect on the image.
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(a) Colour and Opacity fields (b) Alpha and Offset fields (c) Axis Offset fields

Mask with 100% opacityMask with 0% opacity

5 Set the mask colour in the Colour field.

The Colour field defines the blend between the outgoing and incoming image inside the mask. A value
of 50% is a 50/50 blend between the outgoing and the incoming clip. A value of 100% displays only
the outgoing clip. A value of 0% displays only the incoming clip.

Mask with 75% colour and 100% opacityMask with 25% colour and 100% opacity

6 Set the mask softness (see below).

7 Set the axis offsets in the Axis Offset fields.

The Axis Offset fields defines how much a mask is offset from its axis.

8 Enable Outside to apply the effect to the part of the image outside the mask shape.
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You can adjust the softness gradient of a mask to smoothen the edges of your wipe. You can create a uniform
gradient around the edge of the mask or use an advanced gradient to control the shape of the gradient at
different parts of the mask.

To create a uniform gradient, you define how far you want the gradient to be offset from the edge of the
mask and then set its transparency. To vary the shape of the gradient, you move vertices on inner and outer
softness splines. The gradient will be based on how far each vertex point is offset from the mask.

For either type of gradient, you can smoothen the gradient towards the inside edge, the outside edge, as
well as the area where the inside and outside adjustments have an effect.

To smoothen the gradient of a mask:

1 From the Wipe Editor, click Mask.

2 To create a uniform gradient around your mask, do the following:
■ If necessary, toggle the Edge Softness button to Softness.

■ Set the border of the softness gradient using the Offset field. Your gradient will be affected by how
far the softness border is offset from the edge of the mask.

■ Set the transparency of the gradient using the Alpha field.

3 To change the shape of a gradient at different parts of the mask, do the following:
■ If necessary, toggle the Edge Softness button to Advanced Gradient.

■ Adjust the distance of the inner and outer splines from the mask by adding and moving vertex
points on the splines. If you do not see the inner and outer splines, enable Splines.

4 Use the Inner Edge field to smoothen the softness gradient towards the inside.

5 Use the Outer Edge field to smoothen the softness gradient towards the outside. Adjusting this value
is especially noticeable if you are smoothening a transition from a black inside edge to a white outside
edge.

6 Use the Distance field to modify the area over which the Inner and Outer Edge adjustments have an
effect.

Tracking with Masks

You can track a point on your clip and apply that data to the axis of a piece of geometry or a hierarchy of
objects. You can also track individual points on the mask.

NOTE The points in the mask are not affected by the tracking data. The tracking data is applied to the entire mask.

To track the entire mask:

1 After creating a wipe, access the Wipe Editor and click Mask.

2 Select the wipe's mask axis.

3 Select Front or Back from the Layer box to specify whether you want to track on the outgoing clip
(Front) or the incoming clip (Back).

270 | Chapter 11   Timeline Transitions



(a) S (Stabilizer) button (b) Layer box (c) Adjust option box

4 Select an option from the Adjust option box.

Select Adjust Offset if the selected mask is parented to one axis. Select Adjust Axis if the selected mask
is parented to a hierarchy of objects.

5 Go to the first frame of the transition.

6 Click Stabilizer.

7 Set up the tracking point as needed.

8 Click Analyse.

Fine-tune your analysis if necessary.

9 Click Return.

The Wipe Editor reappears.

You can also track individual points on a mask so that portions of the mask follow a point in the clip. Each
point you select is assigned a tracker box in the Stabilizer. The points are repositioned according to the
reference point you set in the Stabilizer.

To track individual points on a mask:

1 After creating a wipe, access the Wipe Editor.

2 Select a vertex or a group of vertices on a wipe's mask.

3 Click Mask.

(a) S (Stabilizer) button (b) Layer box (c) Adjust option box

4 Select Front or Back from the Layer box to specify whether you want to track on the outgoing clip
(Front) or the incoming clip (Back).

5 Select an option from the Adjust option box.
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Select Adjust Tangents if you want the tangents for the selected points to be adjusted while the points
are being tracked.

6 Go to the first frame of the transition.

7 Click Stabilizer.

The Stabilizer appears. A Tracker button appears for each selected vertex.

(a) Tracker buttons (b) Analyse button

8 Click Tracker 1, and then set up the first tracking point.

9 Click Tracker 2 to set up the second tracking point, and then continue setting up tracking points for
all remaining vertices.

10 Click Analyse.

Fine-tune your analysis if necessary. For example, disable problem trackers and analyse again.

11 Click Return.

The Wipe Editor reappears.

12 Fine-tune your mask if necessary.

Adding Axis Timeline Transition
Use the Axis Timeline Transition to modify the scaling, rotation and position for the axis of one image to
create the transition effect.

You can quickly swap the incoming and outgoing sources to reverse the animation. Swapping sources
accommodates applications such as Apple's Final Cut Pro and Avid products, where the effect is applied to
the outgoing source rather than the incoming source.

NOTE The Axis Timeline Transition menu is the same as the Axis Timeline FX menu.

To apply the Axis Timeline Transition:

1 Move the positioner between the two video clips where you want to add the transition.

2 Click the Transitions button to display the Effects menu and select the Axis button or right-click the
positioner and select Add Axis Transition.

3 The settings for the Axis Transition appear on the Effects menu.

4 Adjust the settings for the transition. You can also click the Enter Editor button to access the full editor
for the transition.

To swap the sources of an Axis Timeline Transition:

1 Select a transition point in the timeline.
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2 Right-click on the transition point or click the Transition button to bring up the Effects menu.

3 Select an Axis transition.

4 Create the transition. For example;
■ At the first frame of the transition, set the Scale X and Y values to 0.

■ At the last frame of the transition, set the Scale X and Y values to 100

5 Play the transition.

6 In the Effects menu, enable the Swap button.

NOTE In the full Axis editor, the Swap button is called the Swap Source button.

7 Play the transition again. This time the incoming and outgoing sources are switched and the animation
is reversed.

Adding Fade Timeline Transition
Use the Fade Timeline Transition to specify the duration of a fade, the interpolation of the fade-in and
fade-out, and the rate of the fade. The Fade Timeline Transition is the only transition on the Audio Effects
menu and in the pipeline.

To apply a Fade Timeline Transition:

1 Move the positioner between the two audio clips where you want to add the transition.

2 Click the Transitions button to display the Effects menu and select the Fade button or right-click the
positioner and select Add Fade.

3 The settings for the Fade Transition appear on the Effects menu.

4 Adjust the settings for the transition. You can also click the Enter Editor button to access the full editor
for the transition.
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Timeline FX

Timeline FX are effects you add directly to clips on the timeline. As such, they accelerate the process of creating and
modifying effects because you don't have to enter the editor to apply them.

There are separate video and audio effects, depending on what type of clip you want to apply effects to.

Timeline FX follow a specific processing order. Each effect, regardless of when it is applied to a clip, will be processed in
the same order in the pipeline.

The processing order of the Timeline Video effects is as follows:

■ Time Warp

■ Resize

■ Text

■ Colour Correct

■ Spark

■ Blend

■ Wipe

■ Axis

The processing order of the Timeline Audio effects is as follows:

■ Time Warp

■ Gate

■ Compression

■ Equalizer

■ Gain

■ Reverb Send

■ Delay Send

■ Mod Send

12
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Modifying Clip Format and Import Options on the Timeline
You can access format and import settings of an imported clip directly on the timeline. In the Editing panel,
these options are represented in the Effects pipeline, prior to the application of any Timeline FX. These
options can be edited for the selected clip, and copied and pasted to other segments that use the same clip
format.

For example, after importing R3D footage and adding it to the timeline, you can edit the colour curves of a
clip in the Effects pipeline, and also copy the option from the Effects pipeline directly to other R3D clips
that are used in the same timeline.

To access the Format and Pre-processing Options Editor:

1 Click the Timeline tab.

2 Select the clip in the timeline to display its Effects pipeline.

3 Do one of the following:

NOTE Format and import options are accessible in the same editor. You can open the editor once, then
switch between menus in the editor to edit different option types.

■ Select the Format Options button in the Effects pipeline, and click the Editor button in the quick
menu.

The Basic menu opens. Format options will be saved to this menu.
■ Select the Pre-Processing button in the Effects pipeline, and click the Editor button in the quick

menu.

The Resize menu opens. Import options will be saved to this menu and the RGB LUT menu.

To copy format and import options to another segment on the timeline:

1 Select the clip you wish to copy in the timeline.

2 In the Effects pipeline, do one of the following:
■ To copy basic clip format settings, Click and drag the Format Options button to another segment

on the timeline.

■ To copy resize and RGB LUT settings, click and drag the Pre-processing button to another segment
on the timeline.

Gaps
Gaps are empty spaces between elements in an edit sequence. When you apply Timeline FX to a gap, you
create a gap effect,.
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While Timeline FX can only be applied to a clip, the effects applied to gaps are independent of all media.
They effect the media under them.

Gaps usually appear in the following places:

■ The empty space between media elements on a video track.

■ An empty video track.

■ The space between cut points on an empty video track. Cut points are useful for containing a gap effect
applied to an empty video track. The areas to either side of the cut points are also gaps.

(a) Space between cut points (b) Empty Track(c) Empty space between elements

Gap effects are not restricted by in points, out points, cuts and transitions, so they are easily trimmed, moved
and duplicated. You can trim a gap effect over the entire duration of the video track regardless of the
underlying cut points.

You can also freely edit cuts and transitions between elements on video tracks under the gap effect. You can
cut an element, add a transition at the cut point, and then replace the incoming element without affecting
the gap effect. In addition, gap effects can be copied and placed over different media in the timeline.

Adding Timeline FX to Gaps

To add Timeline FX to a gap:

1 Move the positioner and its focus point over the gap to select the gap, or explicitly select the segment.

2 Click the FX button and select the Timeline FX you wish to apply to the gap, or select a Timeline FX
from the Effects Menu and drag it to the gap.

3 Edit the Timeline FX using the quick menu or click the Enter Editor button to access the full editor.

Modifying Multiple Timeline FX
You can modify Timeline FX from different clips at the same time by mulit-selecting clip segments. Selecting
multiple segments allows you to apply changes to effects in one segment, and have those changes applied
to the same effects in the other segments.

To modify multiple Timeline FX:

1 Select multiple segments in the timeline.

2 Add or edit an effect in one segment using the Effects Menu. Those modifications will be applied to
all segments which you have selected.
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Copying Timeline FX
You can copy Timeline FX from the timeline to the workspace, from the workspace back to the timeline, or
from one segment on the timeline to another. Additionally, you can copy multiple Timeline FX to the
workspace or another segment simultaneously, as long as the Timeline FX you want to copy are from the
same segment.

To copy Timeline FX from the timeline to the workspace:

1 Select the Timeline FX you wish to copy either by clicking the specific FX button in the Effects pipeline
or by clicking the FX proxy on the track.

NOTE If you want to select the FX proxy on the track, you may have to resize the video or audio track so
that the effect is visible on the timeline.

2 Drag the Timeline FX to the workspace. If you want to copy multiple Timeline FX, Ctrl-click the ones
you wish to copy and drag them to the workspace.

The Timeline FX proxy appears in the workspace. It displays the front view of the effect, the effect you
copied, and the name of the effect. If you copied multiple Timeline FX, they will appear as a single black
proxy displaying the names of the Timeline FX.

To copy Timeline FX from the workspace to the timeline:

1 Select the Timeline FX proxy you wish to copy or click the specific Timeline FX button in the Effects
pipeline and drag it to a segment on the timeline.

To copy Timeline FX from one segment in the timeline to another:

1 Click the Timeline FX proxy you wish to copy, or click the specific Timeline FX in the Effects pipeline,
and drag it to the other segment. If you want to copy multiple effects, Ctrl-click the ones you wish
to copy and drag them to the other segment.

NOTE If you want to select the FX proxy on the track, you may have to resize the video or audio track so
that the effect is visible on the timeline.

Sliding Timeline FX KeyFrames
To slide Timeline FX within a clip:

1 Select the Timeline FX that you want to slide by clicking it in the Effects Menu or clicking the effect
icon in the clip.

2 If the clip does not already contain animation keyframes, set keyframes on the clip to animate the FX.

3 Select how the animation channel is affected when you slide the animated effects by choosing an
option from the Keyframe Move Modes box.

To:Select:

Resize the channel as you trim. The animation channel is scaled to fit into the
timeline element. This option has no effect when you slip or slide.

Reposition Proportionally

Link the keyframes to their original frame numbers. The animation channel moves
to follow the original frames as you trim.

Shift With Media
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To:Select:

Unlink the keyframes from their original frame number. The animation channel
remains with the timeline element as you trim.

Pin To Segment Start

4 From the Editorial Mode box, select Slide Keyframes, which allows you to slide all of the keyframes of
a specific Timeline FX on a clip.

NOTE You can only slide one Timeline FX at a time.

Muting and Deleting Timeline FX
If you want to temporarily remove Timeline FX from a clip, you can mute it.

To mute Timeline FX:

1 From a segment on the timeline, select the Timeline FX you wish to mute.

2 Then from the Effects menu, Click the blue LED on the Timeline FX button. The LED on the button
will turn dark to indicate that the Timeline FX has been turned off. The blue LED on the Timeline FX
in the segment on the timeline will turn off as well, indicating that the effect has been muted. To
unmute an effect, click the LED on the Timeline FX button in the Effects menu. The LED will turn
blue, to indicate that the Timeline FX has been unmuted.

To delete Timeline FX:

1 Then from the Effects menu, Click the blue LED on the Timeline FX button. The LED on the button
will turn dark to indicate that the Timeline FX has been turned off. The blue LED on the Timeline FX
in the segment on the timeline will turn off as well, indicating that the effect has been muted. To
unmute an effect, click the LED on the Timeline FX button in the Effects menu. The LED will turn
blue, to indicate that the Timeline FX has been unmuted.

2 Select the Timeline FX from a segment in the timeline that you want to delete.

3 Either click the Timeline FX and drag it to the bottom of the screen, or right-click the Timeline FX,
and from the context menu select Delete. You can also click the Delete button on the right side of the
Effects menu.

Adding Timewarp Timeline FX
Use the Timewarp Timline FX to speed up or slowdown clips on the timeline. The Timewarp Timeline FX
is the first effect on both the Video and Audio Effects menu and in the pipeline.

There are two Timewarp Timeline FX, one for video and one for audio; depending on what type of clip you
select, you will have access to one or the other when you click the FX button.

To apply Timewarp Timeline FX:

1 Select the video or audio clip you wish to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Timewarp button. A timewarp icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Muting and Deleting Timeline FX | 279



Adding Resize Timeline FX
Use the Resize Timeline FX to set how the segment adjusts itself to the timeline resolution and change the
bit depth directly on the timeline. The Resize Timeline FX is the second effect on the Video Effects menu
and in the pipeline.

A Resize Timeline FX is automatically applied to clips added to the pipeline that do not have the same
resolution or scan mode as the current clip on the timeline. When you mix different clips of different
resolutions on the timeline, the Resize Timeline FX is applied using the following attributes:
■ Resolution

■ Bit Depth

■ Scan mode

To apply Resize Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Resize button. A resize icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding Text Timeline FX
Use the Text Timeline FX to add movement and colour to text over time. The Text Timeline FX is the third
effect on the Video Effects menu and in the pipeline.

Most Text Timeline FX can be previewed in real time. You can add several stacked Text Timeline FX to a
timeline without significantly affecting performance.

Text Timeline FX differ from the full Text editor in several ways. With Text Timeline FX you can:
■ Create a text layer with or without a matte

■ Create a matte key

■ Add text to a gap effect

You can also edit attributes such as colour and font directly in the XML file.

NOTE To use logos, you will have to work with the full Text editor.

To apply Text Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Text button. A text icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.
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Creating a Text Matte Key

A matte key allows you to create a text effect in which the text's fill is a background clip. When used with
an Axis Timeline FX (or a Sparks effect that takes a matte), it can be used to layer text made of one background
on top of another background.

NOTE All static (non-animated) fill colours are set to a transparency of 0%.

To create a text matte key:

1 Add two layers to the timeline.

2 Click the FX button or right-click on the clip and select Add Effect. The Effects Menu appears.

3 Click the Text button.

4 To enter the Text menu, click the Text in the Effects Pipeline or click the Enter Editor button.

5 In the Text editor, enable the Matte Key button.

The Alpha Processing Mode box changes to RGBA and the Fill field resets to 0%.

6 Select Context from the Preview Options box to preview the effect.

The text fill is composited over the background layer. This text layer is then applied to the timeline
background layer.

Adding Colour Correct Timeline FX
Use the Colour Correct Timeline FX to add colour corrections directly on the timeline. You can also colour
correct segments on the timeline using the Colour Warper. The Colour Correct Timeline FX is the fourth
effect on the Video Effects menu and in the pipeline.

To apply a Colour Correct Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Colour Correct button. A colour correct icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

NOTE Click the Colour Correct button to toggle between Colour Correct and Colour Warping Settings.

Colour Matching on the Timeline

To colour match using the Triptych player:

1 Click the Layout button and select the Triptych player, or swipe to the side of the Viewing Panel
to prompt the Layout Selection Overlay.
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2 Move the positioners over the elements you want to use for the colour match. See Comparing
Three Shots in the Triptych Player (page 210).

3 Click the FX button or right-click on the clip and select Add Effect. The Effects Menu appears.

4 Click the Colour Correct button.

5 To enter the Colour Corrector menu, click the Colour Corrector in the Effects Pipeline or click
the Enter Editor button.

6 In the Colour Corrector editor, click the Curves tab to display the Curves menu.

7 Click the Source colour pot.

8 Plot the colour you want to modify by selecting it with the eyedrop cursor.

9 Plot the match colour in Dest 1 or Dest 2.

10 Specify the match parameters by enabling the Channel Match button and selecting a channel
from the Channel Selection box.

11 Click either Match 1 or Match 2.

The Match curves update. You can fine-tune the result by adjusting the curves handles.

Adding Sparks Timeline FX
Use the Sparks Timeline FX to apply video Sparks to video elements in the timeline. The Sparks Timeline
FX is the fifth effect on the Video Effects menu and in the pipeline.

Sparks Timeline FX are applied below Axis and Wipe effects. If you want to apply a Sparks Timeline FX to
an element that contains an Axis or Wipe effect, you need to contain it first if the result of the Axis or Wipe
effect is required by the Sparks. You can also apply a Sparks Timeline FX to a gap above the element containing
an Axis or a Wipe effect.

To apply Sparks Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Sparks button. A sparks icon appears on the clip.

4 If the Sparks you are using requires a matte, click the Matte button in the Effects menu to load the
matte.

5 Click the Sparks button to load your Sparks.

6 Depending on what Sparks you load, there may be additional setting on the Effects menu. Additionally,
and also depending on what Sparks you load, you my be able to enter the full editor by clicking the
Enter Editor button.
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Adding Blend Timeline FX
Use the Blend Timeline FX to adjust the transparency between layers on the timeline. The Blend Timeline
FX is the sixth effect on the Video Effects menu and in the pipeline.

To apply Blend Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Blend button. A blend icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding Wipe Timeline FX
Use the Wipe Timeline FX to create vertical wipes between layers on the timeline. The Wipe Timeline FX is
the seventh effect on the Video Effects menu and in the pipeline.

To apply Wipe Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Wipe button. A wipe icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

NOTE For information on creating wipes with masks, see: Creating Customized Wipes with Masks (page
266).

Adding Axis Timeline FX
Use Axis Timeline FX to create a single layer composite directly on the timeline. The Axis Timeline FX is
the eighth effect on the Video Effects menu and in the pipeline.

NOTE Adding an Axis Timeline FX will automatically mute a Resize Timeline FX, however the Resize Timeline FX
can be unmuted.

To apply Axis Timeline FX:

1 Select the video clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Axis button. An axis icon appears on the clip.

4 Adjust the settings of the effect. You can also click the Enter Editor button to access the full editor for
the effect.
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Adding Matte Containers

A matte container is a container with the RGB portion of an image on one track and its matte on another.
If the matte for a clip exists separately from it, you can add the clip and its matte to the timeline as a single
element by creating a matte container for them.

To create a matte container:

1 Select the clip you want to add the matte container to.

2 Click the FX button and add an Axis Timeline FX or right-click on the clip, select Add Effect and choose
the Axis Timeline FX.

3 From the Axis Timeline FX settings, click the Matte button.

4 Select a Matte from the Workspace. The Matte Container button appears in the Effects Menu.

5 To open the Matte Container, click once on the Matte Container button and then click open, or
double-click on the Matte Container button.

6 Once the Matte container is open, you can adjust the settings for the matte or add other effects to it.

7 If you want to mute the matte, right-click the Matte Container button and select Mute.

8 If you want to remove the matte, click once on the Matte Container button and then click on the
Uncontain button.

Accessing the Axis Keyer

You can create chroma keys directly on the timeline by accessing the Axis Keyer using the Axis Timeline
FX. When you enter the Axis Keyer, the clip loaded as the Front is the clip with the Axis soft effect, and the
clip loaded as the Back is the next available track on the timeline.

NOTE The preferred keying workflow is to access the Modular Keyer via the Timeline FX. See Setting Up the Nodes
and Media to Pull a Key (page 554).

To access the Axis Keyer:

1 Build a multilayer timeline with a front track and a background.

2 Select the track you want to key, and then right-click and choose Add Effect, or click on the FX button.
The Effects menu appears.

3 Click the Axis button. An Axis icon appears on the track and an Axis button appears in the Effects
pipeline.

4 To enter the Axis editor, click the Axis button in the Effects pipeline, or click the Enter Editor button.

5 In the Object menu, click the Keyer. The Axis Keyer appears.

The Front clip is provided by the clip with the Axis soft effect.

6 Create the key.

The back is provided by the next available clip in the multilayer timeline.

Adding Gate Timeline FX
Use the Gate Timeline FX to lower or remove the perceptible level of noise in an audio signal from an audio
segment. It does not, however, remove noise from the audio signal. The Gate Timeline FX is the second
effect on the Audio Effects menu and in the pipeline.

284 | Chapter 12   Timeline FX



A noise gate is commonly used when the level of the desired signal generally stays above the level of the
noise. In this case, the threshold is set above the level of the noise. When the level of the signal remains
above the threshold level, the gate is open and both the signal and the noise are allowed to pass through.
When the level of the signal falls below the threshold level, the gate is closed and no signal is allowed to
pass. In effect the perceptible noise is attenuated.

To apply Gate Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Gate button. A gate icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding Compression Timeline FX
Use the Compression Timeline FX to reduce the dynamic range of an audio signal from an audio segment.
The Compression Timeline FX is the third effect on the Audio Effects menu and in the pipeline.

When you compress an audio signal, there is less of a difference between the lowest measured gain of the
signal and the highest measured gain of the signal. Compression is useful if your audio signal has many
different loudness levels that you want to play back at a similar perceived loudness level. For example, when
recording voice-overs, you may want to maintain a constant perceived level of loudness in the actor's voice.

You can also compress an audio signal to attenuate portions of the signal that are too loud. For example, if
your recording is at a consistent loudness level, but for some reason there is an unwanted peak in loudness
level, you can compress the loud portion to give it the same perceived loudness as the rest of the recording.

Because compressing an audio signal could have a drastic effect on the overall dynamic range of the signal,
it is not effective in every situation. For example, for a complex recording that has been mixed down from
many other audio sources, such as a vocal track with music and sound effects, the audio signal might have
complex differences in loudness levels. If you compress a master audio signal such as this, you will lose
many of the original qualities of the audio signal. In such cases, it is advisable that you compress the source
audio track before mixing down.

If you are editing a pair of mono tracks that you wish to process as stereo tracks, you should merge both
tracks into one stereo audio track. This ensures that the same compression is used on both left and right
channels.

To apply Compression Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Compression button. A compression icon appears on the clip.

4 Adjust the settings fo the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding EQ Timeline FX
Use the EQ Timeline FX to perform precise manipulations of the audio frequency content using the EQ
Editor, which is based on the graphical display of EQ settings. The EQ Timeline FX is the third effect on the
Audio Effects menu and in the pipeline.
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You can use any of six available filters or nodes: one Low node, four Mid nodes, and one High node. The
Low node can be set to use either a Low Shelf filter or a Low Cut filter. The four Mid nodes can each be set
to either a Mid Notch filter or a Mid Presence filter. The High node can be set to use a High Shelf filter or a
High Cut Filter.

NOTE These filters can have a dramatic effect on the audio so they should be used sparingly.

To apply EQ Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Gate button. A gate icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding Gain Timeline FX
Use the Gain Timeline FX to adjust the gain for individual segments in an audio track. The Gain Timeline
FX is the fourth effect on the Audio Effects menu and in the pipeline.

Gain is the measure, in decibels, of how much a circuit amplifies a signal. You can set the segment gain to
any value from -96.0 dB to +24.0 dB. The segment gain is combined with the input strip gain in the AudioDesk.

1 To apply Gain Timeline FX:

2 Select the audio clip you want to apply the effect to.

3 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

4 Click the Gain button. A gain icon appears on the clip.

5 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

TIP If Show Gain Animation is enabled in the Timeline options menu, you can interact with a Gain Animation
curve directly on a timeline audio clip. In this case, a Gain Timeline FX is automatically applied when you modify
the Gain curve.

Adding Reverb Send Timeline FX
Use the Reverb Send Timeline FX to patch audio segments to the Reverb Auxiliary Effects. The Reverb Send
Timeline FX is the sixth effect on the Audio Effects menu and in the pipeline.

All parameters for the Reverb Auxiliary Effect are set through the Auxiliary Effects panel. You can route any
number of audio segments through the Reverb Auxiliary Effect but the Reverb effect is output in stereo to
two separate output channels, combining the effect on all input segments. You can adjust the amount of
reverberation that can be applied to an individual segment using the Reverb Amount slider.

To apply Reverb Send Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Reverb Send button. A reverb send icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.
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Adding Delay Send Timeline FX
Use Delay Send Timeline FX to patch audio segments to the Delay Auxiliary Effect. The Delay Send Timeline
FX is the sixth effect on the Audio Effects menu and in the pipeline.

All parameters for the Delay Auxiliary Effect are set through the Auxiliary Effects panel. You can route any
number of audio segments through the Delay Auxiliary Effect but the Delay effect is output in stereo to two
separate output channels, combining the effect on all input segments. You can adjust the amount of
reverberation that can be applied to an individual segment using the Delay Amount slider. You can also
send the segment levels to the Left and Right Delay Channels independently using the Pan Delay slider.

To apply the Delay Send Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Delay Send button. A delay send icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.

Adding Modulation Send Timeline FX
Use the Modulation Send Timeline FX to patch audio segments to the Modulation Auxiliary Effect. The
Modulation Send Timeline FX is the seventh effect in the Audio Effects menu and in the pipeline.

All parameters for the Modulation Auxiliary Effect are set through the Auxiliary Effects panel. You can route
any number of audio segments through the Modulation Auxiliary Effect. The Modulation effect applies
globally to the entire sound track and is output in stereo to a pair of output channels, combining the effect
on all inputted audio segments. You can adjust the amount of modulation that can be applied to an individual
segment by using the Mod Amount slider.

To apply Modulation Send Timeline FX:

1 Select the audio clip you want to apply the effect to.

2 Either click the FX button or right-click on the clip and select Add Effect. The Effects menu appears.

3 Click the Modulation Send button. A modulation send icon appears on the clip.

4 Adjust the settings for the effect. You can also click the Enter Editor button to access the full editor for
the effect.
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Creating New Sources Using Tools from
the Tools Tab

The Tools tab provides access to numerous effects and tools allowing you to create modified clips that you can then use
as sources on the timeline or in ConnectFX. The tools use input clips (or in some cases are generated from scratch) that
are then modified through parameters to produce a result directly in the workspace.

Some tools allow you to set parameters directly in the Tools quick menu, and instantly see a rendered result in the
workspace. Other tools have full editors that you enter, allowing you to tweak numerous settings before rendering your
result back to the workspace. In either case, new modified clips are created that you can use in your project.

Saving and Loading Tool Setups

For each tool that has a full editor, you are able to save and load setups. A setup is a file that contains a record of all changes
you make to a clip in a particular tool. This record includes references to clips used—not the clips themselves. Setups let
you save your work separately from clips, so you can load and work on the setup at anytime or apply the setup to other
clips. Setups can be shared between instances of the same effect, whether accessed from the Tools tab, as a Timeline FX,
or from the ConnectFX node bin.

In the tool editor, use the Save and Load buttons to enter the file browser (pointing to the default directory location for
each tool type). From the Load browser, you can also delete previously saved setups. For most tools, you can load or save
setups or preferences/defaults. Preferences are settings that let you customize the display or functioning of some tool
elements, keyboard shortcuts, pen and tablet, and audio (defaults are the default preferences). Some tools, such as Paint,
have more saving and loading options.

Accessing Tools
To access specific tools

1 From the Tools tab, find and click the button for the tool you want to use.

2 If needed, use the Input Mode box to select the number of source clips you want to modify (for example,
front only or combinations of front, back, and matte).

3 Set any tool parameters, as needed.

4 In the workspace, select the source clip(s) needed.

The colour and text of the cursor indicates which clip you should select next. After selecting the source
clips, the cursor changes to white and the text Render Here appears.

5 Select the area to place your modified clip.
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If the result requires no other settings (other than tool parameters), then the rendered result appears
immediately. If more settings are required, a full editor appears.

TIP Some tools, such as Paint, allow you to enter the full editor without inputs. In this case, you can
double-click the tool name, and directly apply the Render Here location.

To access a tool with the same clips as previously used:

1 From the Tools tab, find and click the button for the tool you want to use.

2 Click the "S" button to the right of the tool name, or click Use Current Setup.

3 Select the area to place your modified clip.

The result is rendered or the editor opens with the clips from the previous session. The most recent
settings are also restored.
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Procedural Compositing with Connect-
FX

About ConnectFX

ConnectFX provides a flow graph environment where you perform procedural compositing with integrated access to all
effects and image-processing commands. An effect you create in ConnectFX is a setup applied directly to one or more
timeline segments.

You use the ConnectFX processing environment to assemble a process tree of clips and nodes where the result of each
operation serves as the source for the next one. Because a ConnectFX pipeline is not fixed, you have the flexibility of
reordering and editing nodes.

If you entered ConnectFX with the Generate Composite option selected, any Timeline FX already applied to your segment
are replicated in the ConnectFX schematic. You can then edit these effects directly in the ConnectFX view, or add or
delete as many other effects as needed.

Here is a typical ConnectFX view:
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■ The default viewport layout is a 2-Up view with the schematic (displaying the process tree) on the left, and the result
view on the right. Use the Layout settings under the left viewport to change the layout, or return to this default view.
You can also set the default view to 1-Up in the Timeline FX / CFX section of the Preferences menu.

■ You can change the actual view of the selected viewport using the View box under the right viewport. If a selected
node has its own views, such as Action, you can select node-specific views also.

■ The bottom portion of the ConnectFX view displays the nodes that you can add to your process tree. This bottom area
can also display the menu for the selected node in the schematic view. To switch between the node view and selected
menu view, use the FX Nodes button (located under the left viewport).

■ You can Render your result in the ConnectFX view, or wait until you return to the timeline sequence.

Creating ConnectFX
To create a ConnectFX on a timeline segment:

1 Select one or more video segments on the sequence to which you want to apply a ConnectFX.

2 Click the FX button.

3 Click Create ConnectFX to quickly enter the ConnectFX view. Use this method if you want to enter
ConnectFX with only one timeline segment without existing Timeline FX, or with Timeline FX that
you don't want carried over into ConnectFX.
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NOTE Once you have returned to the timeline sequence from ConnectFX, you can re-enter the same ConnectFX
by clicking Enter Editor in the FX pipeline, or by double-clicking the CFX icon on the segment, or in the pipeline.

Generating a Composite ConnectFX

Use the Generate Composite option when creating a ConnectFX if you want to convert any existing Timeline
FX to a ConnectFX pipeline. When you enter ConnectFX, you'll see that your pre-existing Timeline FX are
now displayed as ConnectFX nodes, allowing you to edit these effects directly in the ConnectFX view, or
add or delete as many other effects as needed.

1 Select one or more video segments on the sequence to which you want to apply a ConnectFX.

2 Click the FX button.

3 Select Generate Composite.

NOTE If you select multiple video elements on the sequence, this option is automatically selected.

4 Click Create ConnectFX to enter the ConnectFX view.

When you return to the timeline, only the CFX icon appears on your clip, as the previous Timeline FX are
now included within the CFX.

In the case of entering ConnectFX with multiple video elements, you can also see that upon exiting
ConnectFX, only one element exists, comprising the composite of the previous elements. To restore your
previous vertical edit on the timeline, you can click Remove CFX and Recover Stack. The previous
configuration of the video elements is restored, but any pre-existing Timeline FX are lost.

Generating an Adjustment Segment ConnectFX

You can create an edit on the timeline in a gap above multiple clips, without losing any of the effects already
on those clips. After creating an adjustment segment, you can add new clips or edit existing clips on the
timeline under the adjustment segment gap, and the ConnectFX is maintained above. You can perform
edits on an adjustment segment as it is treated like any other timeline segment, such as trimming or even
adding other Timeline FX.

There are two ways to add an adjustment segment to the timeline:

■ Add a ConnectFX to a gap in the timeline. In this case, an adjustment segment added by default.

■ Manually click Generate Adjustment Segment when adding a ConnectFX anywhere on the timeline. In
this case, a gap is automatically created on the track above selected segment.

The adjustment segment uses the top media of the tracks below the timeline gap as the input. Inside
ConnectFX, that input is called the Back Clip. For example, if you have three tracks composited together,
and you add an adjustment segment on top of them, the image available through the Back Clip is only the
output of the third track.

The Back Clip node is available in the ConnectFX I/O bin. The Back Clip node does not contain any media;
instead, it offers a link to the Timeline, giving access to the topmost media located below the CFX segment
you are currently working on. Since the Back Clip is only a link to media, you cannot access common clip
settings within ConnectFX. The only settings that are available if you double-click the Back Clip node are
to set what media is available for the head and tail of the adjustment segment.
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About the ConnectFX Process Tree
Use ConnectFX to assemble a series of tasks using nodes. Each node represents a specific Smoke function.
You connect clips with nodes and use the result of one node as the source for the next node. As you assemble
this arrangement in the ConnectFX schematic, you are building a process tree from left to right, that processes
as many output clips as you want.

A process tree begins with a clip, contains at least one node, and ends with a CFX Output node.

Once you are working in ConnectFX, it is easy to add more clips and nodes to achieve your desired result.
Large schematic pipelines are common, so you can group nodes or add notes to nodes to help you manage
clutter.

About Nodes

Nodes have one or more colour-coded input and output points (also called tabs) used for connecting to clips
and to other nodes. All nodes have an output tab. For example, a Colour Correct node can accept a Front,
Matte, and Back connection, whereas an Auto Matte node accepts a Front input.

As you add nodes, you connect them to the process tree by linking the result from one node and using it as
a source (front, matte, or back) for the next node in the process tree. You can also connect by linking backward
from the source of one node to the output of another (to reuse a node’s output).

To connect nodes, you use the coloured tabs on the node's left side; these tabs are called source tabs. The
colours of the source tabs represent different input types. The yellow tab on the node’s right side is called
the Result tab (for some nodes, a blue tab is also present on the right side, this is the OutMatte tab). You use
the Result tab of a node to connect its result to the input tab of another node.

This is a typical node tab configuration. Some nodes have specific tabs related to their function (such as the
forward vector tab on the Pixel Spread node).

(a) Matte tab (b) Back tab (c) Front tab (d) Warning tab (e) Result tab
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TIP If Auto Display of tooltips is enabled in the Preferences menu (Preferences ➤ User Interface ➤ Tooltips),
hover over a tab to see the name of the tab.

DescriptionTabColour

Connects a front clip to a node.FrontRed

Connects a back clip to a node.BackGreen

Connects a matte clip to a node.MatteBlue

Miscellaneous tab specific to certain nodes, such as a Z-Depth or For-
ward Vector input.

MiscLight Blue

Connects the result of a node to other nodes.ResultYellow

Connects the output matte of a node to other nodes.Output MatteBlue

Warns that clip input to this node is unconnected or is missing media,
or clips parented to this node do not share the same resolution or a
compatible bit-depth.

WarningRed circle

The available source tabs depend on the node. If the node accepts a front, back, and matte clip, all coloured
source tabs are available. If the node only accepts a front clip, the red source tab is available and the other
source tabs are grey. When a source tab or Result tab is not connected to a clip or to another node, the
coloured tabs are dimmed.

TIP Right-click any node in the schematic to reveal a contextual menu of operations available for that type of
node.

Adding Clips to the Process Tree
Even though ConnectFX process trees are pre-populated with clips from the timeline, you can also add more
clips from the Workspace Media panel.

Another way to add clips is through the Read File node (page 297).

To add clips from the Workspace Media panel:

1 Select one or more clips from the Workspace Media panel.
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2 Drag the clips into the ConnectFX schematic.

The clips are now available to use in the process tree. Notice that the clips are also displayed in the
Media panel's CFX Sources folder.

TIP You can also drag clips directly into the CFX Sources folder (you don't even have to be in ConnectFX
to do this). Any clips in the Sources folder can be seen in the schematic (with the exception of Read File clip
nodes).

Once a clip is present in the ConnectFX schematic, you can connect its output tab to other nodes in the
same manner as connecting nodes to nodes. The same clip can be connected to multiple nodes in the process
tree.

To replace a clip:

1 Drag a clip from the Workspace Media panel into the ConnectFX schematic.

2 Release the clip on top of an existing schematic clip, once you see a replace icon.

The clip is replaced.

TIP If the clip proxy is black after replacing, right-click the clip and select Reset to reset the timing offset of
the clip.

Clip Information Reference

You can display detailed information about clips in the schematic such as resolution, frame rate, and size.
As well, visual cues such as symbols and letters identify clips as having had a specific type of operation
applied.

The colour of the clip information and letters and symbols also provides specific information.

Clip Information

You can choose what clip information is displayed under clips in the schematic by selecting an option from
the Clip Info box in the ConnectFX Schematic Preferences:

To display:Select:

The clip's name, number of frames, dimension, frame depth, and aspect ratio.Resolution

The clip's name, number of frames, and dimension (in pixels).Size

The clip's name, number of frames, and number of frames per second (fps).Framerate

The clip's name, number of frames, dimension (in pixels), and number of frames per
second (fps).

Size+Rate

The clip's name, number of frames, dimension, frame depth, aspect ratio, and number
of frames per second (fps). This option provides the most detailed level of clip information.

Resolution+Rate

No information except the clip name and number of frames.No Info
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Clip Name Colouring

The colour of the clip name in the schematic helps you locate where the clip originated.

Origin:Colour:

Media PanelWhite

Read File nodePink

No media found (clip is also displayed as a black proxy)Red

CFX Back ClipGreen

Clip Status Symbols

The following visual cues can help you track the type of clip and clip status.

(A) symbol and Audio Context outline Indicates that an audio context is set for this clip or node. In
addition to the A, the clip has a dotted purple outline. The letter A is followed by the number of the context,
for example, A2 is the second Audio context.

(C) symbol and Context outline Indicates that a context is set for this clip or node. In addition to the C,
the clip has a dotted green outline. The letter C is followed by the number of the context, for example, C1
is the first video context.

LUT symbol Indicates that a LUT was applied to the clip. The first and second number represent the source
and destination bit depths, for example [8 -> 16f].

[R] symbol Indicates that a Resize was applied to the clip.

(CFX) symbol Indicates that a ConnectFX was applied to a timeline made up of one segment, or the clip
was converted as a Create CFX. The clip can be expanded.

Importing With the Read File Node

To import images into ConnectFX using the Read File node:

1 In the I/O node bin, select the Read File node and drag it to the schematic.

The Read Files browser appears.

2 Optional: Set General and Format Specific Options for the files to import.

3 Optional: For each file, set In and Out points using the Preview panel.

4 Select the clips to import.

5 Click Load.

You are returned to ConnectFX and the file appears in the schematic. If you import more than one
file, a Read File clip is created for each file. The clip name appears in pink to help you differentiate
from other schematic clips.

NOTE Whenever you open a ConnectFX setup which uses Read File clips that have been updated, Smoke asks for
your permission to update the setup with updated versions of these clips (when updates exist). Updating the setup
replaces the current Read File clips with the latest found versions. This ensures that you are using the correct
versions, and in any case, Smoke maintains the appropriate schematic connections.
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To Expand a Read File Clip

1 Select the Read File clip.

2 Press Ctrl+C.

To Replace the Current Read File Clip With Another One

1 Double-click the proxy of the Read File clip.

The Read Files browser appears.

2 Optional: Set General and Format Specific Options for the files to import.

3 Optional: For each file, set In and Out points using the Preview panel.

4 Select the clip to import.

5 Click Load.

You are returned to ConnectFX and the Read File clip is updated with the selected file. The Schematic
is also updated, using a channel matching strategy that preserves the links between the clip's channels
and the linked nodes.

To Load a Clip as a Version

1 Double-click the proxy of the Read File clip.

The Read Files browser appears.

2 Optional: Set General and Format Specific Options for the files to import.

3 Optional: For each file, set In and Out points using the Preview panel.

4 Select the clip to import.

5 From the Load drop down menu, select Load as Version.

You are returned to ConnectFX and the Read File clip is updated with the selected file. The previous
clip is now available as a version from the Clip Versions box. You can have as many versions as you
need.

To Switch Between Versions of a Read File Clip

NOTE Only possible with Read File clips loading clips with versions, or after loading a clip as a version.

1 Double-click the Read File clip.

2 Select a Clip Version using the Clip Version box.

The Read File clip now uses the selected version and the schematic is updated accordingly, using a
channel matching strategy that preserves the links between the clip's channels and the linked nodes.

To Check for New Versions of Clips

NOTE The Check for Updated Versions button is only available if at least one Read File clip in the schematic has
been updated.

1 Open the ConnectFX Preferences menu.

2 Under Read File Nodes in the Preferences section, click Check for Updated Versions.

Every Read File clip in the schematic is checked for updated versions of their clip.
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About the Read File Node

Why Use a Read File Node?

While you can import many types of media files using a Read File node, its primary use is to facilitate
integration of Smoke in render pass workflows.

Using the Read File Node With Render Passes

The Read File node is more than just another way to import into the ConnectFX schematic. It actually allows
you to integrate Smoke inside a render pass pipeline very efficiently.

While you can use the Read File node to import almost any file format, three are of interest for multi-channel
render pass workflows:
■ open .clip

■ multi-channel OpenEXR

■ Maya .precomp

And while they differ in their basic structures, they all provide access to a powerful CG concept: Read File
Nodes and Autodesk Maya. The render pass allows you to composite within Smoke the many components,
or passes, making up the scene. By working directly with the render passes, you end up performing tasks
quicker, such as colour correcting, that are much more time-consuming in the 3D application. The fact is
that Smoke only needs to compute the value of pixels in a scene, while the 3D application needs to recompute
the lighting of whole geometries: Smoke is just better for these tasks.

How to Use Smoke With Render Passes?

Working with render passes is not difficult, especially if you use the Read File node and one of the following
file types: Open .clip, multi-channel OpenEXR, or Maya .precomp.

Consider the following example of an image generated in Maya.
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This image was exported from Maya using the following render passes.
■ Beauty - scene

■ Camera Depth

■ Motion Vectors

■ Ambient

■ Beauty with Shadow and Reflections

■ Diffuse

■ Direct Irradiance Without Shadows

■ Raw Shadow

■ Specular

■ Reflection

■ Beauty - sphere-only

Importing this file using the Read File node, you have access to all these passes.
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Once imported, you can create a simple ConnectFX schematic and composition.
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In this ConnectFX setup, you can do the following, for example:
■ Warp the sphere's colour.

■ Warp the sphere reflexion's colour by the same amount.

■ Remove the original shadow and replace it with a new one.

■ Add a spot on the sphere.

■ Change the overall lighting look.

■ Add a lens flare.

If the CG artist updates their work, you can just replace the current clip with the updated version, performing
a simple replace operation (page 298); all the compositing information is maintained.

In fact, the Read File node supports matching channels based not only on their UID and name, but also on
their channel type. This allows you to replace sources with multiple render passes in a clip that are similar,
but not identical, and maintain schematic connections to the Read File node within a composite.
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About .precomp Files

A .precomp file is a file generated by Maya to facilitate data exchange with its Composite component. Smoke
can read that file and extract render pass information. An actual .precomp export from Maya consists of two
distinct elements:
■ One .precomp file which describes the components of the scene. It is a Python plain-text file with

compositing information and path to the render passes.

■ Media files referred to by the .precomp file. In the simplest of cases, there is one OpenEXR file for every
rendered frame. Each OpenEXR contains all the render passes for that frame.

An interesting aspect of .precomp files is their use of render layers as versions: this allows the Maya artist to
create different versions of the same scene using render layers. You can then use the Read File node to import
the .precomp file, and then use the Versions box to switch between looks.

Read File Node and Autodesk Maya

The Read File node automatically recognizes pass types from mental ray in Maya, allowing for more robust
channel matching during clip updates or replacement.

Below is a list of supported mental ray render passes, with a short description.

DescriptionRender Pass

Relative motion (in raster coordinates) of objects in your scene; in other
words, how far each pixel is moving between two frames. Vector is ex-
pressed in normalized pixels.

2D Motion Vector

3D motion vector in world space. In mental ray for Maya, the 3D motion
vector is expressed in internal space.

3D Motion Vector

Ambient contribution of the surface. In Maya, this is the material color
multiplied by the ambient light color.

Ambient

Amount of ambient light received by the surface.Ambient Irradiance

Ambient occlusion contribution from both self ambient occlusion as well
as primary ambient occlusion, which is derived from surrounding objects.

Ambient Occlusion

Reflectivity of the material with respect to ambient light.Ambient Material Color

Final colour computed by mental ray for Maya.Beauty

Beauty pass without reflections or refractions. Used to tune the tint and
intensity of the reflection/refraction separately from the rest of the passes.

Beauty Without Reflections or Refractions

Extracts the distance between the camera and the intersection point.Camera Depth

mental ray Coverage frame buffer. This frame buffer offers only silhouette
coverage. Self-coverage is currently not supported.

Coverage

Diffuse shading of material.Diffuse
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DescriptionRender Pass

Diffuse pass without shadowing information.Diffuse Without Shadows

Provides constant diffuse colour or textured diffuse colour, excluding light
contribution.

Diffuse Material Colour

Direct light arriving at each sample location.Direct Irradiance

Direct irradiance without shadowing information.Direct Irradiance Without Shadows

outGlow output of surface shaders; affected by pass contribution maps.Glow Source

Additive colour.Incandescence

Measures the difference between the direction of the light ray and the
surface normal. If the surface normal is facing the light, this value is 1. If
the normal is facing away from the light, the value is 0.

Incidence

Indirect lighting from final gather, global illumination, and caustics.Indirect

Extracts all light-centric volume effects, for example, a light cone volume
effect.

Light Volume

Measures the difference between the direction of the camera ray and the
surface normal. If the surface normal is pointing to the camera, this value

Material Incidence

is 0. If the normal is facing away from the camera, the value is 1. Any angle
greater than 90 degrees is also translated to 1. If bump mapping is applied
to the shading network, it will appear in this pass.

Interpolated surface normal. If bump mapping is applied to the shading
network, it will appear in this pass.

Material Normal

The object's matte, excluding transparency/opacity. This pass serves as the
render layer compositing mask. Should be solid white in areas where objects
are intersected. Independent of transparency/translucency.

Matte

Relative motion (in raster coordinates) of objects in your scene; in other
words, how far each pixel is moving between two frames. Pixel displace-

Normalized 2D Motion Vector

ment is normalized to (0—1). Static objects are expressed with 0.5,0.5
values.

Similar to the Material Incidence pass but without support for bump
mapping.

Object Incidence

Similar to the Material Normal pass but without support for bump mapping.Object Normal
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DescriptionRender Pass

Extracts all object-centric volume effects, for example, smoke that is con-
tained in a glass object. Also includes volume particles, volume fur, and
fluids.

Object Volume

The object's opacity, which is derived from transparency/refraction. In
compositing, the object's opacity can be controlled independently from
the render layer matte.

Opacity

Similar to the Shadow pass but calculated only with respect to the irradiance
in the scene.

Raw Shadow

Reflection results. Includes self-reflection, primary reflections, secondary
reflections and environment reflections.

Reflection

The reflected colour parameter of the material. Pure constant reflection
colour or textured reflection. Used as a reflection matte to determine where
reflection would be revealed (coloured and non-coloured).

Reflected Material Colour

Refraction results. Includes self-refraction, primary refraction, and environ-
ment refraction.

Refraction

The transparency colour parameter of the material. Pure constant refraction
colour or textured reflection. Used as a refraction/transparency matte to
determine where refraction is revealed (coloured and non-coloured).

Refraction Material Colour

Scattering effects that result from the material’s scattering attributes.Scatter

Extracts all scene-centric volume effects such as fog, layered fog, haze, and
so forth.

Scene Volume

Pure shadow contribution for both self-shadowing as well as direct shadows.
The shadow pass can be luminance or coloured shadows. Takes into account
material contributions.

Shadow

Specular shading. The specular component is modulated differently de-
pending on the type of material associated with the object. For example,

Specular

Phong, PhongE, Blinn, and Anisotropic materials produce specular contri-
butions differently. On a Phong material, the specular pass can be modu-
lated using cosine power and specular colour.

Similar to Specular but without shadow occlusions.Specular Without Shadows

Back shading contribution revealed on the front surface.Translucence

Similar to Translucence but without shadows.Translucence Without Shadows
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Read File Clip Settings

To access Read File clip settings, double-click a Read File node in the schematic.

Basic Settings

NOTE The Import Settings are dynamically generated according to the type of clip imported. You can get a quick
description of each setting by viewing its tooltip.

Basic button Opens the Basic menu where you set the clip version, append the available setup, modify the
import settings, and set the missing media options.

Versions box Select the active version of the clip. If the available channels differ between versions, the
application updates the links to other nodes.

Creation Date field Displays the creation date of the version selected in the Clip Version box. Non-editable.

Head Media box Select to substitute missing media at the beginning of a clip with black frames, the first
frame of media, or leave as is.

Tail Media box Select to substitute missing media at the end of a clip with black frames, the first frame of
media, or leave as is.

In field Set, as an offset of frames from frame 0, the In mark of a clip. Only frames located after the mark
are available and rendered.

Out field Set, in frames from frame 0, the Out mark of a clip. Only frames located before the mark are
available and rendered.

Frame field Displays the absolute frame number of the current frame, from the file with the name displayed
in the File Name field. Non-editable.

File Name field Displays the name of the file from which the current frame is being read. Non-editable.

Clip Information tabs

Available in the Basic and Extended menus of the Read File clip.

The Clip Information tabs display non-editable information about imported clip.

Clip Info tab The Clip Info tab displays the name of the original media, file format, resolution and FCM,
as well as the number of tracks in the clip.

Metadata tab The Metadata tab displays metadata information about the imported media, including but
not limited to: path to the sources, camera settings (RED and ARRI), file creator.

Versions tab The Versions tab lists all the versions available for the selected clip. Available to open clips and
Maya .precomp imports.

Extended Settings

Extended button Opens the Extended menu where you set the channel options, from the channel displayed
in the node proxy to the available outputs.

NOTE With a Read File clip selected in the schematic, press Ctrl+C to expand the node and display its channels
in the schematic.
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(a)Media output (b)Alpha output (c) Displayed and disconnected outputs (d)Hidden and disconnected outputs (e)
Displayed and connected outputs (f) Hidden but connected outputs

Type field Displays the type of channel. Non-editable.

Name field Displays the name of the channel. Non-editable.

Icon field Enable to display the channel in the schematic; disable to hide the channel. The Read File clip
must be expanded (press Ctrl+C) to view the channels in the schematic. Hiding a channel does not break
its link to a node.

Proxy field Enable to use a particular channel as the Read File clip proxy in the schematic.

Outputs fields Click to display or hide the outputs available for each channel from the Read File clip in the
schematic. Hiding an output does not break its link to a node. There is one output each for RGB and its
alpha (if any).

Resize Settings

The Resize settings are the same as when you are using the Resize node in ConnectFX. Click the Active
button to activate the Resize settings.

RGB LUT Settings

The RGB LUT settings are the same as when you are using the LUT Editor node in ConnectFX. Click the
Active button to activate the RGB LUT settings.

Clip Settings

The following settings are available when selecting a clip in the schematic. You can also right-click a clip
node in the schematic to reveal a contextual menu of operations, such as Render options.

Basic Settings

Basic button Opens the Basic menu where you set timeline and timewarp options, control clip locking and
slipping, and define how missing media is displayed and rendered.

Head Media box Select to substitute missing media at the beginning of a clip with black frames, the first
frame of media, or leave as is.

Gap Media box Select to substitute missing media in gaps with black frames or leave as is.

Tail Media box Select to substitute missing media at the end of a clip with black frames, the last frame of
media, or leave as is.

Adding Clips to the Process Tree  | 307



Offset field Displays the number of frames by which selected clips and/or segments are offset. This same
setting can be found in the Timing View as well as the Clip Settings. Editable.

Lock Frame button Enable to display the current frame for the duration of the clip.

Explode All Timeline SFX button Click to explode all Timeline FX in the clip into a process tree.

NOTE If a clip proxy is black after exploding, right-click the clip and select Reset to reset the timing offset of the
clip.

Explode History button  Click to access pre-processing settings for the clip.

Explode One button  Click to explode one level of the clip's CFX setup.

Explode All button  Click to explode all levels of the clip's CFX setup.

Alpha Active button Enable to generate an alpha or matte from a clip.

Alpha Colour box Select whether to output a white or black alpha of your clip.

Resize Settings

Most of the Resize menu is the same as when using the Resize node in ConnectFX. The following settings
are specific to the Resize tab for a clip:

Resize button Opens the Resize menu where you change the size of a clip, as well as its aspect ratio.

Active button Enable to activate the Resize settings.

Load button Loads a Resize setup from the library.

Save button Saves the current resize setup.

RGB LUT Settings

Most of the RGB LUT menu is the same as when using the LUT Editor node in ConnectFX. The following
settings are specific to the RGB LUT tab for a clip:

RGB LUT button Opens the LUT Editor for the selected clip.

Active button Enable to activate the LUT settings.

Back Clip Settings

These settings are available for a ConnectFX Back Clip created for a timeline adjustment segment.

Head Media box  Select what media is available before the In Point of the adjustment segment. Select
Timeline Level to have the Back Clip read the head media from the segments preceding (and below) the
adjustment segment.

Tail Media box Select what media is available after the Out Point of the adjustment segment. Select Timeline
Level to have the Back Clip read the tail media from the segments following (and below) the adjustment
segment.

Adding and Connecting Nodes to the Process Tree
To add a node from the node bin to the schematic, double-click a node, or drag a node directly to the
schematic. There are several ways of connecting clips or nodes together. You can connect them manually
or automatically.
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To insert a node between connected nodes:

1 Do one of the following:
■ If Auto Insert is enabled in the Prefs menu Schematic settings (this is the default), drag a node and

navigate to the link between two connected nodes. The link is highlighted in orange.

■ If Auto Insert is disabled in the Prefs menu Schematic settings, press and hold Option, then drag
a node and navigate to the link between two connected nodes. The link is highlighted in orange.

2 Release the node.

The node is inserted, while retaining the input and output connections.

To connect nodes automatically with autolink:

1 Use the Autolink feature by pressing Option and dragging a node to another node so their tabs touch.

Action: Press and hold Shift while dragging the Negative node to the Keyer node

Result: The Keyer output is the front for the Negative node
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To connect nodes using the advanced autolink:

1 To distinguish between the various source tabs, use the Advanced Autolink feature by pressing Alt
repeatedly while still holding Shift to extend a similarly coloured arm from each source tab (starting
with the topmost source tab, and cycling counter-clockwise with each press of Alt). The name of the
tab is also displayed above the node. You can then touch the extended arm to the tab you want to
connect to.

Hold Shift and press Alt to extend the Front tab.

While still holding Shift, press Alt again to extend the Back
tab.

While still holding Shift, press Alt a third time to extend the
Matte tab.

You can also retain connections using this method by releasing the node over an existing connection
(when it turns orange).

To create a node connection using tap-tap linking:

1 Click the tab of the first node or clip you want to connect.

2 Click the tab of the node you want to connect the first node to.

The nodes are connected.
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NOTE If the first node you click is an Output node, you can add as many subsequent input tab connections
as you like. To finish selecting, click anywhere in the schematic work area.

To connect nodes manually:

1 Click the Result tab of a node whose result you want to use and drag the cursor to one of the source
tabs of the next node in the process tree.

An arrowed line is drawn from the node to the source tab. For example, click the Result tab of the
Colour Correct node and drag the cursor to the front tab of the Flip node to flip the result of the
colour-corrected clip.

To extract a linked node while maintaining connections:

1 Press Option+Ctrl and drag a linked node away from the link.

The node is disconnected and connections between existing nodes are reformed.

To disconnect nodes or clips:

1 Drag the cursor across the connecting line between a clip and a node or between two nodes.

The arrowed line is cut and the source tab is dimmed.

2 You can cut multiple connections in a single stroke by clicking and dragging over several connecting
lines in the schematic.

To delete a node:

1 Do one of the following:
■ Right-click a node and choose Delete.

■ Drag a node towards the bottom of the screen, and release once you see the garbage can icon.

TIP You can combine the extract Option+Ctrl and dragging a node to delete it and maintain
connections.
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Bypassing Node Inputs

You can improve your workflow in ConnectFX by deactivating certain nodes and rendering only the nodes
that you want to process right away.

For any node, you can pass the Front, Back, Matte, or Key-in clip—depending on the type of node you select
and its source tab inputs—as the input to the next node in a branch. If you bypass a node with multiple
outputs (such as Action and Modular Keyer), the matte output will be the same as the result output (depending
on the current selection in the Bypass box).

To bypass a node input:

1 In the schematic, select the node whose input you want to bypass.

2 Enable Bypass.

The Bypass box becomes active.

3 Select the clip that you want to pass as the input to the next node from the Bypass box.

NOTE The Flip node, which was selected in step 1 of this example, has input tabs for a front source. Therefore
Front is the only option in the Bypass box.

The output tab of the bypass node changes colour. In the following example, the tab turns red indicating
that the Front input is passed to the next node in the tree. As well “(Bypass)” is added to the node
name.
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(a) Output tab of bypassed Front input

To unbypass nodes:

1 Do any of the following:
■ Select the node with the bypassed input and disable the Bypass button.

■ If the bypassed node is part of a multi-selection in the schematic, click Disable Bypass On Selection.

NOTE Click Restore Bypass On Selection to redo the bypass.

Adding Notes to the Schematic

You can add notes to the ConnectFX schematic, or to a specific clip, node, or group. Notes are useful when
collaborating on an effect or project with other users. Notes are saved with the setup so they are visible to
all. You can copy and paste content between notes.

To create a freeform schematic note:

1 Drag the note icon from the All Nodes bin to the schematic.

2 Double-click the note icon.

The Note text editor appears.

3 Click the editor window to activate it, and type your note text.
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4 Click the upper-left corner of the text editor to close the editor.

To create a note on a clip, node, or group:

1 In the schematic, select the clip, node, or group to which you want to add the note.

2 Press Shift+V.

The Note text editor appears.

3 Type text into the Note field.

4 Click the upper-left corner of the text editor to close the editor. The note icon appears to the right of
the clip, node, or group.

This note is attached to the clip, node, or group.

Viewing Schematic Notes

You can modify how notes are displayed in the schematic.

To display an existing note:

1 Use one of the following commands with the cursor over the note (for freeform notes), or over a clip,
node, or group that has a note.

To:Press:

Temporarily display a note.Alt+Shift+V

Expand a note for display.Ctrl+Shift+V

Expand a note for editing.Shift+V

Selecting Nodes in the Schematic
Use the following keyboard shortcuts to help you select and work with nodes in the schematic.

Do this:To:

Click node.Select a node.

Press Command, then click and drag a rectangular selection around the
nodes.

Select multiple nodes.

Click on an empty space in the schematic, or press Command and click-
drag on an empty space in the schematic.

Deselect everything.

Press Command and click the nodes you want to add or remove.Add or remove nodes from a selection.

Press Shift and click the node.Select all the nodes before the current node
(ascendants).

314 | Chapter 14    Procedural Compositing with ConnectFX



Do this:To:

Press Ctrl+Shift and click the node.Select all the nodes after the current node
(descendants).

Press Command+Shift and click the branch.Remove a branch from a selection.

Press Command+Ctrl+Shift and click the node.Add or remove the branch after a node (descend-
ants) to the selection.

Press Shift+Ctrl+Alt and click any node in the tree.Select the entire tree.

Press Command+Shift+Ctrl+Alt and click a node in the tree.Add or remove a tree to or from the selection.

Press Command+A.Select the entire setup.

Press Alt and move the node in the selection.Move only one node in a selection.

Adding Media to an Action Node
To add indirect media to an Action node:

1 In the ConnectFX schematic, double-click the Action node and then click Media in the Action menu.

2 From the Media List box, select New Input.

A Media node is added to the Action node.

Notice that the Media list is empty. Although you have added a Media node to the Action node, you
have not yet added any media.

3 Connect front and matte clips (image clips, or the output of another node in the ConnectFX process
tree) to the red and blue input tabs of the Media node, respectively.

The Media list is updated with the indirect media. Brackets (“[ ]”) around the clip names indicate the
media is indirect.

When you select a Media node in the schematic, the corresponding media in the Media list is
highlighted. Conversely, selecting media in the Media list highlights the corresponding Media node
and the link to the Action node.

To add direct media to Action using Clip Select:

1 In the ConnectFX schematic, double-click the Action node and then click Media in the Action menu.

2 From the Media List box, select New Media.

3 From the workspace, select a front and matte clip to load as media.

NOTE You can select any number of front and matte clips by holding the Command key while selecting
clips. Each front/matte selection is added to its own line in the Media list, and image nodes are automatically
added to the schematic if Auto Image is selected in the Node Prefs menu.

To add direct media to Action gesturally:

1 From the Workspace Media panel, drag a clip to the Action schematic or Media list.
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An image node and axis are added to the Action schematic (if Auto Image is selected in the Node Prefs
menu), and the Media list is updated with the front media.

2 To replace the media in an image node, drag a new clip from the workspace Media panel onto an
existing image node in the Action schematic. Release the clip when you see the red replace arrow.

The image is replaced in the schematic, and the Media list is updated with a new entry for the media.
The replaced media remains as a Media list entry in case you are using it elsewhere in your Action
scene.

To convert direct media to indirect media:

1 Select the media that you want to convert from the Media list.

2 Click Extract.

A Media node is added to the ConnectFX Action node and the selected media is automatically connected
to the respective input tabs. In the Media list, brackets appear around the media name, indicating the
media is indirect.

About Action in a ConnectFX Workflow

Action is a multilayer compositing tool for creating complex visual effects, with its own distinct schematic
and node bin. The Action node supports direct media and indirect media.

Indirect media is connected directly to an Action Media node and appears in the ConnectFX schematic.
With indirect media, you can connect any source (such as images, or the output of another node in the
ConnectFX process tree) to an Action node. Media nodes are permanently parented to the Action node (you
cannot sever the process lines). You can add multiple Media nodes to an Action node.

Direct media appears directly inside an Action node, and in the ConnectFX Sources folder in the Workspace
Media panel, as well as in the ConnectFX Timing View. Although direct media does not appear in the
ConnectFX schematic, media and all related settings are saved with the ConnectFX setup.

TIP You can also parent a back clip to the Action node. Although doing so is not necessary, a parented back clip
node provides a good visual reference for identifying the Action composite in the process tree.

The following example displays indirect media in Action. The swan clip is attached to the Action node as
the back clip, whereas the Corridor clip is attached to an Action media node as the front and matte media.

The Action node supports multiple outputs. For example, you can set up your scene to output your entire
composition or just the mattes and then select the type of output you want to process. You can also output
stereo results of your scene.
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About Action Node Output Tabs

The Action node’s output tab changes depending on the number and type of outputs it has, as shown in
the following example.

(a) One output (b) Two outputs (c) Multiple outputs (more than two)

NOTE The colours of a dual-output tab are based on the type of output (for example, yellow for composite, blue
for matte).

The number of outputs is determined by the outputs set up in the Output list. See About Rendering Outputs
from Action (page 364).

Setting Stereo Startup Mode for Action

When dragging an Action node to the ConnectFX schematic, you can automatically set the node to stereo
startup mode. If you change any of the stereo startup settings, you can revert back to the default stereo
startup settings. You can also change the settings of an existing Action mono node to the stereo startup
settings.

For information on the settings that are affected by the stereo startup mode, see Rendering Tab (page 354).

To set the stereo startup mode for a new Action node:

1 Enable the Stereo Mode button below the node bin.

The node is renamed to Action_STEREO, the output tabs display the left eye and right eye outputs,
and all stereo settings are automatically set.

(a) Left eye output tab (b) Right eye output tab (c) Stereo node name

To apply the stereo startup setting to an existing Action node:

1 Select the Action node.

2 In the Node Prefs menu for the Action node, click Reset To Stereo Mode in the Rendering section.
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Once confirmed, the current setup is replaced by the stereo setup and all media is deleted.

Viewing Nodes in Context
View a node in context with another node to compare intermediate results throughout the process tree. By
working with context points, you can modify nodes in the process tree and immediately view the impact
those changes have on the nodes further along in the process tree. You can set two context points in a
process tree.

You can set a context on a node or on any of its output tabs. You can also set a context on any node output
in a group as well as on any output of an Action multiple output node.

To view nodes in context:

1 In the schematic, select the node you want as the context (for example, an Action node).

2 Right-click the node, and select Set as Context.

A dotted green line appears around the node, and (C1) appears next to the node name in the schematic.

3 In the schematic, select the node you want to edit. For example, select a Colour Correct node and
modify the setup.

4 View your colour correction changes in the context of Action by selecting Context 1 from the View
box.

In this way, you are colour correcting “in context” of the intermediate result. Furthermore, as you
move to different frames in the tool, Context 1 also displays the result at the same frame. For instance,
if you are at frame 15 in the Colour Corrector, Context 1 (Action) is also at frame 15. (Exceptions to
this occur when using time-based nodes such as Pulldown, Interlace, and DeInterlace.)

5 If you want to set a second context, select another node in the schematic—such as a Keyer RGB
node—right-click, and select Set as Context.

(C2) appears next to the Keyer RGB node name.

6 Repeat steps 3 and 4.

NOTE For group nodes, stereo nodes, or nodes with multiple output tabs, you can set the context on specific
output tab instead of the complete node.
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About Previewing Results in ConnectFX

While creating your process tree, you can preview results at any time. If you do not like the result of one
operation, you can modify or delete it without affecting the other operations in the sequence. You can
preview your results in ConnectFX by:
■ Using proxies in the schematic.

Double-click the result tab on the node to display or hide the proxy. If Auto Update is enabled in the
Schematic section of the Preferences menu, the proxy updates automatically as changes are made.

■ Selecting one of the options in the View box to view results at the current pipeline level in the image
window.

Select the node whose results you want to preview, then select an output or result view from the View
box (use a 2-Up view to view the schematic and result at the same time). In ConnectFX, you can select
CFX Timeline Result to see your composite in the context of the timeline.

■ Setting up to two context nodes in Schematic view and viewing the results in context in the image
window.

Working with Audio Contexts

While working on one clip or branch of the process tree, you can listen to the audio of another clip. Audio
contexts work in much the same way as video contexts. You can set up to two audio contexts in ConnectFX.

To set an audio context:

1 In the schematic, select a clip that contains audio.

2 Right-click the clip, and select Set as Audio Context.

Clips with an audio context are labelled A1 or A2 and are outlined by a pink dotted line.

3 To hear an audio context, select Context1 or Context2 from the Audio Source box in the ConnectFX
Preferences menu.

NOTE Playback of audio is only available when playing a clip. However, you can scrub audio anytime in ConnectFX.
You can scrub your audio context by using Alt (quick scrub) or Alt+Ctrl (real-time scrub) on any node.

About CFX Output Nodes
A ConnectFX pipeline always terminates with a CFX Output node. This node is created automatically when
you enter ConnectFX from the timeline, and can't be deleted.

You can generate both RGB and alpha results from a CFX Output node to the timeline.

Since an effect you create in ConnectFX is a setup applied directly to one or more timeline segments, you
can choose to render your CFX directly in ConnectFX, or wait until you return to the timeline.

Naming Output Nodes

To help you organize outputs, you can automatically name an Output node with the name of any output
socket in the process tree. With the Output node selected in the schematic, press N and click a node
output—the name of the Output node is updated. If you want to change the Output node name, or if you
change the name of the original output socket, simple redo the naming process.
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Outputting an Alpha to the Timeline

You can output alpha results in addition to the RGB result from a CFX Output node. You connect the RGB
result to the front input of the CFX Output node, and the alpha result to the matte input of the CFX Output
node (The output node now displays CFXa). Both results are fed directly to the timeline.

An Axis Timeline FX is automatically added on output, provided that the Add Axis On Matte Output button
in the ConnectFX section of the Preferences menu is enabled (this is the default).

Output Node Settings

Double-click the CFX Output node in the schematic to see its settings.

Basic Settings

The settings in the Basic menu are non-editable, and are available so you can see the output resolution and
timecode of the timeline segment you entered ConnectFX with.

Width field Displays the width resolution of the output clip. Non-editable.

Height field Displays the height resolution of the output clip. Non-editable.

Frame Depth field Displays the output frame depth. Non-editable.

Aspect Ratio field Displays the output aspect ratio. Non-editable.

In Timecode field Displays the in point timecode of the output clip. Non-editable.

Out Timecode field Displays the out point timecode of the output clip. Non-editable.

Duration Timecode field Displays the timecode duration of the output clip. Non-editable.

Resize Settings

The Resize settings for the CFX Output node are only available if you attach a clip to the pipeline that is a
different resolution than the original CFX output. In this case, the Resize settings are active, but you are not
able to change the Destination settings (these must remain the same as when you entered CFX from the
timeline).

RGB LUT Settings

Similar to the Resize settings, The RGB LUT settings for the CFX Output node are only available if you attach
a clip to the pipeline that is a different resolution than the original CFX output.

Saving and Loading ConnectFX Setups
You can save and load ConnectFX setups. When saving a setup, you have the option of saving the complete
ConnectFX setup, or only the selected items in the schematic. Use the drop-down list beside the Save button
to make a selection before clicking Save. When loading a saved setup, you have the choice of loading
(replacing any existing nodes), or load and append.
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In ConnectFX, you can also save and load specific node setups. The node load and save buttons appear next
to the node name field when a node is selected in the schematic.

Using a Create CFX Clip for Caching or Versioning
Use Create CFX within ConnectFX to create a CFX clip that can be useful for disk caching and give you
flexibility for re-use or versioning of complex pipelines.

A CFX clip is a nested group or container that has benefits over Group nodes in ConnectFX.

Creating a CFX Clip

To create a CFX clip, right-click a node in the schematic, and select Create CFX. A new clip node is created
that included the node you selected, and all downstream inputs to the node (that is, everything connected
to the left of the node). At this point, you can delete the old nodes, and connect the new CFX clip into your
pipeline.

Disk Caching Capabilities

You can switch to the ConnectFX Timing view, select your CFX clip in the timeline, and click Render.
Working in ConnectFX is now faster, since all the nodes that make up the CFX clip are now rendered. Once
you are ready to render your complete ConnectFX pipeline, the CFX clip does not need to be re-rendered if
you haven't modified it.

Flexibility

Another benefit of using a CFX clip is the flexibility it offers for versioning or re-using the clip. You can use
the offset feature in the Timing view to offset the start time of the CFX clip, or even slide or trim the media
and animation keyframes contained within the clip. When you create a CFX clip, it resides in the CFX
Sources folder in the Workspace Media panel. You can copy this clip into another folder in the Media Library,
and re-use it in another timeline segment, or even another project.

Exploding CFX Clips

To return a CFX clip to its original separate nodes, right-click the clip, and select Explode CFX. This action
is non-destructive, but it does delete the rendered frames (if you had rendered the CFX clip).

Since you can nest a CFX clip inside another CFX clip, the explode operation only explodes to one level. In
the Basic menu for the CFX clip, you have an option to Explode All levels of the clip back to its original
nodes.

Using the Timing View to Offset Clips
When you offset a clip, you simultaneously offset all its segments on each track. You can also offset multiple
clips simultaneously, including all clips in a group.

To offset clips:

1 To access the ConnectFX Timing view, click the Timing button.
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2 Select the clips and/or segments to offset. If you are offsetting all clips in a group, select one clip or
segment in the group and then click Select All Clips in Group. To select all clips on a track, click the
clip proxy to the left of the track.

3 Drag left or right in the Offset field, or enter the number of frames by which to offset the clip.

All selections are offset by the same amount.

NOTE If you offset multiple clips simultaneously, the value in the Offset field resets to 0 when the offset is
complete.

About the Timing View

The Timing View displays the timeline of all ConnectFX clips in one view. This view is especially useful for
edits where you want to see the relative position of all clips in time. For example, offset multiple clips or
edit one clip in relation to the others.

You can adjust the timing of any number of clips as well as perform basic editing operations such as slipping,
sliding, or trimming. You cannot perform editing operations that involve combining clips or inserting frames
from one clip into another.

Edit a clip gesturally, or use same buttons and keyboard shortcuts as you would on the timeline.

To access the Timing View, click the Timing button. All clips in the current schematic, including clips that
are part of a group node, are represented by a clip proxy and primary video track. Gaps are displayed based
on Media settings, which are set in the clip's Basic menu.

You can select multiple clips on different tracks to perform timing operations at the same time. Selected clip
proxies and tracks are highlighted by an orange bounding box.

Timing View Settings

Some Timing View settings relating to trimming, slipping, or sliding clips (such as the Ripple and Snap
buttons), or to the actual timeline itself (such as the Timeline Options menu) are exactly the same as the
main Smoke timeline.

The following settings are specific to the Timing View:

Offset field Displays the number of frames by which selected clips and/or segments are offset. This same
setting can be found in the Timing View as well as the Clip Settings. Editable.

Filter box Select the type of clips to display in the Timing View.

To display:Select:

All clips in the schematic.Show All

All clips in the selected processing tree.Show Tree
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To display:Select:

All clips in the current node branch.Show Branch

All clips and nodes selected in the schematic.Show Selected

Select All Clips in Group button Click to select all clips that are part of a group. First select one clip or
segment in the group.

Timing View Render box Select an option and click to render selected Timing View clips. Also available as
a contextual option when right-clicking a clip node.

Grouping Nodes
To group nodes:

1 Command-drag to select the nodes you want to group.

Selected nodes are outlined in white.

2 Right-click the selection, and select Group.

The selected nodes collapse into a Group node. The Group node lists the nodes contained in the group,
as well as the non-hidden input tabs and output tabs.

TIP You can also create a group inside a group.

(a) Input connection (b) Proxy window (c) Output connections (d) Group icon

3 To rename the group, enter a name in the Node Name field.

4 Click the group node to display group display and editing settings.
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To display a proxy of an output in the proxy window in the group node:

1 Do any of the following:
■ Click the field in the Proxy list that corresponds to the node whose output you want to display.

■ Press the Shift+up or down arrow as you navigate through the node’s Group List.

■ If a node has multiple outputs, press Ctrl+Shift+up or down arrow as you navigate through
the node’s Group List to display all the outputs of a node.

To change the size of the group icon:

1 Drag the lower-right corner of the icon to make it wider or narrower.

Editing a Group

Use the Edit Group controls to edit the contents of a group.

To edit a group:

1 Select the group you want to edit.

2 In the Group settings, click Edit.

The nodes in the group appear in the schematic ungrouped, with other schematic nodes grayed out.

TIP Instead of editing the group, you can access a single node's menu by selecting the node's name from
the Node List box. Click the Return to Group button to return to the Group List menu.

3 Modify the nodes as required.

4 Click Exit Group to return to the previous schematic.

NOTE Click Ungroup to expand the group of nodes to their pre-grouped positions in the schematic.

About Group Nodes

A group node is a selection of nodes and clips that are collapsed into one node icon. Each node icon displays
the group’s contents, inputs, and outputs. You can create groups for different branches of your process tree
and work on each separately. Groups are useful for simplifying cluttered schematics.

(a) Group node
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You can create several groups and work on each group separately. For example, group a Keying and Colour
Correction branch separately from an Action and a filtering branch, and then work on each branch
independently. If you need to edit the nodes in a group, you can expand the group and make the necessary
modifications.

A clip with multiple outputs, (a stereo clip with left and right matte outputs, for example) can be displayed
as a group node, allowing all output tabs to be displayed for connection.

Stereo nodes are displayed as group nodes, with inputs and outputs for the left eye and right eye.

Group Settings

Customize the group node using the Group List menu. The Group List menu lists all the nodes and
connections contained in a group. You can rename and hide the contents of the group, as well as define
which input and output connection sockets are visible and available for connection in the schematic.

You can select a node in the Group List menu to display the group at the selected node's stage. The View
box must be set to Result, Front, or Back to use this display option. You can also display a preview proxy of
a node in the group.

(a) Sort Order buttons (b) Enabled icon visibility (c) Disabled UI visibility (d) Enabled input visibility (e)  Enabled output
visibility

Use the Group List menu as follows:

To:Click:

Move the selected node one position up or down (click the single-arrow buttons). To
move the selected node to the first or last position in a group, click the arrow-line buttons.

Sort Order buttons

Change the node's name.Name

Toggle the node's visibility in the group. Icons in the Group List are yellow when the
node is visible and grey when hidden.

Icon

Toggle the node's availability in the Node List box. Icons in the Group List are yellow
when the node is displayed in the box and grey when hidden.

UI

Display a proxy of the corresponding node in the proxy window. Icons in the Proxy list
are white when locked and grey when unlocked. Lock an icon when you do not want its
proxy in the window to change as you navigate the Group List.

Proxy
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To:Click:

Hide or unhide the selected node's input sockets. Sockets are colour-coded with the same
scheme as nodes that are not part of a group. Icons in the Group List have a yellow border
when the input socket is visible.

Inputs

Hide or unhide the selected node's output sockets. Sockets are colour-coded with the
same scheme as nodes that are not part of a group. Icons in the Group List have a yellow
border when the output socket is visible.

Outputs

Node Proxy button Enable to display a preview proxy of a node in the group icon. To change the proxy,
press Shift + up arrow or down arrow as you navigate through the Group List.

Collapsed button Enable to collapse the group icon so that only the preview proxy is displayed.

Edit button Click to display the schematic of the group contents, with all other nodes greyed out. To return
to the Group List menu, click EXIT Group.

EXIT Group button Click to return to the Group List menu after editing.

Ungroup button Click to expand the group of nodes to their original positions in the schematic.

Node List box Displays the menu of the selected option. Select List or click the Return to Group button to
return to the Group List menu.

Return to Group button Displays the Group List menu.

Mimicking, Copying, and Duplicating Nodes
When working in the ConnectFX schematic, you have a few options to help you quickly get settings, or
even complete nodes, to and from similar nodes. See the procedures below for information on how to access
each of these options, but as a quick summary, here are the reasons for using each option:
■ Mimic Link: You can keep two nodes in the schematic in sync by creating a Mimic Link between them.

When you change the settings of one node, they are automatically mimicked in the other node.

NOTE To mimic nodes, the nodes must be of the same type. For example, you can link between Flip nodes
but not between a Flip node and a Colour Correct node. Some nodes, such as Action or Modular Keyer do
not support the Mimic Link option. In this case, you can see an error message in the message bar.

■ Duplicate: Create another instance of a node or group of nodes within the same ConnectFX schematic.
All node information is duplicated as well.

■ Copy: Copy is similar to Duplicate, except that the selected nodes or group of nodes is copied into the
clipboard, so you can paste exactly where you want in the schematic. An added bonus of using Copy
and Paste instead of Duplicate, is that you can paste a copied node or nodes into a different ConnectFX
schematic.

Using Mimic Link

To create a Mimic link between nodes connected to mono clips:

1 From the Edit Mode box, select Mimic Link.

2 In the schematic, drag between nodes of the same type.

A green-arrowed dotted line indicates that the nodes are linked as duplicates. The direction of the
arrow indicates which node is the master.
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(a) Duplicate link (b) Master node (b) Duplicate link (d) Duplicated nodes

3 Connect each node to a mono clip.

4 Change the settings of any node.

To work with Mimic link using a stereo group node:

1 With Stereo Mode selected, drag a node from the node bin to the schematic.

A stereo group node containing left eye and right eye inputs appears in the schematic.

(a) Left eye input (b) Right eye input

2 Connect the left and right eye inputs of the stereo group node to the clip node’s left and right eye
outputs, as shown in the following example.
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(a) Clip containing stereo track (b) Left eye output tab (c) Left eye input tab (d) Right eye input tab (e) Right eye
output tab

3 Double-click the stereo group node or click Edit in the Group List menu.

The schematic is dimmed except for the two nodes of the same type as the one you dragged from the
node bin. A green-arrowed dotted line indicates that the nodes are linked as mimics.

(a) Master node (b) Mimic link (c) Mimicked node

4 Change the settings of either node.

Notice that the changes made to one node are mimicked on the other node so that both the left and
right eye clips are affected simultaneously.
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(a) Flip node connected to left eye is edited (b) Settings are automatically mimicked on Flip node connected to
right eye

5 Click Exit Group.

Duplicating Nodes

To duplicate nodes:

1 In the schematic, select a node, or group of nodes.

2 Right-click the selection, and choose Duplicate.

A duplicate of the node or nodes (with all node settings) appears in the schematic.

Copying Nodes

To copy nodes:

1 In the schematic, select a node, or group of nodes.

2 Right-click the selection, and choose Copy.

A copy of the node or nodes (with all node settings) is added to the clipboard.

3 Navigate to the location in the schematic (or another ConnectFX schematic) where you want the
copied node or nodes to reside, right-click and choose Paste.

A copy of the node or nodes (with all node settings) appears in the schematic.

Customizing the Tools Bin
Create custom bins and populate them with your most commonly used nodes to optimize your workflow.
As well, change the order of the tabs along the top of the bin and rename them to reflect the contents of a
bin.

You can customize any bin in the Tools bin except the All Nodes bin and its tab.
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To create a tab:

1 Click the plus sign tab.

2 Name the tab in the keyboard that appears.

NOTE You can create a maximum of 6 new tabs.

To copy a node to another bin:

1 Drag the node on top of the destination tab.

2 Release the cursor.

3 Click the destination tab.

The copied node appears in the bin. Nodes are added to the end of a bin in the order copied.

NOTE Nodes cannot be duplicated within the same bin.

To move a node to another bin:

1 Press Ctrl+Alt and drag the node on top of the destination tab.
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2 Release the cursor when it changes to a green crosshair.

3 Click the destination tab when the standard yellow cursor reappears.

The node is moved from its original location to the destination bin. Nodes are placed at the end of a
bin in the order moved.

NOTE Nodes cannot be duplicated within the same bin.

To reorder a node within a bin:

1 Press Ctrl+Alt and drag the node to a new location. You can move nodes from one row to another
as well as reorganize nodes within a row.

In the following example, the AutoMatte node is dragged on top of the Degrain node.

2 Release the cursor when it appears where you want the node moved.

If you dragged the node on top of an existing node, the existing node shifts to the right and the moved
node is inserted in its place. In the following example, the AutoMatte node is inserted in the place of
the Degrain node, and the Degrain and Regrain node shift to the right.

(a) Reordered node

NOTE Click Sort to reset a tab to alphabetical layout

To delete a bin:

1 Press Ctrl+Option and drag the tab to the bottom of the screen.

2 Release the cursor when it changes to a delete cursor.

WARNING There is no undo capability when deleting a bin.
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The entire contents of the bin, including the tab, are deleted.

To delete a node from a bin:

1 Press Ctrl+Option and drag the node to the bottom of the screen.

2 Release the cursor when it changes to a delete cursor.

WARNING There is no undo capability when deleting a node.

To reorder a tab:

1 Press Ctrl+Option and slide the tab to its new location.

2 Release the cursor when it changes to a green crosshair at the new location for the tab.

If you dragged the tab on top of an existing tab, the existing tab shifts to the right and the moved tab
is inserted in its place.

About ConnectFX Node Bins

In ConnectFX, a node is a graphical representation of a function or effect that affects a clip or another node
in the process tree. The available nodes are organized in bins that contain all nodes required for building a
process tree. The nodes are divided into the following three groups, classified by tabs.

To access the ConnectFX node bins, click the FX Nodes button. To add a node from the node bin to the
schematic, double-click a node, or drag a node directly to the schematic. Enable Stereo Mode to add stereo
nodes to the schematic.

I/O Bin

In ConnectFX, the I/O bin includes nodes for importing and working with source files. Available nodes are
Read File, MUX, and Back Clip. By default, a CFX Output node is automatically connected to a ConnectFX
process tree.

DescriptionNode

Import clips in any supported formats from any available loc-
ation. Use to import multi-channel clips such as OpenEXR, or
metadata rich clips such as RED clips.

Read File

The MUX node is a schematic tool that helps create cleaner
schematics by allowing you to have multiple outputs from

MUX

one input. It incorporates the hiding of connections to prevent
schematic connection overlaps.

The Back clip node enables you to create composites and ef-
fects in ConnectFX, when using the Generate Adjustment
Segment option from the timeline.

Back Clip

You cannot customize the I/O bin.
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Tools Bin

The Tools bin contains effects and formatting nodes classified by tabs. The All Nodes tab contains all nodes
except the nodes found in the I/O bin. The other tabs in the Tools bin allow you to create and customize
bins.

Some of the nodes in the All Nodes bin are duplicated in other bins according to a preset tab classification.
For example, the Gradient node is found in both the Colour and Comp bins.

The nodes in the Tools bin are listed in alphabetical order from top to bottom of each row. You can customize
any of the bins and preset tabs in the Tools bin except the All Nodes bin.

Enable the Stereo Mode button below the Tools bin to access only stereo nodes (nodes not available as stereo
nodes are greyed out).

TIP Use the scroll bar under the applicable bin to scroll through all available nodes. You can also frame and
highlight all the nodes starting with the same letter by pressing the key corresponding to this first letter on your
keyboard while the cursor is sitting over a node bin. For example: pressing "K" while hovering the cursor above
the All Nodes bin automatically highlights all of the Keyer nodes.

User/Project Bin

The User/Project bin contains custom nodes classified by a User tab and a Project tab. Use this bin to save
custom setups per user or project.

Creating Custom Nodes
Create custom nodes of specific setups that you often use. A custom node can consist of a single node with
specific settings or multiple nodes that create a particular effect.

You create custom nodes by dragging individual nodes, groups, branches, or entire trees into the User/Project
bin.

To create a custom node:

1 In the schematic, select a node or group of nodes.

2 Drag the selection on top of the User or Project tab.

The selection is copied to the bin. The original selection remains in the schematic.

To use a custom node:

1 Select a custom node from the User or Project bin. If necessary, scroll through the bin to find the node.

2 Drag the node to the schematic, or double-click the node.

The same configuration of nodes and clips that was used to create the custom node appears in the
schematic.

You can use custom nodes as often as you like. Each time you drag a custom node to the schematic, a
new number is appended to its name.
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To manage the custom node bins:

1 Select any of the following from the dropdown lists.

To:Select:

Load custom nodes from another project or user.

NOTE If you load unsupported nodes, the unsupported nodes appear greyed
out when dragged to the schematic.

Load Project Bin or Load User Bin from
the Load dropdown list

Save the current custom nodes so they can be loaded by another project or
user.

Save Project Bin or Save User Bin from
the Save dropdown list

Delete all custom nodes in the Project or User bin.Clear Project Bin or Clear User Bin from
the Clear dropdown list

To delete a custom node from the User/Project bin:

1 Press Ctrl+Option and drag the node to the bottom of the screen.

2 Release the cursor when it changes to a delete cursor.

WARNING There is no undo capability when deleting a custom node.

ConnectFX Preferences
Click the CFX Prefs button to access settings to customize rendering, preferences, and adaptive degradation
in ConnectFX.

NOTE Some ConnectFX nodes also have specific preferences related to the functionality of the node. Click Node
Prefs to access the preferences for a selected node.

Rendering Tab

Free Frames field Displays the space remaining on the framestore. Non-editable.

Use Proxies button Enable to replace clips with proxies. When enabled, the image window is outlined in
amber.

Hardware Anti-aliasing Sample box Select a hardware anti-aliasing sampling level to accelerate edge
anti-aliasing with no performance penalty. Available values are dependent on your graphics card.

Preferences Tab

Audio Source box Select the audio context you want to hear when working with another clip. This same
setting appears in the Timing View menu.

Text Log button Enable to save rendering status information in a text file, located in
/usr/discreet/project/<project home>/batch/log.

Status Webpage button Enable to create three status HTML files, located in /usr/discreet/html.

Update Numerics button Enable to update numerics in fields as the timebar is scrubbed.
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Show Negative Frame button Enable to displays negative frame numbers in the Current Frame field when
a segment is offset before frame 1. Disable to display only frames from frame 1 onward.

Set to In/Out button Click to have the timebar display frames as defined by the in and out points set on
the clip's timeline.

Set to Media Range button Click to have the timebar display the head and tail frames brought in from the
clip's timeline.

Clip Info box Select an option to display resolution, frame rate, size, or any combination of information
in the schematic.

Transparency field Displays the transparency of currently unselected nodes in the schematic. Editable.

Auto Parent button Enable to allow Parent and Cut options in the schematic while using the Select edit
mode.

Auto Insert button Enable to automatically insert a node when dragged between two connected nodes.
When disabled, press Shift to auto insert.

Highlight Path button Enable to highlight the path of the currently selected node in the schematic.

Auto Update button Enable to update a node's result proxy automatically.

Update Clip box Choose whether to automatically update all clips or only selected clips.

Clear Buffer button Click to clear the Undo buffer of all previous undo operations.

Check for Updated Versions button Checks each imported Read File .clip file to see if it is the latest version,
and updates it if that is not the case. Asks for confirmation before updating the version. Only available when
a Read File node is used to import .clip files in the schematic.

Adaptive Degradation Tab

Degrade Mode box Select how to propagate display degradation in the image, according to settings for
supported nodes. Nodes in the pipeline respect this degraded image. In this case, press Preview to see your
results with full settings on.

Change Node Degradation box Select whether to enable or disable adaptive degradation before clicking
Apply To Selected.

Apply To Selected button Click to set the selected nodes to the chosen option in the Change Node
Degradation box.

The following two settings appear in the Node Prefs menu for specific nodes that support adaptive degradation:

Active button Enable to activate adaptive degradation display settings. Use to prevent slowdowns in displaying
your results when changing supported settings.

Synchronize All button Enable to synchronize all nodes of the same type with the Adaptive Degradation
settings of the current node.
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Compositing in 3D Space with Action

About Action
Action is a multilayer compositing tool for creating complex visual effects. Use Action to animate clips in
3D and add camera, lighting, and shadow effects.

You create effects and animations by manipulating objects in the scene. Objects you work with include
surfaces, light sources, axes, shadows, and the camera.

Action Concepts

The following concepts are used throughout the Action topics to describe the workflow and user interface.

Scene The scene is Action's representation of 3D world space. It is where objects are placed and animated.
World space has three directions: X (left/right), Y (up/down), and Z (in/out).

Object An object is any element in a scene. An axis, a camera, a surface, a light, or a model can also be
referred to as an object.

Media Media consists of a front and matte clip only.

Surface A surface is a special type of 3D geometry onto which media is mapped.

Geometric Object (Models) A 3D geometric object can be something as simple as a cube, sphere, or cone,
or as complex as a character. Although some basic geometric objects are included with Smoke, most geometry
is imported from a 3D application such as Maya and 3ds Max. A model is another way to refer to a geometric
object.

3D Models and Text You can import 3ds Max files, FBX format files, Alembic format files, Wavefront files,
Inventor files, and Paint geometry into Action. Also, you can create 3D text with custom beveling.

Camera The camera represents the 'eye' you are using to see the scene. The camera is used to “record” the
scene in Action. By default, the camera consists of two objects: the camera eye and the point of interest (the
coordinates the camera is 'looking' at).

Axis An axis is the element of an object or media that can be manipulated to determine the object's 2D or
3D space, position, and movement.

Schematic The Action schematic is an icon representation of the scene. It shows all the objects in the scene
and their relationship with each other. The Action schematic is different from the ConnectFX schematic
(which is more of a process tree view).
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About Using Floating Point Images in Action

You can use 16-bit floating point OpenEXR clips in Action. You can use clips of different resolutions on
separate media, but you cannot specify clips of different resolutions to act as the front and matte clip of a
specific media. Here are some things to keep in mind when working with 16-bit floating point clips:
■ Action operations and settings that are supported with 16-bit floating point clips include textures,

displacement mapping, motion blur, blending modes, anti-aliasing, and depth of field.

■ You can enable or disable colour clamping when working with 16-bit floating point clips in Action. The
Colour Clamping button is located in the Setup menu’s Rendering section.

■ You can set the output resolution for your Action composite to 16-bit fp in the Frame Depth box located
in the Setup menu’s Resolution section.

Action Interface Overview

Action is divided into a number of menus and sections designed to help you quickly create your composites.

Changing Views

You can change the orientation to view a scene from many angles. This can help you set up motion paths,
light sources, and camera angles more easily.

From the View box, select an option to set the view in the image window.

Most of the View box options have keyboard shortcuts displayed in the expanded list. Some of these keyboard
shortcut options are also cycle options. For example, pressing F5 repeatedly cycles through the animation
channels, tracks, and info views.

You can also toggle ` (on the Tilde key) to alternate between the Schematic view and the previous view.

Accessing Action Menus

The left side of the Action menu houses a number of buttons that allow you to switch between the various
Action sections and menus. Clicking any of these buttons opens the specific Action section, such as the
Action Bin or Output menu.

Using the Node Bin

The Action node bin contains nodes classified by tabs. The All Nodes tab contains all Action nodes. The
other tabs in the node bin allow you to create and customize bins. The node bin also contains an image
proxy that displays a proxy of the currently selected media, as well as a mini Media list.

To access the node bin, click the Action Bin button.
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Some nodes are duplicated in other bins according to a preset tab classification. For example, the Light node
is found in both the Objects and ReLighting tabs.

Nodes are listed in alphabetical order from top to bottom of each row. You can customize any of the bins
and preset tabs except the All Nodes bin.

To add a node from the node bin:

1 If applicable, select media from the mini Media list.

2 Do one of the following:
■ Drag the selected node (or image proxy) from the node bin and place it in the schematic. If the

node is an image type node, an axis and an image are created and linked together.

■ Drag the node (or image proxy) from the node bin and place it where you want it in Result view.
For example, as you drag a Light node into Result view, it becomes active, so you can see its effect
on the scene before placing it exactly where you want.

■ Double-click a node (or image proxy). Depending on the node, it appears next to the last added
object, or is attached to a selected node in the schematic. You do not need to be in Schematic view
to add a node in this manner.

TIP You can frame and highlight all the nodes starting with the same letter by pressing the key corresponding to
this first letter on your keyboard, while the cursor is sitting over a node bin. For example, pressing "L" while hovering
the cursor above the All Nodes bin automatically highlights Lens Flare, Lens Texture, and Light nodes.

Customizing the Node Bin

Create custom tabs and populate them with your most commonly used nodes to optimize your workflow.
As well, change the order of the tabs along the top of the bin and rename them to reflect the contents of a
tab.

You can customize any tab except the All Nodes tab.

To create a tab:

1 Click the plus sign tab.

2 Name the tab in the keyboard that appears.

NOTE You can create a maximum of 6 new tabs.
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To copy a node to another tab:

1 Drag the node on top of the destination tab.

2 Release the cursor when it changes to a green crosshair.

3 Click the destination tab when the standard yellow cursor reappears.

The copied node appears in the new tab. Nodes are added to the end of a tab in the order copied
(following the same alphabetical node order of the rows, from top to bottom of each row).

NOTE Nodes cannot be duplicated within the same tab.

To move a node to another tab:

1 Press Ctrl+Alt and drag the node on top of the destination tab.

2 Release the cursor when it changes to a green crosshair.

3 Click the destination tab when the standard yellow cursor reappears.

The node is moved from its original location to the destination tab. Nodes are placed at the end of a
tab in the order moved (following the same alphabetical node order of the rows, from top to bottom
of each row).

NOTE Nodes cannot be duplicated within the same tab.
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To reorder a node within a tab:

1 Press Ctrl+Alt and drag the node to a new location. You can move nodes from one row to another
as well as reorganize nodes within a row.

2 Release the cursor when it changes to a green crosshair at the location where you want the node moved.

If you dragged the node on top of an existing node, the existing node shifts to the right and the moved
node is inserted in its place.

To reset a bin to alphabetical layout:

1 With the applicable tab active, click Sort.

The nodes in the bin are reset to their alphabetical layout.

To delete a tab:

1 Press Ctrl+Alt and drag the tab to the bottom of the screen.

2 Release the cursor when it changes to a delete cursor.

WARNING There is no undo capability when deleting a tab.

The entire contents of the tab are deleted.

To delete a node from a tab:

1 Press Ctrl+Alt and drag the node to the bottom of the screen.

2 Release the cursor when it changes to a delete cursor.

WARNING There is no undo capability when deleting a node.

To rename a tab:

1 Click the Rename Tab button.

2 Enter a new tab name in the keyboard that appears.

To reorder a tab:

1 Press Ctrl+Alt and slide the tab to its new location.

2 Release the cursor when it changes to a green crosshair at the new location for the tab.

If you dragged the tab on top of an existing tab, the existing tab shifts to the right and the moved tab
is inserted in its place.

To save a bin layout:

1 Click Save Bin Layout.

2 Name the layout.

The layout of the entire node bin is saved, including all new and customized tabs. You cannot save
only select tabs.

Layouts are saved per user, not by project.

To load a bin layout:

1 Click Load Bin Layout.

2 Select the layout you want to load.
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NOTE If you load a bin layout containing unsupported nodes, the unsupported nodes do not appear.

Animating with the Channel Editor

Use the Channel Editor to animate the media, axis, surface, light, camera, and other properties of every
object in the scene.

To open the Channel Editor and display the Action channels:

1 In Action, click Animation.

2 In the Animation menu, select Channel from the View box.

The top-level folder in the hierarchy is the Scene, which provides the overall view of the animation.
The Scene folder contains the Result Camera and folders of objects in the Action scene. Initially these
are the media, motion blur, camera, axis, and image folders.

If you add an object to the scene, the Channel Editor adds a folder to the channel hierarchy for the
new object. For example, if you add a light, a Light folder is added in the channel hierarchy.

Action Channel Editor Reference

Some of the Action folders in the Channel Editor are described as follows.

Camera Animates the camera position and point of interest. It also contains channels for animating camera
roll, field of view, and the near and far clipping planes.

When Free Camera is selected, the point of interest channels are replaced by rotation channels in the Channel
Editor.

Media Animates media properties such as blur, crop, shadow softness. A Media folder is listed for each media
in the scene.

Axis Animates axis properties such as position, rotation, scaling, and shearing.

Image, Bilinear, Bicubic, or Extended bicubic Animates surface properties such as material, offset, and
displacement. The Material folder contains a shininess channel and folders for the specular highlight, diffuse,
and ambient lighting.

Shadow Animates the shadow colour and shadow transparency.

Light Animates light properties such as intensity, falloff, spread, position, rotation, and colour.

TIP Selecting nodes in the schematic will automatically select the associated channels in the Channel Editor.

Most of the settings in the Animation menu are standard for all tools that support animation, but there are
a few animation settings specific to Action, available from any Action menu (on the right side).

Auto Key button Enable to set a keyframe automatically each time you change a value at any frame.

Set Key button Click to set the current values for the selected channels in the current frame (when Auto
Key is disabled).

Delete Key button Click to delete the selected keyframe.
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About the Schematic and Menu Tabs

In Action Schematic view, a node exists for all objects in the scene, for example, shadows, lights, and texture
maps.

(a) Axis object is the parent of axis 4 and poly1 (b) 3D model (c) Light source (d) Diffuse texture applied to the 3D
model (e) Drop shadow of bilinear1

Here are some hints when working in the schematic with some of the various node types.

Surface Nodes (Bilinear, Bicubic, and Extended Bicubic) When you add one of these surface nodes to the
schematic, the node name is displayed with a number in parentheses. The number indicates the media
applied to the surface. For example, a bicubic object labeled (2) shows that the bicubic uses the clips from
Media 2.
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(a) Media 2 is used by the bicubic surface.

For more information on the relationship between media and surfaces, see Adding Surfaces (page 385).

Camera Node The camera node appears in Schematic view by default and you can link it to any image. Use
the camera node to rotate the camera about its own axis, and parent other nodes including shadow, texture,
and geometry nodes.

Shadow and Texture Nodes Shadow and texture nodes each display a single number in parentheses beside
the name that indicates the media used for the shadow or texture. For example, a shadow labeled (2) shows
that the shadow uses the matte from Media 2.

Source Nodes Source nodes are used as part of an advanced schematic structure that separates the media's
matte and front so that each clip can be animated individually. You can also use sources to create complex
compositing effects such as nesting.

TIP Adding many nodes and connections can quickly make for a disorganized schematic. To solve this, press
Alt+T to reorganize the schematic.

Node Settings

Object Node Name field Displays the selected object node name. Editable.

Previous Node button Scrolls to the previous similar node.

Next Node button Scrolls to the next similar node.

The right side of Action also includes other settings to help you work with nodes in the schematic.

Solo button Enable to solo an object or a branch (object and its children), depending on what is selected
in the Selection Mode box. See Soloing Objects (page 351).

Selection Mode box Make a selection to copy, delete, hide, or reset.

Clear All button Available in the Action Setup menu. Resets all parameters, and deletes nodes and media
as well. Press Alt to bypass confirmation

Reset All button Available in the Action Setup menu. Resets all parameters but does not delete nodes or
media. Press Alt to bypass confirmation.

Populating Menu Tabs of Selected Objects

Depending on what type of object is selected in the schematic, the tabs in the Object menu are populated
based on different rules, as illustrated in the following examples.
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An object’s name appears on the Object menu tab as well as beneath its node in the schematic and as a
folder in the Channel Editor.

Axis selected

The Axis menu of the selected axis appears on the left side of the Object menu, and a limited number of the
children objects' menus appear on the right side of the Object menu. The children objects are identified by
scanning the hierarchy of the schematic from top-to-bottom (starting at the selected axis). The hierarchical
scanning stops for any given branch when a non-axis object is encountered.

The order of tabs is determined on a per branch basis; that is, all of the tabs of one branch are listed before
moving to another branch, starting with the highest levels in the parenting hierarchy (lowest index levels).

For example, in the following schematic, Axis 1 is selected.

The tabs in the Object menu appear as follows. The image1 tab appears in light blue to signify that multiple
objects are connected down to it. Use the tabs to switch between menus within the Object menu. The Camera
tab appears in orange as the first tab on the right side of the Object menu, and is exempt from the tab
population rules.

NOTE If there are more than five tabs on either side of the Object menu, use the arrows beside the tab names to
navigate to the desired tab.

Other object selected (no “axis attributes”)

These objects include surfaces, texture maps, shadows, geometries, and 3D text. When one of these objects
is selected in the schematic, an ascending (bottom-to-top) scanning of branches is performed. The hierarchical
scanning stops for any given branch when an axis or object with axis attributes is encountered.

The menu of the selected object appears on the right side of the Object menu, and a limited number of the
parent objects' menus appear on the left side of the Object menu.
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For example, in the following schematic, Image 1 is selected.

The tabs in the Object menu appear as follows. The image1 tab appears in light blue to signify that multiple
objects are connected down to it. Use the tabs to switch between menus within the Object menu. The Camera
tab appears in orange as the first tab on the right side of the Object menu, and is exempt from the tab
population rules.

Object with “axis attributes” selected

These types of objects include lights and cameras. These objects trigger a different scanning behaviour
depending on their position within the schematic hierarchy. If the selected object is the first of its branch
(top of the hierarchy), it inherits the tab population rules of an axis, that is, descending branch scanning.
If the selected object is not the top object of its branch, it inherits the tab population rules of other objects,
that is, ascending branch scanning.

For example, in the following schematic, light 1 is selected.
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Since Light 1 is not the top object in its branch, the tabs in the Object menu appear as follows.

In the following schematic, light 1 is moved to the top of the branch.

The tabs in the Object menu appear as follows. The image1 tab appears in light blue to signify that multiple
objects are connected down to it. Use the tabs to switch between menus within the Object menu.
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NOTE  The Camera tab appears in orange as the first tab on the right side of the Object menu, and is exempt
from the tab population rules. If a camera node is selected in the schematic, the special Camera tab does not
appear, and the normal tab population rules apply.

Using the Object Menu for Multiple Selections

You can select multiple nodes to change some of the settings in the Object menu for all objects of the same
type.

Objects that support multiple selection and changing of field settings are axes, images, shadows, and lights.
For example, in the following schematic, you can select all of the nodes.

The tabs in the Object menu reflect the multiple selections.

In the Object menu, you can relatively change any of the available fields. For example, if the X Position for
Axis1 and Axis2 was originally 100, and for Axis3 was 200, and you drag the X Position slider under the
Mult-axes tab to 50, Axis1 and Axis2 are now set to 150 and Axis3 is set to 250.

NOTE Because the field values for individual objects can be different, the values in the multiple selected fields
display as default values in the Object menu. When you select an individual object and view its Object menu, you
can see the true field values.
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Connecting Action Nodes

In Action, you can create complex animations where movements applied to one node are passed down to
all connecting nodes.

You can add an axis to the scene by itself, then make it the parent of another node. Use this method of
parenting additional axes to create complex animations.

For example, create a cube of surfaces by parenting three additional axes to the same surface. Each axis that
is parented to a surface places an additional surface in the scene. By changing the position and rotation of
each axis, you can create a cube. If you parent the axes with another axis, you can control the position,
rotation, scale, and shear of the cube.

To create a branch:

1 Add an axis (axis2) to the scene.

2 From the View box, select Schematic. The Schematic view should be similar to the Before figure.

3 Do one of the following:
■ In the Edit Mode box, select Conenct and drag the cursor from the edge of the parent node to the

node that will be its child.

■ Press Shift and drag a parent node over another node that will be its child. With this method, the
Edit Mode box does not have to be set to Connect mode, and can remain in Select mode, for
example.

■ In the Action Prefs menu, enable Auto Parent in the Schematic section, and then in the schematic,
drag the cursor from the edge of the parent node to the node that will be its child. With this method,
the Edit Mode box does not have to be set to Connect mode, and can remain in Select mode, for
example.

Axis2 becomes the parent of axis1, as shown in the After figure.

After: Axis2 is made the parent of Axis1 using Connect
mode

Before: The schematic shows axis1 as the parent of
image1

Any transformations applied to axis2 are applied to axis1 and its surface (image1). If axis1 has any
transformations, they are added to the transformations from axis2. For example, if axis2 is set to 500,
100, 0 and axis1 is set to -50, 20, -30, the positions are accumulated and applied to the surface. In this
case, Image1 is positioned at 450, 120, -30.
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TIP You can override the transformations passed from a parent to a child by enabling the Free button in the
Axis menu.

Inserting a Node Between Connected Nodes

1 Do one of the following:
■ If Auto Insert is enabled in the Setup menu Schematic settings (this is the default), drag a node and

navigate to the link between two connected nodes. The link is highlighted in orange.

■ If Auto Insert is disabled in the Prefs menu Schematic settings, press Shift then drag a node and
navigate to the link between two connected nodes. The link is highlighted in orange.

2 Release the node.

The node is inserted, and linked to the two previously connected nodes.

Mimicking, Copying, and Duplicating Objects

Similar to working in the ConnectFX schematic, you can mimic, copy, or duplicate objects of the same type
in the Action schematic.

Using Mimic Link

To create a Mimic link between Action objects:

1 From the Edit Mode box, select Mimic Link.

2 In the schematic, drag between two similar object types, for example Axis to Axis. You can also link
different map types, such as from a diffuse map to a reflection map.

A green arrowed dotted line indicates that the objects are linked as duplicates. The direction of the
arrow indicates which object is the master.

(a) Originating object (b) Mimic link (c) Linked object

3 Change the settings of any node.

All of the settings applied to the original object are automatically applied to the linked object. Once objects
are linked, any settings applied to either object are applied to both. When linking different map types, only
the settings found in the Texture tab are mimicked.
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The originating object can link to multiple objects, but only one object can be the originating link.

NOTE To remove the link between mimicked objects, drag the cursor across the green line that joins the two
objects. Each object keeps the settings that were applied while they were linked.

Duplicating Objects

To duplicate objects:

1 In the schematic, select a node, or group of nodes.

2 Right-click the selection, and choose Duplicate.

A duplicate of the node or nodes (with all node settings) appears in the schematic.

Copying Objects

To copy objects:

1 In the schematic, select a node, or group of nodes.

2 Right-click the selection, and choose Copy.

A copy of the node or nodes (with all node settings) is added to the clipboard.

3 Navigate to the location in the schematic (or another Action schematic) where you want the copied
node or nodes to reside, right-click and choose Paste.

A copy of the node or nodes (with all node settings) appears in the schematic.

Soloing Objects

Use the Solo button to hide all other objects except the selected object. Using Solo is useful for identifying
an object in a scene with many objects, without having to hide all of the other objects.

To solo an object:

1 In the schematic, select the object that you want to solo.

2 From the Selection Mode box, choose Selected.

3 Enable Solo.

All other objects in the scene are hidden, regardless of whether they are set to Hide or not. When Solo
is disabled, the Hide settings are restored.

TIP You can leave Solo enabled and select different objects in the schematic to view each object separately.

To solo a branch:

1 In the schematic, select the parent of the branch that you want to solo.

2 From the Selection Mode box, choose Branch.

3 Enable Solo.

All other objects in the scene are hidden, regardless of whether they are set to Hide or not. When Solo
is disabled, the Hide settings are restored.
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Grouping or Hiding Objects

You can collapse branches in the schematic into a group to reduce clutter in the schematic. You can also
temporarily hide an object or objects in the schematic to see different results, for example.

To group a branch:

1 Select an object with children in the schematic view.

2 Right-click the parent object, and choose Group to collapse the selected object and all its children into
a group.

A blue group node appears in the schematic to represent the entire group.

NOTE Collapsed groups cannot act as parents, but you can parent nodes to a group.

3 To uncollapse the group, right-click the Group node, and select Ungroup.

NOTE Groups created in the Schematic view are not related to groups created in the Priority Editor.

To hide and object or objects:

1 Select and object or multiple objects in the schematic view.

2 Right-click the object, and choose Hide.

(hidden) appears after the object name in the schematic.

3 To unhide the object, right-click the object, and select Show.

Setup and Processing Options

Use the Action Node Prefs menu to customize your Action display and to access tools and guides.

Use the tabs in the menu to switch between the different options.

Rendering Tab

Resolution Settings

You can set the rendering resolution of clips that are output in Action. For example, if you are working in
an NTSC 8-bit project, the default output is NTSC 8 bits. However, if you want to change the output resolution
to HD (1920x1080), use the Resolution menu to change the values so the final outcome will be 1920x1080.

You can choose between progressive or interlaced when rendering at video resolution. Action media
automatically adjust the rendering mode of each clip. This inherent awareness also makes it possible for
Action to properly mix field-based HD / PAL with NTSC and not have dominance problems.
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Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

Once you make a selection from the Apply and Scale box, the resolution is set for processing clips, and is
remembered between Action sessions.

TIP Select Background Resolution to set the resolution to that of the background clip. The settings in the Resolution
section change automatically to reflect the background clip resolution. If there is no background clip, the settings
revert to the project resolution.

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Frame Depth box Select the render/output frame depth of clips.

Scan Mode box Select the scan mode of clips.

Apply and Scale box Select whether to apply or apply and scale the defined resolution settings. All subsequent
processes will use the new render settings.

To:Select:

Specify the output resolution.Apply

Specify the output resolution and scale a scene to the defined resolution. Use this option

if you are working with a low resolution of an Action setup from a previous version of

Apply + Scale

Smoke. The scaling is applied to geometries, axes, lights, and cameras as well as their

coordinates. Their positions are scaled accordingly.

Smoke automatically scales textures and images.

NOTE If you do not change the Resolution settings, rendered results and camera settings default to the values set
for the current project (set when you created a new project).
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Stereo Settings

Reset To Stereo Mode button Enable to clear any previous stereo settings in Action, and reset all stereo
settings to their defaults.

In the Stereo mode, these are the default settings when you enter Action with the Front/Back/Matte input
option using stereo clips:
■ A 3D camera (stereo camera) is created and the default camera is hidden.

■ In the 3D Camera menu, the Result Camera is set to the stereo camera.

■ In the Output menu, the Mode is set to Stereo and the Camera is set to Result Cam.

■ A stereo object is created with the clips you selected.

NOTE If you enter Action using mono clips, the default camera is automatically created. If you need a stereo
camera, you must add it manually.

Rendering Settings

Use the Rendering settings to improve the final output quality of your image.

Z-Buffer box Select an option to determine whether the distance from the camera eye is considered to
determine the order in which objects are rendered.

Wireframe button Enable to display each surface and 3D model as a wireframe.

This is useful if interaction with Action becomes slow because of many surfaces and 3D models. Convert
objects to wireframe when you want to speed up processing or rendering times. Because lighting and textures
are not computed in wireframe mode, interaction time and rendering times are reduced.

Shading button Enable to light up the scene using added light sources. When Shading is disabled, no lighting
effects appear in the scene; surfaces and 3D models appear flat.

Enable Shading for:
■ Light sources

■ Ambient or diffuse lighting for surfaces

■ Specular highlights for surfaces and 3D models

Clamp Colours button Enable to clamp colour and luminance in the 16-bit floating point processing
pipeline.
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Anti-Aliasing Settings

Software Anti-Aliasing Sample box Select a software anti-aliasing sampling level.

The jagged lines that often occur along the edges of diagonal or curved lines when processing high-frequency
images such as text are the result of aliasing. You can increase or decrease the anti-aliasing sampling level
(up to 64 samples). Higher values yield smoother results at the expense of processing time.

Anti-Aliasing Softness field Displays the softness value of the software anti-aliasing sample. Editable.

Hardware Anti-aliasing Sample box Select a hardware anti-aliasing sampling level to accelerate edge
anti-aliasing with no performance penalty. Available values are dependent on graphics card and project
graphic bit depth. Hardware anti-aliasing also gives anti-aliasing during normal interaction instead of only
while rendering.

You can combine hardware anti-aliasing level with software anti-aliasing to obtain the desired level of image
quality. For example, with hardware anti-aliasing set to 4 samples, and with 4 samples of software anti-aliasing
selected, your results should be similar to selecting 16 samples of software anti-aliasing, but with a processing
time much closer to that of 4 samples. You should experiment with different combinations to determine
what works best for you.

Accumulation Settings

Use the Accumulation settings to define motion blur properties.

Global Motion Blur button Enable to use motion blur. Once enabled, specific Action object Motion Blur
buttons can be enabled or disabled. See About Motion Blur (page 525) for specific examples of creating motion
blurs.
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Samples field Displays the quality of motion blur and the depth of field produced by the number of samples
taken at each frame. Editable.

Increasing this value causes the processing time to increase linearly and affects the quality of the depth of
field. The number of motion blur samples is multiplied by the number of anti-aliasing samples. To reduce
the total number of passes made for each frame, reduce the level of anti-aliasing when motion blur is enabled.

Phase field Displays the frame that motion blur is based on (before or after the current frame). Editable.

A value of -100 places the motion blur before while a value of 100 places the motion blur after. A value of
0 is centred, which evenly distributes the motion blur. The default value is 0.

Shutter field Displays the duration of motion blur at each frame (essentially the number of frames that the
shutter is open). Increasing this value does not increase the processing time. Editable

TIP You can animate the Global Motion blur button, as well as the Phase, Shutter, and Samples fields. They can
be found in the Channel Editor under the motion_blur folder.

Motion Blur curve Controls the sample weight over the scope of the motion blur.

Home button Resets the position of the motion blur curve after panning.

Reset button Resets the motion blur curve.

Preferences Tab

Surfaces Settings

Default Resolution field Displays the default geometry resolution (number of polygons) of surfaces. You
can also change the geometry resolution of specific surfaces in the Surface menu. Editable.

The lower the value, the better the resolution and the greater the processing time required to interact with
the image. A value of 1 creates one polygon per pixel on a surface, affording accurate displacement and
lighting.

Apply Resolution To All button Click to apply the geometry resolution in the Resolution field to all surfaces.
Since you can change the resolution of specific surfaces in the Surface menu, you can use this button to
re-apply the default resolution to all surfaces.

Filtering Settings

Default Filter box Select the type of filtering to be set as the default when creating surfaces and maps.

Apply To All button Click to apply the default filter to all existing surfaces and maps.

Miscellaneous Settings

Animation Update button Enable to update properties such as position, rotation, and colour in the scene.
When disabled, animated objects do not move, but keep the position of their current value. Disable to copy
keyframe values from one frame to another.
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Play Lock button Enable to update the animation settings according to the frame or timebar position as
you move through the clip while keeping it locked at the current frame.

When Play Lock is disabled and you use > or < to play the resulting clip, each frame is loaded and displayed
in sequence in the image window.

Front Only button Enable to display only the front media in the Media menu. Disable to display both the
front and matte media.

Auto Image button Enable to add an image node and axis automatically in the schematic when new media
is added.

Shift-Snap button Enable to use the Shift key as a snap-to-surface modifier key. Hold the Shift key when
selecting an axis to snap the selected axis to the surface of the underlying geometry. Not available when in
Top, Front, or Side views.

Matte Channel box Select which channel is displayed as transparent by default. This can be useful for a
multichannel clip to display only the Red channel matte, for example.

Display Settings

Icons box Select object icon (axes, borders, control points) display options. The selected option displays
icons only for the object currently selected in the scene.

Icon Transparency field Displays the transparency level for icons in the scene. Editable.

Ruler button Enable to display the ruler in the scene area. Use the arrows at each extremity of the ruler to
place the beginning and end of the ruler anywhere in your scene view.
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TIP Use the Shift key to snap the ruler into place either horizontally or vertically.

Ruler Define button Enable to define real unit measurements, such as feet, metres, or inches, instead of
pixels. All camera distance or axes measurements thereafter use the defined scale.

Ruler Length field Displays the length and measuring unit (feet, metres) to use in Action. When you enter
a length, click Define again to apply the new scale to the ruler and all pertinent fields, such as position,
rotation, and scale. Editable.

TIP Hold the Ctrl key and click Define to reset the ruler’s scale.

Grid Colour pot Displays the custom colour for the grid. Editable.

Grid box Select the type of grid to display in the scene. Use to position objects in the scene more accurately.

To:Select:

Disable the grid.Grid Off

Use a grid constructed on the X and Y planes.Grid XY

Use a grid constructed on the X and Z planes. The XZ grid is visible only when the camera

is moved from its default position.

Grid XZ

Use a grid constructed on the Y and Z planes. The YZ grid is visible only when the camera

is moved from its default position.

Grid YZ

NOTE The Action grid is independent from the global grid in the Grids and Guides menu.
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Ortho Near field Displays the value of the near view in the image window when using Camera or an
orthographic view. Editable.

Ortho Far field Displays the value of the far view in the image window when using Camera or an orthographic
view. Editable.

Schematic Settings

Auto Parent button Enable to automatically parent nodes in the schematic. Press Alt and drag a node in
the schematic to disable Auto Parent temporarily.

Auto Insert button Enable to automatically insert a node when dragged between two connected nodes.
When disabled, press Shift to auto insert.

Snap To Grid button Enable to position objects with precision in the scene. When you move an object in
the scene, the object is automatically aligned to the snap grid.

NOTE When enabled, this snap only applies to the grid defined in Action. The grid defined from the Grid & Guides
menu remains visible, but its snap is overridden as long as the Action Snap is enabled.

Schematic Transparency field Displays the level of transparency of unselected nodes in the schematic.
Editable.

Display Information box Select what clip information is displayed in the schematic.

Proxy Update button Enable to automatically update proxies in the schematic. Interaction is slower when
enabled. When disabled, Action updates proxies when you switch views. You can also update proxies by
clicking Update.

Output Naming Settings

Action Name button Enable to allow newly created outputs in the Output List to inherit the name of the
Action node. If disabled, it will use a default output [number] for additional outputs. You also can rename
any output manually by clicking the Rename button below the Output List. Once a setup is saved, the output
will use the setup name when processed.

Append Type button Enable to append the type of output to the name of a processed file.

Adaptive Degradation Tab

Use these settings to temporarily deactivate taxing operations during interactive manipulations. These
settings do not affect the final renders.
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Active button Enable to activate adaptive degradation display settings. Use to prevent slowdowns of the
image window display when changing Action settings. Press Ctrl+D to activate or deactivate degradation
settings.

You'll see an icon  displayed at the bottom right corner of the image window when degradation is active
in Action.

Synchronize All button Enable to synchronize all ConnectFX Action nodes with the Adaptive Degradation
settings of the current Action node.

Filtering Degrade box Select whether to degrade filtering selections in the image window when changing
any Action settings.

Filtering Update box Select whether to always degrade filtering selections, or on manipulation only.

EWA Filtering box Select whether to apply EWA or EWA+Linear filtering on maps (if selected in the Filter
box) only when processing (On Process Only), or all the time when working in Action (Degrade).

Flares Degrade box Select whether or not to degrade Lens Flares.

Rays Degrade box Select whether or not to degrade Rays.

Blooming Degrade box Select whether or not to degrade Blooming.

Particles Degrade box Select a particle quality display setting.

Particles Update box Select whether to always degrade particles selections, or on manipulation only.

NOTE The Particles options are available in Smoke since you can load an Action setup with particles that can be
viewed in the image window.

AO Degrade box Select an ambient occlusion quality display setting.

Shading Degrade box Select whether to degrade shading selections in the image window when changing
any Action settings.

Shading Update box Select whether to always degrade shading selections, or on manipulation only.

Shadows Degrade box Select a shadow quality display setting.

Shadows Update box Select whether to always degrade shadows selections, or on manipulation only.

Surfaces Degrade box Select a surface quality display setting.

Surfaces Update box Select whether to always degrade surfaces selections, or on manipulation only.
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Motion Blur Degrade box Select whether or not to degrade Action motion blurs in the pipeline.

Software AA Degrade box Select whether or not to degrade Action software anti-aliasing in the pipeline.

Depth of Field Degrade box Select whether or not to degrade Action depth of field in the pipeline.

NOTE When Adaptive Degradation is active for a ConnectFX Action node, you'll see an icon  over the node
in the schematic, and in the bottom right corner of the image window in result view.

Saving, Loading, and Importing in Action

You can save, load, and delete Action setups, and import Photoshop files into Action.

When importing a setup that contains non-supported objects (such as particles and deformations in Smoke),
these objects are displayed as greyed out nodes in the schematic, and greyed out menus in the Object menu.
These greyed out objects are read-only objects that can be viewed (in the image window and the Object
menu), but not modified or linked to or from. In Channels view, you can view the parent channel for the
non-supported object, and in Tracks view, you can slide or stretch the parent channel. If you modify the
setup and resave it, you can then open it in the application that supports the objects, and modify all objects.

Schematic of same setup opened in SmokeSchematic of Flame setup

To save an Action setup:

1 In ConnectFX, select the Action node. Click Save Node (found next to the node name field).

The file browser and Save menu appear.
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2 From the Save Action box, select the format for saving the setup.

To save:Select:

References to all clips in the Media list.All

The selected objects, their media and media settings.
Any expressions on channels of selected nodes are baked to the channels before saving,
and any Mimic links to or from non-selected nodes are removed before saving. If a node

Selected Objects

is selected that is mimicked from a non-selected node, though, the animation channels
are copied from the node before saving.

Selected animation channels as a user-readable ASCII file. In the file, each line corresponds
to one frame, and each column consists of one frame number and the value of the anim-
ation curve at that frame. All saved information starts at frame one.
A file with the extension .raw is saved in the .../action directory by default.

Raw

At least one channel must be selected in the Channel Editor.

The current text settings, including font, character size, kerning, italics, depth, beveling
curve, and text string properties, all of which can be loaded in another Action session.
A file with the extension .atext is saved in the .../action directory by default.

Text

A 3D text node must be selected in the schematic.

The current Action settings as user preferences.
A file with the extension .pref is saved in the /usr/dis-
creet/user/<product_name>/<user_name>/action/pref directory.

Preferences

The current Action preferences as Action's new default settings.
To restore Action's factory default settings, select Factory Defaults in the Load menu.

Defaults

A multilayer setup for all Action media and save a multiversion clip in the current library.MultiVersion

3 Type a name for the setup file and click Enter.

The name appears in the Name field.

By default, the setup is saved in the /usr/discreet/project/<project_name>/action directory. Using the file
browser, you can save setups to the directory of your choice.

4 Once you have saved an Action setup, you can quickly resave it by clicking Save again.

To load a setup in Action:

1 In ConnectFX, select an Action node. Click Load Node (found next to the node name field).

The file browser and Load menu appear.

NOTE When you access the file browser through Load, you also have the option of deleting existing setups.

2 In the Load box, select the format for loading the setup.

To:Select:

Load the clips in the selected setup into their corresponding media. The media in the
Media list is replaced with the loaded clips. If a clip cannot be found, Action searches for

All

it and loads it automatically to Action. If the clip still cannot be found, Action displays
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To:Select:

the missing clip name in red in the Media list. A surface that uses a missing clip appears
as an outline in the image area and is shown in red in Schematic view.

Load a setup without its clips. The current media in the Media list remains the same.No Clips

Add nodes and media from the setup file. This option appends the schematic from the
setup file to the current schematic, and wherever possible, media from the setup file fills

Add Nodes+Media

empty slots in the Media list. Remaining media from the setup file is appended to the
end of the Media list.
Enable Load Cameras if you want to include the cameras saved with the setup.

Add only the nodes from the setup file. This option appends the schematic from the
setup file to the current schematic.
Enable Load Cameras if you want to include the cameras saved with the setup.

Add Nodes

Load a multiversion setup. Loads front, matte, back, and background video versions from
an entire clip. Replaces all media.

MultiVersion

Load raw animation data to a selected channel in the Channel Editor.Raw

Load the text setup files.
The text settings are loaded into Action's Text menu.

Text

Load a file containing Action preferences.Preferences

Load original Action default settings.
Selecting this option prompts you to confirm that you want to restore factory defaults
and returns you to the Action menu.

Factory Defaults

3 Select the setup you want to load.

NOTE Sample Action setups are provided in the ~/examples/action directory.

Importing Photoshop Files into Action

You can import Adobe Photoshop® format files into Action without having to convert them into a TIFF or
other format. Once imported, the PSD file keeps its inherent layer structure, which can be used or modified
within Smoke.

You also have the option of automatically importing all the layers at their native resolution. Each layer is
parented by an axis that gives it the correct offset in the X and Y axes. Hidden layers are imported, but will
remain hidden. Photoshop blend modes are maintained for each layer.

To import a PSD file into Action:

1 From the Action Node bin, double-click the Import node.

The file browser appears.

2 From the Import Type box, select the Photoshop format.
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3 Select a .psd format file.

4 Click Load.

The Photoshop file is loaded into Action. Each layer is parented by an axis, and blend modes are
maintained. The Photoshop files are added to the media list and to the ConnectFX Sources folder.

About Rendering Outputs from Action

Use the multi-pass rendering capabilities of Action's Output menu to manage your outputs. Options are
available to help you set up and prepare many different types of outputs, much as you would with render
passes in a 3D application. You can process multiple outputs at once, from your complete Action scene, to
specific Shadow or Z-Depth outputs, for example.

Action Output Workflow

When using the Action Output menu, you usually follow the options from left to right.

Action:Step:

Use the Outputs List (page 364) to add, copy, delete, and rename outputs.1

Set Output (page 365) and Render (page 367) options per output in the Output List.2

Select objects (page 368) to output.3

Render your outputs from Action (using the options in the Render button and dropdown list).4

To access the Output menu, click the Output button.

Outputs List Settings

Use the Outputs List to organize the outputs you want to process. You must have at least one output in the
Outputs List. By default, a complete_scene[Comp] output exists, which is set to process the entire comp and
result camera.

When you save an Action setup, your outputs are also saved.
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Output List Lists all of the existing outputs. Use the buttons below the list to populate the list with the
outputs you want. To select an output to process, click the yellow arrow beside the output (you can click as
many outputs as needed).

Add button Adds a new output to the Outputs list. Use the Rename button to change the name to something
more meaningful.

TIP Use the Output Naming settings in the Action Setup Preferences (page 356) menu to set default naming
conventions for your outputs.

Copy button Creates a copy of a selected output.

Delete button Deletes the selected output from the Outputs list.

Rename button Opens the onscreen keyboard to rename the selected output in the Outputs list.

Output Options

For each output in the Outputs List, you can refine the output parameters.

Mode box Select a render mode: Stereo, Left, Right, or Mono.

NOTE Selecting the Stereo mode and a stereo camera results in left and right clips when processed. Selecting
Stereo mode and any monoscopic camera results in two identical clips. Selecting Left, Right, or Mono results in
a single output, regardless of the camera selected.

Camera box Select a camera or stereo rig to output for the selected output.
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Type box Select an output type. Output and Render options change based on the Output Type.

To render:Select:

Selected objects in the scene with their parameters.Comp

The matte of the selected objects in the scene.Matte

The matte of the media specified in the Media field.Media Matte

The Z-depth of selected objects in the scene.Z-Depth

A white image with greyscale regions that represent the shadow cast coverage.Shadow

A grayscale output that is dark in areas that light cannot reach and bright in areas

where it can.

AO (Ambient Occlusion)

Shadow Output Type box Select the type of shadow cast to output.

Comp box Select whether to render the scene over a background or over a colour you choose using the
colour picker.

Comp colour pot Displays the colour that the comp is rendered over. Editable.

Threshold field Displays the value at which the alpha is included in the depth of the output.

Matte Background box Not shown. Select whether the object's matte is rendered on top of a black (default)
or white background.

Media field Not shown. Displays the number that corresponds to the media in the Media list. Editable.

Light box Not shown. Select which light to include in a shadow output.

Filtering field Not shown. Displays the amount of smoothing in a shadow output. Editable.

Maximum Z Difference field Not shown. Displays the maximum amount of Z depth information to take
into account for smoothing a shadow output. Editable.

Bit Depth field Not shown. This locked field displays that this output type is locked to a 16-bit floating
point output. Non-editable.

Ambient Occlusion Output Options

Ambient occlusion refers to the blocking of indirect or diffuse light on an object. Ambient occlusion is caused
by indirect light's inability to bounce around and illuminate areas that are blocked by a nearby object that
absorbs the light rays. These subtle variations in lighting are visual clues for our eyes to detect surface details
and distinctions that would otherwise be washed out and unnoticeable. Ambient occlusion adds realism to
your scene by adding shadows in crevices, nooks and crannies, and so on. For each surface point, it calculates
how much light is blocked by other geometry.
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These settings are available for the AO type, and for the Comp type, if Use AO is enabled in Render Options.

Density field Displays the amount of darker areas to include in the ambient occlusion output. Editable.

Tolerance field Displays the starting point at which darker areas are included in the ambient occlusion
output. Editable.

Spread field Displays the width of the ambient occlusion effect. Editable.

Blur field Displays the amount of blur applied to the ambient occlusion. Editable.

Falloff field Displays the amount of falloff around the edge of the ambient occlusion effect. Editable.

Precision field Displays the number of steps to take into account on rays cast from the surface of the object.
Editable.

Samples box Select an ambient occlusion sampling level. Press Preview to see the result.

Softness field Displays the softness value of the ambient occlusion sample. Press Preview to see the result.
Editable.

Regen button Enable to dynamically refresh the image as changes are made to the ambient occlusion
settings.

Render Options

Use the Render Options to further refine your output. Different options are available or greyed out depending
on the output type you choose in Output Options.

Anti-Aliasing button Enable to include anti-aliasing processing in the output.

Motion Blur button Enable to include motion blur processing in the output.

Transparency button Enable to include the alpha transparency of the objects in the Output when processing
this output.

Depth of Field button Enable to process the selected output with the Depth of Field settings defined in the
Action Setup menu.

NOTE The Depth of Field option is unavailable in Smoke unless an Action setup is loaded that has depth of field
information in it.
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Use Emissive button Enable to process an output with the effect of an emissive map in the scene. An emissive
map uses colours to simulate a glowing effect within the texture.

Use Ambient button Enable to process an output with the ambient effect.

Use GMask button Enable to process the output with garbage mask effects. Available for all output types
except Matte and Media Matte.

Use Gmask box Not shown. Select whether to use the garbage mask transparency or render the GMask
colour. Available for Matte and Media Matte output types.

Blending box Not shown. Select whether to use a master blend option (Change Blend) or to use the blend
set in the Blending Mode box (Keep Blend). Available for Matte and Media Matte output types.

Blend Mode box Not shown. Select an option to determine the blending mode of the mask when it overlaps
with another mask. Available for Matte and Media Matte output types.

Use Specularity button Enable to process an output with the specularity effect.

Use Reflection button Enable to process an output with the reflection effect.

Use AO button Enable to process an output with the ambient occlusion effect.

Selecting Objects to Output

You can select objects to include in your output by using the Object Options and Object List, or the Edit
Output mode. Objects that are part of an output are displayed in the Object List. For each selected object,
you can decide if you want it to be visible in the final render or not. Non-renderable objects, such as cameras,
are always included in outputs.

TIP When you create a new output in the Outputs list, it is empty by default. Enable All Objects to display all
objects in the scene.

To select an object:

1 In the Object List, click an object.

Selected objects are highlighted in the Object List, schematic, and image window.

2 To select additional objects, Ctrl-click another object.

NOTE When you select multiple objects with different visibility settings (Visible or Occluded), Mixed is
indicated in the Visibility box.
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To output all objects:

1 In the Object Options, enable All Objects.

All objects in the scene, as well as any object you subsequently create, are included in the selected
output.

To set the visibility of an object:

1 Select an object from the Object List.

2 From the Visibility box, select one of the following:

Occlude Only Renders the object as black, excluding it from the shading effect. The result is a perceptual
hole where the object was originally located.

Visible Renders the object in the final render.

NOTE When the Output type is set to Z-Depth, the objects in Occlude Only mode are rendered normally;
it will be part of the Z-Depth output. The Visibility mode is ignored.

To add or remove an object from the Object List:

1 From the Edit Mode box, select Edit Output.

NOTE In Edit Output mode, All Objects in the Object Options is disabled when you remove objects from
the selected output.

2 Add or remove objects from the output by doing one of the following in the schematic:
■ Click an object. The complete tree of the object in the schematic must either be selected or grayed

out for it to be included or excluded from the output.

■ Press Ctrl and drag in the schematic to add or remove multiple objects (or trees) from the output.
This acts as a toggle between selected or greyed out (included or excluded from the output).

To set all objects to Visible mode:

1 Click Reset All.

All objects in the selected output are set to the Visible mode.

Object Options

All Objects button Enable to output all objects in the Object List.

Visibility box Select a visibility option for the selected object.

Reset All button Click to set all objects to Visible mode in the Object List.

About Media
You should have a working understanding of Action media and the relationship between media and surfaces
to be successful in using Action. Media has the following characteristics:
■ Each front and matte clip combination that you load into Action is called media.

■ The clips you load into Action are listed in the Media list.

■ When you first open Action, you load the front clip and matte clip for the first media and a common
back clip for all media.
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■ Media must have a front and matte of the same resolution, but each media can have a different resolution
from the other.

■ You can work with front only or matte only media. In this case, the empty front or matte is replaced
with an internal white frame of the same resolution.

■ The same media can be applied to multiple surfaces. Any cropping, blurring, or recolouring that you
apply to one instance of media is applied to all the surfaces for that media. For example, if you blur
media, all of the surfaces using that media are blurred.

Working With Media in the Media Menu

When you open Action, you load the front and matte clips for the first media. You can then load any
additional media.

The clips you load for each media appear in the Media list. The back clip you selected to access Action appears
in the first row of the Media list and is assigned the letter B in the # column. The second row in the Media
list contains the first front and matte clips you selected when accessing Action. The length of each clip
appears in parentheses beside the clip name. A new line is added to the Media list each time you add media.
For stereoscopic projects, you can apply media to the left and right eye.

You can sort the Media list by list number, front clip name, or matte clip name. As you view clips, you can
look at the original front, back, or matte clip individually, as well as the results of colour correcting and
keying a matte.

To access the Media menu, click Media in the Action menu. To help identify media, Alt+click a surface
in the schematic, result, or camera view to automatically select the media in the Media list. If the Media
menu is not selected, press Alt and double-click the surface to switch to the Media menu, and automatically
select the media in the Media list. Also, when you select multiple surfaces, you can press Alt to select all
associated media in the Media list. In this case, the first item selected is framed in yellow in the Media list
as the current selection.

(a) Back media (b) Front media (c) Matte media (d) Reset box

Media Menu Tips

Use these tips when working with clips and media in the Media menu.
■ Different colours and shades are used as visual cues within the Media menu. The current media is outlined

in yellow, and the selected media is highlighted in light grey. Selected fields of the media are highlighted
in grey.

■ Ctrl-click fields or media to add to a selection, or Shift-click to add a range to a selection. If you
Ctrl-click a field that is already selected, all selected fields of this type in other selected media become
deselected. However, if you continue to press Ctrl, you can then click any field, and all fields of the
same type in other selected media become selected.

■ Click a numeric field to display the calculator, or click and drag to increase or decrease the value in a
field.
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■ Ctrl+Alt-click a field to reset the field.

■ Double-click the Gaussian, Divide, or Crop field to toggle the effect on or off. Press Shift while
double-clicking to apply the toggle to all selected media.

■ Double-click The K or CC to enter its menu.

■ Click a front or matte media to select all the displayed fields.

■ Use the F keyboard shortcut to toggle the matte media display in the Media list on or off. You can also
set this behaviour with the Show Front Only button in the Action Setup menu.

■ Resize the column widths in the Media menu by dragging the column dividers.

■ Ctrl-click to multiselect media for applying to the left or right eye of a stereo object. The media you
select first (odd numbers) are applied to the left eye. Even numbered media apply to the right eye.

Media Menu Settings

The Media controls are described as follows.

Media List box To add media directly to the Media list, select New Media. To add an indirect layer to the
Action node, select New Input.

Image Proxy Displays a proxy of the currently selected media.

Apply button Applies the selected media in the Media list to the selected surface in the scene.

Apply dropdown list For stereoscopic clips, select how the selected media in the Media list is applied to
the selected surface in the scene.

Copy button Copies media and effects (for example, Blur and Crop settings) of the selected media in the
Media list. Use the Paste options to decide how you want to use the copy/paste operation.

Clone button Clones the selected media, or media and effects onto a new media entry in the Media list.

Clone dropdown list Select whether the clone operation clones just selected media, or media and effects.

Paste button Pastes the copied parameters onto the selected media or media entry in the Media list.

Paste dropdown list Select how the paste operation is applied in the Media list.

To:Select:

Paste the copied media onto a selected empty media entry, without any

effects (such as Blur or Crop settings).

Paste Media Only

If pasting onto an existing media entry, pastes only the copied effects. If

pasting on an empty media entry, pastes both the copied media and effects.

Paste FX/Media+FX

Delete button Deletes the selected media from the Media list.

Replace button Click to open the area selected in the Media From box to choose media to replace the
selected media in the Media list.

Extract button Click to convert the selected media in the Media list from direct to indirect media.
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Front Clip box Select an option to edit the front clip's visibility.

To:Select:

Display the front clip for the selected media.Front On

Hide the front clip for the selected media.Front Off

Lock the selected front clip at the current frame in the timebar.Front Lock

Back Clip box Select an option to edit the back clip's visibility.

To:Select:

Display the back clip.Back On

Hide the back clip.Back Off

Lock the back clip at the current frame in the timebar.Back Lock

Matte Clip box Select an option to edit the matte clip's visibility.

To:Select:

Display the matte clip for the selected media.Matte On

Hide the matte clip for the selected media.Matte Off

Invert a matte. Black areas will be made white, and white areas will become black.

TIP To invert multiple matte clips, Ctrl-click the matte media and select Invert in the Matte

Clip box.

Matte Invert

TIP Use options in the View box to display selected media in the image window: Media Front (or press F1), Media
Back (F2, and Media Matte (F3).

Media Rendering box Select a rendering option per media.

Reset Choice box Select the Media list properties to reset.

Reset button Resets the properties selected in the Reset Choice box.

Keyer field Loads the back, front, and matte clips for the selected media into the Modular Keyer. See Accessing
the Colour Corrector and the Modular Keyer from Action (page 376).

NOTE The back clip is loaded into the Modular Keyer for reference only. Any modifications you make to the back
clip, such as colour correction, are not applied in Action.

CC field Loads the clip for the selected media into the Colour Corrector. See Accessing the Colour Corrector
and the Modular Keyer from Action (page 376).

Xblur and Yblur fields Adjusts the amount of Gaussian or Box blur along the X and Y axes.

Slip field Slips the back, front, or matte clip.
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Shadow field Adjusts the softness of a shadow. If the scene contains more than one shadow using the
selected media, all shadows are softened by the same amount you specify in this field. See Adding Drop
Shadows (page 405).

Gaussian field Uses Gaussian blur on a selected media.

Divide field Divides the front media by its associated matte media.

Crop and Crop Softness fields Crops a front clip or a matte clip for a selected media. Use the Top, Bottom,
Left, and Right fields to crop the selected sides. You can also add crop softness.

NOTE For more information on slipping, blurring, dividing, and cropping in the Media list, see  Adding Effects to
Media  (page 373)

Adding Effects to Media

The Media list allows you to easily add and edit effects to your clips, such as blurs and crops.

Blurring a Clip

To blur the front, matte clip, or back clip for the selected media, use the Xblur and Yblur fields. The Xblur
field controls the amount of blurring on the horizontal (X) axis, and the Yblur field controls the amount of
blurring on the vertical (Y) axis.

NOTE If you apply the media to more than one surface, all the surfaces are blurred.

(a) Xblur (b) Yblur (c) Gaussian Blur

You can use a Gaussian (Gaussian enabled) or a Box blur (Gaussian disabled):
■ Gaussian blur has rounded, smoother edges. It is a better blur for animation because it can be blurred

on a subpixel level (0.00).

■ Box blur has rectangular, rougher edges.

To blur the front clip of media:

1 In Action, click Media.

2 Select the front media.

3 To use a Gaussian blur, double-click the Gaussian field (otherwise a Box blur is applied).

4 Set the blur using the Xblur and Yblur values, and then negate the values for the Blur fields on the
matte media. For example, to blur only the front clip 10 pixels on both axes, set the front Xblur and
Yblur fields to 10 and the matte Xblur and Yblur fields to -10.

TIP Alt-drag over the XBlur or YBlur field to change both values proportionally.
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To blur the matte clip of media:

1 In Action, click Media.

2 Select the matte media.

3 To use a Gaussian blur, double-click the Gaussian field (otherwise a Box blur is applied).

4 Set the matte Xblur and Yblur fields. Blurring only the matte clip produces a softer edge on the surface
of the front clip.

TIP Alt-drag over the Xblur or Yblur field to change both values proportionally.

Cropping a Clip

When you crop media, the front and matte clips are cropped together. You cannot crop the back clip. If you
applied the media to more than one surface, all the surfaces are cropped.

You can animate a crop by changing the size and shape of the Crop box at different keyframes. You can also
animate the softness of the Crop box.

NOTE Animating a crop in the Channel Editor does not enable the Crop field in the Media list.

To crop a clip with the Media list:

1 In Action, click Media.

2 Set values for cropping and softness in the Top, Bottom, Left, and Right fields. Once you set a value
in one of the Crop or Softness fields, white checkmarks indicate that Crop and Softness are enabled.

(a) Softness area of Crop field (b) Crop area of Crop field

TIP Alt-drag over one of the fields to change all four values proportionally.

To crop gesturally in the image window:

1 Double-click the Crop field to enable Crop and Softness.

2 In the View box, select Media Front or Media Matte.

The clip appears in the image window with a red outline, which indicates the Crop box, and a green
outline, which indicates the Softness box.
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(a) Crop box (b) Softness box

TIP You can use two viewports to view the crop interactively on both the front and the matte clips.

3 Set the corners of the Crop box and Softness box by dragging either the corners or edges of the red
and green outlines.

The crop and softness values in the Media list are updated as you drag.

4 Click Result.

The cropped media appears in the image window, and the front and matte clip share the same crop.

5 To mute the Crop and Softness values, double-click the Crop field. To mute only the Softness,
double-click the Softness area of the Crop field. When muted, a black checkmark appears in the Crop
field.

Eliminating Unwanted Black in Areas of Media Transparency

When compositing with images generated by rendering 3D objects over a black background, unwanted black
often appears on translucent or anti-aliased areas of the media. Use the Divide tool to divide the front media
by its associated matte media, which eliminates the black edges in the composite.

To remove unwanted black in media transparency:

1 In Action, click Media.

2 In the Media list, select the media containing the unwanted black.

3 Double-click the Divide field of the media containing the unwanted black.

The selected media's front is divided by its matte, resulting in correct colour in areas of transparency.
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Slipping Media

You can animate the Slip value of a media's front, matte or background clip. Do this to begin a clip at a
specified frame number, or to produce a freeze frame effect where the first frame is held for a specified
number of frames. In addition, Slip values are animatable for all types of clips.

If you want to animate the Slip values, or control the Front Slip and Matte Slip separately, use the Channel
Editor. The channels are found in their respective media and are named Slip and slip_matte. The Background
Slip channel is found in Scene ➤ Media ➤ Background ➤ Slip.

To slip media:

1 In Action, click Media.

2 Change the value of Slip for either the Front or Matte fields, or both, of the media you want to slip.

TIP Alt-drag over the Front or Matte slip field to change both while maintaining the same offset.

A positive value starts the clip at the specified frame. A negative value creates a freeze frame effect
where the first frame of the clip is held by the specified number of frames.

To slip a background clip:

1 Change the value of the B (background) Slip field.

Accessing the Colour Corrector and the Modular Keyer from Action

By accessing the Modular Keyer and the Colour Corrector directly from Action, you can key any media or
colour correct any front, matte, or back clip without having to exit Action.

When you enter the Colour Corrector or Modular Keyer from Action, you can view the result of your colour
correction or key as it would appear in Action by selecting Context from the View box. The Context view
is interactive; as you make changes, the Action result is updated in the image window.

Use Result view while keying or colour correcting. In this way, the number of Action media has no impact
on system performance. You can tweak the keying and colour correction setup using Context view.

While you work in the Colour Corrector or Modular Keyer, you do not have to click Render; the modifications
are automatically applied to the media in Action. If you enter the Colour Corrector from Action, scrub the
timebar to view the Result.

When loading Action setups that contain CC or Keyer effects from a previous version, you may experience
a slight loss of quality when viewing proxies. To avoid this loss of quality, select Proxy Full from the Action
Setup menu.
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To access other tools from Action:

1 In Action, click Media.

2 Double-click the corresponding field for your chosen media and tool. For example, to colour correct
the matte clip, double-click the matte CC field.

(a) Modular Keyer (b) Colour Corrector

3 As you work in the tool, select Context from the View box to preview the result.

4 Click Return to return to Action.

Muting Media Effects

You can mute Keyer and Colour Corrector media effects in the Action Media menu. Muting effect media
can be helpful when you want to see what your Action setup looks like without the Keyer or Colour Corrector
settings, but not lose any of the settings of the muted media effect.

To mute an effect, press Alt and click the K or CC media. The check mark in the field turns black to signify
the media effect is muted. To unmute the media effect, press Alt and click the field again.

(a) Active media effect (b) Muted media effect

About Using the Modular Keyer from Action

There are some minor differences when you access the Modular Keyer from Action instead of from the
ConnectFX. This section describes features specific to using the Modular Keyer in Action.

When you load media into the Modular Keyer, the front and matte clips for the selected media are loaded
with the back clip and appear at the beginning of the processing pipeline. The front clip is used as the Front
clip and the matte clip is used as the Key In clip for the processing pipeline.

The back clip is used as the Back clip in the processing pipeline and is loaded as a reference only. Any
modifications you make to the Back clip in the Modular Keyer are not used when you return to Action.

NOTE If the Action back clip is a different resolution than the front clip, a Resize node is added to the Back pipeline
when entering the Modular Keyer.
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To view the results of your Modular Keyer work as it would appear in Action, select ActionRes from the View
box.

The following example shows media loaded into the Modular Keyer from Action.

All branches in the processing pipeline are connected to the Result node. When you return to Action from
the Modular Keyer, the following information is used:
■ The colour-corrected front clip (attached to the red tab of the Result node)

■ The matte clip (attached to the blue tab of the Result node)

■ The matte curves for the Result node (To access the matte curves, click the Result node.)

NOTE The back clip is for reference only. Any modifications you make to the back clip, such as colour correction,
are not applied in Action.

About Axes
An axis is the element of an object or media that can be manipulated to determine the object's 2D or 3D
space, position, and movement.

Use the scene's X,Y, and Z coordinate system to place each surface in the scene, or to rotate, scale, and shear
surfaces. You move, rotate, and animate objects directly in the scene and use the camera to record the scene.
The part of the scene that the camera, or frustum, looks at is what gets rendered.

Manipulating an Object's Axis

When you add certain objects to the scene, such as models or images, they are added with their own axes.
Each axis is used to place its respective object in the scene. An axis is represented by the following icon.
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All transformations that you apply to the selected axis are applied to the objects connected to the axis. For
example, if the position of a surface's axis is set to 500, 100, 0, then its surface is placed at 500 on the X-axis,
100 on the Y-axis, and 0 on the Z-axis.

(a) Surface is placed in the scene at 500, 100, 0

You can also add an axis manually to the scene from the node bin.

Action Views

Front, top, and side view are orthographic views used to position an object's axis in the scene. These views
are useful for viewing the scene from another angle than the camera's. See Setting the Camera and Ortho-
graphic Views (page 523).

Selecting an Axis

You can select an axis in any of the following ways:
■ Click directly on the axis in the scene.

TIP If you have numerous overlapping axes in the scene, press and hold Q while clicking to cycle through each
axis until the axis you need is selected.

■ Go to Schematic view and click the node for the axis.

■ Display the Channel Editor and select the Axis folder or one of its channels.

■ Use the Prev and Next buttons in the Axis menu to select the previous or next axis.

About Axes | 379



Moving and Rotating Axes in the Scene

You can move and rotate an axis directly in the scene. You can do this when viewing the scene in Camera,
Top, Side, or Front view. See Setting the Camera and Orthographic Views (page 523).

The selected mode remains in effect until you select a different mode. To select a mode, use the Edit Mode
box.

(a) Edit Mode box

Moving an Axis in the Scene

You can move an axis in the scene, as well as objects that do not have exclusive axes, such as lights.

To move an axis directly in the scene:

1 In the Edit Mode box, select Move.

2 Select the axis you want to move and drag it to a new position.

If the Axis menu is displayed while you move an axis, you can see the Position X, Y, and Z fields update
after the axis is placed in its new position. You can also change the X, Y, and Z position by dragging
any of the position fields in the Axis menu to move the axis.

TIP Enable Shift-Snap (Setup > Preferences), and then hold the Shift key when selecting an axis to snap the selected
axis to the surface of the underlying geometry. Not available when in Top, Front, or Side views.

Rotating an Axis in the Scene

You can rotate an axis in the scene, as well as objects that do not have exclusive axes such as lights.

To rotate an axis directly in the scene:

1 From the Edit Mode box, select Rotate.

2 Select the axis or the object you want to rotate.

A trackball appears in the scene. The trackball consists of three concentric rings. Each ring is used to
rotate the object and its axis around one of the three axes.
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3 Click and drag one of the trackball rings.

The axis and its object rotate in the image window. If the Axis menu is displayed while you rotate, you
can see the Rotation fields update after the axis is rotated to its new position. You can also rotate the
axis by dragging any of the Rotation fields in the Axis menu.

Changing the Plane

When you move an object in the scene, the object moves on a 2D plane. By default, an axis is moved
gesturally on all three planes. You can change the orientation of the plane by selecting an option in the
Plane box.

For example, if the camera is pointed toward the Y plane and you want to move an axis along the X and Z
planes, change the orientation to Plane XZ.

To move objects:Select:

On the X or Y plane, but not on the Z plane.Plane XY

On the X or Z plane, but not on the Y plane.Plane XZ

On the Y or Z plane, but not on the X plane.Plane YZ

On the X, Y, or Z plane. The plane is oriented to face the camera.Plane Off

NOTE The different planes can only be used in Camera view. You see the change in the orientation of the plane
only when you move the camera away from its default position.

Applying an Axis Look-at Connection

You can attach a look-at connection between the axis and another object in your scene. The axis then rotates
to face the look-at object, no matter where it is positioned. You attach a look-at connection in the schematic
between the Axis node and any object with axis characteristics (Axis, Camera, Light).

To apply a look-at connection:

1 Select Look At in the Edit Mode box.

2 In the schematic, drag from the Axis node to an object with axis characteristics.

The selected object is connected to the Axis node by an orange dotted line with an arrow.
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(a) Look-at connection

3 In the Axis menu, select which axis looks at the attached object in the Point Axis box.

Applying Tracking Data to an Axis

To remove jitter, or track the movement of a feature in the back clip, you can apply tracking data to an axis
using the Stabilizer. You can access the Stabilizer directly from the Axis menu in Action.
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(a)  Stabilizer button (b) Tracking Data controls

Stabilizing an Axis

You can import stabilizing data from the Stabilizer to lock the position of the selected axis to a reference
point on the front clip in Action. Any movement in the front clip is matched by the axis. See Stabilizing a
Clip from Action (page 603).

Tracking a Feature in the Back Clip

You can track the movement of a feature in the back clip and apply the tracking data to the selected axis in
Action. The axis follows the movement of the feature in the back clip. You can also track the rotation or
change in size of the feature. See One-Point and Two-Point Tracking (page 608).

TIP To help you view your tracking result without any objects blocking the view, enable the Context button in
the Stabilizer menu. While similar to a result view, the context view allows you to see all of the Action scene, except
for the selected node (and any children of the selected node).

Axis Menu Settings

X Position field Displays the position of the X axis. Editable.

Y Position field Displays the position of the Y axis. Editable.

Z Position field Displays the position of the Z axis. Editable.
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Motion Path button Enable to animate the position of the axis using a spline drawn in the scene. Disable
to animate the position of the axis using explicit animation.

X Rotation field Displays the rotation of the X axis. Editable.

Y Rotation field Displays the rotation of the Y axis. Editable.

Z Rotation field Displays the rotation of the Z axis. Editable.

X Scale field Displays the scale of the X axis. Editable.

Y Scale field Displays the scale of the Y axis. Editable.

Z Scale field Displays the scale of the Z axis. Editable.

Proportional button Enable to change the fields proportionally.

X Shear field Displays the shear of the X axis. Editable.

Y Shear field Displays the shear of the Y axis. Editable.

Z Shear field Displays the shear of the Z axis. Editable.

X Centre field Displays the centre of the X axis. Editable.

Y Centre field Displays the centre of the Y axis. Editable.

Z Centre field Displays the centre of the Z axis. Editable.

Stabilizer button Opens the Stabilizer menu to apply stabilizing data to an axis. See Applying Tracking Data
to an Axis (page 382).

Stabilizer box Select Track or Stabilize, then click the Stabilizer button.

Tracking Rotation box Select whether tracking rotation is On, Off, or Inverted.

Tracking Scale box Select whether tracking scaling is On, Off, or Inverted.

Autoscale option box Select whether to autoscale when Position settings are changed relative to the camera
(On Position Changes), or when Position, Rotation, Shear, or Centre settings are changed (On All Transforms).

To:Select:

Not use autoscaling on the image.Off

Preserve the projected size of the image by automatically scaling when

changing any Position parameters that affect the depth of the image relative

to the camera.

On Position Changes

Preserve the projected size of the image by automatically changing Position,

Scale, and Centre parameters (when any Position, Rotation, Shear, or Centre

parameters are changed).

On All Transforms

Parented Camera box Select which camera is used for the parenting offset when the immediate parent is
a stereo camera. Choose left, right, or center camera. Active only when there is exactly one parent that is a
stereo camera, or if a look-at connection is attached between the axis and the stereo camera.

Point Axis box Select which axis is pointed to the attached look-at object. Available only when objects are
attached with a Look At connection. See Applying an Axis Look-at Connection (page 381).

Motion Blur button Enable to use a motion blur effect for the selected axis (can only be used once the
global Motion Blur is enabled in the Setup menu).
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Free Axis button Enable to ignore transformations from parent axes.

Plane box Select an orientation for the plane (in Camera view). See Changing the Plane (page 381).

About Surfaces
You use surfaces to display media in the scene and then composite front and matte clips with a common
back clip.

You should have a working understanding of Action media and the relationship between media and surfaces
to be successful in using Action.

A surface is used to place a media in the scene. To use media that you load into Action, you must add a
surface to the scene for that media. A surface has the following characteristics:
■ A surface type can be flat, bilinear, bicubic, or extended bicubic.

■ The same media can be applied to multiple surfaces. Any cropping, blurring, or recolouring that you
apply to one media is applied to all the surfaces for that media. For example, if you blur a media, all of
the surfaces using that media are blurred.

The first time you open Action during a session, an image surface is added to the scene using the first media
(if Auto Image is enabled in the Action Setup menu). You must add a surface for each additional media
before its clips can be used in the scene. You can then add textures and lighting effects, or change the surface's
properties such as its shape, transparency, and specular highlight. Once added, the media appears in the
Media list.

By default, a Flat surface is added. You can change the surface type in the Shape box of the Surface menu.
See Changing the Shape of a Surface (page 392).

You control the position of the surface using axis, rotation, scale, shear, and other attributes related to its
placement. See Manipulating an Object's Axis (page 378).

Adding Surfaces

To add a surface:

1 In the Media list, select the media containing the front and matte that you want to add to the scene.

2 Do one of the following:
■ Drag an image node from the node bin and place it in the schematic. An axis and an image are

created and linked together.

■ Drag an image node from the node bin to the Result view, so you can see its effect on the scene
before placing it exactly where you want.

■ Double-click an image node. The node appears next to the last added object. You do not need to
be in Schematic view to add a node in this manner.

The surface is added to the scene with its own axis. The selected media in the Media list is automatically
applied to the surface.

Notice that when media is applied to the image surface, the front and matte clip are combined. You
can turn off the matte in the Matte Clip box in the Media menu to show the entire front clip.

3 If you later decide to change the media on the surface, select the surface in the schematic, then select
the new media in the Media list and click Apply.
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Modifying Surfaces

The Surface menu includes properties common to all surfaces, and specific controls for bilinear and bicubic
surfaces. You can change a surface's shape, position, and transparency, as well as apply lighting effects. You
can also apply four-point tracking data to a bilinear surface.

To access the Surface menu:

1 Double-click the selected surface in the schematic, or follow the tab population rules for the Object
menu. See Populating Menu Tabs of Selected Objects (page 344).

The Object Image menu appears with the Image controls for the selected surface displayed on the right
side of the menu. Some of the tabs for the Surface menu are contextual, and are available depending
on the circumstance.

Surface Settings

The Surface tab is available at all times, and is divided into a number of sections.

(a)  Blend Mode box (b) Shape box (c) Lighting box

Blend Type Section

Blend Type box Select whether to use Flame or Photoshop blend modes.

Blend Mode Section

Blend Mode box Select how the front and matte clips or the front and back clips are combined. See Surface
Blending Modes (page 394).

Transparency field Displays the transparency of the image. Enter 0 for a completely opaque image, or 100
for a completely transparent image.

Surface Section

Shape box Select a shape for the selected surface. For Stereo Objects, you are limited to using a Flat surface.
See Changing the Shape of a Surface (page 392).

Surface Resolution field Displays the geometry resolution of the selected surface. By default, the value is
equal to the default Action Resolution setting (in the Rendering section of the Setup menu).
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The lower the value, the better the resolution and the greater the processing time required to interact with
the image. For example, a value of 1 on an NTSC image creates a mesh with 720 horizontal and 486 vertical
subdivisions on the selected surface, affording accurate displacement, normals, and lighting.

Auto Expand button Enable to automatically resize the surface when an attached diffuse map's Axis settings
are changed. Only available for Flat surfaces, and when a diffuse map is parented from the surface. Always
available for stereo objects.

Flip Normals button Enable to flip the selected surface normals to light the back side of a surface.

Force 2-Sided button Enable to have lights in the scene light both sides of the surface (when shading is
turned on).

Surface Offset X field Defines the level of offset for a surface along the X axis. Editable.

Surface Offset Y field Defines the level of offset for a surface along the Y axis. Editable.

See Offsetting a Surface (page 394).

Shadow Casting Section

Shadow Casting box Select how the selected image object will be affected by a Shadow Cast object in the
scene. See  Surface and Geometry Shadow Casters  (page 435).

Material Section

Shine field Displays the level of shine for the specular highlights (there are no specular highlights when
Shine is set to 0). Editable.

Lighting box Select Ambient or Diffuse lighting so that the surface can reflect incidental light. See Applying
Incidental Light Reflection (page 428).

Specular Highlights colour pot Displays the colour of the surface highlights. Editable.

The specular highlight is visible only if Shading is enabled in the Setup menu and if shine is greater than 0.
See Adjusting Specular Highlights (page 428).

Diffuse colour pot Displays the diffuse colour. If Diffuse is selected in the Lighting box, the Ambient colour
takes on the same shade as the selected Diffuse colour. Editable.

Ambient colour pot Displays the ambient colour. Available when Ambient is selected in the Lighting box.
Editable.

Rendering Section

Filter box Select the type of filtering to apply to the surface.

To apply:Select:

No filtering — the pixel of the texture closest to the screen pixel is displayed.Nearest

Basic bilinear filtering.Linear

Non-proportional filtering between X and Y (faster to process than EWA, but with

a lesser quality).

Anisotropic

A combination of Anisotropic and Linear filtering.Aniso+Linear
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To apply:Select:

A high-quality elliptical weighted average filter to produce enhanced rendering

results (slower to process than other filters).

EWA

A combination of EWA and Linear filtering (offers the most advanced filter pro-

cessing).

EWA+Linear

Wireframe button Enable to convert the selected surface to a wireframe representation (lighting and
transparency properties are kept).

Motion Blur button Enable to use motion blur for the selected surface (can only be used if the global Motion
Blur is enabled in the Action Setup menu).

Vertices Settings for Bilinear Surfaces

For bilinear surfaces, there are extra controls available in the Vertices tab.

(a) Offsets fields (b) Shape Channel button (c) Stabilizer controls (d) Vertex Translation fields (e) Reset Selection box
(f) Edit Offsets button

Upper Left X Offset field Displays the position of the upper left offset point along the X axis. Enable Edit
Offsets, and use Media Front view to see the offset point. Editable.

Upper Left Y Offset field Displays the position of the upper left offset point along the Y axis. Enable Edit
Offsets, and use Media Front view to see the offset point. Editable.

Upper Right X Offset field Displays the position of the upper right offset point along the X axis. Enable
Edit Offsets, and use Media Front view to see the offset point. Editable.

Upper Right Y Offset field Displays the position of the upper right offset point along the Y axis. Enable
Edit Offsets, and use Media Front view to see the offset point. Editable.

Lower Left X Offset field Displays the position of the lower left offset point along the X axis. Enable Edit
Offsets, and use Media Front view to see the offset point. Editable.

Lower Left Y Offset field Displays the position of the lower left offset point along the Y axis. Enable Edit
Offsets, and use Media Front view to see the offset point. Editable.
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Lower Right X Offset field Displays the position of the lower right offset point along the X axis. Enable
Edit Offsets, and use Media Front view to see the offset point. Editable.

Lower Right Y Offset field Displays the position of the lower right offset point along the Y axis. Enable
Edit Offsets, and use Media Front view to see the offset point. Editable.

TIP In Media Front view, you can also move the offset points directly in the image window. The offset fields in
the Vertices menu are updated accordingly.

Stabilizer button Opens the Stabilizer menu to apply stabilizing data to a surface or surface offsets.

Stabilizer box Select Track or Offsets, then click the Stabilizer button.

Vertex Position X field Defines the position of the bilinear or bicubic vertices on the X axis. Editable.

Vertex Position Y field Defines the position of the bilinear or bicubic vertices on the Y axis. Editable.

Vertex Position Z field Defines the position of the bilinear or bicubic vertices on the Z axis. Editable.

Shape Channel button Enable to use the Shape channel in the Channel Editor. Disable to use individual
Vertex channels in the Channel Editor. See Reshaping Using the Channel Editor (page 395).

Sort button Enable to sort non-flat surfaces where overlapping transparent regions are causing artefacts.

Edit Offsets button Enable to move the bilinear anchor points away from the entire image (used with
four-point tracking). Use Media Front view to see the offset points. See Editing Tracker Offsets of a Bilinear
Surface (page 398).

Reset Selection box Select whether to reset surface handles to their default position (Reset Shape) or reset
selected points (Reset Select) on a bilinear or bicubic surface.

Vertices Settings for Bicubic and Extended Bicubic Surfaces

For bicubic and extended bicubic surfaces, there are extra controls available in the Vertices tab.

(a) Subdivide button (b) Shape Channel button (c) Magnet Transformation box (d) Reference Point fields (e) Reset
Selection box (f) 3D Handles button

Subdivide button Click to subdivide the extended bicubic surface into more sections (can be clicked multiple
times). See Subdividing an Extended Bicubic (page 400).

X Position field Positions the selected surface points along the X axis. Editable.
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Y Position field Positions the selected surface points along the Y axis. Editable.

Z Position field Positions the selected surface points along the Z axis. Editable.

X Rotation field Rotates the selected surface points along the X axis. Editable.

Y Rotation field Rotates the selected surface points along the Y axis. Editable.

Z Rotation field Rotates the selected surface points along the Z axis. Editable.

X Scale field Scales the selected surface points along the X axis. Editable.

Y Scale field Scales the selected surface points along the Y axis. Editable.

Z Scale field Scales the selected surface points along the Z axis. Editable.

Proportional Scale button Enable to scale the surface points proportionally.

Magnet button Enable to transform a range of extended bicubic surface points. Use in conjunction with
the Magnet Transformation box. See Transforming Multiple Points (page 402).

Magnet Transformation box Select a transformation type to use when Magnet is enabled.

Magnet Curve Editor Displays the weighted polarity from the centre to the edge of the magnet.

Magnet Curve Home button Resets the position of the magnet curve after panning.

Magnet Curve Undo button Undoes a change to the Magnet Curve Editor.

Magnet Curve Reset button Resets the Magnet Curve Editor.

Vertex Position X field Defines the position of the bilinear or bicubic vertices on the X axis. Editable.

Vertex Position Y field Defines the position of the bilinear or bicubic vertices on the Y axis. Editable.

Vertex Position Z field Defines the position of the bilinear or bicubic vertices on the Z axis. Editable.

Shape Channel button Enable to use the Shape channel in the Channel Editor. Disable to use individual
Vertex channels in the Channel Editor. See Reshaping Using the Channel Editor (page 395).

Sort button Enable to sort non-flat surfaces where overlapping transparent regions are causing artefacts.

Auto Adjust button Enable to scale adjacent tangents automatically. Auto Adjust creates a smooth curve
between points in the deformation. If you want to work on a specific area of the image without affecting
other tangents, disable Auto Adjust.

NOTE If you move a tangent explicitly, it is not affected by Auto Adjust. Click Reset Select or Reset Shape so that
the tangents will be affected by the Auto Adjust mode.

3D Handles button Enable to allow Z buffering of the vertices. By default, the vertices are always visible,
regardless of their position in Z space in relation to other media.

Reset Selection box Select whether to reset surface handles to their default position (Reset Shape) or reset
selected points (Reset Select) on a bilinear or bicubic surface.

Blending Settings

Use the settings in the Blending tab to adjust blending curve for each surface.
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(a) Front matte curve (b) Back matte curve (c) Matte box (d) Blend Curves option box (e) Keyframe option box (f) Reset
Selection box

Blend Curves option box Select whether to work with the surface blend curves or view the existing keyer
blend curves.

Matte box Select the matte curve you want to adjust.

Keyframe Option box Select an option to Set, Delete, or Reset keyframes. If Auto Key is enabled, a keyframe
is added automatically when you adjust the blending curve.

Home button Click to reset the curve view.

Reset Selection box Select whether to reset the selected curve (Reset) or all curves (Reset All) to their default
settings.

For more information on using the blending curves, see Applying Blending Curves per Surface (page 397).

Lens Distort Settings

Differences in camera lenses or perspective irregularities cause lens distortion that results in skewed angles.
Use the settings in the Lens Distort tab to rectify or simulate these types of distortions in your images.

Distortion box Specify whether you want perform a lens distortion or rectification.

Distort Corrections box Select whether to apply radial corrections manually in this menu, or use the
automatic settings derived from the selected analyzer.
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Distort Analyzer box Select which analyzer is used to provide automatic radial corrections.

Auto Expand button Enable to automatically resize the surface when an attached diffuse map's Axis settings
are changed. This same button appears in the Surface tab.

Centre X field Displays the horizontal position of the centre of the lens. Editable.

Centre Y field Displays the vertical position of the centre of the lens. Editable.

Magnitude field Displays the magnitude of radial distortion or rectification. Editable.

Adjustment field Displays the level of secondary adjustment of radial distortion or rectification. Editable.

Anamorph field Displays the ratio of radial distortion or rectification along the X or Y axis. Editable.

Sources Settings

If a source node is parented above a surface node in the schematic, the Source tab is available. These settings
allow you to change source settings on a per surface basis, independent of the source type set in the Source
menu for the parent source node or nodes. See Replacing the Front or Matte Clip (page 546).

Changing the Shape of a Surface

When you first activate media or access Action, the media's surface is set to Flat by default. In Action, you
can also represent a clip using custom bilinear or bicubic surfaces.

To change the shape of a surface:

1 Double-click the surface in the Schematic view.

2 Select the shape of the surface from the Shape box.

Flat You cannot change its shape because a flat image
does not have vertices. You can, however, scale and shear
a flat image using its axis. See Manipulating an Object's
Axis (page 378).

This is the simplest surface. It is added to the scene by default the
first time you enter Action with a Front, Back, and Matte.
When working with a Stereo Object, Flat is the only shape available.

Bilinear A bilinear surface has four vertices: one for each
corner. The vertices are joined using linear interpolation
(straight lines).

You can animate the shape of a bilinear surface by changing the
position of the corners.
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Bicubic A bicubic surface has four vertices: one for each
corner. The vertices are joined using bicubic interpolation
(curved lines). Each corner has two additional tangent
handles used to adjust the curve of the line between
points. You can animate the shape of a bicubic surface
by changing the position of the corners and moving the
tangent handles to adjust the curve between corners.

Extended Bicubic An extended bicubic surface has four
vertices like a bicubic surface, but the sections of the ex-
tended bicubic surface can be subdivided up to eight
times to increase the number of vertices. The vertices are
joined using bicubic interpolation (curved lines). You
can animate the shape of a bicubic surface by changing
the position of the corners and moving the tangent
handles to adjust the curve between corners. See Warping
an Extended Bicubic Surface (page 399).

3 Click the vertex you want to edit and drag it to its new position.

You use the vertices—or handles—on bilinear and bicubic surfaces to change a surface's shape. You
can move, rotate, shear, and scale a surface using the Axis (page 383) menu.

(a) Vertices on a bilinear surface
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(a) Vertices and tangent handles on a bicubic surface

To move a handle on a bilinear or bicubic surface, click the handle that you want to edit. The selected
handle appears in red. Use the cursor to drag the handle to its new position.

Each corner has two tangent handles. Lengthen or move the tangents to change the shape of the
bicubic between corners.

All of the animation modifications you make to a shape are saved. If you decide to change a shape,
then change it back to the original shape, your modifications are not lost.

Surface Blending Modes

Use the Blend Mode box to select how the front and matte clips or the front and back clips are combined.
For example, use Screen for blending a fire or a lightning bolt shot on black that you want to composite
with a different background.

You can select between a number of Flame or Photoshop blend modes by making a selection in the Blend
Type box. Some of the blend modes are similar (or identical) between the different types, but are repeated
with the mode names you are used to working with.

Offsetting a Surface

By default, a surface's axis is at the centre of the surface. Use the Surface Offset X and Y fields to offset a
surface along the X-axis or Y-axis. All rotations, scaling, and shearing applied to a surface are applied about
its axis. The location of the axis is indicated by the axis icon in the scene.

To offset a surface:

1 Select the surface you want to offset.
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2 In the Surface menu, change the Surface Offset X and Surface Offset Y fields accordingly.

(a) Surface Offset fields

The following figure illustrates the difference between rotating a surface that has not been offset and
a surface offset using the Surface Offset X field.

Rotated image with an offset along the X-axis. Notice
that the axis is offset from the image centre.

Rotated image with no offset. Notice that the axis is
in the centre of the image.

Reshaping Using the Channel Editor

You can select whether you want to create an animation for bilinear, bicubic or extended bicubic surfaces
using the Shape channel or individual Vertex channels in the Channel Editor. The Shape channel shows
when the shape of the surface changes during the animation. Each time you move a surface handle, a shape
key is added at the current frame, provided Auto Key is enabled in the Setup menu.

Vertex channels correspond to the vertices—or handles—that appear on the four corners of bilinear, bicubic,
and extended bicubic surfaces. The channel names for each corner are: upper_left, upper_right, lower_left,
and lower_right, and are listed in the channel hierarchy each with a position x,y,z.

Each corner vertex has two tangent handles—the tangent handles for upper_left are named horz_tan_right
and vert_tan_down.
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(a) upper_left (b) horz_tan_right (c) horz_tan_left (d) upper right (e) vert_tan_ down (f) vert_tan_ up (g) lower_right
(h) lower_left

Extended bicubics have additional vertex channels that appear in the Channel Editor for subdivided vertex
channels. These channels appear only when you create a keyframe for the channel and its value changes.
These vertex channels are named vertex_0.1, vertex_1.0, vertex_2.1, and so on, according to their position
on the surface. Click the vertex on the surface to highlight its channel in the channel hierarchy. See Warping
an Extended Bicubic Surface (page 399).
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Blending Curves

You can adjust the blending curves of each surface separately. The blending curve is similar to the Keyer
luminance blending curve, but you can adjust it per surface.

When you create a matte for the front clip, a matte for the back clip is automatically created to specify which
part of the back clip is used for the composite. By default, the back matte is the inverse of the front matte.

You can adjust the luminance of the front matte and back matte separately in the Action blending curve.
For example, increase the luminance of the back matte so that more of the back clip shows through at the
edges of the key. This creates a better blend at the edges.

The following calculation is applied to each pixel of the image to create the composite. The calculation is
applied in three passes, one each for the R, G, and B values of the front and back images, and the pixel is
given the resulting R, G, and B values.

Result = F * FrontLUT + B * BackLUT

where:
■ F = the R, G, and B values of the front image

■ B = the R, G, and B values of the back image

■ FrontLUT is the front matte pixel value, re-mapped according to any luminance curve change made in
the blending curve. The value is expressed as a decimal, where, for example:
■ in 8-bit mode, 0 = 0, 127.5 = 0.5, and 255 = 1

■ in 12-bit mode, 0 = 0, 2047.5 = 0.5, and 4095 = 1

■ 16-bit floating point images, the values are represented on a logarithmic scale between 0 and 1.

■ BackLUT is the back matte pixel value, re-mapped according to any luminance curve change made in
the blending curve. The value is expressed as a decimal, as is the FrontLUT.

Applying Blending Curves per Surface

To adjust the blending curve:

1 In the Surface menu, click the Blending tab.

The Blending Curve menu appears.

(a) Front matte curve (b) Back matte curve (c) Matte box (d) Blend Curves option box (e) Keyframe option box
(f) Reset Selection box
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2 Select Result view from the View box. This allows you to view a particular image as you adjust the
curve.

3 To adjust the luminance curve for the front matte, select Front from the Matte box. To adjust the back
matte curve, select Back. Alternatively, click a curve to select it.

(a) 255 (White) (b) Output (remapping of luminance values) (c) 0 (Black) (d) 0 (Black) (e) Input (current luminance
values) (f) 255 (White)

In Move edit mode, click a point to display its tangent handle and drag the handle to adjust the curve.
Use other modes in the Edit Mode box (Add, Delete, or Break, for example) to further adjust the curve,
adding or deleting points, or breaking tangent handles as needed.

4 Use the options in the Keyframe option box to Set, Delete, or Reset keyframes. If Auto Key is enabled,
a keyframe is added automatically when you adjust the blending curve.

5 Use the Blend Curves option box to switch between the surface blend curves and the keyer blend
curves. This gives you a good comparison to luminance curve work you have already done in the Keyer.
When Use Keyer Blend Curves is selected, all of the other Action blend curve settings are unavailable.

Editing Tracker Offsets of a Bilinear Surface

Enable the Edit Offsets button to change the way the image is applied to a bilinear surface. For example,
when you enable this button, an offset point appears for each of the surface's four corners (if Media Front
is selected in the View box), then you use the Offsets controls to edit the offsets to match the corners of
your square. View the result by disabling Edit Offsets.
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You can then apply stabilizing data to a surface or surface offsets. See Four-Point Tracking (page 610).

Warping an Extended Bicubic Surface

Use an extended bicubic surface to warp specific areas of a surface. An extended bicubic surface can be
subdivided into many sections, which are controlled by vertices. The vertices allow you to bend and contort
the surface. The vertices are joined using bicubic interpolation—curved lines.

You can animate the shape of a bicubic surface by changing the position of the vertices and moving the
vertex tangent handles. See Reshaping Using the Channel Editor (page 395).

By default, the extended bicubic surface has four vertices and eight tangents. You can translate, scale, or
rotate these points and tangents individually or as a group. Subdividing the bicubic surface increases the
number of vertices in the image and allows for more precision.
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(a) vertex 1 (b) tangents of vertex 1 (c) tangents of vertex 2 (d) vertex 2 (e) Reference point

Image courtesy of Topix

Extended bicubics have three types of points: vertices, tangents, and the reference point. Vertices and tangents
are collectively called surface points.

Vertices lie on the surface and its tangents determine the curvature of the deformation at each vertex. The
reference point indicates the axis of origin for applying rotation and scaling to surface points.

Use the surface points to control the deformation of the surface. Each vertex has tangent handles. By moving
the tangents and their handles, you can warp specific areas of the surface. You can translate, scale, or rotate
these points and tangents individually or as a group.

TIP If a tangent point is hidden behind a vertex or reference point, press Q and click the point in the image window
to select the tangent.

Tangent handles have three modes.

Indicates:This mode:

The handles are not broken. If you move this handle, the adjacent handle will move in the
opposite direction and by the same magnitude (length).

The handles are broken. If you move this handle, no other handles are affected.

The handles are geometrically continuous. If you move this tangent, the adjacent handles
will move in the opposite directions but maintain its magnitude (length).

Subdividing an Extended Bicubic

Subdivide the bicubic surface up to eight times to increase the number of vertices and tangents. Then translate
the vertices for a smaller region of the image for more precision. You should warp the surface with a small
number of subdivisions to obtain the best results. After applying some deformations to a large portion of
the surface, subdivide the surface further and perform deformations on a more localized region of the surface.

To subdivide extended bicubics:

1 From the Extended Bicubic Vertices menu, click Subdivide.

You can click the subdivide button up to eight times to further subdivide the surface.
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2 Transform the tangents to achieve the effect you want.

To move the reference point:

1 Select the reference point.

The reference point turns red when selected.

2 Drag the reference point to a new location, or use the X, Y and Z fields to assign a new coordinate for
the reference point.

To rotate multiple surface points:

1 Set the reference point values you want to use as the axis of origin using the X, Y, Z Reference Point
fields.

2 Select multiple surface points by pressing Ctrl and dragging to select the surface points.

3 From the Edit Mode box, select Rotate.

A 3D trackball appears on the reference point.

4 Use the 3D trackball to rotate the reference point and selected points.

All selected points rotate around the reference point.

To scale multiple surface points:

1 Set the reference point values you want to use as the axis of origin using the X, Y, Z Reference Point
fields.

2 Select multiple surface points by pressing Ctrl and dragging to select the surface points.

3 From the Edit Mode box, select Scale.

4 Drag in a direction in the image window to scale accordingly.

About Transforming Multiple Points

Use the magnet to transform a range of extended bicubic points. Use the magnet when there are many
surface points as a result of more than one subdivision. In the Extended Bicubic menu, the magnet controls
include the Magnet button, the Magnet Transformation box, and the Magnet Curve Editor.

(a) Magnet button (b) Magnet Transformation box (c) Magnet Curve Editor
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There are two ways to transform points with the magnet. You can use the magnet to select a range of points
and transform them gesturally. Or, you can use the invisible magnet in conjunction with the Translation,
Rotation, and Scale fields to transform selected points numerically.

Before you can use the magnet, you must set the polarity of the magnet and the magnet area of focus. The
magnet's area of focus is determined by where you click the surface and the polarity of the magnet is set by
the Magnet Curve Editor. The radius is determined by the distance from the centre to the farthest selected
point.

Transforming Multiple Points

Setting the Magnet Polarity

Use the Magnet Curve Editor to define the weighted polarity from the centre to the edge of the magnet.
Points are either attracted or repelled depending on their location in the magnet and the shape of the magnet
curve.

The area of the magnet is plotted on the X-axis where 0 is the centre of the magnet and 100 is the edge of
the magnet. The polarity is plotted on the Y-axis where 1 is maximum positive strength and -1 is maximum
negative strength.

A positive polarity value attracts nearby points. A negative polarity value repels nearby points. The following
example illustrates a magnet that has a strong positive polarity near the centre and strong negative polarity
near the edges.

Magnetic Curve Editor

The following example illustrates a magnet that has a strong negative polarity near the centre and a strong
positive polarity near the edges.

Magnetic Curve Editor
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The following example illustrates a magnet whose positive polarity decreases from the centre and whose
negative polarity increases toward the edges.

When you transform points, the direction and size of the transformation is determined by the weighted
polarity of the magnet at the location of the points.

Using the first example, if you use the magnet to translate the points on the X-axis by +200, the points in
the centre of the magnet move in the positive direction on the X-axis—they are attracted to the magnet—while
the points near the edge of the magnet move in the negative direction on the X axis—they are repelled by
the magnet.

To change the polarity of the magnet:

1 In the Extended Bicubic Vertices menu, click Reset to return the magnet curve to its default.

2 Click the left-most handle on the curve and drag to define the polarity for the centre of the magnet.

To:Drag the point:

Increase the positive polarity.Up

Increase the negative polarity.Down

Assign no polarity.To the middle

3 Click the right-most handle on the curve and drag to define the polarity for the edge of the magnet.

To:Drag the point:

Increase the positive polarity.Up

Increase the negative polarity.Down

Assign no polarity.To the middle

About Surfaces | 403



4 Click the middle handle on the curve and drag to define the transition of polarity from the centre to
the edge of the magnet.

Transforming Points

Use Magnet mode to transform points gesturally. The magnet’s area of focus is determined by where you
click the surface and the radius of the magnet is set by the Magnet Curve Editor. The radius is determined
by the distance from the centre to the farthest selected point.

To transform points:

1 Use the Magnet Curve Editor to determine the polarity for the magnet.

2 From the Edit Mode box, select Magnet.

The magnet appears as a red circular outline.

3 To resize the magnet, press Ctrl+S and drag left or right.

4 From the Magnet Transformation box, select the type of transformation.

To:Select:

Translate the selected points along the X-, Y-, or Z-axis.Translate

Rotate the selected points about the centre of the magnet.Rotate

Scale the selected points about the centre of the magnet.Scale

5 Click the points you want to transform in the image window.

6 Drag in the image window to apply the transformation to the selected points.

Transforming Unselectable Points

Use the invisible magnet to transform points you cannot select with the magnet. The centre of the magnet
is determined by the centre of the selection and the radius is determined by the distance from the centre to
the farthest selected point. Any transformations to the selected points are affected by the magnet.

To transform unselectable points:

1 Use the Magnet Curve Editor to determine the polarity for the magnet.

2 From the Edit Mode box, select Move or Select.

3 Hold Ctrl and drag to select a range of points.

4 In the Extended Bicubic Vertices menu, enable Magnet.

The magnet is not visible, but is illustrated here to show how the points will be affected when you
transform them.
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(a) Selected Points (b) Magnet (not visible)

5 From the Magnet Transformation box, select the transformation type.

To:Select:

Translate the selected points along the X-, Y-, or Z- axis.Translate

Rotate the selected points about the centre of the magnet.Rotate

Scale the selected points about the centre of the magnet.Scale

6 Change the values in the Translation, Rotation, or Scale fields.

Adding Drop Shadows

In Action, drop shadows are cutouts based on a surface's matte. A drop shadow can be fully opaque or slightly
transparent to simulate a real shadow.

Shadows cast by lit objects are also supported in Action (see Casting Shadows (page 433)).

To add a drop shadow:

1 Select the surface that you want to use.

2 Do one of the following:
■ Drag the shadow node from the node bin and place it in the schematic. An axis and a shadow are

created and linked together.

■ Drag the shadow node from the node bin to the Result view, so you can see its effect on the scene
before placing it exactly where you want.

■ Double-click the shadow node. An axis and a shadow are created and linked together. You do not
need to be in Schematic view to add a node in this manner.

If a surface node is selected in the schematic, the axis of the shadow node is automatically connected
to the surface.
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NOTE A shadow has its own parent axis. It can be moved, rotated, scaled, and sheared independently of
its parent surface. Because a shadow is also the child of the surface, moving the surface axis also moves the
shadow.

Adjusting Shadow Softness

You can adjust the softness of a shadow using the Shadow field in the Media menu. Use a value of 0.00 to
have a distinct shadow. Increase the value to soften the shadow.

Shadow softness is a property of the media. If you add more than one shadow for the same media, all shadows
are softened by the same amount.

Adjusting Shadow Colour and Transparency

Adjust shadow colour and transparency in the Shadow menu of the Object menu.

To adjust the colour and transparency of a shadow:

1 Double-click a shadow node to display the Shadow menu.

2 Make sure that the Shadow button is set to Shadow On.

NOTE You can turn the shadow on or off from the Shadow button. This button is independent of the Hide
option.

3 To change the colour of the shadow, do one of the following:
■ Enter colour values in the three colour fields in the Shadow menu.

■ Click the colour pot below the fields. Use the colour picker to pick the shadow colour.

4 To adjust the transparency of the drop shadow, use the Transparency field. When this field is set to
100, the shadow is completely transparent. When set to 0, the shadow is completely opaque.

TIP You can lock the shadow's transparency to the transparency of its parent surface using the Transparency
Lock button. Once a shadow transparency is locked to its parent surface, changes to the surface transparency
also affect the shadow's transparency. You can then adjust transparency of the shadow as an offset of the
surface's transparency.
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Using Shadow Mix

Use Shadow Mix to render shadows and surfaces according to their order in the Priority Editor, independently
of their position in Z-space. This option makes it possible to have the shadow of one media on top of the
shadow of another media. Shadow Mix is an option in the Z-Buffer box in the Rendering section of the Setup
menu.

Shadow Menu Settings

Red Shadow field Displays the red shadow value. Editable.

Green Shadow field Displays the green shadow value. Editable.

Blue Shadow field Displays the blue shadow value. Editable.

Shadow colour Pot Displays the colour of the shadow. Editable.

Shadow Transparency Lock button Locks a shadow's transparency to the transparency of its parent surface.

Shadow Transparency field Displays the transparency level of the drop shadow. Editable.

Shadow button Toggles the shadow on or off.

Reordering Surfaces

When you add a surface (flat image, bilinear, or bicubic) or geometry (3D text or model), the surface or
geometry appears in front of all other objects in the scene. These overlapping objects create a stack and an
order of priority as one object is drawn in front of the other.

You can change the drawing order of surfaces, 3D models, and other objects using the Priority Editor.
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Accessing the Priority Editor

Each entry in the Priority Editor indicates the object's name, the order of the object in the stack, and the
location of the object in its branch. There is also a proxy showing what the object looks like in Schematic
view.

To access the Priority Editor, click the Priority button, or swipe the bar at the bottom of the Media or Object
menu.

NOTE If a source node is selected in the schematic, the Priority Editor that is displayed is that of the source node
(the source node name is prepended to the branch name).

(a) Drawing order of objects in the scene (b) Priority Editor controls

Use the Priority Editor controls to analyse the scene for changes in rendering priority, to change the rendering
priority, and to cut, copy, and paste priority information from one frame to another.

Changing the Drawing Order

The objects in the scene are shown according to z-depth, while still being drawn in the order of their priority:
highest priority at the top of the list to the lowest priority at the bottom. The lowest level object is drawn
first, the second to lowest level object is drawn next, and so on, until the top of the list.

To change the drawing order of objects:

1 In the Priority Editor, select the object.

The selected object name is highlighted in yellow.

2 Click the Push To Back button to move the selected object one position lower in the stack, or click the
Bring To Front button to move the selected object one position higher in the stack.

When you move an object in the stack, a keyframe is added to the timebar.

3 Click Preview to ensure that the drawing order is correct.

Occasionally, a matte may obscure another object if the drawing order is unordered. If this happens,
move the surface up and down in the stack until the drawing order is corrected, or click Z-Sort.

TIP You can also select and drag a media (or multiple media using Ctrl) while holding the spacebar.
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Grouping Media

Select objects in the Priority Editor and group them to edit or affect several media at once. You can analyse
or Z-Sort groups as you would single media.

Groups are named according to their contents. For example, if a group is created from Image 3 and Image
32, the Group's label will be “Image 2 Image 32”.

It is not possible to add a scene object to an existing group. To do this, you must ungroup the objects, reselect
those you want to include in the group, and click Group.

NOTE Single element groups cannot be created.

To create groups in the Priority Editor:

1 Select multiple scene objects in the Priority Editor using either Alt-click for individual objects or
Shift-click to select a range.

2 Click Group in the Priority Editor menu.

Media is minimized to a single line in the Priority Editor. To expand the group and view its contents,
click the arrow to the left of the group.

3 Scene objects can be ungrouped by clicking Group once again.

Analyze, Z-Sort, and the Z-Buffer

When you use Analyze or Z-Sort, the objects in the scene are compared using their position in the scene
and not the individual pixels of a shape or model. The Priority Editor uses distance between the camera and
the nearest and farthest points on the objects in the scene to determine the sorting order.

Since the Priority Editor is geometry based and not polygon based, you cannot properly order objects or
groups that intersect due to their rotation, scale, or shear values. The Z-buffer uses the Z-value of each pixel
for the sorting order. Use the Priority Editor in conjunction with the Z-Buffer box in the Setup menu Rendering
section.

(a) Z-buffer box
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When Z-buffer is on, objects and groups are arranged according to their distance from the camera eye. Since
the camera is pointed towards the Z-axis by default, objects and groups are arranged according to their
location on the Z-axis. In the following example, Image A is at Z position 200, Image B is at Z position 100,
and Image C is at -50. When Z-buffer is on, Action draws these images as shown.

If you move the camera, objects are sorted according to the axis the camera is pointed towards.

When Z-buffer is off, the distance of objects from the camera eye is not considered. Objects are drawn in
the order shown in the Priority Editor. To follow the previous example, you can turn off Z-buffer and change
the priority of Image B so that it is drawn on top of both Image A and Image C. The Z position of these
images is therefore ignored.

Shadow Mix, like Z-buffer, arranges objects according to their distance from the camera eye. Use Shadow
Mix so that each shadow is rendered in the correct Z order with its corresponding surface.

Creating Keyframes Using the Priority Editor

When you edit media priorities in the Priority Editor, keyframes are not created by default. To create keyframes
from the Priority Editor, the Auto Key button must be enabled. By default, the Auto Key button is set to off
so as not to create keyframes when reordering media.

To create keyframes for a media priority change:

1 Display the Priority Editor by clicking the Priority button, or swipe the bar at the bottom of the Media
or Object menu.

2 Click Auto Key to enable auto-keyframing.
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3 Reorder priorities at different points in the timebar. Keyframes are automatically created as priorities
are edited.

NOTE Stop all priority auto-keying anytime by disabling the Auto Key button.

Priority Editor Settings

Action Layers Selection box Based on the object selection in the Action scene, select an option to determine
which Priority Editor to display.

Analyze button Click to analyze the entire scene for changes in rendering priority.

Z-Sort button Click to analyze the current frame for changes in rendering priority.

See Analyze, Z-Sort, and the Z-Buffer (page 409).

Bring To Front button Click to move the selected object one position higher in the stack, in front of the
next higher object.

Push To Back button Click to move the selected object one position lower in the stack, behind the next
lower object.

Undo button Undoes the last Priority Editor operation, except for Z-Sort or Analyze.

Use Action's Undo List to view a list of recent operations and revert to a prior state. Select an item in the list
to return to that state. All actions that occurred after the selected item are undone.

Auto Key button Enable to create keyframes when reordering media. See Creating Keyframes Using the
Priority Editor (page 410).

Group button Click to create groups of selected media (use this to analyze, Z-Sort, or manage several lines
of media at once). See Grouping Media (page 409).

Cut button Click to cut priority information between frames.

Copy button Click to copy priority information between frames.

Paste button Click to paste priority information between frames.

NOTE A mark indicates when a change in priority occurs. If you copy and paste a mark that does not change the
priority, no mark appears on the timebar.
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Reset box Select whether to reset priority information for the current frame or for all frames.

About Stereoscopic Workflow in Action
A stereoscopic workflow in Action allows you to create stereo composites using 3D and stereo elements.
With the stereo camera rig (the 3D camera), you can access stereo rigs and monoscopic cameras. With support
for multiple outputs, you can experiment with any number of passes, including left and right scene output,
as well as Z-Depth, matte, media matte, and composition outputs.

When working in a stereoscopic compositing workflow in Action, there are three essential elements: a stereo
camera, a stereo object for viewing and adjusting the result, and outputs. The following table outlines the
stereoscopic workflow in Action.

Refer to:Step:

Starting a Stereoscopic Session (page 412).1. Bring stereo clips into Action.

About the FBX Camera (page 528) and Working with the Stereo
Scene (page 412).

2. Work with the stereo camera and stereo object to make
any adjustments to the scene.

About Rendering Outputs from Action (page 364).3. Output various passes of your work.

Starting a Stereoscopic Session

You can start a stereoscopic session in Action by loading stereo clips and using the Stereo Startup mode.
This creates a stereo camera. The output is set to the stereo camera, a stereo object is created for visualizing
the scene, and the clips are placed on separate lines in the Media list.

NOTE A stereo clip cannot be loaded in Action if it is selected as the Back or MultiVersion input, or if it is selected
to replace a clip in the Media list.

When using a stereo clip, its left and right eye tracks are automatically split and placed on individual lines
in the Media list. Also, new clips appear in the workspace. They retain the name of the original clips, and
are appended with a “_Left” or “_Right” suffix. It is important to save these clips, as they are used for loading
an Action setup or loading the previous Action session.

NOTE It is not possible to select a mono clip as the Matte input if the Front input is stereo, and vice versa.

Working with the Stereo Scene

When working in a stereoscopic workflow, the stereo object lets you visualize the scene. The stereo object
lets you composite stereo sources in Action, ensuring the stereo effect of the stereo source is preserved during
the compositing process. You can combine stereo objects with 3D geometry, such as 3D text or FBX models
within the same scene.

The stereo object is a single image surface which contains two diffuse maps (left and right) for handling
stereo sources. When working in a stereoscopic workflow in Action, you must handle the left and right eye
as separate media in the Media list. When a stereo object is filmed by a stereo camera, a link is created
between the left image of the object and the left camera of the stereo rig. This is the same for the right image
and right camera. The link ensures that left-eye material is only visible through the left camera, and likewise,
right-eye material is handled with the right camera.
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NOTE Entering Action with a stereo clip will automatically create a stereo object with the stereo clip used as the
left and right material.

To add a stereo object to a scene:

1 In the Media list, select the media for the left eye. Press Ctrl and select media for the right eye.

NOTE By default, the first clip you select is the media for the left eye. You can select multiple pairs of left-right
media. Odd numbered selections are considered as left media and even numbered selections are the right
media when creating stereo objects.

2 Create a stereo object for the media by doing one of the following:
■ Drag the Stereo Object node from the node bin and place it in the schematic.

■ Drag the Stereo Object node from the node bin and place it where you want it in the Result view.

■ Double-click the Stereo Object node. You do not need to be in Schematic view to add a node in
this manner.

The stereo object is added to the scene.

3 To display a selected viewport in any of the stereo modes (Anaglyph Mono, Anaglyph Dubois, Blend
or one of the Difference modes), select one from the Stereo mode button in the lower-left corner of
the viewport.

NOTE The viewport must be set to Result.

4 To open the Stereo Object menu, double-click the StereoObject node in the schematic.

Stereo Object Settings

Stereo Object Axis Settings

Use the Axis tab of the Stereo Object menu to position, rotate, scale, and shear an axis, as well as adjust the
convergence, parenting, and autoscaling of stereo objects.

The Position, Rotation, Scale, and Centre settings are the same as in the Axis menu. The following Axis
settings are specific to the Stereo Object:
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Autoscale box Select whether to autoscale when settings are changed relative to the camera.

To:Select:

Not use autoscaling on the image.Auto Off

Link the Position Z parameter with Convergence. This allows you to see how a

change in the Convergence value makes the object appear to move closer or

Auto Z

farther from the camera. This preserves the same visual aspect while scaling the

textures up or down accordingly.

NOTE The result camera must be set to the stereo camera.

Change the left and right texture parameters when the Position Z or a Scale

parameter is changed. When you create a stereo object, it is automatically oriented

AutoScale

towards the camera and automatically scales. That is, the apparent size of the im-

ages scale to compensate when you move the stereo object along the Z axis. If

you move a stereo object away from the camera, it grows, and vice versa.

NOTE The result camera must be set to the stereo camera.

Convergence field Displays the equal amount of convergence in opposite directions horizontally, between
left and right images. Positive values make the image appear farther from the camera. Editable.

Parent To button Enable to associate a stereo object with the camera selected in the Parent Camera box.
Enabled by default to force the stereo object to face the 3D camera at all times when the camera is moved
around.

Parent Camera box Select which camera in the scene is associated with the stereo object. Setting found in
the Axis and Correction tabs.

Stereo Object Correction Settings

Use the Correction tab of the Stereo Object menu to indicate how the footage was shot, and make interaxial
offset and FOV offset adjustments to the left/right images.

Keystone Correction box Select whether to apply keystone corrections manually in this menu, use the
automatic settings derived from the selected analyzer, or inherit the Stereo Mode settings from the stereo
camera (Pass Through).
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In most cases, a keystone correction is needed if the stereo types of the camera and the stereo object do not
match, but there may be cases when you want to sync the two.

Correction Analyzer box Select which analyzer is used to provide automatic keystone corrections.

Interaxial Offset Left Eye field Displays the offset distance between the left eye compared to the 3D camera.
Editable.

Interaxial Offset Right Eye field Displays the offset distance between the right eye compared to the 3D
camera. Editable.

Interaxial Offset Current Camera field Displays the interaxial offset of the selected camera. Non-editable.

FOV Offset Left field Displays the offset field of view between the left eye compared to the 3D camera.
Editable.

FOV Offset Right field Displays the offset field of view between the right eye compared to the 3D camera.
Editable.

FOV Offset Current Camera field Displays the offset field of view of the selected camera. Non-editable.

Stereo Clip Type box Specify how the footage was shot: Parallel, Off Axis, or Converged.

Parent Camera box Select which camera in the scene is associated with the stereo object. Setting found in
the Axis and Correction tabs.

Camera Number field Displays the number of the selected camera. Non-editable.

Edit Mode box Select whether to sync the left and right eye correction values.

When synced, a change to one value affects the other value. The left eye position is a combination of the
camera’s left eye position and the left interaxial offset; the same applies for the right eye. The effective FOV
for the correction is the sum of the camera’s FOV and the FOV offset.

Sync Type box Select whether the relationship between the left and right eye correction values is absolute
or relative. Available when Sync L+R is selected in the Edit mode box.

Stereo Object Surface Settings

Use the Surface tab of the Stereo Object menu to adjust surface and shading properties of the stereo object.

The Surface tab settings are the same as in the Object Image menu for non-stereo objects. See Surface Settings
(page 386).

Stereo Object Texture Settings

Use the Texture tab of the Stereo Object menu to set the built-in diffuse maps (as well as any added texture
maps) of a stereo object.
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X Position field Displays the position of the X axis. Editable.

Y Position field Displays the position of the Y axis. Editable.

Z Position field Displays the position of the Z axis. Editable.

X Rotation field Displays the rotation of the X axis. Editable.

Y Rotation field Displays the rotation of the Y axis. Editable.

Z Rotation field Displays the rotation of the Z axis. Editable.

X Scale field Displays the scale of the X axis. Editable.

Y Scale field Displays the scale of the Y axis. Editable.

Z Scale field Displays the scale of the Z axis. Editable.

Proportional button Enable to change the fields proportionally.

X Shear field Displays the shear of the X axis. Editable.

Y Shear field Displays the shear of the Y axis. Editable.

Z Shear field Displays the shear of the Z axis. Editable.

X Centre field Displays the centre of the X axis. Editable.

Y Centre field Displays the centre of the Y axis. Editable.

Z Centre field Displays the centre of the Z axis. Editable.

Edit Mode box Select whether to sync the left and right eye texture values.

Sync Type box Select whether the relationship between the left and right eye texture values is absolute or
relative. Available when Sync L+R is selected in the Edit mode box.

Texture Eye box Select whether to apply changes to the left or right eye and display the values of the left
or right texture.

Stereo Object Blending Settings

Use the Blending tab of the Stereo Object menu to adjust the blending curves of each stereo surface separately.
The blending curve is similar to the Keyer luminance blending curve, but you can adjust it per eye.
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You can switch between the stereo surface blend curves and the keyer blend curves. This gives you a good
comparison to luminance curve work you have already done in the Keyer.

The Blending tab settings are the same as in the Object Image menu for non-stereo objects. See Applying
Blending Curves per Surface (page 397). One extra setting is available for stereo objects, allowing you to select
which eye to apply blending curves.

Eye Selection box Select which eye to apply the blending curves. Select Both Eyes to apply the same blending
settings to both eyes. In this case, the settings of the last selected eye apply to both eyes.

Stereo Object Lens Distort Settings

Differences in camera lenses or perspective irregularities cause lens distortion that results in skewed angles.
Use the settings in the Lens Distort tab to rectify or simulate these types of distortions in your stereo images.

The Lens Distort tab settings are the same as in the Object Image menu for non-stereo objects. See Lens
Distort Settings (page 391).

About the Perspective Grid
Use the Perspective Grid node to help you with perspective alignments in your Action scene. The perspective
grid creates a rectangle on a plane within the perspective of the clip. The accuracy of the plane determines
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whether any adjustments are properly scaled and oriented in your clip. Objects can be placed anywhere on
this plane. Aligning objects to the perspective grid has multiple benefits:
■ You can perform a 4-corner pin with a surface or geometry that respects the perspective.

■ Aligning the grid establishes the orientation of the plane in 3D space and the Field of View (FOV) of the
camera that shot the scene.

■ Because the Perspective Grid node has an axis-like behaviour, objects attached to it inherit the grid's 3D
transformations.

Working with FOV

You can animate the perspective grid by positioning corner points in other frames. To create an animated
transform, place the grid in the first frame, then Lock Camera in other key frames. You would also enable
the Lock Camera if the camera FOV does not change over the clip.

NOTE If you enable Allow Adjustments, Action will solve for the FOV in each frame on which you edit the corners.

To use the existing value in the camera and not solve for it, regardless if you animate the perspective grid,
you should lock Camera before positioning in the first frame.

NOTE When the FOV of the camera is computed (not locked) the camera is repositioned in order to frame the
media.

Aligning an Object with a Perspective Grid

To align an object with a perspective grid:

1 Click Media.

2 In the Media menu, select the media you want to use for the perspective grid (you can change the
media later in the Perspective Grid menu).

This media becomes the reference for the perspective grid alignment.
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3 Do one of the following:
■ Drag the Perspective Grid node from the node bin and place it in the schematic.

■ Drag the Perspective Grid node from the node bin and place it where you want it in Result view.

■ Double-click the Perspective Grid node. You do not need to be in Schematic view to add a node in
this manner.

The Perspective Grid object is added to the schematic. In the Schematic view, the number in brackets
next to the name of the node indicates the media used for the perspective grid reference.

To specify different perspective grid reference media, select the media in the Media menu, then click
Apply, or enter a different media number in the Use Media field of the Perspective Grid menu.

4 With the Perspective Grid object selected in the schematic, select Object view from the View box to
see the grid and the selected media.

5 While in Object view, drag each of the four corners of the rectangle to the desired location. The grid
automatically aligns to the new perspective.
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NOTE When dragging one of the corner points of the rectangle, if your desired location cannot be computed
(for example, if a point goes past another point on the plane), the location is remembered with a dotted
line and red circle. Once you move other corners, your original location may now become viable, and the
rectangle and grid align properly.

■ If Allow Adjustments is selected in the Lock Camera box , the target camera FOV and position
adjusts to fit the perspective set by the perspective grid. If Lock Camera is selected in the Lock
Camera box, the perspective grid does not adjust the target camera.

6 Once you are satisfied with the alignment of the perspective grid rectangle, parent an object to the
Perspective Grid node. The object inherits the perspective transformation of the Perspective Grid node.
Switch to Result view (F4) to see the complete scene.

NOTE You can also manipulate the perspective grid in the Result view, provided that Lock Camera is not
enabled in the Perspective Grid menu, or the perspective grid camera is the same as the Result camera.
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Perspective Grid Menu Settings

Lock Camera box  Select Allow Adjustments to allow adjustments of the Target camera FOV and position.
Select Lock Camera to lock camera FOV and position.

Perspective Camera box Specify which camera to view the perspective grid in Object view, and for modifying
its FOV when working with the perspective grid.

Perspective Camera field Displays the active perspective camera number. Non-editable.

Stereo Camera Perspective box Select whether to use the left or right camera from a stereo camera rig when
working with the perspective grid.

FOV field Displays the field of view of the active perspective camera. When adjusting the perspective grid,
the FOV of the target camera updates automatically (unless Lock Camera is enabled). Non-editable.

Width field Displays the width of the four-point perspective grid rectangle. Non-editable.

Height field Displays the height of the four-point perspective grid rectangle. Non-editable.

Lock Size button Enable to lock the width and height of the perspective grid rectangle. For example, use
to lock the dimensions of the grid when animating it, if the feature size you aimed for in the image doesn't
change in time.

Use Media field Displays the number of the media associated with the perspective grid. You can change
the media number in this field, or select a media entry in the Media List and click Apply.

Z Offset field Displays the amount of offset to apply along the Z axis to make the grid larger or smaller while
maintaining the visual result.

Display Grid button Enable to display the grid lines in Result or Object view.

Grid Colour pot Displays the colour of the grid lines. Click to change the colour.

Magnifier button Enable to display the magnifier while dragging a corner of the perspective grid rectangle
in Object view.

Zoom field Displays the zoom factor of the magnifier. Editable up to 5x.

Reset button Resets the perspective grid settings, but does not reset the active perspective camera settings.

About Lights and Lighting Effects
Objects are lit up in the scene according to the number, position, direction, and colour of light sources, as
well as the rotation and spread of each light source.
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You can add up to 64 active light sources to a scene. You can also control each light individually. By default,
the light you add to the scene is applied to all surfaces. However, you can also apply a light source to specific
surfaces.

Once lights are added to your scene, you can use them to add other effects to enhance the scene, such as
cast shadows, lens flares, rays, and blooming effects.

Adding a Light Source

When you add a light to a scene, it is applied to all objects. Before adding another light, you may want to
position the light and modify its attributes. In the Lights menu, you can set lighting properties such as
position, orientation, spread, falloff, and colour.

To add a light to the scene:

1 Do one of the following:
■ Drag the light node from the node bin and place it in the schematic.

■ Drag the light node from the node bin to Result view, so you can see its effect on the scene before
placing it exactly where you want.

■ Double-click the light node. The node appears next to the last added object. You do not need to
be in Schematic view to add a node in this manner.

A light is added to the scene. An icon representing the light source is added to the schematic.

Unlike many objects, a light is added without an axis. To set the position and rotation of a light source,
use the Position and Rotation fields in the Light menu.

2 To display the Light menu, double-click the selected light in the schematic, or follow the tab population
rules for the Object menu. See Populating Menu Tabs of Selected Objects (page 344).

3 Enable the Active button in the Light menu to activate the light source.

The light icon appears in the scene.
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(a) Light sources in the scene.

Importing Lights

In Action, you can import 3D data saved in the FBX format. FBX files may have lights and their data included,
and you can use these same lights in Action. Supported light types from FBX files are Area, Directional,
Ambient, Point, or Spot. See  Importing the FBX Format  (page 459).

Selecting a Light Source

You can select a light source in the following ways:
■ Click the light source in the scene.

■ In Schematic view, click the icon corresponding to the light source. All light sources initially appear at
the same X, Y, and Z position in the scene (0, 0, 0). If you add two light sources, for example, you need
to move one light source in order to see the other.

■ Select a Light folder in the Channel Editor.

■ Use the Prev and Next buttons to select the previous or next light source.

Using the Light Bevel Curve

The bevel curve allows you to create unique lighting effects in conjuntion with the Spread field in the Light
Basics tab. Since a spread value of 90 or less creates a spotlight, you can then create a bevel curve to act as
a multiplier of the spotlight intensity.

For example, a curve such as this.
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Results in a lighting ripple-like effect.

TIP To create black holes in your lighting effect, use values below zero on the Bevel curve.

Applying Selective Lighting

When you add a light source to a scene, the light is applied to all surfaces. You may want a light source to
only illuminate an individual or specific group of surfaces, or prevent a light source from illuminating an
individual or specific group of surfaces.

To apply selective lighting:

1 Add multiple surfaces to the scene.

2 Add a light to the scene.

All surfaces are illuminated.
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3 Select Lighting from the Edit Mode box.

4 To illuminate only a selected surface, click the light node, and drag it to an axis or image you want
illuminated.

The selected object is connected to the light source by a blue dotted line with an arrow, and only the
selected surfaces are illuminated.

(a) Light inclusion link
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5 To exclude a surface, hold the Alt key while clicking and dragging from the light source to the surface
you do not want illuminated.

Excluded surfaces are connected to the light source by a red dotted line with an “X”, and they are not
illuminated. In the following example, all surfaces are illuminated, except for image3, which is excluded.

(a) Light exclusion link

NOTE To remove the inclusion or exclusion link, while still in Lighting mode, click and drag over the line that
connects the light source to the axis or image.

Modifying Surface Lighting

After you set the parent-to-child relationships between lights and surfaces, you can set specific surface lighting
properties. You control a surface's lighting and adjust the surface's specular highlight in the Surface menu.
To access the Surface menu, double-click the selected surface in the schematic, or follow the tab population
rules for the Object menu (see Populating Menu Tabs of Selected Objects (page 344)).
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(a) Shine field (b) Lighting box (c) Specular Highlight colour box (d) Flip Normals button (e) Wireframe button

Surface Controls Settings

The Surface controls that relate to lights are described as follows.

Motion Blur button Enable to exclude the selected object from the global motion blur effect. See Blurring
a Single Object (page 526).

Wireframe button You can remove some lighting effects for a selected surface by converting surfaces to a
wireframe depiction of the surface. See Converting to Wireframe (page 429).

Flip Normals button Flips the normals of the surface so that light is applied to the opposite side of the
surface. See Flipping a Surface's Normals (page 430).

Shine field Displays the intensity of the specular highlight. See  Adjusting Specular Highlights  (page 428).

Lighting box Applies diffuse or ambient lighting to a surface. See Applying Incidental Light Reflection (page
428).

Specular Highlight colour box Click the colour pot and use the colour picker to change the specular colour.

The specular highlight is visible only if Shading is enabled and Shine is greater than 0. See  Adjusting Spec-
ular Highlights  (page 428).

About Specular Highlights

A specular highlight is a reflection of a light source. The position of the specular highlight depends on the
position and number of light sources surrounding a surface and the angle of the camera.
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Use the Shine field to change the intensity of the specular highlight. When the Shine value is set to 0, the
specular highlight is disabled. To change the size of the specular highlight, use the Falloff field in the Light
menu.

This surface is lit using a Falloff of 20 and a Spread of 27.
The surface's Shine is set to 1.

This surface is lit using a Falloff of 30 and a Spread of 27.
The surface's Shine is set to 10.

By default, the specular highlight is the same colour as the light source. You can change the colour of the
specular highlight by changing the specular colour values.

The specular colour is the colour of light that is reflected by the surface. For example, if the specular colour
is red and the light source is white, the specular highlight is red. If the specular colour is yellow and the
light source is red, the highlight is orange.

Adjusting Specular Highlights

To adjust specular highlights:

1 Add and position a light source in the scene.

2 In the Light menu or the Rendering section of the Action Setup menu, enable Shading.

3 In the Surface menu, use the Specular Highlight colour pot to set the specular colour.

4 Set a value in the Shine field. A small Shine value produces an intense highlight while a large Shine
value produces a dim highlight.

Applying Incidental Light Reflection

Set how a surface reflects incidental light by applying ambient or diffuse lighting. The actual colour of the
reflection depends on both the colour value of each pixel and the colour of the incidental light. The intensity
of the reflection depends on the orientation of the light source relative to the surface; it is greatest where
the incident light strikes the object perpendicular to its surface. The intensity of the reflection is independent
of the camera eye position.

When you turn shading on, you do not have to enable a light source to see the lighting effect, as a default
infinite light source supplies ambient light at 20% intensity. The infinite light source is located behind the
camera eye and cannot be moved. As soon as you add a light source, the infinite light source is replaced by
the new light source.

To apply incidental light reflection:

1 In the Light menu or the Rendering section of the Action Setup menu, enable Shading.

2 In the scene, select the surface to receive incidental light reflection.

428 | Chapter 15   Compositing in 3D Space with Action



3 In the Surface menu, make a selection from the Lighting box.

To reflect incidental light:Select:

To all parts of a surface that are not directly illuminated.Ambient

Equally in all directions, producing a flat reflection on the object.Diffuse

4 Optional: Adjust the colour of the incidental light using the ambient or diffuse RGB channels.

To display the RGB channels, click Animation to display the Channel Editor. Expand the surface's
folder (it should already be selected), expand its Material folder, then expand the Ambient or Diffuse
folder.

Converting to Wireframe

You can remove some lighting effects for a selected surface by converting surfaces to a wireframe depiction
of the surface. When Wireframe is enabled, specular values and any applied textures are replaced with a
wireframe view of the surface. When used on an image, the surface will adopt a screen-like look.

To convert to wireframe:

1 In the scene, select the surface to convert to wireframe.

2 In the Surface menu, enable Wireframe.
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The selected surface becomes a wireframe surface.

Flipping a Surface's Normals

When you flip a surface's normals, light is applied to the opposite side of a surface. Use this feature to create
a two-sided shaded surface.

To create a two-sided surface:

1 Add a surface and a light source.

2 In the Light menu or the Rendering section of the Action Setup menu, enable Shading.

3 Copy the surface and its axis in Schematic view. See Mimicking, Copying, and Duplicating Objects
(page 350).

4 Select the surface of the copied branch.

5 In the Surface menu, enable Flip Normals.
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To control both surfaces, parent them by a new axis and use this axis to rotate, scale, shear, and move the
two surfaces. There may be a priority problem causing one surface to be drawn over the other. To correct
this problem, use the Priority Editor to animate the drawing priority of surfaces or change the Z position of
one surface by one pixel. See Reordering Surfaces (page 407).

Light Menu Settings

The Light menu settings are described as follows.

Light Type box Select the type of light to apply to the scene.

Example:Description:Light Type:

A point light radiates light uniformly in all directions.

A spotlight radiates a cone of light centred along the

spotlight direction. Use the Spread field to change the

spread angle. A spread of 90 or less creates a spotlight.

Point / Spot

A directional light shines evenly in one direction only.

The light icon in the scene displays an arrow showing

the direction of the light. Use a directional light to

simulate a very distant point light source (for example,

the sun as viewed from the surface of the Earth).

Directional

An ambient light shines in two ways—some of the

light shines evenly in all directions from the location

of the light (similar to a point light), and some of the

light shines evenly in all directions from all directions

(as if emitted from the inner surface of an infinitely

large sphere). Use the Shade field to set the percent-

age on ambient light applied.

Ambient
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Example:Description:Light Type:

A rectangle area light is similar to a point or spot light

light except that it produces a hotspot based on the

shape of the rectangle. Use the area size fields to set

the size of the rectangle.

Rectangle Area

An ellipse area light is similar to a point or spot light

light except that it produces a hotspot based on the

shape of the ellipse. Use the area size fields to set the

size of the ellipse

Ellipse Area

Active button Enable to turn the selected light source on.

Shading button Enable to light up the scene using added light sources. When Shading is disabled, no lighting
effects appear in the scene; surfaces and 3D models appear flat.

Enable Shading for:
■ Light sources

■ Ambient or diffuse lighting for surfaces

■ Specular highlights for surfaces and 3D models

This same button appears in the Rendering section of the Action Setup menu.

Motion Blur button Enable to use a motion blur effect for the selected light (can only be used if the global
Motion Blur is enabled in the Setup menu).

Red Light field Displays the red value of the selected light. Editable.

Green Light field Displays the green value of the selected light. Editable.

Blue Light field Displays the blue value of the selected light. Editable.

Light colour pot Displays the colour of the light source. Editable.

X Position field Displays the position of the selected light along the X axis. Editable.

Y Position field Displays the position of the selected light along the Y axis. Editable.

Z Position field Displays the position of the selected light along the Z axis. Editable.

Path button Enable to animate the position of the light using a spline drawn in the scene. Disable to animate
the position of a light using explicit animation.

X Rotation field Displays the rotation of the selected light along the X axis. Editable.

Y Rotation field Displays the rotation the selected light along the Y axis. Editable.

Z Rotation field Displays the rotation the selected light along the Z axis. Editable.

Width field Displays the width of an area or directional light. Editable.

Height field Displays the height of an area or directional light. Editable.

Light Intensity field Displays the intensity of the selected light. Editable.
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Light Spread field Displays the spread angle. A value of 90 or less creates a spotlight. Editable

Light Falloff field Displays the amount of falloff around the edge of the light source (also changes the size
of the specular highlight). Editable.

Decay Type box Select the type of decay to apply to the light source.

Decay field Displays the rate at which light decreases for the chosen decay type. Editable.

Shade field Displays the percentage of ambient light applied. Editable.

Light Profile Settings

Settings for controlling the light bevel curve are located in the Light Profile tab.

Light Bevel curve Adds a specific profile to the selected light. Use the options in the Edit Mode box to add,
select, delete, or move keyframes on the bevel curve. The bevel curve behaves in much the same way as an
animation curve in the Channel Editor. See Using the Light Bevel Curve (page 423).

Home button Resets the Bevel curve viewer to show the whole curve.

Undo button Undoes the last set of Bevel curve operations.

Reset button Resets the Bevel curve.

Relighting: Casting Shadows

You can create realistic 2D and 3D shadows in your Action scene by using lights to cast and receive shadows,
as well as self-shadow (an object can cast a shadow on itself).

About Lights and Lighting Effects | 433



After adding and setting up shadow casts in Action, you can output the shadow by itself, or as part of your
overall composition. A shadow pass is a white image with greyscale regions that represent the shadow
coverage. See Output Options (page 365) for information on the specific shadow output settings.

Action also supports drop shadows (see Adding Drop Shadows (page 405)).

Adding a Shadow Cast to a Light

Lights in the scene are able to cast shadows. You can parent a Shadow Cast object to multiple lights at once.
This allows you to control the overall attributes of the shadow (for example, colour, softness, and
transparency).

To add a shadow cast to the scene:

1 Add and position a light to your scene.

2 Do one of the following:
■ Drag the shadow cast node from the node bin and place it in the schematic.

■ Double-click the shadow cast node.

If there is only one light in the scene, the shadow cast node is automatically connected to it. If there
are several lights in the scene, select the light in the schematic that you want parented to the shadow
cast before added the shadow cast node. Otherwise, you can parent the shadow cast node to the light
or lights manually in the schematic.

3 To display the Shadow Cast menu, double-click the shadow cast object in the schematic, or follow the
tab population rules for the Object menu. See Populating Menu Tabs of Selected Objects (page 344).
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Surface and Geometry Shadow Casters

By default, all objects in the scene cast and receive shadows from a light attached to a Shadow Cast object.
You can control this on a per object basis in the Object Surface or Geometry menu.

The Shadow Casting box in the Surface or Geometry menu allows you to select how the each image or
geometry object is affected by a Shadow Cast object in the scene.

For the Surface or Geometry to:Select:

Cast and receive a shadow (this is the default).Cast & Receive

Receive, but not cast a shadow.Receiver

Cast, but not receive a shadow.Caster

Not be displayed, but the shadow is displayed.Shadow Only

Not cast or receive a shadow.Off

Shadow Cast Menu Settings

The Shadow Cast menu settings are described as follows. Shadow types are dependant on your graphics card,
so you may not see all of these settings.

Shadow Output Type box Select the type of shadow to output. This setting is repeated in the Output Options
section of the Output menu.

Source Shadow Type box Select the type of shadow cast for the source node. This setting is available in the
Shadow Cast menu only if the shadow cast node is a child of a source node, and is repeated in the Source
menu.

Shadow Type box Select a mapping type for the shadow.

Description:Shadow Type:

Use 3D Hard Shadows for higher precision shadows when lights are close to the objects

in the scene. These are best for hard edge shadows with penumbra effects, but can be

slower.

3D Hard Shadows
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Description:Shadow Type:

Use 3D Soft Shadows if you want faster soft shadows with lights further away from your

objects. These shadows offer explicit control over softness.

3D Soft Shadows

2.5D Shadows work best on transparent or semi-transparent objects, for example a shadow

projected on a wall by smoke.

2.5D Shadows

NOTE Some of the settings in the Shadow Cast menu differ based on the shadow type you choose.

Resolution box Select a resolution to determine the quality of the selected mapping type.

Anti-Aliasing Sample box Select an anti-aliasing sampling level for the shadow cast.

NOTE Depending on your graphics card and the size of your Action scene, shadows may not appear or render
properly with higher anti-aliasing sampling levels.

Anti-Aliasing Softness field Displays the softness value of the anti-aliasing sample for the shadow cast.

NOTE Jitter on 3D shadows is inherent to the shadow map technique. However, in most situations it can be go
completely unnoticed. Some lighting situations which cause stretched shadows, such as lights close to the horizon,
are very likely to create visible jittering. To alleviate jittering problems, you can try to use higher resolution,
anti-aliasing, and anti-aliasing softness levels. In these cases, interactive manipulations in the image window may
become taxing; therefore, you should activate Adaptive Degradation (page 359) for Shadows.

Red Colour field Displays the amount of red in the shadow (based on the colour of the attached light).
Editable.

Green Colour field Displays the amount of green in the shadow (based on the colour of the attached light).
Editable.

Blue Colour field Displays the amount of blue in the shadow (based on the colour of the attached light).
Editable.

Shadow Colour pot Displays the colour of the shadow (based on the colour of the attached light). Editable.

Proportional button Enable to change the Red, Green, and Blue colour fields proportionally.

Transparency field Displays the transparency level of the shadow. Editable.

Decay Type box Select the type of decay to apply to the shadow.

Decay field Displays the rate at which the shadow decreases for the chosen decay type. Editable.

Softness field Displays the softness of a shadow. Editable.

Density field Displays the amount of dark values to include in the softness of a 3D soft shadow. Editable.

Dark Threshold field Displays the amount of light values to include in the softness of a 3D soft shadow.
Editable.

Focus field Displays the softness of the 2.5D shadow based on the distance from the light. Objects closer
to the focus distance are less blurred. Editable.

Colour Bleed field Displays the amount of colour bleed in the 2.5D shadow from semi-transparent objects
in the scene. Editable.

Flattening Mode box Select a flattening mode for the 2.5D shadow. Most of the time, Best Fit gives the best
quality, but if you see clipping artefacts in the shadow, try one of the other modes.
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Penumbra field Displays the softness of a 3D hard shadow. Editable.

Sampling Mode box Select a softness sampling mode for the 3D hard shadow.

Filter Samples field Displays the amount of filter samples to take into account when creating softness (X
xY) for a 3D hard shadow. Available when Regular sampling is chosen in the Sampling Mode box. Editable.

Caster Samples field Displays the amount of shadow caster samples to take into account when creating
softness (X xY) for a 3D hard shadow. Editable.

Auto Near/Far button Enable to automatically set the near and far parameters for the 3D shadow based on
the objects in the scene.

Near field Displays the near distance of the start of the 3D shadow. Editable.

Far field Displays the far distance of the end of the 3D shadow. Editable.

Matte Threshold field Displays the value at which the alpha casts a 3D shadow. Editable.

Overlap field Displays the amount of overlap from the light source. Increase to remove imperfections in
the 3D shadow. Editable.

Relighting: Lens Flares

Use lights in your scene to generate procedural lens flares with built-in 3D occlusions.
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With lens flares in Action, you can control:
■ How lights change as they move behind 2D or 3D layers.

■ How flares behave when a light exits or enters the camera field of view.

Lens Flares in Action are comprised of a Lens Flare object, attached to one or more Border FX objects, and
any number of texture components, such as irises, streaks, and glows. To help you get accustomed to working
with lens flares, a preset with typical settings is loaded when you first add a lens flare object to your scene.

You can attach multiple lens flares to a light, and multiple lights can attach to a lens flare.
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Using Lens Flare Presets

A number of lens flare presets are included in Action, simulating the light refraction of certain camera lenses,
as well as some creative flare effects, such as car lights. These presets can help you add complex lighting
effects with just a few clicks.

To add a lens flare preset:

1 Do one of the following:
■ Drag the Presets node from the node bin and place it in the schematic.

■ Drag the Presets node from the node bin and place it where you want it in Result view.

■ Double-click the Presets node. You do not need to be in Schematic view to add a node in this
manner.

The file browser opens.

2 From the Preset Type box, select Lens Flare.

The Lens Flare Preset file browser appears, pointing to the default location of the presets:
usr/discreet/<product home>/lensflare/presets.

3 Optional: Enable Scale to Action Resolution to load the preset in the current Action resolution.

4 Optional: Select which rendering settings to enable or disable in the preset (Z-Buffer, Shading, Polygon
Resolution, and Colour Clamping).

NOTE These settings are enabled by default, and by disabling any of them, you may not see the intended
results in the preset.

5 Select the lens flare preset you want to load. Hold Ctrl and click to select multiple presets.

TIP Switch to Proxies view to see a visual representation of the presets.

6 Click Load.

The lens flare preset is then appended to your Action scene. You may need to move the light in the
image to see the full lens flare effect.

Presets Browser Settings

Preset Type box Select the category of presets to display in the browser.

Scale to Action Resolution button Enable to load the preset in the current Action resolution.

Z-Buffer button Enable to load the Z-buffer rendering settings of the preset.

Shading button Enable to load the shading rendering settings of the preset.

Polygon Resolution button Enable to load the rendering resolution settings of the preset.
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Colour Clamping button Enable to load the resolution colour clamping settings of the preset.

Adding a Lens Flare to a Light

In Action, a lens flare is a child of a light. Multiple lights can be parented to the same Lens Flare object.

To add a lens flare to the scene.

1 Add and position a light to your scene.

2 Do one of the following:
■ Drag the lens flare node from the node bin and place it in the schematic.

■ Double-click the lens flare node.

A default lens flare (including a Lens Flare object, Border FX object, and multiple component texture
objects) is added to the schematic. In Result view, you can see the lens flare (you may need to move
the light in the scene to see the full lens flare effect).

If there is only one light in the scene, the lens flare node is automatically connected to it. If there are
several lights in the scene, select the light in the schematic that you want parented to the lens flare
before added the lens flare node. Otherwise, you can parent the lens flare node to the light or lights
manually in the schematic.

3 To add a texture component to a lens flare, select the Border FX object in the schematic, then
double-click a texture node in the Relighting tab of the node bin.

4 To display the Lens Flare menu, double-click the lens flare object in the schematic, or follow the tab
population rules for the Object menu. See Populating Menu Tabs of Selected Objects (page 344).

You can also add a Lens Flare using the Presets node. See Using Lens Flare Presets (page 439). In this case, a
light is automatically added as part of the preset.

Using Texture Components With Lens Flares

You must add texture components to the Border FX object of a lens flare to see a result. These components
are textures that are attached to a Lens Flare Border FX object (or optionally, directly to a Rays or Blooming
object). The Lens Flare Object menu has global settings for the complete lens flare, but each component
texture has its own menu to control settings particular to it.

Each type of component can be added multiple times, each with its own settings. The following are the
types of texture components you can add:

Example:Description:Component:

Star-like texture.Glint Texture
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Example:Description:Component:

Glowing loops of different colours.Glow Texture

Multiple shapes, such as polygons, discs,
orbs, or caustics.

Iris Texture

Lens "defects" such as hair, scratches, or fin-
gerprints.

Lens Texture

Rings with multi-coloured loops.Ring Texture

Lines streaking across the image.Streak Texture

In the Action schematic, the components are attached to a Border FX object that is itself attached to the
Lens Flare object. You can use multiple Border FX objects to achieve the lens flare look you want. For example,
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attach a ring and glow to one Border FX object, while a streak and iris are attached to another Border FX
object. In this case, you can control how the lens flare behaves when it reaches the borders of your image
differently for the components under each Border FX object.

TIP You can also attach multiple Border FX objects to the same texture component, to compare different Border
FX settings, for example. In this case, you can use the Action Hide button to hide each selected Border FX node
to see the different results.

Re-Texturing Components

Since the components are textures, you can also re-texture a component using a Diffuse Map with your own
texture media applied. To do so, select the component in the schematic, then select the media you want to
use from the media list, and double-click the Diffuse Map node in the node bin. In this case, the Pattern
settings in the component menu are not applicable, though you can still use the settings in the Basics and
Border FX tabs of the component menu, as well as the Diffuse menu settings.

Lens Flare Menu Settings

The Lens Flare Object menu lets you control settings for the complete lens flare effect. The Border FX object
and each attached component texture also have their own specific menus.

Basics Tab
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Position X field Displays the screen space position along the X axis of the Lens Flare pivot point. Editable.

Position Y field Displays the screen space position along the Y axis of the Lens Flare pivot point. Editable.

Position Z field Displays the screen space position along the Z axis of the Lens Flare pivot point. Editable.

Red Colour field Displays the amount of red in attached flare components (based on the colour of the
attached light). Editable.

Green Colour field Displays the amount of green in attached flare components (based on the colour of the
attached light). Editable.

Blue Colour field Displays the amount of blue in attached flare components (based on the colour of the
attached light). Editable.

Flare Colour pot Displays the colour of the attached flare components (based on the colour of the attached
light). Editable.

Global Intensity field Displays the intensity of the attached flare components (multiplied by the intensity
of the attached light). Editable.

Global Scale field Displays the scale of the attached flare components. Editable.

Global Position field Displays the position of attached flare components in relation to the light (0%) and
pivot point (100%). Editable.

Hue Shift field Displays the RGB offset applied to the edges of attached flare components. Editable.

Spread field Displays the amount of refractive distortion applied to the edges of attached flare components.
Editable.

Occlusion Tab

Occlusion curve Displays the occlusion profile of the lens flare. Use to set the behaviour of the lens flare
components when behind other objects in the scene.

Occluder Size field Displays the size of fade in/out of occluded lens flare components. Editable.

Z Threshold field Displays the transparency value at which objects start occluding the flare. Editable.

Home button Resets the bevel curve viewer to show the whole curve.

Undo button Undoes bevel curve operations.

Reset button Resets the bevel curve.

Border FX Menu Settings

Use the Border FX settings to control how the lens flare behaves when it reaches the borders of your image.
A visual representation of the inner and outer borders, as well as the pivot area is displayed in the menu.
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Border Gain field Displays the amount of gain to apply to the attached lens flare components when the
light reaches the defined border. Editable.

Inner Interpolation box Select an interpolation type to define the transition between the border gain and
the inner border.

Outer Extrapolation box Select an extrapolation type to define the transition between the border gain and
the outer border.

Pivot Gain field Displays the amount of gain to apply to the attached lens flare components when the light
reaches the defined pivot area. Editable.

Pivot Interpolation box Select an interpolation type to define the transition between the pivot gain and
the pivot point.

Border Mode box Select whether Border FX settings are applied vertically, horizontally, or in both directions.

Inner Border Margin field Displays the position of the inner border. Editable.

Outer Border Margin field Displays the position of the outer border. Editable.

Border Scale field Displays the scale of the border that controls where the lens flare effect occurs. Editable.

Pivot Radius In field Displays the inner radius of the pivot point. Editable.

Pivot Radius Out field Displays the outer radius of the pivot point. Editable.

Component Menu Settings

Each flare component has its own menu to control settings particular to the component. Some of these
settings are common among the different component types, while some are specific to the component type.
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Basics 1 Tab

Intensity Value field Displays the brightness of the component. Editable.

Intensity Variance field Displays how much the intensity varies. Available when the Number field value
is greater than 1. Editable.

Intensity Seed field Displays the random intensity seed value. Available when the Number field value is
greater than 1. Editable.

Scale Value field Displays the size of the component. Editable.

Scale Variance field Displays how much the scale varies. Available when the Number field value is greater
than 1. Editable.

Scale Seed field Displays the random scale seed value. Available when the Number field value is greater
than 1. Editable.

Spread Value field Displays the position of components in relation to each other. Available when the
Number field value is greater than 1. Editable.

Spread Variance field Displays how much the spread varies. Available when the Number field value is
greater than 1. Editable.

Spread Seed field Displays the random spread seed value. Available when the Number field value is greater
than 1. Editable.

Spread option box Select a behaviour for the spread settings: Centre (equal), Positive (light to pivot direction),
or Negative (pivot to light direction).

Rotation Value field Displays the level of rotation of the component. Editable.

Rotation Variance field Displays how much the rotation varies. Available when the Number field value is
greater than 1. Editable.

Rotation Seed field Displays the random rotation seed value. Available when the Number field value is
greater than 1. Editable.

Ratio Value field Displays the aspect ratio of the component. Editable.

Ratio Variance field Displays how much the ratio varies. Available when the Number field value is greater
than 1. Editable.

Ratio Seed field Displays the random ratio seed value. Available when the Number field value is greater
than 1. Editable.
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Iris Shape box Select the shape of iris component. For other component types, this box is grayed out and
displays the type of component.

Number field Displays the amount of components. Editable.

Position field Displays the offset applied to the component in relation to the light (0%) and pivot point
(100%). Editable.

Lock To Light button Enable to lock the orientation of the component to the light.

Order box Select whether ratio is applied before rotation or vice-versa.

The Lens Texture component Basics 1 tab only has the following two settings (not shown):

Overall Brightness field Displays the brightness level of the Lens Texture component. Editable.

Inner Brightness field Displays how much of the lens is revealed. Editable.

The Glint component Basics tab also has the following two settings (not shown):

Overall Speed field Displays the rate at which the Glint animation plays.

Time Offset field Displays the start point of the Glint animation. With a value of 0, the animation starts
at frame 1. With a value of 100, the animation begins as if it has been generating for 99 frames. You cannot
animate this field.

Basics 2 Tab

Centre X Position field Displays the position of scaling and rotation of the component along the X axis.
Editable.

Centre X Variance field Displays how much the centre position varies along the X axis. Available when
the Number field value is greater than 1. Editable.

Centre X Seed field Displays the random centre X seed value. Available when the Number field value is
greater than 1. Editable.

Centre Y Position field Displays the position of scaling and rotation of the component along the Y axis.
Editable.

Centre Y Variance field Displays how much the centre position varies along the Y axis. Available when the
Number field value is greater than 1. Editable.

Centre Y Seed field Displays the random centre Y seed value. Available when the Number field value is
greater than 1. Editable.
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Border FX Tab

The component Border FX settings allow you to choose which how the component interacts with the parent
lens flare border settings.

Border Intensity button Enable to take into account intensity values of the parent relighting object.

Intensity Gain field Displays the amount of gain applied to the intensity. Editable.

Intensity Variance field Displays how much the intensity varies. Editable.

Border Scale button Enable to take into account scale values of the parent relighting object.

Scale Gain field Displays the amount of gain applied to the scale. Editable.

Scale Variance field Displays how much the scale varies. Editable.

Border Rotation button Enable to take into account rotation values of the parent relighting object.

Rotation Gain field Displays the amount of gain applied to the rotation. Editable.

Rotation Variance field Displays how much the rotation varies. Editable.

Border Centre button Enable to take into account centre values of the parent relighting object.

Centre Gain field Displays the amount of gain applied to the centre. Editable.

Centre Variance field Displays how much the centre varies. Editable.

Border Ratio button Enable to take into account ratio values of the parent relighting object.

Ratio Gain field Displays the amount of gain applied to the ratio. Editable.

Ratio Variance field Displays how much the ratio varies. Editable.

Border Spread button Enable to take into account spread values of the parent relighting object.

Spread Gain field Displays the amount of gain applied to the spread. Editable.

Spread Variance field Displays how much the spread varies. Editable.
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Pattern Tab(s)

Use the pattern settings to control the texture before it is applied to the lens flare or ray. The settings in the
Pattern tabs vary depending on the component type. You can get a quick description of each setting by
viewing its tooltip.

Relighting: Rays

Use rays to simulate volumetric effects. You can attach a Rays object to a light in Action.
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You can position rays behind 2D or 3D objects to generate effects, although rays are still visible even without
an object to outline them. When semi-transparent objects are positioned in front of the light, it is possible
to generate volumetric rays that use the colour of the object.

Adding a Rays Object to a Light

In Action, a ray is a child of a light. Multiple lights can be parented to the same Rays object.

To add a ray to the scene.

1 Add and position a light to your scene.

2 Do one of the following:
■ Drag the rays node from the node bin and place it in the schematic.

■ Double-click the rays node.

A Rays object is added to the schematic. In Result view, you can see the ray.

If there is only one light in the scene, the rays node is automatically connected to it. If there are several
lights in the scene, select the light in the schematic that you want parented to the rays node before
added the rays node. Otherwise, you can parent the rays node to the light or lights manually in the
schematic.

3 To display the Rays menu, double-click the Rays object in the schematic, or follow the tab population
rules for the Object menu. See Populating Menu Tabs of Selected Objects (page 344).

Similar to the workflow of the Lens Flare, you can add texture components (page 440) to a rays node to
enhance the effect.

Rays Menu Settings

The Rays Object menu lets you control settings for the complete rays effect. If you have added component
textures to the Rays effect, each component texture also has its own menu that is specific to the component
(see Component Menu Settings (page 444)).

Position X field Displays the screen space position along the X axis of the Rays point-of-interest. Unavailable
if Free is disabled. Editable.

Position Y field Displays the screen space position along the Y axis of the Rays point-of-interest. Unavailable
if Free is disabled. Editable.

Position Z field Displays the screen space position along the Z axis of the Rays point-of-interest. Editable.
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Free button Enable to ignore transformations from the parent light object. When disabled, the ray is affected
by the parent light's position, rotation, spread, and falloff settings.

Colour button Enable to add the ray colour to the colour bleed applied to semi-transparent 3D objects
placed in front of the attached light.

Red Colour field Displays the amount of red in the effect and in any attached components (based on the
colour of the attached light). Editable.

Green Colour field Displays the amount of green in the effect and in any attached components (based on
the colour of the attached light). Editable.

Blue Colour field Displays the amount of blue in the effect and in any attached components (based on the
colour of the attached light). Editable.

Colour pot Displays the colour of the effect and any attached components (based on the colour of the
attached light). Editable.

Intensity field Displays the intensity of the effect and any attached components (multiplied by the intensity
of the attached light). Editable.

Spread field Displays the shape of the ray cone. Editable.

Falloff field Displays the amount of smoothness applied to the borders of the ray cone. Editable.

Length field Displays the amount of softness applied to the ray. Editable.

Samples field Displays the quality of the ray based on the radial distance to the attached light. Editable.

Active button Enable to use shimmering settings to modulate the ray with noise particles.

Animated button Enable to automatically apply a noise effect to the shimmer at each frame.

Thickness field Displays the thickness of the shimmer noise particles. Editable.

Pan X field Displays the amount of movement of the shimmer noise particles along the X axis. Editable.

Pan Y field Displays the amount of movement of the shimmer noise particles along the Y axis. Editable.

Object Intensity field Displays the amount of ray colour bleed applied to semi-transparent 3D objects placed
in front of the attached light. Editable.

Shading button Enable to allow the ray to inherit the shaded colours of a 3D object as it passes through
the object.

Relighting: Blooming

Attach a Blooming node to a light in the scene to help define highlight areas that generate a glowing effect.
You can add textures to stamp a blooming node with particular patterns, such as streaks and glints.
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Blooming can affect surfaces and geometries in your Action scene, and you can also use lighting links from
the attached lights to selectively include or exclude blooming from objects in the scene.

Since Blooming works in Action screen space, the effect is not limited to the surface or geometry in your
scene. Note however, that while blooming can occur outside of the Action scene while you are viewing the
effect in the image window, in this case you may not see the full blooming effect when you preview or
process in Action. You may notice this also if you zoom in or out while viewing in the image window.

Adding a Blooming Object to a Light

In Action, a blooming node is a child of a light. Multiple lights can be parented to the same Blooming object.

To add a bloom to the scene.

1 Add and position a light to your scene.

2 Do one of the following:
■ Drag the blooming node from the node bin and place it in the schematic.

■ Double-click the blooming node.

A Blooming object is added to the schematic. In the Result view, you can see the bloom effect.

If there is only one light in the scene, the blooming node is automatically connected to it. If there are
several lights in the scene, select the light in the schematic that you want parented to the blooming
node before adding the blooming node. Otherwise, you can parent the blooming node to the light or
lights manually in the schematic.

3 Optional: To add a texture component, select the blooming object in the schematic, then double-click
a texture node in the Relighting tab of the node bin.
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4 To display the Blooming menu, double-click the Blooming object in the schematic, or follow the tab
population rules for the Object menu.

Blooming with Texture Components

Similar to the workflow of the Lens Flare, you can add texture components to a blooming node to enhance
the effect. When using blooming in Stamping mode, texture components must be attached to see any result.

The Stamping tab of the Blooming menu has global settings for all attached components, but each component
texture has its own menu to control settings particular to it.

Be aware of the following when working with texture components attached to a blooming node:
■ Each type of component can be added multiple times to a blooming object, each with its own settings.

■ Some settings in the Basic tab of the component menu do not affect stamping, such as Number, Position,
Variance, and Seed. Only one instance of the texture pattern is used for stamping, so these settings have
no effect.

■ You can use the Border FX settings for each component to decide how the luminance of the objects that
the blooming is affecting modulates the Basics settings (Intensity, Scale, Rotation, and Ratio) of the
texture pattern. Centre and Spread are not used for blooming.

■ You can re-texture a component using a Diffuse Map with your own texture media applied. To do so,
select the component in the schematic, then select the media you want to use from the media list, and
double-click the Diffuse Map node in the node bin. In this case, the Pattern settings in the component
menu are not applicable, though you can still use the settings in the Basics and Border FX tabs of the
component menu, as well as the Diffuse menu settings.

Blooming Menu Settings

The Blooming menu is divided into two tabs, each with its own type of blooming effect, which can work
independantly, or in combination with each other.

Blooming Tab

Red Colour field Displays the amount of red in the effect and in any attached components (based on the
colour of the attached light). Editable.

Green Colour field Displays the amount of green in the effect and in any attached components (based on
the colour of the attached light). Editable.

452 | Chapter 15   Compositing in 3D Space with Action



Blue Colour field Displays the amount of blue in the effect and in any attached components (based on the
colour of the attached light). Editable.

Rays Colour pot Displays the colour of the effect and any attached components (based on the colour of the
attached light). Editable.

NOTE The same colour settings are also found in the Stamping tab.

Intensity field Displays the intensity of the effect and any attached components (multiplied by the intensity
of the attached light). Editable.

Threshold field Displays the minimum luminance value at which blooming occurs. Editable.

Softness X field Displays the amount of softness along the X axis of the blooming effect. Editable.

Softness Y field Displays the amount of softness along the Y axis of the blooming effect. Editable.

Stamping Tab

For stamping settings to have any effect, you need to attach one or more texture components to the blooming
node. In this case, stamping settings are global for all attached components, and each component texture
has its own menu that is specific to the texture.

Red Colour field Displays the amount of red in the effect and in any attached components (based on the
colour of the attached light). Editable.

Green Colour field Displays the amount of green in the effect and in any attached components (based on
the colour of the attached light). Editable.

Blue Colour field Displays the amount of blue in the effect and in any attached components (based on the
colour of the attached light). Editable.

Rays Colour pot Displays the colour of the effect and any attached components (based on the colour of the
attached light). Editable.

NOTE The same colour settings are also found in the Blooming tab.

Stamping Intensity field Displays the global stamping intensity of all attached texture components. Editable.

Stamping Threshold field Displays the minimum value at which stamping occurs for all attached texture
components. Editable.

Stamping Softness X field Displays the softness along the X axis for all attached texture components.
Editable.

Stamping Softness Y field Displays the softness along the X axis for all attached texture components.
Editable.
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Stamping Attenuation field Displays the smoothing level of the blooming effect. Use to fade out regions
that have too much blooming. Editable.

Texture Minimum Size field Displays the minimum size of all attached texture components. Editable.

Texture Scale field Displays the size of all attached texture components. Editable.

Texture Rotation field Displays the level of rotation of all attached texture components. Editable.

Texture Ratio field Displays the aspect ratio of all attached texture components. Editable.

Sampling X field Displays the size of the grid along the X axis to affect the number of samples taken to
calculate the stamping effect. A higher value yields faster results, but may be less precise. Editable.

Sampling Y field Displays the size of the grid along the Y axis to affect the number of samples taken to
calculate the stamping effect. A higher value yields faster results, but may be less precise. Editable.

About 3D Geometry
A powerful feature of Action is its ability to import 3D models created in other applications and combine
them with existing clips. Compositing 3D models and characters with other media or a background can be
done quickly and with a finite level of control.

3D geometric objects are manipulated like an image or a clip: you can animate their position and shape,
apply textures and media, and light objects to produce a variety of effects.

You can import 3D polygon objects such as 3ds Max files, FBX files, Alembic files, Wavefront files, Inventor
files, and Paint geometry. 3ds Max files contain object data, specifically, texture and materials. The FBX
format acts as the intermediary between different file types. Files can be exported from another product to
the FBX or ABC format and then imported into Smoke.

Paint geometry files are created by the Smoke Paint tool. If you want to work with polygon geometry in
Action, import Paint geometry. Action ignores its animation and attributes, such as its colour, outline, and
gradient. For example, in Paint, if you create a blue polygon, animate its scale, and save it as geometry, it is
imported in Action as a white polygon with no animation.

NOTE Sample 3ds Max and FBX model files are located in the usr/discreet/<product_home>/models/(FBX or 3DS)
libraries. All models are textured with an identical image. The library consists mostly of geometric primitives such
as cubes, cylinders, and spheres.

Importing 3D Models

You can import a 3D model into one or several geometry nodes. You can also import multiple 3D models
into a single animated geometry node.

To import a 3D model:

1 Do one of the following:
■ Drag the Import node from the node bin and place it in the schematic.

■ Drag the Import node from the node bin and place it where you want it in Result view.

■ Double-click the Import node. You do not need to be in Schematic view to add a node in this
manner.

The Import menu and file browser appear.

NOTE When selecting Paint or Photoshop, the subsequent controls described in this section do not apply.
When selecting FBX, other controls appear. See  Importing the FBX Format  (page 459).
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2 From the Import Type box, select the import format.

3 If the file you want to import has a file extension different from the one specified, type a file extension.

4 Enable or disable Geometry, Object, and Material options, as needed. See below for descriptions of the
options.

5 Select the file to import from the file browser.

6 Click Load.

The 3D model (Geom node) and axis is added to the scene.

You can change the 3D model's colour, specular highlight, shine, and other material properties. See
3D Geometry Menu Settings (page 461).

To import multiple 3D models into an animated sequence:

1 Follow the same steps for adding a single 3D model, but from the Import file browser, select multiple
3D models by holding the Shift or Ctrl key.

2 Once the models are selected, click Load.

The selected 3D models are loaded to the same line in the Media list.

3 Double-click the Geometry node in the schematic to access the Geometry menu, then click the Timing
tab.

Import Settings

Geometry Import Settings

Depending on the type of import, some of the options differ.

Import Type box Select the 3D model type to import.

File Extension field Displays the default extension for the file type selected in the Import Type box.

Smooth button Enable to build normals for the 3D model. Enable if you are importing polygons that do
not have normals.

Auto Fit In Scene button Enable to scale the imported model to fit into the current frame. When disabled,
the imported model maintains the same size in which it was created.

Mesh Animations button Enable to import the Alembic scene animations and preserve complex geometry
animations.

Cameras button Enable to import cameras from the Alembic format file.

Normal button Enable to import an Alembic model's normal information.

Separate Nodes button Enable to create individual nodes for all 3D models contained in a file. When
disabled, the 3D model is added to the scene with its own axis.

Rotate Axis button Enable to rotate the 3D model by 90 degrees on the X-axis so that it is compatible with
the target's coordinate system.

Create Media button Enable to load the textures of the geometry to the Media list. If a texture is used in
multiple geometry maps, it is loaded only once in the Media list.
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Timing Settings

Animation Mode box Select the animation mode to use for multiple 3D geometries imported into a single
animated geometry node.

To:Select:

Play in a continuous loop.Loop

Play once. The 3D geometry is no longer displayed.Once

Play once, and hold the last frame.Last Still

Animate according to the timing in the animation channel.Timing

Hold field Displays the number of continuous frames for Loop, Once, or Last Still Animation modes. Editable.

Slip field Displays the offset to the start point for Loop, Once, or Last Still Animation modes. Editable.

Timing Range option box Select an option to determine how Frame Timing values outside the timing range
of the animation are handled. Available when Timing is selected in the Animation Mode box.

To:Select:

Roll over the Frame Timing value.Roll

(Geometry is not displayed.)Cut

Display the first or last geometry (with this option, you can select the first and the last

geometry of your animation).

Round
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Frame Timing field Displays the value for the frame in the timing curve. Available when Timing is selected
in the Animation Mode box. Editable.

About 3D Data in the FBX Format

Smoke supports the import of 3D data saved in the FBX format.

The FBX standard format provides a means for exchanging 3D data—3D polygonal models, cameras, lights,
keyframe animation—for scene compositions between tools and packages developed by different
manufacturers.

FBX support makes it possible to import Autodesk 3ds Max, Autodesk Maya, Autodesk MotionBuilder,
Autodesk Mudbox, and Autodesk Softimage files. You can import models, scene compositions, lights, and
camera data.

NOTE Smoke supports the import of most models, including polygonal, nurbs, and smooth bind skinning, while
subdiv primitives are not supported. See the FBX compatibility maps.

About Mesh Animation

Mesh animation (geometry caching) records the position of every vertex in an animated 3D scene over time.
This allows character animations, animated geometry deformations, or physical simulations to be "baked"
and transported in the FBX file without an understanding of the animation technique used to create the
effect. By exporting FBX scenes with geometry caching, and then importing into Action with Mesh Animations
enabled, you can preserve complex geometry animations, such as nCloth animations.

All imported cached geometry can still be manipulated in Action like a normal geometry. Deform meshes,
texture maps, lighting, and axis manipulations are all supported on the animated geometry. Animations
can also be retimed within Action.

FBX Information Preserved at Import

Smoke supports the latest FBX SDK, in sync with Autodesk 3D applications. To ensure compatibility, all
applications must use the same version of the FBX SDK.

The following FBX features are preserved in Action:
■ Point lights, spotlights, area lights, ambient lights, and directional lights

■ Shadow casting

■ Object ID and material assignments

■ Sub-materials, exposed explicitly in the Action schematic

■ Bezier animation curves

Object Group and Material Nodes

FBX models are created with one or more faces, which leads to different representations in Action.

NOTE In this context, face actually means either a single face (such as one of six sides of a cube) or faces (such as
a group consisting of 2 sides of a cube) that are grouped together to receive a single texture. How faces are
grouped (if grouped at all) is decided when the model is created and cannot be modified in Smoke.

A model with a single face appears as a simple model, with a single Material node attached to the Geom
node.
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A model with multiple faces appears as a complex schematic where one Object Group node is created for
each face. To each Object Group node is then attached the Material node. Having multiple Object Nodes
allows you to modify, even replace, the textures applied to each shader.

You cannot create new Object Group nodes, and their link to the Geom node is unbreakable; they have no
editable attributes. Object Group nodes details how faces were applied to the FBX model, and allow you to
texture differently the components of the FBX model.

In the following examples, one imported FBX model has a single face, while the other has three faces, one
for each sides of the cylinder.

(a) FBX model with a single face (b) FBX model with multiple faces (c) Added Object Group nodes, one for each face

The schematic above creates the image below. Note how having different Object Group nodes allows you
to link different textures.
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(a) FBX model with a single face: one texture map for the whole model (b) FBX model with multiple faces: a different
texture for each face

Importing the FBX Format

To import FBX format data in Action:

1 Do one of the following:
■ Drag the Import node from the node bar and place it in the schematic.

■ Drag the Import node from the node bar and place it where you want it in Result view.

■ Double-click the Import node. You do not need to be in Schematic view to add a node in this
manner.

2 In the Import menu, select FBX as your format type.

3 Use the FBX import settings, as needed.

4 Navigate to the location where the FBX files are located.

NOTE  Make sure that you have write permissions to the folder where the FBX file is located, as Smoke
decompresses the textures embedded in the FBX to an .fbm folder collocated with the FBX file.

5 Select a file from the file browser.

The FBX data is imported into Action.

FBX Import Settings

Auto Fit In Scene button Enable to scale the imported model to fit into the current frame. When disabled,
the imported model maintains the same size in which it was created, or you can use the FBX Units to Pixels
field to manually set a scaling factor.

FBX Units to Pixels field Displays the scaling factor used on the imported FBX file to fit the scaling used
in the application. One unit in the FBX file (default is cm) is converted to the number of pixels (default is
10) that you specify.
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FBX Import Type box Select an FBX import type. Select Link to Original File to keep a live link to the
original FBX file, but without control over the components of the scene. Select Create Local Copy to have
control over the elements of the scene, but lose the link.

Keep FBX Frame Rate button Enable to use the frame rate of the FBX file as the frame rate in Action.

TIP It might be useful to enable Keep FBX Frame Rate when importing an FBX file before starting to build your
animation, otherwise the timing of your animation may be affected.

Bake FBX Animation button Enable to add a keyframe at every frame of the imported FBX file. When
disabled, Action translates the FBX keyframes to a comparable animation curve for comparable channels.
Experiment with this option enabled and disabled to get your desired results.

Create Media button Enable to load the textures of the geometry to the Media list. If a texture is used in
multiple geometry maps, it is loaded only once in the Media list.

Lights button Enable to import lights from the FBX format file.

Cameras button Enable to import cameras from the FBX format file. Free cameras are imported as target
cameras (with a point of interest).

Mesh Animations button Enable to import the FBX scene animations and preserve complex geometry
animations , such as nCloth animations.

Normals button Enable to import the model's normal information.

Working with FBX Scenes Linked to the Original Files

When importing an FBX file in an Action schematic, setting FBX Import Type to the option Link to Original
File does not create a Geom node like Create Local Copy does, but rather creates an FBX Scene node.

You cannot perform the same operations on an FBX Scene node as on a Geom node.
■ You can only parent Axis nodes.

■ You cannot parent it to other nodes.

■ You cannot select individual components; you always select the entire scene.

■ There is only one node in the Priority Editor for the whole scene.

If someone updates the linked FBX file, click Refresh to update the FBX Scene node in Action.

The options available in an FBX Scene node are also different from the ones found in a Geom node.

FBX Scene Settings

FBX Scale field Displays the factor by which to scale the FBX scene. Does not scale the camera if it has
already been extracted using the Extract Camera button. Editable.

Extract Camera button Click to extract the 3D camera from the FBX scene. It extracts and creates a new
3D camera node, scaled to the current FBX Scale . Once extracted, the camera is no longer linked to the FBX
scale: changing the FBX scale does not affect the camera. If you need to edit then rescale the camera after
changing the FBX Scale, delete the extracted camera and extract a new one.

Sort button Enable so the 3D models contained in the FBX Scene are drawn according to their normals.
Consider using this option if the scene contains semi-transparent 3D models to ensure they are correctly
drawn.
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FBX File Path field Displays the path to the FBX file. Click to replace the currently displayed FBX scene
with another one.

Refresh button Click to update the FBX Scene node with the content of the FBX file. Use this if the FBX
file has been updated since its import.

3D Geometry Menu Settings

You can change and animate parameters such as the colour, specular highlight, shine, and transparency of
3D models. You set these parameters using the Geometry menu. To access this menu, double-click a Geometry
node in the schematic, or follow the tab population rules for the Object menu (see Populating Menu Tabs
of Selected Objects (page 344)).

The Geometry controls are described as follows.

Lighting Settings

Red Specular field Displays the red specular highlight value. Editable.

Green Specular field Displays the green specular highlight value. Editable.

Blue Specular field Displays the blue specular highlight value. Editable

Specular colour pot Displays the colour of light reflected by the 3D model's surface. To enable the specular
highlight, the Shine value must be larger than 0. Editable.

NOTE Specular lighting sets the colour of light reflected by the 3D model's surface. To enable the specular highlight,
the Shine value must be larger than zero.

Red Ambient field Displays the red ambient colour value. Editable.

Green Ambient field Displays the green ambient colour value. Editable.

Blue Ambient field Displays the blue ambient colour value. Editable.

Ambient colour pot Displays the colour of the area of the 3D model that is not illuminated by a direct light
source. Editable.

NOTE Ambient lighting sets colour to the area of the 3D model that is not illuminated by a direct light source.
The edge of the ambient area mixes with the specular highlight colour and the diffuse colour.

Red Diffuse field Displays the red diffuse colour value. Editable.
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Green Diffuse field Displays the green diffuse colour value. Editable.

Blue Diffuse field Displays the blue diffuse colour value. Editable.

Diffuse colour pot Displays the diffuse colour. Editable.

NOTE Diffuse lighting modifies the colour and illumination of the entire 3D model. Diffuse light mixes with the
colour of the light sources used to illuminate the 3D model. The diffuse colour may also mix with the ambient
colour and the colour of the specular highlight.

Surface Settings

Blend Type box Select whether to use Flame or Photoshop blend modes.

Blend Mode box Select how the 3D model and the scene are combined. The available list of modes depends
on the selection in the Blend Type box. See Surface Blending Modes (page 394).

Transparency field Displays the transparency level of the 3D model. Editable.

Shine field Displays the intensity value of the specular highlight. When this value is zero, the specular
highlight is disabled. Shine affects both size and intensity. Editable.

See Creating a Specular Highlight on a Model (page 466).

Sort Order box Select the drawing priority of the 3D model normals.

To draw the polygons:Select:

That are both facing and opposite the camera.Shade Both

Facing the camera last.Shade Front

Opposite the camera last. This option is especially useful for semi-transparent modelsShade Back

Shadow Casting box Select how the selected geometry object will be affected by a Shadow Cast object in
the scene. See  Surface and Geometry Shadow Casters  (page 435).

Force 2-Sided button Enable to have lights in the scene light both the inside and outside of the geometry
(when shading is turned on).

Polygons Settings

Polygons field Displays the number of polygons in the 3D model. Non-editable.

Subdivide button Enable to create high-quality shading for polygon models.

Resolution field Displays the geometry resolution of the 3D model. Active when Subdivide is enabled.
Editable.

Wireframe box Select a wireframe option for the 3D model. When you render the 3D model with Wireframe
or Original Wire selected, it retains its light, shading, and texture attributes.

To:Select:

Disable wireframe for the 3D model (filled polygons are drawn).Solid

Display the model as a wireframe outline (triangular polygons only).Wireframe

462 | Chapter 15   Compositing in 3D Space with Action



To:Select:

Display the model as a wireframe outline (original mesh; any polygon type). May be useful

for imported geometries.

Original Wire

Sort button Enable to determine how the 3D model is drawn according to its normals.

UV Map Settings

Use the UV Mapping settings to select how the UV coordinates of an attached displace or diffuse node are
mapped to the 3D model. You can also apply axis transformations to the UV map. These transformations
are different from the settings of the parent axis in that they transform the axes of the actual UV map
coordinates.

UV Mapping Type box Select the type of UV mapping to apply to the attached node.

When a Displace node is attached to a geometry, you may need a UV mapping type other than Default for
the displace pattern to have any effect on the geometry.

NOTE When a Diffuse node is attached to a geometry, you must select Wrap from the Mapping box in the Diffuse
menu to be able to use the UV mapping settings. See Diffuse Mapping (page 502).

Use GroupId button Enable to respect GroupId information in an FBX file created in 3ds Max.

Smooth Angle button Enable to override existing normals in the geometry, then use the Smooth Angle
field to change the value.

Smooth Angle field Displays the angle at which the edges of normals become hard. Changes to this field
only affect the shading of the displacement, and not the shape. Editable.

Position X field Displays the position of the X axis. Editable.

Position Y field Displays the position of the Y axis. Editable.

Position Z field Displays the position of the Z axis. Editable.

Rotation X field Displays the rotation of the X axis. Editable.

Rotation Y field Displays the rotation of the Y axis. Editable.

Rotation Z field Displays the rotation of the Z axis. Editable.
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Scale X field Displays the scale of the X axis. Editable.

Scale Y field Displays the scale of the Y axis. Editable.

Scale Z field Displays the scale of the Z axis. Editable.

Prop Scale button Scales the X, Y, and Z UV axes proportionally.

Shear X field Displays the shear of the X axis. Editable.

Shear Y field Displays the shear of the Y axis. Editable.

Shear Z field Displays the shear of the Z axis. Editable.

NOTE The UV Transform fields are only available if a Mapping Type other than Default is selected.

Material Menu Settings

If you import a 3ds Max model or an FBX file that has a texture applied to it, that texture map and its parent
Axis node is attached to the geometry through a Material node.

You can use the materials imported with the model, or replace the texture with another texture map, or
even a Substance texture.

Material Node Menu Settings

Lighting Settings

Red Specular field Displays the red specular highlight value. Editable.

Green Specular field Displays the green specular highlight value. Editable.

Blue Specular field Displays the blue specular highlight value. Editable

Specular colour pot Displays the colour of light reflected by the 3D model's surface. To enable the specular
highlight, the Shine value must be larger than 0. Editable.

NOTE Specular lighting sets the colour of light reflected by the 3D model's surface. To enable the specular highlight,
the Shine value must be larger than zero.

Red Ambient field Displays the red ambient colour value. Editable.

Green Ambient field Displays the green ambient colour value. Editable.

Blue Ambient field Displays the blue ambient colour value. Editable.

Ambient colour pot Displays the colour of the area of the 3D model that is not illuminated by a direct light
source. Editable.
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NOTE Ambient lighting sets colour to the area of the 3D model that is not illuminated by a direct light source.
The edge of the ambient area mixes with the specular highlight colour and the diffuse colour.

Red Diffuse field Displays the red diffuse colour value. Editable.

Green Diffuse field Displays the green diffuse colour value. Editable.

Blue Diffuse field Displays the blue diffuse colour value. Editable.

Diffuse colour pot Displays the diffuse colour. Editable.

NOTE Diffuse lighting modifies the colour and illumination of the entire 3D model. Diffuse light mixes with the
colour of the light sources used to illuminate the 3D model. The diffuse colour may also mix with the ambient
colour and the colour of the specular highlight.

Surface Settings

Transparency field Displays the transparency level of the 3D model. Editable.

Shine field Displays the intensity value of the specular highlight. When this value is zero, the specular
highlight is disabled. Shine affects both size and intensity. Editable.

See Creating a Specular Highlight on a Model (page 466).

Adjusting Normals

When using transparency with 3D models, you may sometimes see the back polygons, giving the model a
shattered or broken look. This happens when the drawing priority of the normals is not sorted properly.
Enable Sort and select an option from the Sort Order box to sort the drawing priority back to front or front
to back.

Select Front to sort the polygons front to back. The
transparency is drawn correctly.Drawing order of the 3D model's polygons is incorrect. Back

polygons are drawn through when the model is transparent.
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Subdividing a Model

The Subdivide feature is useful for creating precise highlights and spotlights. The polygons in the 3D model
are subdivided at the time of render according to the value you specify, resulting in smoother rendered
surfaces.

Spotlight on a polygon model rendered with Subdivide
set to 2.

Spotlight on a polygon model rendered with Subdivide off.

To subdivide a model:

1 Select the model or geometry you want to subdivide.

2 In the Geometry menu, click Subdivide to enable the Subdivide field.

3 Edit the Subdivide value. The default value is 5.

NOTE The smaller the value, the slower the rendering.

4 Click Process or Preview to see the subdivision effect.

You can animate the Subdivide channel in the Channel Editor; however, expect a longer rendering time
when the Subdivide value changes over several keyframes.

Creating a Specular Highlight on a Model

Change the specular colour by entering values in the Specular red, green, and blue channel fields or using
the colour picker. For example, if the specular colour is red and the light source is white, the specular highlight
is also red. If the specular colour is yellow and the light source is red, the highlight is orange.

To use a specular highlight with a 3D model:

1 Add and position a light source in the scene.

2 In the scene, select the 3D model to which you want to add the highlight.

3 In the Action Setup menu, enable Shading.
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4 In the Geometry menu, set a value in the Shine field.

A high Shine value produces a dimmer highlight while a low Shine value produces an intense highlight.
When the Shine field is set to zero, the 3D model does not have a highlight. The following example
shows the same 3D model using two different Shine values.

Shine is set to 20. The specular highlight is dimmer.Shine is set to 1. The specular highlight is intense.

About 3D Text
You can create and manipulate 3D text strings in your Action scenes. With 3D text, you specify typical text
properties such as font, font size, kerning, and italics. Since 3D text strings created in Action are also 3D
geometries, you can extrude text, offset your text from a path, and apply other geometry settings.

Using 3D Text Presets

A number of 3d text presets are included in Action, such as rotating or fading text to add to your scene.
These presets can help you add complex text effects with just a few clicks.

To add a 3d text preset:

1 Do one of the following:
■ Drag the Presets node from the node bin and place it in the schematic.

■ Drag the Presets node from the node bin and place it where you want it in Result view.

■ Double-click the Presets node. You do not need to be in Schematic view to add a node in this
manner.

The file browser opens.

2 From the Preset Type box, select 3D Text.
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The 3D Text Preset file browser appears, pointing to the default location of the presets:
usr/discreet/<product home>/3d_text_presets.

3 Optional: Enable Scale to Action Resolution to load the preset in the current Action resolution.

4 Optional: Select which rendering settings to enable or disable in the preset (Z-Buffer, Shading, Polygon
Resolution, and Colour Clamping).

NOTE These settings are enabled by default, and by disabling any of them, you may not see the intended
results in the preset.

5 Select the 3d text preset you want to load. Hold Ctrl and click to select multiple presets.

TIP Switch to Proxies view to see a visual representation of the presets.

6 Click Load.

The 3d text preset is then appended to your Action scene. In the 3D Text menu, you can change the
default text string of the preset.

3D Text Presets Usage Tips

A number of 3D text presets are included in Action, such as fading or spinning 3D text effects to add to your
scene. The presets are easily added to your scene from the Action node bar. For more information on the
3D Text node and its menu, see About 3D Text (page 467).

The 3D Text presets are designed for ease-of-use, so you should be able to easily identify the various schematic
nodes and their corresponding menus. For example, the nodes in the schematic for each preset are renamed
to give you an indication of the functionality of the node. Many of the presets include a transition_ctrl Axis
node, that you can use to modify the timing of the text effect, as follows:

Rotation X=duration of the In effect; Y=start weight; Z=end weight. The Y and Z Rotation fields represent
the shape of the “S” curve of the In effect, if applicable. The combined Y and Z values should equal 100.

Scale X=duration before the start of the In effect; Y=duration between the end of In effect and the start of
the Out effect.

Shear X=duration of the Out effect; Y=start weight; Z=end weight. The Y and Z Shear fields represent the
shape of the “S” curve of the Out effect, if applicable. The combined Y and Z values should equal 100.

Centre These fields include expressions to produce animation curves, and shouldn’t be altered.

When loading a 3D Text preset, with a few exceptions, you can replace the Type Your Own Text string
in the Text field of the 3D Text menu. Some of the presets have multiple text entries. In these cases, replace
the text string of each Text Geom node with your preferred text string.

Presets Browser Settings

Preset Type box Select the category of presets to display in the browser.
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Scale to Action Resolution button Enable to load the preset in the current Action resolution.

Z-Buffer button Enable to load the Z-buffer rendering settings of the preset.

Shading button Enable to load the shading rendering settings of the preset.

Polygon Resolution button Enable to load the rendering resolution settings of the preset.

Colour Clamping button Enable to load the resolution colour clamping settings of the preset.

3D Text Preset List

Use the following table to get a quick overview of the 3D text presets available in this release, along with
particular comments, if applicable.

Name/Description/CommentsProxy

3DRotate Text on a rotating circular path. Edit timing using the Animation Track
Editor.

3DRotate_Shadow Text rotating on a circular path with a fake shadow. Edit
timing using the Animation Track Editor.

3DRotate_Transition Transition between two text strings rotating on a circular
path. Edit timing using the Animation Track Editor.

Behind_Camera_3D Characters coming from behind the camera. Edit timing
using transition_ctrl settings.
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Name/Description/CommentsProxy

Bounce Characters falling and bouncing. Edit timing using transition_ctrl settings.
Set duration and amplitude of the bouncing.

Break_and_Fall Characters breaking in two parts and falling down. Edit timing
using the Animation Track Editor.

Bubble_Pop Characters forming a bubble which pops. Edit timing using trans-
ition_ctrl settings.

Chop_Sticks Characters arriving one after the other with a scale and rotation
effect. Edit timing using transition_ctrl settings.

Circle Characters moving along a circular path. Edit timing using the Animation
Track Editor.
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Name/Description/CommentsProxy

Circle_Transition Transition between two text strings, in which characters are
moving along a circular path with a banking effect. Edit timing using transition_ctrl
settings.

Climber Characters climbing from the bottom to the top of the frame. Edit
timing using transition_ctrl settings. Use offset.rotation.X to set the displacement
duration and offset.rotation.Y to set the rotation duration.

Clock_Transition Transition between four text strings rotating like clock hands.
Edit timing using transition_ctrl settings.

Colour_Flasher Moving coloured flashing text. Edit timing using transition_ctrl
settings. Colour_offset sets the time offset between red, green, and blue channels.

Counter Incremental counter with numbers 000 to 999.
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Name/Description/CommentsProxy

Diagonal Characters dispersing diagonally in the frame. Edit timing using
transition_ctrl settings.

Dispersion Characters dispersing randomly. Use time_stretch.scaling.X to slow
down or speed up the effect.

Dispersion_Transition Transition between two text strings using a dispersion
movement. Edit timing using transition_ctrl settings.

DNA Animated double helix structure using two text strings of the letter “T”.

Dominos Characters falling one after the other. Edit timing using transition_ctrl
settings.
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Name/Description/CommentsProxy

Fade_In_Flicker Fade in of randomly flickering characters. Edit timing using
transition_ctrl settings.

Fade_In_From_Centre Fade in from the centre to the extremities of the text.
Edit timing using transition_ctrl settings. Set characters.rotation.X to the number
of characters in the Text field.

Fade_In_From_Left Fade in from the left to the right of the text. Edit timing
using transition_ctrl settings.

Fade_In_Out_By_Character Fade in and out one character after the other.
Edit timing using transition_ctrl settings. Set characters.rotation.X to the number
of characters in the Text field.

Fade_In_Random Use time_stretch.scaling.X to slow down or speed up the
effect.
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Name/Description/CommentsProxy

Fade_In_To_Centre Fade in from the extremities to the centre of the text. Edit
timing using transition_ctrl settings.

Fade_Out_From_Centre Fade out from the centre to the extremities of the
text. Edit timing using transition_ctrl settings. Set characters.rotation.X to the
number of characters in the Text field.

Fade_Out_From_Right Fade out from the right to the left of the text. Edit
timing using transition_ctrl settings.

Fade_Out_Random Use time_stretch.scaling.X to slow down or speed up the
effect.

Fade_Out_To_Centre Fade out from the extremities to the centre of the text.
Edit timing using transition_ctrl settings.
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Name/Description/CommentsProxy

Fast_Beam Characters arriving from the right side of the frame, with scaling and
flickering. Edit timing using transition_ctrl settings. Customize the flicker effect
using flicker settings.

Flasher Customize the flashing using period_offset settings.

Flicker Animate with period.rotation.X.

Flip_Transition Transition between two text strings, with characters rotating
on the Y axis. Edit timing using transition_ctrl settings.

Flutter Characters arriving one after the other with a scale and rotation effect.
Edit timing using transition_ctrl settings.
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Name/Description/CommentsProxy

Flying_Transition Transition between two text strings in which characters are
flying out from the centre and coming back to it. Edit timing using transition_ctrl
settings.

From_Back Characters arriving from behind the camera. Use time_stretch.scal-
ing.X to slow down or speed up the effect.

From_Bottom Characters arriving from the bottom of the frame, with rotation.
Edit timing using transition_ctrl settings.

From_Camera_3D Characters arriving from behind the camera and turning
towards the camera. Edit timing using transition_ctrl settings.

Ghost Text arriving toward the camera, reflecting, and fading. Edit timing using
the Animation Track Editor.

476 | Chapter 15   Compositing in 3D Space with Action



Name/Description/CommentsProxy

Ghost_Cascade Similar to Ghost, with a cascade applied. Edit timing using the
Animation Track Editor.

Ghost_Rotation Similar to Ghost with an animated ParticleDraw axis. Edit
timing using the Animation Track Editor.

Helix_Transition Transition between two text strings in which characters are
rotating on their X axis. Edit timing using transition_ctrl settings.

Insertion Text is revealed frame after frame in insert mode. Edit timing using
transition_ctrl settings. Use offset.rotation.X to set the starting value of the path.

Kern Characters arriving and leaving the frame with kerning and rotation. Edit
timing using transition_ctrl settings.
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Name/Description/CommentsProxy

Mirror Text on path with a mirror effect. Edit timing using the Animation Track
Editor.

Negate Text revealed using a negate blending effect. Edit timing using trans-
ition_ctrl settings.

Ocean_Tide Text moving slowly as if characters were floating on the sea. Use
period and amplitude axes to customize the wavy effect.

Ocean_Tide_Transition Transition between two text strings moving slowly
as if characters were floating on the sea. Edit timing using transition_ctrl settings.
Use period and amplitude axes to customize the wavy effect.

Path_Warp Text on animated path producing a warping effect. Edit timing using
the Animation Track Editor.
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Name/Description/CommentsProxy

Pendulum Characters moving as if attached to a pendulum Edit timing using
transition_ctrl settings. Use period and amplitude axes to customize the oscillating
effect.

Pulse_Wave Characters moving vertically with a pulsating effect. Customize
using period and amplitude settings.

Quick_Rotate Characters rotating on their X axis. Edit timing using transition_ctrl
settings.

Quick_Twist Characters scaled on their Y axis. Edit timing using transition_ctrl
settings.

Random_Display Random letters with a specific starting and ending text string.
Edit timing using transition_ctrl settings. Type the start text in text_1 and the stop
text in text_2.
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Name/Description/CommentsProxy

Random_Hide Characters disappearing randomly. Clipping Plane modified.
Use time_stretch.scaling.X to slow down or speed up the effect.

Random_Letters Letters displayed randomly.

Random_Reveal Characters appearing randomly. Clipping Plane modified. Use
time_stretch.scaling.X to slow down or speed up the effect.

Replace_Transition Transition between two text strings with rotation. Edit
timing using transition_ctrl settings.

Reverse Transition between two text strings in which characters reverse direction.
Edit timing using the Animation Track Editor.

480 | Chapter 15   Compositing in 3D Space with Action



Name/Description/CommentsProxy

Rubber Characters are stretched and released like rubber. Edit timing using
transition_ctrl settings. Set period and amplitude of the bouncing.

Rubber_Transition Transition between two text strings using a rubber effect.
Edit timing using transition_ctrl settings. Set period and amplitude of the bouncing.

Scaling_Transition Transition between two text string using a scaling effect.
Edit timing using transition_ctrl settings. Set characters.rotation.X to the number
of characters in the Text field.

Shiver_Transition Transition between two text strings with a shiver-like effect.
Edit timing using transition_ctrl settings. Increase or decrease the turbulence using
noise_amplitude.

Shuffle_In_Out Characters arriving from the left, stopping in the centre, and
leaving to the right. Edit timing using transition_ctrl settings.
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Name/Description/CommentsProxy

Spin_Compress Characters revealed with rotation, and leaving with a compres-
sion effect. Edit timing using the Animation Track Editor.

Spin_In_Out Characters arriving and leaving with rotation. Edit timing using
transition_ctrl settings.

Spin_Transition Transition between two spinning text strings. Edit timing using
transition_ctrl settings.

Spinning_Letters Characters thrown with a spinning effect. Edit timing using
transition_ctrl settings. Experiment with transition_ctrl.scaling.Y and trans-
ition_ctrl.scaling.Z.

Spiral Text on a spiral path. Edit timing using the Animation Track Editor.
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Name/Description/CommentsProxy

Spiral_Transition Transition between two text strings with a spiral effect. Edit
timing using transition_ctrl settings.

Spring_Transition Transition between two text strings with letters springing
left and right. Edit timing using transition_ctrl settings. Customize the pulsing effect
using period and amplitude settings

Squash_Transition Transition from a text string with letters being squashed
to reveal the other text string. Edit timing using transition_ctrl settings.

Star Text moving along a star path. Edit timing using the Animation Track Editor.

Stretch Text arriving from the left of the frame with a stretching effect. Edit
timing using transition_ctrl settings.
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Name/Description/CommentsProxy

Subtract Text revealed using a subtract blending effect. Edit timing using
transition_ctrl settings.

Text_Falling Characters moving along a line, then falling down. Edit timing
using the Animation Track Editor.

Titles Three text strings on a path arriving from the upper left. Edit timing using
the Animation Track Editor.

Titles_Stairs Three text strings revealed with a spinning effect. Edit timing using
transition_ctrl settings.

Track_In Characters appear and disappear with scaling. Edit timing using
transition_ctrl settings.
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Name/Description/CommentsProxy

Tremor Characters appear as if shaking. Increase or decrease the turbulence effect
using noise_amplitude.

Twist Characters arriving and leaving with a twisting effect. Edit timing using
transition_ctrl settings.

Typewriter Text revealed frame after frame with a typewriter effect. Edit timing
using transition_ctrl settings. Use transition_ctrl.rotation.X andtransition_ctrl.shear-
ing.X to set the fade in duration of characters.

Typewriter_Cursor Text is revealed frame after frame with a cursor preceding
characters. Edit timing using transition_ctrl settings. Use transition_ctrl.rotation.X
and transition_ctrl.shearing.X to set the fade in duration of characters. Set as many
white squares as characters in the text node. Adapt cursor kerning if needed.

Vertical_In_Out Characters arriving from the left side of the frame and moving
vertically before going out to the right of the frame. Edit timing using transition_ctrl
settings.
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Name/Description/CommentsProxy

Vertical_Rotation_Transition Transition between two text strings moving
vertically. Edit timing using transition_ctrl settings.

Waveform Waveform using Cursor font. Link text.character_anim.scaling.Y to
an audio file.

Whip_Effect Characters whipped by a rotating effect. Edit timing using trans-
ition_ctrl settings.

Whip_Transition Transition between two text string with characters whipped
by a rotating effect. Edit timing using transition_ctrl settings.

Whirlwind_Transition Transition between two text string with characters
circulating by a rotating effect. Edit timing using transition_ctrl settings.
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Name/Description/CommentsProxy

White_Background Characters revealed on a white background. Edit timing
using transition_ctrl settings. Change the background using white_bkgd_ax settings
and white_bkgd kerning value.

Windy Characters moving as if by wind. Customize with period and amplitude
axes.

Zig_Zag Characters arriving and leaving following a zig-zag path. Edit timing
using transition_ctrl settings. Change the path, if needed.

Adding a 3D Text Node

When you add a 3D Text node to your Action schematic, a special geometry node with an axis is added.

To add a 3D Text node to the scene:

1 Do one of the following:
■ Drag the 3D Text node from the node bin and place it in the schematic.

■ Drag the 3D Text node from the node bin and place it where you want it in Result view.

■ Double-click the 3D Text node. You do not need to be in Schematic view to add a node in this
manner.

A Geometry object, called Text1 by default, and parent axis appear in the schematic. In Result view,
the default Text string appears.

2 To open the 3D Text menu, double-click the 3D Text node in the schematic, or follow the tab population
rules for the Object menu.

See Populating Menu Tabs of Selected Objects (page 344).

You can also add a 3D Text node using the Presets node. See Using 3D Text Presets (page 467).
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Changing 3D Text Properties

When you add a 3D Text node to your scene, the default text string “Text” appears. You can easily change
this text string.

To change a text string:

1 Click the Text field.

The on-screen keyboard appears, representing the character set for the selected font. Enable Up ASCII
to access the rest of the character set. If the selected font has special symbol characters, enable Symbols
to see them.

2 Type your text string or use the on-screen keyboard.

3 Click Exit Keyboard. The text string is displayed in the Text field and automatically updated in the
scene.

4 Use the settings in the 3D Text tab to change the font, size, depth, and other text properties.

Creating Bevelled Text

Use the Bevel curve to add a bevelled edge to your 3D text. Use the options in the Edit Mode box to add,
select, delete, or move keyframes on the Bevel curve. The Bevel curve behaves in much the same way as an
animation curve in the Channel Editor. Experiment with different curves to create different effects.

Resulting bevelled text

Bevel curve

Separating Text

Rather than create a separate pivot point for each letter, you can separate words or sentences so that each
letter can be individually manipulated by its own axis in the schematic.

To separate text:

1 Select the text to separate.

2 From the Text tab, click Separate.

Each letter of the text geometry is now an independent geometric object, and has its own axis and
offset (to separate the letters). Each word is also given its own axis. The original 3D Text node is hidden
in the schematic.
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(a) Root axis for word (b) Root axis for letter (c) Offset per letter (d) Letter geometry

Animating 3D Text

You can animate the 3D text property and geometry channels in the Channel Editor. However, you cannot
animate the text string or its bevel curve. The 3D text channels are contained in the text folder.
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3D Text Menu Settings

3D Text Tab

(a) Text field (b) Font field (c) Bevel curve

Text field Displays the current text string. Editable.

Font field Displays the current font. Click to open the font library to select a different font for the text.

You specify the default font in the Preferences menu. Also, you can install additional fonts for use with
Smoke.

Kern field Displays the kerning value for the text string. Editable.

Size field Displays the font size for the text string. Editable.

Italic field Displays the level of italics for the characters in the text string. Editable.

Depth field Displays the level of depth (thus extruding the selection, making it three dimensional). Editable.

Rigid Text button Enable to gang the text string characters as a single geometry. Enabling this button is
particularly noticeable when attaching the 3D Text node to a 3D path.

Show Pivots button Enable to display the pivot points for each individual text character in the 3D Text
string (displayed in the image window in red). When disabled, only the master character pivot point is
displayed (in green).

This setting can also be found in the Character Axis tab.

Separate button Click to separate selected text so that each letter has its own axis. See Separating Text (page
488).

Motion Blur button Enable to use a motion blur effect for the selected text (can only be used if the global
Motion Blur is enabled in the Action Setup menu).

Bevel Curve Applies a bevel to the depth of the geometry when you manipulate the Bevel curve. You can
move and add points to the curve, as well as adjust the tangent handles to produce different effects with
the text string.

Home button Resets the Bevel curve viewer to show the whole curve.

Undo button Undoes the last set of Bevel curve operations.
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Reset button Resets the Bevel curve.

Multi Material button Enable to create an Object Group node for each of the front, back, and extrude of
the 3D object. You can then attach a different texture map to apply to the different surfaces.

Character Axis Tab

You can change the axis properties of your 3D text string characters. This can be useful in offsetting your
text from a 3D path.

(a) Cascade Alignment box (b) Vertical Pivot box (c) Horizontal Pivot box

Master Character field Displays the number of the character in the text string that is considered to be the
master. All other text characters follow this character in any character axis settings. Editable.

Cascade field Displays the amount of frames to offset the animation of other characters from the master
character. The animation that is offset includes all numeric fields in the Character Axis tab, as well as the
Specular, Ambient, Diffuse, Transparency, and Shine fields in the Geometry tab. Editable.

For example, if Cascade is set to 0, all characters have the same animation as the master character. If Cascade
is set to a positive number, all characters other than the master character have their animation offset forward
in time.

Cascade Alignment box Select the flow of the cascade offset, with respect to the master character.

X Position field Displays the position of the offset along the X axis. Editable.

Y Position field Displays the position of the offset along the Y axis. Editable.

Z Position field Displays the position of the offset along the Z axis. Editable.

X Rotation field Displays the rotation of the offset along the X axis. Editable.

Y Rotation field Displays the rotation of the offset along the Y axis. Editable.

Z Rotation field Displays the rotation of the offset along the Z axis. Editable.

X Scale field Displays the scale of the offset along the X axis. Editable.

Y Scale field Displays the scale of the offset along the Y axis. Editable.

Z Scale field Displays the scale of the offset along the Z axis. Editable.

Proportional Scale button Enable to scale the X, Y, and Z axes proportionally.

X Shear field Displays the shear of the offset along the X axis. Editable.

Y Shear field Displays the shear of the offset along the Y axis. Editable.
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Z Shear field Displays the shear of the offset along the Z axis. Editable.

X Centre field Displays the centre of the offset along the X axis. Editable.

Y Centre field Displays the centre of the offset along the Y axis. Editable.

Z Centre field Displays the centre of the offset along the Z axis. Editable.

Vertical Pivot box Select the vertical position of the pivot point for the selected text characters.

Horizontal Pivot box Select the horizontal position of the pivot point for the selected text characters.

Show Pivots button Enable to display the pivot point for each individual text character in the 3D text
string, displayed in the image window in red. When disabled, only the master character pivot point is
displayed (in green). This setting can also be found in the 3D Text tab.

Geometry and UV Map Tabs

Click the Geometry and UV Map tabs to apply any of the other geometry settings to your 3D text.

See 3D Geometry Menu Settings (page 461) for definitions of the specific Geometry and UV Map controls.

Changing Tessellation Properties

Tessellation is the process of tiling the curves' shapes with polygons. Smoke offers three different tessellation
methods:

Tessellation Type box Select the tessellation type you want to apply to the geometry. More settings appear
if you select Delaunay or Medial Axis.
■ Standard (GLU) is the least taxing tessellation option, although it is also the least efficient.

■ Delaunay generates a mesh composed entirely of triangular polygons. This method gives consistent
and predictable results, and in particular, it will not give different results if the tessellated objects are
rotated.

■ Medial Axis creates concentric contour lines along the medial axes (averages between the input boundary
curves), morphing from one boundary shape to the next.

The Wireframe box is also provided in the Tessellation menu. It is the same setting as in the Geometry
tab, but repeated here for ease-of-use.

Each method has its own set of options, described in the sections that follow.

Standard (GLU)

The Standard (GLU) tessellation method is the legacy tessellation option; while being very light in its
processing requirements, it is also the least efficient and precise. And compared to Delaunay and Medial
Axis tessellation methods, it has no options to fine tune the resulting tessellation.

Delaunay

The Delaunay tessellation method (or more precisely, constrained Delaunay tessellation) generates a mesh
composed entirely of triangular polygons. This method gives consistent and predictable results, and in
particular, it does not give different results if the curves are rotated.
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With this method, there are several options for fine-tuning the tessellation further.

Min Angle field Displays the smallest value of angle that the polygons can have. If a triangle contains an
angle that is smaller than this value, it gets replaced by better-shaped ones. Eliminating small-angled triangles
gives a more uniform shading and is more suited for deformations.

Min Angle = 20

Max Area field Displays the largest value of area that the polygons can have. If a triangle is larger than this
value, it gets replaced by smaller ones. This allows the polygon mesh to be deformed more smoothly.

Max Area = 5

Max Vertices field Displays the total number of new vertices that can be added by the Minimum Angle and
Maximum Area options. 0 by default.
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Use this option as a precaution against accidentally setting the other options to values that would create
huge amounts of geometry with long processing times.

It is not recommended that you rely on this option to control the final number of vertices because it can
force the tessellation to stop before the process is completed, thereby giving an unpredictable combination
of polygon shapes and sizes.

Boundary Split box Select an option to control tessellation along boundaries.

To:Select:

Allow the boundary edges along the outer contour and inner holes to be split further during tessel-

lation.

This is particularly useful for text and other shapes that may contain straight edges that need to

be deformed smoothly.

Free

Allow boundary edges along inner holes to be split, but not boundary edges along the outer contour.

Note that this may affect the uniformity of the mesh if you enabled Min Angle or Max Area.

None (Contour Only)

Prevent any boundary to be split.

Note that this may affect the uniformity of the mesh if you enabled Min Angle or Max Area.

None (Contour and

Holes)

Medial Axis

The Medial Axis tessellation method creates concentric contour lines along the medial axes (averages between
the input boundary curves), morphing from one boundary shape to the next. This method creates mainly
quads with some triangles, so it is well-suited for subdivision surfaces.

With this method, there are several options for fine-tuning the tessellation further.

Loops field Displays the number of loops used in the tessellation, modified by the Adaptive toggle.
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Loops = 2

Adaptive button Enable to set the Loops field as the average number of medial axes drawn and to keep the
distance between them fairly constant. Disable to set the Loops field as the exact number of medial axes
drawn per boundary (rounded to the nearest integer).

Backtrack Length field Displays the tessellation value at the extremities. Editable.

To have:Set to:

The medial axis intersects boundaries at each point of concavity, which can often create many small

triangles especially in sharp extremities.

0

The medial axis does not extend completely to the boundary and the remaining area is tessellated

with a fan shape.

Positive value

Sharper embossing effectsNegative value

Split Edges to Enhance button Enable to add vertices to allow the contour lines to follow the medial axes
more accurately. Turn this option off if there are no holes in the geometry; otherwise, there may be shading
artifacts along internal curves.

Edge Tessellation box Select an option to control the shape of the polygons.

To:Select:

Have long edges that are not split. This results in fewer polygons and lighter geometry, but the res-

ulting long, thin polygons may not deform well.

None

Have a tessellation made of squarer polygons that deform better, at the cost of a heavier tessellation.Equal on Both Sides

About Shading and Textures
Action uses shaders to compute the colour, lighting, shadows, and other attributes of each pixel or vertex
of objects in the scene.

You can use any media to map textures to Action surfaces and geometries, thus adding detail such as depth
and reflections to your 3D composites.
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Material Node

The Material node creates a central hub to control the specular, ambient, diffuse, transparency, and shininess
of a geometry's children maps and substances.

Smoke automatically creates a Material node when you insert a Substance Texture or when you import 3ds
Max or FBX models with textures.

Material Node Menu Settings

Lighting Settings

Red Specular field Displays the red specular highlight value. Editable.

Green Specular field Displays the green specular highlight value. Editable.

Blue Specular field Displays the blue specular highlight value. Editable

Specular colour pot Displays the colour of light reflected by the 3D model's surface. To enable the specular
highlight, the Shine value must be larger than 0. Editable.

NOTE Specular lighting sets the colour of light reflected by the 3D model's surface. To enable the specular highlight,
the Shine value must be larger than zero.

Red Ambient field Displays the red ambient colour value. Editable.

Green Ambient field Displays the green ambient colour value. Editable.

Blue Ambient field Displays the blue ambient colour value. Editable.

Ambient colour pot Displays the colour of the area of the 3D model that is not illuminated by a direct light
source. Editable.

NOTE Ambient lighting sets colour to the area of the 3D model that is not illuminated by a direct light source.
The edge of the ambient area mixes with the specular highlight colour and the diffuse colour.

Red Diffuse field Displays the red diffuse colour value. Editable.

Green Diffuse field Displays the green diffuse colour value. Editable.

Blue Diffuse field Displays the blue diffuse colour value. Editable.

Diffuse colour pot Displays the diffuse colour. Editable.

NOTE Diffuse lighting modifies the colour and illumination of the entire 3D model. Diffuse light mixes with the
colour of the light sources used to illuminate the 3D model. The diffuse colour may also mix with the ambient
colour and the colour of the specular highlight.
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Surface Settings

Transparency field Displays the transparency level of the 3D model. Editable.

Shine field Displays the intensity value of the specular highlight. When this value is zero, the specular
highlight is disabled. Shine affects both size and intensity. Editable.

See Creating a Specular Highlight on a Model (page 466).

Displacement Mapping

Use displacement mapping to create a 3D model from a 2D surface. The values of a selected colour channel
in the displacement source clip are used to create a displacement map. Displacement mapping uses the
media’s matte clip, so you can turn the matte on or off to get the desired effect.

You have the choice of applying hardware or software displacement mapping. Hardware displacement
mapping is GPU-accelerated and allows you to create a normal map if none exists. Software displacement
mapping displaces the pixels of the surface along the positive or negative X, Y, and/or Z axes. Hardware
Displacement is faster than software displacement, especially when using low resolution values in an image
surface (high polygon count).

NOTE If the Displace node is attached to an imported 3D Geometry, you may need to select a UV Mapping mode
other than Default in the Geometry menu for the displace pattern to have an effect on the geometry. See  UV
Map Settings (page 463).

To add a displacement map:

1 In the schematic, select the surface or 3D geometry to which you want to apply the displacement.

2 Click Media.

3 In the Media menu, select the media you want to use for the displacement.

4 Do one of the following:
■ Drag the Displace Map node from the node bin and place it in the schematic.

■ Drag the Displace Map node from the node bin and place it where you want it in Result view.

■ Double-click the Displace Map node. You do not need to be in Schematic view to add a node in
this manner.

The displace object is added to the schematic with its own parent axis. The new axis is the child of the
selected surface or geometry. In Schematic view, the number in brackets next to the name of the
displace node indicates the media used for the displacement.
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To specify different media as the displacement source, select the media in the Media menu, then click
Apply.

5 Double-click the Displace node in the schematic, or follow the tab population rules for the Object
menu (see Populating Menu Tabs of Selected Objects (page 344)).

The Displacement menu appears. You can choose between Hardware Displacement or Software
Displacement using the Displacement Type box.

Software Displacement Menu Settings

Displacement Type box Select whether to use hardware or software displacement mapping.

Regen button Enable to dynamically refresh the image as changes are made to the menu settings.

The Software Displacement menu is divided into two tabbed sections: Controls and Texture.
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Controls Tab

Channel box Select a colour channel to calculate the displacement map.

Softness field Displays the level of rounding off, or softening of the spikes that result from colour values in
the image that vary from pixel to pixel in the displacement map. Editable.

Softness rounds the edges of the displacement. The larger the softness, the smoother the displacement.
Softness also affects rendering; the larger the softness, the longer it takes to render.

Displace Direction box Select the direction in which a displace occurs when a displacement map is attached
to a surface. Geometries parented to a displacement map always use Normal Displace as the direction.

To Displace:Select:

In the X, Y, and Z directions.Flat Displace

Bilinear and bicubic surfaces according to their normals.Normal Displace

In the direction of the camera selected in the Displace Camera box.Camera Displace

Offset field Displays the offset to the displacement of X and Y. Editable.

Displace Camera box Active only when Camera Displace is selected in the Displace Direction box. Select
which camera to take into account when using camera displacement.

Displace Camera field Displays the active displace camera number. Non-editable.

Displacement X field Displays the amount of displacement in pixel units along the X axis. Editable.

Displacement Y field Displays the amount of displacement in pixel units along the Y axis. Editable.

Displacement Z field Displays the amount of displacement in pixel units along the Z axis. Editable.
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Texture Tab

Repeat mode box Select how the map pattern is repeated on the surface.

Fit Method box Select a fit method option to be applied to the map.

Hardware Displacement Menu Settings

Displacement Type box Select whether to use hardware or software displacement mapping.

Regen button Enable to dynamically refresh the image as changes are made to the menu settings.

The Hardware Displacement menu is divided into two tabbed sections: Controls and Texture.

Controls Tab

Channel box Select a colour channel to calculate the displacement map.

Softness X field Displays the amount of X-axis blur applied to the map. Editable.

Softness Y field Displays the amount of Y-axis blur applied to the map. Editable.

Displace Direction box Select the direction in which a displace occurs when a displacement map is attached
to a surface. Geometries parented to a displacement map always use Normal Displace as the direction.

To Displace:Select:

In the X, Y, and Z directions.Flat Displace
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To Displace:Select:

Bilinear and bicubic surfaces according to their normals.Normal Displace

In the direction of the camera selected in the Displace Camera box.Camera Displace

Bias field Displays the distance between the real surface of the object and the perceptual ground (zero level)
of the texture. Editable.

Attenuate field Displays the level of amplitude of the effect caused by the displacement map texture. Editable.

Displace Camera box Active only when Camera Displace is selected in the Displace Direction box. Select
which camera to take into account when using camera displacement.

Displace Camera field Displays the active displace camera number. Non-editable.

Displacement X field Displays the amount of displacement in pixel units along the X axis. Editable.

Displacement Y field Displays the amount of displacement in pixel units along the Y axis. Editable.

Displacement Z field Displays the amount of displacement in pixel units along the Z axis. Editable.

Bump Normals button Enable to allow the map to create a normal map for enhanced lighting effects. Used
only if no normal map exists for the object using the displacement texture. The availability of this setting
is dependant on your graphics card.

Depth field Displays the amount of Z scale applied to the generated normals. Higher values attenuate the
effect toward the normals of the parent surface. Editable.

Texture Tab

Repeat mode box Select how the map pattern is repeated on the surface.

Fit Method box Select a fit method option to be applied to the map.

Keep Aspect button Enable to preserve the aspect ratio of non-square pixels (not available for the Fill fit
method).

Use Cropped Size button Enable to replace the map with the cropped size of the media. Disable to use the
cropped media as is.

Mapping box Select the type of texture mapping.
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Camera box Specify which camera's FOV to take into account when using perspective mapping.

Camera field Displays the active perspective camera number.

Filter box Select the type of filtering to apply to the map.

Camera Type box Select the camera type visibility for the map.

Diffuse Mapping

Use a diffuse map to define the diffuse reflection and main colour of a surface, 3D model, or 3D text. Since
the diffuse map and its axis are parented by the surface or geometry node, animating the parent’s axis also
animates the diffuse map, which has the effect of keeping the map properly in place on the model. A diffuse
map uses the specular highlight, diffuse colour, and shine set by its parent.

When adding a diffuse map to a shaded surface, the diffuse is used when generating the shadow. The diffuse
is only used to apply the colour to the shadow, so effects such as surface displacement still reference the
media associated with the surface. If a node has an applied diffuse map, it is the matte setting of the diffuse
map that controls whether the object will be included in the various output mattes (scene matte, blend
matte, for example).

To add a diffuse map:

1 In the schematic, select the surface, 3D model, or 3D text to which you want to apply the diffuse map.

2 Click Media.

3 In the Media menu, select the media you want to use for the diffuse map texture (you can change this
texture later).

A diffuse map uses the front and matte of the media. If you do not want to apply transparency to your
diffuse map, turn its matte off.

4 Do one of the following:
■ Drag the Diffuse Map node from the node bin and place it in the schematic.

■ Drag the Diffuse Map node from the node bin and place it where you want it in Result view.

■ Double-click the Diffuse Map node. You do not need to be in Schematic view to add a node in this
manner.

The diffuse object is added to the schematic with its own parent axis. The new axis is the child of the
selected surface or geometry. In Schematic view, the number in brackets next to the name of the Diffuse
node indicates the media used for the diffuse.
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To specify different media as the diffuse source, select the media in the Media menu, then click Apply.
Alternately, you can load an external texture directly from the Diffuse menu.

5 In the Rendering section of the Action Setup menu, enable or disable Shading depending on the method
of diffuse mapping you are using. When Shading is enabled, normals are used. You must enable Shading
when using Reflection mapping because it also uses normals.

6 Double-click the Diffuse node in the schematic, or follow the tab population rules for the Object menu
(see Populating Menu Tabs of Selected Objects (page 344)).

The Diffuse menu appears.

Diffuse Menu Settings

The Diffuse menu is divided into two tabbed sections: Controls and Texture.
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Controls Tab

Effect field Displays the amount of diffuse colour. Editable.

Softness X field Displays the amount of X-axis blur applied to the diffuse map. Editable.

Softness Y field Displays the amount of Y-axis blur applied to the diffuse map. Editable.

Regen button Enable to dynamically refresh the image as changes are made to the settings.

Texture Tab

Repeat Mode box Select how the map pattern is repeated on the surface.

Fit Method box Select a fit method option to be applied to the diffuse map.

Keep Aspect button Enable to preserve the aspect ratio of non-square pixels (not available for the Fill fit
method).

Use Cropped Size button Enable to replace the diffuse map with the cropped size of the diffuse media.
Disable to use the cropped diffuse media as is.

Mapping box Select the type of texture mapping.

Wrap (Geom UVs) Wrap mapping completely envelops the 3D model with the diffuse map according to the object’s diffuse

coordinates. To use this option, you must import a model that has its own diffuse coordinates. When using Wrap mode, you

can also apply UV mapping settings from the Geometry menu. See  UV Map Settings (page 463).
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Plane Planar mapping applies the diffuse map without distorting the front plane of the 3D model, similar to a movie pro-

jector casting an image onto a screen. All 3D coordinates of the geometry are mapped to this plane to generate the diffuse

values. Planar mapping positions the lower-left corner of the diffuse map on the 3D model’s axis. When you apply planar

mapping, any surfaces on the 3D model perpendicular to the front plane cause the pixels at the edge of the texture to project

along the “sides” of the object.

Perspective Perspective mapping is similar to planar mapping, except that it performs a perspective transformation of the

diffuse map based on the selected camera’s field of view (FOV). When you select Perspective as the mapping type, the Per-

spective Camera box becomes active, allowing you to specify the active camera. The FOV of the camera has an impact on

the resulting effect of any transform applied to the parent axis of the texture. On stereo cameras, the interaxial distance

between left and right cameras also has an effect on the resulting perspective transform.

Projection The texture behaves as if it is projected by the selected camera. Projection mapping is useful as an alternative

to projecting textures using the Projector node, especially when it is necessary to project while preserving a specific camera

POV.

Camera box Specify which camera's FOV to take into account when using perspective or projection mapping.

Camera field Displays the active perspective or projection camera number. Non-editable.

Stereo Camera Projection box Select whether to use the centre, left, or right camera from a stereo camera
rig when projection mapping.

Filter box Select the type of filtering to apply to the diffuse map.

To apply:Select:

No filtering — the pixel of the texture closest to the screen pixel is displayed.Nearest

Basic bilinear filtering.Linear

Non-proportional filtering between X and Y (faster to process than EWA, but with

a lesser quality).

Anisotropic

A combination of Anisotropic and Linear filtering.Aniso+Linear
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To apply:Select:

A high-quality elliptical weighted average filter to produce enhanced rendering

results (slower to process than other filters).

EWA

A combination of EWA and Linear filtering (offers the most advanced filter pro-

cessing).

EWA+Linear

TIP You can set the default filtering type in the Action Setup menu Preferences tab.

Camera Type box Select the camera type visibility for the map. For example, you can use this setting to
apply a Left Eye and Right Eye camera type for two maps that are children of the same surface or geometry
in a stereo scene.

Texture Name field Displays the name of an externally loaded diffuse map texture. Non-editable.

Load Texture button Click to open the Import Media browser to select an external single-frame image file
to be used as the diffuse map texture. This file is not added to the Media list.

NOTE When a diffuse map is connected to a flat surface, you can enable Auto Expand in the Surface menu to
automatically resize the surface when the diffuse map’s Axis settings are changed.

Reflection Mapping

Reflection mapping simulates a mirrored surface by using the specular reflection values in the map. You
have the option of combining the result of a reflection map to a diffuse map.

To add a reflection map:

1 In the schematic, select the surface, 3D model, or 3D text to which you want to apply the diffuse map.

2 Click Media.

3 In the Media menu, select the media you want to use for the diffuse map.

4 Do one of the following:
■ Drag the Reflection Map node from the node bin and place it in the schematic.

■ Drag the Reflection Map node from the node bin and place it where you want it in Result view.

■ Double-click the Reflection Map node. You do not need to be in Schematic view to add a node in
this manner.

The reflection object is added to the schematic with its own parent axis. The new axis is the child of
the selected surface or geometry. In Schematic view, the number in brackets next to the name of the
Reflection node indicates the media used for the diffuse.
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To specify different media as the reflection source, select the media in the Media menu, then click
Apply.

5 Double-click the Reflection node in the schematic, or follow the tab population rules for the Object
menu (see Populating Menu Tabs of Selected Objects (page 344)).

The Reflection menu appears.

Reflection Menu Settings

The Reflection menu is divided into two tabbed sections: Controls and Texture.

Controls Tab
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Effect field Displays the amount of diffuse colour. Editable.

Softness X field Displays the amount of X-axis blur applied to the diffuse map. Editable.

Softness Y field Displays the amount of Y-axis blur applied to the diffuse map. Editable.

Regen button Enable to dynamically refresh the image as changes are made to the settings.

Texture Tab

(a) Repeat Mode box (b) Add/Replace box (c) Camera Type box

Repeat Mode box Select how the map pattern is repeated on the surface.

Add/Replace box Select whether to add or replace the reflection map to the diffuse colour.

Camera Type box Select the camera type visibility for the map. For example, you can use this setting to
apply a Left Eye and Right Eye camera type for two maps that are children of the same surface or geometry
in a stereo scene.

About 3D Paths
A 3D path is an animatable 3D spline that you attach to other Action objects, such as surfaces, geometries,
3d text, cameras, or lights. The attached objects then follow the spline based on the path normals, allowing
you to create effects, such as a 3D roller coaster.

Adding a 3D Path Node

When you add a 3D Path node to your Action schematic, the node is added with an axis.

To add a 3D Path node to the scene:

1 Do one of the following:
■ Drag the 3D Path node from the node bin and place it in the schematic.

■ Drag the 3D Path node from the node bin and place it in Result view.

■ Double-click the 3D Path node. You do not need to be in Schematic view to add a node in this
manner.

A Path object (called path1, by default), with its parent axis, appears in the schematic.

2 Create mode is automatically selected in the Edit Mode box so you can create your spline. See Creating
Splines (page 509).

3 Parent the 3D Path node to another object in your schematic, such as a Light node or a 3D Text node.
The 3D path becomes part of the transformation hierarchy of the attached object.
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3D Path node parented to a 3D Text node

4 To open the 3D Path menu, double-click the 3D Path node in the schematic, or follow the tab population
rules for the Object menu.

See Populating Menu Tabs of Selected Objects (page 344).

Creating Splines

You can draw open or closed splines to use as your 3D path.

To create a spline:

1 Make sure that the Edit Mode box is in Create mode (this is the default when you first add a 3D Path
node).

2 In the image window, click to add vertices.

TIP Shift-drag to add freehand segments to the spline. Vertices are added where you drag, and appear
when you release Shift. After closing or finishing the spline, you can use the Lasso Fit field to increase or
decrease the number of vertices that define the freehand segments of the spline.

3 To complete your spline, do one of the following:
■ Click the first vertex to close the spline.

■ Click Finish in the 3D Path tab to leave the spline open. If you decide later that you want to close
the spline, enable Closed in the 3D Text tab.

4 Make sure that the Edit Mode box is in Move mode, so that you do not add more vertices by mistake.

When the spline is closed or finished, its vertices and tangents can then be edited.
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Editing Splines

Use the settings in the 3D Path tab to work with the spline you created. You edit splines in the same way
as you edit garbage masks, working with their vertices and tangents. See Manipulating Vertices and Tangents
(page 633).

Finish button Click to finish an open spline.

Closed button Enable to close a spline from the last to first point.

Motion Blur button Enable to use a motion blur effect for the selected path (can only be used if the global
Motion Blur is enabled in the Action Setup menu).

Constant Shape button Enable to modify the spline's shape without setting keyframes. This forces all
animatable parameters to be set for the whole clip rather than for only the current frame. It also removes
any existing keyframes and applies the shape of the current frame to the rest of the clip.

Lasso Fit field Displays the number of points in the segments of the spline that are drawn freehand. Use a
lower number to simplify the curve by removing vertices and tangents, resulting in a smoother curve.
Editable.

X Vertex field Displays the position of the selected vertices on the X axis. Editable.

Y Vertex field Displays the position of the selected vertices on the Y axis. Editable.

Z Vertex field Displays the position of the selected vertices on the Z axis. Editable.

Auto Tangents button Enable to position a tangent for each vertex set, to create a smooth curve between
the vertices. When enabled, it is possible to create a spline with both straight and curved segments.

When Auto Tangents is disabled, the tangents are positioned under the vertex, resulting in straight lines
between vertices. When you draw freehand segments in a spline with Auto Tangents off, vertices are added
with broken tangents, allowing the spline to follow your cursor movement.

Auto Adjust button Enable to automatically adjust the tangent handles of the two adjacent vertices when
moving vertices, to create smooth curves between the vertices.
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Changing Spline Display Properties

You can change spline display properties in the Display tab. For example, you can change the colour of
tangents on the splines you draw. This is useful to better contrast the spline’s tangents from the clip so that
they are easier to work with.

Normals button Enable to display normals along the 3D path.

Normals colour pot Displays the normals colour. Editable.

Spacing field Displays the space between the displayed normals, in pixels. Also used to calculate the position
of the object on the path. A lower value may result in better positioning and smoother movement of the
object, but rendering may be slower. Editable.

Scale field Displays the scale of the displayed normals, in pixels. Editable.

Spline colour pot Displays the colour for the display of splines. Editable.

Tangents colour pot Displays the colour for the display of tangents. Editable.

Positioning Objects on the Path

Use the Position On Path settings in the 3D Path or Banking tabs to offset the position of attached objects
along the path and beyond. For open paths, if you offset past the first or last points on the path, the position
is extrapolated accordingly. For closed paths, if you offset past the first or last points on the path, the attached
object continues on the path with a tangent interpolated from the first and last normals.

Offset field Displays the amount of offset to apply to the object on the 3D path. Use to animate the attached
object along the path. Editable.

Offset box Select whether to offset the object from the path in a relative (expressed as a percentage of the
path) or absolute mode (expressed in pixels).

NOTE These settings are repeated in the 3D Path and Banking tabs to make it easier for you not to have to switch
tabs to change the settings. The same settings are reflected in both tabs.
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Aligning Objects on the Path

Use the Alignment to Path section of the 3D Path tab to set orientation behaviour.

(a) Alignment option box (b) Point Axis box(a) Alignment option box (b) Orientation Axis box

Alignment option box Select how the object connected to the 3D Path node aligns to the path.

Example:To:Select:

Not align the attached object to the path. In this

case, the Orientation Axis box and banking controls

are unavailable. This can be useful for vertical text

effects.

Align Off

Align the attached object to the 3D path. You can

then select which axis is aligned to the path in the

Orientation Axis box, and use the banking controls.

Align to Path

Point the attached object to a look-at object, such

as a light. You can then select which axis is pointed

to the look-at object in the Point Axis box, and use

the banking controls. See Applying a Look-At

Connection (page 512).

Look At

Orientation Axis box Select which axis is aligned to the path. Available when Align to Path is selected in
the Alignment option box.

Point Axis box Select which axis is pointed to the attached look-at object. Available when Look At is selected
in the Alignment option box.

Applying a Look-At Connection

You can create interesting 3D path effects by attaching a look-at connection between the path and another
object in your scene. The attached object on the path then rotates to face the look-at object, no matter where
it is positioned. You attach a look-at connection in the schematic between the 3D Path node and any object
with axis characteristics (Axis, Camera, Light).
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To apply a look-at connection:

1 Do one of the following:
■ Select Look At in the Alignment option box.

■ Select Lookat in the Edit Mode box.

2 In the schematic, drag from the 3D Path node to an object with axis characteristics.

The selected object is connected to the 3D Path node by an orange dotted line with an arrow.

(a) Look-at connection

3 Select which axis looks at the attached object in the Point Axis box.

4 Optional: Use the banking curve to orient the attached objects.

Using the Banking Curve

When Align to Path or Look At is selected in the Alignment option box, the Banking tab becomes available.
Banking uses the normals of the path to orient objects attached to it. Use the banking curve and settings to
control the torsion effect of the object as it travels along the 3D path.
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The Position on Path settings are the same as those in the 3D Path tab. See  Positioning Objects on the Path
(page 511).

Banking Curve Adds twists and torsion to the normals of the 3D path. Use the options in the Edit Mode
box to add, select, delete, or move keyframes on the Banking curve. The horizontal axis represents the length
of the path, and the vertical axis displays the orientation, expressed in degrees.

Normals Offset Angle field Displays the angle of rotation of all normals, applied to the entire banking
curve. Editable.

NOTE Changes made to the banking curve and Angle field are cumulative.

Regen button Enable to dynamically refresh the image as changes are made to the banking curve.

Home button Resets the Banking curve viewer to show the whole curve.

Undo button Undoes Banking curve operations.

Set Key button Sets the current values for the banking curve in the current frame (when Auto Key is disabled).

Del Key button Deletes the selected banking curve keyframes.

Reset Selection box Select whether to reset all of the banking settings (Reset All) or just the banking curve
(Reset Key).

Interpolation box Select the default interpolation type for the Banking curve.

Extrapolation box Select the default extrapolation type for the Banking curve.

About the Camera
The scene is what you see through the camera lens. Typically, you work with the camera to frame and
animate the view to achieve the effect you want. In Action, you have the choice of using the automatic
camera or the manual camera, whose F-Stop, film size, and focal length you can set yourself. You can also
animate specific camera properties.

Adding a Camera

By default, a camera exists in the Action scene (you may need to pan in the schematic to see the camera
node). You can add multiple cameras in order to change point of view or depth of field from one camera to
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another. Add and animate multiple cameras when creating compositions. You can also switch from one
camera to another at any point.

To add a camera:

1 Do one of the following:
■ Drag the camera node from the node bin and place it in the schematic.

■ Drag the camera node from the node bin to Result view, so you can see its effect on the scene before
placing it exactly where you want.

■ Double-click the camera node. The node appears next to the last added object. You do not need to
be in Schematic view to add a node in this manner.

A new camera is added to the scene. An icon representing the camera is added to the schematic.

2 To display the Camera menu, double-click the selected camera in the schematic, or follow the tab
population rules for the Object menu. See Populating Menu Tabs of Selected Objects (page 344).

The result camera always appears as the first tab on the right side of the Object menu. To allow you
to easily access the camera without losing your place in the scene, this special camera tab (appearing
in orange) does not follow the tab population rules. If a camera node is selected in the schematic, the
special Camera tab does not appear, and the normal tab population rules apply.
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Camera Menu Settings

X Eye field Displays the position of the camera eye on the X axis. Editable

Y Eye field Displays the position of the camera eye on the Y axis. Editable

Z Eye field Displays the position of the camera eye on the Z axis. Editable

Motion Path button Enable to animate the camera eye on a motion path. See Moving the Camera Eye and
Point of Interest (page 518).

X Point of Interest field Displays the position of the point of interest on the X axis. Editable.

Y Point of Interest field Displays the position of the point of interest on the Y axis. Editable.

Z Point of Interest field Displays the position of the point of interest on the Z axis. Editable.

X Rotation field Displays the level of camera rotation along the X axis. Editable.

Y Rotation field Displays the level of camera rotation along the Y axis. Editable.

Z Rotation field Displays the level of camera rotation along the Z axis. Editable.

Camera Type box Select Free (to view the scene in the direction that you aim the camera), or Target (to
aim the camera at a target object in the scene based on a point of interest).

Free cameras are easy to use because you do not have to manipulate the point of interest. You can simply
animate the camera rotation or camera tilt as though it were on a tripod. Use the Distance field in conjunction
with Free Camera.

Roll field Displays the amount of camera roll (available with Target Camera). Editable.

Use the Roll field in conjunction with Target Camera.

Field of View field Displays the camera field of view value, measured in degrees. Editable.

Distance field Displays the position of the camera's focus. Editable.

Near field Displays the near view of the selected camera. Editable.

Far field Displays the far view of the selected camera. Editable.

See Moving the Clipping Planes (page 518).

Export Camera button Opens the Export Camera file browser to save a camera.
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Exported data includes Eye X, Y, and Z; Poi X, Y, and Z; Fov; Roll, Target or Free Camera; motion path and
explicit keyframe camera animation. See  Importing and Exporting Cameras  (page 519).

Import Camera button Opens the Import Camera file browser to import a camera. See  Importing and Ex-
porting Cameras  (page 519).

Result Camera box Specify which camera is active. The active camera is the one that will be used when
processing/rendering your scene.

Result Camera field Displays the active camera number. Non-editable.

Reset Camera button Resets the Camera menu to its default settings.

Camera box Not shown. When in Camera view, select which camera is used in the image window.

Parenting Offset box Not shown (Found in the Param2 tab). Select an offset option for viewing an image
when parenting a camera node. When parenting a camera node, the image offset gets reset to the camera
origin, which is not always the desired viewing option. Origin sets the image to the camera origin; Target
sets the image to the default viewplane distance relative to the camera; and Live Target sets the image to
the current viewplane distance based on the FOV. The offset value is computed from the default camera
field of view and the default image size, and does not change even if other camera parameters are changed.
This value is displayed in the Parenting Offset field.

About the Frustum

The volume of space viewed by the camera eye is called the frustum. The frustum is in effect a viewing
pyramid. The camera eye is located at the apex of the pyramid, and the far clipping plane forms the base.
The pyramid may be truncated by the near clipping plane.

(a) Camera eye (b) Near clipping plane (c) Far clipping plane (d) Camera interest point or look-at point

If you place a surface within the frustum, it is visible in the final animation. If the surface is located outside
the scope of the frustum, it is not visible at that frame in the animation.

Viewing the Camera and Frustum

To see the camera and frustum:

1 From the View box, select Side.
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2 In the image window controls, click  to zoom out from the scene.

3 Select Pan in the Edit Mode box and pan around the scene until you see the camera eye icon.
Alternatively, use Orbit mode to pan around the scene in circular motion.

4 Go to the Camera menu and drag the Roll field until you see the four sides of the frustum.

5 To modify the frustum, do one of the following:
■ Change the position of the near clipping planes to alter the depth of the frustum. See Moving the

Clipping Planes (page 518).

■ Change the position of either the camera eye or the camera's point of interest to alter the orientation
of the frustum. See Moving the Camera Eye and Point of Interest (page 518).

■ Enter a value in the FOV (field of view) field to adjust the width of the camera frustum.

Moving the Clipping Planes

The camera frustum is determined by six clipping planes: the left, right, top, bottom, near, and far clipping
planes. The depth of the frustum is affected by the near and far clipping planes. The values for these channels
are expressed in units relative to the position of the camera eye.

To move the clipping planes:

1 From the View box, select Side, Front or Top depending on how your camera is positioned. Ideally,
you will want a view that profiles the camera so the near and far planes are visible.

2 In the Camera menu, enter a value in the Near field to edit the near clipping plane's position.

The value in the Near field corresponds to the position of the near clipping plane. The default value
is 1. Any object between the camera eye and the near clipping plane is outside the camera frustum and
does not get processed in the final result.

3 Enter a value in the Far field to edit the far clipping plane's position.

The value in the Far field corresponds to the position of the far clipping plane. The default value is
10000. Any object positioned behind the far clipping plane is outside the camera frustum and does
not get processed in the final result.

4 Narrow or widen the frustum by modifying the camera's FOV (field of view). Increasing the FOV narrows
the frustum and field of view. Decreasing the value widens the frustum and field of view.

Moving the Camera Eye and Point of Interest

Objects in the scene can be recorded from an arbitrary position as determined by the orientation of the
camera eye in world space.

To change the position of the camera eye:

1 In the Camera menu, modify the Eye X, Y, and Z fields.

You can also animate the camera eye on a motion path. Enable the Motion Path button and drag the camera
icon while viewing the scene in Top, Side, or Front view.

NOTE You can only animate the point of interest with a Target Camera.

The camera point of interest is the point in world space at which the camera eye is directed. The point of
interest is always at the centre of the camera's frustum. Changing the position of the point of interest causes
the orientation of the frustum to change. You can take advantage of the relationship between the point of
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interest and the frustum to make the camera follow a moving object. To do this, animate the point of interest
while keeping the camera eye in a fixed position.

To change the point of interest:

1 In the Camera menu, do one of the following:
■ Modify the Interest X, Y, and Z fields.

■ Move the point of interest by dragging while viewing the scene in Top, Side, or Front view.

TIP You can animate the point of interest using a motion path by enabling the Motion Path button.

Importing and Exporting Cameras

You can either import a camera you created and edited in Action, or import one from another 3D application.
Once a camera is imported, you can edit its parameters, change its animation, and then export it back to
the application it came from.

FBX Cameras

Smoke supports the import and export of 3D data saved in the FBX 3D format. This format provides a means
for exchanging 3D data for scene compositions—such as cameras—between tools and packages developed
by different manufacturers.

To export a camera to FBX format:

1 Select the camera you want to export.

2 In the Camera menu, click Export.

The Export Camera file browser appears.

3 From the Export Type box, select FBX.
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4 Select which elements of the FBX files you wish to export by clicking the corresponding filter button.

To:Enable:

Rotate the exported camera by -90° on the X-axis so that it is compatible with the co-
ordinate system of the 3D application.

Rotate Axis

Export the animated axes present in the Action scene.Export Axes

Export the 3D point cloud created by the 3D Tracker.Export Point Cloud

5 Navigate to the location where you want to export the camera animation.

6 Enter a name for your exported camera in the file field.

7 Click Save.

3ds Max Cameras

An alternative to animating a camera's position is to import a camera animation from 3ds Max. 3ds Max
camera animation can be saved as a . 3DS or .ase (ASCII Scene Export) file in your scene. While the .ase
format contains only a camera's positional data, the .3DS format contains the camera's position, point of
interest, roll and field of view values.

Once the camera is imported, you can edit any of the camera's values and, if necessary, export it back to 3ds
Max in its native 3DS format using the Camera menu.

(a) Import Camera button (b) Export Camera button
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To import a 3ds Max camera:

1 In the Camera menu, click Import.

The Import Camera file browser appears.

2 From the Import Type box, select either the .3DS or .ase format.

3 If needed, enable Rotate Axis to rotate the imported camera by 90° on the X-axis so that it is compatible
with Action's coordinate system.

4 Navigate to the location where a 3ds Max camera setup was exported, and select the file.

You return to Action and the imported camera is applied to your scene.

To export a camera to 3ds Max format:

1 Select the camera you want to export.

2 In the Camera menu, click Export.

The Export Camera file browser appears.

3 From the Export Type box, select 3DS.
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4 If needed, enable Rotate Axis to rotate the exported camera by -90° on the X-axis so that it is compatible
with the coordinate system of the 3D application.

5 Navigate to the location where you want to export the camera animation.

6 Enter a name for your exported camera in the file field.

7 Click Save.

NOTE When exporting from Smoke, save the .3DS file in a directory that is readable by a 3ds Max system.

Camera and Orthographic Views

You can view the scene from various angles and display multiple views of these angles simultaneously. This
is helpful in setting motion paths, light sources, camera angles, and animation keyframes more accurately.

You can view the scene from Camera view and three orthographic views. In Camera view, an object becomes
smaller as it moves farther away from the camera. In orthographic view, an object remains the same size,
regardless of its distance from the camera. Orthographic views are more helpful for aligning objects.

The following figures illustrate the different angles by which the scene can be viewed. The scene in this
example contains a grey back clip and the 3D model of an apple.

Camera viewFront view
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Top viewSide view

Setting the Camera and Orthographic Views

To set camera and orthographic views:

1 From the View box, select Camera or an orthographic view. When in Camera view, use the Camera
box that appears to select which camera is used in the image window.

(a) View box (b) Camera box

To:Select:

View the scene in Camera view. This is the scene as viewed by the camera eye. In other
words, your field of vision in world space is equivalent to the viewing frustum of the camera.
The size of objects depends on their distance from the camera eye.

Camera

View the scene as if you are positioned on the positive Y-axis. This is an orthographic view;
there is no perspective deformation.

Top

View the scene from the side, as if you are positioned on the positive X-axis. This is an or-
thographic view; there is no perspective deformation.

Side

View the scene as if your line of vision is directed into the camera eye. This is an orthographic
view; there is no perspective deformation.

Front
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2 If you have multiple cameras in the scene, use the Camera box to define which camera is used for the
Camera view in the image window. The camera selected in this box is not necessarily the camera used
to process the scene.

3 Adjust the view with the Ortho Views controls, if needed.

When using an orthographic view, you may notice that parts of the object you are viewing are getting
cut off. Adjust the near and far ortho views. You gain more space to view the object, but lose some
viewing precision.

In the Display section of the Action Setup menu , adjust the Near and Far fields.

(a) Ortho Views in Setup menu

NOTE The Ortho Views parameters in the Action Setup menu are only for viewing objects, and cannot be
animated or saved. The Near and Far fields in the Camera menu are used to set clipping planes. See Moving
the Clipping Planes (page 518).

In addition to Camera and the three orthographic views, you can also select Schematic view, which uses
nodes to represent the objects in the scene and arrows to illustrate the relationships between objects.

Modifying the Camera

You can gesturally modify the camera directly in the scene using options in the Edit Mode box. A mode
remains in effect until you select a different mode.

To gesturally modify the camera:

1 Make a selection in the Edit Mode box.

To:Select:

Move the camera lens and look-at point.Track

Tilt the camera up and down by moving the look-at point. Also changes the camera
roll. This option only modifies Target cameras.

Tilt
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To:Select:

Rotate the camera on the Z-axis. This option only modifies Target cameras.Roll

Rotate the camera lens around the look-at point.Orbit

Move the camera field of view.FOV

Move the camera lens towards (zoom in) or away from (zoom out) the look-at point.Dolly

Move the camera left and right by moving the look-at point. Also changes the camera
roll, when not 0.00.

Pan

2 Drag the cursor in the image window.

The camera is modified. Related Camera menu controls are updated to reflect the changes.

Zooming In and Out

Use the Zoom option to move the camera eye toward or away from the point of interest. While viewing the
scene in Camera view, zoom in or out from the point of interest to move the camera eye closer to or farther
from the point of interest. In Top, Side, or Front view, you can enlarge or reduce the scene in the image
window without affecting the camera. Zooming has no effect in Schematic view.

To zoom the camera:

1 From the Edit Mode box, select Zoom.

2 Place the cursor in the image window.

The cursor changes to a magnifying glass.

3 To zoom in, drag the cursor to the left. To zoom out, drag the cursor to the right.

About Motion Blur

Use the Motion Blur tool to simulate the blur created by fast-moving objects. You can apply motion blur
globally (to the entire scene) and then exclude objects in the scene from its effect.

To use motion blur, enable the Motion Blur button in the Action Setup menu and specify motion blur
settings.
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You can animate the Motion blur button, as well as the Phase, Shutter, and Samples fields. They can be
found in the Channel Editor under the motion_blur folder.

See Accumulation Settings in Rendering Tab (page 352).

Blurring a Single Object

You can apply motion blur to an object rather than to the entire scene. To use the per object motion blur,
you must apply Motion Blur globally, and then disable motion blur per object.

NOTE The motion blur curve in the Action Setup menu is global. It cannot be set per node. When motion blur is
enabled, all surfaces have the same blur characteristics but not necessarily the same animation.

To blur a single object:

1 Enable Motion Blur in the Action Setup menu.

This activates a global motion blur applied to everything within the scene.

2 Disable motion blur per object (for example, in the surface, axis or light menu) to exclude objects from
the global motion blur.

Creating Custom Motion Blurs

The motion blur curve controls the sample weight over the scope of the motion blur. The point on the left
is the weight of the first sample and the point on the right is the weight of the last sample. By changing the
curve, you can create custom motion blur effects such as a Gaussian blur.
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As with the Channel Editor, you can add keyframes to the motion blur curve using Add mode, move keyframes
with Move mode, and modify the curve's shape using tangent handles.

The original animation with Motion Blur disabled.

Motion Blur is enabled using a custom motion blur curve
and phase set to 100.

Motion Blur is enabled using the same motion blur curve
as above. Phase is set to -100.

TIP You can preview your motion blur effect by clicking Preview. This will display the rendered frame at the current
frame in the timebar.
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Simulating Motion Blur on a Still Object

You can add motion blur to an object that has no axis movement, by adding a second axis to simulate the
motion.

To simulate motion blur on a still object:

1 From the View box, select Schematic.

2 From the Node bin, drag an Axis node to the schematic.

3 Press Shift and drag the original Axis node over the new Axis node.

New axis as child of original axisNew axis addedStill object with Axis

Image courtesy of Das Werk

4 Enable Motion Blur and animate the new axis with the desired motion.

About the 3D Camera
The 3D camera is a full-featured animatable camera in Action that allows you to build 3D compositing
scenes, mixing 3D objects and stereo objects.

Typically, you work with the 3D camera to frame and animate the view to achieve the effect that you want.
You can also animate specific camera properties.

Use the 3D camera in Stereo mode to create three-dimensional renders with the illusion of a three-dimensional
depth-of-field. When rendering a stereoscopic scene, Action takes into account all of the stereoscopic camera
attributes. Action outputs two clips: one rendered for the left camera and one for the right camera. These
clips can then be viewed in stereo mode, used in other stereo clips, output to VTR, or composited by another
program.

Adding a 3D Camera

By default, a 3D camera exists in the Action scene when using stereo clips, or when Action has been set up
to work in stereo (you may need to pan in the schematic to see the camera node). You can add multiple 3D
cameras in order to change point-of-view or depth-of-field from one camera to another. You can add and
animate multiple cameras when creating compositions. You can also switch from one camera to another at
any point.
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To add a stereo camera to a scene:

1 Do one of the following:
■ Drag the Camera 3D node from the node bin and place it in the schematic.

■ Drag the Camera 3D node from the node bin and place it where you want it in the Result view.

■ Double-click the Camera 3D node. You do not need to be in Schematic view to add a node in this
manner.

A new 3D camera is added to the scene. An icon representing the camera is added to the schematic.

2 Select the 3D Camera node to make it the active camera in the scene.

3 In the Object menu that appears, set the Result Camera to a numbered camera representing a 3D
camera.

4 In the Output menu, set the Mode to Stereo and set the Camera to Result Cam.

3D Camera Parameters

Basics Tab

(a) Stereo Camera View Type box (b) 3D Camera Type box (c) Camera Type box (d) Rotation Order box

Export FBX Camera button Opens the Export Camera file browser to save an FBX camera.

Stereo Camera View Type box Available when Stereo is selected in the 3D Camera Type box. Select Left,
Right, or Rig (for Stereo Rig).

3D Camera Type box Select whether the 3D camera is stereo or mono.

Camera Type box Select whether the camera is Free, Aim, or Aim and Up.

For:Select:

Static scenes and for simple animations (up, down, side-to-side, in and out), such as panning

out of a scene. A Free camera views the scene in the direction that you aim the camera. You

Free

can simply animate the camera rotation or camera tilt as though it were on a tripod. Use

the Rotation fields in conjunction with a Free camera.
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For:Select:

Slightly more complex animations (along a path, for example), such as a camera that follows

the erratic path of a bird. The Aim camera ensures the camera is specifically aimed at a target

object in the scene. Use the Roll and Aim fields in conjunction with the Aim camera.

Aim

Complex animations, such as a camera that travels along a looping roller coaster. Use the

Aim and Up camera to specify which end of the camera must face upward. Use the Roll,

Aim, and Up fields in conjunction with the Aim and Up camera.

Aim and Up

FOV field Displays the angular field of view value, measured in degrees. Use to adjust the width of the
camera frustum. Editable.

Focal Length field Displays the focal length of the camera lens, measured in millimeters. Increasing zooms
the camera in and increases the size of objects. Decreasing zooms the camera out and decreases the size of
objects. Editable.

Near Clipping Plane field Displays the position of the near clipping plane, in pixels, which represents the
distance from the camera to the closest point within which image details are processed. Editable.

Far Clipping Plane field Displays the position of the far clipping plane, in pixels, which represents the
distance from the camera to the farthest point within which image details are processed. Editable.

See Moving the Near and Far Clipping Planes (page 537).

X Position field Displays the position of the camera, in pixels, on the horizontal (X) axis. Editable.

Y Position field Displays the position of the camera, in pixels, on the vertical (Y) axis. Editable.

Z Position field Displays the position of the camera, in pixels, on the perpendicular (Z) axis. Editable.

Rotation Order box Select the order in which the camera is rotated, on the horizontal, vertical, and
perpendicular (X, Y, and Z) axes.

X Rotation field Displays the level of rotation of the camera on the horizontal (X) axis, in degrees. Active
when Camera Type is set to Free. Editable.

Y Rotation field Displays the level of rotation of the camera on the vertical (Y) axis, in degrees. Active when
Camera Type is set to Free. Editable.

Z Rotation field Displays the level of rotation of the camera on the perpendicular (Z) axis, in degrees. Active
when Camera Type is set to Free. Editable.

X Scale field Displays the scale of the camera on the horizontal (X) axis, as a percentage. Editable.

Y Scale field Displays the scale of the camera on the vertical (Y) axis, as a percentage. Editable.

Z Scale field Displays the scale of the camera on the perpendicular (Z) axis, as a percentage. Editable.

X Shear field Displays the shearing of the camera (diagonal shift) on the horizontal (X) axis, as a percentage.
Editable.

Y Shear field Displays the shearing of the camera (diagonal shift) on the vertical (Y) axis, as a percentage.
Editable.

Z Shear field Displays the shearing of the camera (diagonal shift) on the perpendicular (Z) axis, as a
percentage. Editable.

Result Camera box Specify which camera is active. The active camera is the one that will be used when
processing/rendering your scene.
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Camera Scale field Displays the size of the camera relative to the scene, independently for either Left or
Right camera views. For example, if Camera Scale is set to 0.5, the camera's view covers an area half as large,
but objects in the camera's view are twice as large. If Focal Length is set to 35, the effective focal length for
the camera would be 70. Editable.

Reset button Resets the 3D Camera menu to its default settings.

FBX Unit Scaling field Not shown. This locked field displays the scale factor of the FBX camera used within
the application. Use to help set the Pixels to FBX Units field when exporting an FBX camera. Non-editable.

Aim/Up Tab

When Camera Type is set to Aim or Aim and Up, the available options are enabled in the Aim/Up tab.

3D Camera Type box Select whether the 3D camera is stereo or mono.

Camera Type box Select whether the camera is Free, Aim, or Aim and Up.

For:Select:

Static scenes and for simple animations (up, down, side-to-side, in and out), such as panning

out of a scene. A Free camera views the scene in the direction that you aim the camera. You

Free

can simply animate the camera rotation or camera tilt as though it were on a tripod. Use

the Rotation fields in conjunction with a Free camera.

Slightly more complex animations (along a path, for example), such as a camera that follows

the erratic path of a bird. The Aim camera ensures the camera is specifically aimed at a target

object in the scene. Use the Roll and Aim fields in conjunction with the Aim camera.

Aim

Complex animations, such as a camera that travels along a looping roller coaster. Use the

Aim and Up camera to specify which end of the camera must face upward. Use the Roll,

Aim, and Up fields in conjunction with the Aim and Up camera.

Aim and Up

Parenting Offset box Select an offset option for viewing an image when parenting a camera node. Origin
sets the image to the camera origin; Target sets the image to the default viewplane distance relative to the
camera; and Live Target sets the image to the current viewplane distance based on the FOV.

Parenting Offset field Displays the offset value, as computed from the default camera field of view and the
default image size. This value does not change even if other camera parameters are changed. Non-editable.

X Aim field Displays the position of the aiming target of the camera on the horizontal (X) axis, in pixels.
Editable.
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Y Aim field Displays the position of the aiming target of the camera on the vertical (Y) axis, in pixels.
Editable.

Z Aim field Displays the position of the aiming target of the camera on the perpendicular (Z) axis, in pixels.
Editable.

X Up field Displays the up direction on the horizontal (X) axis, in pixels. Editable.

Y Up field Displays the up direction on the vertical (Y) axis, in pixels. Editable.

Z Up field Displays the up direction on the perpendicular (Z) axis, in pixels. Editable.

Roll field Displays the amount of camera roll, in degrees. A positive value rolls the camera clockwise, where
a negative value rolls it counter-clockwise. Available only with the Aim, and Aim and Up cameras. Editable.

Stereo Tab

Stereo Mode box Select the method for computing the zero parallax plane.

To:Select:

Compute the zero parallax plane by toeing-in the cameras. You can compare this effect

to our focusing on an object by rotating our pupils inwards. However, a dangerous side

Converged

effect may occur where you get a keystone effect on the pairs of render images, causing

visual confusion in other elements in the scene. In a rendered image, our focus tends to

cascade over the entire image and we are not focusing on a single object, which is not

true in real life. You should only use Converged when an object is at the center of the

screen with no scene elements at the render borders on either the left or right camera

frustum.

Compute the convergence plane by shifting the frustum using camera film back. This is

the safer way to compute stereo image pairs and avoids keystone artifacts. Off-axis is the

default setting.

Off-axis

Create a parallel camera setup where there is effectively no convergence plane. This is

useful for landscape settings where objects exist at infinite focus.

Parallel

Interaxial Separation field Displays the distance between the left and right cameras, in pixels. Editable.

Zero Parallax field Displays the distance on the camera view axis, in pixels, where the zero parallax plane
occurs (the point where objects appear off screen). Objects in front of the zero parallax plane have negative
parallax. Objects behind the zero parallax plane have positive parallax. Editable.
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NOTE In general, your object should be behind the zero parallax plane. In other words, the camera distance
should be greater than the zero parallax plane value. The zero parallax value, the camera separation, and focal
length are all used to determine the shift that must be applied to film back on the respective left and right cameras.
The zero parallax distance is enabled only when Stereo Mode is set to Off-Axis or Toe-In.

Zero Parallax Plane button Enable to display the zero parallax plane.

Zero Parallax colour pot Displays the colour used for the zero parallax plane. Editable.

Zero Parallax Transparency field Displays the level of transparency for the zero parallax plane. Editable.

Safe Stereo Viewing Volume button Enable to display the safe viewing volume created by the intersection
of the frustum of the left and right cameras.

Safe Stereo Volume colour pot Displays the colour used for the safe stereo viewing volume. Editable.

Safe Stereo Volume Transparency field Displays the level of transparency for the safe stereo viewing volume.
Editable.

Toe In Adjust field Displays the offset, in degrees, applied to the computed toe-in effect when Stereo Mode
is set to Converged. Editable.

Film Offset Left Cam field Displays the horizontal film offset for the left camera. Editable.

Film Offset Right Cam field Displays the horizontal film offset for the right camera. Editable.

Film Back Tab

(a) Film Gate box (b) Film Roll Rotation Order box

Film Gate box Select a preset film frame format type. This action automatically sets the corresponding
Camera Aperture, Film Aspect Ratio, and Lens Squeeze Ratio. To set these attributes individually, set Film
Gate to User. The default setting is User.

Camera Aperture X field Displays the width of the camera Film Gate setting, measured in inches. This
setting has a direct effect on the camera's angle of view and automatically updates Film Aspect Ratio. Editable.

Camera Aperture Y field Display the height of the camera Film Gate setting, measured in inches. This
setting has a direct effect on the camera's angle of view and automatically updates Film Aspect Ratio. Editable.

Film Aspect Ratio field Displays the ratio of the camera aperture width versus height. Modifying this field
automatically updates the Camera Aperture fields. Editable.
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Lens Squeeze Ratio field Displays the amount horizontal compression that is applied to the image. Used
with some cameras (for example, anamorphic cameras), which compress the image horizontally to record
a wider aspect ratio image onto a square area on film. Editable.

Film Roll Value field Displays the amount of rotation applied to the film back. The rotation occurs around
the specified pivot point. Used to compute a film roll matrix, which is a component of the post-projection
matrix. Editable.

Film Roll Rotation Order box Select how the roll is applied with respect to the pivot value.

To:Enable:

First rotate the film back, then translate it by the pivot point value.Rotate-Translate

First translate the film back, then rotate it by the film roll value.Translate-Rotate

Pre Scale field Displays the artificial 2D camera zoom that is applied before the film roll. Used in 2D effects.
Editable.

Post Scale field Displays the artificial 2D camera zoom that is applied after the film roll. Used in 2D effects.
Editable.

Film Fit Resolution Gate box Select the size of the resolution gate relative to the film gate (Film fit). If the
resolution gate and the film gate have the same aspect ratio, then the Film Fit setting has no effect.

To:Select:

Fit the resolution gate within the film gate.Fill

Fit the resolution gate horizontally within the film gate.Horizontal

Fit the resolution gate vertically within the film gate.Vertical

Fit the film gate within the resolution gate.Overscan

Film Fit Offset field Displays the offsets of the resolution gate relative to the film gate either vertically (if
Film Fit Resolution Gate is Horizontal) or horizontally (if Film Fit Resolution Gate is Vertical). Film Fit Offset
has no effect if Film Fit Resolution Gate is Fill or Overscan. Editable.

Film X Offset field Displays the horizontal offset, in pixels, of the resolution gate and the film gate relative
to the scene. Changing the Film X Offset produces a two-dimensional track. Editable.

Film Y Offset field Displays the vertical offset, in pixels, of the resolution gate and the film gate relative to
the scene. Changing the Film Y Offset produces a two-dimensional track. Editable.

To:Enter:

Have the view guide fill the view. The edges of the view guide may be exactly aligned with
the edges of the view, in which case the view guide is not visible.

1

Increase the space outside the view guide. The higher the value, the more space is outside
the view guide.

> 1

Film X Translate field Displays the artificial 2D horizontal camera pan. Used in 2D effects. Editable.
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Film Y Translate field Displays the artificial 2D vertical camera pan. Used in 2D effects. Editable.

Film Roll X Pivot field Displays the horizontal pivot point from the center of the film back, which is used
during the rotating of the film back. Used to compute the film roll matrix, which is a component of the
post projection matrix. Editable.

Film Roll Y Pivot field Displays the vertical pivot point from the center of the film back, which is used
during the rotating of the film back. Used to compute the film roll matrix, which is a component of the
post projection matrix. Editable.

Working with the Frustum

The volume of space viewed by the camera is called the frustum. The frustum is, in effect, a viewing pyramid.
The camera is located at the apex of the pyramid, and the far clipping plane forms the base. The pyramid
may be truncated by the near clipping plane. The point of interest, or aim, is the target at the center of the
camera’s view.

(a) Camera (b) Near clipping plane (c) Far clipping plane (d) Aiming target

If you place a surface within the frustum, it is visible in the final animation. If the surface is located outside
the scope of the frustum, it is not visible at that frame in the animation.

To see the camera and frustum:

1 From the View box, select Side.

2 In the image window controls, click  to zoom out from the scene.

3 Enable the Pan button, and pan around the scene until you see the camera icon.
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4 From the Camera menu, click the Aim/Up tab.

5 Ensure that Camera Type is set to Aim, or Aim and Up.

6 Drag the Roll field until you see the four sides of the frustum.

7 On the Stereo tab, enable Zero Parallax Plane and Safe Stereo Viewing.

The safe viewable volume of the frustum, and the zero parallax plane area appear and are denoted with
a transparent colour. The aiming target is centered at zero parallax.

8 Change the position of the near and far clipping planes to alter the depth of the frustum. See Moving
the Near and Far Clipping Planes (page 537).

9 Change the position of the camera to alter the orientation of the frustum. See Moving the 3D Camera
(page 537).

10 Change the position of the camera's aim to alter the orientation of the frustum. See Adjusting the Aim
of the 3D Camera (page 538).
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11 Adjust the angle of view to adjust the size of the objects as viewed by the camera. See Adjusting the
Field of View (page 538).

Near and Far Clipping Planes

The camera frustum is determined by six clipping planes: the left, right, top, bottom, near, and far clipping
planes. The depth of the frustum is affected by the near and far. The values for these channels are expressed
in pixels relative to the position of the camera.

Set the Near and Far clipping planes to the lowest and highest respective values that produce the desired
result. If the distance between the near and far clipping planes is much larger than is required to contain
all the objects in the scene, the image quality of some objects may be poor.

TIP Objects that you want to render are usually within a certain range from the camera. Setting the near and far
clipping planes just slightly beyond the limits of the objects in the scene can help improve image quality.

The ratio of far:near clipping planes determines the depth precision. Try to keep that ratio as small as possible
for better results. Since most of the depth precision is concentrated around the near clip plane, try to avoid
a lot of detail on distant objects.

Moving the Near and Far Clipping Planes

To move the near and far clipping planes:

1 From the View box, select Side or Top, depending on how your camera is positioned.

Either of these views profiles the camera so that the near and far clipping planes are clearly visible.

2 From the Camera menu, on the Basics tab, enter a value in the Near field to edit the position of the
near clipping plane.

The value in the Near field corresponds to the position of the near clipping plane, in pixels, from the
front of the camera. The farther away that the near clipping plane is placed, the higher the value. The
default value is 1. Any object between the camera and the near clipping plane is outside the camera
frustum and does not get processed in the final result.

3 Enter a value in the Far field to edit the position of the far clipping plane.

The value in the Far field corresponds to the position of the far clipping plane, in pixels, from the front
of the camera. The lower the value, the closer the far clipping plane is placed. The default value is
10000. Any object positioned behind the far clipping plane is outside the camera frustum and does
not get processed in the final result.

Moving the 3D Camera

Objects in the scene can be recorded from an arbitrary position as determined by the orientation of the
camera in world space. The position of the camera can be moved left or right, up or down, or closer or farther
from the central point of interest. The values for camera position are expressed in pixels relative to the
aiming target.

To change the position of the 3D camera:

1 From the View box, select Front, Side, or Top, depending on how your camera is positioned, to provide
a clear view of the camera motion.

2 From the Camera menu, on the Basics tab, modify the Position X, Y, and Z fields.
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You can also animate the camera using keyframes and the Channel Editor.

Adjusting the Aim of the 3D Camera

The aiming target is the point in world space at which the camera is directed. The aiming target is always
at the centre of the camera's frustum. Changing the position of the camera’s aim causes the orientation of
the frustum to change. You can take advantage of the relationship between the aim and the frustum to make
the camera follow a moving object. To do this, animate the aim while keeping the camera in a fixed position.
You can adjust the aim only with an Aim, or Aim and Up camera.

To adjust the aim of the 3D camera:

1 From the View box, select Front, Side, or Top, depending on how your camera is positioned, to provide
a clear view of the camera motion.

2 Do one of the following:
■ From the Camera menu, on the Aim/Up tab, modify the Aim X, Y, and Z fields.

■ Move the aiming target by dragging.

You can also animate the aim using keyframes and the Channel Editor.

Adjusting the Field of View

For every shot, you can decide how big an object appears in the frame, for example, whether a shot includes
an entire character or just its head and shoulders. This is directly controlled by adjusting the field of view.

The field of view is the amount of a scene (measurable in terms of area) that can be viewed by the camera.
The field of view can be altered by changing the angle of view or the distance between the camera and the
subject. See Moving the 3D Camera (page 537).

About the Angle of View

The angle of view, or more accurately, the angular field of view, is the amount of a scene (measurable in
terms of an angle in degrees, originating at the camera position) that can be viewed by the camera. The
angle of view is not affected by changes in the distance between camera and subject. It can be modified
directly, in the FOV field, or indirectly, via the Focal Length field.

The angle of view and the focal length are inversely proportional. As you extend the camera's focal length,
the field of view gets narrower. As you shorten the focal length, the field of view gets larger.
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Playing with the relationship between distance and angle of view affects the focus and perspective of objects
in the scene that can be used to creative advantage.

For example, a pair of objects that are placed a distance apart from each other, but in line with the camera,
can appear differently when changing these two parameters.

If these objects are viewed by a camera at long range, but using a lens with a high focal length (narrow angle
of view), they will appear large in the frame and in equal focus, and will seem to be located on the same
plane.

These same objects, when viewed at close range, but using a lens with a low focal length (wide angle of
view), will appear to also fill the frame, but the size difference between them will be exaggerated (the
foreground object will appear much bigger than the background object) and there will be a very noticeable
focus difference.

Focal Length

The focal length of a lens is the distance from the center of the lens to the film plane. The shorter the focal
length, the closer the focal plane is to the back of the lens. Focal length is usually expressed in millimeters.

The object's size in the frame is directly proportional to the focal length. If you double the focal length
(keeping the distance from the camera to the object constant), the subject appears twice as large in the frame.
The size of the object in the frame is inversely proportional to the object's distance from the camera. If you
double the distance, you reduce the size of the object by half in the frame.

Adjusting the Angle of View

To adjust the angle of view:

1 From the Camera menu, ensure that the Basics tab is active.

2 If you are using degrees for angle of view, enter the value directly in the FOV field.

Increasing the FOV value widens the frustum and decreases the Focal Length. Decreasing the FOV
value narrows the frustum and increases the Focal Length.

About the 3D Camera | 539



Importing and Exporting 3D Cameras

Smoke supports the import of Alembic 3D data, and the import and export of 3D data saved in the FBX 3D
format. These formats provide a means for exchanging 3D data for scene compositions—such as
cameras—between tools and packages developed by different manufacturers.

You can either import a camera you created and edited in Action, or import one from another 3D application.
Once a camera is imported, you can edit its parameters, change its animation, and then export it back to
the application it came from.

NOTE Some parameters in Maya are not supported in FBX, such as Shear, FilmPostScale, and CamScale. Also,
many parameters that are animatable in Maya and Smoke are not supported as animation curves in FBX. The 3D
Camera does not support depth of field.

Export a 3D camera from Action to FBX format, which can be used later by any other FBX-compatible
application.

To export a 3D camera from Action to FBX format:

1 Select the camera that you want to export.

2 In the 3D Camera menu, click Export.

The Export Camera file browser appears.

3 Set the FBX Scale and Export Options, as needed.

4 Navigate to the location where you want to export the camera animation.

5 Enter a name for your exported camera in the file field.

6 Click Save.

Export FBX Cameras Settings

Pixels to FBX Units field Displays the scaling factor to apply to the exported FBX file to be used in the 3D
application. Use the Units box to select the unit of measurement. Editable.

Units box Select a unit of measurement to apply to the exported FBX file.

Rotate Axis button Enable to rotate the 3D model by 90 degrees on the X-axis so that it is compatible with
the target's coordinate system.
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Export Axes button Enable to export the animated axes present in the Action scene.

Bake Animation button Enable to add a keyframe at every frame of the exported FBX camera file.

Camera, Working, and Orthographic Views

You can view the scene from various angles and display multiple views of these angles simultaneously. This
is helpful in setting light sources, camera angles, stereo parameters, and animation keyframes more accurately.

You can view the scene from Camera view, the Working view, and three orthographic views. In Camera
view, an object becomes smaller as it moves farther away from the camera. Working view is very similar to
Camera view, except that no camera settings are affected. Working view is useful for trying out different
settings and positions without actually making changes that can affect your cameras. In Orthographic view,
an object remains the same size, regardless of its distance from the camera. Orthographic views are more
helpful for aligning objects.

The following figures illustrate the different angles by which the scene can be viewed. The scene in this
example contains a grey back clip and the 3D model of an apple.

Camera viewFront view

Top viewSide view
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Setting Camera, Working, and Orthographic Views

To set camera, working, and orthographic views:

1 From the View box, select Camera, Working, or an orthographic view. When in Camera view, use the
Camera box that appears to select which camera is used in the image window.

(a) View box (b) Camera box

To:Select:

View the scene in Camera view. This is the scene as viewed by the camera eye. In other
words, your field of vision in world space is equivalent to the viewing frustum of the camera.
The size of objects depends on their distance from the camera eye.

Camera

View the scene as if you are positioned on the positive Y-axis. This is an orthographic view;
there is no perspective deformation.

Top

View the scene from the side, as if you are positioned on the positive X-axis. This is an or-
thographic view; there is no perspective deformation.

Side

View the scene as if your line of vision is directed into the camera eye. This is an orthographic
view; there is no perspective deformation.

Front

View the scene just as in Camera view. Try out different positions and adjustments without
affecting the camera settings.

Working

2 If you have multiple cameras in the scene, use the Camera box to define which camera is used for the
Camera view in the image window. The camera selected in this box is not necessarily the camera used
to process the scene.

3 Use the Working view if you want to view the scene using different adjustments, without saving any
of the settings to a camera setup. For this reason, no parameters are animatable.

4 Adjust the view with the Ortho Views controls, if needed.

When using an orthographic view, you may notice that parts of the object you are viewing are getting
cut off. Adjust the near and far ortho views. You gain more space to view the object, but lose some
viewing precision.

In the Display section of the Action Setup menu, adjust the Near and Far fields.
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(a) Ortho Views in Setup menu

NOTE The Ortho Views parameters in the Action Setup menu are only for viewing objects, and cannot be
animated or saved. The Near and Far fields in the Camera menu are used to set clipping planes. See Moving
the Near and Far Clipping Planes (page 537).

In addition to Camera, Working, and the three orthographic views, you can also select Schematic view,
which uses nodes to represent the objects in the scene and arrows to illustrate the relationships between
objects.

Modifying the Camera

You can gesturally modify the camera directly in the scene using options in the Edit Mode box. A mode
remains in effect until you select a different mode.

To gesturally modify the camera:

1 Make a selection in the Edit Mode box.

To:Select:

Move the camera lens and look-at point.Track

Tilt the camera up and down by moving the look-at point. Also changes the camera
roll. This option only modifies Target cameras.

Tilt

Rotate the camera on the Z-axis. This option only modifies Target cameras.Roll

Rotate the camera lens around the look-at point.Orbit

Move the camera field of view.FOV
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To:Select:

Move the camera lens towards (zoom in) or away from (zoom out) the look-at point.Dolly

Move the camera left and right by moving the look-at point. Also changes the camera
roll, when not 0.00.

Pan

2 Drag the cursor in the image window.

The camera is modified. Related Camera menu controls are updated to reflect the changes.

Zooming In and Out

Use the Zoom option to move the camera eye toward or away from the point of interest. While viewing the
scene in Camera view, zoom in or out from the point of interest to move the camera eye closer to or farther
from the point of interest. In Top, Side, or Front view, you can enlarge or reduce the scene in the image
window without affecting the camera. Zooming has no effect in Schematic view.

To zoom the camera:

1 From the Edit Mode box, select Zoom.

2 Place the cursor in the image window.

The cursor changes to a magnifying glass.

3 To zoom in, drag the cursor to the left. To zoom out, drag the cursor to the right.

Optimizing Attributes of the 3D Camera

Here are some general guidelines for tweaking the stereo attributes of the 3D camera:
■ Many parameters are relative to each other, and can be scaled and changed upon import using the Auto

Fit in Scene or FBX Unit to Pixels settings.

■ Tweak the Interaxial Separation to move the cameras closer to or farther away from one another.

NOTE You should re-adjust your Interaxial Separation if you change your output device, since the settings for
one display method may differ from another.

■ Increase the Zero Parallax to move objects further away from the camera. The 3D effect becomes less
pronounced in this case. Decrease your Zero Parallax to move objects closer to the camera. You can see
more depth if you do this.

The stereoscopic effect is the most realistic when the Zero Parallax Plane is in between the two objects.

■ You may need to re-adjust your camera attributes if you change the resolution of your output device.

■ You can also increase the Far Clip Plane to increase the depth of the camera.

■ In Anaglyph viewing mode, the red/cyan colors for objects are swapped depending on whether they are
behind or in front of the parallax plane. For objects behind the zero parallax plane, they appear in
cyan/red. For objects in front of the zero parallax plane, they appear in red/cyan.

About Source Nodes
Use source nodes in Action to create more advanced techniques such as transforming or replacing a front
or matte clip or applying motion blur. Source nodes can be used to separate front and matte clips in media
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and then apply separate transformations to each clip. For example, if you apply media to a surface and you
want to create an effect where the matte moves into the scene, add a source that isolates the matte clip. A
matte source lets you animate the matte's position separately from the front. You can also use source nodes
to apply several matte clips to a single front clip.

NOTE When applying colour corrector, blur, and crop effects with source nodes, the effects are applied to the
result of the source of the media. In contrast, keyer effects are applied only to the input clip of the media.

Creating a Matte or Front Source

When you create a matte or front source, a new branch appears in the schematic showing the matte or front
clip is separated from its media, ultimately replacing the matte or front with itself. This method of using
source nodes lets you animate the media's matte or front separately.

To create a matte or front source:

1 In Action, click Media.

2 In the Media list, select the matte or front media that you want to replace.

3 Do one of the following:
■ Drag the Source Matte or Source Front node from the node bin and place it in the schematic.

■ Double-click the Source Matte or Source Front node. You do not need to be in Schematic view to
add a node in this manner.

■ Drag the Source Matte or Source Front node from the node bin directly to the image window. The
view switches to Source view automatically.

A source node is created in Schematic view that parents an axis and a surface.

(a) Normal branch (b) Source branch

To view the contents of the source node in the image window, see Viewing a Source Node (page 548).

NOTE You can change a source from a front to a matte source, or vice versa, from the Source Type box in
the Source menu.

4 Select the axis or surface parented by the source and create the animation.

The changes applied to the axis or surface connected to a source are applied to the media's matte or
front.
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For example, on a matte source, if you change the axis's scale to 80%, the media's matte is scaled 80%
when used with the media's front. In addition, if you replace the surface by a bilinear or bicubic, you
can create complex animations where the matte behaves like a page turn leading into the scene.

Accessing the Source Menu

Once you added source nodes to your scene, you can access the Source menu to apply various settings.

To access the Source menu:

1 Do one of the following:
■ Select a Source Matte or Source Front node in the schematic, and then click the Source menu button.

NOTE If no source node is selected when first accessing the Source menu, or if there are no source nodes
present in the scene, all of the options in the menu are disabled.

■ Double-click a Matte or Front Source node in the schematic.

Parenting and Redrawing Source Nodes

A source cannot be parented by other objects in the schematic. If you attempt to parent a source, the
connection is refused. You can, however, parent objects inside a source node and they appear in your scene
based on the Source Type settings in the Object Image menu.

NOTE Be careful when you unparent or delete a source. Surfaces or other objects that were parented by the source
are added to the scene.

See Connecting Action Nodes (page 349).

Replacing the Front or Matte Clip

When working with source nodes, you can replace the media's front and matte clips with the front, matte,
or a combination of the front and matte clips from other media. These changes can be made in the Source
menu, or from the Sources tab in the Object Image menu of the image attached to the source node.

To replace the media's front or matte:

1 Double-click the source node in the schematic.

2 In the Source menu, change the source node from Matte to Front or vice versa.

3 Enable Override.
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4 Select the type of source from the Source Type box.

You can also change the source type in the Object Image menu for an image parented by a source
node. The source type set in the Object Image menu is independent of the source type set in the Source
menu for the parent source node or nodes.

5 If you selected Custom, select the clip to use as the front and matte from the image parented by the
source. You can select Front, Matte, or White for each.

For example, if you select F: Matte and M: Matte, only the matte of the source's child image is rendered
and used. A summary of your choice can be seen under the image node in the schematic. In this case
you will see (MM).

NOTE You can combine multiple parent sources each with their own override setting.

Source Settings

Source box Select a Front or Matte source.

Override button Enable to override a source node selection on the parent source.

Source Type box Select a source type. When selecting Custom, you can also designate a Front and Matte
type in the boxes below.

To:Select:

Set the source to use only the front of the selected surface; the matte will be replaced

with white (displayed as FW under the selected surface in the schematic).

Front only
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To:Select:

Set the source to use only the matte of the selected surface; the front will be replaced

with white (displayed as WM under the selected surface in the schematic).

Matte only

Set the source to have all the options of replacing the front and the matte of the selected

surface by White, original Front or original Matte.

Custom

Front Type box Select the clip to use as the front from the image parented by the source.

Matte Type box Select the clip to use as the matte from the image parented by the source.

Source View box Select which source to view in the image window. See Viewing a Source Node (page 548).

Viewing a Source Node

There are different ways to view a source node while working in Action. For example, a 2-up view with
Schematic and Source views allows you to view the complete scene and the interactive result of your source
node.

The Src Working view provides you with the ability to view your source scene using a working camera,
through which you can experiment without saving anything while preserving your camera setups. Each
source node has its own working camera apart from the regular camera. See  Setting the Camera and Ortho-
graphic Views  (page 523).

You can also select Source Result, Source Front, and Source Matte views from the View box.

To view a source node:

1 From the View box, select a Source view.

(a) View box (b) Source View box
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2 Press F6 again to cycle through the Source Result, Source Front, and Source Matte views.

3 From the Source View box, select which source node you want to view.

Blurring with Source Nodes

Motion blur and anti-aliasing can be set for either the front or matte clip of the media. Motion blur simulates
the blur created by fast-moving objects by blurring the motion of the front or matte media.

Similar settings for anti-aliasing and motion blur can be found in the Action Setup menu. You have the
option of using the same settings from the Setup menu for source nodes, or you can create specific source
node settings.

(a) Anti-Aliasing box (b) Anti-Aliasing Softness field (c) Motion Blur button (d) Samples field (e) Motion Blur Curve

Rendering Settings

Anti-Aliasing Sample box Select an anti-aliasing sampling level.

Softness field Displays the softness of the anti-aliasing sample. Editable.

Z-Buffer Mode box Select an option to determine whether the distance from the camera eye is considered.

To:Select:

Arrange sources according to their distance from the camera eye.Z-Buffer

Not consider the distance from the camera eye when arranging sources.Z-Buffer Off

To render each shadow in the correct Z order with its corresponding source.Shadow Mix

Camera Selector box Select the child camera under a parent source node.
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Shadow Type Settings

Source Shadow Type box Select the type of shadow cast for the source node. This setting is available in the
Shadow Cast menu only if the shadow cast node is a child of a source node, and is repeated in the Source
menu.

Accumulation Settings

Motion Blur button Enable to use a motion blur effect for the selected source node (can only be used if the
global Motion Blur is enabled in the Action Setup menu).

Phase field Displays the frame that motion blur is based on (before or after the current frame). Editable.

Shutter field Displays the duration of motion blur at each frame. Editable.

Samples field Displays the quality level of motion blur and the depth of field produced by the number of
samples taken at each frame. Editable.

Increasing the number of samples causes the processing time to increase linearly. The number of motion
blur samples is multiplied by the number of anti-aliasing samples. To reduce the total number of passes
made for each frame, reduce the level of anti-aliasing when Motion Blur is enabled.

TIP You can animate the Motion Blur button, as well as the Phase, Shutter, and Samples fields in the Channel
Editor under the source > motion_blur folder.

Motion Blur Curve Displays the sample weight over the scope of the motion blur.

Import from Setup button Click to use the anti-aliasing and motion blur values from the Setup menu.

Home button Resets the curve viewer to show the whole curve.

Reset button Resets the anti-aliasing and motion blur settings to their default values.

Adding Cameras

You can add multiple cameras under a parent source node to change the point of view (by orbiting to a
different orientation, for example). Camera 0 is always the default camera in a scene (you may need to pan
in the schematic to see this camera).
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If you have multiple child cameras under a selected parent source node, you can switch from one camera
to another from the Camera Selector box.
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Chroma Keying and Working with
Green Screens

The Modular Keyer is a schematic environment, like ConnectFX, that is designed specifically keying. Within the Modular
Keyer, you can choose different Start Modes or presets, which generate node schematics adapted to the different keys you
want to pull, such as 3D keys, chroma keys, etc.

When you start the Modular Keyer for the first time, Smoke builds a default schematic that includes the Master Keyer
node, in addition to a number of other nodes, that all work well together to create and refine a basic key. This is the Master
Keyer Start Mode.

Within the Modular Keyer, the keyers are represented as processing pipelines, which are collections of interconnected
nodes. As you perform keying tasks in the Modular Keyer, you navigate from node to node to accomplish the final key,
displayed in the Result node.

As a general example, you could proceed as follows:
■ Key out the selected colour in the Keyer node;
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■ Adjust your blacks and your whites in the 2D Histogram node;

■ Refine your matte in the Matte Edge node;

■ Mask out troublesome areas of your matte in the GMask node;

■ Perform colour correction of the front clip in the Master Keyer node or the Colour Curves node;

■ View the result in the Result node.

Because it is node-based, you have a lot of flexibility with the Modular Keyer. You can:
■ Choose a different Start Mode to start with a different default keying pipeline. Options are:

■ Channel Keyer

■ HLS Keyer

■ Luminance Keyer

■ Master Keyer

■ RGB Keyer

■ RGBCMYL Keyer

■ YUV Keyer

IMPORTANT When you select another Start Mode, any work in progress will be lost and the selected keyer is loaded with
the default settings.

■ Add other effects nodes from the node bin to further refine your key.

NOTE All of the legacy keyers had a colour section available in the settings. This colour section of the legacy keyers is only carried
over to the Modular Keyer if the legacy keyer setup used the Master Keyer. If any other legacy keyer was used (RGB, Luminance,
etc.), the colour section is discarded when the setup is loaded. Also, motion blur data, from the GMask section of the legacy
keyers is not carried over to the Modular Keyer.

Setting Up the Nodes and Media to Pull a Key
To pull a key, you must first set up your composite in the Modular Keyer.

To set up the composite in the Modular Keyer:

1 From the timeline, select your front clip segment.

2 Click FX and select Create ConnectFX.

You are taken to the ConnectFX view. The schematic is displayed and your front clip is connected to
the output node.

3 From the ConnectFX node bin, drag the Modular Keyer node between the front clip and the output
node and release it when the connection goes from red to yellow.

The front clip is connected to the front (red) input of the Modular Keyer node, which is connected to
the output node.

4 Double-click the back (green) input of the Modular Keyer node.

You are taken to the Viewing panel and the cursor becomes a green arrow, prompting you to select a
back clip.

5 In the Viewing panel, click on the clip you want as your back.

You are taken back to the ConnectFX schematic and your back clip is connected to the back input of
the Modular Keyer node.

6 Double-click the matte (blue) input of the Modular Keyer node.
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You are taken to the Viewing panel and the cursor becomes a blue arrow, prompting you to select a
matte clip.

7 In the Viewing panel, click on the clip you want as your matte.

You are taken back to the ConnectFX schematic and your Matte clip is connected to the matte input
of the Modular Keyer node.

Your front, back and matte clips are now connected to the front, back and matte inputs of the Modular
Keyer node. You are ready to start creating your key.

8 Double-click the Modular Keyer node.

9 Click the Edit button that appears at the bottom of the screen.

The Master Keyer processing pipeline appears. The Master Keyer is the default keyer.

NOTE Once inside the Modular Keyer, the Modular Keyer node bin is displayed at the bottom of the screen.
Though very similar to the Connect FX Node bin, the Modular Keyer node bin contains only nodes that are
relevant for keying. To return to the ConnectFX view, click Return.

10 Double-click the Master Keyer node to display the Master Keyer menu at the bottom of the screen.

After you have set up the nodes and media, set up the viewports for keying (page 555).

Setting Up Viewports for Keying
After you have set up your processing pipeline and your media (page 554), you want to set up the viewports
for keying.

When keying, you want to set the viewport to 2-up view, to display the schematic and the result views
simultaneously, enabling you to view the result as you work.

To set up the viewports for keying:

1 From the Layout box, select 2-up.

The view area is split in two. The schematic view is displayed on the left, by default.

2 Click in the right-side viewer to select it.

A white frame appears around the viewer to show that it is selected.

3 From the View box, select Result.

The result of your key, in its current state, is displayed in the right-side viewer.

Creating and Refining a Key in the Master Keyer
Use the Master Keyer method to create a complete key—extract colours to generate a matte and then refine
the result—using only the Master Keyer menu. The Master Keyer uses an algorithm that quickly isolates a
colour and is very good for chroma keying.

With the Master Keyer, you can refine the key by gesturally modifying the matte, removing colour spill,
blending edges, applying patches, and removing grain.
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(a) Primary Sample colour pot (b) Secondary Sample colour pot (c) Edge Balance trackball (d) Sampling box (e) Reset
button

The following procedure is a recommended workflow for keying a clip with the Master Keyer. You may not
need to complete all the procedures. You may also revisit procedures as you develop the key.

To create a complete key:

1 Generate and refine a matte using the Matte controls.

2 Remove any colour spill.

3 Improve the blend between the front and back clips.

4 If the image is grainy, apply the Degrain algorithm.

5 Create any necessary patches to remove unwanted grey areas from the matte.

Generating Mattes

Use the Matte controls in the Master Keyer to generate and refine a matte for your chroma key.

To generate and refine a matte:

1 In the Master Keyer menu, select Matte from the Sampling box.

2 Set the view to Result or Matte view.

3 Click the Primary Sample colour pot and then sample the image. Click the image to sample a single
pixel.

The Auto CC button is enabled and the initial pure colour value for the key is set.

4 Click the Secondary Sample colour pot and then sample the image. Sample an area where you do not
want any softness in the matte.

5 Drag in the Mix field to adjust the mix between the primary and secondary sample. Drag right to
include more of the secondary sample or left to include less.
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TIP You can adjust the mix at any time as you develop the key.

6 Gesturally refine the matte. In the image window, click an area of the matte that you want to
refine—only those parameters that pertain to the area you click appear. Parameters are displayed in
order of importance, from top to bottom (those that are brightest and at the top have the greatest effect
on the image). You can then modify a parameter by dragging its highlighted slider.
■ To add softness, drag a slider to the right.

■ To remove softness, drag a slider to the left.

The red indicator shows the original value and the yellow indicator shows the current value.

7 To modify more than one parameter, move the mouse between the parameters to highlight a parameter,
or drag the pen vertically. When you highlight the parameter you want to adjust, drag the slider.

TIP If you do not like the result, you can click Undo to reset parameters directly after you complete the
operation. There is only one level of undo in the Keyer menu.

8 When you are finished modifying the displayed parameters, click another area of the image without
highlighting a parameter to hide them. Alternatively, you can press any key, such as spacebar or Esc.

The parameters are no longer displayed.

9 Repeat steps 6 to 8 in other parts of the matte to further refine it. Only the parameters that apply to
the problem area will appear.

10 To scroll through the image and display the pertinent parameters, Option-drag the image without
clicking it. The parameters update as you drag. You can then modify the displayed parameters by
clicking the image and dragging the highlighted slider.

NOTE To reset matte parameters, click the Reset button, next to the sampling box. All matte parameters are reset,
except the Mix field and the key colour.

After you have generated your matte, perform basic colour spill removal (page 557).

Basic Colour Spill Removal

After you create and refine your matte (page 556) for the key, you can perform basic colour spill removal by
gesturally modifying the Spill parameters.

To gesturally remove colour spill:

1 In the Master Keyer menu, select Spill from the Sampling box.

2 Set the view to Result view.
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3 Enable Auto CC to apply the Spill settings to the front clip.

4 Remove any colour spill. Click anywhere in the image window, and then modify the parameters that
appear by dragging the sliders—you do not need to click a specific area.

To:Drag:

Set the range for the removal of colour spill along the edges of the key. Drag right to
soften the edge and remove colour spill further into the key. Drag left to harden, or
create a thinner, edge.

Range

Modify and suppress colours that are adjacent to the primary sample.Hue

The red indicator shows the original value and the yellow indicator shows the current value. The values
also appear in the Spill fields. The original values should be good, so make small adjustments only.

5 To modify both parameters, move the mouse between them to highlight a parameter, or drag the pen
vertically. When you highlight the parameter you want to adjust, drag the slider.

If you do not like the result, you can click Undo to reset parameters directly after you complete an
operation. There is only one level of undo in the Modular Keyer.

6 When you are finished modifying the displayed parameters, click another area of the image without
highlighting a parameter to hide them. Alternatively, you can press any key, such as spacebar or Esc.

The parameters are no longer displayed.

NOTE To reset Spill parameters, click the Reset button, next to the sampling box.

If you are satisfied with your colour spill removal, move on to blending your front and back clips (page 560).

If you want to perform additional colour spill suppressions, see Advanced Colour Spill Removal (page 558).

Advanced Colour Spill Removal

If you want to suppress colour spill beyond what was shown in Basic Colour Spill Removal (page 557), you
can use the Spill controls in the Colour menu to eliminate and disguise the colour spill in the Master Keyer.
You can sample the colour you want to remove, and then adjust the Range and Hue fields to suppress the
selected colour and shift its adjacent colours.
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(a) Spill Colour pot (b) Auto CC button in Range menu (c) Spill fields

When you sample an image to generate a key from a Range menu, the sampled colour in the Spill colour
pot is also updated. However, the inverse is not true—if you sample a colour using the Spill colour pot,
sampled colours used to generate keys are not updated. You can therefore sample colour spill without
affecting the original sample.

NOTE To apply these settings to the key, the Auto CC button must be enabled.

To remove colour spill from a key:

1 Click the Result node so that you can see the changes in the right side viewer. If you do not see the
result, see Setting Up Viewports for Keying (page 555).

2 Enable Auto CC in the Colour menu to apply the Spill settings to the front clip.

3 The Spill colour pot displays the colour that will be suppressed in the clip. By default, the original
colour extracted from the key-in clip is displayed. In many cases, you can use this colour because the
colour spill is the same colour as the original colour. However, if the colour spill is not the same, change
the colour sample. Click the colour pot, use the colour picker to sample the colour spill in the image
window, and then click the colour pot again.

NOTE When you select the colour you want to key from the Master Keyer menu, the colour that appears
in the Spill colour pot is automatically updated to match the key colour. However, the inverse is not
true—when you sample a colour from the Spill colour pot, the sampled colour used to generate a key is not
updated.

4 Drag in the Spill fields to remove the colour spill.

To:Drag:

Suppress the primary sample colour where there is colour spill (along the edges of the
key).

Range

Modify colours that are adjacent to the primary sample and further remove colour spill.Hue
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NOTE You can reset the Spill parameters, Blend parameters, and the Edge Balance trackball by clicking Reset,
located to the right of the Hue field.

When you are satisfied with your colour spill removal, move on to blending your front and back clips (page
560).

Blending Front and Back Clips

After you remove colour spill (page 557), you can use the Blend parameters in the Master Keyer to gesturally
modify the luminance at the edge of the key so that it blends with the luminance in the background clip.
For example, when the front clip is darker than the back clip, you can use the Master Keyer's Blend parameters
to lighten the edge of the key.

When you blend front and back clips, you can add a cast to the edge of the key and further merge the clips.

To blend the front and back clips:

1 In the Master Keyer menu, select Blend from the Sampling box.

2 Set the view to Result view.

3 Enable Auto CC to apply the Spill settings to the front clip.

4 Blend the front and back clip. Click anywhere in the image window, and then modify the parameters
that appear by dragging the sliders—you do not need to click a specific area.

To:Drag:

Darken or lighten the edge of the key. Luma only affects the luma of the edge.Luma
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To:Drag:

Set the range for the blend. Drag right to soften the edge and blend further into the
key. Drag left to harden, or create a thinner, edge. Edge Size affects both the Luma field
and the Edge Balance trackball.

Edge Size

TIP To drag faster, apply more pressure with the pen, or hold Option+Spacebar while you drag.

The red indicator shows the original value and the yellow indicator shows the current value. The values
also appear in the Blend fields.

5 To modify both parameters, move the mouse between them to highlight a parameter, or drag the pen
vertically. When you highlight the parameter you want to adjust, drag the slider.

TIP If you do not like the result, you can click Undo to reset parameters.

6 When you are finished modifying the displayed parameters, click another area of the image without
highlighting a parameter to hide them. Alternatively, you can press any key, such as spacebar or Esc.

The parameters are no longer displayed.

7 To add a cast to the edge of the key and improve the overall look by matching the edge with a colour
cast in the back clip, drag the Edge Balance trackball toward the colour you want to add. The trackball
only affects the chroma of the edge.
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NOTE To reset Blend parameters, click the Reset button, next to the sampling box. All blend parameters are reset,
except the Edge Balance trackball. Command-click the Edge Balance trackball to reset it.

After you have set your blend parameters for the front and back clip, remove grain from your clips (page
562).

Removing Grain

After you have set your blend parameters for the front and back clips (page 560), you may want to remove
grain from your clips. Graininess can make it difficult to pull a clean and effective key. Use the Degrain tools
in the Master Keyer to remove grain from clips.

NOTE Degrain parameters are animatable. Degrain samples are also animatable and appear in the Channel Editor
as the Degrain_Matrix channel, located in the Key_Degrain folder. See Animating Keyframes (page 1099).

To remove grain:

1 In the Master Keyer menu, select Degrain from the Sampling box.

2 Set the view to Result view.

3 Sample a grainy area of the image. To sample a single pixel, click the image. To sample an area of the
image, Command-drag a selection box.

The Degrain button is enabled and the algorithm is applied to the image—grain is removed from the
image.

NOTE The Degrain button is either enabled or disabled for the entire clip—you cannot turn it on and off
for different frames in the clip.
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4 Drag in the Degrain fields to modify the grain size and restore edge sharpness.

(a) Size field (b) Edges field

To:Drag:

Estimate the size of the grain in the image.Size

De-sharpen the edge of the image. By default, Degrain sharpens the edges. Use the Edges
field to restore the natural look of the edges in the image.

Edges

5 If you are not satisfied with the result, you can start over with a new sample, and then adjust the
Degrain fields. To resample an area of the image, Command+Option-drag the image.

The sample is outlined in green, indicating that you are resampling the image.

NOTE You can also reset Degrain parameters. To reset Degrain parameters, click the Reset button, next to
the sampling box.

6 If resampling the image and adjusting the Degrain fields does not sufficiently remove grain, enable
More to increase the overall effect of Degrain.

NOTE The More button is either enabled or disabled for the entire clip—you cannot turn it on and off for
different frames in the clip. When you enable More, processing speed slows down.

After you have removed grain from your clips, you may still have to remove unwanted greys (page 563).

Removing Unwanted Greys

If you have unwanted grey areas in the matte, you can use up to three patches in the Master Keyer to isolate
a range of colours to be included in, or excluded from, the key.

NOTE Patch parameters are animatable. Patch samples are also animatable and appear in the Channel Editor as
a Matrix channel, located in the Patch folder.
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There are three types of patches in the Master Keyer, that are applied to different areas of the image.

Is applied to:Selected patch:

Areas of the image to be included in the black part of the matte.Black

Areas of the image to be included in the white part of the matte.White

Areas of the image that are along the edge of the key. Edge Analysis is useful when there
is a specific edge you want to erode but cannot do so with the Matte parameters. You
can then increase or decrease the softness of this patch using the Soft field.

Edge Analysis

To remove unwanted greys:

1 In the Master Keyer menu, select Patch1, Patch2, or Patch3 from the Sampling box.

2 Set the view to Matte view or Result view.

3 Sample the image where you want to apply the patch. To sample a single pixel, click the image. To
sample an area of the image, Command-drag a selection box.

When you Command-drag to sample, the sample is outlined in red. In the Master Keyer menu, the
Patch button is enabled and the appropriate patch appears in the Patch box and is applied to the image.

NOTE A Patch button is either enabled or disabled for the entire clip—you cannot turn it on and off for
different frames in the clip.

(a) Patch buttons (b) Patch controls (c) Patch boxes

4 To add more colour to the patch, resample the image.

5 To use the same patch but start with a new sample, Command+Option-drag the image.

The sample is outlined in green, indicating that you are resampling the current patch.
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6 To manually select a patch type, select it from the Patch box.

NOTE If you want to reset the patch so that you can automatically select the patch type, you must disable
the patch and set the patch type to Off. You can then resample an area in the image and generate a patch
type.

7 To improve the patch, use the Patch controls.

To:Drag:

Increase or decrease the colour range that is included in the patch.Range

Soften the edge.Soft

NOTE To reset Patch parameters, click the Reset button, next to the sampling box.

Creating a Key by Extracting a Single Colour with the Channel
Keyer

You can extract one of the three primary colours (red, green, or blue), or a custom colour from the key-in
clip. This method is useful for clips containing transparencies such as glass or smoke.

Extracting a Primary Colour

Extract one of the three primary colours from the key-in clip when you have a front clip shot in front of a
blue, red, or green screen.

To create a key by extracting a primary colour:

1 From the Start Mode dropdown list, select Reset to Channel and click Confirm.

The Channel keyer processing pipeline is displayed in the schematic view.

2 Double-click the Channel Keyer node.

The Channel controls appear.

(a) Channel Mode box (b) Softness field

3 Select one of the primary colour options (Red, Green, Blue) from the Channel Mode box.

4 Enable More to enhance the keying effect.

The More option extends the range of the colour to be extracted from the key-in clip.

5 Increase or decrease the softness for the key using the Softness field.

The softness value determines how much of the key-in clip is partially transparent in the matte. Softness
creates a smoother transition between the front and back clips in the composite clip.

6 Click Result to see the result of your key.
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Extracting a Custom Colour

Use the Custom colour channel option in the Channel Keyer to select the colour to be extracted from the
key-in clip. This option can give good results when keying transparencies, particularly by experimenting
with the Softness and Colour Spread values.

To create a key by extracting a custom colour:

1 From the Start Mode dropdown list, select Reset to Channel and click Confirm.

The Channel keyer processing pipeline is displayed in the schematic view.

2 Double-click the Channel Keyer node.

The Channel controls appear.

(a) Channel Mode box (b) Average Colour pot (c) Softness field (d) Colour Spread field

3 Select Custom from the Channel Mode box.

4 Click the Average Colour pot.

The cursor changes to a colour picker.

5 Click the image to select a single colour, or drag the colour picker across a region to obtain the average
of the colours encountered by the colour picker. Try selecting different colours in the background area
to get the best result.

TIP To keep shadows, click just outside them. To remove shadows, click inside them.

6 Adjust the softness for the key using the Softness field.

Increasing softness raises the level of grey in the matte. Lowering it makes the matte sharper.

7 Adjust the colour spread for the key using the Spread field.

Increasing the colour spread value extends the range of colours extracted from the key-in clip.

8 Click the Result node so that you can see the changes in the right side viewer. If you do not see the
result, see Setting Up Viewports for Keying (page 555).

NOTE To improve the key at this point, try adjusting it with the histogram in the 2D Histogram node. See
Adjusting the Luminance of the Key (page 570).

Creating a Key by Extracting a Range of Colours with the HLS,
YUV, RGB and RGBCMYL Keyers

Another technique for creating a key is to extract a range of colours from the key-in clip. Use this technique
for clips where the colour you are extracting contains impurities.

When you build a key by defining a colour range, you can use one of four colour models: RGB, YUV, HLS,
or RGBCMYL. Each model interprets the key-in clip differently and gives a slightly different result.

After you choose a colour model, you set a range of colours to become partially transparent in the key-in
clip to soften the transition between the front and back clips. This is called the softness range. All pixels in
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the front clip within the softness range become grey in the matte. The key should have the greatest possible
softness value.

After setting the softness range, you set a range of colours to be keyed out in the key-in clip. This is called
the tolerance range. All pixels in the front clip within the tolerance range become black in the matte. The
tolerance range must not be too large or the edge of the composite will be too hard and the subject in the
front clip will appear to be pasted into the back clip.

About the Different Colour Models

There are four colour models you can use.

HLS

In the HLS Keyer menu, you set the softness and tolerance ranges using the hue, luminance, and saturation
channels.

YUV

In the YUV Keyer menu, you set the softness and tolerance ranges using the luma and chroma signals of
YUV component video.

RGB

In the RGB Keyer menu, you set the softness and tolerance ranges using the red, green, and blue channels.

RGBCMYL

In the RGBCMYL Keyer menu, you set the softness and tolerance ranges using the red, green, blue, cyan,
magenta, yellow, and luminance channels. This colour model provides subpixel resolution.

Selecting a Colour Model Based Component Keyer

To determine which component keyer will give you the best key, try creating a sample matte for each keyer.

To create a sample matte for each keyer:

1 From the Start Mode dropdown list, select one of the following: Reset to RGB, Reset to YUV, Reset to
HLS, Reset to RGBCMYL.

2 Set the View to Key In to view the key-in clip.

3 Double-click the Keyer node in the schematic.

The softness for each model is set automatically to 50, which helps you to quickly gauge the model
that will create the best key for your clip.

4 At frame 1, click the Average Colour pot.

5 Drag the colour picker around the area you want to key out.
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The average colour sampled by the colour picker appears in the Average Colour pot. In each channel
of the colour model, the channel value of the average colour appears as a white line. All pixels in the
key-in clip with the selected colour value are keyed out.

The yellow lines in the colour model channels indicate the limits of the softness range. The pixels in
the front clip with colour values at the centre of the range are black (transparent) in the matte. As you
move away from the centre, the pixels become more opaque.

6 Set the view to Matte view.

7 Repeat this procedure to plot the average colour using the other colour models, and then view each
resulting matte to determine which model gives the best result. After you decide on a colour model,
use the tools described in the next sections to refine your matte.

After you have selected a colour model and set the average colour, set the softness range (page 568).

Setting the Softness Range

After you choose a colour model based component keyer and set the average colour (page 567), adjust the
softness range. The softness at the edges of the matte increases as you increase the softness range. To set the
softness, you can use the colour picker, the numeric fields, or the Master Softness field.

To set the softness using the colour picker:

1 Zoom in to see the edges of the matte more clearly.

2 Click Softness in the selected colour model menu.

The cursor changes to a colour picker.

3 Position the colour picker at the edge of the matte. To increase the softness, click and slowly drag the
colour picker toward the centre of the matte. The values within the area you selected are used to adjust
the maximum and minimum values for the softness range. The positions of the yellow lines change
as you drag the cursor on the image.

(a) Master Softness field (b) Minimum Softness field (c) Maximum Softness field

4 To increase or decrease the softness range, click the + or - button beside the Softness button and then
click an area of the image.

To set the softness range using the numeric fields:

1 Set the minimum value for the softness range using the Minimum Softness field on the left side of the
colour bar.

2 Set the maximum value for the softness range using the Maximum Softness field on the right side of
the colour bar.

NOTE You can also set the softness range by entering a numeric value in the Master Softness field.
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TIP As a reference, when setting softness and tolerance ranges, you can display the colour value for any pixel in
the key-in clip using the Plot tool. You can then adjust the tolerance or softness range so the pixel falls within one
of the ranges. For example, plot pixels at the edges of the matte to check for softness, or plot pixels in the
background to check for tolerance.

To plot a pixel's colour values:

1 Click Plot.

The cursor changes to a colour picker.

2 Select a pixel in the image area.

A red bar appears in each colour gradient showing the colour value of the pixel.

After you have adjusted the softness range, set the tolerance range (page 569).

Setting the Tolerance Range

After you define the softness range in a colour model based component keyer, you can set the tolerance
range to remove the greys outside the key shape. The maximum and minimum tolerance values define the
range of colours to be keyed out in the key-in clip.

To set the tolerance range using the colour picker:

1 Click Tolerance.

The cursor changes to a colour picker.

2 Drag the colour picker around the area of the image that you want to key out.

The colour values that the colour picker samples are used to set the maximum and minimum values
for the tolerance range. The white lines define the limits of the tolerance range. All colour values
between the white lines are extracted from the key-in clip.

(a) Master Tolerance field (b) Minimum Tolerance field (c) Maximum Tolerance field

3 To increase or decrease the tolerance range, click the + or - button beside the Tolerance button.

NOTE An alternative method of setting the tolerance range is to press Command and draw a rectangle in
the area of the image you want to key out.

To set the tolerance range using the numeric fields:

1 Set the minimum value for the tolerance range using the Minimum Tolerance field on the left side of
the colour bar.

2 Set the maximum value for the tolerance range using the Maximum Tolerance field on the right side
of the colour bar.

NOTE You can also set the tolerance range by entering a numeric value in the Master Tolerance field.
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TIP As a reference, when setting softness and tolerance ranges, you can display the colour value for any pixel in
the key-in clip using the Plot tool. You can then adjust the tolerance or softness range so the pixel falls within one
of the ranges. For example, plot pixels at the edges of the matte to check for softness, or plot pixels in the
background to check for tolerance.

To plot a pixel's colour values:

1 Click Plot.

The cursor changes to a colour picker.

2 Select a pixel in the image area.

A red bar appears in each colour gradient showing the colour value of the pixel.

Creating a Key by Setting the Luminance
You can create a key using only the Luminance channel. The softness and tolerance values are expressed as
percentages.

This technique is useful for clips with high contrast or filmed against a black background. You can also use
the Luminance channel to adjust a matte that has already been rendered. Load the matte as the key-in clip,
and then adjust it in the Luminance menu.

NOTE When you load a matte as the key-in clip and open the Luminance menu with default menu values, the
resulting Keyer matte is identical to the original matte.

To create a key by setting the luminance:

1 From the Start Mode dropdown list, select Reset to Luminance and click Confirm.

The Luminance Keyer processing pipeline is displayed in the schematic view.

2 Double-click the Luminance Keyer node.

The Luminance controls appear.

(a) Master Tolerance field (b) Master Softness field

3 Set the softness in the Master Softness field.

4 Set the tolerance in the Master Tolerance field.

A value of 100 for the tolerance creates an entirely opaque matte.

Refining Your Key

Adjusting the Luminance of the Key

After creating a key, you can adjust luminance values to fine-tune the result. The 2D Histogram node in the
schematic displays the distribution of luminance values within the matte. The horizontal axis of the histogram
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represents the range of luminance values in the matte and spans from 0 (black) to 255 (white). The vertical
axis shows the number of pixels at each luminance value.

Setting the Range of the Luminance Values

Use the List and Gain fields with the Input Level controls, in the 2D Histogram node in the schematic, to
set the range of luminance values in the matte. You can darken black areas of the matte or remove grey from
white areas of the matte.

(a) Minimum Input level (b) Maximum Input level

Removing Grey from the Black Areas of the Matte

The Minimum Input level sets the start of the range of luminance values. Pixels with luminance values below
the Minimum Input level are mapped to black (0).
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You can set the Minimum Input level by dragging the black triangle, or by setting a value in the Minimum
Input Level field.

The matte after lowering the Minimum Input level
The matte before adjusting the Input levels

Removing Grey from the White Areas of the Matte

The Maximum Input level sets the end of the range of luminance values. Pixels with luminance values
greater than the Maximum Input level are mapped to white (255).

You can set the Maximum Input level by dragging the white triangle, or by setting a value in the Maximum
Input Level field.

The matte after lowering the Maximum Input levelThe matte before adjusting the Input levels

Remapping Black and White

Use the Output levels in the 2D Histogram node in the schematic to remap the luminance values for black
(0) and white (255). You can brighten the dark areas of the matte or darken the white areas.
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(a) Minimum Output level (b) Maximum Output level

Brightening the Matte

The Minimum Output level sets the luminance value of all black (0) pixels in the matte. Black pixels in the
matte are mapped to the luminance value set by the Minimum Output level.

You can set the Minimum Output level by dragging the black triangle, or by setting the value in the Minimum
Output Level field.

The matte after lowering the Minimum Output levelThe matte before adjusting the Output levels

Darkening the Matte

The Maximum Output level sets the luminance value of all white (255) pixels in the matte. White pixels in
the matte are mapped to the luminance value set by the Maximum Output level.
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You can set the Maximum Output level by dragging the white triangle or by setting the value in the Maximum
Output Level field.

The matte after lowering the Maximum Output levelThe matte before adjusting the Output levels

Boosting the Luminance of the Key Using Gain and Lift

You can remove grey from the key by increasing the gain and lowering the lift values in the 2D Histogram
node in the schematic. Increase the gain to eliminate the light greys that may be in the white area of the
matte, and decrease the lift to eliminate dark greys in the black area of the matte.

NOTE Adjusting these values increases the contrast and may harden the edges of the matte.

Using the Luminance Curves

When you create a matte for the front clip, the Keyer automatically creates a matte for the back clip to
specify which part of the back clip is used for the composite. By default, the back matte is the inverse of the
front matte.

You can adjust the luminance of the front matte and back matte separately in the Blending menu in the
Result node in the schematic. For example, increase the luminance of the back matte so that more of the
back clip shows through at the edges of the key. This creates a better blend at the edges of the key.

To adjust the luminance curve:

1 Double-click the Result node in the schematic.

The Luminance curve appears.
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(a) Front matte curve (b) Back matte curve (c) Front/Back box

2 Use the Viewing box to select the image you want to view as you adjust the curves.

To view:Select:

The composite clip.Result

The front matte. You cannot see changes made to the back matte when this view is selected.Matte

The back matte. You cannot see changes made to the front matte when this view is selected.Bmatte

The composite with a coloured background. The default colour is black. To select a different
colour, click the colour pot to the right of the Comp button. The colour picker appears.

Comp

3 To adjust the luminance curve for the front matte, select Front from the Front/Back box. To adjust the
back matte curve, select Back. Alternatively, click a curve to select it.

The selected curve changes to white.

(a) 255 (White) (b) Output (remapping of luminance values) (c) 0 (Black) (d) 0 (Black) (e) Input (current luminance
values) (f) 255 (White)
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4 Click a point to display its tangent handle and drag the handle to adjust the curve. Use other modes
in the Tools box to further adjust the curve, adding or deleting points or breaking tangent handles, as
needed.

Modifying the Edges of the Key

Use the Shrink, Erode, and Blur controls in the Matte Edge node in the schematic, to enhance the edge of
the keyed image.

To:Use:

Detect the edges of your matte and fine-tune the edges with tolerance controls. This is useful
for cleaning up difficult mattes.

Edges

Remove pixels from the edge of the matte. This control should not be used when the object
in the front clip has soft edges, such as hair.

Shrink

Blend the light and dark edges of the matte.Erode

Apply a softening filter to the edge of the matte. You can select either a Gaussian filter or Box
filter.

Blur

To access the Edge Matte controls:

1 Double-click the Matte Edge node in the schematic.

The Edge Matte controls appear.

To detect the edges of your matte:

1 In the Matte Edge menu, enable Edges.

The edges af your matte are detected and displayed in the viewer.

2 Fine-tune the edges by modifying the Min and Max fields (tolerance) and the Width field, which
determines the width, in number of pixels, of the detected edges.

To shrink the edge of the matte:

1 In the Matte Edge menu, enable Shrink.

2 Set a value in the Shrink Width field.
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This value specifies the width of the border, in number of pixels, that is removed from the edge of the
matte.

The matte after setting the shrink width value to 1.00
The matte before enabling the Shrink filter

To erode the edge of the matte:

1 In the Edge Matte menu, enable Erode.

2 Set a value in the Erode Width field.

Refining Your Key | 577



This value specifies the width of the matte border, in number of pixels, that will be softened.

The matte after setting the erode width value to 1.00The matte before enabling the Erode filter

To blur the edge of the matte:

1 In the Edge Matte menu, enable Blur.

2 Set values in the Blur Width and Height fields.
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These values specify the width and height of the Blur filter applied to the edge of the matte.

The matte after setting the blur width and height values
to 1.00The matte before enabling the Blur filter

Adjusting Spill Controls with the Colour Curves Node

After you create a key and key out any trouble areas, some of the background colour may have spilled over
at the edge of the key. Colour spill suppression in the component keyers is done through the Colour Curves
node. The Colour Curves menu lets you sample the colour you want to suppress and then suppress that
colour where necessary, using the suppression curve.
■ Adjust the Suppression curve in the Colour Curves node to suppress a selected colour.

■ Adjust the Hue Shift curve in the Colour Curves node to perform a hue shift on a selected colour.

NOTE To remove colour spill in the Master Keyer, see Basic Colour Spill Removal (page 557) and Advanced Colour
Spill Removal (page 558). Alternatively, you can connect a Colour Curves node between the front clip and the front
input of the Master Keyer and follow the procedures below.

Adjusting the Suppression Curve

To suppress colour spill using the suppression curve:

1 Set the view to Result, so that you can see the changes as you make them.

2 Double-click the Colour Curves node in the schematic.

The Colour menu appears.
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The Colour menu displays colour curves over a hue spectrum. When you modify the shape of a curve
over a region of the spectrum, only those colours are affected.

3 Click Supp to modify the Suppression curve.

4 The colour pot next to the Suppress button displays the colour that will be suppressed in the clip when
you modify the curve. By default, the blue colour is displayed. To change the colour sample, click the
colour pot, use the colour picker to sample the colour spill in the image window, and then click the
colour pot again.

5 Click the colour pot next to the Supp button.

The cursor turns into a colour picker.

6 Select a pixel within the spill.

A red vertical bar appears in the hue spectrum identifying the colour to be suppressed.

7 Use the cursor to move the points along the Suppression curve.

8 On the Suppression curve, drag the point closest to the plotted colour down to a value of 25, intersecting
the plotted colour.

The colour spill is suppressed.

9 Continue modifying the shape of the curve until you are satisfied with the result.

10 Click Saturation to adjust the saturation of the spill.

NOTE Once you remove the saturation from a spill, you may want to increase the values for the other curves
(for example, red and green if you removed a blue spill) to reconstruct some of the natural colours at the
edge of the keyed image.

11 Click Red, Green, or Blue to edit individual colour curves.

12 Click Luminance to adjust the luminance of the spill.

Adjusting the Hue Shift Curve

You can disguise colour spill by shifting its hue so the colour blends better with the background. Sample
the colour to which you want to shift the colour spill and then adjust the Hue Shift curve to shift the colour
spill accordingly.

To Create a Hue Shift:

1 Set the view to Result, so that you can see the changes as you make them.

2 Double-click the Colour Curves node in the schematic.

The Colour menu appears.

The Colour menu displays colour curves over a hue spectrum. When you modify the shape of a curve
over a region of the spectrum, only those colours are affected.

3 Enable Hue to modify the Hue Shift curve.
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4 Select a pixel within the spill in the Result image.

A red vertical bar appears in the hue spectrum identifying the colour to be shifted.

5 Click the colour pot next to the Hue button.

The colour picker appears.

6 Select or pick the colour you want to shift the spill to.

7 Use the cursor to move the points along the Suppression curve.

8 On the Hue Shift curve, drag the point closest to the plotted colour down to a value of 75, intersecting
the plotted colour.

The colour spill is shifted toward the Hue colour.

9 Continue modifying the shape of the curve until you are satisfied with the result.

Inverting a Matte

Use the Negative node to invert a matte. By inserting the Negative node between the Matte Edge and the
GMask nodes in the processing pipeline, the matte is automatically inverted. The Negative node has no
settings to configure.

To invert a matte:

1 From the Modular Keyer Node bin, drag the Negative node to the schematic.

2 Hold Shift and drag the Negative node to the Matte Edge node so their tabs touch and repeat for the
GMask node.

The Negative node is inserted to the schematic and your matte is inverted.

Adjusting the Front and Matte Luminance Curves

When you create a matte for the front clip, the Modular Keyer automatically creates a matte for the back
clip to specify which part of the back clip is used for the composite. By default, the back matte is the inverse
of the front matte.

You can adjust the luminance of the front matte and back matte separately in the Matte Curves menu. For
example, increase the luminance of the back matte so that more of the back clip shows through at the edges
of the key. This creates a better blend at the edges.

To adjust the luminance curves:

1 Click the Result node in the pipeline.

The Matte Curves menu appears.

Refining Your Key | 581



(a) Result box (b) Front matte curve (c) Matte box (d) View box (e) Back matte curve

2 Select Result view from the Result box. This allows you to select a particular image to view as you adjust
the curve.

3 From the Result box, select the image you want to view as you adjust the curves.

To view:Select:

The composite clip.Result

The front matte. You cannot see changes made to the back matte when this view is se-
lected.

Matte

The back matte. You cannot see changes made to the front matte when this view is se-
lected.

Bmatte

The composite with a coloured background. The default colour is white. To select a dif-
ferent colour, click the colour swatch below the Edit Mode box. The colour picker appears.

Comp

4 To adjust the luminance curve for the front matte, select Front from the Matte box. To adjust the back
matte curve, select Back. Alternatively, click a curve to select it.

(a) 255 (White) (b) Output (remapping of luminance values) (c) 0 (Black) (d) 0 (Black) (e) Input (current luminance
values) (f) 255 (White)
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In Move edit mode, click a point to display its tangent handle and drag the handle to adjust the curve.
Use other modes in the Edit Mode box (Add, Delete, or Break, for example) to further adjust the curve,
adding or deleting points, or breaking tangent handles as needed.

Viewing a Key with a Solid Colour Background

The following optional technique can help you create cleaner keys more quickly.

While creating the key, you can view the composite using a solid colour for the background in place of the
back clip. This can help you see details in the image, such as colour spill, that you may otherwise miss. You
can use the default colour (black) or select a colour using the colour picker.

NOTE This view does not affect the final render.

To use a solid colour background:

1 Double-click the Result node.

The Matte Luminance Curves menu appears.

2 In the Result box, select Comp.

A colour pot appears.

3 Click the colour pot under the Comp view output option.

The colour picker appears.

4 Select a colour for the background using the colour picker.

Your key is displayed on a solid colour background in the Result view.

Animating Your Key

The following parameters of a key can be animated:
■ The average colour selected using the Average Colour pot in the Keyer menu
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■ The minimum and maximum Tolerance and Softness values

■ The Lift, Gain, Shrink, and Erode values

■ The blur factors for the matte and key-in clip

■ The Maximum and Minimum Input and Output level values for the histogram

To display the Animation controls in the Keyers, click Animation to the left of the keyer menus. Using the
Channel Editor, animate the parameters.

Resetting Your Key
You can reset the individual node within the Modular Keyer processing piepline. You can also reset the
entire Modular Keyer processing pipeline.

To reset individual node within the Modular Keyer processing pipeline:

1 Select the node you want to reset.

2 Right-click the node and select Reset.

The selected node is reset.

NOTE You can reset multiple nodes by holding the Command key, selecting the nodes and right-clicking
to reset.

To reset the entire Modular Keyer processing pipeline:

1 Shift+click the Result node.

2 Right-click the Result node and select Reset.

The entire Modular Keyer processing pipeline is reset.

Rendering Your Key
To view your key in the timeline, you must render it. You can render the key inside the ConnectFX view or
in the timeline.

To render your key in the ConnectFX view:

1 When you are satisfied with your key, exit the Modular Keyer by clicking the Return button.

You are taken to the ConnectFX view.

2 In the ConnectFX view, click the Render Combo box and select Render. If the Render option is already
displayed, simply click Render.

The rendering starts. A progress bar appears at the bottom of the screen.

3 After the rendering is complete, click EXIT CFX to return to the timeline.

Your original source clip is updated in the timeline and in the Viewing panel and displays the result
of your key.

A small CFX icon appears on the clip and the timeline segment.

To render your key in the timeline:

1 Once you are happy with your key, exit the Modular Keyer by clicking the Return.

You are taken to the ConnectFX view.
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2 In the ConnectFX view, click EXIT CFX to return to the timeline.

Your key is displayed in the timeline. A dotted line is displayed on the segment and you cannot view
the result, as the segment needs to be rendered.

3 From the Editing panel, click the Render Combo box and select Render. If the Render option is already
displayed, simply click Render.

The rendering starts. A progress bar appears at the bottom of the screen.

4 Once the rendering is complete, the dotted line becomes a full line and you can view the result of your
key. Your original source clip is updated in the Viewing panel and displays the result of your key. A
small CFX icon appears on the clip and the timeline segment.
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Stabilizing and Tracking

Use the Stabilizer to remove camera instability and motion jitter, and to track reference points in your clips. You can also
use the Stabilizer to produce 2D motion or lock a bilinear surface to the clip's background. With tracking, a point or points
on the clip are tracked as they move through the scene. You can then apply the resulting motion path to an object on
another layer so that it follows the same path as the object you tracked.

Stabilizing is the inverse of tracking. With stabilizing, the motion path is used to shift the scene so that the point that is
tracked remains fixed at one position.

Tracking and stabilizing are often processes of trial and error. It is recommended that you track or stabilize using the
default settings. If the tracker box strays from its original point, you can fine-tune the analysis.

Accessing the Stabilizer
You access the Stabilizer differently, depending on how you want to track or stabilize a clip. For example,
when you access the Stabilizer from the Tools tab, you stabilize with one tracker. When you access from
Action, you have the option to use two trackers. You need two trackers when the clip you want to stabilize
has a camera roll or zoom—the second tracker enables you to track the rotation and zoom of the camera.

To:Access the Stabilizer from:

Stabilize.The Tools tab

Track or stabilize.Action/ Timeline Effects Axis

Track a garbage mask or the vertices of a GMask.Keyer/ GMask

How the Stabilizer Works
The Stabilizer uses trackers to generate tracking data. Each tracker consists of a solid box, called the reference
box, and a dashed box, called the tracker box. The reference box establishes the reference point (the feature
to track or stabilize) in any frame of the sequence. The tracker box indicates to the Stabilizer where to locate
the reference point. The tracker box follows the frame-to-frame movement of the reference point.
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(a) Tracker number (b) Tracker box (c) Reference box

You start by selecting one or more reference points on your clip. Locate the first frame containing the
movement to be tracked (the reference frame). In general, the reference frame is the first frame of the
sequence. The choice of the reference point depends on whether you are tracking or stabilizing. When
tracking, the reference point is a feature you want to track; when stabilizing, the reference point represents
the point around which the image is stabilized. See Selecting a Reference Point (page 590) for details. Place
the reference box(es) around the selected feature(s).

Once you have set the tracker positions, start the tracking process, also referred to as analyzing the clip.
During the analysis, the tracker box associated with each tracker moves as the Stabilizer looks for a pattern
that matches the reference in each frame of the clip.

The Stabilizer calculates the difference between the position of the tracker box and the position of the
reference box to produce X and Y Shift values. Shift values represent a measurement in pixels and subpixels
of how much the reference point has moved.

588 | Chapter 17   Stabilizing and Tracking



When the analysis is complete, you fine-tune it if a tracker box has strayed from the reference it was supposed
to follow. Once you are satisfied with the results, you can apply the data to the clip.

To track, the Stabilizer applies the Shift values “as is.” To stabilize, the Stabilizer inverts the X and Y Shift
values in each frame of the sequence, and moves the image according to these values. This gives the impression
that the reference point stays in the same position throughout the sequence. Because the image is moved
during stabilization, a border appears on one or more edges, which means that you lose some pixels. The
following illustrations summarize the process.
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Working with Trackers
This section provides information that is common to many procedures. It is recommended that you first
read the procedure you want to perform in Selecting a Stabilizer Method (page 598) or Tracking (page 608),
and then consult this section when needed.

Selecting a Reference Point

A good reference point is a high-contrast pattern that has good definition both vertically and horizontally,
which allows for perfect registration in both directions.

Selecting a good reference point is a process of trial and error. Play the clip several times to become familiar
with the material. Ideally, you should try to find a pattern that is present in every frame. In some cases, this
is not always possible and you may have to track two different patterns, track an object that disappears
behind another one, or track an object that moves out of the frame. For more information, see Tracking
Difficult Shots and Correcting Errors (page 611).
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The frame you use for the reference point should be the frame where the reference image is most representative
in terms of shape, size, and rotation. For this reason, you can select the reference point in the middle frame
if the pattern you want to use as a reference undergoes severe rotation or scaling. In most other cases, you
will position the reference box over the reference point in the first frame of the sequence.

Selecting a Tracker

You can use any of the following methods to select a tracker:
■ Select any tracker by selecting Move or Select in the Edit Mode box and click the tracker box, the tracking

path, or the reference box of the tracker in the image window.

■ Select a tracker by clicking its corresponding button (Tracker1, Tracker2, and so on).

■ Select a tracker by pressing the corresponding number key on your keyboard. You must use the number
keys on the alphanumeric keyboard, not the numeric keypad.

■ Select any tracker by pressing the up and down arrow keys on your keyboard.

■ Select any tracker by selecting its channel in the Channel Editor.

When you select a reference box, a tracker box, or a keyframe in the image window, the timeline automatically
goes to the frame where the keyframe was set.

Positioning the Reference and Tracker Boxes

When you position the reference box, the tracker box automatically follows. You can leave the boxes together
if you place the reference box in the first or last frame of the clip. However, if you start the analysis on a
different frame from where you position the reference box, you should position the tracker box in the first
frame of the clip on the pattern you want to track. This way, the Stabilizer knows where to look for the
pattern to track when you analyse the clip.

To position the reference and tracker boxes:

1 Go to the frame where you want to position the reference and tracker boxes.

2 If the tracker and reference boxes do not appear on the image, click the appropriate Tracker button
and enable Active.

(a) Tracker buttons (b) Active button
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NOTE Each tracker is automatically assigned a different colour. However, you can customize the tracker
colour at any time.

3 Click inside the reference box to select it, and drag it over the pattern you want to track.

The reference box changes into a magnifying glass. By default, the tracker box follows the reference
box.

4 To position the tracker box on a different frame from the reference box, go to that frame and move
the tracker box over the pattern to track. To move only the tracker box, click anywhere outside the
reference box.

Moving the Reference

When you select the reference box in the image window, the timeline automatically goes to the frame where
you set the reference. For example, if you move to frame 1 and select the reference box, if the reference is
set in frame 10, frame 10 appears automatically in the image window.

To move the reference, you can:
■ Reset the reference box. See Resetting the Reference and Tracker Boxes (page 592).

■ Select Add in the Edit Mode box to add a new reference.

Resetting the Reference and Tracker Boxes

By default, the tracker box moves with the reference box. If you move the tracker box by clicking in the area
outside the reference box, it no longer follows the reference box. The new position is recorded in the Track
X and Track Y channels in the Channel Editor and has precedence over the Shift value when the tracker
box appears. If you want the tracker box to follow the reference box, you can delete the new keyframe. You
can also use the Reset box to reset the reference and tracker boxes to their default position and size.

To reset the tracker box:

1 From the Edit Mode box, select Delete.

2 Click the tracker box.

The keyframe for the tracker box is deleted and the tracker box moves to the current position of the
reference box.

3 From the Edit Mode box, select Move.

The tracker box now follows the reference box.
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To use the Reset box:

1 Select either Reset Ref or Reset Track from the Reset box.

The reference or tracker box is reset to its default position and size.

NOTE You can also select the tracker box, enable Active for the tracker, and click Delete in the Animation
menu to reset the tracker box.

Resizing the Reference and Tracker Boxes

Resize the reference box to make it surround the feature you chose to track more closely. By only including
the recognizable feature in the box with no other details that may change throughout the clip, you minimize
the possibility of the tracker losing the reference point.

TIP Sometimes a small reference point does not give good results. Try enlarging the box to include more of the
selected feature. Note that the larger the box, the slower the analysing speed.

Resize the tracker box so that it is large enough to accommodate the most frame-to-frame movement of the
reference point. For example, if the movement of the reference point is mostly horizontal, you can increase
the width and reduce the height of the tracker box. If there is a large amount of movement both horizontally
and vertically, increase both the width and the height of the tracker box. Note that the smaller the tracker
box, the faster the analysis.

To resize the reference and tracker boxes:

1 Do one of the following:
■ To resize the reference box and tracker box interactively on the frame, press a resize handle on the

box and drag.

■ To use the menu to move or resize the reference or tracker box for the current tracker, enter values
in the Reference or Track fields.

Working with Trackers | 593



TIP Use the image window Zoom command to get a closer view of the tracker and reference boxes.

NOTE To reset the reference or tracker box to its default position and size, select either Reset Ref or Reset
Track from the Reset box.

Working with Multiple Trackers

You can change a parameter for all active trackers at once. For example, you can change the dimensions of
the tracker box for all trackers or set Fixed to off for all trackers. It can be useful to hide all but a selected
tracker if you want to edit its tracking path.

(a) Tracker Selection box

To affect:Choose:

Only the selected tracker and show all trackers in the image window.Selected

Only the selected tracker and hide all other trackers.Solo

All the active trackers, except when changing the colour of the trackers.Gang

Locating a Tracker or a Keyframe

To find the number of a tracker, click any part of its tracking path in the image window. To find the frame
number associated with a particular keyframe, click the keyframe. The timeline moves to the corresponding
frame.
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(a) When you select a tracking path, the tracker number appears here.

Locating a Shift Channel

Use the Expand/Collapse button to locate a Shift channel quickly.

To locate a Shift channel:

1 Select Gang in the Tracker Selection box.

You can now change a parameter for all active trackers at once.

2 Click on the tracking path in the image window.

3 Toggle the Expand/Collapse button to Expand.
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4 Click Animation to display the Channel Editor.

5 Scroll up or down to display the Shift folder.

The Shift curve of the tracker appears in the Channel Editor.

Speeding Up the Analysis

To speed up the analysis, disable the Icons and Path buttons in the Setup menu before starting. This turns
off the display of the tracker and reference boxes, as well as the tracking path. Re-enable the buttons to
fine-tune the analysis.

Manual 3D Tracking

Before you start manual 3D tracking, you should examine the clip closely to determine the points you want
to track. The quality of the 2D track has a direct impact on the 3D tracking result, so it is important that
you have a strategy for positioning the trackers in the clip sequence. Use the Stabilizer to track and stabilize
the clip as accurately as possible. See Selecting a Stabilizer Method (page 598).

For optimum results, each frame in the clip you are tracking must contain at least six track points. In the
Stabilizer, this means six trackers are enabled. Also, at least two frames in the clip sequence must have a
minimum of eight trackers, and these two reference frames should show the widest camera movement.

When tracking, the more track points you have in each frame, the smoother and more accurate the tracking
result will be. As you place the trackers on the image, consider the following guidelines:
■ Scatter the trackers by placing them on markings, corners, and shadows in the widest area possible. For

example, avoid placing all trackers on the floor; place them on walls and other objects in the scene, as
well as on the floor.

■ Create a sense of depth by positioning trackers on points that lie in different planes, as well as on points
located in the foreground and the background of the sequence.

■ Avoid tracking points such as highlights or a point where the foreground and a background object meet,
as they do not represent physical 3D points.

■ Balance the number of trackers within each frame of the sequence so that as you move through the clip,
some points leave the frame and other points appear in the frame. However, maintain a balance so that
too many points do not leave or enter the frame at the same time.

■ Avoid positioning the trackers in uniform areas or on linear edges where the track points may slide along
the edge.
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To set up manual trackers:

1 In Action, click 3D Track.

2 From the 3D Tracker Option box, select Manual.

3 Click Stabilizer to open the Stabilizer menu.

4 Add trackers to the scene by clicking Add Tracker.

NOTE You can track points only on the back clip that you load in Action.

5 Drag each tracker to a position on the image following the guidelines described in Tracking (page 608).

You should have at least six trackers active at any one time, and at least two frames should have eight
active trackers.
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6 In the Stabilizer menu, click Analyse to process the 2D tracking path and check your result.

7 Click Return to return to the 3D tracking controls.

When you track a pattern that appears to drift or stray, you should set more intermediate trackers in the
frames of the sequence, and ensure both the first and the last reference frames are set properly.

Selecting a Stabilizer Method
Use the stabilizer to remove unwanted shaky motion and to smooth the camera motion. It can separately
smooth motion with respect to translation, rotation and scaling in an image sequence to produce a stabilized
image.

Stabilizing a clip is divided into two parts. First, the movie is scanned frame by frame, while the motion
within the movie is tracked, and the related tracked motion data is recorded. With trackers installed, you
can play the stabilized clip.

The first step to stabilizing a clip is to select an appropriate stabilization method.

Stabilization Methods

Auto Stabilize

■ No way to add manual trackers.

■ Requires the least work to stabilize a clip.

■ Can stabilize simple 2D motion, scaling and rotation, and perspective transformation.

■ Tries to do best effort.

■ Can smooth or pin the detected motion.

■ Can remove jitter but keeps camera motion.

■ Can adapt resolution and advanced padding options.

Where possible, start with this stabilization method.

Stabilizer

■ Requires you to add manual trackers.

■ Enable simple padding and texture repeat options.

■ Can only stabilize simple 2D motion.

2D Transform

■ Can stabilize simple 2D motion, scaling and rotation.

■ Can adapt resolution and advanced padding options.

NOTE To access any of the above stabilizers:

1 Select the Transform tab in the Tools tab.

2 Enable the preferred stabilizer (Auto Stabilize, Stabilizer, or 2D Transform).

3 Pick the clip, then click on an empty part of the Thumbnail view.

You are in the selected stabilizer editor.
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Workflow

Step1: Consider your goal and select a method of stabilizing the clip.

Goal: To Stabilize Simple 2D motion (click here).  (page 599)
■ Auto Stablize

■ Stablizer

■ 2D Transform

Goal: To Stabilize Motion or Scaling or Rotation (click here).  (page 601)
■ Auto Stabilize

■ 2D Transform

Goal: To Stabilize a Perspective Transformation (click here). (page 602)
■ Auto Stabilize

Step 2: Determine the quality of the result of the stabilization method. Change stabilization method if
necessary.

Depending on the goal of the stabilization, not all methods may be available. For example, if doing perspective
transformation, Auto Stabilize is the only option available.

1 If Auto Stabilize does not provide adequate results, then use Stabilizer.

2 If Stabilizer does not provide adequate results, then use 2D Transform.

Simple Stabilization

Use simple stabilization to stabilize a clip where there is no pan or tilt.

To stabilize when there is no pan or tilt:

1 Select Tools ➤ Composite ➤ Stabilizer.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are in Stabilizer.

4 Switch to Front view.

5 Position Tracker1 over a pattern that you want to stabilize.

6 Click Analyze to generate the stabilization data.

7 Fine-tune the data if necessary. See Tracking Difficult Shots and Correcting Errors (page 611).

8 Switch to Result view to see the stabilized shot.

9 Adjust the framing options as you need (Roll, Fill, Crop Edges, Letterbox, Shift).

10 Once you are satisfied with the stabilization, go to frame 1, make sure Tracker 1 is still active, and click
Render.

To stabilize using Auto Stabilize:

1 Select Tools ➤ Composite ➤ Auto Stabilize.
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The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are in Auto Stabilize.

4 Select 2D Stabilization from the Stabilization Method box.

You are performing a two-dimensional analysis.

5 Switch to Front View.

6 Optional: Enable the Region Of Interest button.

Indicate the region you want to analyze on the front clip.

7 Click the Analyze button.

Analysis takes place. This may take some time however you will see the percentage of progress in the
analysis in the Progress field.

8 Switch to Result view to see the stabilized shot.

9 Enable the Components (Position X, Position Y) that you want to stabilize.

10 For these components select either Fixed or Smooth.
■ Fixed pins the component during the analysis.

■ Smooth removes the jittering with 0% being the original motion and 100% removing the highest
frequency jitter.

The analysis is complete.

NOTE The default reference frame is the first frame of the clip. You can change the reference frame of the analysis
by defining a new reference point.

To define a new reference point:

1 Position the positioner to the desired frame.

2 Click the Set Frame button.

The analysis will readapt the timing of the transformation; stabilization will occur before and after the
set frame.

To stabilize using 2D Transform:

1 Select Tools ➤ Composite ➤ 2D Transform.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

4 Select Pan & Scan from the Transform Type box.

You are now limited to modifying only the position and scale.

5 In the Stabilization tab, select the Enter Stabilizer button.

You are in Stabilizer.

6 Position Tracker 1 over a pattern that you want to stabilize.

7 Click Analyze to generate the stabilization data.

8 Fine-tune the data if necessary. See Tracking Difficult Shots and Correcting Errors (page 611).

9 Once you are satisfied with the stabilization, exit back to 2D Transform.
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10 Enable the Components (Position X, Position Y) that you want to stabilize.

11 Adjust the framing options as you need (Roll, Fill, Crop Edges, Letterbox, Shift) .

NOTE The default reference frame is the first frame of the clip. You can change the reference frame of the analysis
by defining a new reference point.

To define a new reference point:

1 Position the positioner to the desired frame.

2 Click the Set Frame button.

The analysis will readapt the timing of the transformation; stabilization will occur before and after the
set frame.

Stabilizing Motion, Scaling, and Rotation

To stabilize Motion, Scaling and Rotation using Auto Stabilize:

1 Select Tools ➤ Composite ➤ Auto Stabilize.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are in Auto Stabilize.

4 Select 2D Stabilization from the Stabilization Method box.

You are performing a two-dimensional analysis.

5 Switch to Front View.

6 Optional: Enable the Region Of Interest button.

Indicate the region you want to analyze on the front clip.

7 Click the Analyze button.

Analysis takes place. This may take some time however you will see the percentage of progress in the
analysis in the Progress field.

8 Switch to Result view to see the stabilized shot.

9 Enable the Components (Position X, Position Y, Scaling, Rotation) that you want to stabilize.

10 For these components select either Fixed or Smooth.
■ Fixed pins the component during the analysis.

■ Smooth removes the jittering with 0% being the original motion and 100% removing the highest
frequency jitter.

The analysis is complete.
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NOTE The default reference frame is the first frame of the clip. You can change the reference frame of the analysis
by defining a new reference point.

To define a new reference point:

1 Position the positioner to the desired frame.

2 Click the Set Frame button.

The analysis will readapt the timing of the transformation; stabilization will occur before and after the
set frame.

To stabilize Motion, Scaling and Rotation using 2D Transform:

1 Select Tools ➤ Composite ➤ 2D Transform.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

4 Select Pan & Scan from the Transform Type box.

5 In the Stabilization tab, select the Enter Stabilizer button.

You are in Stabilizer.

6 Position Tracker 1 over a pattern that you want to stabilize.

7 For stabilizing scaling and rotation you must position Tracker 2 over a pattern.

8 Click Analyze to generate the stabilization data.

9 Fine-tune the data if necessary. See Tracking Difficult Shots and Correcting Errors (page 611).

10 Once you are satisfied with the stabilization, exit back to 2D Transform.

11 Enable the Components (Position X, Position Y, Scaling, Rotation)that you want to stabilize.

12 Adjust the framing options as you need (Roll, Fill, Crop Edges, Letterbox, Shift).

NOTE The default reference frame is the first frame of the clip. You can change the reference frame of the analysis
by defining a new reference point.

To define a new reference point:

1 Position the positioner to the desired frame.

2 Click the Set Frame button.

The analysis will readapt the timing of the transformation; stabilization will occur before and after the
set frame.

Stabilizing a Perspective Transformation

To stabilize Motion, Scaling and Rotation using Auto Stabilize:

1 Select Tools ➤ Composite ➤ Auto Stabilize.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.
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You are in Auto Stabilize.

4 Select Perspective from the Stabilization Method box.

The Perspective button is enabled.

5 Switch to Front View.

6 Optional: Enable the Region Of Interest button.

Indicate the region you want to analyze on the front clip.

7 Click the Analyze button.

Analysis takes place. This may take some time however you will see the percentage of progress in the
analysis in the Progress field.

8 Switch to Result view to see the stabilized shot.

9 For the Perspective component select either Fixed or Smooth.
■ Fixed pins the component during the analysis.

■ Smooth removes the jittering with 0% being the original motion and 100% removing the highest
frequency jitter.

The analysis is complete.

NOTE The default reference frame is the first frame of the clip. You can change the reference frame of the analysis
by defining a new reference point.

To define a new reference point:

1 Position the positioner to the desired frame.

2 Click the Set Frame button.

The analysis will readapt the timing of the transformation; stabilization will occur before and after the
set frame.

Manually Stabilizing 2D Motion

To manually stabilize 2D motion:

1 Select Tools ➤ Composite ➤ Stabilizer

The cursor will change to Pick Front.

2 Select the front clip.

Your source clip is rendered (if needed).

The cursor will change to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are now in the stabilizer.

Stabilizing a Clip from Action

You can import stabilizing data to lock the position of an axis in relation to a reference point on the front
clip. This means that any movement in the front clip is matched by the axis. You can enter the Stabilizer
from Action to stabilize an image so that the axis changes to keep the reference point fixed against the
background.
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To stabilize a clip from Action:

1 Load the clips into Action.

When selecting clips, keep in mind that the front clip is the image that you want to stabilize and the
back clip contains the reference point you want to track. Also, the clips must be of the same resolution.

2 In the Axis menu for the selected media, make sure that the motion path is disabled (Path button).

(a)  Stabilizer button (b) Stabilizer Option box (c) Tracking Rotation Option box (d) Tracking Scale Option box
(e) Motion Path button

NOTE Do not move the axis from its default position at the centre of the image window before entering
the Stabilizer, or else the tracking data will be overwritten. Use the offset axis to add an offset to the tracker
movement instead.

3 In the Stabilizer Option box, select Stabilize and click the Stabilizer button.

The front clip is automatically loaded into the Stabilizer and the Stabilizer menu appears.

4 In the Stabilizer, position Tracker1 over the reference point that you want to track.

5 To help you view your tracking result without any objects blocking the view, enable the Context
button. While similar to a result view, the context view allows you to see all of the Action scene, except
for the selected node (and any children of the selected node).

6 Depending on the performance of your system and the complexity of your Action setup, you can
enable Linetest in the setup menu to display the context view at a lower resolution.
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When you play the clip in Action context, you can see the front image follow the inverse movement
of the reference point in the front clip.

7 Click Analyse to generate the translation data.

8 Once the analysis is complete, make sure that Tracker1 is still active, and click Return.

When you exit the Stabilizer, the X and Y Shift values for the reference position are automatically
copied into the X and Y translation channels for the selected axis in Action.

Removing Jitter While Keeping Overall Motion

Use the Jitter option to remove the jitter from a clip while retaining the overall motion. The Stabilizer
calculates the difference between an average applied to the channel by using the current Over value and
the original tracking data. Applying this curve leaves only the jitter values as keyframes. Copying these
curves can also be useful if you want to extract the jitter values to apply to another clip.

The Jitter option removes jitter in a clip on both the X and Y axes simultaneously, and averages the pan
over time so that it appears even. Jitter control offers more flexibility than Fixed X and Fixed Y, which
remove motion in one direction only. Use Fixed X and Fixed Y in simple situations, or to produce a result
quickly.

Removing jitter is a process of trial and error. Try different Over values until you find one that yields good
results. As a general rule, start with a large Over value over n frames to remove slow jitter, and start with a
small Over value to remove fast jitter.

To remove jitter and keep overall motion:

1 Select Tools ➤ Composite ➤ Stabilizer.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are now in Stabilizer.

4 Position Tracker1 over a pattern you want to stabilize.

5 To automatically remove the border at the edges of the clip, select Crop Edges from the Scaling and
Shifting box.

6 Go to the reference frame, and click Analyze to generate the Shift data.

7 Click Animation to display the Channel Editor. Select the tracker number and expand the Shift folder.

The Shift curves turn white when the Shift channel is selected.

8 Select Keyframe from the Animation Controls box, and then enter an Over value in the Curve Value
field.
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(a) Animation Controls box (b) Curve option box (c) Curve Value field

9 Select Jitter from the Curve option box. If Jitter was already displayed when you entered the Over value,
select it again to apply the Over value.

The transformation is applied to the curves. The curves show the amount of motion that the Stabilizer
will remove. They should wrap around the zero point and should not be entirely flat; otherwise, the
Stabilizer will not remove any jitter.

10 Click Result and play the clip to determine if it is stable enough. If the clip is stable enough, click Exit.
To revert to the original shift data, click Paste.

11 Repeat from step 7 with different Over values until you are satisfied with the results.

Removing Jitter with Fixed X and Fixed Y

The Fixed X and Fixed Y buttons remove motion in one direction only. Enable the Fixed X button to remove
vertical jitter only. Movement on the horizontal (X) axis, such as a camera pan, is not affected. Enable the
Fixed Y button to remove horizontal jitter. Movement on the vertical (Y) axis is not affected.
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Smoothing Out Camera Motion
Use the Average options to smooth out uneven camera motion. For example, if the camera moves at a certain
rate and suddenly drops or increases in speed, the Average option can stabilize the camera motion.

The Average option smooths camera motion over a group of keyframes. Use the Curve Value field to determine
how much stabilizing is applied to the clip. A larger value averages camera motion over more keyframes and
increases camera smoothness. Use Average to affect the Stabilizer's Shift values since Shift represents the
amount of movement in a clip.

Analyse your clip to generate the initial channel data, then select the channel to apply the average to.

To smooth out camera motion:

1 Position the tracker(s) on your image and click Analyse.

2 Click Animation to open the Channel Editor and expand the Shift folder for the track(s).

3 Select the X or Y Shift folder and enter an average value in the Over field.

4 Select Keyframe from the Animation Controls box, and then enter an average value in the Curve Value
field.

(a) Animation Controls box (b) Curve option box (c) Curve Value field

5 Select Average from the Curve option box.
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Tracking
You can use the Stabilizer to make a clip or part of a clip track an object in another clip. For example, you
can paste a logo to the side of a moving car. You can track a clip using one, two, or four reference points:
■ In one-point tracking, one reference point is tracked to produce 2D motion without rotation or scaling.

■ In two-point tracking, two reference points are tracked to generate translation, scaling, and rotation data
that is applied to the foreground composite.

■ In four-point tracking, the tracking data generated from four reference points is used to lock the four
corners of a bilinear surface to the background in Action.

Since tracking involves compositing at least two clips, you open the Stabilizer from Action. When loading
the clips in Action, you load the clip that contains the pattern you want to track as the back clip. The method
for selecting the object that follows the pattern on the back clip is different for four-point tracking than it
is for one and two-point tracking. Both methods are explained in the following sections.

One-Point and Two-Point Tracking

In both one-point and two-point tracking, you select the object that follows the pattern on the back clip by
assigning the tracking data to its axis in Action.

For one-point tracking, you use only one tracker (usually Tracker1) to generate position information. For
two-point tracking, you use a second tracker (usually Tracker2) to generate rotation and/or scaling information.
The Stabilizer obtains this information by comparing the position of Tracker2 to that of Tracker1.

Before you select the two reference points on the back clip, note the task of each tracker:
■ Tracker1 follows the horizontal and vertical translation of the reference point. You should position

Tracker1 over a point on the pattern that you want to track.

■ Tracker2 tracks the rotation and/or the change in size of the pattern. In the first frame, the rotation is
always 0 and the scaling factor is always 100%. In subsequent frames, a rotation and/or scaling factor is
added if the relative position of the two trackers changes. You should position Tracker2 over a point that
represents the rotation or change in size of the pattern.

When you open the Stabilizer from Action for two-point tracking, you can select whether you want rotation
information, scaling information, or both. The choice depends on the movement of the object to track and
on the camera movement in the clip.

To perform one-point or two-point tracking in Action:

1 Load a front and back clip in Action.

The front clip contains the object and the back clip supplies the pattern that you want to track.

2 In the Axis menu for the selected media, make sure that the motion path is disabled (Path button).
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(a)  Stabilizer button (b) Stabilizer Option box (c) Tracking Rotation Option box (d) Tracking Scale Option box
(e) Motion Path button

NOTE Do not move the axis from its default position at the centre of the image window before entering
the Stabilizer, or else the tracking data will be overwritten. Use the offset axis to add an offset to the tracker
movement instead.

3 In the Stabilizer Option box, select Track.

4 From the Tracking Rotation option box and Tracking Scale option box, set the tracking options.

To:Select:

Do one-point tracking.Rotation Off and Scaling Off

Do two-point tracking.Rotation On and/or Scaling On

Invert the rotation data.Rotation Inv

Invert the scaling data.Scale Inv

5 Click the Stabilizer button.

The Stabilizer opens and the back clip appears.

NOTE If the wrong clip appears in the image window, return to Action and change the back clip to the clip
that contains the pattern you want to track.

6 Position the tracker(s) over the pattern(s) that you want to track, and click Analyse to generate the
tracking data.

NOTE You can fine-tune the tracking data if necessary. See Tracking Difficult Shots and Correcting Errors
(page 611).

7 Once you are satisfied with the tracking, make sure the trackers you used are still active, and then click
Return.

The Axis menu in Action reappears. The tracking data is applied to the front clip.
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Four-Point Tracking

With four-point tracking, you use four trackers in the Stabilizer to generate tracking data for anchoring the
four corners of a bilinear surface to the background clip. The bilinear surface then tracks the horizontal and
vertical translation of the reference points on the background clip.

Because four-point tracking applies to surfaces, you select the object that follows the pattern on the back
clip by assigning the tracking data to its bilinear surface in Action.

The markers you use must be well defined and should be planned when shooting the sequence. It is not
always possible to do four-point tracking when the markers are not well defined.

To perform four-point tracking:

1 Load front and back clips in Action.

The front clip supplies the surface and the back clip supplies the four anchor points that you want to
track.

2 Double-click the image node in the schematic to display the Surface menu.

3 Select Bilinear from the Shape box.

4 Click the Vertices tab to display the Stabilizer button and tracking options.

5 In the Stabilizer Option box, select Track

6 Click the Stabilizer button.

The Stabilizer opens and the back clip appears.

NOTE If the wrong clip appears in the image window, return to Action and change the back clip to the clip
that contains the pattern you want to track.

7 Position the four trackers on the background clip, and click Analyse to generate the tracking data.

NOTE The trackers should be positioned in order; otherwise, the result will be inverted or displaced. Place
Tracker1 in the upper left area of the image to be tracked, Tracker2 in the upper right, Tracker3 in the lower
left and Tracker4 in the lower right.

8 After the analysis is complete, make sure the trackers are still active, then click Return.

The Surface menu in Action reappears. The tracking data is automatically applied to the four corners
of the bilinear surface.

Using Offsets

Instead of anchoring the entire front image to the back clip, you may only want to use a small region of the
image. You can move the four corner anchor points anywhere inside or outside the front image to define
the area of the front image that you want to use, and animate the resulting offsets.

If the anchor point offsets need to change from frame to frame to track a pattern on a bilinear surface, you
can use the Stabilizer to generate the offsets automatically. Note that the image can be distorted when you
use this method.

To generate the offsets using the Stabilizer:

1 Track the four anchor points on the back clip.

2 Display the Action Surface menu for the bilinear surface that you tracked.

3 In the Vertices tab, enable Edit Offsets and use the Offsets controls to edit the offsets to match the
corners of your square.

4 Click the Stabilizer button.
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The front clip appears in the Stabilizer.

5 Position the four trackers on the front clip in the same order as the four anchor points.

6 Click Analyse to generate the tracking data. After the analysis is complete, make sure the trackers are
still active, then click Return.

The Surface menu in Action appears. The tracking data is automatically applied to the front clip.

You can also animate the offsets. The animation channels for the anchor point offsets are in the Offsets
channel of the bilinear surface in Action Animation menu. To maintain resolution independence, each X
and Y value is expressed as a percentage relative to its corresponding corner. Each anchor point offset starts
with a default value of zero. For example, if you change the upper-left X offset value to 20, then the upper-left
anchor point is moved inside the bilinear surface by 20%. Negative values offset the anchor points outside
the bilinear surface.

You can also use the Copy and Paste buttons in the Channel Editor to copy one anchor point offset setup
to another.

Tracking Difficult Shots and Correcting Errors
If the tracker box strays from the reference point that it is supposed to be tracking, incorrect shift keyframes
result. If such an error occurs, you can stop the analysis, correct it, and restart it at any frame.

This section covers the different strategies you can use to track difficult shots. After trying any of the strategies,
you will need to redo the analysis. Click Analyse to generate new keyframes based on the updated information
you provide.

Resetting the Shift Data

Although it is not necessary, you can erase old keyframes before redoing the analysis.

To reset the shift data:

1 Select Reset Shift from the Reset box.

The shift value reverts to 0.
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Adjusting the Size of the Tracker Box

If the Stabilizer cannot find the reference point within the boundaries of the tracker box during analysis,
the tracker box will stray from the reference point and produce incorrect keyframes. Although you can
manually correct these keyframes, it is easier to make the tracker box large enough to accommodate the
movement of the reference point. Note that processing time increases as the size of the tracker box increases.
See Resizing the Reference and Tracker Boxes (page 593).

To adjust the size of the tracker box:

1 Press on the pen or hold down the left mouse button to stop the analysis.

NOTE Make sure to press below the timeline to avoid moving the tracker box.

2 Go back to the last good frame before the tracker box strayed from the reference point.

3 Adjust the size of the tracker box so that it is large enough to accommodate the largest frame-to-frame
movement of the reference point.

4 Click Snap, and then click Analyse.

Positioning the Tracker Box Manually

When the reference point is temporarily covered by another object, position the tracker box manually.

When you manually position the tracker box, the new position is recorded in the Track X and Track Y
channels of the Channel Editor. These values have precedence over the Shift X and Shift Y values.

To manually position the tracker box:

1 Press on the pen or hold down the left mouse button to stop the analysis.

NOTE Make sure to press below the timeline to avoid moving the tracker box.

2 Advance the clip to the frame where the reference point becomes visible again, and reposition the
tracker box over the reference point. Click Analyse to restart the analysis at this frame.

Since the X and Y shifts are recorded as keyframes in channels, the Stabilizer calculates the translation
values for the frames in which the reference point was covered. The final result will be a smooth motion.

Locking Keyframes in Place

You can lock Shift keyframes so that they stay in place even if you try to move them manually or perform
an analysis. This is useful, for example, when you set keyframes manually and want to prevent Smoke from
overwriting them when you redo the analysis.

In the following procedure, you select the keyframes directly in the image window. However, you can also
select the Shift keyframes in the Channel Editor.

NOTE You cannot lock several keyframes at once. You must lock each keyframe individually.

To lock keyframes in place:

1 If the tracking path does not appear in the image window, enable Motion Path in the Setup menu.

2 Zoom in on the image until you can see the points clearly and select the point you want to lock on
the tracking path.
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The tracking path becomes white when you click it, and the frame that corresponds to the keyframe
appears in the image window.

(a) The inside of locked keyframes are filled (b) The tracker box appears when you select a keyframe

3 Click Lock Key.

4 To unlock a keyframe, select it and click Unlock Key.

Changing the Reference Point

Change the reference point to another feature if the feature you have been tracking moves out of the frame,
or alters such that it is no longer trackable. You should do this before the original reference point moves
out of the frame. This allows the Stabilizer to calculate the offset between the two reference points and
predict the position of the original reference point. If the Path button in the Setup menu is enabled, you
will see the extrapolated path of the original reference point.

Change the reference point before analysing the clip.

To change the reference point:

1 Click Setup and then enable Path.

2 Select the tracker for which you want to change the reference point.

3 Display the desired frame in the image window.

4 Select Add from the Edit Mode box.

5 Ctrl+Shift-drag the reference box and position it on the new reference point.
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6 Go to the first frame of the sequence and click Analyse.

Finding the Best Tolerance Value

The Tolerance value determines how much discrimination the Stabilizer uses in matching the reference
point from frame to frame and in setting a keyframe for that frame. At 100% tolerance (no discrimination),
almost anything is considered as a match and a keyframe is set. At 0% tolerance (complete discrimination),
only a perfect match is accepted.

If the reference point becomes hidden by another object, you can use the Tolerance value to make the tracker
ignore the reference point in parts of the clip where it is hidden, then continue tracking it normally when
it reappears. Choosing a good Tolerance value reduces the need to manually reposition the tracker box
during analysis.

TIP You can also adjust the tolerance to make a desirable keyframe that has been filtered out reappear.

To find the best Tolerance value:

1 Click Setup and then enable Path to view the tracking path.

2 Analyse the clip with full (100%) tolerance.

3 Go to the first frame where the reference point is hidden by another object and adjust the tolerance
value until the crosshair reappears in the tracker box.

The crosshair reappears when there is a keyframe.

4 Go to the first frame in the sequence and click Analyse.

Once you determine the optimal tolerance value, further analysis automatically discards the undesirable
keyframes, and the position of the reference point is extrapolated until the reference point reappears.

Analysing Backward

Analyse the clip backward when the pattern you want to track grows larger or when it is off screen at the
beginning of the clip.

NOTE You cannot analyse backward if you need to change or snap the reference. In this case, reverse the clip
without interpolation before entering the Stabilizer and analyse it forward.
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To analyse backward:

1 Select Backward from the Direction box.

2 Go to the last frame of the sequence.

3 Position the reference and tracker boxes.

4 Click Analyse.

Tracking Manually

Track manually when the pattern you are tracking disappears behind an object for several frames, moves
out of the frame, or is extremely difficult to track.

Tracking a Pattern that Disappears

Tracking a pattern that disappears is easier to do when the Fixed option is off. However, the results may not
be as accurate because any small errors you make in positioning the tracker box are compounded when
Fixed is off. Leave Fixed on when possible.

To track a pattern that disappears:

1 Go to the last keyframe before the reference point disappears.

2 Click Snap to redefine the reference point on this frame.

3 Select Add in the Edit Mode box.

4 Ctrl+Shift-drag the tracker box to the required position in the current frame.

Use the reference image you see in transparency as a guide to find the new position. A keyframe is set
and the timeline advances one frame forward or backward when you release the pen. The direction of
the timeline depends on the setting in the Direction box.

NOTE If you do not see the reference image in transparency, set the Opacity option in the Setup menu to
approximately 50%.

5 Repeat step 4 as necessary.

TIP Lock the keyframes as you add them.
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Tracking an Erratic Pattern Manually

Using this method, you create part of the tracking path manually. You can either add a keyframe in each
frame, or add keyframes in significant frames of the clip and extrapolate the curve for the other frames.

You must delete unwanted keyframes before you can add new ones.

TIP To go to the desired frame, select Move in the Edit Mode box and click on the corresponding keyframe in
the image window.

To track an erratic pattern manually:

1 Erase any bad keyframes by selecting Delete in the Edit Mode box and clicking the bad keyframes in
the image window.

2 Go to the last good frame before the frame where you want to start tracking manually.

3 Click Snap to redefine the reference on this frame.

NOTE If you are tracking a whole clip manually, position the reference box on the pattern to track.

4 Select Add from the Edit Mode box.

5 Select one of the following options from the Interpolation Mode box.

■ To set critical keyframes only, select Bézier.

■ To set keyframes on every frame, select Linear.

6 Add a keyframe by holding Shift and dragging the tracker box over the reference point.

You should see the reference image in transparency. The keyframe is added in the following frame
when you release the mouse button or lift the pen.

NOTE If you do not see the reference image in transparency, make sure you have defined a reference and
check that the Opacity is set to approximately 50% in the Setup menu.

7 Repeat step 6 for every frame where you want to define a keyframe.

8 Play the clip and adjust the tracking path by moving or adding keyframes.
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Analysing One Frame at a Time

Analysing one frame at a time is useful for difficult shots because you can adjust the position of the tracker
after each frame. Click the Step button to analyse a single frame and advance to the next frame.

Editing the Stabilizer Channels on the Image

You can edit the tracker channels directly on the image instead of editing them in the Channel Editor. Note
that the curve on the image shows the X and Y components together and not separately like in the Channel
Editor. The tracking path on the image shows the actual displacement of the tracker box.

To edit the curve directly in the image window, Path must be enabled in the Setup menu. When you select
a keyframe on the curve, the timeline goes to the frame that corresponds to the keyframe. When you select
the reference box, the timeline goes to the frame where you set the reference.

When you edit the tracking path in the image window, all the options in the Edit Mode box are available
except Rect Zoom, Zoom, and Pan.

Tracking a Degraded Copy of the Clip

If other options do not work, you can try degrading a copy of the image until the contrast of the pattern to
track is high enough. You then generate tracking data from this copy, save the setup, and apply it to the
original clip. Try the following methods for degrading the clip:
■ Saturate the colours in the Colour Corrector.

■ Increase the contrast in the Colour Corrector.

■ Apply filters (for example, Emboss).

■ Remove film grain using Degrain.

Setup Options
Use the options in the Stabilizer menu to specify preferences for tracking and the user interface. Use the
options in the Setup menu to specify general and rendering preferences.
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Changing the Colour of Trackers

When you add a new tracker, the system automatically assigns it a unique colour so that you can easily
distinguish between multiple trackers. You can change the colour of an individual tracker or of all the trackers
at once.

To change the colour of the tracker:

1 Click the Tracker button that corresponds to the tracker you want to change.

TIP To change all trackers, select Gang in the Tracker Selection box.

2 Click the Tracker colour pot.

3 Select a colour with the colour picker.

4 Click in the Tracker colour pot to apply the new colour to the tracker.

Pretracking a Clip

Before analysing, you can use the Pretracking option in the Setup menu to preview the motion path for a
specified number of frames. You can then adjust the tracker position, if necessary, to find the best reference
point. The Pretracking option applies only to the selected tracker, regardless of whether you selected Solo,
Selected, or Gang in the Tracker Selection box. If you move or resize a tracker with Pretracking enabled, the
next frames are analysed.

To pretrack a clip:

1 Position and select a tracker.

2 In the Setup menu, make sure that Path is enabled. If it is disabled, Pretracking is not available.

3 Enter the number of frames to pretrack.

NOTE If you enter a number larger than the length of the clip, only existing frames are pre-tracked.

4 Enable Pretracking.

The motion path appears.

NOTE Frames, not fields, are pretracked. If you are in Fields mode, frames will be pretracked.
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Copying Shift Channels
Using the Channel Editor, you can copy a tracker's Shift channel values and paste them into any other
channel in any module. For example, you can copy jitter values to the X and Y position channels of an axis
to add realism to a static scene, or to a channel to add noise.

There are two Copy buttons in the Stabilizer. One takes the aspect ratio of the clip into account and the
other one does not.

(a) This Copy button takes the aspect ratio into account (b) This Copy button does not take the aspect ratio into account

The coordinate system that the Stabilizer uses for mapping pixels on the image differs from the system used
by other tools. In the Stabilizer, the pixel with coordinates (0,0) is in the lower-left corner, while in most
other modules it is in the centre of the screen. When pasting shift curves to the channels of an axis, use the
Copy button that takes the aspect ratio into account. Since this button also accounts for the differences in
pixel coordinates between tools, it ensures that the values are mapped properly.

To copy and paste a shift channel:

1 In the Channel Editor, open the folder of the tracker whose shift values you want to copy.

2 Select the X or Y Shift channel, or the entire Shift folder to select both X and Y Shift channels.

3 Click one of the Copy buttons, depending on whether or not you want to maintain the aspect ratio.

4 If necessary, load the clip to which you want to apply the Shift values into the appropriate tool.

5 Open the folder of the channel to receive the copied shift values and select the appropriate channel(s).

6 Click Paste.

Importing and Exporting Data
Import and export tracking and shift data values to an ASCII file using the Import and Export buttons located
in the Track and Shift areas of the Stabilizer menu.
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The tracking data specifies the X and Y position of the tracker box in relation to the origin point of the
image; these are absolute coordinate values. The origin point has coordinates (0,0), and is located at the
lower-left corner of the image.

The shift data specifies the difference between the position of the reference box (0,0) and the position of
the tracker box in the current frame. These are relative coordinate values.

Both the Tracking values and the Shift values are formatted as follows:

frame#: X position, Y position

NOTE If the position of the reference box is changed during the analysis, the offset is compensated for and the
exported tracking data still shows a continuous tracker path.
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Masking and Rotoscoping

When pulling a key, use garbage masks to isolate particular areas of an image to include with, or exclude from, the opaque
area of the matte. Garbage masks are spline-based objects you draw directly on a clip or image. Depending on what you
want to accomplish, you can set the area inside each garbage mask to be either opaque (white), transparent (black), or
semi-transparent (any shade of grey).

Garbage masks are useful in many situations, such as when removing unwanted elements like equipment or people from
a blue-screen shot, when removing unwanted borders from an image, or when creating complex keys by blending portions
of the front and back clips. You can animate the shape of a garbage mask, apply motion blur to it, and even use the
Stabilizer to make a garbage mask follow a moving element in a clip.

The following example illustrates keying out an unwanted white border using a garbage mask.

Matte after garbage mask is appliedMatte before garbage mask is applied

You can also apply softness to the edge of a mask using a uniform or advanced gradient. Instead of having an abrupt
transition from white to black in the matte, you can control the gradations of grey between the key and the background.
For example, softness can compensate for uneven edges of a key by blending the front and back clip. You can apply
uniform softness around the edge of a mask or vary the softness range for different parts of the mask.
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An advanced gradient adds two splines around the garbage mask. By moving points on these splines, you can control the
gradient according to how far the surrounding spline is offset from the garbage mask.

Advanced gradient varies softness for different parts of the garbage
mask

Image courtesy of Behavior Communications Inc.Softness applied around edge of garbage mask spline

Image courtesy of Behavior Communications Inc.

Using Garbage Masks in ConnectFX and the Modular Keyer
Certain garbage mask features are supported only in the GMask node in ConnectFX and the Modular Keyer.

You can use a parameter called Region of Interest (ROI) when drawing multiple garbage masks on a clip to
remove the portion of the matte that falls outside of each mask while respecting the area defined by all
masks.

ROI enables you to reveal multiple parts of the matte.

Image courtesy of The Post Group

You also have the option of using the Tracer with an advanced gradient. The Tracer is an additional softness
tool you can use to pull a key from scratch. This allows you to key images with a lot of detail at the edges.
It uses a system of localized keys, called pickers, which analyse the colour information both inside and outside
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the mask to derive a key for the mask edge. You can use both the Tracer and the advanced gradient within
the same garbage mask.

The Tracer is particularly useful for keying challenges such as:
■ Very fine, wispy talent edges (hair, fur, or lace) where a blue or green screen may show through.

■ An object not shot on a blue or green screen.

Garbage mask with pickers sampling image for more ad-
vanced softness

Image courtesy of Behavior Communications Inc. Garbage mask with pickers applied to only select vertices,
the remainder using an advanced gradient

Image courtesy of Behavior Communications Inc.

The Stabilizer and pickers are not available when this type of input is attached to the node.

Accessing the Garbage Mask Menu
Access the Garbage Mask menu from the Modular Keyer or the GMask node when you want to use multiple
garbage masks or use the Tracer for detailed masks.

Use the Garbage Mask to isolate particular areas of an image to include with, or exclude from, the opaque
area of the matte.

To access the Garbage Mask menu, use:
■ Timeline, then use ConnectFX (page 624).

■ Modular Keyer, then select a node from the Node bin. (page 624)

This node accepts a front and a matte clip as input, and outputs a result.
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The Garbage Mask menu includes the Tracer and the region of Interest (ROI) functions, which can also be
found in the Modular Keyer. The node processes gaps in clips set to No Media as black frames. An unconnected
front clip will return an error, while and unconnected back clip will process black frames. You can save and
load GMask setups directly in ConnectFX.

Accessing the Garbage Mask from the ConnectFX

To access the Garbage Mask from the Timeline through ConnectFX;

1 Select Timeline.

2 Select the segment.

3 Click the FX button.

4 Click the Create ConnectFX button.

5 Double-click on, or drag, a GMask node into the schematic.

The GMask node is now in the schematic.

6 Double-click the GMask node.

You are in the GMask node editor.

Accessing the Garbage Mask from Modular Keyer

To access the Garbage Mask from the Modular Keyer;

1 Double-click on, or drag, a GMask node into the schematic from the Modular Keyer editor.

The GMask node is now in the schematic.

2 Double-click the GMask node.

You are in the GMask node editor.

About Garbage Mask Options
You can customize a mask's properties in the Garbage Mask menu.

Render Mask button Turns masks on or off as you work. A mask that is turned off can be seen in the image
window, but it has no effect on the image. Masks are turned on by default.garbage masks:turning on and
offConstant shape, for garbage masks

NOTE This parameter cannot be animated.

Outside button Applies the effect to the part of the image that is outside the mask.
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Colour field Sets the blend value between the front and back image in the area that the mask is affecting
(that is, either outside or inside the mask). A value of 50% is a 50/50 blend between the front and back clip.
A value of 100% is the front clip. A value of 0% is the back clip.

Mask with 75% colourMask with 25% colour

Opacity field Sets the opacity of the matte in the area affected by the mask (that is, either inside or outside
the mask). A value of 100% means the matte is completely opaque; 50% means the matte is 50% transparent;
and 0% has no effect on the image.

Mask with 100% opacityMask with 0% opacity

Lasso Fit field Increase or decrease the number of points in the segments of the mask that are drawn freehand.
See Adjusting the Number of Points in Freehand Segments (page 631).

Edge Softness box Apply a uniform gradient or use an advanced gradient to set different levels of softness
for different parts of the mask edge. In the GMask node in ConnectFX or the Modular Keyer, use the Tracer
to set variable softness around the mask edge using pickers. See Refining the Mask (page 646).

Alpha field Defines the transparency of the gradient from the edge of the mask.

Offset field Defines the border position of the gradient from the edge of the mask.

Inner Edge, Outer Edge, Distance fields Applies the distance and degree of change between the opaque
and transparent part of the mask edge.

Linear Interp Enable to use linear interpolation of the mask border between keyframes. Disable to use
rounded interpolation.

Constant Shape button Enable to modify the mask's shape without setting keyframes. This forces all
animatable parameters (except the Tracer parameter Sample On) to be set for the whole clip rather than for
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only the current frame. It also removes any existing keyframes and applies the shape of the current frame
to the rest of the clip.

Splines button Enable the display of softness, borders and pickers.

Borders button Enable the display of borders. The Border button is active when the Advanced Gradient and
Tracer menus are displayed.

Pickers button Enable the display of pickers. This element is only available when accessing the Tracer tool
in the Garbage Mask menu from the GMask node in ConnectFX or the Modular Keyer.

X/Y fields Defines the mask's X and Y offset from its axis.

Setting Mask Options
You can control how a mask affects the matte. For example:
■ Set the opacity, colour, and edge softness of the mask.

■ Specify whether the effect is applied to the inside or outside of the mask.

■ Adjust the offset of the mask from its axis.

■ Turn a mask on or off.

To set mask options:

1 Display the Matte or Result view.

2 Select the mask in the image window:
■ Click anywhere on the garbage mask spline.

■ Click the Geom node in the schematic.

3 Access the Garbage Mask menu.

4 Set the mask options. See About Garbage Mask Options (page 624).

About Drawing Options
Use the Mask Setup menu to access mask drawing options.
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Spline Keyframing box Determines under what conditions keys are set, and for which parameters, when
you are animating a garbage mask spline. See Animating Masks Using Spline Keyframing (page 637).

Motion Blur settings Controls motion blur applied to garbage masks that can be used to match the movement
of objects in a clip. See Applying Motion Blur to Garbage Masks (page 642).

NOTE There are additional setup options to do with animating garbage masks. These only appear when you
disable Shape Animation in the Garbage Mask menu. For more information, see Animating Masks Using Spline
Keyframing (page 637).

Icons button Globally displays or hides the garbage mask splines and axes.

NOTE If you hide garbage maks splines and axes with the Icons button, the Widget All / Widget Sel button in the
View menu has no effect.

Transparency field Sets the transparency for the garbage mask splines and axes.

Show Border button Displays the Softness Offset wireframe border, defined in the Shape menu.wireframe:in
garbage masks

Show Border colour pot Sets the colour for the Softness Offset wireframe.

Spline colour pot Sets the colour for the wireframe of the garbage mask.

Tangents colour pot Sets the colour of the garbage mask tangents and vertices.

Pickers Display colour pot Sets the colour of the Tracer's pickers. This element is only available when
accessing the Garbage Mask Setup menu from the GMask node.

Schematic Display Transparency field Sets the transparency of the nodes in the garbage mask schematic.

Rendering box Select the rendering method.

Hardware Anti-aliasing Sample box Select a hardware anti-aliasing sampling level to accelerate edge
anti-aliasing with no performance penalty. The graphics hardware automatically renders the image at full
speed with approximately the equivalent of up to 32 samples of anti-aliasing (depending on your graphics
card and project graphic bit depth). Hardware anti-aliasing also gives anti-aliasing during normal interaction
instead of only while rendering.

Auto Tangents button Positions a tangent for each vertex set to create a smooth curve between the vertices.
When Auto Tangents is disabled, the tangents are positioned under the vertex, resulting in straight lines
between vertices. When you draw freehand segments in a mask with Auto Tangents off, vertices are added
with broken tangents, allowing the mask to follow your cursor movement.

Drawing a Mask
After setting the drawing options, you can draw the mask.
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To draw a garbage mask:

1 Access the Garbage Mask menu.

2 Select the view where you want to draw the mask from the View box.

Which view you use depends on the context of your key and why you are drawing the mask. For
example, if you want to crop the edges of a clip by drawing an opaque mask around the subject and
then turning on Outside, try drawing the mask using the Matte view. Or, if you are rotoscoping a
subject that has not been shot on a blue or green screen, try either the Front or Result view.

TIP In ConnectFX or the Modular Keyer, you can use multiple viewports as you draw the garbage mask. For
example, you can draw the mask in Matte view, while also displaying Result view. Using multiple viewports,
you can immediately see how your mask affects the clip.

3 Do one of the following:
■ Click Add.

■ Select Create from the Edit Mode box.

■ Press spacebar+C.

4 Do any of the following to draw the garbage mask:
■ Click to add vertices.
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(a) Vertex added by first click (b) Vertex added by third click

■ Press Shift to temporarily hide the vertices and tangents as you are drawing the mask.

(a) Vertices are temporarily hidden while holding Shift

■ Click-drag to control the tangency of any vertex as you are drawing the mask. When you release,
you can continue to add vertices.
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Tangency handles extend as you drag from a vertex

■ Shift-drag to add freehand segments to the mask. The vertices and tangents of the mask you are
drawing are temporarily hidden. Vertices are added where you drag, and appear when you release
Shift. After closing the mask, you can use the Lasso Fit parameter to increase or decrease the
number of vertices that define the freehand segments of the mask. See Adjusting the Number of
Points in Freehand Segments (page 631).

Segments of garbage mask drawn freehand

NOTE If you are drawing the mask with Auto Tangents turned off, freehand segments are drawn with broken
tangents. See Breaking Tangents (page 634).

5 To close the mask, do one of the following:
■ Click Close.

■ Click the first vertex.

■ Drag to the first vertex.

TIP You can also close the mask by pressing the keyboard shortcut for the edit mode you want to use next:
spacebar+M for Move, spacebar+S for Select, or spacebar+B for Break. The mask closes and you are
ready to work in that mode.

When the garbage mask is closed, its vertices and tangents can be edited and animated.
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(a) Vertex (b) Tangent

If you want to view the nodes that are added with each new garbage mask, select Schematic from the
World View box. You can use the Schematic view to access a menu, create parent-child relationships
between masks and axes, delete masks, as well as perform other organizational tasks.

(a) World View box

Adjusting the Number of Points in Freehand Segments
You can increase or decrease the number of points in freehand segments of a mask by adjusting the Lasso
Fit value. An entire garbage mask can consist of freehand segments, in which case the Lasso Fit value affects
the whole garbage mask. Otherwise, the Lasso Fit value only affects the part of the mask drawn freehand.

The Lasso Fit parameter loses its influence over freehand segments of a mask if you have edited points as
follows:
■ Added or deleted points using the Add or Delete Edit modes

■ Saved and loaded a garbage mask

■ Started a new session with the application

To adjust the number of vertices using Lasso Fit:

1 If necessary, select the garbage mask you want to affect.

2 Drag the Lasso Fit field. Increase the value to decrease the number of points in the freehand segments
of the mask. Decrease the value to increase the number of points in the freehand segments.
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Segments of the mask that have been drawn freehand are affected, while segments created by simple
clicks remain unaffected.

NOTE If you move vertices of a garbage mask and then change the Lasso Fit value, all the vertices snap back
to the original position where they were first drawn, and all animation is lost. This occurs only if the Lasso
Fit value retains its influence on the garbage mask.

Garbage Mask Nodes
When you create a garbage mask, an Axis node and a Geom node are added to the schematic. The Axis node
contains rotation, position and scaling data. The Geom node contains information about how the mask will
affect the image.

To view the schematic, select Schematic from the World View box to toggle between the Schematic view
and the previous view.

(a) Axis node (b) Geom node

Changing the Priority Order of Masks
When you create several garbage masks on an image, you can change the order in which they are drawn,
or layered in the scene. This affects the resulting image because a mask with a higher priority has precedence
over one with a lower priority. You can use the priority order to create complex effects involving multiple
garbage masks.

To set the priority of a mask:

1 Select the mask.

2 Click Push to move the mask down a layer; click Pop to move the mask up a layer.
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NOTE You cannot animate the priority by setting Push and Pop at different frames. When you set a mask's
priority with Push or Pop, it is set for the entire clip.

Transforming the Mask
You can apply transformations such as translation, rotation, scaling, shearing, and centre changes to a
garbage mask. The transformation data for the mask is stored in its Axis node. You apply transformations
to the mask using the Axis controls.

All transformation parameters in the Axis menu can be animated. You can use a motion path to animate
the position of a mask.

You can also apply motion blur to a garbage mask. See Applying Motion Blur to Garbage Masks (page 642).

To transform a mask:

1 Access the Garbage Mask menu.

The Axis controls appear.

NOTE The Axis controls are similar to the Axis menu in Action.

2 Use the Transformation fields to modify the position, shape, and size of the mask.

Manipulating Vertices and Tangents
Use the options in the Edit Mode box to manipulate the vertices on the mask. You can edit the mask most
easily in Front, Key-In, or Matte view.

Selecting Vertices and Tangents

You can select vertices and tangent handles when Select, Move, or Scale is selected in the Edit Mode box:
■ To select an individual vertex or tangent handle, click the vertex or tangent handle.

■ To select multiple vertices, Ctrl-drag a selection box over a series of vertices.

■ To select multiple vertices using the pen, press the pen button and drag a selection box over a series of
vertices.

■ To add another vertex to a multiple selection, Shift-click the vertex.
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■ To add several more vertices, press Shift+Ctrl and drag a selection box over the additional vertices.

■ To deselect all vertices, click anywhere outside the mask.

Selecting Pickers and Softness Vertices

You can select pickers or softness vertices using the following techniques. Pickers are an element of the
Tracer tool, which is only available in the GMask node in ConnectFX and the Modular Keyer. See Applying
Softness Using Pickers (page 648).

To select a single picker or softness vertex:

1 Click the picker or vertex that you want to select.

To select multiple pickers or softness vertices:

1 Select the mask vertices that the pickers or softness vertices are associated with (see previous section).

2 Click a picker or softness vertex corresponding to one of the selected mask vertices.

The pickers or softness vertices are selected for all the selected mask vertices.

Moving Vertices and Tangents

You can move vertices and tangents using the Move and Scale options of the Edit Mode box:
■ To move a vertex or tangent in any direction, select Move. Click the vertex or tangent and drag.

TIP If you have trouble selecting a tangent handle that is very close to the vertex, hold Q then select it.

■ To move selected vertices in any direction, select Move. Click one of the selected vertices and drag.

■ To move one or more selected vertices in the direction perpendicular to their tangents, select Scale. Click
one of the selected vertices and drag.

■ To ensure better continuity on a garbage mask, automatically adjust tangents as you move vertices or
scale the mask. Press and hold G and then drag a vertex. See Automatically Adjusting Tangent Handles
of Adjacent Vertices (page 635).

Breaking Tangents

You can separate two tangent handles (“break” the tangent) and move them separately using the Break
option from the Edit Mode box:
■ To break and move a tangent handle, select Break and click the tangent handle. The tangent is displayed

as a solid line, indicating it is “broken.”

■ To reconnect two broken tangent handles, select Auto and click either of the two tangent handles. The
tangent is displayed as a dotted line.

■ To change the position of an individual tangent handle after releasing the cursor, select Move.

Removing and Adding Tangents

You can also use the Break option to remove tangents from vertices by clicking the vertex while in Break
mode. When you remove a tangent, the curve defined by the tangent is removed.
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The shape of the border line differs depending on whether adjacent vertices are broken:
■ If adjacent vertices are unbroken, the border line curves as it approaches the vertices.

■ If adjacent vertices are broken, the border line is straight as it approaches the vertices.

You can create a garbage mask composed entirely of straight edges by removing the tangents from all the
vertices:
■ To remove the tangent of a vertex, select Break and click the vertex.

■ To add a tangent back to a vertex, select Auto and click the vertex. Alternatively, using the Break option,
click the vertex and “drag” the tangent out again.

Automatically Adjusting Tangent Handles of Adjacent Vertices

When you move vertices, the tangent handles of the two adjacent vertices remain fixed in their current
position. You can make them automatically adjust to create smooth curves between the vertices by pressing
the G keyboard shortcut as you move vertices.

You can reverse the behaviour so that dragging vertices automatically adjusts tangents without using the
keyboard shortcut. You reverse the behaviour by setting the following environment variable:

DL_GMASK_AUTO_MOVE_MODE

To reverse functionality of the G keyboard shortcut:

1 From the home directory of the application, open the .cshrc file in a text editor.

2 Add the following line to the end of the .cshrc file:

setenv DL_GMASK_AUTO_MOVE_MODE

3 Save and close the .cshrc file.

4 In the home directory, type:

source .cshrc

5 Launch or restart the application.

When you click or move a vertex on a garbage mask, the tangents are automatically repositioned.
When you press G and click or move a vertex, the tangents are not repositioned.

TIP Alternatively, you can set the environment variable in the shell pointing to the home directory of the
application. When you set an environment variable in the shell, the environment variable is enabled for the
current session only.

Creating Right-Angled Vertices

You can create right-angled vertices using the following technique.

To:Press:

Break apart tangents.B

Create right-angled vertices of selected vertices.G
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Animating Garbage Masks
You can animate a garbage mask using the Shape channel in the Channel Editor or using spline keyframing,
which animates individual Vertex channels. Vertex channels correspond to the vertices—or handles—that
appear along the perimeter of the garbage mask. The Vertex channel names are contained in the Spline
folder in the Channel Editor.

You can apply tracking data to a mask's axis to animate a garbage mask. Existing keyframes are disregarded,
after applying tracking data, you can animate individual vertices and make adjustments.

Animating Masks Using the Shape Channel

The Shape channel shows when the shape of the garbage mask changes during the animation.

To animate a garbage mask using the Shape channel:

1 In the Garbage Mask menu, click Mask Setup.

2 In the Garbage Mask Setup menu, turn on Spline Keyframing.

Each time you move a vertex, a shape key is added at the current frame.

NOTE Disable Spline Keyframing if you do not want a keyframe added to the Shape channel.

3 Click Mask Setup again.

The Garbage Mask menu appears.

(a) Shape Animation button (b) Linear Interpolation button

4 Enable Shape Animation.

If keyframes are already set for specific vertex channels, the following message appears: “Convert
explicit channels to a single shape channel?”

5 Click Confirm.

The Shape channel appears in the Channel Editor and any Vertex channel keyframes are converted.
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(a) Shape channel with 4 keyframes

NOTE Enabling Shape Animation disables the Vertex Keyframing and Channel Selecting boxes in the Garbage
Mask Setup menu. These contain options for animating individual vertex channels. See Animating Masks
Using Spline Keyframing (page 637).

6 Depending on how you want to animate the garbage mask, use the Linear Interpolation and Constant
Shape buttons as follows.

To:Enable:

Make the garbage mask trajectory linear. Enable this button when rotoscoping. For
smooth garbage mask animation, disable this button.

Linear Interpolation

Keep the garbage mask shape the same for all frames. When you enable this button, the
following message appears: “Remove all keyframes except current one?” Click Confirm.

Constant Shape

Animating Masks Using Spline Keyframing

You can animate the shape of a mask by moving the vertices of a garbage mask spline at different frames
throughout the clip. Each vertex has its own X, Y and Z position channels in the Channel Editor, as well as
several other parameters, as shown in the following table.

Channel Editor ValuesChannel Editor Folder &
Name(s)

Parameter

position: X, Y, ZThe position of the mask vertices.

tangents: left, rightThe position of the left and right tangent handles rel-
ative to the mask vertex.

0 = broken handles
1 = unbroken handles

tangents: continuityThe tangent continuity (handles broken or unbroken).

0= inactive
1 = active

Vertex_x: activeThe active/inactive status of mask vertices. See Adding
and Removing Vertices (page 639).
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Before you start to animate the mask, set the Spline Keyframing options in the Garbage Mask Setup menu.
In the GMask node in ConnectFX, these options are located in the Node Setup menu. Use these options to
specify which elements will get a keyframe as you animate the mask.

As you adjust the mask, you can opt to apply keyframes to selected vertices or to all vertices. To quickly
animate a mask, keyframe all vertices every time you adjust a single vertex. This way, what you see at a given
frame will be exactly what you get no matter how you animate the “surrounding” frames.

To have more control over the shape of the mask frame by frame, animate one vertex at a time. This method
is useful for tracking garbage masks and keeping control over tangent animation. See Animating Masks Using
Tracking (page 641).

By combining the Spline and Vertex Keyframing options in different ways, you can set an animation mode
to suit the task at hand. For example, by selecting Item and All Vertices, you could animate just the tangent
handles of all vertices on the mask.

(a) Spline Keyframing box (b) Vertex Keyframing box (c) Channel Selecting box

Spline Keyframing box Sets the conditions under which keyframes are set, and for which parameters.

NOTE The Spline & Tracer, Spline only, and Item options are only available if you disable Shape Animation in the
Garbage Mask menu.

To:Select:

Set a keyframe for all the parameters of the vertex or vertices and related elements, with
the exception of the Sample On parameter. This option is only available when accessing
the Garbage Mask Setup menu from the GMask node.

Spline & Tracer

Set a keyframe for one or more vertices, or related elements, for the specified parameter,
as well as for the mask vertex position and the tangent position channels.

Spline only

Set a keyframe for a parameter of a vertex, or of a related element. Only the particular
parameter gets a keyframe.

Item

Set a keyframe for the shape channel when a change to a vertex is made (such as moving
a vertex or tangent handle, breaking tangent handles, or changing the Active/Inactive

On

status of a vertex). This option is only available when Shape Animation is enabled in the
Garbage Mask menu.
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To:Select:

No keyframes are set.Off

Vertex Keyframing box Sets the conditions under which parameters are applied to specified vertices in the
mask.

NOTE The Vertex Keyframing box is only available if you disable Shape Animation from the Garbage Mask menu.

To:Select:

Set a keyframe for the parameter you are animating for all the vertices of the mask. Related
elements, such as tangents, also all get a keyframe when you animate a parameter on the
mask.

All Vertices

Set a keyframe for the parameter you are animating for all selected vertices on the mask.
Related elements, such as tangents, that are selected, also all get a keyframe when you
animate one on the mask.

Selected Vertices

Channel Selecting box Determines which channels are selected in the Channel Editor when you select one
or more vertices.

NOTE The Channel Selecting box is only available if you disable Shape Animation from the Garbage Mask menu.

To:Select:

Select all the channels related to the vertices you select on the garbage mask. For example,
whether you select a vertex or one of its tangents, its active, position, and tangent channels
are also selected in the Channel Editor.

Vertex

Select only the particular channel corresponding to the selected vertices. For example, if
you select the right tangent handle of a vertex, only the corresponding right channel is
selected in the Channel Editor.

Item

Adding and Removing Vertices

To further control the shape of a mask throughout the clip, you can add and remove vertices from your
mask at any frame of the clip. For example, if the shape changes radically or gets bigger part way through
the clip, you can add vertices to reshape the mask at that frame. When you add a vertex part way through
the clip, it is added to the whole clip but respects the existing shape of the mask in all previous and subsequent
frames. Therefore, any reshaping that you have done to the mask is not affected by the new vertices.

NOTE Adding or deleting vertices on masks with freehand segments causes the Lasso Fit value to lose influence.
See Adjusting the Number of Points in Freehand Segments (page 631).

If you delete a vertex, it becomes “inactive” from that frame to the next active/inactive keyframe set for that
vertex, or, if there are no keyframes, to the end of the clip. An inactive vertex has no effect on the shape of
the mask. On previous frames, the vertex is still active, so the mask shape is unchanged by the deletion. To
delete the vertex completely (that is, throughout the whole clip), click it a second time.

Animating Garbage Masks | 639



(a) Active vertices (b) Inactive vertices

Use the options in the Edit Mode box to add and delete vertices from the mask, and to control which vertices
are active and inactive.

To add a vertex to the entire mask:

1 Select Add from the Edit Mode box.

2 On any frame in the clip, click the mask where you want to add the vertex.

The new vertex is added and is active throughout the clip. It does not affect the existing mask animation,
regardless of where in the clip you add the vertex.

To make an active vertex inactive:

1 Switch to Delete mode.

2 Click the vertex.

The vertex is inactive from the current frame to the next frame where an Active/Inactive keyframe has
been set, or, if there are no keyframes, to the end of the clip. The status of the vertex on previous frames
is unchanged.

NOTE Alternatively, use the Active button in the Shape menu to make vertices inactive. Select the vertex
you want to make inactive (you must be in Select, Move, or Scale mode), and then click Active.

To make an inactive vertex active:

1 Switch to Add mode.

2 Click the inactive vertex.

The vertex is active from the current frame to the next frame where an Active/Inactive keyframe has
been set, or, if there are no keyframes, to the end of the clip. The status of the vertex on previous frames
is unchanged.

NOTE Alternatively, use the Active button in the Shape menu to make vertices active. Select the vertex you
want to make active (you must be in Select, Move, or Scale mode), and then click Active.
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To delete a vertex from the mask:

1 At any frame, switch to Delete mode.

2 Click the vertex.

It becomes inactive.

3 Click the vertex a second time.

It is removed from the mask for the duration of the clip.

NOTE You cannot delete the last three vertices of a mask, as they are the minimum necessary to define it.
If you want to delete the mask, you delete its Geom node in the Garbage Mask Schematic.

Animating Masks Using Tracking

You can animate a mask by applying tracking data to it. This is useful when you want a garbage mask to
follow a moving element in a clip. To do this, you can either:
■ Animate the entire mask by applying the data to the mask's axis.

You can track an object on the front or back clip and apply the tracking data to the axis of a mask, or to
a hierarchy of masks.

■ Animate selected vertices according to reference points that you set in the Stabilizer.

Each vertex you select is assigned a tracker in the Stabilizer. The vertices are repositioned according to
the reference points that you set in the Stabilizer.

When you apply tracking data to a mask, only the mask axis, or position of selected vertices, is animated.
Any other keyframes set for the mask are disregarded. You can, however, animate individual vertices after
applying tracking data to your mask's axis or to individual vertices. It is especially useful to manually adjust
the tangent handles of the vertices at different frames where needed.

To animate an entire mask with tracking:

1 Access the Garbage Mask menu.

The Garbage Mask menu appears.

2 Select the mask.

3 From the Clip box, select the clip you want to track.

4 If necessary, adjust the mask using the Position, Rotation, Scale, Shear, and Centre fields.

5 Set the Rotation and Scaling options. To track rotation, select Rotation On; to track scaling, select
Scaling On.

6 Select an option from the Adjust box.

If the selected mask is:Select:

Parented to one axis.Adj Offset

Parented to a hierarchy of objects.Adj Axis

7 Go to the frame where you want to start tracking.

8 Click S.

The Stabilizer appears.

9 Position of the trackers.
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NOTE The first tracker is for position data and the second tracker is for rotation and scaling data. If rotation
and scaling were not selected, the second tracker has no effect.

10 Click Analyse.

Fine-tune your analysis if necessary. For more information, see Stabilizing and Tracking (page 587).

11 Click Return.

The Garbage Mask menu reappears. The tracking data is applied to the mask.

12 Fine-tune your mask if necessary.

To animate individual vertices on a mask with tracking:

1 Select a vertex or a group of vertices on a mask.

2 Access the Garbage Mask menu.

The Garbage Mask menu appears.

(a) Clip box (b) Adjust box

3 From the Clip box, select the clip you want to track.

NOTE When tracking vertices on a mask using the Garbage Mask menu in the GMask node in ConnectFX
or the Modular Keyer, you can only track the front clip.

4 From the Adjust box, select Adj Tangents.

The tangents for the selected vertices are adjusted while the points are being tracked.

5 Go to the frame where you want to start tracking.

6 Click S.

The Stabilizer appears. The trackers are automatically placed in the position of the selected vertices.
Reposition if needed.

7 Click Analyse.

Fine-tune your analysis if necessary.

8 Click Return.

The Garbage Mask menu reappears. The tracking data is applied to the selected vertices on the mask.

9 Fine-tune your mask if necessary.

Applying Motion Blur to Garbage Masks
Use motion blur on a garbage mask to compensate for the movement of an object in a clip. Motion blur is
created according to the animated movement of a mask's vertices. The amount of blurring is affected by the
speed of the mask's movement.

Motion blur can account for the natural blurring of an object as it moves or rotates in space. For example,
assume you are drawing a garbage mask around a car as it turns a corner. Because you are using an overhead
shot, the edges of the car where motion blur occurs change as the car accelerates and rounds the corner. By
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applying motion blur to the mask, which has animated position and rotation values to match the car's
movement, appropriate blurring of the car's edges into the background clip occurs.

TIP Besides the practical use of blurring a garbage mask, that is, to match the movement of an object you are
keying, you can try blurring masks for artistic effects in multi-layered composites.

To apply motion blur to a garbage mask:

1 Access the Garbage Mask Setup menu.

2 Set the motion blur as follows.

Motion Blur button Enable to apply motion blur to garbage masks.

Phase field Specifies whether the motion blur is based on the movement before or after the current
frame. A value of -100 places the motion blur before the frame, while a value of 100 places the motion
blur after the frame. A value of 0 is centred, which evenly distributes the motion blur. The default
value is 0.

Shutter field Controls the duration of the motion blur at each frame, which affects the size of the
motion blur. Increasing Shutter value does not increase the processing time.

Samples field Determines the quality of the motion blur produced by the number of samples taken
at each frame. Increasing the Samples value causes the processing time to increase linearly.

NOTE You can animate the Motion blur button, as well as the Phase, Shutter, and Samples fields. They can
be found in the Channel Editor under the motion_blur folder.

Motion Blur curve Determines the transparency of the samples that create the blurring effect. The
left side of the curve controls the samples of the incoming movement of the subject in the frame. The
right side of the curve controls the samples of the outgoing movement of the subject in the frame.

For example, to add blur to the left edge of the mask as it travels from left to right in the clip, adjust
the motion blur curve so it slopes down. If you want to add a bit of blur on each side of the mask,
adjust the motion blur curve so it peaks in the middle.

Select one of the three vertices on the curve to move it. When you select a vertex, its tangent handle
is displayed. You use the tangent handle to adjust the slope of the curve.

NOTE The garbage mask motion blur settings are similar to those in the Axis menu in Action.

Motion blur occurs on the mask according to the settings you select and the speed its vertices traverse
the clip.

3 Enable Motion Blur. This makes the motion blur available for application on any garbage mask or axis
in the setup.
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NOTE Motion blur settings are applied uniformly to all garbage masks in the setup.

4 To reset all motion blur settings back to their default settings, click Reset and then click Confirm.

5 To apply motion blur to a garbage mask, access the Garbage Mask Shape controls, select the garbage
mask, and then enable MBlur.

The settings specified in the Garbage Mask Setup menu will be used to create the motion blur effect
on the garbage mask. You can select one garbage mask at a time.

6 To apply motion blur to an axis, select the axis, and then enable MBlur.

The settings specified in the Garbage Mask Setup menu will be used to create the motion blur effect
on the axis. You can select one axis at a time.

Blurring a Stationary Garbage Mask
You can create a motion blur effect for a garbage mask without having the mask actually change position.
This could be useful, for example, if you would like to simulate movement in a stationary image.

To apply axis motion blur:

1 Toggle to schematic view and add a new axis.

2 Parent the new axis to the garbage mask axis.

The garbage mask and the new axis should now both be parented to the garbage mask axis.

3 Apply motion blur to the new axis.

Motion blur is applied to the stationary garbage mask.

Rendering Garbage Masks in Interlaced Mode
Using the GMask node, you can render garbage masks in Interlaced mode to accommodate video material.

To render garbage masks in Interlaced mode:

1 From the GMask node's menu, select Interlaced from the Rendering box.
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Using Multiple Garbage Masks
Use the Region of Interest feature on clips containing multiple garbage masks that each hide a portion of
the matte. Region of Interest ensures that multiple overlapping or non-overlapping garbage masks all respect
the areas defined by one another. Furthermore, you can individually modify the opacity of each mask.

Region of Interest is only available when accessing the Garbage Mask menu from the GMask node in
ConnectFX.

Two garbage masks with Region of Interest enabled

To draw more than one garbage mask revealing a matte:

1 In the Garbage Mask menu, select Geom from the Object box and click Add.

(a) Add button (b) Object box
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2 Draw the first garbage mask.

3 Switch to Result view.

4 Enable Region of Interest.

Outside is enabled and the Colour is set to 0.0 for the mask.

NOTE Disabling Region of Interest toggles the Colour setting back to what it was before.

5 Adjust offsets and softness as required.

6 To adjust the individual opacity for each mask, select the mask and then adjust the value in the Opacity
field.

7 Draw any other garbage masks as needed.

NOTE Each time you add a garbage mask with ROI enabled, Result view is temporarily cleared of all masks
so that you see the entire matte. This way you have a better view of what you want to reveal and mask.

Refining the Mask
You can adjust the softness gradient of a mask to smoothen its edges. You can smoothen the gradient towards
the inside edge, the outside edge, as well as the area where the inside and outside adjustments have an effect.
You can create a uniform gradient around the edge of the mask, or use an advanced gradient to control the
shape of the gradient at different parts of the mask.

To create a uniform gradient, you define how far you want the gradient to be offset from the edge of the
mask and then set its transparency. To vary the shape of the gradient, you move vertices on inner and outer
softness splines. The gradient will be based on how far each vertex point is offset from the mask.

(a) Alpha region (b) Inner offset

Advanced gradient provides a versatile method for setting the softness of the mask edge. It applies a gradient
according to the distance of the softness borders from the garbage mask spline. It allows you to customize
the softness gradient at different parts of the mask. The advanced gradient has two softness borders, one
inside and one outside the mask border. It also includes inner and outer softness vertices for each regular
mask vertex.
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(a) Outer Softness border (b) Inner Softness border (c) Softness vertices (d)  Mask border

Some potential uses for the advanced gradient are:
■ Creating compositing effects when using Action

■ Removing wires

■ Pulling a key on areas of the mask where pickers are not needed

When using the Tracer in the GMask node in ConnectFX or the Modular Keyer, you can work in two modes:
advanced gradient and pickers. Individual vertices can be set to either of these modes.

You can change the default mode of the Tracer from advanced gradient to pickers, a system of localized
keys. Tracer analyses the colour information both inside and outside the mask, then compares the values
and uses a keying algorithm to derive a key for the mask edge. This system allows you to key images with a
lot of detail at the edges.

NOTE For good results with the Tracer, the object must have sufficient (and relatively consistent) chroma and
luma differences between its foreground and background.

To control softness and advanced gradients, use the Garbage Mask Shape controls.

(a) Edge Softness box (b) Alpha field (c) Offset field (d) Distance field (e) Inner Edge field (f) Outer Edge field

Applying Softness Using a Uniform Gradient

Use the Softness fields to apply a constant range of softness to the edge of the mask. The Alpha and Offset
fields define the fade-out of the softness gradient from the edge of the mask.
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Once gradient transparency and offset have been determined, the degree of smoothness can be set using
the Inner Edge and Outer Edge fields. You can then use the Distance field to determine the area where Inner
Edge and Outer Edge settings have an effect.

To apply uniform softness:

1 Access the Garbage Mask menu.

2 Select a mask in the image window.

3 If necessary, toggle the Edge Softness box to Softness.

4 Set the border of the softness gradient using the Offset field. The gradient will be affected by how far
the softness border is offset from the edge of the mask.

5 Set the transparency of the gradient using the Alpha field.

6 Use the Inner Edge field to smoothen the softness gradient towards the inside.

7 Use the Outer Edge field to smoothen the softness gradient towards the outside. Adjusting this value
is especially noticeable if you are smoothening a transition from a black inside edge to a white outside
edge.

8 Use the Distance field to modify the area of which the Inner and Outer Edge adjustments have an
effect.

Applying Softness Using Pickers

You can change the default mode of the Tracer from advanced gradient to pickers, allowing you to sample
colours inside and outside the garbage mask spline, to apply softness according to the colour transition in
the clip. Individual vertices can be set to either of these modes.

When great control over the mask edge is needed, for example, for fine edge detail, use pickers to effectively
key out the background. The Tracer uses pairs of pickers to do luma and chroma analysis of the area inside
and outside of the mask and derives localized edge keys from this information.

648 | Chapter 18   Masking and Rotoscoping



(a) Pickers—Colour analysis is done in the area inside the pickers.

The area that each picker affects extends halfway towards the two adjacent mask vertices, and up to the two
softness borders, as shown in the following example.

(a) Borders of area of pickers' influence.

Using pickers, you can key objects that otherwise would be extremely difficult to key. Imagine a golden
horse with a very fine mane on an unfocused background of various colours. As long as you have some
chroma/luma differences in the background (green vegetation, blue sky, black earth or rocks), you can 'force'
the outside pickers to sample these colour values. The inside pickers can sample the golden average values,
and the Tracer can generate a soft-edged matte based on the difference between the two sets of values.

Pickers can be selected and manipulated independently of the vertices they are associated with. See Selecting
Pickers and Softness Vertices (page 634).

Mixing Advanced Gradient and Pickers

When the subject has a mixture of fine, wispy edges and hard, clean edges, use a mix of localized keys and
advanced gradients. Pickers are better for the fine edge areas and advanced gradient is sometimes better for
the hard edge areas. You can set the state of each vertex to advanced gradient (pickers off) or localized key
(pickers on) mode.
■ To convert a section of a mask from advanced gradient to pickers, select one or more vertices with no

pickers and enable the Picker button. Adjust the pickers as needed.
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■ To convert a section of a mask from pickers to advanced gradient, select one or more vertices with pickers
and disable the Picker button.

■ To toggle selected vertices between the two modes, use the 0 (zero) keyboard shortcut.

To completely remove gradient (for hard edges):

1 Select the mask vertices in the area of the mask border where you want to remove the gradient.

2 Click any one softness vertex corresponding to one of the selected mask vertices (either an inner or
outer vertex).

All the corresponding inner or outer softness vertices are selected.

3 From the Edit Mode box, select Scale.

4 Click any one of the selected softness vertices and drag until the softness border is lined up with the
mask border.

5 Repeat for the second softness border (inner or outer).

To separate the softness border from the mask border:

1 Click a mask vertex, and then drag to the right to move the softness vertex out.

Applying Softness Using the Tracer

Drawing a Tracer-aided matte entails four basic steps.

To draw a Tracer-aided matte:

1 Analyse the image to determine which areas are appropriate for pickers and which areas are better
served by advanced gradients.

2 Draw the garbage mask.

3 Assign pickers to vertices where they are needed.

4 Adjust the softness borders, offsets, tangents, vertices, and pickers (where used).

To analyse the image:

1 Examine the edges of your talent to decide which portions would benefit from advanced gradient
treatment and which would respond better to localized key treatment. If your clip has colours that
change greatly throughout the clip, using pickers may be difficult.

For more information, see Applying Softness Using Pickers (page 648).

To draw the garbage mask:

1 In the Modular Keyer or ConnectFX, add a context point further down the processing pipeline or
processing tree. You can then use the Context view to see the effect of the matte on the result image.

NOTE When using the Tracer to pull a key from the Modular Keyer, remove the nodes before the GMask
node in the default pipeline.

2 Display the Garbage Mask menu.

3 From the View box, select Reference.

This view is a reference image of the clip.
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4 Draw a garbage mask around the subject and close it by clicking the first vertex drawn. Use as many
vertices as required to adequately enclose the subject, but try to avoid excessive vertices. This will
minimize unnecessary tweaking and manipulation later.

TIP Place more vertices in areas with variation in the background.

To assign pickers to selected vertices:

1 From the Edge Softness box, select Tracer.

The Tracer menu appears, and two softness borders (the green lines) are added to the mask.

(a) Edge Softness box

2 Select the vertices to which you want to apply pickers. See Selecting Vertices and Tangents (page 633).

3 Enable Pickers.

NOTE When one or more pickers are enabled, mask characteristics are automatically set to Outside disabled
and a Colour value of 0 so that the mask will be white inside and black outside. Do not set the Outside
button unless you want to reverse the effect.

A pair of pickers is provided for each selected vertex.

(a) Softness borders (b) Picker

■ On vertices without pickers, the softness borders delineate the area where a softness gradient is
applied.

■ On vertices with pickers, the softness borders delineate the area to which softness is applied according
to the picker values.
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To fine-tune the matte:

1 Adjust the softness borders and mask border by moving the vertices and tangents:
■ The mask border should follow the general contour of the subject as closely as possible.

■ The outer softness border should completely surround all details that you want to include in the
matte—all wispy details and edges must be within this line.

■ The inner softness border should be well within the area where softness control is needed.

When moving tangents, you can opt to have the pickers follow the tangent movement (the default
behaviour), or be independent of tangent movement. To make pickers independent of tangents, switch
to Break mode and click either picker. You can animate this behaviour. See Animating a Tracer Mask
(page 653).

NOTE If the tangents are broken, the pickers are automatically unlinked from the tangents.

2 For each pair of pickers, one requires a sample of the area outside the mask, while the other requires
a sample of the mask interior.

Place one picker outside the subject to sample values you do not want to include in the matte (for
example, a blue screen). Place the other picker within the subject for a colour value sample of an area
you do want included in the matte. Try to select areas where the colour values do not change too much
throughout the clip.

3 Click Matte or Result (Matte will provide a clearer view) to see your progress.

4 Scale the pickers by doing one of the following:
■ Select Scale edit mode, click within the picker, and drag to the left to reduce the size or to the right

to increase the size.

■ Select the picker and then drag the cursor over the Sample Size field.

5 Move the pickers around and enlarge or reduce them to interactively see how you can obtain the best
results. This will require toggling between the Front and Matte views.
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The following figure illustrates the Matte view result of the pickers placed in the previous figures.

Animating a Tracer Mask

When using the Tracer, you can animate the basic vertex parameters, as well as the following additional
parameters.

Channel ValuesChannel Folder and Name(s)Parameter

border:
upper = outer vertex*

The position of the two softness vertices relative to the
mask vertex.

bottom = inner vertex*

0 = unlinked
1 = linked

pickers: fixedWhether pickers are linked to tangents or not.
Linked—Pickers move with tangents.
Unlinked—Pickers remain in their current position
when tangents are moved.

0 = off, 1 = onpickers: activeThe on/off status of pickers.

pickers:
upper = outer picker*

The position of the pickers relative to the mask vertex.

bottom = inner picker*

pickers:
u-size = outer picker size*

The picker size.

b-size = inner picker size*

0 = Sample off
1 = Sample on

sample: activeThe Sample on/off status of pickers. See Animating
Picker Values (page 654).

0 = Constant
1 = Linear

sample: interp.The interpolation mode for picker values when Sample
is off. See Animating Picker Values (page 654).
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*Channel Editor designations for “upper” and “bottom” assume the mask was drawn clockwise.

Animating Picker Values

Two options are available to control how picker values (that is, the sampled colour values) are animated:
Sample On and Interpolation mode.

(a) Sample box (b) Interpolation button

Sample box Active resamples picker values at every frame (the default). Passive disables resampling for one
or more frames. When Passive at a particular frame, the picker values previously sampled at another frame
are used. It is useful to adjust the size and position of pickers at one particular frame until the result is
optimal, and then apply these values to other frames. In this way, if movement in the clip in other frames
causes the area being sampled to move away from the pickers, you do not need to readjust the pickers to
get a good reading.

You can select Active or Passive for one or more selected pickers.

Selecting Passive works best when colour values remain fairly consistent throughout the clip. In this case,
one picker sampling will often be enough for the entire clip.

Typical technique for using Sample On: one sample is used for the entire clip

(a) Sample Off (b) Sample On (c) Sample Off

When there is more colour variation in the clip, you may need to take samples at several frames.

To use one picker sampling throughout a clip:

1 Choose a frame in which the colour values are representative of the average colour values found in
the clip.

2 Select the pickers you want to sample. See Selecting Pickers and Softness Vertices (page 634).

3 At that frame, make sure Active is selected from the Sample box (the default).

4 Set the picker values by setting their position and size until you get the optimal result.

5 Go to the next frame and select Passive from the Sample box.

The sample values read at the frame you chose will be used to compute the softness for all other frames
in the clip.

To take samples at several frames:

1 Follow the steps in the previous procedure to set a picker sampling for the clip.
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2 Starting at the first frame sampled, examine your results frame by frame (either forward or backward
through the clip).

3 When you come to an unsatisfactory result, select the pickers you want to re-sample and select Active.

4 Adjust the picker position and size until you get a good result.

5 Go to the next frame and select Passive from the Sample box.

6 Continue verifying frames until you come to one that needs to be adjusted.

7 Repeat steps 3-5.

8 Repeat for the remainder of the clip.

Interpolation button Displays the interpolation between keyframes that have Active selected as the Sampling
option.

■ Linear (enabled): Picker values are interpolated between keyframes with active sampling. The picker
values for each frame are computed based on the values of the previous and next active sampling keyframes
and the proximity of the frame to those keyframes.

■ Constant (disabled): Picker values are fixed between keyframes with active sampling. This means that
the picker values at the first active sampling keyframe will be used for all subsequent frames up until the
sampling is active again.
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Tracking with the Tracer

Tracking with the Tracer is done using the same method as with regular garbage masks. See Animating Masks
Using Tracking (page 641).

NOTE When animating selected vertices with the Stabilizer, the vertices do the tracking, not the pickers. Once
you obtain the tracking data, you will need to go back through your clip from frame 1 onwards, making adjustments
to the pickers where necessary.

Troubleshooting the Tracer

Every clip has its own challenges and requires a certain amount of tweaking and fine-tuning to achieve the
best results.

One of the Tracer segments (localized keys) on my matte shows noisy black and white
artefacts and nothing else. What's wrong?

Problem

The two pickers are sampling luma and/or chroma values that are too similar.Possible Cause

Try moving one of the pickers to a differently coloured area, or enlarge or reduce the size
of one or both of the pickers to include more varied colour information. If there is simply

Solution

no area in the clip that differs enough, you will need to use an advanced gradient for that
segment.

One of the Tracer segments (localized keys) on my matte appears to be showing the
black/white matte information reversed, or as a negative. What's wrong?

Problem

You may have reversed the position of the two pickers.Possible Cause

Try exchanging the inside picker for the outside one and vice-versa.Solution

I can't get a good colour sample from the area outside the mask edge in a certain portion
of the image. What can I do?

Problem

There is simply none (or not enough) of the needed colour in the immediate area of that
particular picker.

Possible Cause

You can drag the picker somewhere further away from the vertex to get a better colour
sample. The picker can be located anywhere on the image in order to facilitate the best
possible colour sample. Do not, however, place a picker outside the image.

Solution

I'm getting really nice edge detail on my matte, but I'm also getting black/white holes in
my matte. Is there anything I can do?

Problem

This may be caused by the generation of random noise and/or artefacts.Possible Cause
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Try the Clean algorithm by clicking the box labelled Clean. You may want to try several
different percentages to find the optimal level of cleaning that doesn't effect your edges

Solution 1

(the default percentage is 70%). The Clean algorithm works only with the Tracer and
pickers on. If you have advanced gradient segments, they will be unaffected. The Clean
command works on all vertices with pickers, whether or not they are selected. The area
affected by the Clean command is the same area that the pickers affect (see Applying
Softness Using Pickers (page 648)).

Use the inner border to isolate the problem areas.Solution 2

Add a second garbage mask.Solution 3

I'm repositioning and rescaling the pickers and the matte goes from having too much
softness (overly transparent) to having too little (overly opaque). What can I do?

Problem

The sampled colour range is either too broad or too narrow.Possible Cause

Locate the areas that have a tendency to become too softened and the picker that is 're-
sponsible' for this by moving the pickers until the matte results change for the worse. Include

Solution

a larger portion of these softer areas in a picker box. By sampling a fuller range of
chroma/luma in this area, a more uniform, averaged effect is created.

Saving Garbage Mask Setups
Garbage masks can be saved and loaded as setup files, with all vertex and animation information preserved.

To save garbage masks as a setup:

1 In the Garbage Mask menu, click Save to open the file browser.

2 From the GMask Type box, select Save GMask.

3 Type the name of the setup, and click Save.
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Loading Garbage Mask Setups
In the file browser, when loading garbage mask setups, you can quickly navigate to either the default gmask
directory or a custom directory for the current project.

To navigate to the default or custom directory when loading garbage mask setups:

1 Select Default or Custom from the GMask Directory box.

NOTE The custom directory is updated every time you navigate to a new directory.

To load a garbage mask setup:

1 In the Garbage Mask menu, click Load to open the file browser.

2 From the GMask Type box, select Load GMask.

3 From the file browser and select the name of the setup to load.

If the GMask setup you are loading was created in a different resolution than the current project, click
Scale Setup to scale the GMask.
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NOTE The Scale Setup button is available on the GMask Setup menu only when accessed from the GMask
node in ConnectFX or the Modular Keyer.

Preset Garbage Mask Setups
A library of preset garbage mask setups is available. To load a preset garbage mask, navigate to the
/usr/discreet/<product home>/gmask directory and select one of the following:

■ arrowhead■ 6_point_star■ 5_point_star■ 4_point_star

■ ■■■cat_eye diamonddiagonalcircle

■■ ■■hexagonheart ovalkeyhole

■■■ ■round_rectanglerectanglepentagon s_shape

■■■ v_shapetrianglesquare

You can also view proxies for each of these setups using the file browser.

Importing and Exporting Raw Setup Files
You can import and export raw setup files for animated garbage masks. A garbage mask exported as a raw
setup file includes the following information:
■ The number of keyframes in the animation of the spline

■ The number of vertices in the shape

■ The x, y, and z position of every vertex at each keyframe

To export a raw setup file:

1 In the Garbage Mask menu, click Save to open the file browser.

2 From the GMask Type box, select Export RAW.

3 Type the name of the file to be exported, and click Save.

To import a raw setup file:

1 In the Garbage Mask menu, click Load to open the file browser.

2 From the GMask Type box, select Import RAW.

3 Navigate to the appropriate directory and select the raw setup file to import.

The raw setup file is imported into the Keyer.
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To import a raw setup file in the Modular Keyer:

1 In the Modular Keyer, click the GMask node in the processing pipeline. See Accessing the Garbage
Mask Menu (page 623).

2 In the GMask menu, click Load.

The Load menu and file browser appear.

3 In the Load menu, select Import Raw and Default from the Load option boxes.

4 Enable Append or Replace.

5 In the file browser, specify the name and path of the file to import.

To export a raw setup file in the Modular Keyer:

1 In the Modular Keyer, click the GMask node in the processing pipeline. See Accessing the Garbage
Mask Menu (page 623).

2 In the GMask Setup menu, click Save.

The Save menu and file browser appear.

(a) Save option box

3 In the Save menu, select Export Raw from the Save option box.

4 In the file browser, specify the name and path of the file to export.

5 Click Save.

Creating Customized Wipes with Garbage Masks
Use masks on the incoming clip to create a customized transition that wipes into the outgoing clip.

Setting the Mask Drawing Options

Before you create a mask, set how the points of the mask are drawn.

To set the drawing options:

1 From the Wipe Editor, click Setup.
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2 Specify the setup options.

To:Enable:

Create tangents for every new point you set.Auto Tangents

View the border defined in the Offset field of the Shape menu. The colour pot next
to the Show Border button defines the colour of the border.

Show Border

Reverse your wipe. For instance, if you originally create an expanding box wipe,
enabling Invert creates a shrinking box.

Invert

Allow animation of points on the mask.Spline Keyframing

3 To change the colour of the mask's wireframe, colour points, or offset border, click a colour pot and
pick a colour.
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Colour Correcting

About Colour Correcting
The Colour Corrector includes tools that provide precise control over colour values. You can modify luma
ranges in a clip (shadows, midtones, and highlights), sample colours, and adjust the colour balance. You
can rewire colour channels and suppress colours, as well as animate a colour correction by manipulating
the animation curve in the Channel Editor.

Accessing the Colour Corrector

To access the Colour Corrector, you must load clips of the same resolution. If the clips you want to load
have different resolutions, resize them so that they have the same resolution.

You can load a front clip, a front and back clip, or a front, back, and matte clip for colour correction. Changes
in colour are applied to the front clip.

The Colour Corrector can be accessed from the following locations:
■ Timeline, then use a Colour Corrector timeline effect. (page 663)

■ Modular Keyer, Action, Paint tool. (page 664)

■ Timeline, then use ConnectFX. (page 664)

Accessing the Colour Corrector from the Timeline

To access the Colour Corrector from the Timeline:

1 Select Timeline.

2 Right-click on the segment that will be colour corrected.

3 Select Add Effect.

The Video Effects ribbon appears.

4 Enable CC (colour correct).

5 Click Enter Editor...

You are in the Colour Corrector.
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Accessing the Colour Corrector from Modular Keyer, Action, or Paint

You can colour correct clips loaded into the MOdular Keyer, Action or Paint.

Back clips and key-in clips cannot be colour corrected.

To access the Colour Corrector from the Modular Keyer:

1 Double-click on, or drag, the Colour Correct node from the node bar to the schematic.

2 Double-click the Colour Correct node.

You are in the Colour Correct editor.

To access the Colour Corrector from Action:

1 From the Media menu, select the media containing the clip you want to colour correct.

2 Double-click the CC field for the media you want to colour correct.

The clip is loaded into the Colour Corrector.

To access the Colour Corrector from Paint:

1 Do one of the following:
■ To colour correct a clip, click Setup in the Paint menu, click CutOut, enable CC, and then enable

the CC button for the clip you want to colour correct.

The clip is loaded into the Colour Corrector.

■ To colour correct a cutout, click Cut/Paste in the Paint menu, create a cutout, and then use the
Colour Correction field or click CC.

The cutout is loaded into the Colour Corrector.

Accessing the Colour Correct through ConnectFX

To access Colour Correct through ConnectFX:

1 Select Timeline.

2 Select the segment.

3 Click the FX button.

4 Click the Create ConnectFX button.

5 Double-click on, or drag, a Colour Correct node into the schematic.

The Colour Correct node is now in the schematic.

6 Double-click the Colour Correct node.

You are in the Colour Correct node editor.

Hiding the Colour Corrector Menu

You can hide the Colour Corrector menu while adjusting an image if you find the menu distracting. With
the menu hidden you can modify numeric fields, use the colour wheel, or access buttons via their
corresponding keyboard shortcuts.
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To hide the Colour Corrector menu while modifying a numeric field or the colour wheel:

1 Click and hold any numeric field or the colour wheel. For example, click and hold the Hue field.

2 Press Esc while continuing to hold the cursor.

The Colour Corrector menu is hidden.

3 Drag the cursor to modify the field value or adjust the colour wheel.

The changes you apply will be visible in the image as you drag if Regen is enabled (see Dynamic Up-
dating (page 671)). Otherwise, the changes appear when you release the mouse.

4 Press Esc to display the menu.

To hide the Colour Corrector menu while accessing buttons via their corresponding keyboard shortcuts:

1 Press Esc.

2 Use the Colour Corrector keyboard shortcuts.

3 Press Esc to display the menu.

Overlay User Interface

The Overlay user interface is specific to the Colour Corrector and Colour Warper. Its controls are identical
to those on the regular user interface except that they are transparent and appear on top of the image. This
allows you a greater viewing area when working with large or zoomed-in images.

The Overlay user interface is available when accessing Colour Corrector or Colour Warper from Tools. It is
not available when accessing the Colour Corrector or Colour Warper as a node or as a timeline effect.

To toggle between the Overlay user interface and the regular user interface:

1 Press Ctrl+Esc.

NOTE If accessing the Colour Corrector as a softFX, you can also use the Player box to toggle between the
Overlay user interface and the regular interface options (Player or Triptych).
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To hide the Overlay user interface:

1 Press Esc.

In addition to the increased area provided by the transparent controls, you can view even more of your
image depending on the action you are performing. For example:
■ Panning and zooming in the clip causes the Overlay user interface to disappear completely until the pan

or zoom is complete.

■ When you play the clip, the Overlay user interface disappears except for the timebar and the current
frame number.

■ When adjusting a menu parameter, all other user interface elements disappear.

The Overlay user interface does not support multiple views. When you switch to Overlay user interface while
using multiple views, your viewport automatically goes to 1-Up until you toggle back to the regular user
interface.

When you access a submenu in the Colour Corrector that does not support Overlay user interface, such as
Load or Save, the Overlay user interface is restored when you return to the Colour Corrector.

Changing the Look of the Overlay User Interface Buttons

You can adjust the opacity of the Overlay user interface buttons to suit your preference, and even invert the
elements in the interface so that white outlines and text appear in a muted grey.

To set preferences for the Overlay user interface:

1 While in the Overlay user interface from the Colour Corrector tool, click View.
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The Overlay user interface preferences are displayed.

If you accessed the Colour Corrector as a timeline effect, the preferences are displayed in the lower-left
portion of the screen.

Use the Opacity field to increase or decrease the opacity of the buttons. An opacity of 1.0 displays the
buttons as they look in the regular user interface. You can also use the following keyboard shortcuts.

To:Press:

Increase the opacity of the Overlay user interface.Ctrl+Alt+(num pad)+

Decrease the opacity of the Overlay user interface.Ctrl+Alt+(num pad)-

TIP You can repeatedly press the keyboard shortcuts to increase or decrease opacity, or simply hold down
the keyboard shortcuts until the desired opacity is reached.

Enable Invert (or press Ctrl+Alt+(num pad)* to switch the Overlay user interface outlines and text
from white to grey.
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Viewing Clips

You can view a front, back, matte, or result clip in the image window. The front, back, and matte clips show
the source clips used. The result clip shows your colour corrections as you apply them.

You can also view the following information for the clip:
■ Channel: displays the numerical data used by the components in the clip.

■ Reference: displays any referenced clips.

■ Tracks: displays when an effect is used in the timeline

■ Info: lists the channel, components, any related values, and the number of keys used in each effect in
the clip.

To display a clip:

1 From the View box, select the clip you want to view. For example, select Result to view the result clip.

TIP Use the controls below the image window to change the frame displayed in the image window. Use the
viewing tools in the upper-right corner of the panel to enlarge and pan images.

To change the clip that is displayed using the keyboard shortcuts:

1 Consult the following table.

Press:To display:

F1The front clip

F2The back clip

F3The matte clip

F4The result clip

F5The channel data

F5The track timeline

F5The Info table

Select Reference from the View boxThe Referenced clips

Colour Corrector Settings

In the Colour Corrector Setup menu, you can change matte clip settings, the way that colour changes are
updated, background brightness, and cropping. You can also reset colour corrections made from the Colour
Corrector, Colour Warper, or both.

668 | Chapter 19   Colour Correcting



Inverting the Matte

You can invert the matte clip. Inverting the matte swaps the transparent and opaque areas of the matte and
redefines the area of the front image that can be colour corrected, as well as the area of the back image that
is shown.

To invert the matte clip:

1 Click Setup in the Colour Corrector menu.

2 Enable Invert Matte.

Changing the Background Brightness

You can adjust the brightness of your work area background. Changing the background brightness is a global
setting. Changing the brightness through the Colour Corrector menu has the same effect as changing it
through the Smoke Preferences menu.

To change the background brightness:

1 Click Setup in the Colour Corrector menu.

2 Enter a value in the Background field.

Creating a Crop Box

Use a crop box to view the colour changes to a limited region of the front clip. Colour changes only appear
in the area within the crop box. This feature speeds up processing and lets you see the difference between
the source clip and the result clip.

For example, while colour correcting, you can use the crop box to split the image window. The split window
allows you to view the front clip and the result or matte clip at the same time.
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To create a crop box:

1 Do one of the following:
■ Hold down the Ctrl key or hold the pen button and drag the box across the image.

■ From the Setup menu, enable the Crop button and enter the dimensions for the crop box in the
Left, Right, Bottom, and Top fields.

The crop box appears in the image window. The display inside and outside the crop box depends on
how many clips are loaded.

Outside the crop box:Inside the crop box:If you loaded:

Shows the back clip.Shows the front clip in the opaque area of the
matte and the back clip in the transparent area
of the matte.

A front, back, and matte clip

Shows the back clip.Shows the front clip.A front and back clip

Shows the non-colour corrected
clip.

Shows the colour-corrected clip.A front clip only

2 To adjust the size of the crop box, drag on the corner points of the box, or modify the values in the
Left, Right, Bottom, and Top fields in the Setup menu.

3 To move the crop box in the image window, click a side of the box and drag to a new location.
Alternatively, press Ctrl and redraw the crop box.

TIP If Overlay user interface is enabled, the crop box will extend beneath the Overlay user interface. To
access the bottom edge, be sure to grab from an area where there are no user interface elements.

To disable a crop box:

1 From any Colour Corrector menu, disable the Crop button.

When you disable the Crop button in a Colour Corrector menu, it is also disabled in the Setup menu.

Changing the Colour of the Crop Box

You can change the colour of the crop box so that it is easier to distinguish from the rest of your image.

To change the colour of the crop box:

1 In the Colour Corrector Setup menu, click the colour pot beside Border.
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(a) Border button (b) Colour pot

2 Select a colour with the colour picker.

3 Click in the Border colour pot to apply the new colour to the border.

Hiding the Crop Box

You can hide the crop box to prevent it from affecting your colour correction.

To hide the crop box:

1 In the Setup menu, disable Border.

Dynamic Updating

Use the Regen button to enable dynamic updating of changes you make in the Colour Corrector. When
Regen is enabled, you see the changes interactively as you adjust the values in the various displays. When
Regen is disabled, you do not see changes until values are entered after releasing the cursor, or by clicking
the Enter key in the calculator.

To enable dynamic updating:

1 Select Setup ➤ Master.

2 Enable Regen.
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Viewing Reference Clips

You can use the split bar to view and sample a reference clip while you work. Reference clips are particularly
useful when you want to match colours or compare colour corrections.

(a) Focus clip (b) Split bar (c) Reference clip

TIP If the Overlay user interface is enabled, the split bar can extend beneath the Overlay user interface. To access
it, grab from an area where there are no menu elements.

Resetting Colour Corrections

You can reset colour corrections created with the Colour Corrector, the Colour Warper, or both. You can
also reset the corrections you make inside the Colour Corrector using the Reset Basics button, or by using
the Range, Histogram, or Curve graphs.

To reset a colour correction:

1 Select an option from the Reset box.
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To reset:Select:

The entire tool. Both the Colour Corrector and Colour Warper settings are reset to
their default values.

Reset All

The Colour Corrector. Settings in the Colour Warper are not affected.Reset CC

The Colour Warper. Settings in the Colour Corrector are not affected.Reset CW

NOTE If accessing the Colour Corrector or the Colour Warper as a timeline effects, only Reset All is available.

2 Click Confirm.

To reset a colour correction within the Colour Corrector:

1 Select one of the reset buttons depending on what you want to reset.

To reset:Select:

The basic properties of the Colour Corrector. Any changes made using the Curve,
Histogram, or Range charts are unaffected.

Reset Basics

The settings defined by the Curve chart. The Basic properties of the Colour Corrector
are unaffected.

Reset in the Curve menu

The settings defined by the Histogram. The Basic properties of the Colour Corrector
are unaffected.

Reset in the Histogram menu

The settings defined by the Range chart. The Basic properties of the Colour Corrector
are unaffected.

Reset in the Range menu

Saving Colour Correction Setups and Preferences

You can save or load colour correction setups using the Save or Load button. Any setup can be loaded from
the file browser for use with another set of clips. You can also save or load colour correction preferences
using the Load or Save button.
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■ To save setups or preferences, click Save.

■ To load setups or preferences, click Load.

TIP Click Revert to revert to the last saved setup. All changes made since the previous Save operation are
undone.

When you save colour correction setups, you save the current settings for both the Colour Corrector and
the Colour Warper to the setup file. If you overwrite a setup file using the Save button, the current settings
in both the Colour Corrector and Colour Warper are saved.

Colour Sampling

You can sample colours from the front and back clips, and instantly see how the front clip will be affected
by the colour correction.

Colours are sampled using colour patches. The sampled colours appear in the patches with their colour
values. You can display the RGB, HLS, or Y (luma) values for the sampled colours. You can choose to display
numerical sample data as either RGB bit values or percentages.

To sample a colour:

1 Below the colour patches, select the sample option you want to use.

To:Select:

Display the NTSC luma values for the colours sampled. Either NTSC 601 or HD 709 luma
values are displayed, depending on the settings in the configuration file.

Y

Display the hue, lightness, and saturation values for the colours sampled.HLS

Display the red, green, and blue values for the colours sampled.RGB
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To:Select:

Turn off the colour information display.Off

2 Click the Front colour patch to sample a colour from the front clip. Click the Back colour patch to
sample a colour from the back clip. Click both patches to sample front and back clips simultaneously.

The cursor becomes a colour picker.

3 To sample an individual pixel, click a colour in the image.

4 To sample an average colour, Alt-drag in the image, or press Ctrl and draw a selection box.

TIP Zoom in for more precise colour sampling.

The sampled colour appears in the colour patch. The sampled colour also appears in each menu.

A sample is displayed:In the:

As a reference point on the colour wheel. A black reference point indicates the colour
you sampled from the front clip. A white reference point indicates the sample from
the back clip.

Colour Wheel

As a red vertical line on the gradient bar, indicating the luma value. Only the front
sample is displayed.

Histogram menu

As red, green, and blue values mapped to the colour curves.Curves menu

As a red vertical line on the Luminance gradient bar, indicating the luma value. Only
the front sample is displayed.

Ranges menu

Colour Sampling and Processing Order

You can use any combination of colour correction commands to modify the front clip. The commands are
processed in the following order:
■ RGB Rewiring, Monochrome, Negative

■ Hue Shifting

■ Saturation

■ Colour Balancing

■ Gamma, Gain, Offset, and Contrast

■ Histogram

■ Colour Curves

■ Chroma Suppression

The processing order is important in determining the colour that appears in the middle (result) section of
the colour patch. The middle section displays the colour resulting from the application of all colour correction
setups; in other words, the colour at the end of the processing order. This colour is updated as you change
any parameter value. The original front colour appears in the left section of the patch.
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Matching Colours

You can match and colour correct the colours of the front clip using the back clip as a reference. To perform
a match operation, sample colours from the front and back clip and then use the Match button in the Curves
menu.

NOTE The procedure for colour matching a Colour Correction timeline effect is different from what is explained
here.

To match colours between two clips:

1 Load a front and back clip from the Thumbnail view.

2 Use the split bar to view the front and back clips in the image window.

3 Click the Curves tab to display the Curves menu.

4 Click the Front colour patch.

The colour picker appears.

5 Using the colour picker, select a colour in the front clip to be corrected.

The colour is added to the Front and Result colour patches.

6 Click the Back colour patch.

676 | Chapter 19   Colour Correcting



The colour picker appears.

7 Using the colour picker, select a colour in the back clip to use as a reference colour.

8 Click Match.

The reference colour is applied to the result clip. The reference colour is also added to the Result colour
patch and points are added to the colour curves.

When you use Match, a number is displayed in the numerical field beside the Rematch button. The
first match you perform is indicated by a 1 in the field, the second by a 2, and so on. To revert to a
previous match, click the numerical field and type the number of the match you want to recall. The
colour patches and colour curves reset to the values stored in the specified match.

To reset the red, green, blue, or luminance curve, select a curve and click Reset in the Curve menu.
The Curves menu also has its own Undo button that is separate from the overall Colour Corrector
Undo.

Colour Correcting

Use the colour correction controls to perform many operations. You can:
■ Colour correct shadows, midtones, and highlights separately or together.

■ Adjust the hue, saturation, or contrast pivot point of an image.
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■ Rewire the red, green, or blue channels of an image.

■ Create a negative or monochrome image.

■ Adjust the gamma of the individual red, green, blue, or RGB channels.

■ Adjust the red, green, blue, or RGB values in an image by modifying the gain, offset and contrast values
for the channel.

■ Perform colour suppression.

■ Adjust the colour balance.

To reset any of these changes, click Reset Basics. To reset all the changes in the Colour Corrector, click Reset
All.

Colour Correcting Shadows, Midtones, and Highlights

When you modify Saturation, Gamma, Gain, Offset, and Contrast, you can colour correct the shadows,
midtones, and highlights ranges in the image individually or all together.

To colour correct shadows, midtones, or highlights:

1 Select the luma range you want to modify.

To modify:Click:

Dark areas in the image.Shadows

Midlevel areas in the image.Midtones

Light areas in the image.Highlights

The entire image. Modification made in the Master range are applied after indi-
vidual range modifications.

Master

NOTE Monochrome, Negative, Chroma Suppression, and RGB Rewiring always affect the Master tonal
range.
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Adjusting the Hue

Hue is the main attribute that distinguishes one colour from another. When you adjust the hue, you also
change the colours in the image.

NOTE Hue shift can be applied to individual ranges (highlights, midtones, and shadows) or to the Master tonal
range.

To adjust the hue of an image:

1 Select the range you want to modify: Master, Shadows, Midtones, or Highlights.

2 Drag the Hue field to adjust the level of hue and saturation until you are satisfied with the result.

3 Click Process to apply the changes to the clip.

Adjusting the Saturation

You can adjust the purity of colour in an image by adjusting the saturation level. Increasing the level of
saturation decreases the amount of grey and produces purer colours. Decreasing the level of saturation
increases the amount of grey and reduces the purity of colours.

To adjust the saturation of an image:

1 Select the range you want to modify.

2 Drag the Saturation field to decrease or increase the level of saturation until you are satisfied with the
result.
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3 Click Process to apply the changes to the clip.

Adjusting the Pivot

Adjust the point at which contrast pixel value is equal to that of the pivot value. Colour values darker than
the pivot are further darkened and colours that brighter than the pivot are further brightened.

To adjust the pivot in an image:

1 Select the range you want to modify.

2 Click the Pivot field and adjust the pivot percentage value of the colour range around which the contrast
pivots. The default value is 50% for integer input and 18% for floating point input.

3 Click Process to apply the changes to the clip.

Rewiring the RGB Channels

Use the Red, Green, and Blue Channel Rewiring fields to rewire the red, green, and blue channels of an
image. Use the Rewire option box to create a monochrome or negative image.
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When you rewire a channel, the values for the current colour channel are replaced with those of the new
channel. For example, if you select the R    G option in the Red Channel Rewiring field, the colour values
of the red channel are replaced with those of the green channel.

The RGB Rewiring commands can be applied to the Master range only.

To rewire the red channel:

1 Select an option from the Red Channel Rewiring box.

To:Select:

Use colour values for the red channel.

Replace colour values of the red channel with those of the green channel.

Replace colour values of the red channel with those of the blue channel.

Replace colour values of the red channel with the luma of all channels.

Replace colour values of the red channel with its inverse. For example, 1 corresponds
to the maximum value of the given colour channel. In 8 bits, this value is 255.

2 Click Process to apply the changes to the clip.

NOTE The green and blue channels are rewired in the same way as the red channel (described in the previous
table).

Creating a Negative or Monochrome Image

You can convert a colour image into a monochrome or negative image using the Rewire option box.

TIP You can also convert the image manually by clicking the appropriate Rewire selection box (R, G or B) and
selecting the Y option for monochrome or 1- R for a negative image.

To convert a colour image into a monochrome or negative image:

1 Select Mono or Negative from the Rewire option box.
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The image is automatically converted to a monochrome or negative image.

2 Click Process to apply the changes to the clip. To cancel the changes, click Reset Basics.

Adjusting the Gamma

You can adjust the grey values of an image by adjusting the gamma. This allows you to brighten or darken
an image without greatly affecting the shadows or highlights.

To adjust the gamma of the image:

1 Select the tonal range you want to modify.

2 Click a Gamma field and enter a value. Lower the gamma value to increase the contrast or raise the
gamma value to decrease the contrast.

Adjusting the Gain and Offset

You can boost the colours in an image by increasing the Gain and Offset values. The Colour Corrector
multiplies the pixel colour values by the Gain and then adds the Offset value. The resulting colour values
are clipped at the maximum value of 255 in 8-bit mode, or 4095 in 12-bit mode.

You can also reduce the colours in the image by decreasing the Gain and Offset values. The resulting colour
values are clipped at the minimum value of 0.

Gain is expressed as a percentage value. The default value of 100% has no effect on the image since the
colour values are multiplied by 1.

NOTE You can adjust the Gain for individual ranges, or across all ranges simultaneously (by using the Gain fields
in the Global controls). However, changes in gain mostly affect the highlights in the image.
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To boost or reduce the colours in the image:

1 Select the range you want to modify.

2 Enter a value in the Gain field for the colour channel you want to modify.

3 Enter a value in the Offset field for the channel you want to modify.

4 Click Process to apply the changes to the clip.

Adjusting the Contrast

You can control the gradations between the light and dark areas of an image by adjusting the contrast. The
pivot value affects the contrast behaviour. See Adjusting the Pivot (page 680).

To adjust the contrast of the image:

1 Select the range you want to modify.

2 Click a Contrast field and enter a value.

Suppressing Colours

You can suppress the RGB or CMYw colours in an image. Chroma suppression is useful for removing blue
spill from a blue-screen composite.
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To suppress a colour:

1 Click Master.

NOTE Chroma suppression can only be applied to the Master tonal range.

2 Enable the appropriate button for the colour to suppress.

To suppress:Enable:

RedR

GreenG

BlueB

CyanC

MagentaM

YellowYw

The status box on the button is light blue when the button is enabled.

NOTE Suppression of RGB and CMYw always reduces luma.

Adjusting the Colour Balance

You can adjust the colour balance in an image using the colour wheel or the Balance Tools Hue and Gain
fields. The value of Hue determines the colour to add and the value of Gain specifies the amount of colour
to use.
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(a) Colour wheel (b) Hue field (c) Gain field

Pure red is the 0-degree point for hue on the colour wheel. When you increase the Hue value, you move
counterclockwise on the colour wheel. When you decrease the Hue, you move clockwise on the colour
wheel.

The centre of the colour wheel represents 0 Gain. As you increase the value of Gain, you move towards the
edge of the colour wheel and add more of the selected colour to the image.

NOTE If Saturation is set to 0, no colour balancing is performed, regardless of the Gain value. In the Channel
Editor, Balance channels are labelled hue_balance and gain_balance, respectively.

Creating and Modifying a Colour Balance Point

You can make colour balance points for each range (highlights, midtones, and shadows) or for all ranges
simultaneously (master). Click inside the colour wheel to create a balance point for the current tonal range.

The current range's colour balance point is connected to the hub of the colour wheel by a line. You can
constrain how the point is modified according to how you select it. If you select the line, the radius of the
line Strength is constrained. If you select the point, the direction of the line Tint is constrained. You can
make unconstrained modifications by clicking anywhere in the wheel, or by entering values in the Balance
fields.

NOTE As you move the colour balance point on the colour wheel, the values in the Balance Tools Hue and Gain
fields update automatically. You can also set the values for Tint and Strength directly in these fields.
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(a) Current colour balance point (b) Hue shift/saturation comparison (outside ring is Result; inside ring is Source)
(c) Balance tools

Colour balancing is performed in RGB colour space. The luma of the image is not changed. For example, if
Hue (tint) is set to 0 and Gain (strength) is set to 100%, pure red is added to the image. However, a black
pixel remains black since it keeps the same luma value.

To change the colour balance in the image:

1 Enable Regen so that the image will update as you change the colour balance.

2 Select the range you want to modify.

3 On the colour wheel, click and drag toward the colour you want to use.

As you drag the cursor, a colour balance point follows the cursor. Depending on the range you are
modifying, the colour balance points are shaded to make for easier identification (from light grey to
black, in this order: Highlights, Shadows, Midtones, Master).

You can continue dragging outside of the colour wheel. The colour balance point is replaced by a
triangle in the outer circle of the colour wheel. The triangles are also shaded depending on the range
selected (from white to grey, in this order: Master, Highlights, Shadows, Midtones).

The image dynamically updates as you drag.

TIP You can interact directly in the image window to change the colour balance. While holding Alt and
the range keyboard shortcut (V for Master; Z for Shadows; X for Midtones; or C for Highlights), drag directly
in the image window. The colour wheel and Balance Tools fields update accordingly.

4 If you are not satisfied with the resulting image, click and drag the colour balance point or triangle
again. You can continue to move the colour balance point or triangle until the desired effect is achieved.

5 Click Process to apply the changes to the clip.

Adjusting the Colour Range

You can use the Histogram menu to adjust the range of values used for the red, green, blue, or luminance
channels of an image. The histogram shows the colour distribution of pixels in the front and result image
for the selected channel. The horizontal axis represents the values of pixels, from black at the left to white
at the right. The vertical axis represents the number of pixels with these colour values.

686 | Chapter 19   Colour Correcting



When working with 16-bit floating point images, the values of the histogram are represented on a logarithmic
scale. When working with integer images (8, 10, or12-bit), the values of the histogram are represented on a
linear scale.

To access the Histogram menu:

1 Click the Histogram tab.

The Histogram menu options are described as follows.

(a) Minimum Input slider (b) Minimum Output slider (c) Minimum Input field box (d) Minimum Output field
(e) Maximum Input field  (f) Maximum Output field (g) Maximum Output slider (h) Maximum Input slider

Input controls Use the minimum and maximum input sliders or fields to set the input levels of your
image.

Output controls Use the minimum and maximum output sliders or fields to set the output levels of
your image.
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(a) Channel Selection box (b) Out Range Option box (c) Frame Selection box (d) Source View Option box
(e) Destination View Option box

To Frame:Select

Based on the minimum and maximum slider values.Min / Max

The complete range of histogram values.Full Range

The plot and reference colours.Plot Colour

Based on a [0:1] horizontal and vertical range.Home

Increasing Image Contrast

The slider controls directly below the histogram are the Input Level controls. These controls are used to set
the range of colour values used in the image:
■ The white triangle on the right sets the maximum value for the range.

■ The black triangle on the left sets the minimum value for the range.

You can use the Input Level controls to increase the contrast in the image. For example, if you set the
minimum value to 50, pixels with colour values less than 50 are remapped to 0 (black). Pixels with colour
values greater than 50 are remapped to the appropriate values. This darkens the image and increases the
contrast in the shadow areas.

You can also set the maximum and minimum limits for the colour range by entering the values directly in
the Minimum and Maximum Input fields on either side of the histogram.

To increase the contrast in an image:

1 Display the Histogram menu.

2 Click the Master, Shadows, Midtones, or Highlights button to select the parts of the image you want
to modify.

3 From the Channel Selection box, select Luminance, Red, Green, or Blue as the channel you want to
work with.

4 Position the cursor on the black triangle below the histogram. Drag right to darken the shadow areas
in the image.
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The value of the lower limit for the colour range appears in the Minimum Input field.

5 Position the cursor on the white triangle below the histogram. Drag left to brighten in the highlight
areas in the image.

The value of the upper limit for the colour range appears in the Maximum Input field.

NOTE If you are in Luminance, you can invert the image by reversing the order of the black and white
triangles.

6 Click Process to apply the changes to the clip. To cancel the changes, click Reset Basics.

Reducing Image Contrast

The slider controls on the gradient bar below the histogram are the Output Level controls. These controls
are used to set the range of colours used in the image:
■ The white triangle on the right sets the maximum value for the range.

■ The black triangle on the left sets the minimum value for the range.

You can use the Output Level controls to decrease the contrast in the image. For example, suppose that you
set the minimum value to 100. A pixel with a colour value of 0 is remapped to 100. Pixels with colour values
greater than 0 are remapped to the appropriate values. This has the effect of lightening the image and
decreasing the contrast in the shadow areas.

Suppose that you set the maximum value for the range to 200. A pixel with a colour value of 255 is remapped
to 200. Pixels with colour values less than 255 are remapped to the corresponding values. This has the effect
of darkening the image and decreasing the contrast in the highlight areas.

You can also set the maximum and minimum limits for the colour range by setting the values directly in
the Minimum and Maximum Output fields.

To reduce the contrast in an image:

1 Display the Histogram menu.

2 Click the Master, Shadows, Midtones, or Highlights button to select the parts of the image you want
to modify.

3 From the Channel Selection box, select Luminance, Red, Green, or Blue as the channel you want to
work with.

4 Position the cursor on the black triangle below the Output Level bar. Drag right to lighten the shadow
areas in the image.

The value of the lower limit for the colour range appears in the Minimum Output field.

5 Position the cursor on the white triangle below the gradient bar. Drag left to decrease the brightness
in the highlight areas.

The value of the upper limit appears in the Maximum Output field.

Defining Luma Ranges

Use the histogram in the Ranges menu to modify the shadow, midtone, or highlight ranges.

When working with 16-bit floating point images, the values of the histogram are represented on a logarithmic
scale. When working with integer images (8, 10, or12-bit), the values of the histogram are represented on a
linear scale.
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To access the Ranges menu:

1 Click the Ranges tab.

The Ranges menu options are described as follows.

(a) Shadows curve (b) Midtones curve (c) Highlights curve

The X-axis is luma and the Y-axis is weight. The Shadow curve is labelled “S”, the Highlight curve is
labelled “H”, and the Midtones curve is not labelled.

(a) Frame Selection box (b) Source View option box  (c) Destination View option box

Frame Selection box Choose how you want to frame the Ranges Histogram.

To Frame:Select

Based on the minimum and maximum slider values.Min / Max

The complete range of histogram values.Full Range

The plot and reference colours.Plot Colour

Based on a [0:1] horizontal and vertical range.Home
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To see the effect of adjusting these curves:

1 Adjust the colour balance for each of the Shadows, Midtones, and Highlights channels. Note the effect
that this setup has on the image.

2 Display the Ranges menu. Adjust the curves using the tangent handles.

You should see that the resulting image is different from that in step 1. The difference is the result of
the changes you made to the luma curves for the shadows, midtones, and highlights.

Remapping Colour Values

Like the Histogram menu, the Curves menu allows you to remap the colour values for the individual red,
green, blue, and luminance channels of the image. However, instead of adjusting the colour values by
resetting just the maximum and minimum values for the colour range, the Curves menu allows you to remap
any value in the colour range precisely.

To reset any changes to the Curves chart, click Reset. To reset all the changes in the Colour Corrector, click
Reset All. The Curves menu also has its own Undo button that is separate from the overall Colour Corrector
Undo.

To access the Curves menu:

1 Click the Curves tab.

There is one colour curve for each of the red, green, blue, and luminance channels of an image. The colour
curves are generated by plotting the input values for the source image versus the output values for the
resulting image.

For integer images, the input values range from 0 to 255, and are plotted along the horizontal axis. The
output values range from 0 to 255, and are plotted along the vertical axis. The range for both the input
values and the output values is from 0 to 255 in 8-bit mode, and from 0 to 4095 in 12-bit mode.

For 16-bit floating point images, the input values range from 0 to 1, and are plotted along the horizontal
axis. The output values range from 0 to 1, and are plotted along the vertical axis. By default, there are 2
points on the curve, mapping 0 to 0 and 1 to 1. Use the Out Range option box to define whether the curves
are constant (select Clamp) or linear (select No Clamp) before the first point of the curve and after the last
point of the curve.

The default curve for each channel is a diagonal line that extends from the lower-left corner to the upper-right
corner of the graph. The default curve represents the initial state in which the colour values for the pixels
of the source image are equal to the values for the corresponding pixels of the resulting image. For example,
all pixels that have a value of 100 in the source image also have a value of 100 in the resulting image.

The colour values of an image are remapped when you change the shape of a colour curve. Use the Curves
Editor to add, delete, or move vertices on the curve. For example, move the end vertices on the curve to
change the maximum and minimum values for the colour range. Add a vertex anywhere on the curve to
remap a particular colour value.

The Curves Editor behaves in much the same way as an animation curve in the Channel Editor. To edit
colour curves, select Add, Delete, or Move from the Edit Mode box.
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Animating a Colour Correction

Use the Animation controls to animate a colour correction that has been applied to a clip. You can animate
any value in the Colour Corrector.

To access the Animation controls:

1 In the Colour Corrector menu, click Animation.

Processing Colour Changes

After you adjust the colours to your satisfaction, you are ready to process the clip. The destination resolution
is the same resolution as the source clip.

Before you process the colour changes, you can preview the result clip in the image window.

To apply the colour changes to the front clip:

1 In the Colour Corrector menu, click Process.

The processed clip is saved on the rendered destination reel.

2 Click Exit in the Colour Corrector to return to the Tools tab.

If you entered the Colour Corrector from another tool, you must return to that tool to process the clip.
If you are in the timeline, a black line appears on the timeline element to indicate that the clip has
been processed.

About the Colour Warper
When you colour correct an image or clip, use the Colour Warper to perform advanced colour corrections
and create artistic colour effects. The way in which you approach these tasks depends on your goal, the
number of clips you are using, and the type of clips being used.

Clips created from source material shot with the same camera equipment under the same lighting conditions
may be colour corrected quickly and easily to correct lighting and colour imbalances. Clips created from
source material shot at different times of the day, in different seasons, at different locations, or using different
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equipment require more work. With the Colour Warper, you can manipulate colours with precision and
ease, working on the entire clip as you would with traditional tools or working with a matte to adjust a range
of colour in the clip.

Use the Colour Warper to gesturally set black and white levels, adjust specific colours and colour ranges,
and accurately match colours in one clip to another. You can also perform hue shifts and suppress colour
to remove colour spill or create visual effects such as a colour cast. While you manipulate the colour content
of a clip, you can monitor reference clips as well as changes in the colour distribution to ensure that you
achieve the result you want. Original data is always preserved, so you can adjust colours without the risk of
permanently losing colour information.

When working with 16-bit floating point images in the Colour Warper, you can plot colours outside of the
0 to 1 range. Even when working with integer images, clamped colour information (colours that go beyond
the RGB range) can be retrieved using the Colour Warper controls.

(a) Clamped colour

(a) Colour information restored
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Accessing the Colour Warper

Use the Colour Warper to modify the colour content in your clips. You can manipulate colour content with
intuitive controls that provide precise colour correction, and view histograms that help you visualize your
image's colours. You can also output a matte corresponding to selected colours.

You can access the Colour Warper as a ConnectFX node that you drag and drop into the process tree or the
Modular Keyer's processing pipeline. Access the Colour Warper from the Modular Keyer to remove colour
spill, or access it from ConnectFX to modify the colour content of your clips.

The Colour Warper can be accessed from the following locations:
■ The Timeline, using a Colour Correct timeline effect. (page 694)

■ Modular Keyer, Action or Paint.  (page 694)

■ ConnectFX.  (page 695)

When working with large images, you can free up additional screen space with the Overlay user interface.
This feature is exclusive to the Colour Corrector and the Colour Warper. The Colour Warper's Overlay user
interface is not available when accessing the Colour Warper as a ConnectFX node.

For details on using the Overlay user interface, see Overlay User Interface (page 665).

You can access the following menus from the Colour Warper menu.

NOTE If you are accessing the Colour Warper from ConnectFX or the Modular Keyer, you use the Setup menu
for the node to adjust vectorscope and hue cube settings, as well as update colour information. You cannot use
the Setup menu for the node to crop the colour correction area or invert a matte.

Accessing Colour Warper from the Timeline

To access Colour Warper from the Timeline:

1 From the Timeline, right-click on the sequence to which you will apply the Colour Warper.

2 Select Add Effect.

The Video Effects ribbon is displayed.

3 Enable CC (Colour Correct).

4 Click the Colour Box to select Colour Warper.

5 Click the Enter Editor button.

The Editor screen is displayed.

Accessing the Colour Warper from Modular Keyer, Action, or Paint

To access the Colour Warper from the Modular Keyer:

1 Double-click on, or drag, the Colour Warper node from the node bar to the schematic.

2 Double-click the Colour Warper node.

You are in the Colour Warper editor.

To access the Colour Warper from Action:

1 From the Media menu, select the media containing the clip you want to colour correct.
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2 Double-click the CC field for the media you want to colour warp.

3 Click the Colour box.

The Colour box changes to CW. You are in the Colour Warper.

To access the Colour Warper from Paint:

1 Do one of the following:
■ To colour correct a clip, click Setup in the Paint menu, click CutOut, enable CC, and then enable

the CC button for the clip you want to colour correct.

The clip is loaded into the Colour Warper.

■ To colour correct a cutout, click Cut/Paste in the Paint menu, create a cutout, and then use the
Colour Correction field or click CC.

The cutout is loaded into the Colour Warper.

Accessing Colour Warper through ConnectFX

To access Colour Warper through ConnectFX:

1 Select Timeline.

2 Select the segment.

3 Click the FX button.

4 Click the Create ConnectFX button.

5 Double-click on, or drag, a Colour Warper node into the schematic.

The Colour Warper node is now in the schematic.

6 Double-click the Colour Warper node.

You are in the Colour Warper node editor.

Setting Up Your Work Environment

Set up your work environment to streamline the colour correction process. Use the tools provided to examine
the clip or image and efficiently perform advanced colour corrections. As your work progresses, you can
modify the Colour Warper environment to suit the task at hand.

You can:
■ Display multiple viewports.

■ View reference clips.

■ View the colour and luma content of a source (front) clip and result clip.

■ Apply a colour correction to all or part of a clip.

■ Crop the colour correction area (when accessed from the Colour Corrector).

■ Invert the matte (when accessed from the Colour Corrector).

■ Dynamically update colour information as you work.

■ Reset entire colour corrections.

■ Clear or reset individual values.

■ Save and load colour correction setups and preferences.

■ Use the Undo/Redo list.
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Multiple Viewports

When working in the Colour Warper, you can display up to four viewports at a time in the image window,
including a view of the Channel Editor. Multiple viewports are convenient when you want to modify colour
values, create mattes, and compare your result with other images in different viewports simultaneously.

NOTE The Overlay user interface cannot be used with multiple views in the Colour Warper tool.

Reference Clips

You can use the split bar to view a reference clip while you work. Reference clips are useful when you want
to match one clip to another. Carefully selecting a suitable reference clip will help you make your colour
corrections quickly and efficiently. For example, you can use a reference clip from the ConnectFX schematic
to match saturation, whites and blacks, or colours. You can also switch between different references to ensure
continuity throughout the project.

NOTE You cannot view reference clips when you access the Colour Warper from the Colour Correction timeline
effects. Also, if the Overlay user interface is enabled, the split bar will extend beneath the Overlay user interface.
To access it, be sure to grab from an area where there are no user interface elements.

Viewing Colour Information with a Vectorscope

In the Colour Warper, you can use a 2D or 3D vectorscope to help match colours, adjust shadows and
highlights, view colour distribution, and ensure that broadcast standards are met. The vectorscopes show
the changes you make to colour content in a clip or image.

Each vectorscope can display:
■ A histogram showing the distribution of image pixels across luma and hue ranges. The histogram

dynamically updates to reflect your changes as you modify colours in the image. Exposure and contrast
settings in the image display viewer are taken into account.

■ Source and destination colours. Source colours are the colour values in the front clip and destination
colours are the colour values in the result clip.

■ Plotted and reference colours that are obtained by sampling images in the image window. See Sampling
Clips in the Image Window (page 705).

NOTE The 2D and 3D vectorscopes only appear in Result view.

To view colour information in either the 2D or 3D vectorscope:

1 In the Colour Warper menu, enable Scope.

The vectorscope appears in the image window.

NOTE You can only view one vectorscope at a time.

2 Click Setup.

3 From the Scope box, select the vectorscope you want to use to view the clip.

2DDisplays the 2D vectorscope. Use the 2D vectorscope to analyse the colour content of the clip and
locate specific colours in terms of their chroma values. When you view a clip in the 2D vectorscope,
you see it in terms of hue and saturation. The size and placement of the colour squares in the 2D
vectorscope show the distribution of all the colours in the clip—like a colour wheel; the distance from
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the centre to the perimeter of the scope maps colour saturation, with the outside edge of the scope
delineating pure colour.

3DDisplays the 3D vectorscope. Use the 3D vectorscope to both analyse the colour content of the clip
and to locate specific colours in terms of their chroma and luma values. When you view a clip in the
3D vectorscope, you see it in terms of HLS (hue, lightness, and saturation). Its X, Y, and Z axes represent
red, green, and blue, and the size and placement of the colour cubes show the distribution of all the
colours of the clip in RGB colour space.

The selected vectorscope is displayed in the image window. As you scroll through a clip, the histogram
is updated to display the colour distribution of each frame.

(a) 3D vectorscope (b) 3D histogram

(a) 2D vectorscope (b) Histogram

4 Set the following options to customize the display of the 2D or 3D vectorscope.

To:Enable:

Show the vectorscope canvas. When the canvas is off, the vectorscope is transparent,
but can be outlined.

Canvas
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To:Enable:

Show the vectorscope outline.Lines

5 Set the following histogram options to show clip colour information.

To:Enable:

Show a histogram of the colour values in the front, or source clip. The source colour
values are obtained from the current frame. If you input both front and matte clips,

Source

the colour values in the front clip that are defined by the white part of the matte are
displayed.

Show a histogram of the colour values in the result clip. The destination colour values
are obtained from the current frame. If you input both front and matte clips, the

Destination

colour values in the front clip that are defined by the white part of the matte are dis-
played.

When both Source and Destination are enabled, you see both the source and destination colour values.
The source clip's colour values are displayed in black and the result clip's colour values are displayed
in colour. When only Source is enabled, the source clip's colour values are displayed in colour.

(a) Result clip (in colour) (b) Source clip (in black)

NOTE You can also toggle the Source and Destination buttons in the Basics menu to show or hide source
and destination colours in the histograms.

6 From the Size box, select the size of the coloured squares or cubes that make up the histogram. You
can display 8x8, 16x16, or 32x32 coloured dots.

7 To set SMPTE bars for the 2D vectorscope, select an option from the Bars box.

To match:Select:

75% SMPTE bars. If the current project is NTSC, the bars are set to 75% by default.Bars 75%
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To match:Select:

100% SMPTE bars.Bars 100%

The parameters of the histogram of the 2D vectorscope update accordingly.

8 To toggle between the vectorscopes, double-click the vectorscope in the image window.

Use these other shortcuts to interact with the vectorscopes.

To:Press:

Move the 2D or 3D vectorscopeAlt-drag

Zoom the 2D or 3D vectorscopeShift-drag

Rotate the 3D vectorscope. If you Ctrl-drag the 2D vectorscope, the 3D vec-
torscope appears and rotates.

Ctrl-drag

9 To position a vectorscope at its default location and size, click Home.

Viewing Luma Information with the 2D Luma Histogram

The 2D luma histogram shows the changes you make to luma content in a clip. Use the 2D luma histogram
when you want to adjust the lightness of a sample. The 2D luma histogram is displayed in the Basics menu
of the Colour Warper.

The 2D luma histogram can display:
■ A histogram showing the distribution of image pixels across the luma range—the size and distribution

of the vertical bars show the luma distribution.

■ Source and destination colour values. Source colour values are the luma values in the front clip and
destination colours are the luma values in the result clip.

■ Plotted and reference colours that are obtained by sampling images in the image window. See Sampling
Clips in the Image Window (page 705).
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To view luma information in the 2D luma histogram:

1 In the Colour Warper menu, click Basics.

The 2D luma histogram appears in the Basics menu. R, G, and B values that are modified by the Midtones
trackball are displayed as curves in the histogram.

(a) RGB curves (b) Midtone triangle

2 Set the following options to show clip luma information.

To:Enable:

Show a histogram of the luma values in the front, or source, clip. The source luma
values are obtained from the current frame.

Source

Show a histogram of the luma values in the result clip. The destination colour values
are obtained from the current frame.

Destination

When both Source and Destination are enabled, you see both the source and destination luma values
in the histogram. Source clip colour values are displayed in black and result clip colour values are
displayed in off-white.

NOTE You can also toggle the Source and Destination buttons in the Setup menu to show or hide source
and destination colours in the histograms.

Colour Correcting All or Part of an Image

Use the options in the Work On box to apply colour corrections to all or part of an image. You can select
an option from the Work On box at any time to further modify the image. Use Master to apply colour
corrections to the entire image and use a selective to generate a matte and perform selective colour
correction—apply the colour correction to a selected range of colour. The Work On box is available in every
menu of the Colour Warper.
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(a) Work On box

To colour correct all or part of a clip:

1 Select an option from the Work On box.

To:Select:

Use the Basics menu to modify the entire image. In Master mode, you cannot
output a matte.

Master

Generate a matte from the front clip selective colour correction. You can then
use the Basics menu to modify the range of colour defined by the matte. In a

Sel. 1, Sel.2, or Sel. 3

selective mode, you can output the matte, selective, or result. See Selecting
Colour Ranges for Colour Correction (page 707).

Cropping the Colour Correction Area

When you access the Colour Warper from the Colour Corrector, you can create a crop box to limit the area
where the colour correction is applied.

Using a crop box as you colour correct a clip speeds up interactivity, which is especially useful when working
at high resolutions. You can also process the clip with a crop box. Everything outside the crop box will be
processed as black on the matte.

To use a crop box:

1 In the Colour Warper menu, click Setup.

2 Do one of the following:
■ Hold down the Ctrl key or hold the pen button and drag the box across the image.

■ Turn on the Crop button and enter the dimensions for the crop box in the Left, Right, Bottom,
and Top fields.
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The crop box appears in the image window. By default, the crop box has the same dimensions as the
clip. The display inside and outside the crop box depends on how many clips are loaded.

Outside the crop box:Inside the crop box:If you loaded:

Shows the back clip.Shows the front clip in the opaque area of the
matte and the back clip in the transparent area
of the matte.

A front, back, and matte clip

Shows the back clip.Shows the front clip.A front and back clip

Shows the non-colour corrected
clip.

Shows the colour-corrected clip.A front clip only

3 To adjust the size of the crop box, drag on the corner points of the box, or modify the values in the
Left, Right, Bottom, and Top fields in the Setup menu.

4 To move the crop box in the image window, click a side of the box and drag to a new location.
Alternatively, press Ctrl and redraw the crop box.

TIP If the Overlay user interface is enabled, the crop box will extend beneath the Overlay user interface. To
access the bottom edge, be sure to grab from an area where there are no user interface elements.

5 You can now use any Colour Warper menu and colour correct the area of the clip that is defined by
the crop box. You will only see the results of your changes within the crop box.

6 If you want to process the clip with the crop box, leave the Crop button enabled when you process.

To disable a crop box:

1 From any Colour Warper menu, disable Crop.

When you disable the Crop button in a Colour Warper menu, the Crop button in the Setup menu is
also disabled.

To change the colour of the crop box:

1 In the Colour Warper Setup menu, click the colour pot beside Border.
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The colour picker appears.

2 Select a colour with the colour picker.

3 Click in the Border colour pot to apply the new colour to the border.

To hide the crop box:

1 In the Setup menu, disable Border.

Inverting the Matte

When you access the Colour Warper from the Colour Corrector and you input a front, back, and matte clip,
you can invert the matte to colour correct the region outside the area defined by the matte. Inverting the
matte swaps the transparent and opaque areas of the matte and redefines the area of the front image that
can be colour corrected, as well as the area of the back image that is shown. To invert a matte, enable the
Invert Matte button in the Setup menu.

(a) Invert Matte button

Resetting Colour Corrections

When you access the Colour Warper from the Colour Corrector, you can reset colour corrections created
with the Colour Warper, the Colour Corrector, or both.

To reset a colour correction:

1 In the Colour Warper menu, select an option from the Reset box.

To reset:Select:

The entire tool. Both the Colour Corrector and Colour Warper settings are reset to
their default values.

Reset All

The Colour Corrector. Settings in the Colour Warper are not affected.Reset CC

The Colour Warper. Settings in the Colour Corrector are not affected.Reset CW

NOTE If accessing the Colour Corrector or the Colour Warper as a timeline FX, only Reset All is available.

2 Click Confirm.
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Resetting and Clearing Values

You can clear or reset several Colour Warper values in the Basics menu using individual C/R boxes. C resets
the value for the current frame by setting a keyframe. R resets the value for the entire animation curve.

To reset a Colour Warper value:

1 In the Basics menu, do one of the following:
■ Select C from the C/R box next to a control.

The value is reset at the current frame.

■ Select R from the C/R box.

The value is reset for the entire animation curve.

NOTE Fields that do not have C/R boxes next to them cannot be reset. Use the Undo box instead.

Saving Colour Correction Setups and Preferences

You can save or load colour correction setups using the Save or Load button. Any setup can be loaded from
the file browser for use with another set of clips. You can also save or load colour correction preferences
using the Load or Save button.

■ To save setups or preferences, click Save.

■ To load setups or preferences, click Load.

TIP Click Revert to revert to the last saved setup. All changes made since the previous Save operation are
undone.
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When you save colour correction setups, you save the current settings for both the Colour Corrector and
the Colour Warper to the setup file. If you overwrite a setup file using the Save button, the current settings
in both the Colour Corrector and Colour Warper are saved.

Using Undo and Redo

Use the Undo and Redo boxes to remove or redo colour modifications. To undo or redo a modification, click
a box and select an option from the list. Set the number of undo levels in the Setup menu.

NOTE You also set the number of undo levels for the Modular Keyer in the Setup menu of ConnectFX.

(a) Redo option box

Sampling Clips in the Image Window

When you generate mattes, modify clips, or match colours between clips, you can sample colours in both
the result clip and a reference clip. Use Plot to sample a colour from the result clip and Ref to sample one
from a reference clip. The Plot and Ref buttons appear on every menu in the Colour Warper.

NOTE Ref samples cannot be adjusted.

Samples appear in the histograms. In the 2D luma histogram, the Plot sample is represented by a red bar
and the Ref sample is represented by a yellow bar.

(a) Reference colour (yellow vertical line) (b) Plotted colour (red vertical line)

In the vectorscope, the Plot sample is outlined in red and the Ref sample is outlined in yellow.
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(a) Plotted colour (outlined in red) (b) Reference colour (outlined in yellow)

You can use Plot to get more information on colours you want to change. When you are adjusting colours
and levels and are not sure which controls to use, click Plot and select a colour in the image. You can then
view the histograms to determine which control you should use. For example, if the plotted colour appears
in the middle of the 2D luma histogram, you can modify the colour in the image using the Midtones trackball
while viewing the plotted colour in the 2D vectorscope.

To sample clips:

1 Load a reference clip and position the split bar so that both the reference clip and the result clip appear
in the image window.

2 Do one or both of the following:
■ Enable Plot and then sample the result clip.

To:You can:

Sample a single pixel in the image. You can drag through the image until you locate
the pixel you want to sample.

Click-drag

Sample an average taken from a range of colours in the image.Ctrl-drag

A red vertical line appears in the 2D luma histogram indicating the luma of the sample. The sampled
colour is also outlined in red in the 2D or 3D vectorscope. In the 2D vectorscope, you see the sample
in terms of hue and saturation. In the 3D vectorscope, you see it in terms of HLS. If you are plotting
a colour in a 16-bit floating point image that is out of the 0:1 range, the red outline appears outside
of the vectorscope.

■ Enable Ref and then sample the reference clip.

To:You can:

Sample a single pixel in the image. You can drag through the image until you locate
the pixel you want to sample.

Click-drag

706 | Chapter 19   Colour Correcting



To:You can:

Sample an average taken from a range of colours in the image.Ctrl-drag

A yellow vertical line appears in the 2D luma histogram and the sampled colour is outlined in yellow
in the 2D or 3D vectorscope. If you are referencing a colour in a 16-bit floating point image that is out
of the 0:1 range, the yellow outline appears outside of the vectorscope.

Selecting Colour Ranges for Colour Correction

With some images or clips, you may need to perform selective colour correction—where you modify a range
of colour, as opposed to the entire clip or image. Use the tools in the Selective menu to create selectives.
Selectives are generated mattes used to isolate colour ranges for selective colour correction.

In the Selective menu, you can:
■ Create and refine a matte using tolerance and softness to define the range you want to modify.

■ View a matte, a selected colour range, or the result.

■ Enable mattes to apply the selective colour correction to the result image. Disable mattes to remove the
selective colour correction from the result image.

TIP Set the image window to 2-Up view (Alt+2) so that you can create your matte in one viewport while
simultaneously monitoring the result in the other.

Generating Mattes

Mattes can be used for several purposes. For instance, use a matte to remove colour spill, hue shift an object
in an image for artistic effect, or match colours in a specific range. Use mattes to define the range of colour
you want to modify in the result clip.

You can generate up to three mattes using the Selective menu.

TIP To get the best key, make sure you have enough processing speed to see the result in real time while interacting
with the Tolerance and Softness boundary handles. In the Modular Keyer, you can use the Crop feature to improve
interaction.

To generate a matte for selective colour correction:

1 Enable Plot and then sample the image.

A black dot representing the sample appears on the hue cube. A red line also appears in the luma range
and the sample is outlined in the 2D or 3D vectorscope. When you create the matte, you can modify
the softness and tolerance boundaries to include or exclude the plotted colour.

2 From the Work On box, select a selective (Sel 1, Sel 2, or Sel 3). With each selective, you define a range
for a matte by selecting colours in the front clip.

3 From the Selective View box that appears, select Sel.
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The front clip is displayed as a greyscale image.

4 Click one of the Define controls to set the initial softness and tolerance for the matte.

To define:Click:

The tolerance range based on a sample from the image. You must drag the
cursor over the image to define initial tolerance.

Pick Custom

The tolerance range based on the selected colour channel. For example, click
Yw to use the yellow channel to set the tolerance. The luma range is set to default
tolerance and softness values.

R, G, B, C, M, or Yw

The tolerance range based on the selected luma range. These buttons expand
the tolerance and softness boundaries to include all ranges of colours in the image.

Shadows, Midtones, Highlights

The initial softness and tolerance is set for the matte. The range you use to define the matte becomes
visible through the greyscale image. The unselected colours remain greyscale.
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(a) Original colour visible through the greyscale display.

The Active button associated with the selective is enabled when you set the initial softness and tolerance.
When an Active button is enabled, the selective's matte will be applied to the result clip. You can
disable the Active button at any time if you do not want to apply this matte to the result clip.

TIP To redefine a matte based on a different Define control, click the control you want to use. The matte is
reset according to your selection.

5 Enable Tolerance and Softness.

The range of colour used to define the matte is shown on the hue cube with tolerance and softness
indicators. The light grey outline shows tolerance and the black outline shows softness. When you
define a matte with a luma range, it is shown in the luma range—the white line indicates the tolerance
and the yellow line indicates softness.
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(a) Plotted colour (black dot) (b) Hue cube (c) Tolerance range (d) Softness range (e) Luma range

TIP Select Home from the Frame Options box to reset the hue cube to its original size and position.

6 To view the matte while you refine it, select Matte from the Selective View box.

(a) Work On box (b) Selective View box

The matte appears in the image window. The black and grey areas of the matte can be colour corrected.
The white areas will remain unaffected.

TIP Select Matte view to output a matte for use in another tool in ConnectFX. The selective must also be
selected in the Work On box.

7 To refine the matte, do any of the following:
■ Adjust softness and tolerance by selecting options from the Adjusting box and then sampling the

result clip.

To:Select:

Add tolerance to the matte.Tolerance

Add softness to the matte.+Softness
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To:Select:

Remove softness from the matte.-Softness

■ Adjust softness and tolerance by selecting Move from the Move/Zoom box and then moving the
handles of the tolerance or softness outlines on the hue cube. The Tolerance and Softness buttons
must also be enabled.

(a) Adjusting box (b) Tolerance handle (c) Softness handle (d) Move/Zoom box

TIP You can zoom the hue cube by selecting Zoom in the Move/Zoom box and then dragging the cube.
Alternatively, Ctrl+spacebar-drag to zoom. You can pan the hue cube by pressing spacebar and
dragging.

■ Adjust the softness and tolerance in the luma range by dragging the Softness and Tolerance fields.

(a) Softness range (b) Low Softness field (c) Low Tolerance field (d) Low bracket (e) Tolerance range (f) Plot line
(g) High bracket (h) High Tolerance field (i) High Softness field

When working with 16-bit floating point images, you can press spacebar to pan the gradient bar,
and Ctrl+spacebar to zoom the gradient. Select Home from the Frame Options box to reset the
gradient to the default 0:1 position. If you have softness or tolerance values out of the 0:1 range, select
Autoframe from the Frame Options box to view the complete gradient range. Select Plot Colour from
the Frame Options box to enlarge the gradient to include the plot and reference colours.

■ If the matte appears grainy, drag the Sharpness field to adjust softness and reduce noise.

8 To apply a Gaussian blur, enable G. To apply a box blur, disable G and set the width and height of the
blur with the X and Y fields.

9 To invert the matte, enable Inv Selection.
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10 Continue fine-tuning the matte until you are satisfied.

You can select the selective in the Work On box from any menu in the Colour Warper to perform
advanced colour corrections on the range defined by the matte. You can also change the view in the
Selective View box.

TIP When you switch from the Selective menu to any other menu in the Colour Warper, Result appears in
the Selective View box. Select Result to view the result clip.

Clearing and Deleting Mattes and Colour Corrections

Use the C/R boxes next to the Work On box and Selective View box to reset a matte or a colour correction.
C deletes the matte or colour correction at the current frame by setting a keyframe. R deletes the matte or
colour correction for the entire animation curve.

(a) Work On box (b) C/R boxes (c) Selective View box

NOTE If there is no matte or colour correction associated with the correction, the C/R button is disabled.

To delete a matte for the entire animation curve:

1 Select the matte from the Work On box (Sel 1, Sel 2, or Sel 3).

2 Select R from the C/R box next to the Selective View box.

The matte is deleted. All keyframes and colour corrections associated with the matte are also cleared.

NOTE Keyframes associated with the colour correction are not cleared.

To delete a matte at the current frame:

1 Select the matte from the Work On box (Sel 1, Sel 2, or Sel 3).

2 Select C from the C/R box next to the Selective View box.

The matte is deleted at the current frame and a keyframe is set.

To delete a colour correction for the entire animation curve:

1 Select a matte or the entire image from the Work On box (Master, Sel 1, Sel 2, or Sel 3).

2 Select R from the C/R box next to the Work On box.

The colour correction is deleted and all keyframes are cleared. If you selected a matte (Sel 1, Sel 2, or
Sel 3) from the Work On box, the matte is unaffected and its keyframes are not cleared.
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To delete a colour correction at the current frame:

1 Select a matte or the entire image from the Work On box (Master, Sel 1, Sel 2, or Sel 3).

2 Select C from the C/R box next to the Work On box.

The colour correction is cleared at the current frame and a keyframe is set. If you selected a matte (Sel
1, Sel 2, or Sel 3) from the Work On box, the matte is unaffected and its keyframes are not cleared.

Correcting Colour Imbalances

During production, differences in lighting and equipment often create colour imbalances in and between
clips. When you work on these clips in the Colour Warper, you should perform a basic colour correction to
colour balance them. You can balance colours using the tools in the Basics menu. Perform your tasks in the
following order:
■ Set black and white levels.

■ Remove unwanted colour.

Setting Black and White Levels

When you balance the colours in a clip, you should always start with the darkest and lightest parts of the
image. You may, for example, need to establish parameters for the black and white (luma) content to ensure
that the intensity of the image is in accordance with established broadcast parameters. These parameters
are known as black points and white points. You use the Black and White fields to establish black and white
points.

(a) Black field (b) White field

Black field Modifies the luma in the image's shadows without affecting the chroma.

White field Modifies the luma in the image's highlights without affecting the chroma.

To set black and white levels:

1 Sample the highlights in the image. To determine the white point, select a white that appears to be
flat rather than reflective so that you obtain a more accurate reading. Do not use a highly reflective
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surface such as a window or metal surface as they are often too bright. Enable Plot and then sample
the whites in the result clip.

In the Basics menu, a red plot line is displayed in the 2D luma histogram indicating the luma value of
the sampled whites in the result clip.

2 While viewing the 2D luma histogram and the image, adjust the white level to modify the luma value
and set the white point—drag left to darken the highlights and right to lighten them. The Plot sample
is updated as you drag the field.

TIP You can view both the 2D luma histogram and 2D vectorscope to determine what adjustments you
need to make to the highlights. For example, if the white point is set to an acceptable level in the 2D luma
histogram but the sampled chroma value shows an unwanted colour cast in the 2D vectorscope, use the
Highlights trackball to modify the chroma value in the highlights. See Removing Unwanted Colour (page
714).

3 Enable Plot and sample the shadows in the result clip to determine the black level. Sample the darkest
part of the image to determine the black point.

A red plot line is displayed in the 2D luma histogram indicating the luma value of the sampled blacks
in the result clip.

4 While viewing the 2D luma histogram and the image, adjust the black level to modify the luma
value—drag left to darken the shadows and right to lighten them. The Plot sample is updated as you
drag the field.

TIP Once the black level is set, you can use the Shadows trackball to adjust the chroma values in the highlights
while viewing the plot sample in the 2D vectorscope. See Removing Unwanted Colour (page 714).

Removing Unwanted Colour

Unwanted colour can be caused by factors such as inconsistent lighting conditions during a shoot or
incongruities between the white levels set on a video camera and the given lighting conditions. Factors such
as these can result in clips or images that contain unnatural looking colours or one predominant colour,
which gives the image an unwanted colour cast. After setting black and white points, you can remove the
unwanted colour without affecting the black and white levels. You can:
■ Use the Shadows, Midtones, and Highlights trackballs to remove colour from the shadows, midtones,

and highlights ranges.

■ Use the Suppress trackball to remove a range of colour, such as a colour cast that pervades the entire
image.

Not all colour casts detract from the natural appearance of the image. Before you remove a colour cast, it is
best to analyse the image or clip, both in relation to other clips in the project and with an eye on maintaining
the atmosphere, or mood inherent to the clip. For example, images of sunny summer days should have a
reddish cast to convey an atmosphere of warmth. Completely removing the reddish cast may result in a
colder feel than you want. In cases where the cast is a complementary one, you may want to refine it to
improve the overall effect. See Creating Colour Casts (page 725).

The shadows, midtones, and highlights trackballs in the Basics menu are described as follows.
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(a) Trackballs

NOTE To make the trackballs respond to changes in pressure, use the Pointer preferences in the Preferences menu.

Shadows trackball Modifies the chroma in the low luminance area without affecting the luma.

Midtones trackball Modifies horizontal RGB curves in the 2D luma histogram. These curves represent the
amount of chroma tint you apply to the image. For example, if the red and green curves are above the middle
line while the blue curve is below the middle line, you are adding a yellow tint to the midtones components
of your image.

By default, the Midtones trackball affects all ranges except white and black, as shown by the histogram's
RGB curves. To set the luma range affected by the Midtones trackball, use the two midtones triangles below
the 2D luma histogram. Drag the triangles closer together to decrease the range and further apart to increase
it. You can modify the range as many times as you like. When working with 16-bit floating point images,
the midtones range is set to 0:1, and the midtones triangles can only be moved in this range.

(a) RGB curves (b) Midtones triangle (c) Midtones triangle

Because you can modify the range that the Midtones trackball affects, the trackball will always return to its
default reference value—when you release the Midtones trackball and apply the change, it will return to 0.
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NOTE You can animate the curve using the Shape channel under Midtone in the Channel Editor. Click Animation
to view the Channel Editor.

Highlights trackball Modifies the chroma in the high luminance area without affecting the luma.

To remove unwanted colour using the Shadows, Midtones, and Highlights trackballs:

1 Click Basics to display the Basics menu.

2 Enable Plot and then sample the image's highlights.

The sample (outlined in red) appears in the 2D or 3D vectorscope.

TIP You can determine the colour of a sample by dragging right in the Saturation field to temporarily increase
the saturation while monitoring the sample in the 2D vectorscope. When you release the mouse, the level
that appears in the field resets to its default reference value. Once you determine the cast of the colour, click
Undo to reset the saturation level and then resample the image.

3 If necessary, double-click the 3D vectorscope to display the 2D vectorscope.

4 While viewing the 2D vectorscope, drag the Highlights trackball to move the sample towards the centre
of the 2D vectorscope.

The chroma in the high luminance area of the clip is modified without affecting the luma.

5 Drag the Midtones trackball to make minor adjustments to the chroma content.

TIP Drag the left midtones triangle to decrease the range affected by the Midtones trackball. Make sure the
range includes the sampled colour.

The RGB curves in the 2D luma histogram reflect the changes you make. More of the unwanted colour
is removed from the image (while still preserving luma) without affecting the black and white points.

TIP To achieve true white, drag the Highlights and Midtones trackball to move the plot sample to the centre
of the 2D vectorscope.

6 Continue modifying the highlights and midtones until you are satisfied with the result.

7 Enable Plot and then sample the image's shadows.

8 Repeat steps 2 to 6 using the Shadows and Midtones trackballs to remove unwanted colour from the
shadows (and midtones) in the image.
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To remove unwanted colour using the Suppression trackball:

1 Click Basics to display the Basics menu.

2 Select Suppress from the Trackball option box.

3 To sample the colour you want to suppress, enable Plot and then sample the image.

The sample (outlined in red) appears in the 2D or 3D vectorscope.

4 While monitoring the 2D vectorscope and image, drag the Suppress trackball towards the colour you
want to suppress to move it closer to the centre of the 2D vectorscope. For example, to suppress yellows,
move the trackball towards yellow.

TIP Disable Source and Destination to only view the sample.

5 Release the trackball.

6 To further increase the suppression of the same colour, use the trackball to move the colour closer to
the centre of the 2D vectorscope.

Improving Contrast

Poor image contrast can be caused by various factors. For example, when you remove a colour cast from a
clip, it may become washed out. Washed out clips usually occur when the image contrast and saturation
levels are too low. To complete the task of balancing the colours in the clip, use the tools in the Basics menu
to correct the poor contrast. To improve contrast and the overall look of the clip, you can:
■ Adjust the luma and chroma content in the shadows and highlights, including the black and white point.

■ Increase colour saturation without changing luma.

■ Modify the luma and chroma content using the Gamma controls.

Adjusting Shadows and Highlights to Improve Contrast

When there is not enough, or too much, black or white in a clip, it will lack contrast. If you want to improve
the contrast by changing both the chroma and luma content, including the black and white points, use the
controls in the Basics menu to adjust the shadows and highlights in the image.
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To adjust the shadows and highlights to improve contrast:

1 Click Basics to display the Basics menu.

2 Enable Plot and then Ctrl-drag the cursor over the portion of the result clip containing black or white.

In the Basics menu, a red plot line is displayed in the 2D luma histogram indicating the luma value of
the sampled blacks. In the vectorscope, you can view the saturation and hue.

3 Use the 2D luma histogram and 2D vectorscope to determine which controls you need to use (such as
the Black field, and Shadows and Midtones trackballs).

4 While viewing the 2D luma histogram, adjust the black level to modify the luma value. The Plot sample
is updated as you drag the field.

5 While viewing the 2D vectorscope, drag the Midtones and Shadows (Highlights) trackballs towards
the colour you want to increase in the blacks or whites. The Plot sample is updated as you drag the
trackball.

TIP To achieve true black or white, drag the Midtones and Shadows trackball to move the plot sample to
the centre of the 2D vectorscope.

6 Continue modifying the shadows until you are satisfied with the result.

TIP View the sample in the 3D vectorscope to make more refined modifications.

Increasing Saturation

When an image is desaturated, the colours can appear washed out. To improve contrast, you can increase
the colour saturation globally, saturate specific hues, or do both. Increasing saturation levels increases the
colour intensity and causes minor changes to the hue. The luma content is virtually unaffected when you
modify saturation.

To increase saturation globally:

1 Click Basics to display the Basics menu.

2 Drag right in the Saturation field while monitoring the 2D or 3D vectorscope and the image.

The selected colour range (or entire image) moves towards the perimeter of the 2D luma histogram.
There is also an increase in colour saturation in the image.
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To saturate specific hues of an image:

1 Click Basics to display the Basics menu.

2 Select Saturate from the Trackball option box.

3 Drag the Saturate trackball towards the colour you want to saturate while monitoring the 2D vectorscope.
Drag until the colour is closer to the edge of the 2D vectorscope. For example, to saturate reds, move
the trackball towards red.

NOTE To make the trackballs respond to changes in pressure, use the Pointer preferences in the Preferences
menu.

4 Release the trackball.

5 To further increase the saturation of the same colour, use the trackball to move the colour closer to
the edge of the 2D vectorscope.

Improving Contrast Using Gamma

When you want to improve contrast by modifying both the chroma and luma content simultaneously
without changing the black and white points, use the Gamma controls. You only need to make small
adjustments to the RGB gamma curves to improve the contrast.

You can adjust the RGB gamma curves uniformly using the RGB Gamma fields.

You can also use a second set of adjustment curves to tweak each colour channel, as well as the luminance
channel, regionally.

After making uniform or regional adjustments, if you are not satisfied with the result, you can reset each
channel's gamma or adjustment curve, or clear edited curve values for individual frames.
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(a) Trackball option box (b) Gamma curves (c) Reset box (d) Luma range

To improve contrast using gamma:

1 Click Basics to display the Basics menu.

2 Select Gamma from the Trackball option box.

3 Display the gamma curve(s) you want to adjust.

To display:Enable:

The R, G, and B gamma curves at the same time.RGB

The R, G, or B gamma curve individually.Red, Green, or Blue

The Luminance curve. Use this curve to modify luminance levels locally without
affecting the overall luminance.

Luminance

Two curves are displayed for each channel, the original gamma curve, and an adjustment curve with
control points for regional control. Initially these curves overlap.
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(a) Red channel's gamma curve (b) Red channel's adjustment curve (c) Added control points on adjustment curve

4 While monitoring the 2D vectorscope and image, make a minor adjustment to the gamma curves by
doing one of the following:
■ To modify R, G, and B gamma values individually across the entire luma range (from black to white),

click and drag in the Gamma R, G, and B fields. Drag left to increase contrast or right to decrease
contrast. You can also enter a value directly in these fields. Enter a low value to increase contrast
or a high value to decrease contrast.

Only the field you modified is updated. The gamma curves are also updated to reflect your changes.
The gamma curve is offset from its dotted adjustment curve. Use the adjustment curve to make regional
adjustments to the channel.

(a) RGB Gamma Fields

■ To modify R, G, and B gamma values proportionally across the entire luma range (from black to
white), Alt-drag the Gamma R, G, or B field. Drag left to increase contrast or right to decrease
contrast.

All three fields are updated. The gamma curves are also updated to reflect your changes. The gamma
curves are offset from their dotted adjustment curves. Use the adjustment curve to make regional
adjustments to the channel.
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TIP To smooth the contrast, you can increase the gamma (raise the curves) and then adjust the Black and
White levels in the Basics menu.

■ To modify part of the RGB gamma or luminescence range rather than the entire range, use the Edit
Mode box to modify the adjustment curves.

To:Select:

Add control points to an adjustment curve. With Add selected, click either the red,
green, blue or luminance adjustment curve to add a control point.

Add

Delete control points from an adjustment curve. With Delete selected, click a point on
the red, green, blue or luminance adjustment curve to delete it.

Delete

Move the control points. With Move selected, drag the points to move them.Move

Zoom in on the curves. With Zoom selected, drag over the curves right or left to zoom
in or out. You can also press Ctrl+spacebar and drag in the curves to zoom.

Zoom

Zoom in on a section of the curves. With Rect Zoom selected, drag a selection box to
zoom in on the area of the curves contained by the selection box.

Rect Zoom

Pan the curves. With Pan selected, drag over the curves to pan the curves in any direc-
tion. You can also press spacebar and drag in the curves to pan.

Pan

After dragging control points, the image and 2D vectorscope update accordingly.

To reset RGB gamma or luminance curves for all frames in the clip:

1 Do one of the following:
■ To reset individual RGB gamma curves, select R in one of the Channel Reset boxes next to the

Gamma R, B, or C field.

The gamma curve is reset along with its adjustment curve for all frames in the clip. Any control points
added to the adjustment curve are removed.

■ To reset the R, G, or B gamma value for the current frame, Ctrl-click the GamR, GamB, or GamC
field.

■ To reset RGB adjustment or luminance curve values for all frames in the clip, click one of the
channel buttons (RGB, Red, Green, or Blue) or the Luminance button to display the curves you
want to affect, then select Reset in the Reset box.

The values for the displayed adjustment curves or luminance curve are reset. Any control points added
to the adjustment curves or luminance curve are removed.

To clear RGB gamma or luminance curve values for the current frame:

1 Do one of the following:
■ To clear individual RGB gamma curve values for the current frame, select C in one of the Channel

Reset boxes next to the Gamma R,B, or G field.
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The gamma curve value is cleared for the current frame, and the gamma curve is updated without
affecting its adjustment curve. A keyframe is set with the reset values.

■ To clear RGB adjustment or luminance curve values for the current frame, click one of the channel
buttons (RGB, Red, Green, or Blue) or the Luminance button to display the curves you want to
affect, then select Clear in the Reset box.

The values for the displayed adjustment curves or luminance curve are reset for the current frame. The
curves' control points are distributed equidistantly along each curve. A keyframe is set with the reset
values.

Matching Colours in Clips

You can match a sample from the result clip to one from a reference clip. Matching clips can improve
continuity between clips. You can:
■ Match specific colours.

■ Match shadows, highlights and overall saturation.

Matching Specific Colours

You can match plot samples to reference samples using the trackballs and by aligning the colours in the
vectorscope. For example, you may want to match a red in one image to a different shade of red in another
clip. For information on using Plot and Ref controls, see Sampling Clips in the Image Window (page 705).

To match specific colours:

1 Select Result from the View box.

The result clip is displayed in the image window.

2 If necessary, position the split bar so that both a reference clip and the result clip appear.

3 Enable Plot and then sample a colour in the clip you want to modify (the result clip).

A red plot line is displayed in the 2D luma histogram indicating the luma value of the sample. In the
2D vectorscope, you can view the saturation and hue of the sample (outlined in red). In the 3D
vectorscope, you can view the sample in terms of HLS.

4 Enable Ref and then sample the colour in the reference image you want to match.

A yellow reference line is displayed in the 2D luma histogram indicating the luma value of the sample.
In the 2D vectorscope, you can view the saturation and hue of the sample (outlined in yellow). In the
3D vectorscope, you can view the sample in terms of HLS.

5 Use the 2D luma histogram in the Basics menu and 2D vectorscope in the image window to determine
which controls you need to use.

When:Drag:

You need to adjust the luma values in the highlights or shadows without
modifying the chroma. Drag the field so that the plot line in the 2D luma his-
togram moves towards the reference line.

White or Black field

You need to adjust the chroma values in the image without modifying the
luma. Drag the trackball(s) so that the plot sample in the 2D vectorscope moves
towards the reference sample.

Highlights, Midtones, or Shadows
trackball
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6 Use the necessary controls to modify the clip until the plotted sample is aligned with the reference
colour in the 2D luma histogram and 2D vectorscope. If necessary, increase or decrease the saturation
as well as shift the hue.

TIP View the sample in the 3D vectorscope to make more refined modifications.

Matching Shadows, Highlights, or Overall Saturation

Use the Match feature to match a range of colours in the result clip to a range of colours in a reference clip.
You can match highlights, shadows, or the overall saturation of an image.

NOTE Match is not designed to match specific colours.

To match shadows, highlights, or overall saturation:

1 Select Result from the View box.

The result clip is displayed in the image window.

2 Position the split bar so that both a reference clip and the result clip appear.

3 Click Match.

The following message appears in the message bar: “MATCHING: Select an area to be modified.”

4 Click and drag on the result clip to draw a box around a range of colours. You can select an area of the
image that is predominantly black, white, or contains a wide spectrum of colours. To match the overall
saturation of an image, select a larger area of the image.

The blue indicator on the Match button is enabled, indicating that you need to select a destination
sample.

5 If necessary, position the split bar to show more of the reference image.

6 Click Match.

The following message appears in the message bar: “MATCHING: Select an area to match to.”

7 Click and drag to draw a box around a range of colours in the reference clip. You should match whites
with whites, blacks with blacks, or select a broad range of colours on both images to match saturation.
Trying to match completely different colours will produce unpredictable results.

The range in the result clip is matched to the range in the reference clip.

8 Repeat these steps as often as necessary to obtain the best possible match between colours. You can
use Match repeatedly to make your colour match more precise.

9 To refine the result, use other controls in the Basics menu (such as the Saturation field), and then reuse
Match.

To clear a Match operation:

1 Click the Undo box.

To cancel a Match operation in progress:

1 If you begin using Match and want to cancel the matching process, adjust any value using the trackballs
or fields.

The blue indicator on the Match button will be disabled, indicating that the matching process has
been cancelled.
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Performing Hue Shifts

You can use the Hue field in the Basics menu to perform hue shifts on the entire image or a range in the
image defined by a selective's matte. Perform hue shifts when you want to change the colour of an object
or create other artistic effects. Hue shifts do not affect the luma.

You can also perform hue shifts when you want to suppress colour spill. See Removing Colour Spill (page
727).

To perform a hue shift:

1 If necessary, create a matte for the range of colour you want to change. See Selecting Colour Ranges
for Colour Correction (page 707).

2 Click Basics to display the Basics menu.

If you are using a selective, the Selective View box should display Result when you display the Basics
menu.

3 Sample the image to see the hue shift in the 2D luma vectorscope. Enable Plot and then sample the
colour range in the image you want to hue shift.

A red line also appears in the 2D luma histogram and the sample is outlined in the 2D or 3D vectorscope.

4 Drag the Hue field while monitoring the 2D or 3D vectorscope and the image.

The selected colour content (or entire image) shifts through the colour range.

5 If necessary, you can change the saturation of the hue by dragging the Saturation field—drag right to
increase saturation or left to decrease it.

The selected colour range moves towards the perimeter or centre of the 2D luma histogram.

Creating Colour Casts

You can use the Midtones trackball to create a colour cast that affects the chroma in the entire image without
affecting the luma. Create a colour cast when you want to emphasize a colour range to create an artistic
effect or when you want to refine an existing cast. For example, create or refine a bluish cast to convey a
cooler atmosphere.

NOTE Before you create a colour cast, you should correct colour imbalances in the image or clip. See Correcting
Colour Imbalances (page 713).

To create a colour cast:

1 Click Basics.
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(a) Trackballs (b) Midtones triangles

TIP You can determine the colour of an existing cast by dragging right in the Saturation field to temporarily
increase the saturation while monitoring the sample in the 2D vectorscope. Click Undo once you determine
the colour of the cast.

2 To add a colour cast to the entire image, drag the midtones triangles so that they span the entire luma
range.

3 While viewing a vectorscope and the image, drag the Midtones trackball towards the colour you want
to increase in the clip or image. For example, to add more yellow to the image, drag the Midtones
trackball towards yellow.

In the 2D or 3D vectorscope, the colours update to reflect your changes. In the image window, the
colour in your clip changes according to the direction the trackball is being dragged.

NOTE When you drag the Midtones trackball, the RGB curves in the 2D luma histogram also reflect the
changes you make.

4 To increase a range of colour in the highlights or shadows of the image, drag the Highlights or Shadows
trackball.

5 To increase or decrease the saturation of the cast, drag the Saturation field—drag right to increase
saturation and left to decrease it.

TIP You can make slight modifications to the hue of the cast using the Hue field.

Readjusting Colour After a Colour Correction

When colour correcting clips, colours that you do not want to alter may be modified in the colour correction
process. Use the Warp trackball in the Basics menu to readjust a specific range of colour.

You can also adjust the luminance of the selected colour using the Luma field.

To readjust colours after a colour correction:

1 Click Basics.

The Basics menu appears.
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(a) Trackball option box (b) Source Colour pot (c) Destination Colour pot (d) Luma field

2 Select Warp from the Trackball option box.

3 Click Pick and then sample a colour in the clip you want to modify.

The colour you select is outlined in white in the 2D or 3D vectorscope. A cyan bar representing the
colour appears in the 2D luma histogram. The Src Colour pot displays the colour.

4 Click the Src Colour pot to set the source colour.

The Dst (destination) Colour pot is updated to match the source colour.

5 Move the Warp trackball towards the destination colour.

The Dst Colour pot dynamically updates to reflect your changes. When you release the mouse, the Src
Colour pot is updated to match the destination colour. In the 2D or 3D vectorscope, the selected colour
moves to reflect the changes you are making to the image.

NOTE To make the trackballs respond to changes in pressure, use the Pointer preferences in the Preferences
menu.

6 To adjust the luminance of the destination colour, adjust the Luma field. When you adjust the luma
of the destination colour, the entire luma content of the image is adjusted around the selection. The
selected luma value changes the most.

The Dst Colour pot dynamically updates to reflect your changes. When you release the mouse, the Src
Colour pot is updated to match the destination colour. In the 2D luma histogram, the cyan bar moves
to reflect the changes you are making to the luma content.

7 Release the trackball or click the Luma field.

The Src Colour pot is set to the Dst box colour.

Removing Colour Spill

When you key clips in the Modular Keyer, there can be colour spill. You can refine the key by suppressing
colour spill in the Colour Warper. Use the Saturate and Suppress trackballs in the Basics menu. Use the
Suppress trackball to suppress the colour spill and the Saturate trackball to correct any unwanted colour
suppression. When you use these trackballs to modify colour in the image or clip, a range of colour is affected.

In the Modular Keyer, place the Colour Warper node in the CBlend pipe.

To remove a colour spill:

1 Click Basics to display the Basics menu.
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2 Select Suppress from the Trackball option box.

NOTE To make the trackballs respond to changes in pressure, use the Pointer preferences in the Preferences
menu.

3 Move the Suppress trackball towards the colour that you want to suppress. For example, to remove a
blue background, move the trackball so that the blue colours appear in the centre of the 2D vectorscope.

NOTE The colour you are suppressing appears in the middle of the 2D vectorscope at full suppression.

By comparing the Result clip and the Front clip, you may notice some unwanted colour suppression
to the colour that is opposite (on the colour wheel) the one you just suppressed. You can fix such
suppression with the Saturate trackball.

4 Select Saturate from the Trackball option box.

5 Move the Saturate trackball towards the colour that you want to saturate.

The colour that you are saturating moves closer to the edge of the 2D vectorscope.

728 | Chapter 19   Colour Correcting



6 It may be necessary to adjust colours in the image using the Suppress and Saturate trackballs several
times to achieve suitable results. Continue adjusting the trackballs until you are satisfied with the
result.

Creating Subsetups

Subsetups are Colour Warper setups selected at a specific moment at a specific frame. Subsetups are for the
current frame only and do not include entire animations. You can select up to ten subsetups and compare
colour corrections in other subsetups. You can save and load a group of subsetups.

NOTE The group of subsetups loaded affects all Colour Warper nodes in the current setup since subsetups are
shared between Colour Warper nodes. Ten subsetups (A-J) constitute a group.

Use the Subsetups menu to:
■ Selectively store intermediate setups.

■ Compare any subsetup to the current setup.

■ Share subsetups between Colour Warper nodes.

■ Save and load a group of subsetups.

(a) Subsetup buttons (b) Subsetup fields

Storing and Retrieving Subsetups

You can store and retrieve subsetups using the Subsetup buttons.

To store and retrieve the current setup:

1 Press and hold one of the subsetups buttons until a message appears indicating “Storing subsetup
<subsetup letter>” and release.

The LED indicator shows that the subsetup is stored. All active subsetups have a LED indicator. If you
have not stored anything into a subsetup, the active light of the button will be off.

2 Use the setup at another frame or in another node by pressing the corresponding Subsetup button.

Naming Subsetups

You can name your subsetups. This allows you to store setups and later compare them to your current setup,
or to apply the same correction to different frames in a clip.
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To name a subsetup:

1 Click in a subsetup field, type in a name or description, and press Enter to store the setup.

Replacing Subsetups

You can replace or override a setup.

To replace an existing setup:

1 Click and hold a subsetup button to overwrite and replace an existing subsetup. A keyframe is set and
the new subsetup is saved.

Comparing Subsetups

The current setup is accessed with the Current button and contains the most recently committed setup.
Compare any of your subsetups to each other or to the contents of the current setup.

To commit the contents of the current setup:

1 Perform an operation such as advancing a frame or changing a value in the Basics menu. Your present
settings will be displayed the next time you click Current.

To compare a subsetup:

1 Click a Subsetup button of the subsetup you want to compare.

2 Click Current to view the current result.

Saving and Loading Subsetups

Use the Save button in the Subsetups menu to save a group of subsetups. Then use the Load button in a
later session to reload the same group of subsetups.

To save a group of subsetups:

1 In the Subsetups menu, click Save.

The file browser appears.

2 Browse to a different directory path if necessary and then type a name in the Name field.

3 Click Save.

The group of subsetups is saved in the specified directory.

To load a group of subsetups:

1 In the Subsetups menu, click Load.

The file browser appears.

2 Browse to the appropriate path and select the name of the group of subsetups.

The group of subsetups is loaded.
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Painting

Paint Node
Paint Node is a system that provides a scalable matte painting, retouching, or restoration workflow in
ConnectFX.

Due to its underlying technology, Paint Node automatically scales strokes when changing the resolution,
ratio, or bit depth of input clips, or when switching from Full Resolution to Proxy mode. Paint Node supports
“clipless” setups, which can be applied to any image input, while accurately reproducing the sequence of
painted strokes.

The Paint Node accepts a front and matte clip as input, and creates a result and output matte clip, respectively.
You can paint on the result and output matte, with a selection of brushes in different paint modes.

Paint Node also allows you to connect multiple sources and use them to paint the contents of source images
onto the result. This paint operation, applied with the Reveal paint tool, can be used with in-context overlay
over the result image. A front and matte clip can be connected as a source by connecting the clips to a source
node. The content of source front and source matte input can be used to create brush strokes on the result
and output matte.

Accessing Paint Node

Paint Node can be accessed from:
■ ConnectFX. (page 731)

■ Modular Keyer. (page 732)

Accessing the Paint Node from ConnectFX

To access Paint through Connect FX:

1 Select Timeline.

2 Select the segment.

3 Click the FX button.

4 Click the Create Connect FX button.

20

731



5 Drag a Paint Node into the schematic.

The Paint Node is now in the schematic.

6 Double-click the Paint Node.

You are in the Paint Node editor.

Accessing the Paint Node from the Modular Keyer

To add a Paint Node in the Modular Keyer:

1 Double-click on, or drag, a Paint Node from the node bar and add it to the schematic.

2 Click the Paint Node.

You are in the Paint editor.

Using Sources

Sources are additional image data that can be used in Reveal paint operations and displayed as an overlay
on the result or output matte. You can scale, rotate, and offset a source. Any transformations applied to a
source will be displayed in Reveal paint strokes.

In the Paint Node menu, all sources appear in the Sources list. The Sources list allows you to select sources
to be hidden, cleared, or displayed as an overlay. The first entry in the list is the front clip and matte clip.

In the schematic, source clips are connected to a Paint Node through a source node, which accepts a source
front and source matte input.

A source can be a clip or the result of any process, and can include a front and/or matte clip. You can add
a source node from the menu or the schematic.

If a clip with frames that are missing media is attached to a source node, the Paint Node processes incoming
frames set to No Media as transparent. Strokes created with the source are stored, although they are not
visible on the canvas at frames with No Media input.

When adding a source input, it is recommended that you use clips as input, or cache the node closest to the
source node instead of parenting a large tree to a source node. This speeds up processing when changing
frames, making for a more interactive experience.

(a) Front (b) Matte (c) Source front (d) Source matte

When you delete a source, it is removed from the Sources list, along with its associated strokes. When you
clear a source, it remains in the Sources list, but all strokes are removed.
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Adding a Source

When you add source, it includes both source front and source matte input. When you add a source front
only, a black matte will automatically be created.

To add source node, front source and matte source:

1 In the Paint Node menu, click Add.

The Viewing Panel appears.

2 Select a source front clip, and then a source matte clip.

3 Click Exit Clip Select to return to the Paint Node menu.

In the Sources list, the source is added. In the schematic, the process tree is updated: a source node
with the selected clips is connected to the Paint node.

4 To help identify source nodes in the schematic, select a source in the Sources list to automatically
highlight in orange the corresponding source node and link to the Paint Node. Conversely, selecting
a source node also highlights the corresponding source in the Sources list.

To add a source node only:

1 Hold Ctrl and click Add to add a source node.

The source node is added and connected to the Paint Node.

(a) Source node (b) Paint Node

2 Connect clips or process tree input to the source node's front and matte inputs.

Removing a Source

You can remove a source clip from the Sources list. If you disconnected a source clip from the source node,
the entry exists in the Sources list, but the clip name and proxy no longer appear. Because the stroke
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information is stored in the node, you can reconnect the same clip or a different clip to the source node,
and the stroke information is preserved. All strokes in the canvas using the source are repainted using the
new source clip.

When you delete a source node, the entry is removed from the Sources list, and the strokes stored in the
node are deleted permanently.

To remove a source clip from the Sources list:

1 In the schematic, disconnect the source clip from the source node.

To delete a source node:

1 From the Edit Mode box, select Delete (or use the keyboard shortcut), and click the source node in the
schematic.

Clearing Strokes on a Source

You can clear strokes from the canvas that were created using a source front or source matte.

WARNING Clearing strokes for an entire sequence cannot be undone.

To clear the strokes associated with a source:

1 In the Sources list, select the source used to create the strokes you want to clear.

2 From the Selection Mode box, select Current Frame or Sequence.

3 Click Clear Strokes.
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Hiding Strokes

You can hide a group of strokes that were created from the same source clip.

Hiding strokes is useful when you need to focus on a particular component of your image: hide strokes on
the canvas that do not require attention. This feature allows you to concentrate on the current stroke. It
also improves the system's interactive performance.

To hide strokes on a source:

1 Select the source used to create the strokes that you want to hide.

2 In the Sources list, click Hide Strokes (H).

A check mark appears in the H column of each source.

3 Click Hides Strokes again to make the strokes visible.
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Restricting Strokes with the Source Matte

You can limit the sections of the source that are painted onto the canvas using the source's matte. To limit
painting on the canvas using the matte. See Restricting Brush Strokes (page 744).

To limit source brush strokes using a source matte:

1 In the Paint Modes box, select Reveal (E).

2 In the Sources list, select a source.

3 From the source controls, select an option in the Matte Source box.

To:Select:

Paint anywhere on the canvas.Matte Off

Limit painting to areas in the source matte.Matte On

Invert the source matte and limit painting to areas outside the source matte.Matte Invert

4 Draw strokes.

Brush strokes only use areas of the selected source that are delimited by its source matte.

Locking Sources

Lock a source to a specific frame. For the duration of the clip, only the source front and source matte at the
selected frame is used.

To lock a source:

1 Select the source you want to lock.

2 Using the playback controls, choose the frame at which you want to lock the clip.

3 In the Source Front option box, select Front Lock.
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A check mark appears in the L column of each selected source.

4 In the Source Front option box, select Front On to unlock the source.

Displaying Sources

Paint Node offers an intuitive way of previewing the effects of a Reveal operation. In this view, the selected
source is superimposed over the result, and the Transparency field is activated to allow for transparency
adjustments. This feature allows you to see exactly what your brush strokes will reveal. See Previewing a
Reveal Operation Using a Reference Image (page 754).

Brush Attributes and Attribute Modes

You can set various brush attributes and attribute modes to determine how paint is applied to the image.

Setting Brush Attributes

The Brush Attribute fields set the size of the brush, the distribution of the paint, and the rate and direction
of the paint application.

(a) Brush Attribute fields

Opacity Affects the transparency of the brush. A value of 100% applies a fully opaque colour. Use a lower
value to apply a more transparent colour.

Size Determines the size of the brush, which is indicated by the diameter of the green dashed circle
surrounding the cursor brush. To increase the brush size, press Q and drag the brush to the right on the
canvas. To decrease it, press Q and drag to the left.

Rate Determines the rate at which brush strokes are applied to the canvas. Use a high value to produce a
smooth continuous stroke, or a low value to produce a less continuous stroke with larger gaps between brush
images. The C (Constant) button in the Rate field determines whether the consistency of the stroke is
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dependent on the speed at which you move the pen or mouse. For example, to create a stroke of evenly
spaced dots, you could set the Rate field to 20 percent and enable Constant.

Rate attribute value = 25Rate attribute value = 100

Pressure Affects the transparency of the paint applied to the image. To apply opaque paint, use a high
percentage value. For more transparent paint, use a low value. The Pressure attribute differs from the Opacity
attribute in that you can set the Pressure attribute mode so that the paint transparency varies according to
the pressure applied to the pen or the direction of the brush.

Pressure attribute value at 50%
Pressure attribute value at 100%
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Jitter Randomizes the brush strokes applied to the image. A high value produces a greater dispersion of
paint, while a low value produces a greater concentration.

Jitter attribute value at 10%
Jitter attribute value at 100%

Direction Causes the brush to rotate around the Z-axis and can be used to produce a calligraphy effect. The
effect of the Direction attribute is most noticeable when used with one of the elliptical or star brushes. The
value of the Direction attribute causes the brush strokes to rotate by 90 degrees for each increment of 25
percent.

Direction attribute value at 75%
Direction attribute value at 100%

Direction attribute value at 25%
Direction attribute value at 50%

Paint Node | 739



Roll Rolls the brush around the X-axis. The effect of the roll is most noticeable when used with one of the
non-symmetrical brushes. For each increment of 25 percent, the Roll attribute value creates a rolled brush
stroke of 90 degrees.

NOTE You can use any attribute mode with the Roll attribute.

Roll attribute value at 75%Roll attribute value at 100%

Roll attribute value at 25%Roll attribute value at 50%

Setting Brush Attribute Modes

The value of a brush attribute depends on the selected attribute.
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(a) Brush Attribute Mode boxes

Off Disables the brush attribute.

Constant Keeps the brush attribute values constant.

Pressure Uses the pressure exerted on the pen as the reference value. The harder you press on the pen, the
greater the brush attribute value. The softer you press, the lower the brush attribute value.

Direction Uses the direction of the brush stroke as the reference. When used with the Direction mode, the
Direction attribute causes the brush strokes to follow the trajectory of the brush. Increase the value to enhance
the effect on brush direction. Drag right to use 100% of the brush attribute value, left to use 0%, up to use
25%, or down to use 75%.

Direction attribute value at 15%, Direction attribute modeDirection attribute value at 100%, Direction attribute mode

Fade Uses the percentage value entered in the Fade field to determine the length of time that elapses before
the brush stroke fades. The greater the percentage, the faster the stroke fades. A value of 100 in the Fade
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field causes the stroke to fade quickly, whereas a value of 1 causes the stroke to last longer. Also, strokes
applied quickly will be longer than those applied more slowly.

Pressure attribute value at 100%, Fade attribute mode at
85%

Pressure attribute value at 100%, Fade attribute mode
at 35%

Front, Matte, Source Front and Source Matte Allows you to use the red channel in a reference image to
set brush attributes. Source Front and Source Matte mode use the red channel of the selected source in the
Sources list.

Painting Brush Strokes

You can paint on the canvas using a variety of brush types and colours. Once you select a brush type, you
can modify brush attributes to further refine your strokes. A stroke can be applied to a single frame, or
simultaneously to multiple frames. You can paint on the result or output matte, or you can use matte paint
mode controls to paint on the result and output matte at the same time.

You can restrict brush strokes to the area delimited by the matte. For example, assume that you have a front
input that includes a person shot against a blue screen and a corresponding matte clip. If you opt to limit
brush strokes to the matte, your brush strokes on the result or output matte appear only inside the matte
area and, therefore, over the person. If you then limit brush strokes to the existing strokes, new paint strokes
are applied only over strokes that have already been applied.

Applying Brush Strokes

You can paint with either a pen or a mouse, and access various pressure settings.
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To apply a brush stroke:

1 Select an option from the Paint Tools box.

2 Select an option from the Paint On box to apply the stroke to the current frame, all frames in the
sequence, or the current frame and subsequent frames.

3 Select the Result (F4) or Output Matte (F4 F4) to set the view where you are painting.

4 If you want to paint on the result and output matte simultaneously, enable Both.

5 Click a brush to select it.

6 Set brush attributes. See Brush Attributes and Attribute Modes (page 737).

7 If you will reveal a source on the image, select the source in the Sources list. See Revealing Sources
(page 749).

8 To change the colour, click a colour pot. If you are painting on the output matte, the brush colour is
grey with an equivalent luminance value.

TIP As an alternative to using the colour pots, you can designate the colour under the pointer as the current
brush colour by pressing the left Ctrl key and clicking on the canvas.

9 Click and drag on the canvas to draw a stroke.

NOTE Downstream context views are not automatically updated as you add strokes, since this would cause
performance degradation. To force an update, click the Update button.

10 Use the eraser end of the pen if you are using the stylus to erase strokes that you have created.

Removing Brush Strokes

You can undo multiple brush strokes in Paint Node. You can use the Undo button to remove brush stroke
operations, beginning with the most recent strokes. Set Undo level operations in the Preferences menu.

If you are using a stylus, remove brush strokes manually by using the back of the stylus to “erase” strokes.
If the result is displayed, erasing reveals the front clip on the canvas. If the output matte is displayed, erasing
reveals the matte.
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Restricting Brush Strokes

You can limit the area where brush strokes are applied on the canvas. Use the matte paint mode controls to
limit painting on the canvas to the matte. You can also invert the matte to limit paint to only the areas
outside the original matte.

To limit which regions of a source front can be used by its source matte, use the Matte Clip option box in
the source controls. See Restricting Strokes with the Source Matte (page 736).

To limit where brush strokes are applied using the matte:

1 Enable Use Matte.

2 If you want to paint outside of your selection, enable Invert.

3 Draw strokes.

Brush strokes are applied only to the areas included in your selection.

4 Disable Use Matte to turn off matte restrictions.

Scaling Brush Strokes

You can set scaling options for brush strokes associated with the Paint Node. By specifying the previous
resolution of an input clip before it was resized, the brush strokes applied to the clip can also be scaled based
on these settings.

To display the stroke scaling options:

1 Double-click the Paint node.

2 Click Node Setup.
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(a) Aspect Ratio Presets box (b) Project Resolution Presets box

Project Resolution Presets box Provides preset aspect ratio options and an option to use a custom resolution.
Set this option to indicate the previous resolution of the clip.

Width and Height fields Displays the frame width and height of the selected resolution preset. If you select
Custom from the Project Resolution Presets box, use these fields to enter the values you want to use.

Aspect Ratio Presets box Provides standard frame aspect ratio options and a w:h option to use a ratio based
on the values entered in the Width and Height fields. Also provides a Custom option so you can enter a
frame aspect ratio in the Ratio field.

Ratio field Displays the original aspect ratio of the clip. When Ratio is set to Custom, this field becomes
active so that you can enter a custom frame aspect ratio.

Stroke Resize box Select a fit method option to be applied to the clip.

To:Select:

Center the strokes over the destination frame. If the clip at the original resolution is larger
than the destination, the strokes are cropped.

Centre/Crop

Fit one edge of the original clip input into the destination frame without stretching or
squashing the frame. Excess parts of the original clip after resizing are cropped.

Crop Edges

Fit the original stroke width and height into the destination frame. If the clip at its original
resolution and destination frames do not have the same aspect ratio, the brush strokes
can become distorted.

Fill

Fit the original stroke to the destination frame without squashing or stretching it, and
without cropping the source.

Letterbox

Keep Aspect button Enable to preserve the aspect ratio of non-square pixels. This button only appears if
you selected Crop Edges or Letterbox in the Fit Method box.

Stroke Pan fields Enter an X and Y value to offset existing strokes on the result. You can also reposition
strokes by holding down Ctrl+Shift and panning the image.

Current Resolution fields Displays details of the current resolution of the clip.

Active button Enable to activate smooth filtering of pixels for enhanced display
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Using Paint Modes

You can select the type of special effects you want to apply to the brush from the Paint Modes box. Strokes
applied with these brushes are processed by the graphics hardware, improving interactive performance. To
paint sources onto images, see Revealing Sources (page 749).

To select a brush:

1 Switch to either Result (F4) or Output Matte (F4 F4) view.

2 From the Paint Modes box, select a brush. Refer to the sections that follow for instructions on using
each brush.

TIP When a brush is selected, brush opacity and blend modes are disabled. To achieve an effect similar to
modified brush opacity, use the Pressure attribute mode.

Blur

Apply a blur filter to the image with each stroke.

After using the Blur brushOriginal image

To use the Blur brush:

1 From the Paint Modes box, select Blur (R).

2 Set the brush size according to the size of the area you want to blur.

3 Paint on the image.

Impression

Paint on colours from a reference clip. When you click on the canvas, the colour at the center of the brush
is used to fill the entire brush stroke.

After using the Impression brushOriginal image
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Image courtesy of Buzz Image Group, Inc., and Les Films Stu-
pefiants

Image courtesy of Buzz Image Group, Inc., and Les Films
Stupefiants

To use the Impression brush:

1 From the Paint Modes box, select Impression.

2 Set the brush size.

3 Paint on the image.

Smear

The Smear brush smudges areas of the image, creating a fingerpainting effect.

After using the Smear brushOriginal image

To use the Smear brush:

1 From the Paint Modes box, select Smear (T).

2 Set the brush size according to the size of the area you want to smear.

3 Paint on the image.

Clone

Use the Clone tool to paint a copy of the result image to any position on the result image. The Clone tool
can also be applied to an output matte image. For example, if the result image has a tree that you would like
to copy to another position on the image, you can offset a copy of it to a different position and then paint
it onto the result.

To paint a source onto the canvas, use the Reveal tool. See Revealing Sources (page 749).

To clone an image and include cloned data in the brush strokes, use the Recursive Clone tool. See Recursive
Clone (page 749).

NOTE If changes are made upstream of the Paint Node, cloned strokes are preserved. However, the strokes will
reflect the “old” input unless you force an update by clicking the Update button or by pressing U. Updates are
not performed automatically because they can affect system performance.
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To clone an image:

1 Select Clone from the Paint Modes box.

The Clone Offset parameters appear.

2 Set brush attributes. See Brush Attributes and Attribute Modes (page 737).

3 To limit the cloned regions to the areas delimited by the matte, select an option in the Matte Source
box.

4 To transform the reference image, do one of the following:
■ To manually offset the image, enable the Overlay button (Tab), then hold down Ctrl+Shift and

drag the overlaid reference image.

■ To scale the image, enter a value in the Scale field.

■ To rotate the image, enter the angle of rotation in the Rotate field.

NOTE To select an area for cloning, Overlay must be turned off. If you offset an image, verify that the Overlay
button is disabled after use.

5 To select the area you want to clone, press Ctrl and click the canvas.

The cursor turns red when you press Ctrl. When you click the canvas, the red cursor is anchored and
a green cursor appears.

6 Position the green cursor over the destination area and click the canvas.

The green and red cursors are now locked into positions relative to each other and move in tandem.

7 To set precise coordinates for the clone offset, use the X and Y fields.

8 Click and drag on the canvas to clone to the destination area.
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Recursive Clone

Use the Recursive Clone brush to paint the contents of the result image to another position on the result.
Unlike the Clone tool, when brush strokes created while using the Recursive Clone tool are used as a reference
when the tool is applied elsewhere, the updated image data will be used.

After using the Recursive Clone mediumOriginal image
Image courtesy of Buzz Image Group, Inc., and Les Films
Stupefiants

Image courtesy of Buzz Image Group, Inc., and Les Films Stu-
pefiants

To use the Recursive Clone brush:

1 From the Paint Modes box, select Recur Clone (Y).

2 Set the brush size according to the size of the area you want to clone.

3 To select the area you want t clone, press Ctrl and click the canvas.

The cursor turns red when you press Ctrl. When you click the canvas, the red cursor is anchored and
a green cursor appears.

4 Position the green cursor over the destination area and click the canvas.

The green and red cursors are now locked into positions relative to each other and move in tandem.

5 To set precise coordinates for the offset, use the X and Y fields.

6 Paint on the image.

The image contained within the red circle brush is copied to the region defined by the green circle.

Revealing Sources

The Reveal tool allows you to paint the contents of one or more source front images directly onto the result.
You can also use the Reveal tool to copy source matte images onto the output matte. For example, if one
source has a tree that you would like to include on the canvas, you can select the source with the tree and
then paint it onto the result.

To paint with a copy of the result or output matte image, use the Clone tool. See Clone (page 747).

NOTE If changes are made upstream of the Paint Node, revealed strokes are preserved. However, the strokes will
reflect the “old” input unless you force an update by clicking the Update button or by pressing U. Updates are
not performed automatically because they affect system performance.
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To reveal a front or matte input:

1 Select Reveal from the Paint Modes box.

The Reveal Offset parameters appear.

2 Set the brush attributes. See Brush Attributes and Attribute Modes (page 737).

3 In the Sources list, select the source you want to reveal.

NOTE You can reveal sources that are marked as hidden in the Sources list. You will only be able to view
the strokes created with a source when you disable Hide Strokes.

4 To limit the revealed sources to the areas delimited by their mattes, select an option in the Matte Source
box.

5 To display the source as an overlay of the result image, enable Overlay (Tab). You can apply
transformations to the source before you apply strokes:
■ To interactively offset a source image, press Ctrl+Shift and drag the source. See Previewing a

Reveal Operation Using a Reference Image (page 754).

■ To scale the source, enter a value in the Scale field.

■ To rotate the source, enter the angle of rotation in the Rotate field.

6 Click and drag on the canvas to apply strokes that reveal the transformed contents of the selected
source.

Using Blending Modes

Blending modes are Boolean operations that can be applied to the brush's colour components. A mode is
applied separately to each of the red, green, and blue components of images. You can apply blending modes
to combine the RGB channels of corresponding pixels from a stroke, described as follows.

Lighten Increases the RGB channel values of each pixel of the brush stroke.

Darken Reduces the RGB channel values of each pixel of the brush stroke.

Exclusion Adds the RGB channel values of the brush stroke, then subtracts twice the product of these
channels.
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Hard Light Multiplies or screens the selected colour of the brush stroke onto the image, depending on the
colour. The effect is similar to shining a harsh spotlight on the image, and greatly reduces the contrast levels
in the image.

If the blend colour (light source) is lighter than 50% grey, the image is lightened as if it were screened—this
is useful for adding highlights to an image. If the blend colour is darker than 50% grey, the image is darkened,
as if it were multiplied—this is useful for adding shadows.

Multiply Multiplies the RGB channel values of corresponding pixels of the stroke and the current image
and normalizes the result by dividing by 255 in 8-bit mode, or 4095 in 12-bit mode. The resulting RGB
channel values are assigned to the corresponding pixels in the generated clip.

Divide Divides the RGB channel values of pixels of the stroke and the current image and normalizes the
result by multiplying by 255 in 8-bit mode, or 4095 in 12-bit mode. The resulting RGB channel values are
assigned to the corresponding pixels in the generated clip.

Overlay Multiplies or screens the colours, depending on the RGB channel values of the colour of the stroke
and the current image. Patterns or colours overlay the existing RGB channel values while preserving the
highlights and shadows of the stroke's colour. The colour of the stroke is not replaced, but is mixed with
the colour of the current image to reflect the lightness or darkness of the original colour.

Screen Multiplies the inverse of the current image with the colour of the brush stroke. The resulting colour
is always lighter. The colour remains unchanged when you screen with black. Screening with white produces
white. The effect is similar to projecting multiple photographic slides on top of each other.

Soft Light Shines a soft, diffuse light on the image. If the blend colour (light source) is lighter than 50%
grey, the image is lightened. If the blend colour is darker than 50% grey, the image is darkened.

Using this mode with a black brush stroke results in a very dark effect; with white, a very bright one.

Add Adds the luma values of corresponding pixels of the brush stroke and the current image. The resulting
value is assigned to the corresponding pixels in the generated clip. If the result is greater than 255 (in 8-bit
mode), the pixel in the destination clip is clamped at a value of 255 (white). In 12-bit mode, the maximum
colour value is 4095. The resulting clip is always brighter.

Subtract Subtracts the RGB channel values of the pixels of the current image from the RGB channel values
of the pixels of the brush stroke and assigns the result to the RGB channel values of the pixel.

If an RGB channel value of the current image is larger than the corresponding channel value of the brush
stroke, yielding a negative result, that result is clamped at 0 (black). The resulting clip is always darker.

To blend a stroke with the current image:

1 Select a Blend mode from the Blend option box.
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2 Select a brush and colour.

3 Draw a stroke.

The stroke with the selected blend is applied. The current blend mode only affects new strokes. However,
if you draw over existing strokes, the blend is created using the pixel values for the two different strokes.

Using the Canvas

Use the canvas controls to control clearing and wiping of the image.

Clearing the Canvas

You can clear all strokes from the result image and output matte at the current frame or all frames. To limit
the operation to a source, see Clearing Strokes on a Source (page 734).

WARNING Any strokes that have been applied will not be maintained when you clear strokes.

To clear strokes from the canvas:

1 Select one of the following from the Clear Canvas option box:
■ Clear to remove strokes from the current frame.

■ Clear All to remove strokes from all frames.
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(a) Clear Canvas option box

The strokes are removed from the result image.

Wiping the Canvas

You can wipe the result image when you want to apply a uniform colour at the current frame in a single
brush stroke. Alternatively, you can use a source, to wipe over an image.

To wipe the result image with a colour or a source:

1 From the View box, select Result (F4).

2 Do one of the following:
■ Pick the wipe colour by clicking the colour pot to the right of the Wipe button.

■ Select the source in the Sources list and enable Use Source.

3 To display the source as an overlay of the result image, enable Overlay (Tab). You can apply
transformations to the source before you apply the wipe:
■ To interactively offset a source image, press Ctrl+Shift and drag the source. See Previewing a

Reveal Operation Using a Reference Image (page 754).

■ To scale the source, enter a value in the Scale field.

■ To rotate the source, enter the angle of rotation in the Rotate field.

4 Do one of the following:
■ Click Wipe to wipe the front and matte.

■ Click the Wipe dropdown list and select Wipe F to wipe the front only.

■ Click Wipe dropdown list and select Wipe M to wipe the matte only.
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Rotating the Canvas

During the painting process, you can rotate the canvas, making it easier to paint on any part of your image.

To rotate the canvas:

1 Do one of the following:
■ Set the angle of rotation in the Rotation field.

■ Press Alt+spacebar and drag in your image.

(a) Rotation field

Previewing a Reveal Operation Using a Reference Image

Overlaying a reference image on the result offers an intuitive way of previewing paint operations.

When you overlay a source onto the result, you can preview the effects of a Reveal operation. The selected
image is superimposed over the result, and the transparency can be adjusted. This allows you to see exactly
what your brush strokes will reveal.

When you overlay a result reference clip onto the result, you can slip the overlaid frame to display previous
or next frames, creating an onion skin effect.

The overlay of the front and the matte can also be shown on the result, allowing you to rotoscope more
easily, for example.

To display the reference image:

1 Enable the Overlay button (Tab).
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(a) Overlay button (b) Reference button (c) Transparency field

The reference image appears by default at 50% transparency.

2 Select the reference image you want to display from the Reference box.

3 If you selected Source Matte or Source Front, select an image from the Sources list.

4 With the reference image, you can:
■ Hold down Ctrl+Shift and drag the source front or source matte to offset it to preview a Reveal

operation.

■ Scale the image, by entering a value in the Scale field.

■ Rotate the image, by entering the angle of rotation in the Rotate field.

■ Set the Slip value in the Sources list to show a reference image at a different frame relative to the
actual frame position. See Slipping a Reference Image (page 755).

■ Set the transparency for the reference image in the Transparency field.

NOTE You can also drag the result image to offset it for a Clone operation by holding down Ctrl+Shift.

Slipping a Reference Image

A reference image that is offset in time can be overlaid on the canvas. You can slip a front, matte, result,
output matte, source front, and source matte clips. In the Sources list, use the Slip field to indicate the offset
amount.

Each slip value can be set independently. To set the same front and matte values for a source, hold down
the Alt key and edit either value.

(a) Front and Source Front Slip fields (b) Matte and Source Matte Slip fields
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Saving Setups and Preferences

Paint Node setups are saved as XML files with the .bpaint extension. The procedures for saving and loading
Paint Node setups are the same as for other setups.

Paint Tool
Use the Paint tools to create graphics, paint on images, and retouch clips. Use a matte to protect areas of
the front clip during painting. Record, animate, and apply a series of brush strokes to a clip. Use the Graphic
and Cut/Paste tools to create rotoscoped sequences and shape animations.

Loading Clips into Paint

When accessing the Paint Tool, you first select the clips that you want to use. Any of the following
combinations of clips can be used in Paint:
■ A front clip only

■ A front clip and a back clip

■ A front clip and a matte clip

■ A front clip, a back clip, and a matte clip

■ None (a blank canvas)

The front clip appears on the Paint canvas, which you can use to apply colours and effects to the clip. The
matte clip delimits the area of the front clip affected by painting. The back clip can be revealed or brushed
through onto the front clip. The colour of the blank canvas is defined by the wipe colour.

NOTE The image window in Paint is referred to as the canvas in the following sections.

To load clips into the Paint Tool:

1 Select Tools ➤ Composite ➤ Paint.

The cursor changes to Pick Front.

2 Select the front clip.

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are now in the Paint Tool.

The Paint menu appears.
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4 Access one of the following Paint menus.

To:Click:

Use the brushes or geometric shapes to paint on the canvas, record and apply strokes
to the canvas, fill areas of the image with a reference colour or image, and move the
image on the canvas.

Paint

Create, edit, and animate shapes and apply them to the canvas.Graphics

Create and add effects to cutouts and apply them to the canvas.CutOut

Set preferences, rendering options, grid guides, and colour correction options.Setup

Accessing the Paint menu with a blank canvas

To access the Paint menu with a blank canvas:

1 Select Tools ➤ Composite ➤ Paint.

The cursor changes to Pick Front.

2 From the Input Mode box, select None.

The Resolution Parameters controls appear.

The cursor changes to Render Here.

3 Choose a resolution, width, height, pixel aspect ratio, bit depth, and scan mode to apply to the
background in Paint.

NOTE The default parameters are the project resolution parameters.

4 Set the frames per second and drop-frame values for the clip from the Frame Code Mode box.

5 Click on any free (or a grey) area on the workspace.

You are now in the Paint Tool.

The Paint menu appears.

Locking and Unlocking the Duration of a Clip

You can determine whether or not frames are added to the end of a clip.

To add frames to the end of the clip:

1 Click Setup.
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2 Enable Extend Clip.

3 Click Next Frame.

A frame is added. You can continue to add frames in the same manner with Extend Clip enabled.

TIP To maintain the length of the original clip, disable Extend Clip. No frames are added to the clip when
you click Next Frame.

Using the Mouse

You can use either the mouse or the tablet and pen to paint. Press and hold the right mouse button to apply
paint at 80% pressure, the middle button to paint at 40% pressure, and the left button to paint at 20%
pressure.

Displaying a Reference Image

You can display a reference image in the background of the result image to use as a guide for rotoscoping.

To display the reference image:

1 Enable the Show button.

(a) Show button (b) Reference box (c) Transparency field (d) Slip field

The reference image appears by default at 50% transparency.

2 Select the reference image you want to display from the Reference box.

3 Set the transparency for the reference image in the Transparency field.

4 Set the Slip field value to show different images from the reference clip.
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This option only works if the reference image you selected is from a clip with more than one frame.

NOTE The Slip field is disabled if you select Matte or Saved from the Reference box.

Using Grids and Guides

Use the Grid/Guides button to set up reference points when painting and to accurately place strokes on the
image.

Use the field guides to provide reference points when painting, and the grid to help you accurately place
strokes on the image. Neither the field guides nor the grids appear on the processed clip.

The Grid and Guides menu contains the Safe area guide controls, the Grid controls, and the Centre controls.

The Safe area guide controls and Centre controls are subsets of their corresponding controls in the Grid and
Guides menu in the other tools.

Grid Controls

You can set the behaviour of the grid so that paint strokes snap or lock to points on the grid. Use the Grid
controls to configure the appearance and behaviour of the grid.

(a) Grid Behaviour box (b) Style buttons

To toggle the grid on and off, click Pixel Grid. When Pixel Grid is on, use the following controls to configure
the appearance and behaviour of the grid.
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Grid Behaviour box Displays the behaviour of the grid with respect to paint strokes:

■ Snap to Point snaps each point of a stroke to the nearest intersection of a horizontal and a vertical grid
line.

■ Snap to Line snaps the current point of a paint stroke to the nearest point on a horizontal or vertical
grid line.

■ Lock to Point locks each point of a paint stroke to the nearest intersection of a horizontal and a vertical
grid line.

■ View uses the grid without the snap to or lock to options.

Style buttons Set a style for the lines of the grid. The style is either a solid line, a dashed line, or a dotted
line.

Spacing field Sets the number of pixels between the dashes in a dashed line style, or between the dots in a
dotted line style.

C, R fields Set the number of columns and rows respectively in the grid.

Resetting the Grid and Guides

Use the Reset All button in the lower-right corner to reset the grid and all guides to their default values.

Using the Player in the Paint Tool

You can access the Player from the Paint Tool. To do so, click Process in the Paint Tool and then click Play
once the clip is processed. Each time you access the Player, a clip is created in the Viewing Panel. This clip
cannot be removed from the Paint tool. You must delete it from the Viewing Panel instead.

Selecting Colours

In Paint, you select colours using the colour picker. You store colours in the colour palette, mix or try out
colours on the scratch pad, and create colour or greyscale gradients using the colour gradient.

Using the Current Colour

The current colour is used when you paint. It is also used to set the colour for the wipe function and the
matte colour. Select the current colour from the colour palette, scratch pad, or colour gradient. Or, click the
Current Colour pot to use the colour picker.

Using the Colour Palette

The colour palette appears in the Paint, Graphics, and CutOut menus. It contains the scratch pad and colour
gradient. A series of colours are stored in the colour palette in colour pots. To select the current colour in
the colour palette, click a colour pot. To set the current colour, press and hold a colour pot.
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(a) Colour pot (b) Colour gradient bar

Build your own colour palette by storing the current colour in the colour pots. You can also save and load
colour palettes.

To store a colour in the colour palette:

1 To display the colour palette, swipe the bar at the bottom of the screen.

The colour palette appears.

TIP If you do not see the palette, click the Palette button. To hide it, swipe the bar a second time.

2 Set the current colour.

3 Click a colour pot in the colour palette and hold the cursor down momentarily.

The colour is saved in the colour pots.

Using the Scratch Pad

Use the scratch pad to mix colours selected from the image or colour pots and to test the selected brush
type. You can also paste cutouts into the scratch pad to use when mixing colours.

(a) Scratch pad

To mix colours on the scratch pad:

1 Click the Pot button.

The scratch pad appears.

2 Paint on the scratch pad.

3 Change the current colour and paint over the previous brush strokes.
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The colours are mixed.

You can also use the Wash, Shade, Smear, Drag, Warp, Impressionist, Recursive Clone, Stamp, and Blur
Special Effects media in the scratch pad.

To use one of the media types in the scratch pad:

1 Select the Special Effects medium you want to use.

2 Enable Medium.

3 Use the brush cursor to apply the medium in the scratch pad.

To set the current colour using the scratch pad:

1 Click the Current Colour pot.

2 Use the colour picker to select the mixed colour in the scratch pad.

3 Click the Current Colour pot to use the selected colour.

Using the Colour Gradient Bar

The colour gradient bar is used to set the gradients for graphics you create in the Graphics menu. You can
also set the current colour by selecting a colour on the gradient using the colour picker.

To set the gradient:

1 Set the current colour.

2 Click either the upper or lower colour pot on the gradient bar.

NOTE You must hold the cursor down for a moment to set the Gradient colour pot.

To set the current colour using the colour gradient bar:

1 Click and drag the cursor across the gradient bar.

The selected colour appears in the Current Colour pot.

2 Select a colour.

The selected colour becomes the current colour.

Previewing an Animation

Use the Flipbook command to preview an animation by playing a sequence of either five or nine frames.

To set up the Flipbook command:

1 Click Setup.

The Setup menu appears.

2 In the Flipbook area, select an animation mode from the Flipbook box.
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(a) Flipbook box (b) Frame Rate field

To:Select:

Play two (or four) frames before the current frame and two (or four) after the
current frame. This is the default setting.

Flip About Current

Play five (or nine) frames beginning at the current frame.Flip From Current

Play five (or nine) frames ending at the current frame.Flip To Current

3 Enter the frame rate in the Frame Rate field.

NOTE If the system is running at high resolution, it may not be able to achieve a flip rate of 30 frames per
second.

4 Press F to play five frames, or press Shift+F to play nine frames.

If you selected Flip About Current, pressing F plays two frames before and after the current frame.
Pressing Shift+F plays four frames before and after the current frame.

Painting on Full-Resolution Film Images

Use the Zoom Mode box to paint on a film resolution image at full resolution from a zoomed out perspective.
With this feature, you can perform complex operations like full-frame rotoscoping without having to
constantly zoom in and out from the image on which you are painting.

In the Paint menu, the Zoom Mode box shows the zoom mode in which you are working. This mode is set
automatically. If you zoom out from the image, the Zoom mode automatically switches from Raster to Tiled.
This allows you to paint on the image from a zoomed out perspective.

(a) Zoom Mode box

NOTE If you manually switch the zoom mode to Raster while zoomed out from the image, you will not be able
to paint on it.

You can also manually select either Raster or Tiled mode if you want to override the default mode. In Raster
mode, if you apply paint to the edge of the image while zoomed in, the paint is applied in an abruptly sharp
straight edge along the border of the canvas; the brush stroke is not completed on the image. In Tiled mode,
if you attempt the same operation, the paint is applied from the full diameter of the brush you are using to
the area of the image that is not visible on the canvas.
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Saving and Restoring the Image

You can save the current frame on the canvas. If you want to reverse a paint application, you can restore
the image without having to recreate it.

Save (Image Buffer) Saves the image that currently appears on the canvas. A single frame is stored in the
Save buffer. The next time you click Save, the current frame replaces the frame stored in the Save buffer.

Restore Replaces the current image on the canvas with the contents of the Save buffer.

Preview Displays the contents of the Save buffer. Select the Saved option in the Reference box and click
and hold Preview to view the contents of the Save buffer.

(a) Reference box

Exiting Paint

When exiting Paint, you may keep or discard the changes you have made to the front clip. Click Exit and
select an option.

To:Select:

Keep the changes you made to the front clip. The modified front clip appears on the Edit-
Desk.

Exit

Keep only the current frame of the front clip. When this option is selected, a Confirm button
appears to the right of the canvas. Click Confirm to keep only the current frame of the
front clip. The current frame appears on the EditDesk.

Keep One

Quit Paint without saving changes to the front clip. When this option is selected, a Confirm
button appears to the right of the canvas. Click Confirm to quit without saving your changes,
or click elsewhere to cancel.

Cancel

About Canvas Mode

When you first open Paint, you are in Canvas mode. In Canvas mode, you can use brushes to modify your
images. Brushes apply colour, filters, and Special Effects media to the image on the canvas. The brush cursor
appears as a green cross surrounded by a circle when placed over the canvas. Canvas mode features are not
available from multiple menus, such Canvas, Geometry, Fill, and Roll.

You can also paint on the canvas using geometric shapes to define the path of the brush.

To ease the painting of canvas edges, you can roll the canvas in the image window.

To paint on the canvas:

1 In the Paint menu, click Canvas.
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If the scratch pad is covering this button, swipe down to hide the scratch pad.

2 From the Paint Mode controls, click Paint.

3 Set a colour in the Current Colour pot. See Selecting Colours (page 760).

4 Select a brush from the Brushes window. See Selecting a Brush (page 765).

5 Set the brush attributes and modes in the Brush Attributes fields. See Brush Attributes (page 770) and
Brush Attribute Modes (page 774).

6 Set the brush opacity in the Opacity field. Set the opacity to 100% to apply a fully opaque colour.

7 Stroke the brush over the canvas. To paint straight horizontal and vertical lines, press Shift and drag
the brush up and down or left and right.

8 Click Undo to erase the strokes applied to the canvas since the last time you zoomed, panned, or
changed a brush attribute.

Selecting a Brush

A number of predefined brush types are available in Paint including round, square, and elliptical brushes of
various sizes and edge softness. The cursor has the same appearance regardless of which brush type you use.
Each brush has its own icon in the Brushes window. The white portions of the brush icon indicate where
the paint will be applied on the image.

See Creating a Custom Brush (page 844).

To select a brush:

1 Scroll through the Brushes window.

To scroll the selections, click the Brushes window and drag left or right.

2 Click the brush icon you want to use.

The selected brush is highlighted by a blue outline.

NOTE Only one brush can be active at a time.

Using the Large Canvas

In Large Canvas mode, almost the entire image window is available for painting, but not all Paint options
are available. You can still change the brush characteristics, medium, and show options. You can also save,
restore, and wipe the canvas.

To display the large canvas:

1 Click Paint.

2 Click Canvas.

3 Swipe your cursor anywhere on the right edge of the screen, or press Esc to toggle between the large
canvas and Paint menu.
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Rolling the Image

Use the Roll menu to reposition the current frame on the canvas to paint its edges.

To roll the image:

1 Click Paint.

2 Click Roll.

The Roll menu appears.

(a) Coordinate fields

3 Zoom in on the image if necessary.

4 Drag the image using the pan cursor.

You can also enter the roll values in the Coordinate fields.

5 To recentre the frame, click Reset.

NOTE The frame is automatically recentred when you go to another frame or exit Paint.

Painting with Geometry

Use the Geometry feature to draw lines, rectangles, circles, and triangles on the canvas.

Painting with geometry is different from drawing objects in Graphics mode. In Graphics mode, you create
objects that can be edited. When you paint with geometry, you define paths for the brush to follow. Paint
uses the current brush setup to apply the stroke to the canvas.

Painting Lines

Use the Line option to paint straight lines. Paint single lines one at a time, or draw connected multiple lines.
You can constrain the lines to vertical or horizontal paths or specific angles.

To paint a line or multiple lines:

1 Click Geometry to display the Geometry menu.

2 Select Line from the Geometry box.

The Multiple Line button and the Line Type box appear.
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(a) Geometry box (b) Multiple button (c) Line Type box

3 Select the type of line you want to draw from the Line Type box.

To:Select:

Paint a line at a specific angle. This option displays a field in which you enter the
angle in degrees.

Angle

Paint vertical lines.Vertical

Paint horizontal lines.Horizontal

Paint lines at any angle with no constraint.FreeForm

4 If you selected Angle, enter a degree in the field.

5 To draw single lines, move to the canvas and click, drag, and release.

A brush stroke is painted along the line.

6 To draw multiple lines, enable Multiple, move to the canvas, and click to place the start point of the
first line. Click again to draw the end point. Continue clicking to place additional points and draw
more lines.

7 To end multiple lines, click below the timebar or on the menu panel to turn the option off.

The brush strokes are painted along the lines.

Painting Rectangles

Use the Rectangle option to draw rectangles or squares.

To paint a rectangle or square:

1 Click Geometry to display the Geometry menu.

2 Select Rectangle from the Geometry box.

The Equal Sides button appears.
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(a) Geometry box (b) Equal Sides button

3 To draw a square, enable Equal Sides or press and hold P.

4 Press the cursor on the canvas to anchor the first corner of the rectangle. Drag the cursor to size the
rectangle.

5 When the rectangle is the required size, release the cursor.

A brush stroke is painted along the sides of the rectangle.

Painting Circles

Use the Circle option to draw circles of any size.

To paint a circle:

1 Click Geometry to display the Geometry menu.

2 Select Circle from the Geometry box.

3 Press the cursor on the canvas to anchor the centre point of the circle. Drag the cursor to size the circle.

4 When the circle is the required size, release the cursor.

A circular brush stroke is painted.

Painting Triangles

Use the Triangle option to draw equilateral or asymmetric triangles.

To paint a triangle:

1 Click Geometry to display the Geometry menu.

2 Select Triangle from the Geometry box.

The Equal Sides button appears.
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(a) Geometry box (b) Equal Sides button

3 To draw an equilateral triangle, enable Equal Sides or press and hold P.

4 Move to the canvas and click to anchor the first vertex of the triangle.

5 Click to place the second vertex and then again to place the third vertex. If you are drawing an
equilateral triangle, drag the cursor until the triangle is the required size.

A brush stroke is painted along the sides of the triangle.

About Brush Attributes and Modes

You can set various brush attributes and attribute modes that determine how paint is applied to the image.
Each brush attribute has a corresponding Attribute Mode control. You use the Preferences menu to affect
the way paint is applied to the image.

(a) Brush Attribute fields (b) Attribute Mode controls

In the Paint menu, the Brush Attributes and Attribute Mode controls share the same space as the colour
palette. To display the brush attributes and modes in the Paint menu, swipe the cursor at the bottom of the
screen.

In the Graphics Edit menu, the Brush Attributes and Mode controls appear only when the object attribute
is set to Outline or Fuzzy. To display the brush attributes and modes in the Graphics menu, swipe the cursor
twice at the bottom of the screen.

NOTE The brush attribute and attribute mode values set in the Paint menu are independent from the values set
in the Graphics menu.
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Brush Attributes

The Brush Attribute fields set the size of the brush, the distribution of the paint, and the rate and direction
of the paint application. Brush attributes are listed as follows:

■ Jitter■ Size

■ ■Rate Direction

■■ RollPressure

■ Opacity

Brush Opacity

The brush opacity affects the transparency of the brush. A value of 100% applies a fully opaque colour. Use
a lower value to apply a more transparent colour. Enter a value in the Opacity field.

(a) Current Colour field

NOTE You can only use the Front, Back, Result, and Saved attribute modes with the Opacity attribute.

Brush Size

The brush size is indicated by the diameter of the green dashed circle surrounding the cursor brush. To
increase the brush size, set a value in the Size field and drag the brush to the right on the canvas. To decrease
it, set a value in the Size field and drag to the left.

You can also use the Size buttons to increase or decrease the brush size. Click the + button to increase the
brush size. Click the - button to decrease the brush size. You can also click and drag in the Size field or click
and enter a value.

NOTE You can use any attribute mode with the Size attribute.

Brush Rate

The brush rate is the rate at which brush strokes are applied to the canvas. Use a high value to produce a
smooth continuous stroke, or a low value to produce a less continuous stroke with larger gaps between brush
images.
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NOTE You can use any attribute mode with the Rate attribute.

Rate attribute value = 25Rate attribute value = 100

Brush Pressure

The brush pressure affects the transparency of the paint applied to the image. To apply opaque paint, use a
high percentage value. For more transparent paint, use a low value.

The Pressure attribute differs from the Opacity attribute in that you can set the Pressure attribute mode so
that the paint transparency varies according to the pressure applied to the pen or the direction of the brush.

NOTE You can use any attribute mode with the Pressure attribute.

Pressure attribute value at 50%
Pressure attribute value at 100%

Brush Jitter

The Jitter attribute randomizes the brush strokes applied to the image. A high value produces a greater
dispersion of paint, while a low value produces a greater concentration.
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NOTE You can use any attribute mode with the Jitter attribute.

Jitter attribute value at 100Jitter attribute value at 10

Brush Direction

The Direction attribute causes the brush to rotate around the Z-axis and can be used to produce a calligraphy
effect. The effect of the Direction attribute is most noticeable when used with one of the elliptical or star
brushes. The value of the Direction attribute causes the brush strokes to rotate by 90 degrees for each
increment of 25 percent.

NOTE You can use any attribute mode with the Direction attribute.

Direction attribute at 75%Direction attribute at 100%
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Direction attribute at 25%Direction attribute at 50%

Brush Roll

The Roll attribute rolls the brush around the X-axis. The effect of the roll is most noticeable when used with
one of the non-symmetrical brushes. For each increment of 25 percent, the Roll attribute value creates a
rolled brush stroke of 90 degrees.

NOTE You can use any attribute mode with the Roll attribute.

Roll attribute value at 75%
Roll attribute value at 100%

Roll attribute value at 25%Roll attribute value at 50%
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Brush Attribute Modes

The value of a brush attribute depends on the selected attribute mode. You can choose Constant, Off, Front,
Back, Result, Saved, Pressure, or Direction.

(a) Brush Attribute fields (b) Attribute Mode controls

In Constant mode, the brush attribute values remain constant. In Off mode, the attribute is disabled.

The Front, Back, Result, and Saved modes use the colour values in a reference image to vary the brush
attribute value. Pressure and Direction modes affect how paint is applied by causing the brush attribute
value to vary in relation to the pressure exerted on the pen and the direction of the brush, respectively.

NOTE Do not set the Size, Rate, or Pressure attributes to Off mode.

Using Reference Images

The Front, Back, Result, and Saved modes use the red channel in reference images to set the brush attribute
values. Front mode uses the front clip as the reference, Back mode uses the back clip, Result mode uses the
result clip, and Saved mode uses the image in the Save buffer.

Using Size attribute with mode set to Back

Back image
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Direction of the Brush

The Direction mode uses the direction of the brush stroke as the reference.

When used with the Direction mode, the Direction attribute causes the brush strokes to follow the trajectory
of the brush. Increase the percentage value to enhance the effect on brush direction.

To:Drag:

Use 100% of the attribute value.Right

Use 0% of the attribute value.Left

Use 25% of the attribute value.Up

Use 75% of the attribute value.Down

Direction attribute value at 15%, Direction modeDirection attribute value at 100%, Direction mode

Pressure Exerted on the Pen

The Pressure mode uses the pressure exerted on the pen as the reference value. The harder you press on the
pen, the greater the brush attribute value. The softer you press, the lower the brush attribute value.

NOTE The Pressure attribute mode cannot be used in the Graphics menu.

Preferences Affecting Brushes

The Spacing setup preference affects how paint strokes are applied to the canvas.

To enable Brush Spacing:

1 Click Setup in the Paint menu.

2 Enable Spacing.
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This option sets a uniform distance between paint strokes. No matter how fast you move the brush,
the brush spreads the paint evenly.

TIP Use a high brush rate when using stamps with the Spacing option enabled. See Using the Stamp Medium
(page 784).

Applying Filters

When applying filters, it is important to try different brush types and change the brush attributes to create
different effects.

Apply filters to the canvas using the brush, Wipe command, or Wash and Shade media. Paint uses the same
filter library as the Filter command in the Processing menu.

(a) Paint Media button (b) Filter button (c) Filter field

To brush a filter onto the image:

1 In the Paint menu, click the Filter field.

The filter library appears.

2 Select the filter you want to use.
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You are returned to the Paint menu and the filter name appears in the Filter field.

3 Click Filter to enable the selected filter.

4 Set the brush opacity. The opacity determines the level of filtering. Reduce the opacity value to reduce
the level of filtering.

5 Paint on the image.

After using the emboss filterOriginal image

Using Special Effects Media

Special Effects media can be brushed onto the image in Canvas mode. You can also apply the Wash, Shade,
and Reveal media to the entire image using the Wipe command. See Wiping Using Special Effects Media
and Filters (page 788). Only one media type can be used at a time.

Use the media buttons to enable some Special Effects media, for example, the Clone and Reveal media. Other
media types, such as Drag and Smear, are enabled using the Custom Media box.

(a) Special Effects Media buttons (b) Reference box (c) Custom Media box

The following Special Effects media are available.

To:Use:

Apply a blur filter to portions of the image. See Blurring the Image (page 778).Blur
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To:Use:

Copy a portion of the image to a new location. See Cloning the Image (page 779).Clone

Create an image trail from a selected region of the screen. See Dragging the Image (page
780).

Drag

Paint on colours from a reference clip. See Using the Impressionist Medium (page 781).Impressionist

Make a number of copies of a selected area of the image. See Using the Recursive Clone
Medium (page 782).

Recursive Clone

Brush a reference image onto the current image. See Revealing a Reference Image (page
782).

Reveal

Darken or lighten the image depending on the luminance value of the current colour. See
Washing and Shading the Image (page 786).

Shade

Smudge areas of the image. See Smearing the Image (page 783).Smear

Apply a captured image to the image. See Using the Stamp Medium (page 784).Stamp

Stretch and distort a region of the image. See Warping the Image (page 785).Warp

Apply a transparent wash of the current colour to the image. See Washing and Shading the
Image (page 786).

Wash

Blurring the Image

Use the Blur medium to blur portions of the image.

To blur the image:

1 Click Custom and select Blur from the Custom Media box.

The Blur option boxes appear.

(a) Filter Type box (b) Blur Strength box

2 Click Canvas.
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3 Set the brush size according to the size of the area you want to blur.

4 Select either a Box or Gaussian filter from the Filter Type box.

5 Set the density of the Blur brush from the Blur Strength box.

You can choose Light, Medium, or Heavy.

6 Drag the brush on the image.

After using the Blur mediumOriginal image

Cloning the Image

Use the Clone medium to copy a region of the image and paint it on a destination point. The result image
is used as the source for the Clone medium. The offset between the origin point and the destination point
is set in the Offset fields.

To paint using the Clone medium:

1 Click Clone.

The Clone controls appear.

(a) Offset fields

2 Click Canvas.

3 Set the brush opacity. The brush opacity determines the transparency of the clone. When the opacity
value is set to 100%, the clone is completely opaque.

4 Set the brush size.

5 Set the offset between the origin point and the destination point in the Offset fields.
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A tracking circle appears at the offset co-ordinates you specified; this is the destination point for the
cloned image.

TIP Press Ctrl and drag the cursor to set the destination point.

6 Paint on the image.

The image contained within the red circle brush is copied to the region defined by the green circle.

After using the Clone mediumOriginal image

Dragging the Image

Use the Drag medium to drag a selected area of the image across the canvas. The selected area is painted on
the canvas as you drag the brush, creating an image trail.

NOTE The Direction brush attribute cannot be used with the Drag medium.

To use the Drag medium:

1 Click Custom and then select Drag from the Custom Media box.

2 Click Canvas.

3 Set the brush size.

4 Position the brush over the region of the image that you want to use. Hold down the cursor to select
that region.

5 Drag the brush.
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The selected region is painted onto the image as you drag. The pressure of the brush determines the
density of the image trail. See Brush Pressure (page 771).

After using the Drag mediumOriginal image

Using the Impressionist Medium

Use the Impressionist medium to brush on colours from a reference clip. The brush opacity determines how
much colour is taken from the reference clip. When the opacity value is set to 100%, all the colour is taken
from the reference image. At 50%, the colour applied is a 50/50 blend of the reference colour and the result
image.

To use the Impressionist medium:

1 Click Custom and then select Impressionist from the Custom Media box.

2 Click Canvas.

3 Set the brush opacity.

4 Select a reference image from the Reference box.

5 Paint on the image.

After using the Impressionist mediumOriginal image
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Revealing a Reference Image

Use the Reveal medium to reveal portions of an image or an entire reference image. You can reveal specific
areas using the brush or the entire image using the Wipe command. The opacity of the brush determines
how much of the reference image is revealed on the image. When the opacity is set to 100%, the reference
image applied is completely opaque. At 50%, the reference image applied is a 50/50 blend of the reference
image and the result clip.

To reveal a reference image on the canvas:

1 Click Reveal.

2 Click Canvas.

3 Set the brush opacity.

4 Select a reference image from the Reference box.

5 Paint on the image.

The Back image revealed on the Result
image

Result imageBack image

Using the Recursive Clone Medium

Use the Recursive Clone medium to make multiple copies of an area of an image. The result image and the
paint applied to it is used as the source. Each copy is a degraded version of its predecessor. The offset between
the origin point and the destination point is set in the Offset fields.

To paint using the Recursive Clone medium:

1 Click Custom and select Recursive Clone from the Custom Media box.

The Recursive Clone options appear.
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(a) Offset fields

2 Click Canvas.

3 Set the offset between the origin point and the destination point in the Offset fields.

A red tracking circle appears around the destination point.

4 Paint on the image.

The image contained within the green circle brush is copied to the region defined by the red circle.

After using the Recursive Clone mediumOriginal image

Smearing the Image

Use the Smear medium to smudge portions of the image.

To smear the image:

1 Click Custom and select Smear from the Custom Media box.

2 Click Canvas.

Paint Tool | 783



3 Drag the brush over the area you want to smear.

After using the Smear mediumOriginal image

Using the Stamp Medium

Use the Stamp medium to capture a portion of the image and apply it to the canvas.

To capture and apply a stamp:

1 Click Custom and select Stamp from the Custom Media box.

The Stamp window appears beneath the Brush Size field.

(a) Brush Size field (b) Stamp window

2 Click Canvas.

3 Set the brush size. Use a small brush to isolate a specific detail of the image. Use a large brush to capture
a bigger sample.

4 Click and hold the cursor on the Stamp window.

5 Without releasing the cursor, move it over the image.

The Stamp window is updated as you move the cursor across the image.

6 Release the cursor when the Stamp window contains the part of the image you want to capture.

The brush cursor appears.

7 Paint on the image.

784 | Chapter 20   Painting



(a) The captured stamp

(a) Stamp applied using a circular brush (b) Stamp applied using an air brush (c) Stamp applied using a chalk brush

Saving and Loading Stamps

You can save a stamp and load it in another session to use with a different clip. See Saving Setups (page 841).

Warping the Image

Use the Warp medium to stretch and distort regions of the image.

To warp the image:

1 Click Custom and select Warp from the Custom Media box.

2 Click Canvas.

3 Set the brush size.

The area that can be warped is determined by the brush size.
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4 Select a portion of the image and hold down and drag the cursor to warp the selection.

After using the Warp mediumOriginal image

Washing and Shading the Image

Use the Wash medium to apply a transparent wash of the current colour to the image. Use the Shade medium
to darken or lighten the image. You can wash or shade specific areas using the brush or the entire image
using the Wipe command.

With the Shade medium, you darken images using a colour with a low luminance value, and lighten them
using a colour with a high luminance value. The opacity of the brush affects the transparency of the paint
applied to the image. When the opacity value is set to 100%, the paint applied is completely opaque. As
you decrease the opacity, the paint becomes more transparent.

Selecting a Colour Model

You can apply the colour using either the YUV or HLS.

To select a colour model:

1 Click Setup.

2 Select either YUV Shade/Wash or HLS Shade/Wash.
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To use Wash or Shade:

1 Click Custom, and select Wash or Shade from the Custom Media box.

2 Click Canvas.

3 Set the current colour.

4 Set the brush opacity.

5 Paint on the image.

A paint stroke using the Shade medi-
um, current colour red.

A paint stroke using the Wash medium,
current colour red.

A paint stroke using the Paint medium,
current colour red.

Wiping an Image

Use the Wipe command to apply colours, filters, and Special Effects media to the entire result image in a
single stroke.
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(a) Wipe colour pot

NOTE You can also wipe an image with the AutoPaint Wipe mode. See Wiping the Canvas in AutoPaint (page
794).

Wiping Using a Colour

Use the Paint medium to wipe the image with a selected colour. The colour used is set in the Wipe colour
pot.

To wipe the image using a colour:

1 Set the current colour you want to use for the wipe. See Selecting Colours (page 760).

2 Click the Wipe colour pot.

The current colour is transferred to the wipe colour.

3 Set the brush opacity.

A value of 100% wipes the image with a completely opaque colour.

4 Click Wipe.

Wiping Using Special Effects Media and Filters

You can use a filter, or the Reveal, Clone, Wash, and Shade Special Effects media.

To wipe with Special Effects media and filters:

1 Set the wipe colour.

2 From the Paint Mode controls, select the Special Effects medium to be applied. See Using Special Effects
Media (page 777).

NOTE If you are using a filter for the wipe, you must enable the Filter button.
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3 Set the brush opacity.

A value of 100% wipes the image with the full effect of the Special Effects Media or filter.

4 Enable the Wipe Using Paint Mode button.

5 Click Wipe.

Using the Wipe Command in Graphics

You can also use the Wipe command in the Graphics menu. The Wipe command wipes over any objects
tacked down on the image. Objects not tacked down are not part of the image and are not wiped over.

Filling an Image

Use the Fill command to fill areas of an image with similar colour values or areas delimited by a colour.
These areas can be filled with either a solid colour or a reference image. You can choose how far the filled
area extends by specifying how similar the pixels must be in order to be filled. This enables you to fill only
the dark areas of an image, or include slightly lighter areas.

Use the Fill controls to set the colour model, range, and softness of the fill.

To display the Fill controls:

1 Click Fill in the Paint menu. If the Fill button is hidden by the colour palette, swipe the bottom of the
screen.

Defining the Range for the Fill

When you use the Fill command, you specify a range for the colour comparison. The Fill command compares
the colour values of adjacent pixels to determine if the values are within the specified colour range. Adjacent
pixels within the range are filled.

The range is determined using two values: the colour value of the pixel you select to begin the fill, called
the selection point, and the value you set in the Range field.

Selecting Colour Channels

You can use either the RGB or YUV model. Within each colour space, you can work with any combination
of colour channels. For example, if you select the R, G, and B channels in the RGB colour model, the Fill
command considers the red, green, and blue values. Adjacent pixels with red, green, and blue values within
the specified range are filled.

Adjusting the Softness

The softness value for the fill determines the amount of colour diffusion applied at the edges of the fill. This
value can be adjusted to modify the transition between the filled and unfilled areas. A softness value of
100% produces the greatest amount of diffusion. A softness value of 0% produces a filled area with well-defined
edges.
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Filling a Region with a Colour

You can choose to fill an image with the current colour.

To fill a region of the image with a colour:

1 Click Fill.

The Fill controls appear.

(a) Colour Model box

NOTE To fill a matte, click From Matte. When this button is enabled, the pixels in the matte are used for
the colour comparison. If this button does not appear at first, click Matte on the right side of the menu
panel.

2 Select a colour model from the Colour Model box.

To:Select:

Display the R, G, and B channel buttons. Enable each channel you want to use.RGB

Display the Y, U, and V channel buttons. Enable each channel you want to use.YUV

3 Set the colour range in the Range field.

You can also set a tolerance by enabling the Boundary button and selecting a distinct boundary colour
from the image.

4 Set the softness in the Soft field.

5 Set the current colour.

6 Select a point in the area you want to fill. This is the selection point.
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The pixels that fall within the specified range are filled with the current colour.

Fill with range 75 and softness 100Original image

Fill with range 50 and softness 100Fill with range 75 and softness 50

Filling a Region with an Image

You can fill a region of an image with a reference image instead of a colour. The front, back, or result image
can be used as the reference image. The Wash, Shade, Clone, or Reveal media can also be used to perform
the fill.

To fill a region with a reference image:

1 Click Fill.

The Fill controls appear.
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(a) Colour Model box

2 Select the colour model and channels you want to work with.

3 Set the range and softness in the Range and Softness fields.

4 Select the Special Effects medium you want to use (Clone, Reveal, Wash, or Shade). See Using Special
Effects Media (page 777).

5 Set the Reference box to Front, Back, Result, or Saved, and set the brush opacity.

A value of 100% fills the area completely with the reference image.

6 Enable Medium.

7 Select a point in the area you want to fill.

Filling a Boundary

Use the Boundary option to fill an area of the canvas delimited by another colour.

To use boundary fill:

1 Click Fill.

The Fill controls appear.
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2 Select the colour model and channels you want to work with.

3 Set the range for the fill in the Range field.

4 Enable Boundary.

The Pick button is no longer greyed out.

5 Click Pick.

The cursor changes to a colour picker when dragged over the image.

6 Drag the colour picker over the canvas without clicking.

The various colour channel values in areas of the image are displayed as you move the colour picker
around the canvas.

7 Click a point to select the colour for the boundary. You can also select a colour by entering the RGB
values directly in the colour channel fields.

The cursor changes to a paint bucket.

8 Click the area inside the boundary to fill that region.

NOTE To fill a boundary with a reference image, set the Reference box to Front, Back, or Saved, and enable
Medium.

Using AutoPaint

Use the AutoPaint controls to apply paint strokes to each frame in the result clip, a range of frames, or the
current frame.

To display the AutoPaint controls:

1 Click AutoPaint in the Paint menu. If the controls are hidden by the colour palette, swipe the bottom
of the screen.

(a) Autopaint Mode box

The AutoPaint Mode options are described as follows.

User Records and plays back a series of manual paint strokes.

Random Applies a number of random strokes to the image.
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Wipe Wipes the entire canvas with the current colour or medium.

Wiping the Canvas in AutoPaint

Use Wipe mode to automatically apply paint strokes from left to right, top to bottom, or diagonally across
the entire canvas. You can use a filter or any of the Special Effects media except Warp, Drag, and Smear. The
size of the brush determines the number of strokes applied. Use a small brush to apply several strokes or a
large brush to apply fewer strokes.

To wipe the canvas in AutoPaint:

1 Click AutoPaint, and select Wipe from the AutoPaint Mode box.

The Wipe menu appears.

(a) AutoPaint Mode box (b) Wipe Mode box

2 Set the current colour.

3 Select the Special Effects medium or filter, and set the brush attributes. See Using Special Effects Media
(page 777), and Brush Attributes (page 770).

4 Select the Wipe mode in the Wipe Mode box. If this box is not visible, make sure that the attribute
mode for the Direction attribute is set to Direction.

To:Select:

Apply diagonal strokes.Diagonal

Apply strokes from top to bottom.Vertical

Apply strokes from left to right.Horizontal
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(a) Wipe Mode box

5 Enable Animation to display the Channel Editor.

If the Channel Editor is not visible, swipe the bar below the menu.

You can animate all brush attributes as well as the current colour.

6 Enable Wipe if you are using a filter or colour.

7 Click the image to apply the paint strokes only to the current frame. Click Process to apply the paint
strokes to each frame in the front clip.

After using the Wipe command with Jitter attribute at
35% and Colour attribute mode set to Front

Original image

Applying Random Strokes

Use Random mode to automatically generate a number of paint strokes with random orientation on the
image. Use the Samples field to specify the number of random strokes you want to generate. You can use
any Special Effects media in Random mode except Warp and Drag.

To apply random paint strokes to the image:

1 Click AutoPaint and select Random from the AutoPaint Mode box.

The Samples field appears.
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(a) Samples field

2 Enter the number of strokes you want to apply in the Samples field.

3 Set the current colour.

4 Select the Special Effects medium, and set the brush attributes. See Using Special Effects Media (page
777), and Brush Attributes (page 770).

5 Enable Animation to display the Channel Editor. If the Channel Editor is not visible, swipe the bar
below the menu.

You can animate the following parameters:

■ Number of strokes

■ All the brush attributes

■ Colour

6 Click the image to apply the paint strokes to the current frame only. Click Process to apply the paint
strokes to each frame in the front clip.

After using the Random command with Jitter attribute
at 30% and Colour attribute mode set to Front

Original image

Recording Brush Strokes

Use User mode to record and play back a series of paint strokes. Only the positions of the brush strokes are
recorded. This means that you cannot change the brush type, current colour, or brush attributes while
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recording the strokes. You can, however, change or animate these parameters after you finish recording and
before you play back the strokes.

TIP You can also play paint strokes created by converting objects (write-ons).

To record a series of brush strokes:

1 Click AutoPaint and select User from the AutoPaint Mode box.

2 Set the brush characteristics so that you can see the recorded brush strokes on your image.

NOTE The strokes you paint are recorded as a series of points or stamps of the brush. The number of strokes
is determined by dividing the number of points by the number of frames. The quality of the rendered strokes
depends on the number of recorded points. To record a larger number of points, select a small brush size.

3 Enable Record.

4 Begin painting on the image.

The position of each brush stroke is recorded, and the stroke count appears in the message bar.

5 To stop recording, click below the timebar.

All paint strokes applied to the image while recording are removed from the image and the number
of strokes is recorded.

NOTE AutoPaint stores only one set of recorded paint strokes at a time. If you record another set of paint
strokes, you lose your previously recorded strokes.

Tracking with AutoPaint

You can apply tracking data to the painted strokes.

(a) Tracking box

To apply tracking data to recorded strokes:

1 Enable Animation.

2 Select Front, Back, or Result from the Tracking box and click Stabilizer to track a point and apply the
offset information to the recorded strokes.

NOTE You can only track after you record paint strokes.

3 Use the X and Y field to offset the painted strokes.
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Playing Recorded Brush Strokes

After recording brush strokes, you can apply them to the front clip using the Play option, which is activated
automatically when you finish recording the paint strokes.

To play recorded strokes:

1 Enable Play.

The Play options appear.

2 Define the brush characteristics using the Brush Attribute fields.

3 Define the duration of the stroke sequence using the second timebar. Drag the indicator to modify the
duration.

(a) Indicator

The number of strokes is divided by the length of the stroke, defined by the second timebar.

The indicator in the second timebar is identical to a track in the Channel Editor.

4 Enable the Play options.

To:Enable:

Play only a part of the recorded strokes. AutoPaint applies the strokes to a frame, erases
those strokes, and moves to the next frame. This has the effect of creating streaks on your
rendered clip.

Part

Play the paint strokes backward.Backward

Play paint strokes based on distance. AutoPaint divides the length of paint strokes by the
number of frames to determine what to render in each frame.

Distance

Play the paint strokes simultaneously.Stroke

5 Enable Animation.

The Animation menu appears.
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(a) Animation Type box (b) Frequency field

6 Enable Wireframe to preview the path(s) of the painted strokes.

(a) Width field (b) Wireframe colour pots

The wireframe preview shows the complete path(s) of the painted strokes. It also shows what will be
painted in each frame as set using the second timebar.

You can set the width of the wireframe using the Width field. You can also change the colour of the
path and progression wireframes using the colour pots beneath the Width field.

For Path animation, you define how often AutoPaint reads the Channel Editor values when rendering
the points or stamps that make up a given stroke. At a frequency of 100%, AutoPaint reads the Channel
Editor values the most frequently.

For example, assume you set your AutoPaint sequence of 100 stamps to run over 10 frames using Path
animation. If you set the Frequency field to 100%, AutoPaint reads the Channel Editor values 10 times
every frame. If you set the Frequency field to 50%, AutoPaint reads the Channel Editor values 5 times
every frame.

TIP Use the Frequency field to lower the processing time for your AutoPaint sequence. Use a low frequency
to render a quick preview of the result.

7 Swipe the bar at the bottom of the menu to display the Channel Editor.
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You can animate the following parameters:

■ Sampling amount

■ X and Y values

■ Brush size, rate, pressure, jitter, direction, roll, opacity, and colour

■ Tracker translation

NOTE The Channel Editor only appears if Animation is enabled. Also, animation data in the Channel Editor
is not erased when you record new strokes.

8 To apply the paint strokes, click Process.

NOTE If you are zoomed in on the image and are in the Raster zoom mode, only the visible portion of the
image will be processed. This is much faster than using Tiled mode, but will not apply your modifications
to the entire frame. For more information on zoom modes, see Painting on Full-Resolution Film Images (page
763).

About Mattes

Mattes protect specific areas of the image when you apply paint, filters, or Special Effects media to the canvas.
You can also use mattes to limit the area of a cutout.

For instructions on loading mattes into Paint, see Loading Clips into Paint (page 756), and Loading Setups
(page 842).

To use the matte:

1 Click Use to enable the matte.

2 Paint on the image.

3 Click Use again to disable the matte.

Using Mattes with Cutouts

If you enable your matte when creating a cutout, the cutout is limited by the matte. Only objects outside
the matte will show up in the cutout. See Creating a Cutout (page 832).

Viewing Mattes

You can view the matte as you use it.
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To view the matte:

1 Load the matte into Paint.

2 Enable Show.

3 Select Matte in the Reference box.

The matte appears.

Changing the Matte Colour

If the colour used to display the matte blends with the image, you can change its colour.

NOTE The matte is always created using shades of grey.

To change the matte display colour:

1 Set the current colour.

2 Click the Matte colour pot.

The matte colour display changes to the current colour.

Changing the Matte Display Transparency

When viewing the matte, use the Transparency field to vary the matte display transparency from 0%
(completely transparent) to 100% (fully opaque). Press Alt+T or click Transparency in the Setup menu to
toggle between the last set value and 100%.

(a) Transparency field
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NOTE The transparency value only affects the display of the matte. It does not affect how the matte is used.

(a) Invert Lock button (b) Transparency button

Inverting the Matte Clip

Click Invert to invert the matte in the current frame. Enable Invert Lock in the Setup menu to invert the
matte in every frame of the clip.

Creating or Modifying Mattes

You can create or modify a matte by painting directly on the matte using any brush, Special Effects media,
or graphic tool. For information on using graphic and cutout tools to create mattes, see Using the Cutout
Commands (page 833).

To create or modify a matte:

1 Load the matte into Paint.

NOTE You must load a matte clip in order to process a matte in Paint. If you want to create a matte from
scratch, load a black source as the matte clip.

2 Click Matte.

The Matte menu appears.
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(a) Matte button (b) Matte Opacity field

3 Set the paint transparency in the Matte Opacity field.

The value in the Matte Opacity field determines the transparency of the paint applied to the matte.
Use a value of 100 to apply fully opaque paint or objects to the matte. Reduce the Matte Opacity value
to increase the transparency of the paint.

4 Paint or place graphics or cutouts on the matte.

The paint and graphics are applied to the matte. If you use graphic tools, use Tack to tack the graphic
to the matte. See Tacking Down Selected Objects (page 831).

5 You can save the matte in the matte library. See Saving Setups (page 841).

6 To process the matte clip, click Exit.

The new matte clip is saved to the rendered destination reel.

Painting on the Matte and Image

When applying paint strokes or graphics to the image, enable Both to paint the image and the matte
simultaneously.

Resetting the Matte

If you do not load a matte, Paint displays the last matte that was loaded.

To erase the matte:

1 Click Matte.

2 Set the Matte Opacity to 0%.

3 Click Wipe.

The matte is erased.

Creating a Gradient Matte

You can use graphics that contain gradients to create a matte that blends from one level of the matte colour
to another level. A gradient matte is useful for blending paint strokes or creating soft edges.

To create a gradient matte, draw a graphic with a gradient on the matte, and then use the Channel Editor
to change the “a” channel of the start or end colour of the gradient. See Creating Graphics (page 805), and
Changing the Object Gradient (page 819).
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Creating High-Contrast Mattes

Use the Auto command to create a high-contrast matte. The minimum and maximum luminance values
for the matte are set using the two colour pots in the AutoMatte menu. Any pixel with a luminance value
below the minimum is set to black, and any pixel with a luminance value above the maximum is set to
white.

Unwanted grey areas can be removed from the matte by increasing the percentage in the Auto Gain field
in the Setup menu.

(a) Auto Gain field

Pixel values between the minimum and maximum values are multiplied by the Gain value. The resulting
values are clipped at the specified maximum luminance value. The Gain is expressed as a percentage value.
The default value of 100% has no effect on the image since the luminance values are multiplied by 1.

To use the AutoMatte command:

1 In the Paint menu, click Matte.

The AutoMatte menu appears.

(a) Minimum luminance (b) Maximum luminance

2 Set the minimum luminance value for the matte in the colour pot on the left. To set the value, click
the field and use the colour picker to select the lightest colour from the image.

3 Set the maximum luminance value for the matte in the colour pot on the right.
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4 Set the Auto Gain for the matte. The Auto Gain field is in the Setup menu.

5 Click Auto to generate the matte.

6 Click Use to enable the generated matte.

Using Graphics in Paint

Accessing the Graphics Menu

To access the Graphics menu, click the Graphics button in the Paint menu. Some options may be hidden if
the colour palette is open. Swipe the cursor across the bars at the bottom of the screen to hide the colour
palette.

Creating Graphics

Graphics can be used to create cutouts or mattes, or to apply geometrical shapes, text, and fills to the result
clip.

To create a graphics object:

1 In the Paint menu, click Graphics.

2 Click Add.

3 Select the type of object to add by selecting an icon in the Object Tools window.

4 Draw the object on the image. See Using the Object Tools (page 806).

5 Set the resolution to be used when adding or editing objects. See Setting the Object Resolution and
Display (page 815). Objects appear at full resolution when they are drawn.

6 Set the object's attributes and gradient. See Setting the Object Attribute (page 817), and Changing the
Object Gradient (page 819).

7 Set the object's colour in the Current Colour pot. See Selecting Colours (page 760).

8 Resize and move the object. See Changing the Size or Position of an Object (page 821).

9 Use the Transformation box or controls to move, rotate, or scale the object. See Changing the Shape
of an Object (page 822).

10 Use the Animation controls to animate the object. See Animating Graphics (page 826).
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11 Click the Tack button to permanently place the object on the result clip.

Once the object has been tacked down, it cannot be moved, rotated, deleted, resized, or copied. See
Tacking Down Objects (page 830).

Auto Edit After Add

After you add an object to the image, Paint automatically switches from Add mode to Edit mode. You can
turn off this default setting by disabling the Auto Edit After Add button in the Setup menu. You can then
add objects one after another without interruption.

(a) Auto Edit After Add button

Using the Object Tools

A number of predefined graphic tools are available in Paint. The cursor looks the same for all graphic types.
When you move the cursor onto an image, it appears as a small green cross with crosshairs that extend the
width and height of the canvas. The crosshairs help align objects on the image.

Each tool has its own icon in the Object Tools window.

To select an object tool:

1 Scroll through the Object Tools window.

Click the Object Tools window and drag left or right. Use the left mouse button to scroll slowly, the
middle button to scroll faster, and the right button to scroll the fastest.

2 Click the object tool icon you want to use.

The selected object tool is highlighted by a blue outline.

NOTE Only one object tool can be active at a time.
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Drawing a Line

Use the Line object tool to draw a single straight line or a multi-line object (a series of lines joined end-to-end).

To draw a line or a series of lines:

1 In the Graphics menu, click Add.

2 Select the Line tool in the Object Tools window.

The Create Multiple Lines button appears.

3 Click Create Multiple Lines.

4 To draw multiple lines, move to the canvas and click to place the start point of the first line. Click
again to draw the end point. Continue clicking to draw more lines.

5 To end a multiple line object, click Create Multiple Lines.

6 To draw single lines, move to the canvas and click, drag, and release.

Paint draws the line as you drag.

Drawing a Rectangle

Use the Rectangle object tool to draw a rectangle or square in one of two ways:
■ Corner-to-corner, with the two vertices located at diagonally opposite corners of the rectangle

■ Centre-to-corner, with the first vertex at the centre of the rectangle and the second at one corner

To draw a rectangle from corner-to-corner:

1 In the Graphics menu, click Add.

2 Select the Rectangle tool in the Object Tools window.

3 Press the cursor to anchor one corner of the rectangle. Do not release the cursor.

4 Drag the cursor diagonally. You can adjust the width and height of the rectangle as long as you hold
down the cursor.

5 Release the cursor to anchor the second vertex.

The rectangle is drawn on the image.

To draw a rectangle from centre-to-corner:

1 In the Graphics menu, click Add.

2 Select the Rectangle tool in the Object Tools window.

3 Press Alt.

4 Position the cursor where you want to place the centre of the rectangle and press down.

5 Drag diagonally, and release the cursor when the rectangle is the correct size.

Drawing a Square

Press E while you draw and repeat the procedure for drawing a rectangle from corner-to-corner.
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Drawing a Triangle

Use the Triangle object tool to draw a triangle or equilateral triangle. The vertices are located at the three
corners of the triangle.

To draw a triangle:

1 In the Graphics menu, click Add.

2 Select the Triangle tool in the Object Tools window.

3 Position the cursor and press to anchor the first vertex on the image. Do not release the cursor.

4 Drag the cursor horizontally to draw the base of the triangle. You can continue to adjust the length
of the base as long as you press down on the cursor.

5 Release the cursor to anchor the second vertex.

6 Move the cursor to where you want to place the third vertex. You can continue to adjust the position
of the third vertex until you press down on the cursor. Press to anchor the third vertex.

The triangle is drawn on the image.

Drawing an Equilateral Triangle

An equilateral triangle has three sides of equal length. To draw an equilateral triangle, repeat the procedure
for drawing a triangle and press E while drawing the base of the triangle. This also establishes the height of
the triangle. Release the cursor to anchor the second and third vertices on the image.

Drawing an Ellipse

Use the Ellipse object tool to draw an ellipse defined by three vertices. The first vertex determines the centre
of the ellipse. The second vertex determines the horizontal radius of the ellipse. The third vertex determines
the vertical radius.

To draw an ellipse:

1 In the Graphics menu, click Add.

2 Select the Ellipse tool in the Object Tools window.

3 Position the cursor at the centre of the ellipse and press to anchor the point on the image. Do not
release the cursor.

4 Drag the cursor horizontally to establish the width of the ellipse. You can continue to adjust the width
as long as you press down on the cursor.

5 Release the cursor to anchor the second vertex.

6 Move the cursor along the vertical axis to position the third vertex. You can continue to adjust the
height of the ellipse until you press down on the cursor. Press to anchor the third vertex.

The ellipse is drawn on the image.

To draw a circle with the Ellipse tool:

1 In the Graphics menu, click Add and select the Ellipse tool.

2 Press E.

3 Position the cursor at the centre of the circle and press to anchor the point on the image. Do not release
the cursor.
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4 Drag the cursor horizontally to establish the radius of the circle. Notice that there are two vertices at
the edge of the circle, as there are for an ellipse.

5 Release the cursor and the E key to anchor the second and third vertices.

The circle is drawn on the image.

Drawing a Circle

Use the Circle object tool to draw a circle in one of two ways:
■ Centre-to-edge, with one vertex at the centre of the circle and a second on the circumference

■ Edge-to-edge, with two vertices at opposite points on the circumference

To draw a circle from edge-to-edge:

1 In the Graphics menu, click Add.

2 Select the Circle tool in the Object Tools window.

3 Position the cursor at the centre of the circle and press to anchor that point on the image. Do not
release the cursor.

4 Drag the cursor to establish the radius of the circle. You can continue to adjust the size of the circle as
long as you press down on the cursor.

5 Release the cursor to anchor the second vertex.

The circle is drawn on the image.

To draw a circle from centre-to-edge:

1 In the Graphics menu, click Add and then select the Circle tool.

2 Press and hold Alt.

3 Drag the cursor to establish the radius of the circle.

When the circle is the required size, release the cursor.

Drawing a Polygon

Use the Polygon object tool to create a series of connected lines that form a closed or open object. You can
specify how the vertices of the polygon should be connected by selecting one of the options from the Polygon
Mode box.

To draw a polygon:

1 In the Graphics menu, click Add.

2 Select the Polygon tool in the Object Tools window.

The Polygon menu appears.
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(a) Polygon Mode box (b) Sides field

3 Select an option from the Polygon Mode box to set the type of curve used to join the vertices of the
polygon.

To:Select:

Use straight lines to join the vertices of the polygon.Linear

Use a smooth curve that passes through the vertices of the poly-
gon.

Cardinal

Use a very smooth curve that passes on the inner side of the ver-
tices of the polygon.

Bspline

Use Bezier curves. Each vertex of the polygon has a tangent with
two tangent handles. In Edit mode, you can move the tangent

Bezier

handles to adjust the slope of the polygon. See Editing a Bezier
Curve (page 823).

The minimum number of vertices for a polygon depends on the type of interpolation used. A polygon
should have at least three vertices when using Linear interpolation, or four when using Cardinal or
Bspline interpolation. The maximum number of vertices is 255. A polygon can be concave.

4 To create an open-ended polygon, click Opened Shape.

5 Position the cursor at one vertex of the polygon, and click to anchor that point on the image.

6 Release the cursor and move it to where you want the next vertex of the polygon. You can continue
to adjust the positioning of the next vertex until you press down on the cursor. Press to anchor the
point on the image.

7 Repeat steps 4 and 5 for each vertex.
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8 To close the polygon, press anywhere outside the canvas.

The polygon is drawn on the image.

Rubber Banding

Rubber banding is the default setting for drawing polygons and lines. This means that a vertex is added to
the polygon only when you press and release the cursor.

To draw a polygon with multiple vertices, disable the Rubber Banding button in the Setup menu. When you
drag the cursor while drawing a polygon or line, vertices are drawn on the image.

(a) Rubber Banding button

Drawing Regular Polygons

Draw regular polygons using the Sides field and the E key. A polygon can have three or more sides. This
enables you to draw a triangle or a square based on the centre point of the object.

To draw a regular polygon:

1 In the Graphics menu, click Add.

2 Select the Polygon tool in the Object Tools window.

3 Enter the number of sides for the polygon in the Sides field.

4 Press E.

5 Position the cursor over the image and press down.

This is the centre of the polygon.

6 Drag the cursor away from the centre point. The polygon is drawn on the image. You can continue to
adjust the size of the polygon as long as you press down on the cursor.

7 When the polygon is the correct size, release the cursor.

The polygon is drawn on the image.

Drawing a Fill Object

Use the Fill object tool to fill areas of an image with colour. While this is similar to using the Fill command
in the Paint menu, you can only use this tool with colour, Shade, and Wash, and not to fill areas with a
reference image. However, you can edit fill objects after you draw them.

NOTE A fill object cannot have a gradient.

To draw a fill object:

1 In the Graphics menu, click Add.

Paint Tool | 811



2 Select the Fill object in the Object Tools window.

The Fill object controls appear.

3 Select a colour model from the Colour Model box (RGB or YUV).

4 Select the colour channels you want to use (R, G, and B, or Y, U, and V).

The choice of colour channels determines how Paint evaluates the area you want to fill. For example,
if you select R, G, and B, Paint fills areas whose adjacent pixels have red, green, and blue values in the
specified range. If you select only R, Paint fills only areas whose adjacent pixels have red values in the
specified range.

5 Enter the Range and Softness values for the fill.

The range determines how far the fill spreads from the point you click on the image; if you increase
the range, you increase the fill area. The softness determines how much diffusion occurs at the edges
of the fill; if you increase the softness, you increase the diffusion at the edges of the fill.

6 Move the cursor to the canvas and click inside the area to fill.

Paint fills the area with the current colour starting at the point you click.

NOTE The colour of the image and the channel, range, and softness settings determine the extent of the
fill. As you move the fill object, it changes size and shape in response to the different colours in the image.

Drawing a Text Object

Use the Text object tool to add text to the image. You can change the size, kerning, and inclination of the
text string.

To add a text object:

1 In the Graphics menu, click Add.

2 Select the Text tool in the Object Tools window.

The Text object controls appear.

(a) Text field (b) Font field

3 Click the Font field and select a new font from the font library.

4 Click the Text field, type the text string, and click Enter.

5 Click the image to place the text object.
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You can adjust the size, kerning, and italics of the text in Edit mode.

To:Use:

Adjust the size (in pixels) of the text.Size

Incline the text. Enter a positive value to slant the text to the right, and a negative value
to slant it to the left.

Italic

Adjust the space (in pixels) between all letters in the text.Kern

Selecting Objects

You must select an object before you can edit it. In Edit mode, you can select objects in three ways:
■ Click an object to select it.

■ Use the Selected field to select individual objects.

■ Use the All command to select all objects at once.

Using the Selected Field

As you add objects to the image, they are numbered sequentially, starting at 1. You can select an object by
specifying the number of the object in the Selected field.

As you change the number in the Selected field, the corresponding object is highlighted by a selection box.

To select a single object using the Selected field:

1 Set the number in the Selected field to the number of the object you want to edit.

You can also click the < and > buttons beside the Selected field to move through the sequence.

2 When the selection box outlines the object, release the cursor. You can now edit it.

Selecting More than One Object

To select an additional object, hold down Shift and click another object. Repeat this step for each object
you want to select.
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Deselecting Objects

To deselect an object or objects, select a different object or click the Add button.

Selecting All Objects

To select all the objects, click the All button. All is shown in the Selected field. Click it again to deselect
them.

Editing Objects

Use the object controls to copy, delete, hide, or layer objects.

Copying Objects

Use the Copy command to create multiple copies of an object. Once a copy is created, it can be selected and
edited like any other object.

To copy an object:

1 In the Graphics menu, click Copy.

2 Click the object you want to copy. Do not release the cursor.

A copy of the object is superimposed on the original image. You cannot see the copy until you drag it
to a new location.

3 Drag the copy to a new location.

4 When the copy is positioned correctly on the image, release the cursor.

Deleting Objects

Use the Delete command to remove one or more objects from the image.

To delete one or more objects:

1 Select the objects you want to delete. Click an individual object or use the Selected box to select an
object. To select multiple objects, click an object, press Shift, and click any other objects you want
to delete.

2 Click Delete.

All selected objects are removed from the image.

To delete all objects from the image:

1 Enable All.

2 Click Delete.
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All objects are deleted from the image.

Hiding Objects

Use the Hide/Unhide commands to hide or unhide objects before they are tacked onto the image.

To hide or unhide one or more objects:

1 Select the objects you want to hide. Click an individual object or use the Selected box to select an
object. To select multiple objects, click an object, press Shift, and click any other objects you want
to hide.

2 In the Graphics menu, click Edit and then click Hiding.

The Hide options appear.

To:Select:

Hide all selected objects.Hide Selected

Hide all objects that are not selected.Hide Unselected

Show all hidden objects.Unhide All

Changing the Order of Overlapping Objects

Objects can be drawn so they overlap other objects to produce a stack of objects.

To send an object to the bottom of the stack:

1 Select the object.

2 In the Graphics menu, click Push and then click the object until it is at the bottom of the stack.

NOTE To bring the object back to the front, click the object until it moves to the front.

Setting the Object Resolution and Display

Use the Object Resolution box to set the resolution while drawing or editing objects. The objects are
regenerated at high resolution once you release the cursor at the end of each editing operation. Use the
options in the Setup menu to affect the display of the graphics before they are tacked down onto the image.

To set the object resolution:

1 Select an option from the Object Resolution box.
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To:Select:

Display the object at full resolution when updating. This is helpful for displaying gradients,
but slows down the rate at which image display is refreshed.

Full Res

Display the object at low resolution when updating.Low Res

Display the object as a wireframe when updating.Wireframe

Wireframe Display Options

The Thick Line and Solid Line buttons in the Setup menu determine the thickness and continuity of the
wireframe.

(a) Control Points button (b) Thick Line and Solid Line buttons (c) Graphic Regen button

Enabling and disabling the Thick Line and Solid Line buttons affects the wireframe as follows:
■ When Thick Line is enabled, the wireframe has a thickness of 2 pixels.

■ When Thick Line is disabled, the wireframe has a thickness of 1 pixel.

■ When Solid Line is enabled, the wireframe is unbroken.

■ When Solid Line is disabled, the wireframe is dashed.
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Increasing Editing Speed

To speed up editing, disable the Graphic Regen button in the Setup menu. Instead of waiting for the graphics
objects to be regenerated at the end of an editing operation, the objects appear at the display resolution.
This can be a useful time-saving feature.

Hiding the Object Vertices

Each object is defined by two or more vertices. These vertices, or tangent handles, appear while you are
drawing or editing the object.

Disable the Control Points button in the Setup menu to turn off the display of the vertices while you are
drawing or editing the object. This feature is useful if you want to trace the outline of a figure.

Displaying Anamorphic Geometry

Select Use Aspect Ratio in the Rendering area of the Setup menu to draw and display anamorphic geometry.
For normal display, click Use Aspect Ratio and switch to Use Square Pixels.

(a) Anti-alias field (b) Use Aspect Ratio option

Anti-Aliasing for Objects

The jagged edges that can occur along diagonal and curved lines in geometry are caused by aliasing, or
insufficient spatial sampling of the image. The process of minimizing jagged edges by increasing the sampling
rate is called anti-aliasing.

Use the Anti-alias field in the Rendering Setup menu to specify an anti-aliasing factor for geometry. When
the value is set to 1, no anti-aliasing occurs. Best results are obtained with a value of 4.

Setting the Object Attribute

Use the Object Attribute box to set the display mode for the object you add to the image.

To change the object attribute:

1 In the Graphics menu, click Edit.
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2 Select the object you want to edit.

3 Click Attributes.

4 Select an option from the Object Attribute box.

To:Select:

Draw a filled object with a well-defined edge. Use the Brush Opacity field to set the object's
transparency. No other brush attributes or types are available. Line objects cannot be set
to Solid.

Solid

Draw an outline of the object. Use the Brush Attribute buttons to set the appearance of
the outline. See Changing the Object's Appearance (page 818).

Outline

Draw a solid object with a soft edge. Use the Brush Attribute fields to set the appearance
of the outline.

Fuzzy

Draw a wireframe object. Use the Brush Opacity field to set the object's transparency. No
other brush attributes or types are available.

Wire

Changing the Object's Appearance

You can change the appearance of an object by changing any of the following display attributes:
■ Current colour

■ Brush attribute values or modes

■ Special Effects media or filters

■ Colour gradient

Changing display attributes affects all currently selected objects. See Selecting Objects (page 813).

Setting Brush Attributes and Modes

In the Graphics menu, you can only change brush attributes and modes when using the Outline or Fuzzy
attribute. See Brush Attributes (page 770).
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If the Brush Attribute controls are not visible, swipe the bar at the bottom of the menu. Use the Current
Colour pot to set the graphic's colour, and the Opacity field to set the opacity of the object, or the effect a
graphic has on the image.

Using Filters and Special Effects Media with Graphics

Any filter can be used with objects. Only the Paint, Clone, Reveal, Wash, and Shade Special Effects media
can be used. See Using Special Effects Media (page 777).

Changing the Object Gradient

All objects, except the fill object, can have a gradient. You can edit a gradient or apply a gradient to an object
that does not have one. A selected object with a gradient displays a gradient control bar that you can use to
edit the orientation of the gradient.

To edit a colour gradient:

1 In the Graphics menu, click Edit.

2 Select the object you want to edit.

3 Click Attributes.

4 Select an option from the Gradient box.

(a) Gradient box (b) Noise Level field

To:Select:

Use a rectangular gradient in which colour changes from top to bottom.Rectangular Gradient

Use a circular gradient in which colour changes from centre to edge.Circular Gradient

Turn off the gradient and use a solid colour.Gradient Off

5 Set the colours for the gradient. See Using the Colour Gradient Bar (page 762).

6 To eliminate banding, enable Anti Band.

Banding normally appears only if you are working at 8-bit colour depth and if the gradient that you
apply is stretched.
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TIP You can also set a noise level to the anti-band function. Noise may help when colour bands are very
large. Set the value in the Noise Level field to 7 to apply the maximum noise, or lower it to apply less
dither/noise. If you set the value to 0, no noise is applied.

7 Use the gradient control bar to change the object's gradient.

Using the Gradient Control Bar

When you select an object with a gradient, Paint displays a gradient control bar in addition to the object
transformation box. The gradient control bar has two handles at each end that show the colours of the
gradient. In a rectangular gradient, the bar also indicates the direction of the gradient.

(a) Gradient control bar (b) Centre point of gradient

(a) Start point of the gradient (b) Gradient control bar (c) End point of the gradient

NOTE If you want to move the transformation box, press M and click the location where you want to move the
box.

To use the gradient control bar:

1 Select an object with a gradient, or add a gradient to an object.

Paint displays the transformation box and the gradient bar.

2 Move the handles of the gradient control bar to change the orientation and location of the gradient.

In a rectangular gradient, this affects the gradient orientation. For example, the default orientation for
a rectangular gradient is top to bottom. If you drag one of the handles left or right, you change the
orientation to diagonal. If you drag the handles so the gradient bar is horizontal, you get a rectangular
gradient with the colours blended from side to side.
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If you select the centre colour handle in a circular gradient, you can move the gradient's centre inside
the object or even outside it.

3 To decrease the amount of one colour visible in an object, move the handle to the edge or outside the
object.

Changing the Size or Position of an Object

Use the transformation box, or the transformation controls in the Axis Transformation menu, to change
the size or position of an object. You can use the transformation box and controls to modify the object in
the following ways:
■ Move the object in any direction on the image.

■ Rotate the object about its centre point.

■ Change the size of the object.

You can translate, resize, or rotate more than one object at the same time by selecting all the objects you
want to edit.

Using the Transformation Box

To display the transformation box, click the Edit button in the Graphics menu and click the object you want
to edit.

(a) Reset handle (b) Centre point (c) Resize handle (d) Rotation handle (e) Translation handle

The position of the transformation box is saved for each object. To move the transformation box, press M
and click the destination.

Resize handle To change the size of an object, drag the resize handle in any direction. To maintain an
object's proportions, press PE as you drag the resize handle.

Centre point To change the point around which the object rotates, move the centre point.

Rotation handle To rotate the object about its centre point, drag the rotation handle.

Translation handle To move the object in any direction on the image, drag the translation handle. The
transformation box moves with the object.

Reset handle To restore the object to its initial size and position on the image, click the reset handle.
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Using the Transformation Controls

Use the transformation controls to translate, rotate, and resize a selected object. To display the transformation
controls, select an object and click the Transform button.

X (Position) Move the object along the horizontal axis (X-axis).

Y (Position) Move the object along the vertical axis (Y-axis).

X (Scale) Change the size of the object along the horizontal axis.

Y (Scale) Change the size of the object along the vertical axis.

Rotation Set the object's angle of rotation along the Z-axis. The object is always rotated around its centre
point.

Reset Use the Reset button to reset the object to its initial size and position.

Start and End Numeric Fields Use these fields to set when the object appears in the clip.

Changing the Shape of an Object

To change the shape of an object, such as a polygon or a line, you must add, delete, or move a vertex on
the object.

To change the shape of an object:

1 In the Graphics menu, click Edit.

2 Select the object you want to edit.

The object vertices and the transformation box appear on the selected object.

3 Press the vertex you want to edit and drag it to a new location. When you are satisfied with the new
position, release the cursor.

Adding and Deleting Vertices on a Polygon or Line

Change the shape of a polygon or line by changing its number of vertices.

To add a vertex to a polygon or line:

1 In the Graphics menu, click Edit.
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2 Select the polygon or line you want to edit.

The vertices for that object are selected.

3 Press A.

4 Press on one of the existing vertices and drag outward. A vertex is added counterclockwise to the
selected point.

To add a point clockwise to the selected point, press Ctrl+A.

5 Repeat steps 3 and 4 for each vertex you want to add to the object.

To delete a vertex from a polygon or line:

1 In the Graphics menu, click Edit.

2 Select the polygon or line you want to edit.

The vertices for that object are selected.

3 Press D.

4 Click the vertex you want to delete.

The selected vertex is deleted from the object.

5 Repeat steps 3 and 4 for each vertex you want to delete on the object.

The Auto Point Command

When you add or delete a vertex on a polygon or line, the same point is added or deleted on all shapes for
that object. You can disable this option in the Setup menu. When the Auto Point button is disabled, any
point you add or delete on a shape is added/deleted in the current shape key only.

(a) Auto Point button

Editing a Bezier Curve

When you use the Bezier option to draw a polygon, each vertex of the polygon has two tangents. Each
tangent ends with a handle.
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(a) Tangent (b) Vertex (c) Handle

Use Edit mode to move a tangent handle and adjust the slope of the adjacent side of the polygon. When
you move one tangent handle, the tangent's reciprocal handle moves in the opposite direction because
handles A and B are joined to keep the joint at the intersection of the two edges smooth.

(a) Edge A (b) Tangent A (c) Handle B (d) Edge B

(a) Edge A (b) Handle B (c) Edge B

To adjust the slope on one side of the vertex only, press B and click the vertex. This breaks the tangent so
that you can move its handles independently. To reset the tangent, press B and click the vertex again.
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(a) Edge A (b) Handle A (c) Handle B (d) Edge B

Converting Graphics to AutoPaint Strokes

Use the Convert command to convert objects to AutoPaint strokes.

(a) Convert button

You can play the paint strokes using the AutoPaint controls in the Paint menu. See Using AutoPaint (page
793).

The following shows how a hexagon is drawn over six frames. One edge is drawn in each frame. After the
object is converted to AutoPaint strokes, it is always drawn as an outline regardless of its attributes in the
Graphics menu.

To determine how much of an object to draw in each frame, the number of edges in the object is divided
by the number of frames in the clip. The polygons are drawn one after the other in the order in which they
were drawn in the Graphics menu.

To convert an object to AutoPaint strokes:

1 Select the object.

2 Click Convert and Confirm.
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Animating Graphics

Use the Channel Editor and Shape Animation controls to animate Paint graphics. You can animate the
position, display, and shape of a graphic. To display the Channel Editor, click the Animation button and
swipe the cursor across the bottom of the screen.

Animation Parameters

The following parameters can be animated for every object:
■ Position, rotation, and size

■ Brush attributes

■ Gradient orientation, transparency, and colour

■ Colour (red, green, and blue channels)

■ Wireframe width

■ Range and Softness of a fill object

■ Transparency

■ Size, Kerning and Italics for a text object

NOTE In Paint, the commands in the Edit Mode box can be performed on animation curves only. To modify a
keyframe by editing the object in the image window, you must use the editing commands in the Graphics menu.

Shape Animation

To animate the shape of an object, you must create keyframes with the Shape Animation controls. Each
shape you define becomes a keyframe in the Shape channel of the Channel Editor. The difference between
the keyframes is interpolated and the shape animation is created.

The Shape channel is used to identify the number and location of shape keyframes in a clip. Use the shape
curve to control the rate at which an object changes to a new shape. The following figure shows the Shape
channel for an object that changes from shape 1 in frame 1, to shape 2 in frame 8, and shape 1 in frame 15.

To animate the shape of an object:

1 Create an object.
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This original shape becomes shape keyframe 1 in the Channel Editor.

2 Advance to another frame in the clip.

3 Select the object, and change its shape.

To change its shape, you must move, add, or delete a vertex on the object. This new shape is shape
keyframe 2 in the Channel Editor.

Shape Interpolation

Use the Shape Interpolation box in the Setup menu to specify the interpolation between shapes in the
animation.

(a) Shape Interpolation box

To:Select:

Produce sudden transitions between shapes.Shape Linear Interp

Produce smooth transitions between shapes.Shape Cardinal Interp

NOTE The type of shape interpolation you use is independent of the type of polygon interpolation you use.

Moving between Shape Keyframes

Use Previous and Next to move between shape keyframes in an animation.

To move between keyframes:

1 Select the object you want to modify.

2 Click Edit and then Shapes.

The Shapes menu appears.

3 Click Next to advance to the next shape keyframe.

4 Click Previous to go to the previous shape keyframe.
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Deleting Keyframes

Use Delete to delete a shape keyframe from the animation.

To delete a shape keyframe:

1 Select the object.

2 Click Shapes.

The Shapes menu appears.

3 Select the keyframe you want to delete.

4 Click Delete.

The selected shape is deleted.

Adding Keyframes

Use Add to create a shape keyframe. This can be useful for creating animations that start and end with the
same shape.

To add a shape key using Add:

1 Select the object you want to animate.

2 Go to the frame where you want to add the shape keyframe.

3 Click Shapes.

The Shapes menu appears.

4 Click Add.

A new keyframe is added to the Shape channel in the Channel Editor.

Gradient Animation

Use the Channel Editor to animate the colours, orientation, and direction of a colour gradient. The Gradient
folder includes Start and End folders for the two colours in the gradient. The Start and End folders each
contain channels for the X and Y position of the colour, as well as the R, G, B, and alpha values.

Although you can animate the gradient independently, by default, the gradient will follow any transformations
of the object.

To animate a gradient:

1 Select the object with the gradient you want to animate.

2 Click Animation. If necessary, swipe the cursor across the bottom of the screen to display the Channel
Editor.

3 Click the Geometry and Stroke folders to expand them.

If you selected more than one object, a Stroke folder appears for each selected object. Click the Stroke
folder for the object you want to animate.

4 Click the Gradient folder to expand it, and click the Start and End folders:
■ The Start folder contains the X and Y channels and a Colour folder for the gradient's colour.

■ The End folder contains the X and Y channels and a Colour folder for the gradient's colour.
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5 Click to expand each Colour folder.

To:Use:

Move colour origin left or right. This is the same as moving the gradient bar handle.x

Move colour origin up or down. This is the same as moving the gradient bar handle.y

Change percentage of red in the colour.r

Change percentage of green in the colour.g

Change percentage of blue in the colour.b

Change percentage of the colour's alpha channel. Use this channel to create a gradient matte
or to change the opacity of the colour.

a

6 Change the values for the channels in different frames to create a gradient animation.

Processing the Animation

To process the animation, click Process in the Graphics menu. Make sure you are at the first frame of the
animation since the clip will be processed from the currently displayed frame until the end of the clip.

Saving and Restoring Objects

Use the Store and Recall commands to save and restore objects to the image. Use the Library menu to save
or load graphics from the graphics library.

To save or load a graphic:

1 In the Paint menu, click Load or Save.

2 Select Geometry from the Load or Save option box.

(a) Save option box

3 Select a file or type in a name for the graphic.

NOTE If you are using Save and have typed in a name for the file, you must press Enter to finish saving
the file.
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The Store and Recall Commands

To save the selected graphic in the buffer, click Store in the Graphics menu. The current object replaces the
graphic saved in the buffer.

The Store command does not save the result image. This means that if you tacked the objects onto the image,
they are not saved using the Store command. To restore the geometry to the image, click Recall.

(a) Store button (b) Recall button

TIP Use Store and Recall to add graphics to clips loaded at a later time.

Tacking Down Objects

An object can be selected, deleted, edited, and transformed until it is tacked down on the image. As soon as
it is tacked down, the object becomes part of the image and can no longer be manipulated.

There are several ways to tack down an object:
■ Select a Tack mode so that an object is either tacked down as soon as it is drawn or as soon as the next

object is drawn.

■ Tack down selected objects only.

■ Tack down all objects simultaneously using the Tack All command.

Tack Modes

The Tack mode is selected with the Tack Mode box in the Rendering Setup menu.

To set the Tack mode:

1 In the Paint tool, click Setup.

The Setup menu appears.
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(a) Tack Mode box

2 In the Rendering area, select an option from the Tack Mode box.

To:Select:

Explicitly tack down the objects using the Tack command.Vector

Edit the last object drawn until the next object is added to the image. As soon as the
next object is added, the last object is tacked down.

Edit Last

Tack down an object as soon as it is added to the image.Raster

Tacking Down Selected Objects

When the Tack mode is set to Vector, objects must be explicitly tacked down on the image using the Tack
button.

(a) Tack button

To tack down one or more objects:

1 Select the objects you want to tack down.

2 Click Tack.

All selected objects are tacked down on the image.
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To tack down all objects on the image:

1 In the Graphics menu, Enable All.

2 Click Tack.

All objects are tacked down on the image.

Cutting and Pasting in Paint

Accessing the CutOut Menu

To access the CutOut menu, click the CutOut button in the Paint menu. Some options may be hidden if
the colour palette is open. Swipe the cursor across the bar at the bottom of the screen to hide the colour
palette.

Creating a Cutout

Creating a cutout is similar to creating a graphic. In the CutOut menu, you use the same controls as you
would in the Graphics menu to select, copy, hide, move, rotate, resize, delete, store, recall, push, and tack
cutouts.

To create a cutout:

1 Click CutOut.

2 Click Add.

The CutOut Shadow options appear.

(a) Shadow Type box (b) Blending Mode box

3 To limit the area of the cutout with a matte, enable Use in the Matte controls.

4 Select an option from the Shadow Type box.
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The Shadow Type box determines how the cutout will be pasted onto the result clip. See Pasting Cutouts
(page 836).

5 Click Attributes.

6 To create a cutout that spans the entire clip, enable Sequence.

7 Click one of the four Cutout commands. See Using the Cutout Commands (page 833).

NOTE To use the GeoCut option, select all the objects you want to use in the cutout in the Graphics menu
before clicking the GeoCut button.

8 Draw the cutout on the image.

9 Set the resolution to be used when updating the object.

The object appears at full resolution when it is drawn. See Setting the Object Resolution and Display
(page 815).

10 Set the cutout's position using the transformation box or controls.

11 Set the cutout's colour using the Current Colour pot.

12 Click Tack to permanently place the object on the result clip.

Once the object is tacked down, it cannot be moved, rotated, deleted, resized, or copied.

Keep Cut On

Once you add a cutout to the image, the default setting automatically switches from Cut mode to Edit mode.
To prevent the switch to Edit mode, enable Keep Cut On in the Setup menu.

(a) Keep Cut On button

Using the Cutout Commands

Four commands are used to create cutouts: FrameCut, RectCut, PolyCut, and GeoCut. FrameCut, RectCut,
and PolyCut create cutouts using shapes you define in the CutOut menu. Geocut creates cutouts using
objects you select in the Graphics menu.
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The FrameCut Command

Use the FrameCut command to make a cutout of the entire frame.

To create a cutout of an entire frame:

1 Click Add in the CutOut menu.

2 Click FrameCut.

The entire frame is cut out and pasted onto the image.

The RectCut Command

Use the RectCut command to cut and paste a single rectangular area of the image.

To use the RectCut command:

1 Click Add in the CutOut menu.

2 Click RectCut.

3 Draw a rectangle over the area of the image that you want to cut out.

The image area defined by the rectangle is copied and pasted onto the image.

The PolyCut Command

Use the PolyCut command to cut and paste a single polygonal area of the image.

To use the PolyCut command:

1 Click Add in the CutOut menu.

2 Click PolyCut.

3 Draw a polygon over the area of the image that you want to cut out.

The image area defined by the polygon is copied and pasted onto the image.
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The GeoCut Command

Use the GeoCut command to create a cutout with objects you selected in the Graphics menu.

To create a cutout using GeoCut:

1 Click Graphics in the Paint menu.

2 Create any number of objects.

3 Select all the objects you want to use to make the cutout.

4 Set the opacity of the object(s) using the Brush Opacity field.

The opacity of the object(s) used in the cutout determines the transparency of the cutout. Use objects
with a low opacity value to create an opaque cutout. Use objects with a high opacity value to create a
transparent cutout.

5 Click CutOut in the Paint menu.

6 Click GeoCut.

The image area defined by the selected objects is copied and pasted onto the image.

Displaying Graphics and Cutouts

To display both the cutouts and the graphics objects in the CutOut menu, enable Show Both in the Setup
menu. Although the graphics objects appear, they cannot be edited. Enabling Show Both also displays both
the graphics objects and the cutouts in the Graphics menu. Although the cutouts appear, they cannot be
edited.

(a) Show Both button

Increasing Editing Speed

To streamline cut and paste functionality, use Graphic Regen and Texture Cut/Paste in the Setup menu, and
Texture in the CutOut menu.

The Graphic Regen Button

Disable Graphic Regen (regeneration) in the Setup menu to ensure the cutout always appears at the display
resolution.
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(a) Texture Cut/Paste button (b) Graphic Regen button

Texture Cut/Paste and Texture Button

Enable Texture Cut/Paste in the Setup menu or Texture in the CutOut menu to speed up cut and paste
operations. These preferences are designed for platforms that support fast texture mapping.

(a) Texture button in CutOut menu

The Filtering button can be used when Texture is enabled. Use Filtering to avoid image degradation as a
result of recursive cutting and pasting. When Filtering is enabled, the image should not degrade.

Pasting Cutouts

Four options in the Shadow Type box are available for pasting a cutout onto the image.

To:Select:

Create an embossed cutout. See The Emboss Option (page 837).Emboss

Create cutout extrusions. See The Extrude Option (page 838).Extrude

Use the blend functions available for pasting cutouts. See The Blend Options (page 838).None
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To:Select:

Add a drop shadow to the cutout. See The Drop Shadow Option (page 839).Shadow

The Emboss Option

The Emboss option makes the cutout appear etched into the image. Shadows and highlights are added to
simulate the effect of light shining on a raised object. Three layers are used to produce this effect:
■ The top layer is a copy of the cutout in which the luminance values are increased by 50%. The top layer

adds the highlights to the cutout.

■ The middle layer is the cutout.

■ The bottom layer is a copy of the cutout in which the luminance values are decreased by 50%. The
bottom layer adds the shadow to the cutout.

Offset Field

Use the Offset field to specify the offset value in pixels for the three layers. The best results are obtained with
values of 1 or 2.

(a) Paste Mode box (b) Offset field (c) Direction field

Direction Field

Use the Direction field to specify the angle of the simulated incident light. The values range from 0 to 7 and
specify the following angles of incident light.
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The Extrude Option

The Extrude option makes the cutout appear to pop out of the image by redrawing the cutout one layer on
top of another. Each layer in the stack is offset slightly from the one below so only the edges of the layer
are visible.

Editing the Layers

When you create a cutout using the Extrude option, two layers are created to produce the effect. There are
vertices at the centre of each layer for manipulating the layer. You can change the depth and direction of
the extrusion by moving either layer.

Changing the Colour of the Layers

Enable Use Colour to apply the current colour to the extrusion layers. The cutout image is used for the top
layer only. When Use Colour is enabled, use the Brush Opacity field to set the transparency of the extrusion
layers.

The Blend Options

The Blend options use the RGB values of the cutout and those of the result image. Select a blend option
from the Blend Mode box.

(a) Blend Mode box

Blend Pastes the cutout onto the result image.

Add Adds the RGB values of the corresponding pixels in the cutout and the result image. Values greater
than 255 are clipped.

Subtract Subtracts the RGB values of pixels in the image from those of the cutout. Values less than 0 are
clipped.

Black Pastes a black object in the shape of the cutout on the result image.

White Pastes a white object in the shape of the cutout on the result image.

Colour Pastes a coloured object in the shape of the cutout on the result image. The current colour is used
for the object.

NAdd Min Compares the brightness values of corresponding pixels in the cutout and the result image, and
uses the pixel with the smaller value in the tacked down cutout.
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NAdd Max Compares the brightness values of corresponding pixels in the cutout and the result image, and
uses the pixel with the greater value in the tacked down cutout.

Multiply Multiplies the RGB values of corresponding pixels in the cutout and the result image. The value
is normalized by dividing the result by 255.

The Drop Shadow Option

You can add a drop shadow to a cutout by selecting the Drop option from the Paste Mode box. The drop
shadow's colour is taken from the Current Colour pot.

(a) Paste Mode box (b) Scale and Shear fields (c) Softness field (d) Shadow Opacity field

Shadow Opacity field Adjusts the transparency of the drop shadow. Decrease the value to increase the
transparency.

Softness field Adjusts the edge softness of the drop shadow. Increase the value to increase the softness of
the shadow.

Scale and Shear fields Shears and scales the drop shadow along the X- or Y-axis. These fields can be used
to add lighting perspective to the image.

Colour Correcting Cutouts

Apply colour correction to cutouts using the Colour Correction field and CC in the CutOut menu. Click the
Colour Correction field to load a setup directly from the colour correction library. Click CC to load the
cutout into the Colour Corrector.

The default colour correction setup is Linear. When you load a different setup, the name of the setup appears
in the Colour Correction field. To reset the colour correction setup, click Reset.
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(a) Colour Correction field

Animating Cutouts

Use the Channel Editor to animate cutouts. To display the Channel Editor, click Animation and swipe the
cursor across the bottom of the screen.

The following parameters can be animated for every cutout:
■ Position, rotation, and shearing

■ Brush attributes

■ Colour (red, green, and blue channels)

■ Emboss options

■ Shadow options

Loading and Saving Cutouts

Use the Cutout Library to load and save cutouts.

To save or load a cutout:

1 In the Paint menu, click Save or Load.

2 Select CutOut from the Save or Load option box.

3 Select a file or type in a name for the cutout.

NOTE If you are using Save and have typed in a name for the file, you must press Enter to finish saving
the file.

Preserving Paint Cutouts

Paint cutouts are saved in the Lost_+_Found library on the Paint reel rather than in memory in order to
conserve memory. During a session, you must not delete the Paint reel or its cutouts because they will be
used when you return to Paint. However, you can safely delete the cutouts once you exit and restart the
application because the Paint reel in the Lost_+_Found library is not searched in subsequent sessions.
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About Paint Setups

A setup is a file that contains a record of all changes you make to a clip in a particular tool. This record
includes references to clips used. Setups let you save your work separately from the clips, so you can load
and work on them any time, or apply the setup to other clips. Both the procedure and the interface involved
in saving Paint setups and preferences differ slightly from those involved in saving setups in most other
tools

NOTE Custom brushes, brush sets, colour pots, and palette setups that you create in Paint are stored in your user
directory. These resources are loaded when you specify a user in the Project Management menu.

Saving Setups

You can save pictures, preferences, mattes, palettes, brush groups, brushes, and stamps. You can also save
cutouts, cut sequences, recorded strokes in AutoPaint, as well as geometry created in the Graphics menu.

To save a setup:

1 In the Paint menu, click Save.

2 Select the item you want to save from the option box.

To:Select:

Save an image created in Paint.Picture

Save the matte.Matte

Save the current colour palette.Palette

Save the current set of brushes.BrushSet

Save the brush that is currently active.Brush

Save the Stamp currently in the Stamp window.Stamp

Save the geometry created in the Graphics menu. This also includes all cutouts.Geometry

Save the cutouts created in the CutOut menu.CutOut

Save the cutout sequence created in the CutOut menu.CutSequence

Save the last series of recorded strokes.AutoPaint

Save current preferences.Preferences

Save current default values.Defaults

The file browser appears, listing any existing setups for that item.

3 Type the name of the setup in the Save field.
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4 Press Save (Enter) to save the setup.

Cropping a Setup

Use the crop box to limit the area of the picture, matte, cutout, or paint graphics to be saved in the setups
directory.

To save a cropped matte, image, or cutout:

1 In the Paint menu, click Save.

2 Click Picture, Matte, or CutOut to specify the element from the image you want to save.

3 Draw the crop box on the canvas by pressing and dragging the cursor diagonally across the screen.
Alternatively, use the left, right, top, and bottom Crop fields to set the boundaries of the crop box.

NOTE Click Reset to reset the crop box values.

4 Click Save.

5 Select the item you are saving from the option box and name the setup in the keyboard display.

If you want to overwrite an existing setup, select the filename from the file browser.

6 Press Save (Enter) to save the setup.

Loading Setups

Use the Load button to load any type of Paint setup.

To load a setup:

1 Click Load.

The Load Paint menu appears.

2 Select the type of setup you want to load from the Load option box.

A list of existing setups appears in the file browser.

3 Click the title or proxy of the setup you want to load.

Deleting Setups

Use the Delete button to remove setups from the setup directory.
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To delete a setup:

1 Click Load.

The Load Paint menu appears.

2 Enable Delete.

3 Select the type of item you want to remove from the Load option box.

A list of existing setups appears in the file browser.

4 Click the title or proxy of the setup you want to remove and click Confirm.

Creating and Saving Brush Setups

Within a given brush set, there are five individual brushes. You can create and save five brush setups using
the buttons numbered 1 to 5 in the Paint menu. Each brush setup saves the brush type, attribute values and
modes, Special Effects medium, filter, fill parameters, and colour correction setups.

(a) Brush Setup buttons

To create and save a brush setup:

1 In the Paint menu, click one of the five Brush Setup buttons.

2 Enable Edit next to the Brush Setup buttons.

3 Set the brush attributes. See Brush Attributes (page 770).

4 Disable Edit to save the changes to the selected brush setup.

NOTE To save a set of five brush setups, use BrushSet in the Save menu.

Copying Brush Setups

You can copy brush setups using the setup buttons.

To copy brush setups:

1 Select a setup using the Brush Setup buttons and enable Edit.

2 Press Ctrl and click another Brush Setup button to copy the setup.

3 Disable Edit to save the setup.
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Creating a Custom Brush

With Paint, you can create your own custom brushes for specialized applications. You can modify an existing
brush, draw your own brush shape, or grab a part of the image to use as a custom brush.

Use the Custom Brush menu to create your own brush. To display the Custom Brush menu, double-click
one of the brush icons in the Brushes window. An enlarged view of the selected brush appears in the editing
panel.

There are three ways to create a custom brush:
■ Using the brush profile

■ Drawing a brush shape in the editing panel

■ Grabbing an area of the image

Changing the Brush Profile

The brush profile describes the size and edge softness of the custom brush. The default S-curve defines a
circular airbrush. You can change the curve by manipulating the two points that define the curve, or you
can add points to the curve.

(a) Profile box (b) Brush profile

The profile does not affect the brush in the editing panel until you modify the curve or click the Update
button.

Changing the Curve

By default, there are two points that define the brush profile. For the following table and examples, these
points will be named A and B as shown in the preceding illustration. To move the points that define the
curve, select the Move option from the Profile box.

To:Move:

Lighten the brush.Point A up

Darken the brush.Point B down
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To:Move:

Harden the outer edge of the brush.Point A right

Soften the middle of the brush.Point B left

To move the points only on the X-axis, select the Xscale option from the Profile box. To move the points
only on the Y-axis, select the Yscale option. To break a point and manipulate its tangent, select the Break
option and click on a point.

Adding Points to the Curve

To add points to the curve, select the Add option from the Profile box and click on the curve. To delete
points from the curve, select the Delete option and click on one of the points on the curve.

Default S-shaped curve

Hard edge curve
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Invert brush curve

Ring-shaped brush curve

Drawing and Updating a Brush Shape

You can draw a new brush shape or update the current brush shape in the editing panel. The new shape is
drawn using the brush that you selected to open the Custom Brush menu.

(a) Editing panel (b) Gradient bar

NOTE You cannot use the Undo command when drawing or updating a custom brush.

846 | Chapter 20   Painting



To draw a brush shape:

1 To create a new shape, erase the existing brush shape by painting over the editing panel.

2 Draw the new shape.

3 To invert the brush shape, click Invert.

4 To blur the brush shape, click Blur. Each time you click Blur, a 3 x 3 filter is applied to the brush image.

Selecting an Area of the Image

You can select an area of the image to use as the custom brush. The brush created from the selected area
will be a square monochrome brush.

To grab an area of the image:

1 Click Grab in the Custom Brush menu.

2 Click on the image and drag across the screen to define the selection box.

To select a square area, press E as you sweep out the selection box.

The selected area appears as a monochrome image in the editing panel. If the area that you select is
not square, then the selected area is resized to fit in the editing panel.

Updating an Existing Brush

To update an existing brush, click the Update button. The changes are applied to the brush icon that you
selected to open the Custom Brush menu.

Creating a New Brush

To create a new brush, click the New button. This creates an icon for the new brush shape and adds it to
the Brushes window.

Saving the Custom Brush

Custom brushes are not saved automatically when you exit Paint. To save the updated or new brush for use
in another work session, click the Save button. This opens the Brush setups directory. Use the keyboard to
enter the name of the brush, and click the Enter button. The new brush is saved in the Brush setups directory.

Loading a Custom Brush

Click the Load button to load a custom brush from the Brush setups directory.

Customizing the Pressure Profile

Adjust the pressure profile to change the amount of pressure needed to paint with a given brush. The slope
of the curve indicates how quickly paint is applied as you press on the tablet. If the curve is steep, a small
amount of pressure applies full paint to the canvas. If the curve is soft and rounded, you must press harder
and longer to apply full paint.
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(a) Profile box (b) Pressure curve (c) Brush/Pressure box

You use the options in the Profile box to change and add points to the pressure curve. Click Load to load a
Pressure profile. Click Save to save a custom pressure profile.

To edit the pressure profile:

1 Toggle the Brush/Pressure box to Pressure.

2 Double-click a brush icon in the Brushes window to display the Custom Brush menu.

3 Click the Brush/Pressure box to display the pressure profile.

4 Select Move from the Edit Mode box.

5 Press the left point (A) and drag it to its new position.

This changes the amount of paint the brush applies when you press lightly on the tablet.

6 Press the right point (B) and drag it to its new position.

This changes the amount of paint the brush applies when you press down firmly on the tablet.

7 Click Update to update the pressure profile for the brush.

The pressure settings will be used when you paint with the brush during the current work session.

Default Pressure Profile

Pressure is mapped along the horizontal axis (X-axis) of the curve, and the amount of paint applied is mapped
along the vertical axis (Y-axis). If you are using the default S-shaped curve and you press lightly on the pen,
very little paint is applied. As you press harder, more paint is applied.
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(a) Point A: Low paint at low pressure (b) Point B: Full paint at full pressure

Maximum Pressure Curve

If you move point A in the previous figure to the maximum position on the Y-axis, the curve results in full
paint applied all the time, no matter how much or how little pressure you use.

Soft Airbrush

If you move Point B in the previous figure to a point midway on the vertical axis, the curve gives you a soft
airbrush, even at full pressure.
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(a) Point A: Low paint at low pressure (b) Point B: Soft paint at full pressure

Using Colour Correction Setups

Use the Colour Correction Setup menu to apply colour correction setups to the clip loaded into Paint. You
can bring the clip into the Colour Corrector or you can load a setup from the Colour Correction setups
directory into Paint.

To load a clip into the Colour Corrector:

1 In the Paint menu, click Setup.

The Colour Correction menu appears.

(a) Setup Name field

2 Click CC next to the clip you want to load into the Colour Corrector.
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The Colour Corrector appears.

3 Use the Colour Corrector as described in About Colour Correcting (page 663).

4 Save the setup to the Colour Correction setups directory.

5 Click Exit.

The name of the Colour Correction setup appears in the Setup Name field beside the clip label for the
selected clip.

To load a setup directly from the Colour Correction setups directory:

1 Click the Setup Name field for the clip you want to colour correct.

The file browser appears, displaying the contents of the Colour Correction setups directory.

2 Select the Colour Correction setup you want to use.

To reset the colour correction for a clip:

1 Click Reset beside the clip you want to reset.

2 Click Confirm.
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Text and Titling

Text is comprised of layers, paragraphs, and characters. You can make text spin, dance, and change colour over time. You
can also create effects such as a text roll of credits, text crawls, bumpers, and text that moves on a motion path. You can
use logo images in a text roll so that the logo of a sponsor appears in the credits list.

You use the Text Tool to add text and text effects to a clip. Once text effects are applied to a clip, you can then use the
clip in Action or ConnectFX depending on the final effect you want to achieve. Use Action to create 3D text deformation
effects, including sliding, magnifying, and oscillating effects. For example, to create an effect of text rolling on a cylinder
in a composite, you first render a text roll in Text and then, in Action, project it as a texture onto a cylinder. See Diffuse
Mapping (page 502).

Text Workflow
The following table shows the recommended workflow for creating text in the Text tool.

Refer to:Step:

Accessing the Text Tool from Tools (page 854).1. Determine whether the text will appear over a clip, a black
background, or a coloured frame.

Setup and Processing Options (page 855).2. Set text processing options.

Creating Text Rolls and Text Crawls (page 871).3. Determine whether you want to create a text roll, a text
crawl, or text on a path or standard layer.

Adding Text to Clips (page 860).4. Create a layer.

Modifying Layer and Character Properties (page 865).5. Set the position, size, and offset of the layer.

Entering Text (page 861) and Loading Text Files (page 859).6. Enter text or load an existing text file.

Creating Text Effects (page 865).7. Set text attributes.

Setup and Processing Options (page 855).8. Preview the result and process the final clip.
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Accessing the Text Tool
The Text Tool can be accessed from the following locations:
■ The Timeline, using a Text timeline effect. (page 854)

■ Accessing the Text Tool from Tools (page 854)

■ Accessing the Text Tool through ConnectFX  (page 855).

Accessing the Text Tool from the Timeline

To access the Text Tool from the Timeline:

1 Select Timeline.

2 Right-click on the segment that will be colour corrected.

3 Select Add Effect.

The Video Effects ribbon appears.

4 Enable TX (Text).

5 Click Enter Editor...

You are in the Text Tool.

Accessing the Text Tool from Tools

When accessing the Text Tool, you first select whether to add text to a source clip, a coloured frame, or a
black background. The first time you open the Text Tool, the frame contains a clip image, but no text. The
next time you open it, the text and settings from the previous Text session appear.

To access the Text Tool from Tools:

1 Select Tools ➤ Composite ➤ Text.

If this is the first time accessing the Text Tool, the cursor changes to Pick Back.

To change to None, from the Input Mode box, select None.

NOTE You can also Alt-click the Text button to enable the Text button and automatically set the Input
Mode box to None.

2 Do one of the following:
■ If you selected None, choose a resolution, width, height, pixel aspect ratio, bit depth, scan mode,

and frame depth to apply to the background in the Text tool.
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■ If you selected Back, select the clip to which you want to add text.

TIP If you want to change the Input mode to None once in the Text Tool, you can do so from the Text
Setup menu. See Setup and Processing Options (page 855).

The cursor changes to Render Here.

3 Click on any free (or a grey) area on the workspace.

You are now in Text.

4 If text from a previous Text session appears, click Reset All.

The Text Tool is cleared and settings are reset to their default settings.

5 To delete any layers from a previous session, click Delete All.

Accessing the Text Tool through ConnectFX

To access Colour Corrector through ConnectFX:

1 Select Timeline.

2 Select the segment.

3 Click the FX button.

4 Click the Create ConnectFX button.

5 Double-click on, or drag, a Text node into the schematic.

The Text node is now in the schematic.

6 Double-click the Text node.

7 Click the Edit button.

You are in the Text node editor.

Setup and Processing Options
Before processing a text clip and rendering text effects, you must set crop settings for the text layer, blur
settings, text animation, softness, and whether or not you want to use prerendering. The prerendering feature
accelerates the rendering process for a text layer.

Set text processing options in the Text Setup menu. To access the Setup menu, click Setup. The Setup controls
are described as follows.
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Software anti-aliasing values can range from 1 to 64. A higher value increases the sampling rate, but also
increases processing time. An anti-aliasing of 1 means no anti-aliasing is performed and the result is a hard
edge.

TIP A higher anti-aliasing value is usually needed with outlined text.

Softness box Defines the softness of the anti-aliasing samples.

Blur box Sets Gaussian Blur or Box Blur. Gaussian Blur uses subpixel resolution and creates a subtle effect
with the Blur Shadow attribute. Gaussian has rounded, smoother edges and is better for animation; however,
processing time is increased.

Box Blur has rectangular, rougher edges, but is more economical with processing time, especially if you are
working on a rough draft.

Processing Text Clips

You can process clips in progressive or interlaced rendering. Interlaced rendering produces a better result,
especially if you use keyframes that are far apart, but it takes longer to process. You should preview the
quality of the image and the text before you process the final clip.

To process a clip with text:

1 From the Rendering box, select Interlaced, Progressive, or As Back (to render using the mode of the
back clip).
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2 From the Process Mode box, select which clip gets processed.

To:Select:

Process only the text on the back layer.RGB

Process only the matte of the text. The text fill transparency attribute is transferred to the
matte. By generating a matte, you can easily composite the text onto another clip.

Matte

Process the text on the back layer and the matte of the text. The fill transparency is removed
from the text and transferred to the matte.

Both

3 Click Setup.

4 From the Setup menu Rendering section, select the sampling level from the Auto-Softness box.

5 Set other options as required.

6 Position the clip at the first frame or the specific frame where you want to start processing.

7 Click Preview.

TIP You can zoom (Ctrl+spacebar) or pan (Ctrl+Shift+spacebar) the image window while in Preview
mode. To disable Preview, make a modification to the text or processing options, or click anywhere in the
image window.

8 Make modifications to the text and processing options and preview until you are satisfied with the
result.

9 When you are ready to process the text clip, click Render.

The clip is processed from the currently displayed frame until the end of the clip.

Processing Considerations

Processing is contingent upon PreRender, Blur, and Animation settings. Depending on which options you
choose, you can increase the processing speed:
■ When more than one non-static layer has blur shadows, Global Blur is faster, although all shadows are

blurred with the same unique colour and appear under all other layers.

■ When there is a combination of animated and non-animated layers, speed depends on the blur shadows.
If animated text has blurred shadows, Global Blur is faster. If you want a static blurred shadow, and a
non-blurred animated layer, Layer Blur is faster.
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■ If you have static layers only (no animation), speed depends on the number of layers and whether
PreRender can be used. Global Blur is faster since it uses PreRender. The processing speed of Layer Blur
is the same with one or two layers. However, it becomes progressively slower with a higher number of
layers and if the layers use blur shadows.

Saving and Loading Files
You can save, load, and import text files, text setups, and images for specific use with the Text tool. You can
save text, text effects, text preferences, layers and new default text settings.

You can load text files from third-party word processing packages, existing Text tool setups, and logos.
Loading existing text files is particularly convenient if you are creating a long text roll of credits as it saves
time that you would otherwise spend typing and spell checking.

Saving Text Files

When saving files, you can save text setups, preferences, and default settings.

To save a file:

1 Click Save.

2 In the Save menu, select an option from the Save box.

To:Select:

Override the default menu options in the Setup menu and replace them with your
specifications.

Defaults

Save Setup menu specifications only and omit text and text attributes.Preferences

Save any selected text paths.Selected Path

Save any selected logos.Selected Logos

Save selected layers, their text, text attributes and Setup menu options.Selected Layers

Save text files with text attributes and Setup menu options.Text

3 Navigate and choose the directory where you want to save the file.

4 Type a name for the file and press Enter or click the Save button.

The file is saved and you return to the Text menu.

858 | Chapter 21   Text and Titling



Loading Text Files

You can load text files, preferences, and ASCII files. You can also reset the Text menu settings with its factory
defaults.

To load a file:

1 Click Load.

2 In the Load menu, select an option from the Load box.

To load:Select:

Setup menu options that you have saved.Preferences

Previously saved text path setups. Setups between text paths and garbage masks
are interchangeable. Therefore, you can also load a garbage mask shape as a path.

NOTE Preset paths are available in the user/discreet/<product home>/path/default
directory.

Path

Previously saved logos.Logo

Text files. When you select Text File, you can select the encoding of the loaded file.
This applies the correct conversion from the selected file's encoding to the applica-
tion's internal encoding.
For example, select ISO8859-1 to import Latin-1 ASCII files, or UCS-2 to import 2-
byte Unicode encoded text files.

Text File

The encoding options reflect the character encodings available with your system.
The load mechanism supports the same encodings as the iconv utility. Optional
iconv converters are available by installing national language support options.

Several layers or text files at a time with preferences. Text tool preferences that were
saved with the selected file are loaded as well.

Multiple Text Setup

A layer or text file created in the Text tool. Text tool preferences that were saved
with the selected file are loaded as well.

Text Setup

The original Text tool settings that were delivered with Smoke.Factory Defaults

3 Choose a directory in either Proxies or Titles mode.

4 Select the file that you want to load in the file browser. If you selected Multiple Text Setup, Ctrl-click
the files you want to load.
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NOTE If you do not select Multiple Text Setup and you use the Ctrl key to load multiple text files, only
the last selected file is loaded.

5 If you are loading a text file or text setup, you can click anywhere in the user interface to abort the
load before it is completed.

6 To discard unwanted files, enable Remove.

7 If necessary, click Exit Load Text to exit the file browser.

Adding Text to Clips
You add text to a clip by first creating a layer for entering the text, setting the layer attributes, and then
typing the text. You can create several layers of text that overlap each other.

Creating a Layer

Text is contained in a layer called a text layer. When you create a text layer, a coloured border called the
crop border appears in the image window indicating the region the text will occupy.

To create a layer:

1 Click New Layer. If this is the first layer you are creating, you can click directly in the image window.

The text layer is positioned in the upper-left corner of the safe title area by default. The text in the
layer is left justified, while the width is equal to the safe title overlay. You can modify the safe title
overlay using the Grid and Guide controls. You can also modify the boundary colour. See Processing
Text Clips (page 856).

2 Click Axis to make sure you are in the Axis menu.

3 To set the text layer dimensions, enable Layer.
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Each layer has its own parent axis for translating, rotating, resizing, and shearing. The axis for the layer
can be in the upper-left or centre of the layer. See Creating Text Effects (page 865).

Entering Text

The text you type may be as short as one letter or word or as long as several paragraphs. If the text is long
or exists in a word processor, you can load the text file into the current layer.

You enter and edit characters much like in a word processor. You type characters using the keyboard and
many known text editing conventions, such as Shift+arrow keys to select text lines. You can also click
once to insert the cursor and select the adjacent character, double-click to select the whole word, and
triple-click to select the entire line. Quadruple-click to select all characters on the layer and use the middle
mouse button to paste selected text.

Use either the workstation or on-screen keyboard to enter characters in a layer. You can also paste the current
text selection (from a shell or any other application) into any keyboard input field by pressing the middle
mouse button or by using the pen button.

You can also input Asian characters using their corresponding ASCII codes with the numeric keypad.

To enter text in a layer:

1 From the Text Mode box, select Edit.
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TIP Use Edit mode to type text strings, select text, edit text in layers, and modify text attributes. Press Esc
to switch between Edit and Move modes. The message bar displays the current mode.

2 In the image window, create a new layer by doing one of the following:
■ Click New Layer.

■ Press Alt+N.

■ Click directly in the image window (if this is the first layer you are creating).

3 To begin a new paragraph within the layer, press Enter.

Notice that each paragraph has its own coloured boundary and a paragraph tag that is a coloured
rectangle in the upper-left corner of the paragraph. In Edit mode, a selected paragraph's boundary is
white.
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(a) Blue indicates paragraphs in text layer (b) Red indicates currently selected paragraph, which has a paragraph
boundary (c) Layer boundary is shown in red

4 In the Paragraph and Font menus, set properties.

Using the Text Keyboard

When you use the on-screen keyboard, consider the following:
■ Special characters use the ISOLatin1 encoding vector. You specify the encoding vector in the init.cfg

configuration file using the FontMapping keyword.

■ The extended keyboard uses the Standard encoding vector.
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■ Asian character sets may not display all characters on the on-screen and extended keyboards. Use the
numeric keypad or load an ASCII file that contains unavailable characters for the selected font. See
Loading Text Files (page 859).

To use the Text keyboard:

1 In the Text menu, click Keyboard.

2 On the on-screen keyboard that appears, enable Up ASCII to display extended characters contained in
the selected font set.

NOTE Enabling Up ASCII also affects your workstation keyboard, so make sure you disable the button again
before exiting the Text menu.

3 If the selected font has special symbol characters, enable Symbols to see them.

4 Type the characters in the text layer.

The keyboard characters appear in the current font.

Word Processing Keyboard Shortcuts

Typical word processing tasks include text selection, cutting, copying, and pasting. The Text tool includes
several character manipulation keyboard shortcuts for these tasks.

To:Press:

Select all characters in the selected text layer.Alt+A

Select all characters in the selected paragraph within a layer.Alt+P

Select all characters in all layers. This operation is the same as using the Select All
Layers button.

Alt+Shift+A

Extend the selection one line up.Shift+up arrow

Extend the selection one line down.Shift+down arrow

Extend the selection one character to the left.Shift+left arrow

864 | Chapter 21   Text and Titling



To:Press:

Extend the selection one character to the right.Shift+right arrow

Extend the selection to the beginning of the current line.Shift+Home

Extend the selection to the end of the current line.Shift+End

Extend the character selection to the beginning of the text layer.Ctrl+Shift+PgUp

Extend the character selection to the end of the text layer.Ctrl+Shift+PgDn

Creating Text Effects
Use the Attributes controls to change the appearance of individual characters, paragraphs, and layers. You
set similar properties for both layers and characters. You can also load a logo in a paragraph and then format
it using the Attributes menu. See Loading Logos (page 869). If you create text formats that you plan to reuse,
save them using the Styles menu. See Defining Styles (page 880).

These text attributes have a cumulative effect on the selected characters. For example, if you enable the Fill
and Outline buttons, the text appears as solid characters with a coloured outline.

Modifying Layer and Character Properties

Use the Layer controls in the Axis menu to rotate, translate, scale, or shear a selected layer and to apply an
effect uniformly to all characters.

Creating Text Effects | 865



Use the Character controls in the Axis menu to view and position the axis of each character. You can use
the position, rotation, scale, and shear settings for each character in a layer to create an effect of scrambled
letters.

To edit text characters, you must be in Move or Edit mode and some text must be selected. The Layer and
Character controls are described as follows.

Layer Order box (in the Layer Attributes section) Moves a layer in front of or behind another layer.

To move the layer:Select:

One position down in the stack behind another layer.Push

One position up in the stack in front of another layer.Pop

To the bottom of the stack behind all other layers.Bottom
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To move the layer:Select:

To the top of the stack in front of all other layers.Top

Aligning Layers

Use Align Sel mode to align multiple layers and specify the direction for the alignment.

To align text layers:

1 In the image window, select two or more layers to be aligned. To select multiple layers, Ctrl-click the
layers (or click the pen button).

2 In the Text Mode box, select Align Sel.

3 On the numeric keypad, press the number that corresponds with the direction in which you want to
align the selected layers.

To:Press:

Align left.4

Align right.6

Align to the top.8

Align to the bottom.2

Centre align.5

The text mode returns to Move when the Align Sel operation is done.

Adjusting Text Leading

Use Leading mode to adjust the spacing between lines of text in a paragraph. The selected lines are adjusted
in proportion to the leading values already specified. Use this mode to adjust the leading among paragraphs
with various leading values.

Rekerning Text

Kerning refers to the space between characters that you can either increase or decrease. Use Rekern mode
to change the kerning of all selected characters in relative proportion to the current kerning values.

Use Rekern to adjust the kerning among paragraphs with various kerning values.

To rekern text:

1 Select the string of characters you want to rekern.

2 In the Text Mode box, select Rekern.

In the Paragraph menu, the Kern field changes to the Rekern field.

3 Enter a new value in the Rekern field or use the up and down arrow keys to rekern the text in single
increments. Press Shift+up arrow or Shift+down arrow to rekern in increments of 10 pixels.
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Resizing Text

Use Resize mode to change the font size of all the characters in a selection in relative proportion to the
current font sizes. Use this mode if you have several font sizes represented in a selection.

The Size field allows you to apply an absolute font size value to selected text.

To resize text:

1 Select the string of characters you want to resize.

2 In the Text Mode box, select Resize.

The Size field you used to specify the original size of the text changes to the Resize field.

3 Enter a new value in the Resize field or use the up and down arrow keys to resize the text in single
increments. Press Shift+up arrow or Shift+down arrow to resize in increments of 10.

Offsetting Text Layers

Use Y Offset mode to shift selected layers along the vertical axis—the Y-axis. Use the up and down arrow
keys to offset the selection.

Using Safe Title

Use Safe Title mode to align selected text within the safe title overlay. Use the numeric keypad (0-9) to specify
the direction of alignment. Safe title is used to define the boundary for positioning text and how it appears
in a rendered clip. By default, new layers appear in the upper-left corner of the safe title area.

To align to the safe title:

1 Select the layer you want to align with the safe title.

2 In the Text Mode box, select Safe Title.

3 Press the number on the numeric keypad that corresponds with the direction in which you want to
align the selected layers. Press 1, 2, 3, 4, 6, 7, 8, or 9 to determine the direction in which to align; press
5 to align the layer in the centre of the safe title area. Press 0 to align the layer horizontally in the safe
title area.

Copying and Pasting Character Channels

You can copy character attributes, transformations, or both, from one character and paste them onto a
selection of others.

To copy and paste character channels:

1 Select the text from which you want to copy the attributes or transformations.

2 In the Character Channels section of the Text menu, click Copy Attributes, Copy Transformations, or
Copy All.
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3 Select the text to which you want to paste the attributes or transformations.

4 Click Paste.

Grouping Text Layers

You can group two or more layers together to create a montage of text and move text layers together. Grouped
layers can be saved and loaded as one unit. You can add more text layers to an existing group, resulting in
a new single group.

NOTE When a group of layers is selected, you cannot switch to Edit mode.

To create a text layer group:

1 In the Text menu, select Move from the Edit Mode box.

2 Ctrl-click (or click the pen button) to select two or more text layers, or click Select All to select all text
layers in the scene.

3 In the Layer Attributes section, enable Group.

Loading Logos
You can use a logo so that it appears on every frame in a clip. Also, you can use logos in text rolls to credit
sponsors, contributors, and products. Place a logo directly in a paragraph and then set text formatting
properties for the logo.

To insert a logo in a paragraph:

1 In the layer Attributes section, click Load Logo.

The EditDesk appears.

2 Select a front clip, and optionally, a matte clip for the logo.

The logo is inserted at the cursor position in the text layer.

3 In the Font and Paragraph menus, increase or decrease the size of the logo in the text layer by adjusting
the font size, leading, and kerning. See Entering Text (page 861).

To save a logo:

1 Select the logos you want to save.
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You can select and save multiple logos.

2 Click Save.

3 From the Save box, select Selected Logos.

4 Use the File field to name the logo.

5 Click Save.

The logo is saved as a .tif file.

Tabulating Text
You can organize text into columns by setting tabs in the Tabulation menu. In a text layer, you can also set
tab stops to align text at specific locations in a paragraph.

To access the Tabulation menu:

1 Create a text layer.

2 In the Text menu, click Tabulation.

The Tabulation menu appears.

The Tabulation controls are described as follows.

To set a tab stop:

1 In the Tabulation menu, click Add to add the tab stop in a text layer.

(a) Tab stop shown in the ruler

2 Click the tab stop and drag it to its new location on the ruler. Alternatively, enter a pixel value in the
Position field.
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Once you set tab stops for a paragraph, press Tab in subsequent paragraphs to type text in the location
of the next tab stop. In a text layer, each time you press Enter, the tab stops you set in the previous
paragraph are carried to the next paragraph.

Spell Checking
In the Spell Check menu, you can check the spelling of the text in a text layer. When spelling errors are
encountered, a red line is drawn through words not in its dictionary. By default, the spell checker uses the
language and dictionary installed with the operating system to verify the spelling of words. You can also
create your own custom dictionary.

NOTE If the spell checker is not installed on your system, the Spell Check menu controls are disabled.

To access the Spell Check menu:

1 In the Text menu, click Spell Check.

The Spell Check menu appears.

To spell check a text layer:

1 In the Text menu, click Spell Check.

2 Enable Check All Layers.

Lines appear through misspelled words.

3 To correct misspellings, in Edit mode, click Next or Previous to navigate to each misspelled word.

Creating Text Rolls and Text Crawls
You can create text rolls, which are commonly used for credit rolls. A text roll is a layer of text that rolls
from the bottom to the top of a clip for a series of frames. In a text roll, you can use special fonts as well as
coloured, animated, and tabulated text.

You can include logos of sponsors, contributors, and products in text rolls. For example, you can create a
list of credits that uses a green, sheared font for all contributors' names and includes a single, larger capitalized
letter spinning on an axis at the beginning of each title line. The contributors' names can appear in a white,
semi-transparent, Courier-type font.

A text crawl scrolls text horizontally across the frame. For example, you can create a list of phone numbers
that scroll from left to right across the bottom of the screen during a telethon broadcast.
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To access the Roll/Crawl menu:

1 In the Text menu, click Roll/Crawl.

The Roll/Crawl menu appears.

The Roll/Crawl controls are described as follows.

To create a text roll or crawl:

1 In the Text Setup menu Rendering section, enable PreRender, and then select Interlaced from the
Render box.

2 In the Text menu, select Interlaced from the Render box.

3 Enable Auto Key.

4 Click Roll/Crawl to enter the Roll/Crawl menu.

5 Go to the first frame of the clip, and enable Roll or Crawl.
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6 Click New Layer and add the text you want to use for the text roll or crawl.

A shaded layer appears in the image window with a vertical scrollbar for a roll or a horizontal scrollbar
for a crawl. The shaded area represents the crop box area. The following is an example of a text roll.

(a) Red indicates currently selected paragraph (b) Crop box (c) Scrollbar (d) Blue indicates paragraphs in text
roll layer (e) Yellow border delimits text

7 To set the start position of where the text appears in the text roll or crawl, use the Scrollbar X and Y
fields or drag the scrollbar up or down (roll), or left or right (crawl).

8 Go to the frame where you want the text roll or crawl to finish and set the end position by dragging
the scrollbar or using the Scrollbar X and Y fields.
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9 If you want to calculate the ideal number of frames for the text roll, choose a roll speed: 1X, 2X, 3X,
or 4X.

The suggested duration appears in the Best Roll Duration field. You can either change the number of
frames in your clip to match the one in the Best Roll Duration field, or you can leave the clip as is.

10 If the suggested duration is acceptable, enter it in the Duration field and then click Fit Best Speed.

The roll is created and the Scrollbar position and Leading are changed (if required) and locked.

11 If the suggested duration is not acceptable, click Fit Best Speed.

The roll is created and the Scrollbar position and Leading are changed (if required) and locked.

12 Click Process to render the text roll and view the results.

When you play the clip, the text rolls or crawls through the image area from the first position to the
final position.

NOTE When processing text rolls and crawls, use PreRender in the Text Setup menu to render the roll or
crawl relatively fast while bypassing the animation. Check the message bar to see whether PreRender is
enabled.

TIP When creating credit rolls, the anti-aliasing on the text should be turned on.

Animating Text
You can animate text properties including colour, softness, size, shadow, and transformation effects such
as rotation, scale, and shear. For example, you can animate text channels to create an effect where the text
appears gradually over time and then disappears from view.

Use Auto Key to create keyframes automatically as you make changes to text attributes. The movement
between keyframes is interpolated according to the interpolation mode you set.

NOTE PreRender must be disabled when creating text animations. See Processing Considerations (page 857). Check
the message bar to verify the PreRender status.

To animate text automatically:

1 In the Text Animation menu, enable Auto Key.
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2 Go to the first frame in the clip.

3 With the Attribute controls, set the attributes and transformation properties.

4 Navigate to another frame in the clip and add more attributes and transformation properties according
to the effect you want to produce.

5 Click Preview.

6 Make modifications as required and when finished, click Process.

7 Click Play to view the result.

When you play the clip, the animation moves from the first frame to the last.

Animating Paragraph Channels

In the Text Tool, the Animation controls include a Paragraph Channel View for viewing text channels in
the Channel Editor. Use the attributes and transformation channels to animate paragraphs and characters
and fine-tune animations created using the Attributes menu.
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(a) Paragraph folder contains all the characters, including spaces between words (b) You can animate specific channels
for each character

To animate paragraph channels:

1 In the Text menu, click Animation to display the Channel Editor.

2 From the Paragraph Channel View box, select the paragraph channels you want to view in the Channel
Editor.
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To view:Select:

The channels for the selected paragraph—the current cursor location.Current

The channels for all paragraphs in the selected layer.Layer

All channels for all paragraphs in all layers.All

3 Animate the selected channels as required.

Animating Text on a Motion Path

You can create a text layer on a spline and animate it over time. In this way, you create marquee text that
twists and turns over an image or in time with other objects in the scene. The spline is fully editable; you
can add control points and manipulate their tangent handles. In the Channel Editor, the Path group contains
a Shape channel for the path and an Offset channel for the offset value.
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You can set custom colours for the text path wireframe and vertices in the Text Setup menu. See Setup and
Processing Options (page 855).

To animate text on a motion path:

1 Create a layer or select a layer in the image window.

2 From the Text On Path section of the Text menu, enable On Path.

By default, the text appears on a path with three vertices.

3 Adjust and animate the shape of the path using the Text On Path controls.

The Text On Path controls are described as follows.

To:Select:

Modify the shape of the spline by changing the position of the vertex or tangent.Move

Add more vertices to the spline to create a more complex shape with text. Click anywhere on
the path to add a vertex.

Add

Remove a vertex from the spline.Delete
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To:Select:

Separate two tangent handles and move them independently. Click a tangent; the tangent
handle changes from a dashed to a solid line to indicate it is broken.

Break

Connect broken tangents automatically. Click a tangent to reconnect it.Auto

Saving and Loading Path Setups

You can use a garbage mask spline as a shape for the motion path of text on a path. You can save and load
the Shape channel as a list in raw shape data (.raw file), which is compatible with garbage mask raw data.
Raw setups between text paths and garbage masks are interchangeable.

To load a raw shape data file:

1 In the Text On Path controls, enable On Path.

2 Click Load.

The Text load options and file browser appear.

3 In the file browser, select Path and then select Default from the Text Path loading boxes.

A set of path files is visible when the Path and Default options are selected in the Load Text menu.

4 Browse to find the file you want to load.

TIP Gmask setup files are typically located in the /usr/discreet/<product_name>/path/default directory.

5 Click Load.

The spline appears with its new shape in the image area.
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Defining Styles
Styles are sets of text attributes and specifications that can be replicated when you need to use the same
format again. You create and modify styles, and save and load them from the file browser using the Styles
menu. The following character attributes are saved with the style: font, colour, outline, shadow, blur, scaling,
rotation and shear. In addition, the layer's background colour and opacity are saved as well.

To access the Styles menu, click the Styles button in the Text menu.

(a) Style Mode box (b) Style Option box

To define a style:

1 Select a character with the attributes you want to save.

You can select multiple characters, but it is the first one that defines the style.

2 From the Style Option box, select Define Style and then click the style button to which you want to
assign the style.

880 | Chapter 21   Text and Titling



3 Click Name and enter a name for the style. Then click the style button to which you want the name
to apply.

The new name appears on the button.

NOTE You can use Ctrl+Shift and F1 to F9 to assign text attributes to Style buttons 1 through 9 from
any menu.

To modify a style:

1 Select the character with the attributes you want to save.

2 From the Style Option box, select Define Style and then click the style button to which you want to
assign the style.

NOTE You can use Ctrl+Shift and F1 to F9 to assign a style to Style buttons 1 through 9 from any menu.

To clear a style:

1 From the Style Option box, select Clear Style and then click a style button.

NOTE It is sometimes convenient to clear all styles just prior to using AutoStyle to save multiple styles
automatically. AutoStyle assigns up to nine style buttons at once. See Saving Multiple Styles Automatically
(page 882).

To apply a style:

1 Select a paragraph or string of characters to which you want to apply a style.

2 Press Ctrl+F1 to F9, or press the style button, to apply the style to the selected text.

Saving and Loading Styles

After you create styles, you may want to save one or all of them. You can load any of them in future sessions.

To save a style:

1 Do one of the following in the Styles menu:
■ Select All Styles from the Style Mode box.

■ Select One Style from the Style Mode box, and the style you want to save (Style 1 to Style 9).

2 Click Save Style.

The Save Styles menu and file browser appear.

3 Choose a directory for the style.

NOTE You can click the Create Dir button to create a new directory in which to save your styles.

4 Enter the filename.

The style is saved. The file browser automatically closes and the Styles menu reappears.
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To load a style:

1 Select an option from the Style Mode box.

To:Select:

Load files saved with multiple styles. The file browser lists setups saved with multiple styles.All Styles

Load files saved with one style only. The file browser lists setups saved with a single style.One Style

2 Click Load Style.

The Load Styles menu and file browser appear.

3 Navigate to the appropriate directory and select the style(s) you want to load.

4 If necessary, click Exit Load Text to exit the file browser.

Saving Multiple Styles Automatically

If you create a section of text with multiple sets of attributes, you can assign each set as a separate style with
a shortcut and then save them. The Text Tool automatically detects the different sets of attributes used in
the section and assigns each set to a Style button. You can then use shortcuts to apply them.

To assign styles from an existing layer using shortcuts:

1 Select the section of text.

2 From the Style Option box, select AutoStyle.

NOTE If you used more than nine sets of attributes in the selection, only the first nine are assigned to a Style
button.

3 Save the styles.

Changing Fonts
When you open the Text tool, the default font is loaded and ready to use. When you choose a different font,
it becomes the current font and all text you type appears in the current font. If you edit text that has a
different font, the current font is replaced by the font of the text at the cursor position. For example, if you
are working with Carta font and you edit text that uses Helvetica, Helvetica becomes the current font and
all subsequent text you type appears in Helvetica.

You specify the default font in the TL Effects / CFX tab of the Preferences menu. Also, you can install
additional fonts for use in the Text Tool.

To change the current font:

1 In the Font section of the Text menu, click the Font field.
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The font library appears.

(a) Font Type box (b) Font Preview window

2 In the Font Type box, select the font type you want to load.

DescriptionType

A single-byte font type designed for Roman language fonts. Soft-links to the Adobe®

Postscript® Type 1 fonts installed with the system or supplied by Autodesk are contained
in /usr/discreet/font directory.

Type 1

A multi-byte adaptation of Adobe Postscript Type 1 fonts, well-suited to representing
the large character sets of Asian languages such as Japanese, Korean and Chinese.

CID

A widely used cross-platform font format.TrueType

A font developed by Adobe and Microsoft® that supports expanded character sets and
layouts.

OpenType®

Displays all font types, detecting the type automatically.Auto

3 In the file browser, navigate to the directory that contains the font you want to load.

4 Preview a font. Do one of the following:
■ Select a font to see it with sample text in the Font Preview window.
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The sample text can be the text you selected in the text layer, or text that you enter by clicking the
Font Preview window to display the on-screen keyboard.

■ In the Proxies/Titles box, select Proxies to preview fonts. If no proxy appears, click Generate Proxies
to generate a font proxy.

This process may take a while, but once you create the proxies, the settings are retained. Each time
you return to the font library, you can toggle between viewing font titles and font proxies by
selecting Proxies or Titles.

5 Select the font.

6 Click Load.

The Text menu reappears with the name of the new font in the Font field.

Pasting Text from an External Source

You can copy text from another application and paste it directly in a text layer.

To paste text from a terminal to the Text tool:

1 In the Text tool, create a layer for the text you want to paste.

2 Click the Font field and select a font.

3 In thewindow, copy the text.

4 In the Text tool, paste the text in a text layer.

Entering Non-Latin Text

When entering non-Latin text characters, consult your system documentation to make sure the required
input method packages are installed. For example, to enter Chinese characters, you can use the chinput
package.

The following example illustrates entering Japanese text in a text layer with the kinput2, canna, and Wnn6
packages.
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To enter Japanese text in a text layer:

1 Start the canna daemon by typing /etc/init.d/canna start in a Linux terminal.

2 Type the following commands in the terminal:
■ kinput2 -canna &

■ setenv XMODIFIERS @im=kinput2

■ setenv LANG ja_JP.eucJP

NOTE For detailed instructions on kinput, canna, and Wnn6, consult your system documentation.

3 Start your Autodesk application.

4 Load a clip in the Text tool.

Notice the message bar that appears at the top of the screen. This indicates you are in Latin input
mode.

(a) Message bar

5 Create a layer and click the Font field to select a Japanese font from the file browser. From the Text
Mode box, select Edit and then select the layer in the image window.

When you type text, notice that you are still in Latin input mode.

6 Press your Input Method keyboard shortcut.

The message bar changes to indicate that you are in Japanese text mode.
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(a) Message bar

7 Type text, as required.

8 Press Enter to accept the characters and add them to the text layer.

9 To revert back to Latin input mode, press the Input Method keyboard shortcut again.

Accessing OTF Fonts

In order to access symbols of the OTF font type, access the on-screen keyboard, enable the Symbols button
(in the lower right of the keyboard), then use the arrow keys to browse through the pages of symbols until
you find the character set you need.
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Effects and Tools Reference

This section provides information about the effects and tools that you can use on your media.

2D Histogram
Use the 2D Histogram to display the luminance distribution of the matte.

To access the 2D Histogram menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

2D Histogram Menu Settings

Lift field Displays the value added to the resulting pixels to create the final matte. Editable.
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Gain field Displays the value that the resulting pixel values are multiplied by to create the final matte.
Editable.

Histogram Displays a bar graph that is used to adjust the luminance values of the image. In the Ranges
menu, the curves for the three luma ranges are also displayed.

Minimum Input field Displays the lower limit of the luminance values. Pixels with lower values are mapped
to black.

Minimum Output field Displays the lower limit of the luminance values for black pixels.

Maximum Input field Displays the upper limit of the luminance values. Pixels with higher values are
mapped to white.

Maximum Output field Displays the upper limit of the luminance values for white pixels.

Out Range box Select a curve that is constant (Clamp) or linear (No Clamp) before the first point of the
curve and after the last point of the curve.

When using 16-bit floating point images, you can select Clamp to clamp colour and luminance values, or
No Clamp to allow pixel floating point values to be less the 0 or more than 1.

Frame Selection box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Destination button Enable to show a histogram of the colour values in the result or destination clip.

The destination colour values are obtained from the current frame. If you input both front and matte clips,
the colour values in the front clip that are defined by the white part of the matte are displayed.

Reset button Resets to default histogram settings.

Zoom field Displays the vertical zoom value of the histogram.

You can also zoom horizontally by pressing Ctrl+spacebar and dragging left or right in the histogram.
To pan horizontally, click spacebar and drag left or right in the histogram.

2D Transform
Use 2D Transform to apply basic axis transformations and camera shake effects to clips.
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To access the 2D Transform menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and a matte clip, and outputs a result and an outmatte.
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2D Transform Menu Settings

General Settings

Transform Type box Select Perspective to modify all available settings, or Pan & Scan to modify only Position
and Scale. In Pan & Scan mode, some Axis and Camera Shake settings are unavailable.

Camera Shake button Enable to simulate camera shake in the image.

Show Icons button Enable to display the vertex editing tool in the image window.

Scan Mode box Select the scan mode of rendered clips.

Axis Settings

Position X field Displays the X-axis offset applied to the clip. Editable.

Position Y field Displays the Y-axis offset applied to the clip. Editable.

Position Z field Displays the depth offset of the clip. Available when Transform Type is set to Perspective.
Editable.

Rotation X field Displays the degree of rotation on the X axis. Available when Transform Type is set to
Perspective. Editable.

Rotation Y field Displays the degree of rotation on the Y axis. Available when Transform Type is set to
Perspective. Editable.

Rotation Z field Displays the degree of rotation along the Z axis. Available when Transform Type is set to
Perspective. Editable.

Scale X field Displays the X-axis scaling offsets applied to the clip. Editable.
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Scale Y field Displays the Y-axis scaling offsets applied to the clip. Editable.

Scale Z field Displays the Z-axis scaling offset. Available when Transform Type is set to Perspective. Editable.

Proportional button Enable to affect the scale fields proportionally.

Shear X field Displays the offset value for the horizontal edges of the clip. Available when Transform Type
is set to Perspective. Editable.

Shear Y field Displays the offset value for the vertical edges of the clip. Available when Transform Type is
set to Perspective. Editable.

Shear Z field Displays the depth value of the horizontal edges of the clip. Available when Transform Type
is set to Perspective. Editable.

Centre X field Displays the centre point value of the clip along the horizontal axis. Available when Transform
Type is set to Perspective. Editable.

Centre Y field Displays the centre point value of the clip along the vertical axis. Available when Transform
Type is set to Perspective. Editable.

Centre Z field Displays the centre point value of the clip along the Z axis. Available when Transform Type
is set to Perspective. Editable.

Camera Shake Settings

Translate X Amount field Displays the amount of horizontal movement applied to the clip. Editable.

Translate Y Amount field Displays the amount of vertical movement applied to the clip. Editable.

Rotation Z Amount field Displays the degree of rotation on the Z axis. Available when Transform Type is
set to Perspective.Editable.

Scale Amount field Displays the amount of scaling applied to the clip. Editable.

Translate X Frequency field Displays the frequency of horizontal movement applied to the clip. Editable.

Translate Y Frequency field Displays the frequency of vertical movement applied to the clip. Editable.

Scale Frequency field Displays the frequency of scaling applied to the clip. Editable.

Rotation Z Frequency field Displays the frequency of rotation on the Z axis. Available when Transform
Type is set to Perspective.Editable.

Translate X Phase field Displays the phase of horizontal movement applied to the clip. Editable.

Translate Y Phase field Displays the phase of vertical movement applied to the clip. Editable.

Rotation Z Phase field Displays the phase of rotation on the Z axis. Editable.

Scale Phase field Displays the phase of scaling applied to the clip. Editable.
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X Centre field Displays the centre point value of the clip along the horizontal axis. Available when Transform
Type is set to Perspective. Editable.

Y Centre field Displays the centre point value of the clip along the vertical axis. Available when Transform
Type is set to Perspective.Editable.

Stabilization Settings

Enter Stabilizer button Enable to enter the Stabilizer editor.

Invert Stabilization button Enable to apply an inverse of the stabilization data to recreate the original
camera shake.

Framing Mode box Select a method to fill or remove the area where the image has been shifted after
stabilization.

Position X button Enable to include the X-axis position in the stabilization.

Position X field Displays the amount of stabilization data found in the animation channel for the X position.

Position Y button Enable to include the Y-axis position in the stabilization.

Position Y field Displays the amount of stabilization data found in the animation channel for the Y position.

Scaling button Enable to include scaling in the stabilization.

Scaling field Displays the amount of stabilization data found in the animation channel for scaling.

Rotation button Enable to include the rotation in the stabilization.

Rotation field Displays the amount of stabilization data found in the animation channel for rotation.

Set Frame button Enable to determine which frame has no transformation data.

Frame field Displays the frame that has no transformation data. Non-editable.

Perspective and Random Seed Settings
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Perspective field Displays the field of view. Available when Transform Type is set to Perspective. Editable.

Random Seed field Displays the random seed value of the camera shake. Editable.

Texture Settings

Filter box Displays available filters to control the quality of resize operations. The list of filters changes when
you switch between Perspective and Pan & Scan Transform Types.

Precision field Displays the frequency cut-off point used during resize. Editable only when doing a pan and
scan with Shannon or Lanczos filters.

Crisp/Soft field Displays the amount of blurring used during resize. Editable only when doing a pan and
scan with Mitchell, Shannon or Lanczos filters.

Repeat Mode box Select an option to fill the empty portions of the frame.

To:Select:

Repeats last pixel color.Repeat Last

Wrap the image around to fill the area.Tile Repeat

Repeats the source pixels both vertically and horizontally.Mirror Repeat

Use a colour to fill the area. Use the adjacent colour pot to pick the colour. You will lose texture

and will fill the rest of the image with a black border.

Repeat Off

Anti-Aliasing Settings

Anti-Aliasing button Enable to activate sampling and softness.

Sampling box Select the number of samples to use in the anti-aliasing process.
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Softness field Displays the level of softness of the samples. Editable.

Motion Blur Settings

Motion Blur button Enable to apply a motion blur to a selected clip.

Samples field Displays the number of frames to sample when creating the blur. The samples include the
current frame, and an equal distribution of past and future frames. Editable.

Phase field Displays the level of softness of the samples. Editable.

Shutter field Displays the number of frames for which the shutter stays open. For example, when the shutter
value is set to 3, every third frame is a sample. Editable.

Lock Transform button Enable to lock the transformation of the motion blur effect.

Result Output Settings

Result Output box Select an output option. Select Premultiplied to output alpha values in the colour channels
of the result.

Canvas Resolution Settings

Resize Fit Mode box Select whether to resize the clip with width and height values.

The output resolution remains the same as the input resolu-
tion.

Same as Input

You define the output resolution.Custom
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The output resolution changes dynamically, which insures
that any transformation applied will not crop the image across
the whole length of the clip.

Auto Scale

Width field Displays the width of the image. Editable.

Height field Displays the height of the image. Editable.

Auto Matte
Use the Auto Matte to generate a high-contrast matte from a clip.

Image courtesy of Optimus

To access the Auto Matte menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip as input, and outputs a result.

Auto Matte Menu Settings

General Settings

Minimum field Displays the minimum luma value considered to be part of the opaque area of the matte.
Editable.

Maximum field Displays the maximum luma value considered to be part of the transparent area of the
matte. Editable.

Gain field Displays a value, in percentage, that is multiplied to the pixel values in the resulting matte to
reduce or increase the grey levels.
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Auto Stabilize
Use the Auto Stabilize to analyse the movement in a clip and remove camera instability. For example, you
can remove camera jitter or lock an object's position over a sequence of frames to make it appear motionless.

To access the Auto Stabilize menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts front and matte clips, and outputs a result and an outmatte.
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Auto Stabilize Menu Settings

Analysis Settings

Analyze button Click to run the stabilization analysis. During analysis, the viewport defaults to the Front
view, and the frame advances as the stabilization is calculated. Progress can be monitored by the keyframes
that have been created during analysis and the percentage of completion displayed next to the Analyze
button. Track points are displayed on the clip to indicate how the stabilization was tracked.

Progress field Displays the percentage of the analysis that is complete. Non-editable.

Scene Flexibility field Displays the level of focus on rigid objects that move in the clip. Enter 0% to focus
on a single rigid object as it moves or 100% to analyse all visible motion paths. If the analysis has no scene
flexibility, the stabilization will focus on a single rigid object as it moves in the clip. Use the following values
as a general guideline:

To:Select:

Stabilize a pan, tilt, zoom, or the motion of a single rigid object that is visible during

the entire analysis.

0%-20%

Stabilize objects that change their shape or depth, and exclude objects that are

smaller or moving rapidly.

30%-70%

Stabilize all visible movements.80%-100%

Use Matte button Enable to exclude black areas on the matte from analysis on the front clip, and constrain
the Analysis region.

Range From field Displays the value of the first frame to include in the analysis. Editable.

Range To field Displays the value of the last frame to include in the analysis. Editable.

Stabilization Method box Select whether to perform a two-dimensional or perspective analysis.

Negate Stabilization button Enable to apply the inverted parameter values.

Region of Interest button Enable to display a rectangle that can be resized to indicate the region you want
to analyse on the front clip. Select Front from the View box.
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Auto button Enable to automatically track motion within the region of interest. At each frame, the position
of the region of interest is updated based on the motion within the area. If this button is disabled, and the
region of interest was not previously tracked, the region of interest remains static.

Stabilization Settings

Position X button Enable to include the X-axis position in the stabilization.

Position X Option box Select whether to lock the X-axis position at the reference frame to all frames in the
analysis (Fixed), or to apply smoothness to the stabilization curve on the X-axis.

Position Y button Enable to include the Y-axis position in the stabilization.

Position Y Option box Select whether to lock the Y-axis position at the reference frame to all frames in the
analysis (Fixed), or to apply smoothness to the stabilization curve on the Y-axis.

Rotation button Enable to include the rotation in the stabilization.

Rotation Option box Select whether to lock the rotation at the reference frame to all frames in the analysis
(Fixed), or to apply smoothness to the stabilization curve on the rotation.

Scaling button Enable to include scaling in the stabilization.

Scaling Lock Option box Select whether to lock the scaling at the reference frame to all frames in the
analysis (Fixed), or to apply smoothness to the stabilization curve on the scaling.

NOTE You can change the centre of rotation and scaling for the image. By default, the centre of rotation and
scaling is the centre of the image, represented by a yellow crosshair. Switch to Front view, then hold down C and
click the new centre point.

Perspective button Enable to include perspective in the stabilization.

Perspective Option box Select whether to lock the perspective at the reference frame to all frames in the
analysis (Fixed), or to apply smoothness to the stabilization curve on the perspective.

Smoothness field Displays the level of smoothness of the stabilization curves generated by the analysis and
determines the mix between the original motion and the completely stabilized transformation. Editable.

Mix field Displays the percentage of smoothness used in the final stabilization output and determines how
smooth the stabilization curves are. Editable.

Reference and Tracker Settings

Set Frame button Click to set the current frame as the reference frame for the stabilization.

Reference Frame field Displays the current reference frame. Non-editable.

Display Size field Displays the pixel width and height of track points. Editable.

Show Cloud button Enable to display the track point cloud.
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Delete and Update button Click to delete selected track points and update stabilization curves. Selected
points are displayed in red in the image.

Offset Settings

Position X field Displays the X-axis offset applied to the clip. Editable.

Position Y field Displays the Y-axis offset applied to the clip. Editable.

Rotation field Displays the rotation offset applied to the clip. Editable.

Scaling field Displays the scaling offsets applied to the clip. Editable.

Project X field Displays the X-axis projection offsets applied to the clip. Editable.

Project Y field Displays the Y-axis projection offsets applied to the clip. Editable.

Anamorphic field Displays the anamorphic offsets applied to the clip. Editable.

Shear field Displays the shearing offsets applied to the clip. Editable.

Rendering Settings

Repeat Mode box Select an option to fill the empty portions of the frame.

To:Select:

Repeats last pixel color.Repeat Last
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To:Select:

Wrap the image around to fill the area.Tile Repeat

Repeats the source pixels both vertically and horizontally.Mirror Repeat

Use a colour to fill the area. Use the adjacent colour pot to pick the colour. You will lose texture

and will fill the rest of the image with a black border.

Repeat Off

Resize Fit Mode box Select whether to resize the clip with width and height values.

To:Select:

The output resolution remains the same as the input resolution.Same as Input

You define the output resolution.Custom

Width field Displays the width of the image. Editable.

Height field Displays the height of the image. Editable.

Hardware Filtering button Enable to filter subpixel information.

Anti-Aliasing button Enable to activate sampling and softness.

Sampling box Select the number of samples to use in the anti-aliasing process.

Softness field Displays the level of softness of the samples. Editable.

Common

Clear Buffer button  Clears the Undo/Redo list of performed actions.

Use Proxies button  Enable to use proxy-sized clips instead of the resolution clip. Increases interactivity
performance.

Backup button Enable to automatically save backups of Tools data.

Tools Save field Displays the time delay for an automatic save when you are using a tool that you have
accessed from the Tool tab. Non-editable.

Append Type button  Appends the output type (Result or OutMatte) to the filenames of rendered clips.

Average
Use Average to simulate the motion blur of a moving object in a clip. An image averaging function is applied
to the frames to create the motion blur.
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To access the Average menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.

Average Menu Settings

The Average Node processes frames based on data from preceding and subsequent sample frames. A frame
set to No Media with missing media may include a sample.

General Settings

Average Over field Displays the number of frames used to calculate the average and create the transparency
for the motion blur effect. Editable.

Weighted/Uniform box Select whether to uniformly average surrounding frames or give frames closest to
the current frame a greater weight when calculating the transparency for the motion blur effect.

Frames box Select whether the blur is calculated from previous frames only or future frames as well.

Blend & Comp
Use Blend & Comp to apply basic blending and compositing between two inputs, and their mattes, over a
background.
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To access the Blend & Comp menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts up to two front and matte clips, as well as a back clip, and outputs a result and outmatte.
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Blend & Comp Menu Settings

General Settings

Blend Type box Select the set of blend mode operations available in the Blend Mode box.

Blend Mode box Select a blend operation. Options determined by Blend Type box.

Swap Inputs button Enable to switch the rendering order of the inputs.

Input Settings

NOTE Input 1 and 2 settings are identical. Activate and use based on inputs selected for Blend & Comp.

Active button Enable to activate the input.

Clamping box Select a clamping option.

Matte box Select how the matte is used when blending.

Pre-multiplication box Select whether the colour values in the input are pre-multiplied or divided from
the alpha, or left as-is when blending.

Transparency field Displays the transparency value. Editable.

Gain Trackball Adjusts the gain of the input.
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Saturation field Displays level of colour purity in the image. Editable.

Gamma field Displays the gamma level. Editable.

Offset field Displays a value that modifies all of the colour parameters. Editable.

Red Gain field Set the percentage of colour values in the red channel. Editable.

Green Gain field Set the percentage of colour values in the green channel. Editable.

Blue Gain field Set the percentage of colour values in the blue channel. Editable.

Luma Gain field Set the percentage of luma gain value to display. Editable.

Proportional button Enable to adjust the gain of the colour values proportionally.

Matte Blending Settings

Composition box Select how the input mattes are combined.

Correlation box Select whether the mattes are related to each other.For example, select Correlated if the
mattes are from different, but continuous parts on the same object.

Result Output Settings

Blend With box Select whether you want to blend the inputs with the second input clip, the background
clip or a colour.
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Blend Type box Select the set of blend mode operations available in the Blend Mode box.

Clamping box Select a clamping option.

Blend Mode box Select a blend operation. Options determined by Blend Type box.

Transparency field Displays the transparency value. Editable.

Gain Trackball Adjusts the gain of the input.

Saturation field Displays level of colour purity in the image. Editable.

Gamma field Displays the gamma level. Editable.

Offset field Displays a value that modifies all of the colour parameters. Editable.

Red Gain field Set the percentage of colour values in the red channel. Editable.

Green Gain field Set the percentage of colour values in the green channel. Editable.

Blue Gain field Set the percentage of colour values in the blue channel. Editable.

Luma Gain field Set the percentage of luma gain value to display. Editable.

Proportional button Enable to adjust the gain of the colour values proportionally.

Blur
Use Blur to apply and customize a blur filter to a clip.
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To access the Blur menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and a matte clip, and outputs a result and outmatte. The outmatte clip can have
a different level of blur than the result clip.

Blur Menu Settings

General Settings

Rendering box Select whether to render in Progressive or Interlaced mode.

Regen button Enable to get dynamic updating of the image as you make changes.

Setup Settings

Clamp Input button Enable to clamp colour and luminance values on input in the 16-bit floating point
rendering pipeline.

Clamp Render box Select a clamping option for colour and luminance values on output in the 16-bit floating
point rendering pipeline.

Blur Type Settings

Blur Type for Radial

Blur Type for Gaussian

Blur Type box Select the type or shape of blur filter to apply to the clip. Depending on the blur type, some
of the other blur settings may vary.

Bokeh Blur field Displays the amount of smoothness applied to sharp bokeh edges. This creates the blur
that is applied to out-of-focus points of light to simulate a shallow focus. Editable.

Bias field Displays the direction of a blur. Enter a positive value for forward, a negative value for backward,
or 0 for a blur that moves in both directions. Available when Directional or Radial Stamp is chosen as the
blur type.

Radial Mode box Select whether a radial blur or glow moves in one circular direction (Spin), or two rotating
directions (Twist). Available when Radial is chosen as the blur type.

906 | Chapter 22   Effects and Tools Reference



Samples field Displays the quality of a Radial Stamp blur or glow. Editable. Available when Radial Stamp is
chosen as the blur type.

Color Space Settings

Colour Space box Select whether to blur in RGB or YUV space. The Channels settings change to reflect this
setting.

Centre Settings (Radial Only)

Stabilizer button Opens the Stabilizer menu to track the centre of the blur from the source clip. See Tracking
(page 608) for more information.

Centre X field Displays the X position of the centre of the radial blur (or gesturally move the red circle in
the image). Editable.

Centre Y field Displays the Y position of the centre of the radial blur (or gesturally move the red circle in
the image). Editable.

NOTE You can also move the red circle on the image to set the position of the centre of the blur. The Centre X
and Y fields update accordingly.

Absolute/Relative box Select whether to position and offset the centre of the radial blur in a relative mode
(expressed as a percentage) or absolute mode (expressed in pixels).

Offset X field Offsets the centre along the X axis (or press Ctrl and gesturally move the red circle in the
image).This field is useful to apply changes to the centre after tracking has been performed. Editable.

Offset Y field Offsets the centre along the Y axis (or press Ctrl and gesturally move the red circle in the
image). This field is useful to apply changes to the centre after tracking has been performed. Editable.

NOTE You can also press Ctrland move the red circle on the image to set the offset of the centre blur.
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Front Settings

Width field Displays the width of the blur.Increasing the blur increases the render time. Editable.

Height field Displays the height of the blur.Increasing the blur increases the render time. Editable.

Proportional button Enable to affect the width and height proportionally.

Pixel Ratio button Enable to blur the image using the same proportion as its aspect ratio.

Gain field Displays a value by which pixel colour values are multiplied. The offset value is added to this
value to determine the final colour. Editable.

Offset field Displays the value to add to current pixel colour values. The resulting colour value is clipped
at 0. Editable.

Length field (Directional) Displays the radius amount of a directional blur. Editable.

Angle field (Directional) Displays the angle of a directional blur. Editable.

Amount field (Radial, Radial Stamp) Displays the amount of radial blur. Editable.

Rotation field (Radial, Radial Stamp) Displays the angle of rotation for a radial blur. Editable.

Blooming Settings (Defocus Only)

Basic/Additive Blooming button Switch between basic blooming and additive blooming bokeh effects.
The basic blooming mode displays the gain applied to highlights in non-HDR images, to allow the creation
of bokeh patterns without affecting colour integrity. The additive blooming mode allows you to create higher
intensity bokeh patterns from any source image, using minimum and maximum thresholds for highlight
segregation.

Basic Blooming field Displays the gain applied to highlights in non-HDR images, to allow the creation of
bokeh patterns without affecting colour integrity. This creates the glow effect that is applied to the bright
spots of the image to simulate light bleeding, or blooming, over the edges. Editable.

Additive Blooming field Displays the amount of high intensity bokeh patterns that can be created from
any source image generating extreme highlight content . Editable.

Additive Blooming minimum field Displays the minimum threshold for highlight segregation. Editable.

Additive Blooming maximum field Displays the maximum threshold for highlight segregation. Editable.
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Matte Settings

Matte Settings for DirectionalMatte Settings for Radial or Radial
Stamp

Matte Settings for Gaussian, Defocus,
or Box

Matte Width field Displays the width of the blur for the matte. Editable.

Matte Height field Displays the height of the blur for the matte. Editable.

Matte Length field Displays the radius amount of a directional blur for the matte. Editable.

Matte Angle field Displays the angle of a direction blur of the matte. Editable.

Matte Amount field Displays the amount of radial blur for the matte. Editable.

Matte Rotation field Displays the angle of rotation for a radial blur for the matte. Editable.

Lock To Front button Enable to keep the matte values the same as their corresponding values for the front
clip.

Invert Matte button Enable to blur the region outside the area defined by the matte.

Channel Settings

YUV Channels

RGB Channels

Weight field Displays the weighted value of the channel.

Position X field Displays the horizontal offset of the channel.

Position Y field Displays the vertical offset of the channel.
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YUV Colour box Select whether to affect Luma or Chroma only, or include both when blurring in YUV
colour space.

Blending Settings

Screen option box Select a logical operation that can be used to blend the front clip and the result clip.

Transparency field Displays the percentage of blending when the result is composited on the front clip.
Editable.

Use Matte button Enable to apply the blur with the areas defined by the matte.

Kernal Settings (Defocus Only)

The kernel is the defocus blur shape. The shape of the kernel is determined by its number of sides, its rotation,
and the shape of its S-curve. This curve represents the shape of the pattern, from its centre to the outside.
The default S-curve defines the softness of the blur. You can change the curve by manipulating the two
points that define the curve, or you can add points to the curve. Use the Edit Mode box to add and delete
points on the curve.

Sides field Displays the number of sides in the kernel shape. Editable, if kernel information is not attached
to the node.

Rotation field Displays the angle of rotation of the kernel shape. Editable, if kernel information is not
attached to the node.

Bokeh Type box Select whether to use a round or angle bokeh curve to define the kernel shape.

Curvature field Displays the amount of curvature applied to a round bokeh kernel shape. Editable.
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Bump Displace
Use the Bump Displace effect to create displacement-like emboss effects using light and surface bumps. You
can select Front or Front/ZDepth or Front/ZDepth/Matte from the Input Mode box.

To access the Bump Displace menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip and a displacement clip (usually a matte), and outputs a result.

Bump Displace Menu Settings

Bump Settings

Minimum Bumps field Displays the lower limit of the bump depth. Editable.

Maximum Bumps field Displays the upper limit of the bump depth. Editable.
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Bump Height field Displays the height value for the effect. Positive numbers create an embossed look.
Negative numbers create an engraved look. Editable.

Bump Softness field Displays a blurring value for the effect. Editable.

Light Settings

Light X Position field Displays the horizontal position of the light. Editable. You can also use the light icon
in the image window to change the position of the light.

Light Y Position field Displays vertical position of the light. Editable. You can also use the light icon in the
image window to change the position of the light.

Light Y Position field Displays the depth of the light. Editable. You can also use the light icon in the image
window to change the position of the light.

TIP You can also use the light icon in the image window to gesturally position the light.

Light Scale field Displays a value that you can modify to see the results of moving your light when using
extreme X, Y or Z values. Editable.

Shaded field Displays the level of intensity for the image. Editable.

Ambient field Displays the percentage of overall lighting for the image. Editable.

Threshold field Displays the percentage of bumps filtered out by using light exposure. Editable.

Red Light field Displays the red value of the light. Editable.

Green Light field Displays the green value of the light. Editable.

Blue Light field Displays the blue value of the light. Editable.

Light Colour Pot Displays the colour of the light. Click to open the Colour Picker and specify a value.

Texture Settings

Diffuse Gain field Displays a value for the contrast in the image. Use to increase or decrease the intensity
of highlights and shadows in surface features. Editable.

Shininess field Displays a value for the amount of shine in the image. Editable.

Specular field Displays a value for the reflectiveness of the image. Editable.
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RGB Distortion Settings

Red Distortion field Displays the amount of distortion in the red channel. Editable.

Green Distortion field Displays the amount of distortion in the green channel. Editable.

Blue Distortion field Displays the amount of distortion in the blue channel. Editable.

Repeat Mode Settings

Repeat Mode Settings  Select an option to fill the empty portions of the frame.

Anti-Aliasing Settings

Anti-aliasing button Enable to activate sampling and softness.

Sampling box Select the number of samples to use in the anit-aliasing process.

Softness field Displays the level of softness of the samples. Editable.

Burn-In Letterbox
Use Burn-In Letterbox to burn a letterbox into a clip.

To access the Burn-In Letterbox menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.
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This node accepts a front clip, and outputs a result.

Burn-In Letterbox Menu Settings

General Settings

Aspect Ratio box Select a preset or custom aspect ratio.

Offset field Displays the vertical offset. Drag left or right to apply the letterbox to a lower or higher portion
of the image. Editable.

Border colour pot View the current border colour. Editable.

Ratio field Displays the custom aspect ratio. Editable.

NOTE The Ratio field is only available when Custom is selected from the Aspect Ratio box.

Burn-In Timecode
Use Burn-In Timecode to burn-in clip information.

To access the Burn-In Timecode menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.
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Burn-In Timecode Menu Settings

General Settings

Text colour pot Select the current colour of burned-in text. Select to open the colour picker.

Shadow button Enable to add a drop shadow to burned-in information.

Shadow colour pot Displays the current shadow colour. Select to open the colour picker.

Background button Enable to display a rectangular background to burned-in text.

Background colour pot Displays the current background colour. Select to open the colour picker.

Font box Displays the font used for burned-in text.

Name field Displays the name of the clip. Click to enter new name or comment. Editable.

Scan Format box Select to scan a frame-based clip with or without interlacing, or use the scan format of
the front clip.

Offset box Select to display the burned in information within the full frame, or a safe area. This box is only
active when position is set using the Horizontal Position and Vertical Position boxes.

Horizontal Position box Select the horizontal placement of the burned-in text.

Horizontal Position field Set the position on the Y-axis. Drag left or right to move the text in the same
direction. Editable.

Vertical Position box Select the vertical placement of burned-in text.

Vertical Position field Set the position on the X-axis. Drag left or right to move the text up or down. Editable.

Size field Displays the font size of burned-in text. Drag left or right to decrease or increase the point size.
Editable.

Comments button Enable to include the current clip name or comment in burned-in text.

Frame Number button Enable to include the current frame number in burned-in text.

Frame Total button Enable to include the total number of frames in burned-in text.

Total Frames field Click to enter a value for the total number of frames in the clip. Editable.
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Date/Time button Enable to include the current date and time in burned-in text.

Keycode button Enable to include the keycode in burned-in text.

Keycode field Click to enter a keycode. Editable.

Source TC button Enable to include the source timecode in burned-in text.

Source TC field Click to enter a new source timecode. Editable.

Source TC Frame Mode box Select the style of source frame code notation.

Record TC button Enable to include the record timecode in burned-in text.

Record TC field Click to enter a new record timecode. Editable.

Record TC Frame Mode box Select the style of record frame code notation.

Clamp
Use the Clamp node to clamp 16-bit floating point OpenExr clips.

To access the Clamp menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

Clamp Menu Settings

General Settings

Out of Range box Select a curve that is constant (clamp) or clamps negative values below 0.

Color Corrector
About Colour Corrector

The Colour Corrector includes tools that provide precise control over colour values. You can modify luma
ranges in a clip (shadows, midtones, and highlights), sample colours, and adjust the colour balance. You
can rewire colour channels and suppress colours, as well as animate a colour correction by manipulating
the animation curve in the Channel Editor.
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Accessing the Colour Corrector

To access the Colour Corrector, you must load clips of the same resolution. If the clips you want to load
have different resolutions, resize them so that they have the same resolution.

You can load a front clip, a front and back clip, or a front, back, and matte clip for colour correction. Changes
in colour are applied to the front clip.

The Colour Corrector can be accessed from the following locations:
■ Timeline, then use a Colour Corrector timeline effect. (page 663)

■ Modular Keyer, Action, Paint tool. (page 664)

■ Timeline, then use ConnectFX. (page 664)

Colour Correct Menu Settings

Main Menu

Crop button Displays a crop box to view colour changes on a limited region of the clip.

Setup button Opens the Setup menu where you setup either Colour Correct or Colour Warper options.

Animation button Opens the Animation menu where you display the animation channel.

Master button Modifies the luma range for the entire image after individual range modifications.

Shadows button Modifies the luma range for the dark areas in the image.

Midtones button Modifies the luma range for the midlevel areas in the image.

Highlights button Modifies the luma range for the light areas in the image.

Regen button Enable to get dynamic updating of your colour corrections.

Rewire box Select an option to rewire the RGB channels of an image, or create a monochrome or negative
image.

Red Rewiring box Select a color or luma channel to replace the red values with the selected channel values.
Select 1-R to replace red values with its inverse values. Active when Master range is selected.

Green Rewiring box Select a color or luma channel to replace the green values of an image with its inverse
(1-R), red, blue, or luma values. Active when Master range is selected.

Blue Rewiring box Select a color or luma channel to replace the blue values of an image with its inverse
(1-R), red, green, or luma values. Active when Master range is selected.

Reset Basics Resets colour correction controls.

Hue field Displays the colour range. Editable.

Saturation field Displays level of colour purity in the image. Editable.

Pivot field Displays the percentage value of the colour range around which the contrast pivots. The default
value is 50% for integer input and 18% for floating point input. Editable.

Hue field Displays the colour range. Editable.

Gain field Drag left or right to increase or decrease light greys from the white area of the image.

RGB Gamma field Adjust the grey values. Editable.

Red Gamma field Adjust the grey values in the red channel. Editable.
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Green Gamma field Adjust the grey values in the green channel. Editable.

Blue Gamma field Adjust the grey values in the blue channel. Editable.

RGB Gain field Set the percentage of original colour values to use in the image. Editable.

Red Gain field Set the percentage of colour values in the red channel to display in the image. Editable.

Green Gain field Set the percentage of colour values in the green channel to display in the image. Editable.

Blue Gain field Set the percentage of colour values in the blue channel to display in the image. Editable.

RGB Offset field Adjust the colour values by adding an offset value. Editable.

Red Offset field Adjust the colour values in the red channel by adding an offset value. Editable.

Green Offset field Adjust the colour values in the green channel by adding an offset value. Editable.

Blue Offset field Adjust the colour values in the blue channel by adding an offset value. Editable.

Contrast field Adjust the gradations between the light and dark areas in the image. Editable.

Red Contrast field Adjust the gradations between the light and dark areas in the red channel of image.
Editable.

Green Contrast field Adjust the gradations between the light and dark areas in the green channel of image.
Editable.

Blue Contrast field Adjust the gradations between the light and dark areas in the blue channel of image.
Editable.

Red Suppression button Enable to suppress red colour values in the image.

Green Suppression button Enable to suppress green colour values in the image.

Blue Suppression button Enable to suppress blue colour values in the image.

Cyan Suppression button Enable to suppress cyan colour values in the image.

Magenta Suppression button Enable to suppress magenta colour values in the image.

Yellow Suppression button Enable to suppress yellow colour values in the image.

Front colour patch Displays colour sampled from the front clip.

Result colour patch Displays the result of front clip colour correction.

Back colour patch Displays colour sampled from the back clip.

Sampling box Select the type of colour values to display for sampled colours.

Sample Data Type box Select the type of measurement to use for RGB values of sampled colours.

Histogram Menu

Histogram tab Displays the Histogram menu where you adjust the red, green, blue, and luminance channels
of the image.

Histogram Displays a bar graph that is used to adjust the luminance values of the image. In the Ranges
menu, the curves for the three luma ranges are also displayed.

Minimum Input field Displays the lower limit of the luminance values. Pixels with lower values are mapped
to black.

Minimum Output field Displays the lower limit of the luminance values for black pixels.
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Maximum Input field Displays the upper limit of the luminance values. Pixels with higher values are
mapped to white.

Maximum Output field Displays the upper limit of the luminance values for white pixels.

Channel Selection box Select the luminance or an RGB channel to extract its values for the key.

Out Range box Select a curve that is constant (Clamp) or linear (No Clamp) before the first point of the
curve and after the last point of the curve.

When using 16-bit floating point images, you can select Clamp to clamp colour and luminance values, or
No Clamp to allow pixel floating point values to be less the 0 or more than 1.

Frame Selection box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Source button Enable to show a histogram of the source colour values.

The source colour values are obtained from the current frame. If you input both front and matte clips, the
colour values in the front clip that are defined by the white part of the matte are displayed.

Source View box Select whether to display all RGB Source histograms or only the histogram you are working
on (Mono).

Destination button Enable to show a histogram of the colour values in the result or destination clip.

The destination colour values are obtained from the current frame. If you input both front and matte clips,
the colour values in the front clip that are defined by the white part of the matte are displayed.

Destination View box Select whether to display all RGB Destination histograms or only the histogram you
are working on (Mono).

When viewing the Source and Destination histograms at the same time in Mono mode, the Destination
histograms are lighter; in RGB mode, the Destination histograms are displayed with a white outline.

Reset button Resets to default histogram settings.

Zoom field Displays the vertical zoom value of the histogram.

You can also zoom horizontally by pressing Ctrl+spacebar and dragging left or right in the histogram.
To pan horizontally, click spacebar and drag left or right in the histogram.

Curves Menu

Curves tab Displays the Curves menu to display luminance and RGB curves.

Curves Display the curves for the luminance and each RGB channel.

Home button Restores the position of panned or zoomed curves to the default setting.

Move button This setting is available when you access the Colour Corrector via the Timeline. Select an
option to work directly in the image window or schematic.

Match button Matches colours in the front and back colour patches, and assigns a number to the current
match.

Match field Displays which match is currently displayed.

ReMatch button Overrides the selected match operation with current settings.

Out Range box Select a curve that is constant (Clamp) or linear (No Clamp) before the first point of the
curve and after the last point of the curve.

Reset button Resets to default curve settings.
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Ranges Menu

Ranges tab Displays the HLS Ranges menu where you can adjust highlight, midtone, and shadow ranges.

Reset button Resets to default histogram and curve settings.

Setup

Border button Enable to display a crop box border.

Border colour pot Displays the border colour. Editable.

Top field Displays the position for the top of the crop box. Editable.

Bottom field Displays the position for the bottom of the crop box. Editable.

Left field Displays the position for the left side of the crop box. Editable.

Right field Displays the position for the right side of the crop box. Editable.

Invert Matte button Enable to colour correct the region outside the area defined by the matte.

Background field Displays the background brightness value. Editable

Colour Curves
Use Colour Curves to access a clip's colour menu, remove colour spill from a front clip, and perform a hue
shift.

To access the Colour Curves menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.
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Colour Curves Menu Settings

General Settings

Curve Channel button Enable this button to select the colour curve for a specific channel. Only one Curves
button can be enabled at a time. Each Curves button is active when you modify its curve in the graph.

Hue colour pot Displays the colour to shift toward when the curve is modified. Editable.

Suppression colour pot Displays the colour to suppress in the clip. Editable.

Home button Reverts to the original view.

Reset box Resets the curve view.

Set Key button Sets a keyframe at the selected frame.

Delete Key button Deletes the selected keyframe.

Reset Key button Resets the curve at the selected keyframe.

Color Warper
About the Colour Warper

When you colour correct an image or clip, use the Colour Warper to perform advanced colour corrections
and create artistic colour effects. The way in which you approach these tasks depends on your goal, the
number of clips you are using, and the type of clips being used.

Clips created from source material shot with the same camera equipment under the same lighting conditions
may be colour corrected quickly and easily to correct lighting and colour imbalances. Clips created from
source material shot at different times of the day, in different seasons, at different locations, or using different
equipment require more work. With the Colour Warper, you can manipulate colours with precision and
ease, working on the entire clip as you would with traditional tools or working with a matte to adjust a range
of colour in the clip.

Use the Colour Warper to gesturally set black and white levels, adjust specific colours and colour ranges,
and accurately match colours in one clip to another. You can also perform hue shifts and suppress colour
to remove colour spill or create visual effects such as a colour cast. While you manipulate the colour content
of a clip, you can monitor reference clips as well as changes in the colour distribution to ensure that you
achieve the result you want. Original data is always preserved, so you can adjust colours without the risk of
permanently losing colour information.
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When working with 16-bit floating point images in the Colour Warper, you can plot colours outside of the
0 to 1 range. Even when working with integer images, clamped colour information (colours that go beyond
the RGB range) can be retrieved using the Colour Warper controls.

(a) Clamped colour

(a) Colour information restored

Accessing the Colour Warper

Use the Colour Warper to modify the colour content in your clips. You can manipulate colour content with
intuitive controls that provide precise colour correction, and view histograms that help you visualize your
image's colours. You can also output a matte corresponding to selected colours.

You can access the Colour Warper as a ConnectFX node that you drag and drop into the process tree or the
Modular Keyer's processing pipeline. Access the Colour Warper from the Modular Keyer to remove colour
spill, or access it from ConnectFX to modify the colour content of your clips.

The Colour Warper can be accessed from the following locations:
■ The Timeline, using a Colour Correct timeline effect. (page 694)

■ Modular Keyer, Action or Paint.  (page 694)

■ ConnectFX.  (page 695)
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When working with large images, you can free up additional screen space with the Overlay user interface.
This feature is exclusive to the Colour Corrector and the Colour Warper. The Colour Warper's Overlay user
interface is not available when accessing the Colour Warper as a ConnectFX node.

For details on using the Overlay user interface, see Overlay User Interface (page 665).

You can access the following menus from the Colour Warper menu.

NOTE If you are accessing the Colour Warper from ConnectFX or the Modular Keyer, you use the Setup menu
for the node to adjust vectorscope and hue cube settings, as well as update colour information. You cannot use
the Setup menu for the node to crop the colour correction area or invert a matte.

Color Warper Menu Settings

Colour box Select whether to open the Colour Corrector or the Colour Warper.

Basics button Opens the Basics menu where you perform basic colour correction, warping, suppression and
saturation of your clips.

Subsetups button Opens the menu where you store, compare, and share Colour Warper subsetups.

Basics Menu

Colour correct your clips. You can adjust shadows, midtones, and highlights, and control black and white
levels, hue, and saturation. You can also perform colour warping, colour suppression, and colour saturation
on a limited range of colour as well as adjust gamma and luminance curves.

Home button Positions a vectorscope at its default location and size.

Scope button Enable to display a 2D or 3D vectorscope in the Result view.

Work On box Select an option to apply colour corrections to all or part of an image. Select Master to apply
colour corrections to the entire image or select a selective to generate a matte and perform selective colour
correction.

Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Selective View box Select whether to view the matte, selective, or result image.

Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Black field Displays the luminance value in the image shadows without affecting the chrominance values.
Editable.

White field Displays the luminance value in the image highlights without affecting the chrominance values.
Editable.

Hue field Displays the luminance value in the image shadows without affecting the chrominance values.
Editable.

Saturation field Displays the global saturation value. Editable.

Red Gamma field Displays the gamma level in the red channel.

Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Green Gamma field Displays the gamma level in the green channel.
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Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Blue Gamma field Displays the gamma level in the blue channel.

Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Select button Activates the pick cursor. Use to sample an area to adjust. Activate the cursor again and select
the area to match.

Plot button Activates the pick cursor. Use to sample an area to display its result clip colour value.

Ref button Activates the pick cursor. Use to sample an area to display its reference clip colour value.

Trackball option box Select a method of adjustment for a range of colour.

Luma field Displays the luminance of the destination colour. Editable.

Edit Mode box Select an edit mode to work with.

Home button Restore the histogram to its default zoom and pan settings.

Clear /Reset box Select whether to clear the value at the current frame or reset the value for the entire
animation curve.

Source button Enable to show a histogram of the colour values in the front, or source clip.

Destination button Enable to show a histogram of the colour values in the result clip.

Zoom field Displays the zoom ratio of the histogram. Editable.

Selective menu

Define colour ranges using softness and tolerance to create a matte and apply colour correction to a selected
region.

1 Enable to apply the matte for Selective 1 to the result.

2 Enable to apply the matte for Selective 2 to the result.

3 Enable to apply the matte for Selective 3 to the result.

Invert button Enable to invert the matte or selective.

Gaussian button Enable to apply a Gaussian blur to the matte. Disable to apply a box blur.

X field Displays the width of the blur. Editable.

Y field Displays the height of the blur. Editable.

Pick Custom button Define the tolerance range based on a sample from the image. Drag the cursor over
the image to define initial tolerance.

Red button Define the tolerance range based on the red channel.

Green button Define the tolerance range based on the green channel.

Blue button Define the tolerance range based on the blue channel.

Cyan button Define the tolerance range based on the cyan channel.

Magenta button Define the tolerance range based on the magenta channel.

Yellow button Define the tolerance range based on the yellow channel.

Shadows button Define the tolerance range based on the dark areas in the image.
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Midtones Define the tolerance range based on the midlevel areas in the image.

Highlights button Define the tolerance range based on the light areas in the image.

Adjusting box Select Tolerance to add tolerance to the matte, +Softness to add softness to the matte, or
-Softness to remove softness from the matte.

Sharpness field Displays the percentage of sharpness of the matte. Editable.

Tolerance button Enable to apply the grey tolerance indicator on the hue cube.

Softness button Enable to apply the black softness indicator on the hue cube.

Move/Zoom box Select Move to adjust the softness and tolerance by moving the handles on the hue cube
or Zoom to zoom in by dragging on the cube.

Low Softness field Displays the minimum value for the softness range. Editable.

Low Tolerance field Displays the minimum value for the tolerance range. Editable.

High Tolerance field Displays the maximum value for the tolerance range. Editable.

High Softness field Displays the maximum value for the softness range. Editable.

Frame Options box Select Home to return the hue cube to its default position, Plot Colour to enlarge the
gradient to include the plot and reference colours, or Autoframe to view the complete gradient range.

Reset box Select CW to reset the Colour Warper, CC to reset the Colour Corrector, or Reset All to restore
all default settings.

Auto Key button Set keyframes automatically when changes are made to a frame.

Gamma Options

RGB button Enable to display the RGB gamma curve.

Red button Enable to display the red gamma curve.

Green button Enable to display the green gamma curve.

Blue button Enable to display the blue gamma curve.

Luminance button Enable to display the luminance curve.

Warp Options

Source colour pot Displays the colour you want to modify. Editable.

Destination colour pot Displays the corrected colour.

Subsetups Menu

Store, compare, and share Colour Warper subsetups.

Current button Access the most recently committed setup.

Load button Open the file browser to load a group of subsetups within a directory.

Save button Open the file browser to save active subsetups in a specific directory.

Subsetup A LED button Indicates the subsetup is stored.

Subsetup A button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.
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Subsetup B LED button Indicates the subsetup is stored.

Subsetup B button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup C LED button Indicates the subsetup is stored.

Subsetup C button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup D LED button Indicates the subsetup is stored.

Subsetup D button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup E LED button Indicates the subsetup is stored.

Subsetup E button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup F LED button Indicates the subsetup is stored.

Subsetup F button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup G LED button Indicates the subsetup is stored.

Subsetup Gbutton Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup H LED button Indicates the subsetup is stored.

Subsetup H button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup I LED button Indicates the subsetup is stored.

Subsetup I button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Subsetup J LED button Indicates the subsetup is stored.

Subsetup J button Apply an active subsetup to the current frame. Hold down to replace an existing subsetup.

Name field Displays the name of the subsetup. Editable.

Setup Menu

Customize your work environment by adjusting vectorscope and hue cube settings, updating colour
information, cropping the area you want to colour correct, and inverting a matte.

Scope box Displays the vectorscope you want to use to view the clip.

Canvas button Enable to show the vectorscope canvas. When the canvas is off, the vectorscope is transparent,
but can be outlined.

Lines button Enable to show the vectorscope outline.

Bars box Select the SMPTE bars setting for the 2D vectorscope.
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Size box Select the size of the coloured squares or cubes that make up the histogram.

Clear Buffer button Clears the Undo buffer of all previous undo operations.

Levels field An upper limit for the number of undo or redo operations. Editable.

Coloured Frame
Use Coloured Frame to generate a colour bar, noise, gradient, or colour clip that can be used as the clip for
other nodes.

To access the Coloured Frame menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node outputs a result.

The Coloured Frame node includes eight colour pots for storing and selecting customized colours for creating
frames. You can specify a frame's resolution and bit depth.

Coloured Frame Menu Settings

General Settings

Source Type box Select whether to generate frames of solid colour, noise, or colour bars.

Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.
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Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Frame Depth box Select the render/output frame depth of clips.

Scan Mode box Select the scan mode of clips.

Current Colour bar Displays the pattern applied to the colour source.

Luminance box Select whether to apply 75% or 100% luminance to the colour frames.

Combine
Use Combine to combine the individual color space channels of three different source clips (RGB, YUV, or
HSL).

To access the Combine menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front, back and matte clip, and outputs a result.

Combine Menu Settings

General Settings

Colour Space Type box Select which type of colour space to combine.

Compound
Use Compound to combine the contents of several frames into a single frame.

To access the Compound menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.
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This node accepts a front clip, and outputs a result.

Compound Menu Settings

General Settings

First Rendered Frame field Displays the first frame at which output is rendered from the node. Unrendered
output does not display any media.Editable.

Compound Over field Displays the number of frames that are combined into one frame. Editable.

Damage
Use Damage to apply a large variety of film or video degradation effects to a clip.

To access the Damage menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.
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This node accepts a front clip, and outputs a result.

Damage Menu Settings

General Settings

Damage Type box Select an option for the media type of damage effects to use. Selecting one of the effects
groups from the Damage Type box will display a menu of options for this effect.

Random Seed field Displays the number used to generate random variations in the damage effects. Editable.

Timing Offset field Displays the number used for timing offset in the damage effects. Editable.

Damage Effect buttons Enable to display options for an effect. Click LED to switch between On (blue) and
Off (grey).

Film Settings

Use the Film Damage effects to apply a large variety of film degradation effects to a clip.
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When you select Film from the Damage type box, the Film Damage Effects are displayed, along with the
most useful adjustment box to the right of each.

Blotches Settings

Blotches button Use this effect to simulate blotches on old film.
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Blotch Amount field Displays the amount of blotches applied to the image. Editable.

Blotch Transparency field Displays the percentage of transparency applied to the blotches. Editable.

Blotch Transparency Variation field Displays the percentage of variation for the transparency applied to
the blotches. Editable.

Blotch Size field Displays the average size of the blotches. Editable.

Blotch Size Variation field Displays the percentage of variation in the size of the blotches. Editable.

Blotch Softness field Displays the percentage by which the blotches are out of focus. Editable.

Blotch Negative Mix field Displays the amount of negative blotches in the mix. Editable.

Blotch colour pot Displays the tint applied to the blotches in the image. Editable.

Colour Settings

Colour button Use this effect to simulate colour fading and variation in old film.

Colour Gain trackball Drag to adjust the colour gain. This is an alternate control combining the Red Gain,
Green Gain, Blue Gain, and Luma fields.

Colour Saturation field Displays the level of colour purity in the image. Editable.

Colour Gamma field Displays the amount of gamma correction applied to the image. Editable.
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Colour Offset field Displays the amount by which all the colour parameters are modified. Editable.

Red Gain field Displays the amount of gain applied to the red channel. Editable.

Green Gain field Displays the amount of gain applied to the green channel. Editable.

Blue Gain field Displays the amount of gain applied to the blue channel. Editable.

Luma field Displays the amount of gain applied to the luminance channel. Editable.

Proportional button Enable to synchronize changes in red, green, blue, and luma channels.

Hue field Displays the colour range. Editable.

Shadows colour pot Displays the tint applied to shadows in the image. Editable.

Highlights colour pot Displays the tint applied to highlights in the image. Editable.

Minimum Colour Value field Displays the luminance value in the image shadows. Editable.

Maximum Colour Value field Displays the luminance value in the image highlights. Editable.

Dust Settings

Dust button Use this effect to simulate dust particles on old film.

Dust Amount field Displays the amount of dust particles applied to the image. Editable.

Dust Transparency field Displays the percentage of transparency applied to the dust particles. Editable.

Dust Transparency Variation field Displays the percentage of variation in transparency applied to the dust
particles. Editable.

Dust Size field Displays the average size of the dust particles. Editable.

Dust Size Variation field Displays the percentage of variation applied to the size of the dust particles.
Editable.

Dust Softness field Displays the percentage by which the dust is out of focus. Editable.

Dust Negative Mix field Displays the amount of negative dust particles in the mix. Editable.

Dust colour pot Displays the tint applied to the dust particles in the image. Editable.
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Grain Settings

Grain button Use this effect to simulate grain on old film.

Grain Coloured button Enable for the grain to be coloured. Disable for the grain to be monochrome.

Grain Transparency field Displays the percentage of transparency applied to the grain. Editable.

Grain Blur field Displays the amount of blur applied th the grain. Editable.

Grain Width field Displays the width of the grain in pixels. Editable.

Grain Height field Displays the height of the grain in pixels. Editable.

Grain Proportional button Enable to effect the width and height proportionally. Editable.

Scratches Settings

Scratches button Use this effect to simulate scratches in old film.

Scratch Amount field Displays the amount of scratches applied to the image. Editable.

Scratch Width field Displays the average width of the scratches. Editable.

Scratch Width Variation field Displays the percentage of variation in the width of the scratches. Editable.

Scratch Length field Displays the average length of the scratches. Editable.

Scratch Length Variation field Displays the percentage of variation in the length of the scratches. Editable.

Scratch Transparency field Displays the transparency of the scratches. Editable.

Scratch Discontinuity field Displays the percentage of gaps that occur in the scratches. Editable.

Scratch Roughness field Displays the amount of irregularities and changes in alignment of the scratches.
Editable.

934 | Chapter 22   Effects and Tools Reference



Scratch Negative Mix field Displays the amount of negative scratches in the mix. Editable.

Scratch colour pot Displays the tint applied to the scratches. Editable.

Scratch Travel field Displays the amount in pixels that the scratches move along. Editable.

Scratch Travel Variation field Displays a percentage of variation that the scratches travel. Editable.

Scratch Angle Variation field Displays the angle at which the scratches occur. Editable.

Scratch Spread field Displays the area of the frame over which the scratches are spread. Editable.

Scratch Horizontal Offset field Displays the horizontal offset of the scratches. Editable.

Scratch Duration field Displays the duration in frames of the scratch effect. Editable.

Scratch Duration Variation field Displays the variation in duration for the scratch effects. Editable.

Splices Settings

Splices button Use this effect to simulate splices on old film.
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Splice Auto box Select whether the splice occurs automatically or is manually inserted. Select Manual to
display the Create Splice and Delete Splice buttons.

Splice Type box Select what kind of splice to be applied to the image.

Splice Border Width field Displays the width of the splice border. Editable.

Splice colour pot Displays the colour used for the splice effects. Editable.

Splice Projector Roll field Displays the amount of space that the frame will travel as a percentage. Editable.

Splice Motion Blur field Displays the amount of motion blur applied to the splice effects. Editable.

Splice Jitter field Displays the amount of jitter applied to the splice effects. Editable.

Splice Defocus field Displays the amount of defocus applied to the splice effects. Editable.

Splice Spacing field Displays the spacing in frames between splice effects. Editable.

Splice Spacing Variation field Displays the percentage of variation in spacing between splice effects. Editable.

Splice Duration field Displays the duration in frames of the splice effects. Editable.

Splice Duration Variation field Displays the percentage of variation in duration for the splice effects.
Editable.
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Create Splice button Creates a splice at the current frame. Available when Splice Auto is set to Manual.

Delete Splice button Deletes the splice at the current frame. Available when Splice Auto is set to Manual.

Defocus Settings

Defocus button Use this effect to simulate projection defocus on old film.

Defocus Amount field Displays the amount of defocus applied to the image. Editable.

Defocus Amount Variation field Displays the percentage of variation in the amount of defocus applied to
the image. Editable.

Defocus Spacing field Displays the spacing in frames between defocus effects. Editable.

Defocus Spacing Variation field Displays the percentage of variation in the spacing between defocus effects.
Editable.

Defocus Duration field Displays the duration in frames of the defocus effects. Editable.

Defocus Duration Variation field Displays the percentage of variation in duration for the defocus effects.
Editable.

Flicker Settings

Flicker button Use this effect to simulate frame flicker on old film.

Damage | 937



Flicker Amount field Displays the amount of flicker added to the image. Editable.

Flicker Amount Variation field Displays the percentage of variation in the amount of flicker added to the
image. Editable.

Flicker Balance field Displays the ratio of dark and bright flickers used for the effect. Editable.

Flicker Spacing field Displays the spacing in frames between flicker effects. Editable.

Flicker Spacing Variation field Displays the percentage of variation in the spacing between flicker effects.
Editable.

Flicker Duration field Displays the duration in frames of the flicker effects. Editable.

Flicker Duration Variation field Displays the percentage of variation in duration for the flicker effects.
Editable.

Hairs Settings

Hairs button Use this effect to simulate hairs on old film.

Hair Amount field Displays the amount of hairs applied to the image. Editable.

Hair Transparency field Displays the transparency applied to the hairs. Editable.

Hair Transparency Variation field Displays the percentage of variation in transparency applied to the hairs.
Editable.

Hair Size field Displays the average size of the hairs. Editable.

Hair Size Variation field Displays the percentage of variation in size of the hairs. Editable.

Hair Jitter field Displays the amount of jitter applied to the hairs. Editable.

Hair Softness field Displays the percentage by which the hair is out of focus. Editable.
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Hair Duration field Displays the duration in frames of the hair effects. Editable.

Hair Duration Variation field Displays the percentage of variation in duration for the hair effects. Editable.

Jitter Settings

Jitter button Use this effect to simulate projection jitter on old film.

Jitter X Amount field Displays the amount of horizontal movement applied to the jitter effect. Editable.

Jitter Y Amount field Displays the amount of vertical movement applied to the jitter effect. Editable.

Jitter Amount Variation field Displays the percentage of variation applied to the movement of the jitter
effect. Editable.

Jitter Spacing field Displays the spacing in frames between jitter effects. Editable.

Jitter Spacing Variation field Displays the percentage of variation in the spacing between jitter effects.
Editable.

Jitter Duration field Displays the duration in frames of the jitter effects. Editable.

Jitter Duration Variation field Displays the percentage of variation in duration for the jitter effects. Editable.

Vignette Settings

Vignette button Use this effect to simulate vignetting on old film.
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Vignette Scale field Displays the size of the vignette effect compared to the size of the frame. Editable.

Vignette Ratio field Displays the ratio of width to height of the vignette effect. Editable.

Vignette Transparency field Displays the amount of transparency applied to the vignette effect. Editable.

Vignette Softness field Displays the amount of softness added to the edge of the vignette effect. Editable.

Analog Video Settings

Use the Analog Video Damage effects to apply a large variety of analog video degradation effects to a clip.

When you select Analog Video from the Damage type box, the Analog Video Damage Effects are displayed,
along with the most useful adjustment box to the right of each.
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Analog Drop Settings

Analog Drops button Use this effect to simulate analog drops causing noise or shash when playing back
old tapes on VTRs. .

Drop Type box Select an option for the type of noise.

Drop Amount field Displays the amount of shash applied to the image. Editable.

Drop Amount Variation field Displays the percentage of variation in the amount of shash applied to the
image. Editable.

Drop Transparency field Displays the percentage of transparency applied to the shash. Editable.

Drop Transparency Variation field Displays the percentage of variation in the transparency applied to the
shash. Editable.
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Drop Type Variation field Displays the percentage of variation applied to the drop type. Editable.

Distortion Settings

Distortion button Use this effect to simulate edge distortion when playing back old tapes on VTRs.

Edge Distortion Amount field Displays the amount of edge distortion applied to the image. Editable.

Edge Distortion Amount Variation field Displays the percentage of variation in the amount of edge
distortion. Editable.

Edge Distortion Transparency field Displays the percentage of transparency applied to the edge distortion
effect. Editable.

Edge Distortion Transparency Variation field Displays the percentage of variation in transparency applied
to the edge distortion effect. Editable.

Edge Distortion Coverage field Displays the percentage of vertical spread for the edge distortion effect.
Editable.

Edge Distortion Scale field Displays the size scaling applied to the edge distortion effect. Editable.

Edge Distortion Vertical Offset field Displays the vertical offset applied to the edge distortion effect.
Editable.

Edge Distortion Speed field Displays the speed at which the edge distortion effect moves across the image.
Editable.

Edge Distortion Speed Variation field Displays the percentage of variation in the speed at which the edge
distortion effect moves. Editable.

Edge Distortion Speed Variation Period field Displays the time period in frames within which the speed
variation occurs. Editable.

Interference Settings

Interference button Use this effect to simulate electromagnetic Interference when playing back old tapes
on VTRs.
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Interference Amount field Displays the amount of electromagnetic interference applied to the image.
Editable.

Interference Transparency field Displays the percentage of variation in the amount of electromagnetic
interference applied to the image. Editable.

Interference Coverage field Displays the percentage of vertical spread applied to the electromagnetic
interference effect. Editable.

Interference Scale field Displays the scaling applied to the electromagnetic interference effect. Editable.

Interference Vertical Offset field Displays the vertical offset applied to the electromagnetic interference
effect. Editable.

Interference Spacing field Displays the spacing in frames between electromagnetic interference effects.
Editable.

Interference Spacing Variation field Displays the percentage of variation in spacing between electromagnetic
interference effects. Editable.

Interference Duration field Displays the duration in frames of the electromagnetic interference effects.
Editable.

Interference Duration Variation field Displays the percentage of variation in duration for the electromagnetic
interference effects. Editable.

Lines Settings

Lines button Use this effect to simulate ones caused by noise artifacts when playing back old tapes on VTRs.
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Lines Distance Amount field Displays the amount of distance between the noise artifact lines applied to
the image. Editable.

Lines Jittering Amount Variation field Displays the percentage of variation in the jitter applied to the
lines. Editable.

Lines Transparency field Displays the percentage of transparency applied to the noise artifact lines. Editable.

Lines Transparency Variation field Displays the percentage of variation in the transparency of the lines.
Editable.

Lines Angle field Displays the angle of the noise artifact lines. Editable.

Lines Speed field Displays the speed at which the noise artifact lines move around. Editable.

Lines Speed Variation field Displays the percentage of variation in the speed of the noise artifact lines.
Editable.

Lines Speed Variation Period field Displays the time period in frames within which the noise artifact lines
occur. Editable.

Play Effects Settings

Play Effects button Use this effect to simulate play effects caused by misaligned or dirty tape heads when
playing back old tapes on VTRs.
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Play Effects Amount field Displays the amount of play effects added to the image. Editable.

Play Effects Speed field Displays the speed at which the play effects occur. Editable.

Play Effects Freeze field Displays the number of repeat frames added to create a jerky play effect. Editable.

Play Effects Spacing field Displays the spacing in frames between play effect errors. Editable.

Play Effects Spacing Variation field Displays the percentage of variation in spacing between play effect
errors. Editable.

Play Effects Duration field Displays the duration in frames of the play effect errors. Editable.

Play Effects Duration Variation field Displays the percentage of variation in duration of the play effects.
Editable.

Vertical Offset Settings

Vertical Offset button Use this offset to simulate vertical rolls when playing back old tapes on VTRs.

Vertical Offset Roll Amount field Displays the amount of vertical roll applied to the image. Editable.

Vertical Offset Roll Amount Variation field Displays the percentage of variation in the amount of the
vertical roll. Editable.

Vertical Offset Jitter field Displays the amount of jitter applied to the vertical roll. Editable.

Vertical Offset Border Width field Displays the width of the vertical roll border. Editable.

Vertical Offset Border Artifacts field Displays the amount of artifacts within the vertical roll border. Editable.
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Vertical Offset Spacing field Displays the spacing in frames between vertical roll errors. Editable.

Vertical Offset Spacing Variation field Displays the percentage of variation in spacing between vertical
roll errors. Editable.

Vertical Offset Duration field Displays the duration in frames of the vertical roll errors. Editable.

Vertical Offset Duration Variation field Displays the percentage of variation in duration for the vertical
roll errors. Editable.

Blur Settings

Blur button Use this effect to simulate blur from poor signal reception.

Blur Amount field Displays the amount of blurring added to the image. Editable.

Blur Amount Variation field Displays the percentage of variation in the amount of the blur effect. Editable.

Colour Settings

Colour button Use this effect to simulate analog colour degradation, shift and variations from poor signal
reception.

Analog Colour Degrade Amount field Displays the amount of colour degradation applied to the image.
Editable.

Analog Colour Degrade Amount Variation field Displays the percentage of variation in the amount of
the colour degradation. Editable.
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Analog Colour Contrast Transparency field Displays the amount of contrast applied to the image. Editable.

Analog Colour Brightness Transparency Variation field Displays the amount of brightness applied to the
image. Editable.

Analog Colour Saturation field Displays the amount of colour saturation applied to the image. Editable.

Analog Colour Shadows colour pot Displays the tint applied to shadows in the image. Editable.

Analog Colour Highlights colour pot Displays the tint applied to highlights in the image. Editable.

Analog Colour Red Channel Gain field Displays the amount of gain applied to the red channel. Editable.

Analog Colour Green Channel Gain field Displays the amount of gain applied to the green channel.
Editable.

Analog Colour Blue Channel Gain field Displays the amount of gain applied to the blue channel. Editable.

Analog Colour Red Channel X Shift field Displays the amount of horizontal offset applied to the red
channel. Editable.

Analog Colour Green Channel X Shift field Displays the amount of horizontal offset applied to the green
channel. Editable.

Analog Colour Blue Channel X Shift field Displays the amount of horizontal offset applied to the blue
channel. Editable.

Analog Colour Red Channel Y Shift field Displays the amount of vertical offset applied to the red channel.
Editable.

Analog Colour Green Channel Y Shift field Displays the amount of vertical offset applied to the green
channel. Editable.

Analog Colour Blue Channel Y Shift field Displays the amount of vertical offset applied to the blue channel.
Editable.
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Ghosting Settings

Ghosting button Enable to simulate ghosting from poor signal reception.

Ghosting Amount field Displays the number of repeated ghost images applied to the original image. Editable.

Ghosting Amount Variation field Displays the percentage of variation in the number of ghost images.
Editable.

Ghosting Transparency field Displays the percentage of the transparency applied to the ghosted images.
Editable.

Ghosting Transparency Variation field Displays the percentage of variation in the transparency of the
ghosted images. Editable.

Ghosting Distortion field Displays the amount of distortion applied to the ghosted images. Editable.

Ghosting Scale field Displays the amount of scaling applied to the ghosted images. Editable.

Ghosting Angle field Displays the angle applied to the ghosted images. Editable.

Ghosting Colour Degradation field Displays the amount of colour degradation applied to the ghosted
images. Editable.

Ghosting Spacing field Displays the spacing in frames between ghosting errors. Editable.

Ghosting Spacing Variation field Displays the percentage of variation in spacing between ghosting errors.
Editable.

Ghosting Duration field Displays the duration in frames of the ghosting errors. Editable.

Ghosting Duration Variaton field Displays the percentage of variation in the duration of ghosting errors.
Editable.

Scanlines Settings

Scanlines button Use this effect to simulate scanlines from poor signal reception.
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Scanlines Scale field Displays the size of the scanlines applied to the image. Editable.

Scanlines Variation field Displays the percentage of variation in the size of the scanlines. Editable.

Scanlines Variation Speed field Displays the speed at which the scanline variation occurs. Editable.

Scanlines Transparency field Displays the percentage of transparency applied to the scanlines.

Scanlines Vertical Offset field Displays the vertical offset for the scanline effect. Editable.

Scanlines Softness field Displays the amount of softness applied to the scanlines. Editable.

Scanlines Angle field Displays the angle at which the scanlines occur. Editable.

Snow Settings

Snow button Enable to simulate snow from poor signal reception.

Snow Amount field Displays the amount of snow applied to the image. Editable.

Snow Amount Variation field Displays the percentage of variation in the amount of snow applied to the
image.

Snow Transparency field Displays the percentage of transparency or softness, applied to the snow. Editable.

Snow Transparency Variation field Displays the percentage of variation in the transparency or softness,
applied to the snow. Editable.

Snow Sparseness field Displays the density of the snow. Editable.

Snow Width field Displays the width in pixels of the snow particles. Editable.

Snow Height field Displays the height in pixels of the snow particles. Editable.

Snow Proportional button Enable to effect the width and height proportionally. Editable.

TV Distort Settings

TV Distort button Use this effect to simulate TV lens distortion from a poor video camera.
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TV Distort Amount field Displays the amount of TV lens distortion applied to the image. Editable.

TV Distort Amount Variation field Displays the percentage of variation in the amount of TV lens distortion
applied to the image.

TV Distort Radius field Displays the size of the image to which the TV lens distortion is applied. A value
of 1 includes the entire image. Editable.

TV Distort Ratio field Displays the ratio of height to width that is affected by the TV lens distortion effect.
Editable.

Digital Video Settings

Use the Digital Video Damage effects to apply a large variety of digital video degradation effects to a clip.
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When you select Digital Video from the Damage type box, the Digital Video Damage Effects are displayed,
along with the most useful adjustment box to the right of each.

Chroma Errors Settings

Chroma Errors button Use this effect to simulate chroma errors in badly encoded digital video transmissions.

Chroma Amount box Displays the value representing the change to the chroma channel. Editable.

Luma Amount box Displays the value representing the change to the luminance channel. Editable.

Variation Amount box Displays the percentage of variation applied to the Chroma and Luma channels.

Colour Artifacts Settings

Colour Artifacts button Use this effect to simulate digital colour artifacts and degradation appearing in
badly encoded digital video transmissions.

Colour Degradation Amount box Displays the amount of digital colour degradation applied to the image.
Editable.

Colour Degradation Variation box Displays the percentage of variation in the amount of colour degradation
applied to the image. Editable.
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Contrast box Displays the amount of contrast applied to the image. Editable.

Brightness box Displays the amount of brightness applied to the image. Editable.

Tint Colour box Displays the tint value applied to the colour in the image. Editable.

Shadows colour pot Displays the tint applied to shadows in the image. Editable.

Highlights colour pot Displays the tint applied to highlights in the image. Editable.

Compression Settings

Compression button Use this effect to simulate digital compression errors in badly encoded digital video
transmissions.

Compression Amount field Displays the amount of the digital compression effect applied to the image.
Editable.

Compression Amount Variation field Displays the percentage of variation in the amount of digital
compression applied to the image. Editable.

Compression Edges Active button Enable to activate edge detection errors in compression.

Compression Edges Minimum field Displays the minimum threshold value used to detect edges. Available
when Active button is enabled. Editable.
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Compression Edges Maximum field Displays the maximum threshold value used to detect edges. Available
when Active button is enabled. Editable.

Compression Edges Width field Displays the width of the edge in pixels. Available when Active button is
enabled. Editable.

Compression Edges Softness field Displays the softness of the edge. Available when Active button is enabled.
Editable.

Compression Spacing field Displays the spacing in frames between digital compression errors. Editable.

Compression Spacing Variation field Displays the percentage of variation in spacing between compression
errors. Editable.

Compression Duration field Displays the duration in frames of the compression errors. Editable.

Compression Duration Variation field Displays the percentage of variation in duration of the compression
errors. Editable.

Digital Drops Settings

Digital Drops button Use this effect to simulate digital drop errors in badly encoded digital video
transmissions.

Digital Drops Amount field Displays the amount of digital drop errors applied to the image. Editable.

Digital Drops Coherence field Displays the amount of coherence to digital drop errors in the image. Editable.

Digital Drops Amount Variation field Displays the percentage of variation in the amount of digital drop
errors applied to the image. Editable.

Digital Drops Spacing field Displays the spacing in frames between digital drop errors. Editable.
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Digital Drops Spacing Variation field Displays the percentage of variation in spacing between digital drop
errors. Editable.

Digital Drops Freeze Frame button Displays the number of repeat frames added to create a jerky digital
drop effect. Editable.

Digital Drops Duration field Displays the duration in frames of the digital drop errors. Editable.

Digital Drops Duration Variation field Displays the percentage of variation in duration for the digital drop
errors. Editable.

Play Effect Settings

Play Effects button Use this effect to simulate digital play effects in badly encoded digital video transmissions.

Play Effects Speed field Displays the amount of change to the speed of playback applied to the image.
Editable.

Play Effects Shuttering field Displays the amount of shuttering during playback that is applied to the
image. Editable.

Play Effects Spacing field Displays the spacing in frames between play effects errors. Editable.

Play Effects Spacing Variation field Displays the percentage of variation in spacing between play effects
errors. Editable.

Play Effects Duration field Displays the duration in frames of the play effects errors. Editable.

Play Effects Duration Variation field Displays the percentage of variation in the duration for play effects
errors. Editable.

Pixelation Settings

Pixelation button Use this effect to simulate reduced resolution and digital pixelation errors in badly
encoded digital video transmissions.

Pixelation Width Amount field Displays the width in pixels of the new pixelation block. Editable.
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Pixelation Height Amount field Displays the height in pixels of the new pixelation block. Editable.

Pixelation Proportional button Enable to effect the width and height proportionally. Editable.

Pixelation Average button Displays the amount of averaging applied between the pixel block and its
surroundings. Editable.

Pixelation Transparency field Displays the percentage of transparency, or softness, applied to the pixel
blocks. Editable.

Pixelation X Offset field Displays the horizontal offset for the pixelation effect. Editable.

Pixelation Y Offset field Displays the vertical offset for the pixelation effect. Editable.

Pixelation Size Variation field Displays the percentage of variation in the size of pixels during playback.
Editable.

Deal
Use Deal to deal out the frames of a single clip evenly to any number of destination clips.

To access the Deal menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.

The Clip field defines the number of times the clip is split; the Frame determines which of the dealt clips is
output. The First Processed Frame field set the value at which output is processed from the node. Unprocessed
output does not display any media.
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Deal Menu Settings

General Settings

First Rendered Frame field Displays the first frame at which output is rendered from the node. Unrendered
output does not display any media.Editable.

Clips field Displays the number of times the clip is split. Editable.

Start Frame field Displays which frame of the input clip used to determine which dealt clip is output.
Editable.

Deform
Use Deform to apply various types of deformation effects to clips.

To access the Deform menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).
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■ Tools, then select from the menu.

This node accepts a front and a matte clip, and outputs a result and an outmatte.

Deform Menu Settings

General Settings

Deform Type button Select the type of deformation you want to create. The available effect parameters
change based on the selection.

Deform Ripple box (not shown) Select how you want the ripples created. Pond Ripples create ripples with
a 45 degree offset. Out from Center pushes the ripples away from the center, extending the first half, and
compressing the second half of each ripple. Around Center rotates the crest of each ripple in a clockwise
direction around the center.

Repeat Mode box Select an option to fill the empty portions of the frame.

Effect Parameters

NOTE The following settings are available when Crumple is selected from the Deform Type button.

Amplitude field Displays the amount of deformation. Increase the value to increase the effect. Editable.

Time Offset field Displays the time offset interval of the crumpling. Editable.

Octaves field Displays a value for the number of layers summed in the operation, from zero to 10. Increase
the value to increase the fractal effect. Editable.

NOTE The following settings are available when Magnify is selected from the Deform Type button.
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Radius field Displays the size of the affected area. You can also drag the circle in the image window to
change the size of the radius. Editable.

Amount field Displays the amount of the deformation. Editable.

Direction box Select Horizontal, Vertical, or Both to indicate the direction of the magnification.

Damping box Select how the effect is applied within the radius. Select None to apply no damping, Linear
to decrease the effect linearly to 0, or Quadratic to decrease the effect quadratically to 0.

NOTE The following settings are available when Pinch is selected from the Deform Type button.

Radius field Displays the size of the affected area. You can also drag the circle in the image window to
change the size of the radius. Editable.

Amount field Displays the amount of the deformation. Editable.

Damping box Select how the effect is applied within the radius. Select None to apply no damping, Linear
to decrease the effect linearly to 0, or Quadratic to decrease the effect quadratically to 0.

NOTE The following settings are available when Ripple is selected from the Deform Type button.
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Amplitude field Displays the amount of deformation. Increase the value to increase the effect. Editable.

Ripples field Displays the frequency of the ripples (from zero to 60). Editable.

Radius field Displays the size of the affected area. You can also drag the circle in the image window to
change the size of the radius. Editable.

Phase field Displays the spread of the ripples to the centre. Use this value to animate the ripple effect.
Editable.

Max Ridges field Displays the total number of ripples that can be generated. For example, set to 5 to create
5 rings of distortion. Editable.

Damping box Select how the effect is applied within the radius. Select None to apply no damping, Linear
to decrease the effect linearly to 0, or Quadratic to decrease the effect quadratically to 0.

NOTE The following settings are available when Twirl is selected from the Deform Type button.

Radius field Displays the size of the affected area. You can also drag the circle in the image window to
change the size of the radius. Editable.

Twirl Angle field Displays the direction of the twirl. Editable.

Damping box Select how the effect is applied within the radius. Select None to apply no damping, Linear
to decrease the effect linearly to 0, or Quadratic to decrease the effect quadratically to 0.

NOTE The following settings are available when Wave is selected from the Deform Type button.
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Amplitude field Displays the amount of deformation. Increase the value to increase the effect. Editable.

Wave Frequency field Displays the number of waves. Editable.

Phase field Displays the spread of the ripples to the centre. Use this value to animate the ripple effect.
Editable.

Compression field Displays a pixel flattening value (negative values flatten to the left, and positive values
flatten to the right). Editable.

Transform Settings

NOTE Transform settings for Input, Deform and Output are identical.

Transform X Position field Displays the horizontal position of the transformation. Enable the Icons button
to change the position by dragging the vertex tool in the image window. Editable.

Transform Y Position field Displays the vertical position of the transformation. Editable. Enable the Icons
button to change the position by dragging the vertex tool in the image window. Editable.

Transform Rotation field Displays the rotation of the transformation. Editable. Enable the Icons button to
change the rotation by dragging the vertex tool in the image window. Editable.

Transform Centre X field Displays the centre point value of the transform along the horizontal axis. Editable.

Transform Centre Y field Displays the centre point value of the transform along the vertical axis. Editable.

Transform X Scale field Displays the horizontal scale factor. Editable.

Transform Y Scale field Displays the vertical scale factor. Editable.

Proportional button Enable to scale X and Y values proportionally.
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Icons button Enable to display the vertex editing tool in the image window.

Anti-Aliasing Settings

Active button Enable to activate software anti-aliasing.

Anti-Aliasing Sampling box Select the number of samples to use in the anti-aliasing process.

Anti-Aliasing Softness field Displays the softness value for software anti-aliasing. Editable.

Degrain
Use Degrain to remove grain from the RGB channels of a selected colour in an image.

To access the Degrain menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.
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Degrain Menu Settings

General Settings

Render Method box Select whether you are removing grain from progressive or interlaced media.

Crop box Applies the Degrain to a specific region in the clip.

Red Average slider Displays the amount of blur applied to the red channel.

Red Average field Displays the amount of blur applied to the red channel. Editable.

Green Average slider Displays the amount of blur applied to the green channel.

Green Average field Displays the amount of blur applied to the green channel. Editable.

Blue Average slider Displays the amount of blur applied to the blue channel.

Blue Average field Displays the amount of blur applied to the blue channel. Editable.

Proportional RGB Average button Enable to blur RGB channels proportionally.

Red Sharpen slider Displays the amount of sharpness applied to the red channel.

Red Sharpen field Displays the amount of sharpness applied to the red channel. Editable.

Green Sharpen slider Displays the amount of sharpness applied to the green channel.

Green Sharpen field Displays the amount of sharpness applied to the green channel. Editable.

Blue Sharpen slider Displays the amount of sharpness applied to the blue channel.

Blue Sharpen field Displays the amount of sharpness applied to the blue channel. Editable.

Proportional RGB Sharpen button Enable to sharpen RGB channels proportionally.

Deinterlace
Use Deinterlace to separate the odd and even scanlines of a clip.
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To access the Deinterlace menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip as input, and outputs a result.

For each frame of the clip, the result clip contains one frame with odd scanlines (Field 1) and one frame
with even scanlines (Field 2).

Deinterlace Menu Settings

General Settings

First Rendered Frame field Displays the first frame at which output is rendered from the node. Unrendered
output does not display any media.Editable.

Field Dominance box Select Field 1 or Field 2 dominance, or Auto to have the application detect
automatically the field dominance.

Interpolation box Enable to interpolate a blend between adjacent lines and fill in the isolated scan lines.
This also reduces interlacing artifacts.

Denoise
Use the Denoise effect to reduce or remove noise and grain from your source media.
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To access the Denoise menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result clip.

Denoise Menu Settings

Setup Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Export button Click to export a Denoise setup to be used as a Lustre Degrain preset.

Import button Click to open the browser to select a Lustre Degrain preset to import.
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Grain Analysis Settings

Add Bounding Box button Adds a new sub-region. Click and drag the bounding box in the image window
to set the location.

Remove Bounding Box box Select an option to remove the currently selected bounding box or all the
bounding boxes.

Analyze button Click to determine the grain structure.

Reference frame field Displays the frame number that is analysed. You can use this frame analysis as a
reference that can be edited and applied to the clip.

Show Icons button Enable to display all the defined bounding boxes.

Bounding Box colour pot Displays the colour used for the border of the bounding boxes. Click to change
the colour.Editable.

Denoise Settings

Denoise button Enable to use noise removal on the clip.

Red Gain field Displays the gain for red channel colour values. Editable.

Green Gain field Displays the gain for green channel colour values. Editable.

Blue Gain field Displays the gain for blue channel colour values. For film scans, the grain is often greater
in this channel. Editable.
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Proportional button Enable to change gain values proportionally for all three colour channels.

Grain Size field Displays a value in pixels that is proportional to the size of the grain. The default value is
3, but may be higher for 4K images. Editable.

Smoothing Radius field Displays the blur radius. For smoother results, a higher value will add more pixels
to the blur, but increase rendering time. Editable.

Detail field Displays the amount of detail to preserve when the Smoothing Radius is set to a high value. It
is recommended you enter 0.05 to 0.15 as an initial value. Editable.

Opacity field Displays a percentage of the level of opacity between the source image and the output with
the applied grain filter. Editable.

Use Past button Enable to compare with pixel data from previous frames.

Use Future button Enable to compare with pixel data from subsequent frames.

Histogram Settings

Histogram box Select to display the red, green, blue, or luminance histogram in the graph. Select Current
Curve to display the histogram for the currently selected Curves Channel.

Curves Channel box Select to highlight the red, green, or blue channel curve in the graph.

Home button Reverts to the original view.

Reset box Resets the curve view.

Set Key button Sets the current values for the selected channels in the current frame.

Delete Key button Deletes the selected keyframe or curve.

Reset Key button Select to reset the current curve or all the curves to default.
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Median Filtering Settings

The Median Filter removes noise by calculating the median value for each pixel (the most probable pixel
value) and applies an edge-preserving smoothing filter.

Median Filtering button Enable to use the median filter.

Type box Select the filtering mode. Options are:
■ Standard: Applies the standard fitering algorithm.

■ Advanced: Applies a more advanced filtering algorithm, but is more resource intensive. Use the Advanced
Filter Mode on particularily noisy shots.

Criteria box Select the ranking criteria by which the median value is chosen. Options are:
■ Luminance :Uses the pixel luminance value to calculate the median value.

■ RGB Vector: Uses the RGB coordinate values to calculate the median value.

■ RGB Component: Uses the R, G and B channels independently to calculate the median value.

Radius field Displays the size of the filtering region in pixels from the centre. A higher value results in more
pixels being taken into account when calculating the median value. Editable.

Iterations field Displays the number of times that the filter is applied recursively. Editable.

Opacity field Displays how much the result of one median iteration is combined with the original input.
Editable.

Depth of Field
Use Depth of Field to create a blur that is applied to out-of-focus points of light to simulate a shallow focus.
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To access the Depth of Field menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front, Z-depth and matte clip, and outputs a result, out Z-depth and outmatte clip. The
output matte clip can have a different level of depth of field than the result clip.

Depth of Field Menu Settings

Blur and Blooming Settings

Blur Width field Displays the horizontal blur amount in pixels. Editable.

Blur Height field Displays the vertical blur amount in pixels. Editable.

Blur Proportional button Enable to constrain blur amount proportions.

Bokeh Blur field Displays the amount of smoothness applied to sharp bokeh edges. This creates the blur
that is applied to out-of-focus points of light to simulate a shallow focus. Editable.
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Basic/Additive Blooming button Switch between basic blooming and additive blooming bokeh effects.
The basic blooming mode displays the gain applied to highlights in non-HDR images, to allow the creation
of bokeh patterns without affecting colour integrity. The additive blooming mode allows you to create higher
intensity bokeh patterns from any source image, using minimum and maximum thresholds for highlight
segregation.

Basic Blooming field Displays the gain applied to highlights in non-HDR images, to allow the creation of
bokeh patterns without affecting colour integrity. This creates the glow effect that is applied to the bright
spots of the image to simulate light bleeding, or blooming, over the edges. Editable.

Additive Blooming field Displays the amount of high intensity bokeh patterns that can be created from
any source image generating extreme highlight content . Editable.

Additive Blooming minimum field Displays the minimum threshold for highlight segregation. Editable.

Additive Blooming maximum field Displays the maximum threshold for highlight segregation. Editable.

Bokeh Settings

Sides field Displays the number of sides in the kernel shape. Editable, if kernel information is not attached
to the node.

Rotation field Displays the angle of rotation of the kernel shape. Editable, if kernel information is not
attached to the node.

Bokeh Type box Select whether to use a round or angle bokeh curve to define the kernel shape.

Curvature field Displays the amount of curvature applied to a round bokeh kernel shape. Editable.
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Slices and Edge Artifacts Settings

Slices Number field Displays the number of slices to blend to determine the Z-Depth interpolation of a
depth-of-field focus blur. You can see the slices in the depth-o-gram to allow a better understanding of the
focus plane behaviour, and to help define the number of slices required, depending on your Z-depth colour
information. Editable.

Slices Overlap field Displays the amount of blending overlap between adjacent slices. Editable.

Foreground Expand field Displays the amount of mixing between the edges of selected objects and their
surroundings in the foreground. Editable.

Background Blend field Displays the amount of mixing between the edges of selected objects and the
background image. Editable.

Z-Depth Settings

Z-Depth Minimum field Displays the lower limit of the Z-Depth values. Pixels with lower values are mapped
to black. Editable.

Z-Depth Z Maximum field Displays the upper limit of the Z-Depth values. Pixels with higher values are
mapped to white. Editable.

White Value box Select whether white pixels represent the furthest point or nearest point on the Z-axis.

Premultiplied Depth button Enable to have the alpha channel information premultiplied with the colour
depth data. Use to prevent a black halo from forming around blurred areas.
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Max Blur Field Displays the maximum total horizontal and vertical blur amount to clamp the value and
avoid unnecessary rendering. The cumulative effect of the high blur amount (Basic tab), and gamma and
gain correction applied to the Depth map (Depth tab) may result in very large values, which greatly increases
the rendering time. Editable.

Slopes field Displays the gamma value. Applies a gamma curve to the Z-depth map before it is used. Editable.

Depth-O-Gram Settings

Use the Depth-O-Gram settings to refine focus values.

Depth blur effects control the amount of blur based on a depth of field matte. Depth blur settings are
displayed in the Depth-O-Gram tab.

A depth of field map (Z-depth map) can be connected to the node. Black portions of the map are in focus.
White portions display the highest level of blur. Note that a Z-depth map imported from another application
may use the opposite convention and may need to be inverted.

Focus Plane field Displays the distance of your focus point, which is the point at which there is no blur on
the image. Editable.

Focus Offset field Displays the distance between the focus plane and the near offset represented as a
percentage of the total offset range. Select 50% to make the near and far offsets equidistant from the focus
point. Editable.

Focus Range field Displays the distance the near and far offset. Editble.

Frame option box Select how you want to frame the histogram.

Zoom field Displays a vertical zoom value for the histogram to display. You can zoom horizontally by
pressing Ctrl+spacebar and dragging left or right in the histogram. To pan horizontally, click spacebar and
drag left or right in the histogram.Editable.

Z Plot button Click to activate the pick cursor. Use to select a pixel in the image to display its depth.

Z Plot Colour pot Displays the colour that indicates the plane on which the plotted value is located.

Modifying Depth of Field Gesturally

Depth blur effects can be modified gesturally by dragging the focus, near offset, and far offset planes in the
graphic representation of the depth of field. As you drag these elements, the planes are also displayed in the
Result view as a preview of the areas that will be in focus. Use the depth control fields to change the gamma
and gain, and to change the focus range while keeping the focus plane constant. These parameters are
updated in the depth of field display automatically.
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(a) Plot Value Plane (b) Near Focus Offset Plane (c) Focus Offset (d) Focus Plane (e) Far Focus Offset Plane (f) Focus
Range

Bokeh Profile Settings

Use the Bokeh Profile tab to edit the blur kernal pattern.

The kernel is the basic blur shape. The shape of the kernel is determined by its number of sides, its rotation,
and the shape of its S-curve. This curve represents the shape of the pattern, from its centre to the outside.
The default S-curve defines the softness of the blur. You can change the curve by manipulating the two
points that define the curve, or you can add points to the curve. Use the Edit Mode box to add and delete
points on the curve.

Set Key button Sets a keyframe at the selected frame.

Delete Key button Deletes the selected keyframe.

Reset Key button Resets the curve at the selected keyframe.

Home button Resets the profile view.

Reset button Resets the blur pattern profile curve to its default values.
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Difference Matte
Use the Difference Matte to generate a matte clip from two source clips with the same background but
different foreground elements.

To access the Difference Matte menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front and back clip as input, and outputs a result.

The Difference Matte allows you to remove an image from one context and add it to another. The matte is
created using the Tolerance and Softness values that you specify.

Difference Matte Menu Settings

General Settings

You can enable the RGB or the YUV settings to generate a matte clip.

RGB Settings

RGB button Enable to use values in the RGB colour space to generate a matte.

R button Enable to use the red colour channel to create the matte.

G button Enable to use the green colour channel to create the matte.

B button Enable to use the blue colour channel to create the matte.

Red Tolerance colour pot Displays the value of the red channel used to create the matte. Editable.

Red Tolerance field Displays the value of the red channel used to create the matte. Editable.

Green Tolerance colour pot Displays the value of the green channel used to create the matte. Editable.

Green Tolerance field Displays the value of the green channel used to create the matte. Editable.

Blue Tolerance colour pot Displays the value of the blue channel used to create the matte. Editable.

Blue Tolerance field Displays the value of the blue channel used to create the matte. Editable.

Red Softness colour pot Displays the softness value applied to the red channel to create the matte. Editable.
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Red Softness field Displays the softness value applied to the red channel to create the matte. Editable.

Green Softness colour pot Displays the softness value applied to the green channel to create the matte.
Editable.

Green Softness field Displays the softness value applied to the green channel to create the matte. Editable.

Blue Softness colour pot Displays the softness value applied to the blue channel to create the matte. Editable.

Blue Softness field Displays the softness value applied to the blue channel to create the matte. Editable.

Gain field Displays the value that the resulting pixel values are multiplied by to create the final matte.
Editable.

Lift field Displays the value added to the resulting pixels to create the final matte. Editable.

YUV Settings

YUV button Enable to use values in the YUV colour space to generate a matte.

Y button Enable to use the Y channel (luminance) to create the matte.

U button Enable to use the U channel (chrominance) to create the matte.

V button Use the V channel (chrominance) to create the matte.

Y Tolerance colour pot Displays the value of the Y channel used to create the matte. Editable.

Y Tolerance field Displays the value of the Y channel used to create the matte. Editable.

U Tolerance colour pot Displays the value of the green channel used to create the matte. Editable.

U Tolerance field Displays the value of the U channel used to create the matte. Editable.

V Tolerance colour pot Displays the value of the V channel used to create the matte. Editable.

V Tolerance field Displays the value of the V channel used to create the matte. Editable.

Y Softness colour pot Displays the softness value applied to the Y channel to create the matte. Editable.

Y Softness field Displays the softness value applied to the Y channel to create the matte. Editable.

U Softness colour pot Displays the softness value applied to the U channel to create the matte. Editable.

U Softness field Displays the softness value applied to the U channel to create the matte. Editable.

V Softness colour pot Displays the softness value applied to the V channel to create the matte. Editable.

V Softness field Displays the softness value applied to the V channel to create the matte. Editable.

Gain field Displays the value that the resulting pixel values are multiplied by to create the final matte.
Editable.

Lift field Displays the value added to the resulting pixels to create the final matte. Editable.

Edge Detect
Use Edge Detect to trace the edges in a clip based on colour. This data can then be used to create a range of
artistic effects in various colour spaces.
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To access the Edge Detect menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and matte clip, and outputs a result and an outmatte.

Edge Detect Settings

General Settings

Colour Type box Select the colour space that you want to use to isolate the edge.
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Result Output box Select Result to output the composite of the input image, input matte, and the matte
generated by the edge detection. Or, select Edge Only to output only the result of compositing the input
image with the matte generated by the edge detection.

Matte Output button Select Input to output the input matte or Edge Matte to output the matte generated
by the edge detection.

Edge Detection Settings

Red Weight field Displays a value for the relative intensity of red used to detect edges. This value is scaling
factor, not the color value of the channel itself. Editable.

Green Weight field Displays a value for the relative intensity of green used to detect edges. This value is
scaling factor, not the color value of the channel itself. Editable.

Blue Weight field Displays a value for the relative intensity of blue used to detect edges. This value is scaling
factor, not the color value of the channel itself. Editable.

Proportional Weight button Enable to adjust the red, green, and blue weights proportionally.

Minimum Edge Detection Threshold field Displays the lower limit for edge detection. Editable.

Maximum Edge Detection Threshold field Displays the upper limit for edge detection. Editable.

Softness Width field Displays a value for the width of the edge. Editable.

Softness Gain field Displays a value for the softness of the edge. Editable.
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Edge Effects Settings

Double Edge button Enable to do a second edge detection pass and create twice as many edges.

Minimum Edge Detection Threshold field Displays the lower limit for edge detection. Editable.

Maximum Edge Detection Threshold field Displays the upper limit for edge detection. Editable.

Softness Width field Displays a value for the width of the edge. Editable.

Softness Gain field Displays a value for the softness of the edge. Editable.

Directional button Enable to create the edge in the direction indicated in the Angle field.

Edge Angle field Displays a value for the direction of the edge. Editable.

Colour Offset pot Displays a colour offset value for the image outside of the detected edges.

Colour Correction Settings

Saturation field Displays level of colour purity in the image. Editable.

Gamma field Displays the gamma level. Editable.

Offset field Displays a value that modifies all of the colour parameters. Editable.

Red Gain field Set the percentage of colour values in the red channel. Editable.
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Green Gain field Set the percentage of colour values in the green channel. Editable.

Blue Gain field Set the percentage of colour values in the blue channel. Editable.

Luma Gain field Set the percentage of luma gain value to display. Editable.

Proportional button Enable to adjust the gain of the colour values proportionally.

Blending Settings

Blend Mode option box Select an operation to blend the input image with the matte created by the edge
detection, and the input matte (if the Use Matte button is enabled).

Edge Transparency field Displays a value for the transparency applied to the edges. Editable.

Use Matte button Enable to use the input matte to constrain the blending of the input image and the matte
created by the edge detection.

Field Merge
Use Field Merge to remove field jitter by merging the fields of a clip.

To access the Field Merge menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.
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Field Merge Menu Settings

General Settings

Level field Enter the percentage of blending between fields, or drag on the field to modify its value.

Filter
Use Filter to apply different effects to a clip, including textures, blurring, edge detection, embossing, and
sharpening.

To access the Filter menu:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.

Filter Menu Settings

General Settings

Filter 1 button Modifies the set of image operations in the first filter element that is applied in the final
composite filter.

Filter 2 button Modifies the set of image operations in the second filter element that is applied in the final
composite filter.

Filter 3 button Modifies the set of image operations in the third filter element that is applied in the final
composite filter.
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Filter 4 button Modifies the set of image operations in the fourth filter element that is applied in the final
composite filter.

Filter 5 button Modifies the set of image operations in the fifth filter element that is applied in the final
composite filter.

Use Filter button Enable to apply the filter element to the final composite filter.

Effect field Displays the level of filtering required. Editable.

Bypass Chroma button Enable to ignore hue and saturation channels of an image.

Bypass Luminance button Enable to ignore luminance channels of an image.

Filter Type box Select whether to use matrix calculations or a predefined procedure to alter the image.

Matrix Settings

Gain field Displays the light values of the image. Editable.

Automatic button Enable to preserve the average luminance of the clip.

Balanced button Enable to activate a compensating algorithm when a value is entered in the matrix, where
the value is divided by the remaining fields, and then the result is subtracted from each value in the matrix.

Symmetry Type box Select an arrangement used to change symmetrical elements.

Same button Enable to change a symmetrical field to the same value as a field that is being edited.

Invert button Enable to change a symmetrical field to the equal and opposite value as the field value that
is being edited.

Copy button Click to copy the current matrix setup.

Paste button Click to paste a copied matrix setup.

Reset Matrix button Reset all values in the matrix.

3x3 button Enable to apply a matrix of three rows and three columns. The field in the centre represents the
pixel that is currently being evaluated; the others represent surrounding pixels. The matrix displays the
relative influence of each pixel surrounding the current one.

5x5 button Enable to apply a matrix of five rows and five columns. The field in the centre represents the
pixel that is currently being evaluated; the others represent surrounding pixels. The matrix displays the
relative influence of each pixel surrounding the current one.

7x7 button Enable to apply a matrix of seven rows and seven columns. The field in the centre represents
the pixel that is currently being evaluated; the others represent surrounding pixels. The matrix displays the
relative influence of each pixel surrounding the current one.

9x9 button Enable to apply a matrix of seven rows and seven columns. The field in the centre represents
the pixel that is currently being evaluated; the others represent surrounding pixels. The matrix displays the
relative influence of each pixel surrounding the current one.

11x11 button Enable to apply a matrix of eleven rows and eleven columns. The field in the centre represents
the pixel that is currently being evaluated; the others represent surrounding pixels. The matrix displays the
relative influence of each pixel surrounding the current one.

Procedural Settings

Invert button Enable to invert the image.

Rect button Enable to blur the image.
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Width field Displays the height of the blur. Editable.

Height field Displays the width of the blur. Editable.

Sobel button Enable to apply an edge-detection filter that uses the Sobel operator.

Sobel Direction box Select the direction in which the filter is applied.

Prewitt button Enable to apply an edge-detection filter that uses the Prewitt operator.

Prewitt Direction box Select the direction in which the field is applied.

Flip
Use Flip to generate a mirror image of a clip. You can flip frames in a clip horizontally, vertically or both.

To access the Field Merge menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs a result.

Flip Menu Settings

General Settings

Flip Direction box Select to flip the clip horizontally or vertically.

Reverse Dominance box Select an option for correcting the field dominance when flipping clips vertically.

Garbage Mask
Use the Garbage Mask to isolate particular areas of an image to include with, or exclude from, the opaque
area of the matte.
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To access the Garbage Mask menu, use:
■ Timeline, then use ConnectFX (page 624).

■ Modular Keyer, then select a node from the Node bin. (page 624)

This node accepts a front and a matte clip as input, and outputs a result.

The Garbage Mask menu includes the Tracer and the region of Interest (ROI) functions, which can also be
found in the Modular Keyer. The node processes gaps in clips set to No Media as black frames. An unconnected
front clip will return an error, while and unconnected back clip will process black frames. You can save and
load GMask setups directly in ConnectFX.

Garbage Mask Menu Settings

Garbage Mask General Settings

Regenerate button Enable to get dynamic updating of your mask as you make changes.

X Position field Position the X axis.

Y Position field Position the Y axis.

Z Position field Position the Z axis.

Path button Enable to animate the position of the axis using a spline drawn in the scene.

X Rotation field Rotate the X axis.

Y Rotation field Rotate the Y axis.

Z Rotation field Rotate the Z axis.

X Scale field Scale the X axis.

Y Scale field Scale the Y axis.

Z Scale field Scale the Z axis.

Proportional button Enable to constrain proportions while scaling.

X Shear field Shear the X axis.

Y Shear field Shear the Y axis.
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Z Shear field Shear the Z axis.

X Centre field Centre the X axis.

Y Centre field Centre the Y axis.

Z Centre field Centre the Z axis.

Stabilizer button Opens the Stabilizer menu where you track reference points in a clip.

Tracking Rotation option box Select Rotation Off for one-point tracking, Rotation On for two-point tracking,
Rotation Inv to invert the rotation data.

Tracking Scale option box Select Scaling Off for one-point tracking, Scaling On for two-point tracking,
Scale Inv to invert the scaling data.

Adjust box Select Adj Offset if the mask is parented to one axis. Select Adj Axis if the mask is parented to a
hierarchy of objects. Select Adj Tangents to have the tangents for the selected points adjusted while the
points are tracked.

Motion Blur button Enable the blur effect for the selected axis (Motion Blur must be enabled in the Setup
menu).

Motion Blur button Toggles the blur effect for the selected geometry (Motion Blur must be enabled in the
Setup menu).

Load button Loads a garbage mask setup.

Save button Saves a garbage mask setup.

Render Mask button Enable to see the mask and its effect on the image.

Region of Interest button Enable to reveal the matte of multiple garbage masks.

Outside button Enable to apply the effect to the part of the image outside the mask.

Colour field Set the blend between the outgoing and incoming image inside the mask.

Opacity field Set the transparency of the mask.

Lasso Fit field Set the number of points used in the freehand part of the mask.

Edge Softness box Select Softness to create a uniform gradient around the mask edge. Select Tracer to key
out details around the mask edge.

Alpha field Set the transparency of the gradient from the mask edge.

Offset field Set the position of the gradient's border from the mask edge.

Distance field Specify the area over which the Inner and Outer Edge adjustments have an effect.

Inner Edge field Smoothen the softness gradient towards the inside of the mask edge.
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Outer Edge field Smoothen the softness gradient towards the outside of the mask edge.

Active Points button Enable to use all points as a reference for the mask. Disable at a specific frame to mute
picker values previously sampled at another frame.

Shape Animation button Enable to animate a mask using the Shape channel.

Linear Interpolation button Enable to use linear interpolation of the mask border between keyframes.
Disable to use rounded interpolation. This button is active when the Shape Animation button is enabled.

Constant Shape button Enable to modify the mask's shape without setting keyframes.

Sample Status box Select how picker values are sampled. Active resamples picker values at every frame (the
default). Passive disables resampling for one or more frames. This box is active when the Shape Animation
button is disabled.

Interpolation Mode box Select the type of interpolation between keyframes when the Sample Status box
is set to Active.

Splines button Enable to display inner and outer splines of the mask.

Borders button Enable to display inner and outer borders for advanced gradients.

Pickers button Enable to display elements that allow for detailed chroma and luma analysis when refining
a detailed key.

X Axis Offset field Offset the mask from its X axis.

Y Axis Offset field Offset the mask from its Y axis.

Stabilizer button Opens the Stabilizer menu where you apply tracking data to selected vertices.

Adjust box Select Adj Tangents to have the tangents for the selected vertices adjusted while the points are
tracked.

Add button Click to add a gmask axis or geometry node.

Node Type box Select whether to add an axis or geometry node.

Close button Click to close the mask shape automatically.

Object Node Name field Displays the name of the selected object node.

Previous Node button Click to scroll to the previous similar node.

Next Node button Click to scroll to the next similar node.

Garbage Mask Node Setup Settings
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Spline Keyframing box Select the parameters to use when animating a Garbage Mask spline. When Shape
Animation is disabled in the Garbage Mask general settings, then the Spline & Tracer, Spline and Item options
become available.

Vertex Keyframing box Select the conditions under which parameters are applied to specified vertices in
the mask.

Channel Selection box Select which channels are selected in the Channel Editor when you select one or
more vertices.

Motion Blur button Enable to apply motion blur to garbage masks that can be used to match the movement
of objects in a clip.

Phase field Displays whether the motion blur is based on the movement before or after the current frame.
-100 places the motion blur before the frame; a value of 100 places it after the frame.

Shutter field Displays the duration of the motion blur at each frame. Editable.

Samples field Displays the number of samples taken at each frame to create the motion blur. Editable.

Motion Blur curve Displays the transparency of the samples that create the blur effect. Drag the curve or
its handles to edit it gesturally.

Reset button Resets all motion blur controls and disables the Motion Blur button.

Icons button Enable to display garbage mask splines and axes.

Transparency field Displays the transparency of garbage mask splines and axes. Editable.

Show Border button Enable to display the Softness Offset wireframe border, defined in the Shape menu.

Show Border colour pot Select the colour for the Softness Offset wireframe.

Wireframe colour pot Select the colour of garbage mask splines.

Control Points colour pot Select the colour of garbage mask control points.

Pickers Display colour pot Select the colour of the pickers.

Transparency field Displays the transparency of nodes in the schematic. Editable.

Auto Insert button Enable to automatically insert a node when dragged between two connected nodes.
When disabled, press Shift to auto insert.

Rendering box Select the rendering method.

Auto Tangents Enable to create tangents for new points.

Scale Setup button Enable to scale the GMask.
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Glow
Use Glow to create and customize a glow effect on a clip.

To access the Glow menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and matte clip, and outputs a result an outmatte. You can add a Glow node to any
part of the pipeline except to the Front and Matte pipes of MBLend nodes and the Matte pipes of CBlend
nodes.

Glow Menu Settings

Using Glow Presets

A number of Glow presets are included, such as a basic glow effect or edge boost effect. These presets can
help you learn how the glow effect works, or provide a good starting point to change settings to create better
glow effects.

To use the Glow preset, select a preset from the Presets drop-down list in the Glow Setup menu. The Glow
menu settings are changed to reflect the chosen preset.
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Presets button Opens the Presets browser where you can select a preset.

Presets dropdown list Select a preset from the dropdown list. Menu settings are changed to reflect the
chosen preset.

General Settings

Rendering box Select whether to render in Progressive or Interlaced mode.

Regen button Enable to get dynamic updating of the image as you make changes.

Setup Settings

Clamp Input button Enable to clamp colour and luminance values on input in the 16-bit floating point
rendering pipeline.

Clamp Render box Select a clamping option for colour and luminance values on output in the 16-bit floating
point rendering pipeline.

Glow Type Settings

Glow Type for Radial Stamp
Glow Type for Radial

Glow Type for Directional
Glow Type for Gaussian

Glow Type box Select the type or shape of glow filter to apply to the clip. For example, a Box blur has
rectangular edges.Depending on the glow type, some of the other glow settings vary.

Radial Mode box Select whether a radial blur or glow moves in one circular direction (Spin), or two rotating
directions (Twist). Available when Radial is chosen as the blur type.

Bias field Displays the direction of a blur. Enter a positive value for forward, a negative value for backward,
or 0 for a blur that moves in both directions. Available when Directional or Radial Stamp is chosen as the
blur type.

Samples field Displays the quality of a Radial Stamp blur or glow. Editable. Available when Radial Stamp is
chosen as the blur type.

Glow | 987



Centre Settings (Radial only)

Stabilizer button Opens the Stabilizer menu to track the centre of the blur from the source clip. See Tracking
(page 608) for more information.

Centre X field Displays the X position of the centre of the radial blur (or gesturally move the red circle in
the image). Editable.

Centre Y field Displays the Y position of the centre of the radial blur (or gesturally move the red circle in
the image). Editable.

NOTE You can also move the red circle on the image to set the position of the centre of the blur. The Centre X
and Y fields update accordingly.

Absolute/Relative box Select whether to position and offset the centre of the radial blur in a relative mode
(expressed as a percentage) or absolute mode (expressed in pixels).

Offset X field Offsets the centre along the X axis (or press Ctrl and gesturally move the red circle in the
image).This field is useful to apply changes to the centre after tracking has been performed. Editable.

Offset Y field Offsets the centre along the Y axis (or press Ctrl and gesturally move the red circle in the
image). This field is useful to apply changes to the centre after tracking has been performed. Editable.

NOTE You can also press Ctrl and move the red circle on the image to set the offset of the centre of the glow.
The Offset X and Y fields update accordingly.
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Input Settings

Hue field Displays the colour range in the image before the glow effect is applied. Editable.

Saturation field Displays the colour purity level in the image before the glow effect is applied. Editable.

Contrast field Displays the level of gradations between light and dark areas before the glow effect is applied.
Editable.

Gamma field Displays the level of grey in the image before the glow effect is applied. Editable.

Gain field Displays a value by which pixel colour values are multiplied. The offset value is added to this
value to determine the final colour. Editable.

Offset field Displays the value to add to current pixel colour values. The resulting colour value is clipped
at 0. Editable.

Front Settings

Front Settings for Radial or Radial
Stamp

Front Settings for Directional

Front Settings for Gaussian or Box

Width field Displays the width of the blur.Increasing the blur increases the render time. Editable.

Height field Displays the height of the blur.Increasing the blur increases the render time. Editable.

Proportional button Enable to affect the width and height proportionally.

Pixel Ratio button Enable to blur the image using the same proportion as its aspect ratio.

Amount field (Radial, Radial Stamp) Displays the amount of radial blur. Editable.
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Rotation field (Radial, Radial Stamp) Displays the angle of rotation for a radial blur. Editable.

Length field (Directional) Displays the radius amount of a directional blur. Editable.

Angle field (Directional) Displays the angle of a directional blur. Editable.

Matte Settings

Matte Settings for Radial or Radial
Stamp

Matte Settings for DirectionalMatte Settings for Gaussian or Box

Matte Width field Displays the width of the blur for the matte. Editable.

Matte Height field Displays the height of the blur for the matte. Editable.

Matte Amount field Displays the amount of radial blur for the matte. Editable.

Matte Rotation field Displays the angle of rotation for a radial blur for the matte. Editable.

Matte Length field Displays the radius amount of a directional blur for the matte. Editable.

Matte Angle field Displays the angle of a direction blur of the matte. Editable.

Lock To Front button Enable to keep the matte values the same as their corresponding values for the front
clip.

Expand field Displays the percentage of additional blur to the matte. Editable when the Lock Expand button
is disabled.

Lock Expand button Enable to make the Expand value directly proportional to the value in the Width
field.

Auto Matte button Enable to generate matte values from the front clip.

Max Level field Displays the upper limit of the luminance values included in the glow effect. Editable.

Min Level field Displays the lower limit of the luminance values included in the glow effect. Editable.

Invert Matte button Enable to apply the glow to the region outside the area defined by the matte.

Premultiply button Enable to multiply the matte clip to the front clip.
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Colour Settings

Colour 1 box Enable to define the first colour used for the glow. If two colours are used, they are combined
in additive mode to create the glow effect.

Colour 1 Colour pot Displays the hue and saturation colour of the first glow colour. Click to open the
colour picker to select a different colour.

Colour 1 Trackball Adjusts the hue and saturation of colour 1.

Colour 1 Hue field Displays the colour range of colour 1. Editable.

Colour 1 Saturation field Displays the level of colour purity of colour 1. Editable.

Colour 1 Intensity field Displays the level of brightness of colour 1. Editable.

Colour 2 box Enable to define the second colour used for the glow. If two colours are used, they are combined
in additive mode to create the glow effect.

NOTE If you are using both Colour 1 and Colour 2, they are combined in additive mode to create the glow effect.

Colour 2 Colour pot Displays the hue and saturation colour of the second glow colour. Click to open the
colour picker to select a different colour.

Colour 2 Trackball Adjusts the hue and saturation of colour 2.

Colour 2 Hue field Displays the colour range of colour 2. Editable.

Colour 2 Saturation field Displays the level of colour purity of colour 2. Editable.

Colour 2 Intensity field Displays the level of brightness of colour 2. Editable.
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Channels Settings

Weight field Displays the weighted value of the channel.

Position X field Displays the horizontal offset of the channel.

Position Y field Displays the vertical offset of the channel.

Blending Settings

Screen option box Select a logical operation that can be used to blend the front clip and the result clip.

Transparency field Displays the percentage of blending when the result is composited on the front clip.
Editable.

Use Matte button Enable to include the matte in the blending.

Result Settings

Result Output button Select whether to output the combined result (with blending), or only the glow effect
itself.

Matte Output Settings

Matte Output button Switch between blend matte and glow luma. Blend matte allows you to output the
matte used internally to perform the blending of the glow effect over the input image. Glow luma allows
you to generate a straight-forward luminance conversion of the actual glow effect.
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Gradient
Use the Gradient to create an effect based on colours and patterns of your choosing.

To access the Gradient menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and matte clip, and outputs a result and outmatte.
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Gradient Menu Settings

Setup Settings

Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Frame Depth box Select the render/output frame depth of clips.

Scan Mode box Select the scan mode of clips.

Icons button Enable to display vertices, splines, and other gradient selection tools in the image window.

Transparency field Displays the transparency level of the gradient icons in the image window. Editable.

Vertex Colour Pot Displays the colour of vertices in the image window. Click to open the colour picker to
select a different colour.

Spline Colour Pot Displays the colour of splines in the image window. Click to open the colour picker to
select a different colour.

Amplitude Colour Pot Displays the colour of amplitude in the image window. Click to open the colour
picker to select a different colour.
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Type Settings

Gradient Type box Select the type of gradient to apply. Some of the gradient settings differ based on the
gradient type you choose.

To create a gradient based on:Select:

A single straight line spline.Directional

Two circular geometries.Radial

A spline that can be manipulated with vertices and tangents.Spline

Multiple coloured points.Point

For each gradient type, you can gesturally create your gradients in the image window with various widgets,
such as splines and vertices. Make sure that Show Widgets is enabled in the Gradient Setup menu.

Orientation Settings

Swap UV button Enable to change the direction of the gradient.

Gradient Controls Settings

Position X field Displays the position of the gradient along the X axis. Editable.

Position Y field Displays the position of the gradient along the Y axis. Editable.
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Rotation field Displays the degree of rotation of the gradient. Editable.

NOTE You can also manipulate the position and rotation of the gradient directly in the image window if Show
Widgets is available.

Scale field Displays the scale of the gradient. Editable.

Centre field Directional gradient only: Displays the offset value of the centre of the spline as a percentage
of its position on the spline. Editable.

Amplitude field Directional gradient only: Displays the pixel length of the spline. You can also drag either
end of the spline directly in the image window. Editable.

Roundness field Radial gradient only: Displays the relative shape of the inner and outer circular patterns.
A value of 1 displays the full rounded shape, whereas a value of 0 indicates a square shape. You can also
enter a negative value to produce a concave shape. Editable.

Sharpness field Point gradient only: Displays the level of edge sharpness between the gradient point colours.
Editable.

Softness field Displays the level of blur added to the gradient. A higher value produces a smoother transition
between gradient colours. Editable.

Extrapolation box Select an extrapolation type for the gradient pattern.

To:Select:

Keep the last value as a solid colour.Constant

Repeat the same gradient pattern.Repeat

Repeat the gradient pattern in reverse order until the frame border is reached.Mirror

Offset Cycle field Displays the cycle position of the color creating the gradient. Editable.

Ramps Settings

NOTE The Colour and Alpha ramps are available for Directional, Radial and Spline gradients.

Colour Ramp Displays the gradations of the gradient colours. The triangles below the ramp represent each
color in the gradient. You can add more colours to your gradient pattern.

A selected triangle’s colour is displayed in the colour pot to the right of the ramp, and its position is displayed
in the Position field. Also, when selecting a triangle, a smaller triangle appears representing the mid point
between the colour and the next triangles’ colour. You can move the triangles gesturally to achieve different
gradations, and move the mid point triangle to shift the weight between the colours.
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Colour Add button Adds a new colour triangle to the right of the currently selected triangle. Press Ctrl while
clicking add to clone the selected triangle colour.

Colour Delete button Deletes the selected triangle.

Colour Ramp Copy list Select whether to copy the Colour ramp information to the Alpha ramp, or to
preserve the Colour ramp information when switching gradient types.

NOTE The Alpha ramp under the Colour ramp is identical in functionality, except that it displays gradations in
gradient transparency.

Alpha Ramp Displays the gradations of the gradient transparency. The triangles below the ramp represent
each alpha colour in the gradient. You can add more alpha colours to your gradient pattern.

Alpha Add button Adds a new colour triangle to the right of the currently selected triangle. Press Ctrl while
clicking add to clone the selected triangle colour.

Alpha Delete button Deletes the selected triangle.

Alpha Ramp Copy list Select whether to copy the Alpha ramp information to the Colour ramp, or to preserve
the Alpha ramp information when switching gradient types.

Colour Interpolation Type box Choose a Linear or Smooth gradient interpolation curve.

Colour Colour pot Displays the colour of the selected triangle. Click to open the colour picker to select a
different colour.

Reverse Colour button Click to reverse the colours of the gradient proportionally.

Colour Even Spacing button Click to space the ramp triangles evenly.

Alpha Interpolation Type box Choose a Linear or Smooth gradient interpolation curve.

Alpha Colour pot Displays the alpha colour of the selected triangle. Click to open the colour picker to select
a different colour.

Reverse Alpha Colour button Click to reverse the alpha colours of the gradient proportionally.

Alpha Even Spacing button Click to space the ramp triangles evenly.

Colour Locator Position field Displays the location of the selected colour triangle along the colour ramp.
Editable.

Colour Locator Mid field Displays the weight level between colours on the ramp (represented by the small
triangle). Editable.

Alpha Locator Position field Displays the location of the selected alpha colour triangle along the alpha
ramp. Editable.

Alpha Locator Mid field Displays the weight level between alpha colours on the ramp (represented by the
small triangle). Editable.
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Radial Shape Settings

Use these settings if you wish to further affect the shape of a radial gradient.

NOTE Radial Shape settings are available when Radial is selected from the Gradient Type box.

Inner Width field Displays the width of the inner radial circle. You can also gesturally drag the red square
on the inner circle. Editable.

Inner Offset X field Displays the offset along the X axis of the inner radial circle. You can also gesturally
drag the + inside the inner circle. Editable.

Inner Offset Y field Displays the offset along the Y axis of the inner radial circle. You can also gesturally
drag the + inside the inner circle. Editable.

Outer Width field Displays the width of the outer radial circle. You can also gesturally drag the right-most
red square on the outer circle. Editable.

Outer Height field Displays the height of the outer radial circle. You can also gesturally drag the left-most
red square on the outer circle. Editable.

NOTE Drag the middle red square of the outer radial circle to affect both the width and the height at the same
time.

Proportional button Enable to affect the outer radial width and height proportionally.
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Spline Shape Settings

Use these settings if you wish to further affect the shape of a spline gradient. All of these settings have gestural
equivalents in the image window. Ensure that Icons is enabled in the Gradient Setup menu.)

NOTE Available when Spline is selected from the Gradient Type box.

Vertex X Position field Displays the position along the X axis of the selected vertex. Editable.

Vertex Y Position field Displays the position along the Y axis of the selected vertex. Editable.

Tangent X Position field Displays the position along the X axis of the selected tangent. Editable.

Tangent Y Position field Displays the position along the Y axis of the selected tangent. Editable.

Amplitude Position field Displays the position of the spline as a percentage of the distance between the
first and last vertex. Editable.

Amplitude Start field Displays the start position of the spline. Use to set the pixel length of the spline.
Editable.

Amplitude End field Displays the end position of the spline. Use to set the pixel length of the spline.
Editable.

Reset Shape button Resets the spline shape.

Points Settings
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NOTE Available when Point is selected from the Gradient Type box.

Points List Use the rows to set the colour, position, and other settings for each color of a Point gradient.

Points Column Displays the number of the point. By default, four points are added to a gradient; however,
you can add more.

Colour Column Displays the colour of the point. Click the colour pot to open the colour picker to select a
different colour.

Alpha Column Displays the alpha colour of the point. Click the colour pot to open the colour picker to
select a different colour.

X Column Displays the position of the point along the X axis. You can also gesturally drag the point in the
image window to position it.

Y Column Displays the position of the point along the Y axis. You can also gesturally drag the point in the
image window to position it.

Weight Column Displays the weight of the colour in relation to the nearest point colour in the image.

Radius Column Displays the radius of the point colour.

Add button Adds a new colour point to the list and image.

Delete button Deletes the selected colour point from the list and image.

Clone button Clones the selected colour point settings in a new point in the list and image.

Blending Settings

Screen option box Select a logical operation that can be used to blend the front clip and the result clip.

Transparency field Displays the percentage of blending when the result is composited on the front clip.
Editable.

Gain field Displays the level of gain applied to the chosen blending option. Editable.

Result Output Settings

Output Mode box Select whether to output the combined result (with blending), or only the gradient effect
itself.
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Alpha Output Settings

Alpha Output box Select whether to output the combined alpha result, or only the gradient effect itself.

Interlace
Use Interlace to connect the odd and even scanlines of a clip.

To access the Interlace menu:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

The Interlace node accepts a front clip as input, and outputs a result.

For each pair of frames in the input clip, the Field 1 scanlines of one frame are interlaced with the even
scanlines of the second frame to produce a single frame in the generated clip.

Interlace Menu Settings

General Settings

First Rendered Frame field Displays the first frame at which output is rendered from the node. Unrendered
output does not display any media.Editable.

Field Dominance box Select Field 1 or Field 2 dominance, or Auto to have the application detect
automatically the field dominance.

Keyer Channel
Use the Keyer Channel to extract a key from a red, green, or blue channel, or from a custom value.
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To access the Keyer Channel menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Keyer Channel Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Channel Mode box Select a predefined or custom colour channel.

Key colour pot Activates the pick cursor. Use to sample an area of the image to display an average colour
value for a custom channel.

Softness field Displays the percentage of transparency of the key-in clip. Editable.

More button Enable to enhance the keying effect.

Spread field The Spread field is available when Custom is selected from the Channel Mode box.Displays a
value for the range of colours extracted from the key-in clip. Editable.

Regen button Enable to get dynamic updating of the image as you make changes.

Keyer HLS
Use the Keyer HLS to extract a key by adjusting tolerance and softness using hue, luminance, and saturation
ranges.
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To access the Keyer HLS menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Keyer HLS Menu Settings

General Menu Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Regen button Enable to get dynamic updating of the image as you make changes.

Picking Controls Settings

Key Colour colour pot Activates the pick cursor. Use to sample an area of the image to display the average
colour value.

Tolerance button Activates the pick cursor. Use to select the maximum and minimum values for the tolerance
range in the image window.

Master Tolerance field Displays the value added to the existing tolerance of each channel. Resets to 0 after
each use.

+ Increases tolerance values.

- Decreases tolerance values.
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Softness button Activates the pick cursor. Use to select the maximum and minimum values for the softness
range in the image window.

Master Softness field Displays the value added to the existing softness of each channel. Resets to 0 after
each use.

+ Increases softness values.

- Decreases softness values.

Colour Control Settings

Hue button Enable to extract hue values for the key.

Minimum Softness field Displays the minimum hue value of the softness range. Editable.

Minimum Tolerance field Displays the minimum hue value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum hue value of the tolerance range. Editable.

Maximum Softness field Displays the maximum hue value of the softness range. Editable.

Luminance button Enable to extract luminance values for the key.

Minimum Softness field Displays the minimum luminance value of the softness range. Editable.

Minimum Tolerance field Displays the minimum luminance value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum luminance value of the tolerance range. Editable.

Maximum Softness field Displays the maximum luminance value of the softness range. Editable.

Saturation button Enable to extract saturation values for the key.

Minimum Softness field Displays the minimum saturation value of the softness range. Editable.

Minimum Tolerance field Displays the minimum saturation value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum saturation value of the tolerance range. Editable.

Maximum Softness field Displays the maximum saturation value of the softness range. Editable.

Plot button Activates the pick cursor. Use to sample an area of the image to display its colour value.

Frame option box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Keyer Luma
Use the Keyer Luma to extract a key from the luminance of a clip.
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To access the Keyer Luma menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Keyer Luma Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Master Tolerance field Displays the value added to the existing tolerance of each channel. Enter 100 for
an entirely opaque matte.

Master Softness field Displays the softness. Drag left or right to adjust the percentage value or enter a new
percentage value.

Relative To box Select to calculate softness and tolerance ranges relative to 0 and 1 colour values, or relative
to the maximum luminance.

Relative To field Displays the maximum luminance. This field is active if the Maximum Luminance option
is selected in the Relative To box.

Get Maximum Value button Analyses the image to determine the maximum luminance value.

Plot button Activates the pick cursor. Use to sample an area of the image to display its colour value.

Frame option box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Keyer RGB
Use the Keyer RGB to extract a key by adjusting tolerance and softness using red, green, and blue ranges.
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To access the Keyer RGB menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Keyer RGB Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Regen button Enable to get dynamic updating of the image as you make changes.

Picking Controls Settings

Key Colour colour pot Activates the pick cursor. Use to sample an area of the image to display the average
colour value.

Tolerance button Activates the pick cursor. Use to select the maximum and minimum values for the tolerance
range in the image window.

Master Tolerance field Displays the value added to the existing tolerance of each channel. Resets to 0 after
each use.

+ Increases tolerance values.

- Decreases tolerance values.

Softness button Activates the pick cursor. Use to select the maximum and minimum values for the softness
range in the image window.

Master Softness field Displays the value added to the existing softness of each channel. Resets to 0 after
each use.

+ Increases softness values.
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- Decreases softness values.

Colour Control Settings

Red Channel button Enable to extract red channel values for the key.

Minimum Softness field Displays the minimum red channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum red channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum red channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum red channel value of the softness range. Editable.

Green Channel button Enable to extract green channel values for the key.

Minimum Softness field Displays the minimum green channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum green channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum green channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum green channel value of the softness range. Editable.

Blue Channel button Enable to extract blue channel values for the key.

Minimum Softness field Displays the minimum blue channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum blue channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum blue channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum blue channel value of the softness range. Editable.

Plot button Activates the pick cursor. Use to sample an area of the image to display its colour value.

Frame option box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Keyer RGBCMYL
Use the Keyer RGBCMYL to extract a key by adjusting tolerance and softness using red, green, blue, cyan,
magenta, yellow, and luminance ranges.

To access the Keyer RGBCMYL menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).
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■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Keyer RGBCMYL Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Regen button Enable to get dynamic updating of the image as you make changes.

Picking Controls Settings

Key Colour colour pot Activates the pick cursor. Use to sample an area of the image to display the average
colour value.

Tolerance button Activates the pick cursor. Use to select the maximum and minimum values for the tolerance
range in the image window.

Master Tolerance field Displays the value added to the existing tolerance of each channel. Resets to 0 after
each use.

+ Increases tolerance values.

- Decreases tolerance values.

Softness button Activates the pick cursor. Use to select the maximum and minimum values for the softness
range in the image window.

Master Softness field Displays the value added to the existing softness of each channel. Resets to 0 after
each use.

+ Increases softness values.

- Decreases softness values.
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Colour Control Settings

Red Channel button Enable to extract red channel values for the key.

Minimum Softness field Displays the minimum red channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum red channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum red channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum red channel value of the softness range. Editable.

Green Channel button Enable to extract green channel values for the key.

Minimum Softness field Displays the minimum green channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum green channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum green channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum green channel value of the softness range. Editable.

Blue Channel button Enable to extract blue channel values for the key.

Minimum Softness field Displays the minimum blue channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum blue channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum blue channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum blue channel value of the softness range. Editable.

Cyan Channel button Enable to extract cyan channel values for the key.

Minimum Softness field Displays the minimum cyan channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum cyan channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum cyan channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum cyan channel value of the softness range. Editable.

Magenta Channel button Enable to extract magenta channel values for the key.

Minimum Softness field Displays the minimum magenta channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum magenta channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum magenta channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum magenta channel value of the softness range. Editable.

Yellow Channel button Enable to extract yellow channel values for the key.
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Minimum Softness field Displays the minimum yellow channel value of the softness range. Editable.

Minimum Tolerance field Displays the minimum yellow channel value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum yellow channel value of the tolerance range. Editable.

Maximum Softness field Displays the maximum yellow channel value of the softness range. Editable.

Luminance button Enable to extract luminance values for the key.

Minimum Softness field Displays the minimum luminance value of the softness range. Editable.

Minimum Tolerance field Displays the minimum luminance value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum luminance value of the tolerance range. Editable.

Maximum Softness field Displays the maximum luminance value of the softness range. Editable.

Plot button Activates the pick cursor. Use to sample an area of the image to display its colour value.

Frame option box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Keyer YUV
Use the Keyer-YUV to extract a key by adjusting tolerance and softness using luma (Y) and video component
(U,V) ranges.

To access the Keyer YUV menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip and outputs a result.
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Keyer YUV Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

Regen button Enable to get dynamic updating of the image as you make changes.

Picking Controls Settings

Key Colour colour pot Activates the pick cursor. Use to sample an area of the image to display the average
colour value.

Tolerance button Activates the pick cursor. Use to select the maximum and minimum values for the tolerance
range in the image window.

Master Tolerance field Displays the value added to the existing tolerance of each channel. Resets to 0 after
each use.

+ Increases tolerance values.

- Decreases tolerance values.

Softness button Activates the pick cursor. Use to select the maximum and minimum values for the softness
range in the image window.

Master Softness field Displays the value added to the existing softness of each channel. Resets to 0 after
each use.

+ Increases softness values.

- Decreases softness values.
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Colour Control Settings

Y Channel button Enable to extract luminance channel values for the key.

Minimum Softness field Displays the minimum luminance value of the softness range. Editable.

Minimum Tolerance field Displays the minimum luminance value of the tolerance range. Editable.

Maximum Tolerance field Displays the maximum luminance value of the tolerance range. Editable.

Maximum Softness field Displays the maximum luminance value of the softness range. Editable.

U button Enable to extract blue-luminance difference values for the key.

Minimum Softness field Displays the minimum blue-luminance difference value of the softness range.
Editable.

Minimum Tolerance field Displays the minimum blue-luminance difference value of the tolerance range.
Editable.

Maximum Tolerance field Displays the maximum blue-luminance difference value of the tolerance range.
Editable.

Maximum Softness field Displays the maximum blue-luminance difference value of the softness range.
Editable.

V button Enable to extract red-luminance difference values for the key.

Minimum Softness field Displays the minimum red-luminance difference value of the softness range.
Editable.

Minimum Tolerance field Displays the minimum red-luminance difference value of the tolerance range.
Editable.

Maximum Tolerance field Displays the maximum red-luminance difference value of the tolerance range.
Editable.

Maximum Softness field Displays the maximum red-luminance difference value of the softness range.
Editable.

Plot button Activates the pick cursor. Use to sample an area of the image to display its colour value.

Frame option box Select whether to frame the histogram based on minimum and maximum slider values,
the full range of histogram values, the plot and reference colours, or the [0:1] vertical and horizontal range
(Home).

Logical Operation
Use the Logical Operation node to process missing media in clips set to No Media, based on the input tab
it is connected to.
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To access the Logic Op menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front, back, and matte clip, and outpus a result and an output matte.

Logic Op Menu Settings

General Settings

Logical Operations box Select the logical operation you want to use to combine the source images.

Swap Inputs button Enable to switch the ordering of the front and back inputs.

Transparency field Displays the percentage of the back clip that is used in the operation. Editable.

Clamp Render box Select a clamping option for colour and luminance values on output in the 16-bit floating
point rendering pipeline.

LUT Editor
Use LUT Editor to convert logarithmic images to linear images or linear images to logarithmic images, while
maintaining color accuracy.

To access the LUT Editor menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.
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The LUT Editor node can also be used to apply a conversion to 16-bit floating-point image in the OpenEXR
file format.

The LUT Editor node can be set to output a bit depth of 8, 10, 12, or 16 bits. You can also manually set the
variables for output.

LUT Editor Menu Settings

General Settings

Conversion LUT Type box Select a basic LUT type, EXR Display, PhotoMap, or Gamma correction.

Destination box Select an output bit-depth.

Export button Opens the Export LUT menu where you select the location to export the LUT.

Basic button Enable to display the basic conversion LUT curve.

Advanced Editing button Enable to display advanced editing curves for each colour channel. RGB curves
use blending to distinguish overlapping curves.

Final button Enable to display the final conversion LUT curve.

Edit Curve box Select to display the editing curve for the selected colour channel.

Zoom field Displays the zoom percentage of the histogram. Editable.

Home box Select whether to recenter the graph or center the frame.

Reset button Applies default settings.
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Log to Lin, Lin to Log, and Gamma Settings

Red Reference White field Displays the lower limit at which red channel values are considered white.
Editable.

Green Reference White field Displays the lower limit at which green channel values are considered white.
Editable.

Blue Reference White field Displays the lower limit at which blue channel values are considered white.
Editable.

Red Reference Black field Displays the upper limit at which red channel values are considered black.
Editable.

Green Reference Black field Displays the upper limit at which green channel values are considered black.
Editable.

Blue Reference Black field Displays the upper limit at which blue channel values are considered black.
Editable.

Red Highlight field Displays the value at which greater red channel values are clamped. Editable.

Green Highlight field Displays the value at which green channel values are clamped. Editable.

Blue Highlight field Displays the value at which blue channel values are clamped. Editable.

Red Shadow field Displays the value at which lower red channel values are clamped. Editable.

Green Shadow field Displays the value at which lower green channel values are clamped. Editable.

Blue Shadow field Displays the value at which blue channel values are clamped. Editable.

Gamma Correction box Select preset gamma correction values (Video Display) or custom values. This
setting is available for Log to Lin and Lin to Log.

Red Gamma Correction field Displays the gamma correction value for the red channel. Editable.

Green Gamma Correction field Displays the gamma correction value for the green channel. Editable.

Blue Gamma Correction field Displays the gamma correction value for the blue channel. Editable.

NOTE The following settings are available for Log to Lin and Lin to Log.

Red Film Gamma field Displays the gamma correction value for the red channel. Editable.

Green Film Gamma field Displays the gamma correction value for the green channel. Editable.

Blue Film Gamma field Displays the gamma correction value for the blue channel. Editable.

Red Soft Clip field Displays the level of adjustment to the shoulder of the conversion curve for the red
channel. The upper limit is dependent on the channel's current reference white value. To create softer
highlight, drag right when using a linear curve. Drag left when using a logarithmic curve.
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Green Soft Clip field Displays the level of adjustment to the shoulder of the conversion curve for the green
channel. The upper limit is dependent on the channel's current reference white value. To create softer
highlight, drag right when using a linear curve. Drag left when using a logarithmic curve.

Blue Soft Clip field Displays the level of adjustment to the shoulder of the conversion curve for the blue
channel. The upper limit is dependent on the channel's current reference white value. To create softer
highlight, drag right when using a linear curve. Drag left when using a logarithmic curve.

Proportional button Enable to constrain channel value proportions.

EXR Display Settings

Red Exposure field Displays the luminance level of the red channel for the display image. Editable.

Green Exposure field Displays the luminance level of the green channel for the display image. Editable.

Blue Exposure field Displays the luminance level of the blue channel for the display image. Editable.

Red Defog field Displays the value to be subtracted from red color values to reduce fogging of the image.
Editable.

Green Defog field Displays the value to be subtracted from green color values to reduce fogging of the
image. Editable.

Blue Defog field Displays the value to be subtracted from blue color values to reduce fogging of the image.
Editable.

Red Knee Low field Displays the lower limit of the compressed pixel range for the red channel. Editable.

Green Knee Low field Displays the lower limit of the compressed pixel range for the green channel. Editable.

Blue Knee Low field Displays the lower limit of the compressed pixel range for the blue channel. Editable.

Red Knee High field Displays the upper limit of the compressed pixel range for the red channel. Editable.

Green Knee High field Displays the upper limit of the compressed pixel range for the green channel. Editable.

Blue Knee High field Displays the upper limit of the compressed pixel range for the blue channel. Editable.

Red Gamma Correction field Displays the gamma correction value for the red channel. Editable.

Green Gamma Correction field Displays the gamma correction value for the green channel. Editable.

Blue Gamma Correction field Displays the gamma correction value for the blue channel. Editable.

Proportional button Enable to constrain channel value proportions.
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Import Settings

Import button Open the file browser to select a 1D LUT for import.

3D LUT Settings

Import button Open the file browser to select a 3D LUT for import.

PhotoMap

Red Exposure field Displays the luminance level of the red channel for the display image. Editable.

Green Exposure field Displays the luminance level of the green channel for the display image. Editable.

Blue Exposure field Displays the luminance level of the blue channel for the display image. Editable.

Red Highlight Detail field Displays the value for the detail in the light areas of the red channel. Editable.

Green Highlight Detail field Displays the value for the detail in the light areas of the green channel. Editable.

Blue Highlight Detail field Displays the value for the detail in the light areas of the blue channel. Editable.

Red Highlight Contrast field Displays the value for the contrast in the light areas of the red channel.
Editable.

Green Highlight Contrast field Displays the value for the contrast in the light areas of the green channel.
Editable.

Blue Highlight Contrast field Displays the value for the contrast in the light areas of the blue channel.
Editable.

Red Contrast field Displays the value for the midtone contrast in the red channel. Editable.

Green Contrast field Displays the value for the midtone contrast in the green channel. Editable.
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Blue Contrast field Displays the value for the midtone contrast in the blue channel. Editable.

Red Shadow Contrast field Displays the value for the contrast in the dark areas of the red channel. Editable.

Green Shadow Contrast field Displays the value for the contrast in the dark areas of the green channel.
Editable.

Blue Shadow Contrast field Displays the value for the contrast in the dark areas of the blue channel.
Editable.

Red Shadow Detail field Displays the value for the detail in the dark areas of the red channel. Editable.

Green Shadow Detail field Displays the value for the detail in the dark areas of the green channel. Editable.

Blue Shadow Detail field Displays the value for the detail in the dark areas of the blue channel. Editable.

Proportional button Enable to constrain channel value proportions.

Encoding option box Select a standard format for the colour space.

Colour Transform Settings

Import button Use to browse and select a LUT or a colour transform.

Custom button Apply a custom chain of color transforms.

Export button Export a custom chain of colour transforms as a single .CTF file.

Add button Add a new row to the end of the chain. Click in the Type column to select or change the
transform type, and then click in the Transform column to select a transform.

Delete button Remove the selected transform from the chain.

Up button Move the selected transform earlier in the chain.

Down button Move the selected transform later in the chain.
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Map Convert
Use Map Conver to provide conversion transformation for image-based lighting (IBL) and environment
maps.

To access the 2D Transform menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and matte clip, and outputs a result an outmatte.
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Map Convert Menu Settings

Input and Output Format Settings

Input Format box Select the type of image you want to convert.

Cubic Type box Select horizontal or vertical to identify the type of cubic image you are inputting. Select
Spliced Faces to stitch together multiple images to create a horizontal cubic image. Available when Cubic is
selected in the Input Format box.

Output Format box Select the output format for the image you are converting.

The Map Convert effect accepts the following format types:

Description:Type:

Sometimes referred to as a chrome ball or mirrored ball. An image of a mirrored ball in
an assumed orthogonal projection.

Spheric

Similar to the mirrored ball format, except that the radial dimension is mapped linearly
with the angle, giving better sampling around the edges.

Angular

An image mapped onto an unfolder cylinder (also known as longitude and latitude maps).Cylindrical

An unfolded six-sided cube.Cubic (Horizontal or Vertical)

A type of cubic map available as an input format using a different frames displayed as an
unfolded cube showing six sides of the image. To use this input type, frames from the input
clip are used as the 6 faces.

Cubic (Spliced Faces)

A coordinate system for locating points in which each point on a plane is determined by
a distance from a fixed point and an angle from a fixed direction. When using this input
format, only Cartesian is available as the output format.

Polar

A coordinate system for locating points on a plane by measuring the horizontal and ver-
tical distances from an arbitrary origin to a point. When using this input format, only Polar
is available as the output format.

Cartesian
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Transform Settings

These Transform settings apply to Cylindrical, Angular, Spheric, and Cubic, (Horizontal or Vertical) input
formats.

Transform X Position field Displays the horizontal value of the image. Editable.

Transform Y Position field Displays the vertical value of the image. Editable.

Transform Z Position field Displays the depth value of the image. Editable.

In addition to the common transform settings, a Cubic (Spliced Faces) input format also contains the
following settings:

Sequence Length field When creating a cubic map from spliced images, indicate how frequently images
change in the sequence. Each change in the sequence gets mapped to a different face of the cube.

Face Assignments fields These locked fields display the order that the face assignment follows when creating
the cubic map.

X Position field Displays the horizontal position of the output image. Editable.

Y Position field Displays the vertical position of the output image. Editable.
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Scale field Displays the scale of the output image. Editable.

Rotation field Displays the rotation of the output image. Editable.

Repeat Mode box Select an option to fill the empty portions of the frame.

Radius Scale field Displays the scale of the radius for a cartesian to polar conversion. Editable.

Radius Offset field Displays the offset of the radius for a cartesian to polar conversion. Editable

Angle Scale field Displays the scale of the angle for a cartesian to polar conversion. Editable.

Angle Offset field Displays the offset of the Angle Scale for a cartesian to polar conversion. Editable.

Angular Repeat Mode box Select an option to fill the empty portions of the frame.

Output Size Settings

Output Size box Select whether to output the map at the size of the input image (Automatic), or select
Custom to change the size of the output image.

Output Width field Displays the width of the output image. Editable when you select a custom output size.

Output Height field Displays the height of the output image. Editable when you select a custom output
size.

Ratio field Displays the width to height ratio of automatic outputs. Non-editable.

Master Keyer
Use the Master Keyer to gesturally pull a key.
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To access the Master Keyer menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front, back and key in clip, and outputs a result and an outmatte.

Add a Master Keyer node to the pipeline when you need to create an accurate key of a clip. Use the Master
Keyer node to automatically suppress colour spill, to colour correct, and to remove noise or grain. See Cre-
ating and Refining a Key in the Master Keyer (page 555).

Select an output type from the Select Output box.

(a) Select Output box

The Master Keyer node processes gaps in clips set to No Media based on the input tab receiving the
information.

ResultInput

No mediaFront

Black framesBack

White framesMatte
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Master Keyer Menu Settings

MasterK Settings

Primary Sample colour pot Activates a pick cursor. Use to sample an area of the image.

Mix field Displays the mix between the primary and secondary sample. Drag right to include more of the
secondary sample or left to include less.

Secondary Sample colour pot Activates a pick cursor. Use to sample an area of the image where you do
not want any softness in the matte.

Patch1 button Enable to isolate a range of colours to be included in, or excluded from, the key. This button
is active when an area of the image is sampled and Patch1 is selected in the Sampling box.

Patch box Select the areas of the matte to which the patch is applied.

Patch Range field Displays the colour range value. Editable.

Patch Softness field Displays the softness value. Editable.

Patch2 button Enable to isolate a range of colours to be included in, or excluded from, the key. This button
is active when an area of the image is sampled and Patch2 is selected in the Sampling box.

Patch box Select the areas of the matte to which the patch is applied.

Patch Range field Displays the colour range value. Editable.

Patch Softness field Displays the softness value. Editable.

Patch3 button Enable to isolate a range of colours to be included in, or excluded from, the key. This button
is active when an area of the image is sampled and Patch3 is selected in the Sampling box.

Patch box Select the areas of the matte to which the patch is applied.

Patch Range field Displays the colour range value. Editable.

Patch Softness field Displays the softness value. Editable.

Degrain button Enable to modify the grain and de-sharpen the edges of the key.

Size field Displays the size of the grain in the image. Editable.

Edges field Displays the level of sharpness of edges in the image. Editable.

More button Enable to increase the overall Degrain effect.

Sampling box Select the sampling method required to refine the key.

Reset button Resets sampling parameters (excluding the mix value and key colour).
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Primary Reference colour pot Activates a pick cursor. Use to sample an area of the image.

Secondary Reference colour pot Activates a pick cursor. Use to sample an area of the image where you do
not want any softness in the matte.

Colour Settings

Luma field Displays the luminance value. Editable.

Edge Size field Displays the range for the blend. Both the Luma field and the Edge Balance trackball are
affected. Editable.

Spill colour pot Displays the colour to suppress in the clip. Editable.

Range field Displays the range for the removal of colour spill along the edges of the key. Drag right to soften
the edge and remove colour spill further into the key. Drag left to harden, or create a thinner, edge.

Hue field Displays the hue value. Editable.

Auto Colour Correct button Enable to apply colour settings to the front clip.

Reset button Resets the colour settings.

Result Output

Result Output button Select the output mode for the result.

Matchbox
Matchbox is an interactive development tool that allows you to run generic OpenGL Shading Language
(GLSL) shader code directly in ConnectFX, to add specific functionality, or create custom effects. GLSL is a
high-level shading language that is part of the OpenGL specification.

Because of the nature of GLSL fragment shaders, Matchbox works well on image processing effects. You can
however, create simulated 3D effects using a number of image processing techniques, like using a Z-depth
pass, for example.

The Matchbox node populates the user interface dynamically, based on the parameters required by the
shader. You can also design and implement more sophisticated interface elements and naming, through
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the use of an XML sidecar file. A utility is included to test your shader code and help you create the sidecar
XML UI file, if needed.

Re-purposing of existing effects is easy, since Matchbox shaders are simple generic GLSL fragment shader
code, with no encryption, and no required customization. Included are a number of useful example shaders,
that can be used as is, or serve as starting points for you to develop your own tools. Some of the included
example shaders are:
■ Vignetting

■ Fabric

■ Cross Hatching

■ NaN Replace

■ Switcher

■ Ripples

■ Twirl

■ Warp

■ Posterise

■ Z-Glow (multipass shader)

■ Z-Rays (multipass shader)

■ Median Filter (multipass shader)

To access the Matchbox menu:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node has six physical inputs, but you are not limited to the amount of actual inputs you can use in the
effect, since you can use the same image for more than one input. It also outputs a result and an outmatte.

Matchbox Menu Settings

Most of the Matchbox menu is generated dynamically based on the GLSL (and optional XML) code, but
there are a few UI elements that are constant.

Name field This locked field displays the name of the current shader.

Change Shader button Click to open the file browser to select a different shader.

Regen button Enable to automatically update the image as settings are changed.
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Output Resolution box Select an output resolution for the effect. If you select Custom, settings appear with
presets and custom options.

Output Width field Displays the width of the selected output resolution. Non-editable.

Output Height field Displays the height of the selected output resolution. Non-editable.

Creating Your Own Matchbox Effects

A great benefit of working with the Matchbox tool is being able to create your own effects, depending on
your particular needs. Creating a Matchbox shader can be as simple as copying and pasting GLSL code
snippets, or can be complex multipass effects with multiple inputs and dozens of UI elements. For example,
here is the contents of a simple Add effect:

uniform sampler2D input1, input2;
uniform float adsk_result_w, adsk_result_h;

void main()
{

vec2 coords = gl_FragCoord.xy / vec2( adsk_result_w, adsk_result_h );
vec3 sourceColor1 = texture2D(input1, coords).rgb;
vec3 sourceColor2 = texture2D(input2, coords).rgb;

gl_FragColor = vec4( sourceColor1+sourceColor2, 1.0 );
}

Here's a quick high-level workflow to follow when creating Matchbox shaders:

1 Write or copy/paste GLSL fragment shader code.

2 Use the provided command line tool to test the shader.

3 Edit the Shader Description output from the test tool.

4 Package the XML and GLSL code together for use in Smoke.

Writing and Testing GLSL Fragment Shader Code

You can repurpose existing fragment shader code, or create an effect specific to your needs. In either case,
you can use the test_shader utility to validate and debug your code, and optionally help you design user
interface elements in a sidecar XML file. The test_shader utility also has an extensive Help file that lists the
available uniforms (including a number of adsk_ custom uniforms) and XML structure.

The test_shader utility can be found in /usr/discreet/<product home>/bin. To access the Help file, from the bin
directory, type test_shader --help.

To create and test a fragment shader:

1 Write or copy your fragment shader code in a text editor.

2 Save the file with the extension .glsl. For example, here is the contents of a scaling effect:
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1 uniform float size;
2 uniform sampler2D myInputTex;
3
4 void main (void) {
5 vec4 tex0 = texture2D(myInputTex, gl_TexCoord[0] * size);
6 gl_FragColor = vec4 (tex0.rgb, 1.0);
7 }

3 Run your code through the test utility. For example, test_shader scale.glsl produces this result:

0(5) : warning C7011: implicit cast from "vec4" to "vec2"

XML :
<ShaderNodeDescription Description="" Name="Preset Name">
<Shader Index="1">

<Uniform RepeatMode="Off" InterpolationMode="Linear" Type="sampler2D"
Tooltip="" Name="myInputTex">

</Uniform>
<Uniform DisplayName="size" Type="float" Name="size">

<SubUniform Inc="0.01" Max="1000000.0" Min="-1000000.0" Default="0.0"
Row="0" Col="0" Page="0" Tooltip="" Name="size">

</SubUniform>
</Uniform>

</Shader>
<Page Name="Page 1" Page="0">

<Col Name="Column 1" Col="0" Page="0">
</Col>

</Page>
</ShaderNodeDescription>

In this case, the first line displays a compilation warning that you might want to fix. In some cases,
you'll receive errors that need to be fixed for the shader to work properly in Smoke.

4 Fix any errors, and rerun the code through the test_shader utility.

5 Optional: Use the XML information in the test_shader output to help you set up the UI of the effect.
This can be especially useful if different users are going to be working with these effects.

Simply copy the XML shader node description section of the test output into a new file and save it
using the same name, but with an .xml extension. In our example, you can edit scale.xml to add default
values, better names for inputs and other UI elements, and even tooltips to help the user (see the bold
sections below):

<ShaderNodePreset SupportsAdaptiveDegradation="0" Description="" Name="Next 
Generation Scaling">

<Shader OutputBitDepth="Output" Index="1">
<Uniform Index="0" NoInput="Error" Tooltip="" DisplayName="Front"

Mipmaps="False" GL_TEXTURE_WRAP_T="GL_REPEAT" GL_TEXTURE_WRAP_S="GL_REPEAT"
GL_TEXTURE_MAG_FILTER="GL_LINEAR" GL_TEXTURE_MIN_FILTER="GL_LINEAR"
Type="sampler2D" Name="myInputTex">

</Uniform>
<Uniform ResDependent="None" Max="100.00" Min="-100.00" Default="0.0"

Inc="0.01" Tooltip="Displays the percentage of scaling applied to the image." Row="0"

Col="0" Page="0" DisplayName="size" Type="float" Name="Scale">
</Uniform>

</Shader>
<Page Name="Page 1" Page="0">

<Col Name="Effect Settings" Col="0" Page="0">
</Col>
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</Page>
</ShaderNodePreset>

6 Add your .glsl and optional sidecar .xml file to the same directory. The existing shader example files
are located in /usr/discreet/<product home>/matchbox.

7 Try your effect in Smoke or Flame.

Creating Multipass Shaders

In order to build more efficient, complex, or sophisticated effects, you can split your effects into multiple
passes. In order to do this, you can separate your effect into multiple .glsl files using advanced adsk_ uniforms.
For example, the existing Median Filter preset consists of MedianFilter.1.glsl and MedianFilter.2.glsl. In this
case, when selecting this effect from the Load Shaders browser in Smoke, you need to select the root group
MedianFilter.glsl file to incorporate all of the passes as one effect.

Optional: Creating Browser Proxy Files

Along with the .glsl and optional .xml files that comprise a fragment shader, you can also create a file that
can display a proxy of your effect in the Load Shaders browser. You can use Smoke to create a proxy of your
effect, but if you don't have access to Smoke, or want to create proxies programmatically, you can use the
following header (byteswap). The standard width and height of the proxy is 126x92, and the file is RGB
8-bit. Save your proxy files as .p, and place them in the same folder as your .glsl and .xml files of the same
name.

typedef struct {
unsigned short Magic;
float Version;
short Width;
short Height;
short Depth;
float Unused [ 6 ];

} LibraryProxyHeaderStruct;

#define PROXY_MAGIC 0xfaf0
#define PROXY_VERSION 1.1f
#define PROXY_DEPTH 130

Matte Curves
Use Matte Curves to adjust the luminance of input mattes.

To access the Matte Curves menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front, back and matte clip, and outputs a result.

NOTE The Matte Curves node is the same as the Modular Keyer Matte Curves node.
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The Matte Curves node processes gaps in clips set to No Media based on the input tab receiving the
information.

ResultInput

Black framesFront

Black framesBack

No mediaMatte

Matte Curves Menu Settings

General Settings

Result box Select the type of clip you want to process.

Home button Reverts to the original view.

Reset box Resets the curve view.

Matte box Select the matte curve you want to adjust.

Set Key button Sets a keyframe at the selected frame.

Delete Key button Deletes the selected keyframe.

Reset Key button Resets the curves at the selected keyframe.

Matte Edge
Use the Matte Edge effect to create an image based on the detected edges, or use it to modify the edges of a
matte to help in creating a key.
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To access the Matte Edge menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front and matte clip as inputs, and outputs a result. You can add the Matte Edge node
to any part of the pipeline except the Front pipe of the CBLend node. The Matte Edge node is not appropriate
for this pipe because its result is a matte.

Matte Edge Menu Settings

General Settings

Rendering box Select whether to render in Progressive or Interlaced mode.

Regen button Enable to get dynamic updating of the image as you make changes.

Edges Settings

Edges button Enable to create an image composed of the edges in an image.

Matte Edge Mode box Select whether to use the Basic, Advanced or Smooth edge-detection algorithm.
Certain settings change based on this selection.
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Basic Settings

Width field Displays the value that affects how the edge-detection algorithm determines whether each pixel
forms part of the edge. Editable.

Minimum Input field Displays the lower limit of the luminance values. Pixels with lower values are mapped
to black. Editable.

Maximum Input field Displays the upper limit of the luminance values. Pixels with higher values are
mapped to white. Editable.

Advanced Settings

Minimum Input field Displays the lower limit of the luminance values. Pixels with lower values are mapped
to black. Editable.

Maximum Input field Displays the upper limit of the luminance values. Pixels with higher values are
mapped to white. Editable.

Inner Width field Displays the width of the inner edges of the matte. Editable.

Outer Width field Displays the width of the outer edges of the matte. Editable.

Width Proportional button Enable to affect the inner and outer width proportionally.

Inner Softness field Displays the level of softness on the inner edges of the matte. Editable.

Outer Softness field Displays the level of softness on the outer edges of the matte. Editable.

Softness Proportional button Enable to affect the inner and outer softness proportionally.
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Smooth Settings

Smooth Minimum field Enter a lower limit for the edge detection. Editable.

Smooth Maximum field Enter the upper limit for the edge detection. Editable.

Smooth Softness field Enter a value for softness of the edge. Editable.

Smooth Gain field Enter a value for the softness gain of the edge. Editable.

Shrink Settings

Shrink button Enable to remove pixels from the edge of the matte.

Shrink Mode box Select whether to use shrink in a single pass or iterative mode. Single Pass mode allows
you to control edge softness.

Shrink Width field Displays the width of the border that is removed from the edge of the matte. Editable.

Softness field Displays the amount of softness applied to the edges of the matte.

Minimum Input field Displays the lower limit of the luminance values. Pixels with lower values are mapped
to black. Editable.

Maximum Input field Displays the upper limit of the luminance values. Pixels with higher values are
mapped to white. Editable.

Erode Settings

Erode button Enable to blend the light and dark edges of the matte.

Erode Width field Displays the width of the matte border to soften. Editable.
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Blur Settings

Blur button Enable to apply a softening Gaussian blur filter to the edge of the matte.

Blur Width field Displays the width of the blur applied to the edge of the matte. Editable.

Blur Height field Displays the height of the blur applied to the edge of the matte. Editable.

Proportional button Enable to constrain blur amount proportions.

Matte Luminance Curve Settings

Matte Luminance Curve Controls the blending of the edges.You can add keyframes to the curve using Add
mode, move keyframes with Move mode, and modify the curve's shape using tangent handles.

Reset box Resets the curve view.

Home button Reverts to the original view.
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Noise Settings

Noise button Enable to add noise to the transparent areas of the matte.

Noise Mode box Select the mode of noise to apply throughout the length of the image. Static adds noise
as a still frame; Impulse adds noise that changes at each frame.

To add noise:Select:

As a still frame. You can move the static noise using the Position X and Y fields.Static

Changing at each frame, but always starting from the same seed.Impulse

Weight field Displays the level of noise in the clip. Values below 1 add more white noise, and values above
1 add black noise. Editable.

Softness field Displays the level of Gaussian softness added to the noise. Editable.

Position X field Displays the X position of the noise when using Static mode. Editable.

Position Y field Displays the Y position of the noise when using Static mode. Editable.

Size X field Displays the size of the noise along the X axis. Editable.

Size Y field Displays the size of the noise along the Y axis. Editable.

Proportional button Enable to affect the X and Y sizes proportionally.

Mono
Use Mono to generate a monochrome copy of the front clip.

To access the Mono menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).
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■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

Mono Menu Settings

General Settings

Luminance box Select the channel you want to use to create the monochrome clip.

Motif
Use the Motif node to create a tiled symmetrical texture.

To access the Motif menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front and a matte input, and outputs a result clip and a matte output.

Source clips can be transformed before symmetrical effects are applied. Transformations are applied to both
the front and matte clips simultaneously. You can select the type of symmetry mode to use on the
transformation, and define its parameters.

The radial symmetry mode displays a user-defined widget, which is a polygon with an equal number of
sectors to the order of symmetry. You select the sector to use as the originating tile, the basis for a kaleidoscopic
texture. Additional parameters allow you to define the center of symmetry of the image, and the angle and
radius of the originating tile.
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Front and Result views in radial symmetry mode

In Radial mode, you can also reuse the pixel on the edge of a sector to pad the space between outer tiles.

Result views with the repeating disabled and enabled

The region of interest (ROI) effect uses a user-defined rectangular or triangular selection as the originating
tile to create a basic mirrored texture.
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Front and Result views in region of interest symmetry mode

Image courtesy of The House

Motif Menu Settings

Motif Node

The Motif node displays 2D Texture Transform controls that allow you to simultaneously change the position,
scaling, rotation, and type of image padding. The Symmetry Mode controls display a colour pot for the
original tile selection.

2D Texture Transform settings

X Position field Displays the horizontal offset in pixels of the input and matte clips. Editable.

Y Position field Displays the vertical offset in pixels of the input and matte clips. Editable.

X Scaling field Displays the amount of horizontal scaling to apply to the front and matte clips.

Y Scaling field Displays the amount of vertical scaling to apply to the front and matte clips. Editable.

Scaling proportional button Enable to effect Scale X and Scale Y proportionally.

Rotation field Displays the angle of rotation of the front and matte clips. Editable.

Repeat button Select fill options to pad the empty portions of the frame with the last line of pixels, a repeated
(rolled) image, or black pixels.

Symmetry Mode settings

Mode button Select the type of symmetry effect to apply to the transformation. Additional parameters are
displayed in Radial mode.

NOTE The following settings are available when the Symmetry Mode button is set to ROI.
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Symmetry Mode box Select between a square or triangle region of interest mode.

Proportional button Enable to effect Scale X and Scale Y proportionally.

NOTE The following settings are available when the Symmetry Mode button is set to Radial.

Order field Displays the order of symmetry and indicates the number of sectors or sides of the polygonal
widget.An order of 2 creates a basic mirrored image. An order of symmetry can have an odd number as a
value. Tiles are mirrored in a counter-clockwise direction, therefor the sector to the right of the highlighted
sector may not be its mirror image. Editable.

Even button Enable to maintain an even order of symmetry.If the order of symmetry is an odd value, an
extra tile will be added, ensuring that adjacent tiles are mirror images of each other.

Angle field Displays angle of the axis of symmetry. Editable.

Radius field Displays the pixel length of the sector radius. Editable.

Edge Repeat button Enable to use the pixel colour on the sector's edge to pad the space between outer tiles.
Displayed in Radial mode.

Position X field Displays the horizontal position of the centre of symmetry. Editable.

Position Y field Displays the vertical position of the centre of symmetry. Editable.

Softness settings

Softness field Displays the amount by which the motif effect is out of focus. Editable.
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Display settings

Show Widgets button Enable to display the widgets in the clip.

Widget colour pot Select the colour used to highlight the originating tile. Editable.

Gestural Modifications

Modifications to the originating tile and symmetry mode parameters can be made gesturally in any view.

To:Drag:

Change the width or height of the selection.Outer edge of the region of interest

Change the width and height of the selection.Corner of the region of interest

Move the selection.Inside the region of interest or widget

Change the centre of symmetry.The widget centre

Change the radius and the angle of symmetry.Circle on the outer edge of the widget

Motion Analysis
Use Motion Analysis to analyse image displacement in a frame with respect to the frame before it.

To access the Motion Analysis menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip, and outputs forward and backward vectors.
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Motion Analysis Menu Settings

General Settings

Quality box Select Use Full Resolution to render the image at the current resolution, or an option with
decreased motion analysis accuracy and increased rendering speed.

Motion Blur
Use Motion Blur to simulate the blur created by fast moving objects.

To access the Motion Blur menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts front, matte and forward vector clips and outputs a result, outmatte, or forward Vector
clip.
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Motion Blur Menu Settings

Vector Input Type Settings

Vector Input Type button Select whether the vector inputs are Absolute or Normalized.

Max Dispersion field Displays the level of motion displacement in the image. Set to the same value that
was set in the 3D application. Editable.

Blue Channel Magnitude field Enable to use the blue channel as a magnitude multiplication of the maximum
displacement value.

Black As No Movement button Enable to set black pixels as no movement in the motion vector. When
enabled, you can set a threshold value for near-black pixels.

Threshold field Displays the level of near-black pixels taken into account in the conversion.

Vector Viewing Settings

Show Icons button Displays the forward motion vectors in the Result view.

Colour pot Changes the display colour of the forward and backward motion vectors.

Grid Step field Displays the length of the pixel area used to calculate each vector.

Scale field Displays the size of the motion vectors.

1042 | Chapter 22   Effects and Tools Reference



Blur Type Settings

Blur Type button Enable this button to select between trails and samples. Choose trails for a pixel-based
motion blur. Choose sample for an accumulation-based motion blur.

Blur Type amount field Displays the amount of motion blur applied to the image. Editable.

Blur Type softness field Displays the amount of softness applied to the trails. Only available when trails is
selected as the blur type. Editable.

Blur Type balance field Displays the amount of blur that either precedes or follows the image. The more
positive the number, the more blur precedes the image. The more negative the number, the more blur follows
the image. Editable.

Artefacts Settings

Vector Softness field Displays the amount of softness that is applied to reduce the quality of vectors, and
therefor solve precision artefacts. Editable.

Post Blur field Displays the amount of global blur applied after other effects have been applied. Apply
conservatively. Editable.

Matte Fill field Display the amount used to fill in gaps in the matte. Best applied after softness adjusted.
Only available when the blur type is trials. Editable.

Colour Interpolation Settings

Colour Interpolation button Enable this button to verify that the source is already premultiplied. In this
case, the colour interpolation effect must treat the image differently for the effect to work properly. This
button is only functional when there is an input matte.

Motion Opacity Curve

Motion Opacity Curve Allows you to control the opacity of the trail by shaping it using the curve.
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Home button Reverts to the original view.

Reset box Resets the curve view.

MUX
Use MUX to make multiple output sockets and to propagate an input to multiple other nodes in the Schematic.
You can also use it to clarify both its graphical representation and the connection scheme of nodes within
the group.

To access the MUX menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front clip, and outputs a result.

MUX Menu Settings

Hide Links Settings

Input button Enable to hide the input link to the MUX node.

Output button Enable to hide all output links to the MUX node.

Timing Offset Settings

Timing Offset field Displays the number of frames by which the timing of the MUX pipeline is offset.
Editable.

FX Range Settings

Range Active button Enable to activate the range settings.

Range From field Displays the first impacted frame. Editable.
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Range To field Displays the last impacted frame. Editable.

Range Before box Select an option to apply before the set frame range.

Range After box Select an option to apply after the set frame range.

NOTE There are two Ping Pong options included in the Range Before box and Range After box: Ping Pong and
Ping Pong+. The Ping Pong repeat mode is inclusive, meaning that the last frame of the sequence is always
repeated. For example, a five frame sequence would be: 1-2-3-4-5-5-4-3-2-1-1-2-3-4. The Ping Pong+ repeat
mode is exclusive, meaning that the last frame of the sequence is never repeated creating a sequence that is always
1 frame shorter, but that does not create stuttering with a frame repeat.

Freeze Current Frame button Click to output the image of the currently selected frame for the duration of
the clip.

Optics
Use Optics to add a glow effect to the clip in the process tree.

To access the Optics menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts front, back, and matte clips, and outputs a result.

The Optics node processes gaps in clips set to No Media based on the input tabs receiving the information.

ResultInput

No mediaFront

Black framesBack

No mediaMatte
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Optics Menu Settings

Optics Node Settings

Size field Displays the size of the glow effect. Editable.

Intensity field Displays the intensity level of the glow effect. Editable.

Noise field Displays the jitter level in the glow effect. Editable.

Transparency field Displays the transparency level of the front clip. Editable.

Optics Front button Enable to use the front clip.

Optics Back button Enable to use the back clip.

Invert button Enable to invert the matte clip.

Random button Enable to produce a different glow effect.

Interior colour pot Select a colour for the interior of the glow effect.

Exterior Colour pot Select a colour for the exterior of the glow effect.

Optics: Creating Glow Effects

Use Optics to add glow effects around front clips composited over back clips. The shape of the glow is
determined by the matte you select when entering Optics.

To add a glow effect to a clip:

1 In the Main menu, click Effects.

2 In the Effects menu, click Optics.

3 Select the front, back, and matte clips, and a destination.

The Optics menu appears. By default, Front view is enabled to speed up processing.

(a) View box (b) Optics Front and Back buttons

4 From the View box, select Result to view the glow effect.
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5 Use the Optics Front and Back buttons to enable or disable the front and back clips. You can also invert
the matte by enabling Invert.

6 If necessary, use the Size and Intensity fields to adjust the size and intensity of the glow effect.

7 Adjust the noise factor to make the glow jitter in the processed clip.

NOTE If you want to create a second processed clip where the glow jitters in a slightly different way from
the first one, enable Random before processing the second clip.

8 If necessary, use the Transparency field to adjust the transparency of the front clip.

NOTE Make sure to enable the Optics Front button.

9 Use the colour pots to change the colour of the glow. Click the colour pot to display the colour picker.

The interior and exterior glow colours are blended.

NOTE To reset the glow, click the Reset All button and Confirm.

10 Click process.

The generated clip appears on the destination reel.

Paint Node
About Paint Node

Paint Node is a system that provides a scalable matte painting, retouching, or restoration workflow in
ConnectFX.

Due to its underlying technology, Paint Node automatically scales strokes when changing the resolution,
ratio, or bit depth of input clips, or when switching from Full Resolution to Proxy mode. Paint Node supports
“clipless” setups, which can be applied to any image input, while accurately reproducing the sequence of
painted strokes.

The Paint Node accepts a front and matte clip as input, and creates a result and output matte clip, respectively.
You can paint on the result and output matte, with a selection of brushes in different paint modes.

Paint Node also allows you to connect multiple sources and use them to paint the contents of source images
onto the result. This paint operation, applied with the Reveal paint tool, can be used with in-context overlay
over the result image. A front and matte clip can be connected as a source by connecting the clips to a source
node. The content of source front and source matte input can be used to create brush strokes on the result
and output matte.

Paint Node can be accessed from:
■ ConnectFX. (page 731)

■ Modular Keyer. (page 732)

The following views are available in Paint Node.

To display:Select:

The front clip or ConnectFX tree input. The modifications to the front create the
result clip.

Front (F1)

The matte clip or ConnectFX tree input. The modifications to the matte create
the output matte.

Matte (F3)
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To display:Select:

The source front that is selected in the Sources list.Source Front (F1 F1)

The source matte that is selected in the Sources list.Source Matte (F3 F3)

The result image. Paint can be applied to the result.Result (F4)

The output matte image. Paint can be applied to the output matte.Output Matte (F4 F4)

Paint Node Menu Settings

Source Controls

Displays the front clip, matte clip, and sources. The Sources list manages the sources attached to the current
node. A source is composed of a front source and a matte source. See Using Sources (page 732) .

Add button Click to add a new source node, and select the source front and source matte. Ctrl-click to add
a source node only.

Source Front option box Select Front Lock to use the current frame for the duration of the source front
clip. Select Front On to unlock the clip and apply it in its original state.

Source Matte option box Select Matte Off to paint anywhere on the canvas, Matte On to limit painting to
areas on the source matte, or Matte Invert to limit painting to areas outside the source matte.

Hide Strokes button Hides the strokes associated with the current source.

Clear Strokes button Clears the strokes associated with the current source.

Current Frame box Select to clear strokes for the Current Frame or the entire Sequence.

Sources List Displays the sources attached to the current node.

Brush Attributes

Sets the size of the brush and other brush attributes affecting how paint is applied to the canvas. See Brush
Attributes and Attribute Modes (page 737).

Size field Set the radius of the brush in pixels. Editable.

Rate field Set the rate at which to apply brush strokes to the canvas. Use a higher percentage value to produce
a smoother continuous stroke. Editable.

Fixed Rate button Enable to make the stroke dependent on the speed at which you move the brush.

Pressure field Set the transparency on the pressure and direction of the pen. Editable.

Jitter field Set the level of dispersion. A lower value produces a greater concentration of paint. Editable.

Direction field Set the percentage of a complete rotation to rotate the brush around the Z-axis. Editable.

Roll field Set the percentage of a complete rotation to rotate the brush around the X-axis. Editable.

Brush Attribute Modes

Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

1048 | Chapter 22   Effects and Tools Reference



Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

Brush Attribute Modes option box Select an attribute as a reference value. Select a clip to use its luminance
as a reference.

Paint Mode

Sets the type of paint operation that is applied to the brush. Some brushes paint in a colour; others use
contents of the result or a source. See Using Paint Modes (page 746) and Using Blending Modes (page 750).

Paint Modes box Select the type of effect you want to apply to the brush.

Opacity field Displays the opacity of the brush. Use a lower value to apply a more transparent colour.
Editable.

Fade field Displays how quickly the stroke fades when the Fade brush attribute mode is selected. A higher
value fades the stroke faster.

Blending Modes box Select the blending operation to apply to the brush colour components.

Paint On box Select to apply strokes to the current frame, from the current frame to the last frame, or to
all frames in the sequence.

Scale field Displays the scale value of the reference image. Editable.

Rotate field Displays the angle of rotation to rotate the reference image. Editable.

X Offset field Displays the horizontal coordinate for the Clone offset. Editable.

Y Offset field Displays the vertical coordinate for the Clone offset. Editable.

Overlay Controls

Overlay button Enable to show a reference clip overlaid onto the canvas.

Reference box Select the view with the reference clip you want overlay.

Transparency field Set the transparency percentage of the reference clip. Editable.

Colour Palette and Brushes

Current colour pot Select the current brush colour. Editable.

Preset colour pots Select preset brush colours. Editable.

Brushes Select a default brush profile to set it as the brush stroke.

Matte Controls

Defines the area that can be used to paint. You can paint on the entire canvas or areas delimited by the
matte properties. See Restricting Strokes with the Source Matte (page 736) and Restricting Brush Strokes (page
744).
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Use Matte button Enable to limit brush strokes on the canvas to areas inside the matte.

Invert button Enable to limit brush strokes on the canvas to areas outside the matte.

Both button Enable to paint on the result and output matte simultaneously.

Canvas Controls

Controls clearing and wiping the canvas at the current frame. See Using the Canvas (page 752).

Clear box Select whether to clear all strokes from the result image and output matte at the current frame
or to clear strokes from all frames.

Wipe button Select to apply a uniform colour in a single brush stroke to the entire result image, the front
only or the output matte only at the current frame.

Wipe colour pot Select the wipe brush stroke. Editable.

Use Source button Enable to use the current source to wipe over the image.

Rotation field Displays the angle of rotation used to rotate the canvas in the image window. Editable.

Node Setup

Active Enable to activate smooth filtering of pixels for enhanced display.

Pixel Spread
Use Pixel Spread to create a stretching effect from the image edges delimted by a matte. This can be useful
to solve keying problems resulting from dark edges around the area to be keyed, for example.
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To access the Pixel Spread menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a front, back and matte clip, as well as a vector map clip, and outputs a result and an
outmatte.

Pixel Spread Menu Settings

Type Settings

Spread Type box Select the type of pixel spread distortion effect to apply to the clip.
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Spread Mode box Select whether to have the distortion effect work in expansion mode or contraction
mode.Active when Spread Type is set to Stretch, Parallax, or Interpolate.

Spread Settings

The following settings are available when Interpolate is selected from the Spread Type box.

Interpolation Softness Amount field Displays the amount of softness applied. Editable.

Edges Shrink Amount field Displays the amount of shrinking applied to the edges. Editable.

Edges Shrink Softness field Displays the softness of the edge. Editable.

Interpolation Source Premultiplied button Enable to verify if the source is already premultiplied, in which
case the interpolation effect must treat the image differently for the effect to work properly.

The following settings are available when Parallax is selected from the Spread Type box.

Parallax Amount field Displays the amount of parallax distortion applied to the clip, in pixels. Editable.

Parallax X Bias field Displays the amount of horizontal offset applied to the parallax distortion effect, in
pixels. Editable.

Parallax Y Bias field Displays the amount of vertical offset applied to the parallax distortion effect, in pixels.
Editable.

Parallax Rotation field Displays the degree of rotation applied to the pixel distortion. Editable.

Edges Width field Displays the width of the distortion edge, in pixels. Editable.

Edges MidPoint field Displays the offset of the distortion edge from the middle. Editable.

Spread Blur Amount field Displays the amount of blur applied to the clip following the direction of the
edge. Editable.

Parallax Repeat Mode box Select an option to fill the empty portions of the frame.
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The following settings are available when Stretch is selected from the Spread Type box.

Stretch Amount field Displays the amount of stretching distortion applied to the clip, in pixels. Editable.

Edges Width field Displays the width of the distortion edge, in pixels. Editable.

Edges MidPoint field Displays the offset of the distortion edge from the middle. Editable.

Spread Blur Amount field Displays the amount of blur applied to the clip following the direction of the
edge. Editable.

The following settings are available when Vector Warp is selected from the Spread Type box.

Motion Distance field Displays the amount of distortion to be applied to the image based on a given motion
vector. A negative amount inverts the direction of the spread. Editable.

Motion Threshold field Displays the percentage for the cut-off point below which motion data is not applied
to the image. Editable.

Vector X Origin field Displays the starting point of any horizontal motion, which can be used to offset
values entered for X Gain. Editable.

Vector Y Origin field Displays the starting point of any vertical motion, which can be used to offset values
entered for Y Gain. Editable.

Vector Overlap button Enable to invert the effects of the vector warp.

Red X Gain field Displays the amount of gain used from the red channel to augment the horizontal motion
of the distortion effect on the image. Editable.

Red Y Gain field Displays the amount of gain used from the red channel to augment the vertical motion
of the distortion effect on the image. Editable.

Green X Gain field Displays the amount of gain used from the green channel to augment the horizontal
motion of the distortion effect on the image. Editable.

Green Y Gain field Displays the amount of gain used from the green channel to augment the vertical motion
of the distortion effect on the image. Editable.

Blue X Gain field Displays the amount of gain used from the blue channel to augment the horizontal
motion of the distortion effect on the image. Editable.
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Blue Y Gain field Displays the amount of gain used from the blue channel to augment the vertical motion
of the distortion effect on the image. Editable.

Spread Blur Amount field Displays the amount of blur applied to the clip following the direction of the
edge. Editable.

Output Settings

Result Output box Select whether to output a combined result or the pixel spread effect only.

Alpha Output box Select Input to output the input matte, or Spread Matte to output the matte generated
by the pixel spread.

Pulldown
Use the Pulldown to remove or add pulldown to a clip.

To access the Pulldown menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front clip as input, and outputs a result.

Additionally, the Pulldown node supports the following:
■ 2:3 pulldown, also known as standard pulldown

■ 2:3:3:2 pulldown, also known as advanced pulldown

■ 24-to-25 fps conversion, also known as PAL pulldown
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Pulldown Menu Settings

Pulldown Settings

When removing a pulldown, you can analyse the clip to automatically detect the type of pulldown and the
A frame. If the analysis fails to determine the type of pulldown or the location of the AA frame, manually
set the Pulldown and the A Frame Location options.

(a) Pulldown Mode option box (b) Pulldown Type option box (c) Remove Pulldown options; available when Pulldown
Mode is set to Remove Pulldown

Pulldown type option box Select an option to add or remove pulldown from the clip.

First Rendered Frame field Displays the first frame at which output is rendered from the node. Unrendered
output does not display any media.Editable.

Pulldown option box Select the type of pulldown process to apply to the clip.

A Frame Location field Displays the value of a reference (AA) frame. The selected frame becomes the frame
of reference when adding or removing pulldown frames.Editable.

NOTE The following settings are available when Remove Pulldown is selected from the Pulldown Type option
box.

Analyze button Click to determine the type of pulldown used and the A frame.

Last Detection Frame field Displays the value of the last frame of the clip used by the Analyse button.
Selecting a subset of a clip speeds up the analysis. Editable.

NOTE When the node renders a transition, preceding and subsequent frames with no media are replaced with
black frames.

Quick Composite
Use Quick Composite for one-step compositing of a front and back clip using a matte clip.

To access the Quick Composite menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).
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■ Tools, then select from the menu.

This node accepts a front, back and matte clip, and outputs a result.

You can use the Front and Back fields to increase or decrease the luminance of the front and back clips. The
values specify the gain for the clips. Quick Composite multiplies the luminance values in the clips by the
gain values you set. The resulting luminance values are clipped at the maximum and minimum values of
255 (white) and 0 (black), respectively.

Gain is expressed as a percentage value. The default value of 100% has no effect on the image since the
luminance values are multiplied by 1. To increase the gain, set the value above 100%. To decrease the gain,
set the value below 100%.

Quick Composite Menu Settings

Quick Composite Node Settings

Blend Mode box Select an option for blending clips in the composite.

To:Select:

Use subtractive blending.Blend

Use additive blending. Select this option if the front clip has a black background, as with a
computer-generated image. This option eliminates the black fringe at the edge of the front
image.

Additive

Prevent loss of detail from the front image. For example, if the front clip is a human model,
this option prevents losing details such as hair in the composite clip.

FrontMin

Front Gain field Displays the value of the luminance of the front clip. Editable.

Back Gain field Displays the value of the luminance of the back clip. Editable.

Invert Matte button Enable to invert the matte.

Recursive Ops
Use Recursive Ops to perform a wide range of recursive, animation-based blending effects. Recursive Ops
uses the processed result of the previous frame and blends it with the current frame using a selected blending
mode. It features a built-in colour selection, which constrains the accumulation effect within that selection.
Additionally, it accepts an external matte input which also conditions the way in which the internal blending
occurs.
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To access the Recursive Ops menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts front and matte clips, and outputs a result and outmatte.

Recursive Ops Menu Settings

Regen button Enable to dynamically refresh the image as changes are made to the settings.

Repeat Mode Settings

Repeat Mode options box Select an option to fill the empty portions of the frame.

Range Settings

Range From field Displays the beginning of the range of frames that to be impacted by the effect. Editable.

Range To field Displays the end of the range of frames that to be impacted by the effect. Editable.

Range Before box Select an option to be applied before the set frame range. Bypass eliminates the effect,
while Cycle repeats the effect.

Range After box Select an option to be applied afer the set frame range. Bypass eliminates the effect, while
Cycle repeats the effect.
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Effects Settings

Crumple Distortion button Enable to activate the crumple settings.

Amplitude field Displays the amount of distortion. Increase the value to increase the crumple effect. Editable.

Time Offset field Displays the time offset interval of the crumpling. Editable.

Octaves field Displays the number of layers summed in the operation, from 0 to 10. Increase the value to
increase the fractal crumple effect. Editable.

Blur button Enable to activate the blur settings.

Amount field Displays the amount of blur applied to the image. Editable.

2D Transform Settings

Active button Enable to activate the 2D Transform settings.

Show Icons button Enable to display the vertex editing tools in the image window.

Position X field Displays the horizontal position of the transformation. Editable.

Position Y field Displays the vertical position of the transformation. Editable.

Centre X field Displays the centre point value of the transformation along the horizontal axis. Editable.

Centre Y field Displays the centre point value of the transformation along the vertical axis. Editable.

Scale X field Displays the horizontal scale factor. Editable.

Scale Y field Displays the vertical scale factor. Editable.

Proportional button Enable to scale X and Y values proportionally.
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Rotation field Displays the rotation of the transformation. Editable.

Colour Correction Settings

Activate button Enable to activate the color correction settings.

Clamping box Select a clamping option.

Gain Trackball Adjusts the gain of the input.

Saturation field Displays level of colour purity in the image. Editable.

Gamma field Displays the gamma level. Editable.

Offset field Displays a value that modifies all of the colour parameters. Editable.

Red Gain field Set the percentage of colour values in the red channel. Editable.

Green Gain field Set the percentage of colour values in the green channel. Editable.

Blue Gain field Set the percentage of colour values in the blue channel. Editable.

Luma Gain field Set the percentage of luma gain value to display. Editable.

Proportional button Enable to adjust the gain of the colour values proportionally.

Blending Settings

Blending options box Select a logical operation that can be used to blend the front clip and the result clip.

Transparency field Displays the percentage of blending when the result is composited on the front clip.
Editable.

Use Matte button Enable to apply the effect with the areas defined by the matte.
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Rendering Settings

Clamp Render box Select a clamping option for colour and luminance values on output in the 16-bit floating
point rendering pipeline.

Matte Output Settings

Matte Output options box Select an matte output option. Choose Selective to select the colour you wish
to keep.

Selective Tolerance field Displays the tolderance level of the selected colour of the matte output. Editable.
Available when Selective is chosen in the Matte Ouput options box.

Selective Colour box Click to enable the crosshair to select a colour in the image to be used as the matte
output. Available when Selective is chosen in the Matte Ouput options box.

Regrain
Use Regrain to add grain from the RGB channels of a selected colour in an image.

To access the Regrain menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

This node accepts front, back, and matte clips as input, and outputs a result.
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Regrain Menu Settings

General Settings

Image Type box Select the type of image data that is input into the node or tool. This determines the type
of transformation applied to the input clip.

fstop field Displays the relative exposure offset. Use to compensate for under or over exposure. Editable.

Grain Signature box Select a film stock grain to add to the clip.

Crop box Applies the regrain to a specific region in the clip.

Red X Radius slider Displays the value of the radius on the x-axis for the red channel. Editable.

Red X Radius field Displays the value of the radius on the x-axis for the red channel. Editable.

Green X Radius slider Displays the value of the radius on the x-axis for the green channel. Editable.

Green X Radius field Displays the value of the radius on the x-axis for the green channel. Editable.

Blue X Radius slider Displays the value of the radius on the x-axis for the blue channel. Editable.

Blue X Radius field Displays the value of the radius on the x-axis for the blue channel. Editable.

Proportional RGB Radius X button Enable to adjust the radius on the x-axis of the red, green, and blue
channels proportionally.

Red Y Radius slider Displays the value of the radius on the y-axis for the red channel. Editable.

Red Y Radius field Displays the value of the radius on the y-axis for the red channel. Editable.

Green Y Radius slider Displays the value of the radius on the y-axis for the green channel. Editable.

Green Y Radius field Displays the value of the radius on the y-axis for the green channel. Editable.

Blue Y Radius slider Displays the value of the radius on the y-axis for the blue channel. Editable.

Blue Y Radius field Displays the value of the radius on the y-axis for the blue channel. Editable.

Proportional RGB Radius Y button Enable to adjust the radius on the y-axis of the red, green, and blue
channels proportionally.

Red Gain slider Displays the grain value in the red channel. Editable.

Red Gain field Displays the grain value in the red channel. Editable.

Green Gain slider Displays the grain value in the green channel. Editable.

Green Gain field Displays the grain value in the green channel. Editable.

Blue Gain slider Displays the grain value in the blue channel. Editable.
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Blue Gain field Displays the grain value in the blue channel. Editable.

Proportional RGB Gain button Enable to adjust the grain on the red, green, and blue channels proportionally.

NOTE The following options are available when Mono or Custom are selected from the Grain Signature box.

Curves Display the curves for the luminance and each RGB channel.

Histogram box Select to display the red, green, blue, or luminance histogram in the graph. Select Current
Curve to display the histogram for the currently selected Curves Channel.

Curves box Select to display the red, green, blue or all curves in the graph.

Home button Restores the position of panned or zoomed curves to the default setting.

Reset button Resets to default curve settings.

Resize
Use Resize to change a clip's resolution, frame depth, and aspect ratio.

To access the Resize menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

■ The Modular Keyer, then select a node from the Node bin.

■ Timeline effects, then choose Resize.

This node accepts a front clip, and outputs a result.

You can also use Resize to pan and scan the destination image relative to the source. You can then select
and animate the portion of the source clip that appears as the destination clip, and process to create the
result image.

NOTE You can use Resize to output, for example, a HD project to a lower resolution for quick viewing.

Resize Menu Settings

Source Settings

Use the Source settings to set or animate the position and size of the crop box.
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Position/Scale Settings

X Position field Displays the horizontal position from the centre of the crop box relative to the centre of
the source frame, in pixels. Drag left or right, or click to enter a new X Position value.

Y Position field  Displays the vertical position from the centre of the crop box relative to the centre of the
source frame, in pixels. Drag left or right, or click to enter a new Y Position value.

X Scale field  Displays the horizontal scale of the crop box relative to the Crop Box Width field value, as a
percentage. Drag left or right, or click to enter a new X Scale value.

Y Scale field  Displays the vertical scale of the crop box relative to the Crop Box Height field value, as a
percentage. Drag left or right, or click to enter a new Y Scale value.

Crop Mode box Select an option to determine the scaling behaviour of the crop box while repositioning
or rescaling. Use Free to adjust the crop box freely. Use Prop to use the current Crop Box Width and Crop
Box Height settings proportionally. Use Source or Destination to use the respective aspect ratio for the crop
box.

Source Ratio field  Displays the aspect ratio of the crop box in the source frame. Editable.

Crop Options Settings

Crop Box Width field Displays the current width setting of the crop box, in pixels. Editable.

Crop Box Height field Displays the current height setting of the crop box, in pixels. Editable.

Source Width button Uses the width settings of the source frame for the Crop Box Width field.

Source Height button Uses the height settings of the source frame for the Crop Box Height field.

Source Frame button Uses the width and height settings of the source frame for the Crop Box Width and
Crop Box Height fields, respectively.

Destination Width button Uses the width settings of the destination frame for the Crop Box Width field.

Destination Height button Uses the height settings of the destination frame for the Crop Box Height field.

Destination Frame button Uses the width and height settings of the destination frame for the Crop Box
Width and Crop Box Height fields, respectively.

Crop Box Border colour pot  Displays the current colour of the crop box border. Editable.

Crop Box Line Style box Select the line style for the crop box.
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Source Pre-Rendering

Source Pre-Rendering buttons Select a conversion method to use for the resize. Use the Both Fields button
when both source and destination formats are interlaced or progressive. Use the Field Merge button to
combine the two fields of the source clip. Use the Deinterlace button to select one field, in which case the
Source Pre-Rendering Field box is enabled.

Source Pre-Rendering Field box Select a field to use for the resize. Active when the Deinterlace Source
Pre-Rendering button is enabled.

Resizing Settings

Use the Resize settings to change the size of a clip.

Resize Field Format box Select an option to determine whether the resize is performed on progressive or
interlaced frames, if both source and destination clips are interlaced. If either clip is progressive, the resize
operation is always progressive.

Fit Method box Select a fit method to be applied to the selected clip.

Precision field Displays the frequency cut-off point used during resize. Editable.

Crisp/Soft field Displays the amount of blurring used during resize. Editable.

Resize Filter box This option is available when Letterbox, Crop Edges or Fill is selected from the Fit Method
box. Select the filter option to determine the quality of the interpolated resize result.

Aspect button This option is available when Letterbox or Crop Edges is selected from the Fit Method box.
Enable to use non-square pixel formats. Active when Fit Method is set to Crop Edges or Letterbox.

Destination Padding colour pot Displays the colour used for padding the destination frame when the
source image is smaller than the destination. Editable.

Adaptive Deinterlacing button Enable to use data from the adjoining interlaced field to improve the results
of the resizing algorithm. This is most effective for clips containing stationary objects.

Adaptive Deinterlacing field Displays the amount of data used from the adjoining field for adaptive
interlacing during resize. Active when Adaptive button is enabled.

Destination Settings

Use the Destination settings to define the format of the resized clip.
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Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Frame Depth box Select the render/output frame depth of clips.

Scan Mode box Select the scan mode of clips.

Crop/Lock Output button Enable to lock the destination resolution to match the crop box. Use this option
to animate the resolution of a clip and change it on a per-frame basis. Available when you access Resize
settings.

Sparks
Sparks are software plug-ins created by Autodesk or third-party developers.

To access Sparks, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

The Autodesk SparksAPI Reference Guide is available in PDF format. If you are interested in marketing or
selling your Sparks, you must apply to the system Sparks program. To request an application, send an e-mail
message to email Sparks Manager .

Using a Sparks Plug-in

A Sparks plug-in functions in the same way as other commands or modules. Before using a Sparks plug-in,
you will have to load it. After loading the plug-ins, you can replace them if all the Sparks buttons are already
in use.

To load a Sparks plug-in, do one of the following:

1 From the Tools menu, select the Plugins tab and then click one of the Sparks buttons.

2 Or, from ConnectFX, select the Sparks node and drag it into the schematic.

3 Or, from the Timeline, select a clip and add a Sparks Timeline FX to it.

Once you have loaded a Sparks plug-in using one of these methods, the Sparks file browser will appear.
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NOTE An L on a Sparks button indicates that you can load a Sparks plug-in. An E on a Sparks button indicates
that there are settings for the plug-in. An S on a Sparks button indicates that you can enter the module using
the same media from the previous session.

4 Navigate to usr/discreet/sparks.

You can also load Sparks from usr//discreet/<product home>/sparks.

5 Select a Sparks plug-in.

You are returned to your previous location. The name of the Sparks plug-in now appears on the selected
button, however the L indicating that you can load a Sparks plug-in no longer appears.

To exit the Sparks plug-in file browser without loading a plug-in, click the Exit Sparks Browser button.

To use Sparks plug-ins from the Tools menu, do the following:

1 Click a loaded Sparks button.

The Sparks controls, if any, appear.

2 Enter the parameter values for the selected Sparks plug-in.

3 Select the source clips and the destination reel.

The processed clip appears in the destination reel.

To use Sparks plug-ins from ConnectFX, do the following:

1 Select the Sparks node from the node bin and drag it into the schematic.

The Sparks Plug-in file browser appears.

2 Select a plug-in.

You are returned to the schematic and a Sparks node corresponding to the plug-in that you selected
now appears in the schematic.

3 Double-click the Sparks node to access and adjust the settings for the Sparks node.

To use Sparks plug-ins from the Timeline, do the following:

1 Select a clip on the Timeline.

2 Click the FX button and add a Sparks Timeline FX to the clip.

3 Click the Sparks button to enter the Sparks Plug-in file browser.

4 Select a Sparks Plug-in.

You are returned to the Timeline.

The Sparks button in the Effects pipeline now appears with the name of the plug-in that you selected,
and it's settings, if any, are available in the quick menu. You can also double-click the Sparks button
to enter the full editor, if the Sparks Plug-in has additional settings.

If you want to load a new Sparks plug-in, but all the Sparks buttons are already in use, you can replace an
existing Sparks plug-in with the new one. This can be done from the Tools menu, ConnectFXor the Timeline.

To replace a Sparks plug-in, do the following:

1 Press Alt and click the existing Sparks button.

The Sparks file browser appears.

2 Navigate to usr/discreet/sparks or usr//discreet/<product home>/sparks and select a Sparks plug-in.

You are returned to your previous location, and the name of the new Sparks plug-in appears on the
selected button.
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Using Sparks in ConnectFX

There are two Sparks nodes that you can access from ConnectFX: the Sparks node and the Sparks Load node.

The Sparks node allows you to load Sparks Plug-ins by accessing the Sparks file browser. The number of
inputs and bit depth that a Sparks node accepts depends on the Sparks plug-in. A Sparks node has light grey
source tabs, since each Sparks plug-in varies in the type of clip it uses

When working with a Sparks plug-in, missing media in front clips set to No Media can be converted into
black frames while they are in use. When missing media is output from this node, it returns to a No Media
state, regardless of whether it was set to display differently in the node.

NOTE When you attempt to use a Sparks plug-in, the error message "SPARK IS NOT SUPPORTED" may appear.
This means the selected Sparks plug-in cannot be used with ConnectFX. Contact the company that developed
the Sparks plug-in for information on obtaining a compatible version.

The Sparks Load node allows you to populate multiple Sparks nodes at the same time into a destination bin.
Populating a bin with predefined Sparks nodes saves you time since you do not have to access the Sparks
browser each time you want to use one of the preloaded Sparks.

Unlike the Sparks node, the Sparks Load node itself cannot be dragged to the schematic; only the predefined
node populated into a bin can be dragged to the schematic.

To create a predefined Sparks node in a bin:

1 Drag the Sparks Load node on top of any tab in the ALL Tools bin except the ALL Nodes tab.

The Sparks Plug-in file browser appears.

2 Select a Sparks Plug-in or select multiple plug-ins by Ctrl-clicking the Sparks you want to load.

3 Click load.

The selected Sparks are created as their own Sparks nodes in the destination bin. To use one of the preloaded
Sparks, drag it from the destination bin to the schematic. You do not have to re-enter the Sparks browser to
load a Sparks if you preloaded it into a bin.

For more information on Sparks plug-ins, see Using a Sparks Plug-in (page 1065).

Stabilizer
Stabilizing and Tracking

Use the Stabilizer to remove camera instability and motion jitter, and to track reference points in your clips.
You can also use the Stabilizer to produce 2D motion or lock a bilinear surface to the clip's background.
With tracking, a point or points on the clip are tracked as they move through the scene. You can then apply
the resulting motion path to an object on another layer so that it follows the same path as the object you
tracked.

Stabilizing is the inverse of tracking. With stabilizing, the motion path is used to shift the scene so that the
point that is tracked remains fixed at one position.

Tracking and stabilizing are often processes of trial and error. It is recommended that you track or stabilize
using the default settings. If the tracker box strays from its original point, you can fine-tune the analysis.

Accessing the Stabilizer

You access the Stabilizer differently, depending on how you want to track or stabilize a clip. For example,
when you access the Stabilizer from the Tools tab, you stabilize with one tracker. When you access from
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Action, you have the option to use two trackers. You need two trackers when the clip you want to stabilize
has a camera roll or zoom—the second tracker enables you to track the rotation and zoom of the camera.

To:Access the Stabilizer from:

Stabilize.The Tools tab

Track or stabilize.Action/ Timeline Effects Axis

Track a garbage mask or the vertices of a GMask.Keyer/ GMask

How the Stabilizer Works

The Stabilizer uses trackers to generate tracking data. Each tracker consists of a solid box, called the reference
box, and a dashed box, called the tracker box. The reference box establishes the reference point (the feature
to track or stabilize) in any frame of the sequence. The tracker box indicates to the Stabilizer where to locate
the reference point. The tracker box follows the frame-to-frame movement of the reference point.

(a) Tracker number (b) Tracker box (c) Reference box

You start by selecting one or more reference points on your clip. Locate the first frame containing the
movement to be tracked (the reference frame). In general, the reference frame is the first frame of the
sequence. The choice of the reference point depends on whether you are tracking or stabilizing. When
tracking, the reference point is a feature you want to track; when stabilizing, the reference point represents
the point around which the image is stabilized. See Selecting a Reference Point (page 590) for details. Place
the reference box(es) around the selected feature(s).

Once you have set the tracker positions, start the tracking process, also referred to as analyzing the clip.
During the analysis, the tracker box associated with each tracker moves as the Stabilizer looks for a pattern
that matches the reference in each frame of the clip.
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The Stabilizer calculates the difference between the position of the tracker box and the position of the
reference box to produce X and Y Shift values. Shift values represent a measurement in pixels and subpixels
of how much the reference point has moved.

When the analysis is complete, you fine-tune it if a tracker box has strayed from the reference it was supposed
to follow. Once you are satisfied with the results, you can apply the data to the clip.

To track, the Stabilizer applies the Shift values “as is.” To stabilize, the Stabilizer inverts the X and Y Shift
values in each frame of the sequence, and moves the image according to these values. This gives the impression
that the reference point stays in the same position throughout the sequence. Because the image is moved
during stabilization, a border appears on one or more edges, which means that you lose some pixels. The
following illustrations summarize the process.
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Stabilizer Menu Settings

Miscellaneous Buttons

Exit button Exits the Stabilizer tool.

Return button Returns to the previous tool.

Load button Loads a setup.

Save button Saves a setup.

Setup Name field Displays the name of the last saved setup.

Revert button Reverts to the last saved setup.

Step Render field Displays the frame number interval to be rendered (to see intermediate results, for example).
Editable.

Scale and Shift Option box Select a method to fill or remove the area where the image has been shifted
after stabilization.

Colour pot Displays the colour to fill the area where the image has been shifted after stabilization (available
if Shift or Letterbox is chosen in the Scale and Shift Option box). Editable.

Player button Opens the Player to view the rendered clip.

Context button Enable to view the tracking result with all of the Action scene, except for the selected node
(and any children of the selected node).

Setup button Opens the Setup menu, where you can specify user interface and tracking preferences.

Animation button Opens the channel editor, where you can animate the various Stabilizer settings.

Expand/Collapse box Select whether to expand or collapse selected animation channels.

View box Select an option to set the view in the image window.

Auto Key button Enable to set a keyframe automatically each time you change a value at any frame.

Set Key button Sets a keyframe at the selected frame.

Delete Key button Deletes the selected keyframe.

Current Frame field Enter a frame number to jump to the corresponding frame.

Duration field Displays the duration of the clip in frames.

Reset box Select an option to reset shift, tracking, reference, or all data.

Reset All button Resets all parameters.

Grid button Accesses the overlay menu.

View button Accesses the viewing settings menu.

Undo button Undoes the last action performed.

Main Stabilizer Menu

Tracker buttons Select the Tracker to work with.

Add Tracker button Click to add a new tracker.

Active button Enable to activate the selected tracker.
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Tracker colour pot Displays the colour of the selected tracker. Editable.

When you add a new tracker, the system automatically assigns it a unique colour so that you can easily
distinguish between multiple trackers. You can change the colour of an individual tracker or of all the trackers
at once.

Tolerance field Displays a value the Stabilizer uses to match reference points from frame to frame and to
set keyframes. Editable.

Tracker Selection box Select which trackers are affected when you change a parameter.

Analyze button Click to generate stabilization or tracking data.

Step button Click to analyze a single frame and advance to the next frame.

Direction box Select to analyze forward or backward.

Snap button Click to redefine the reference at the selected frame.

Lock Key button Click to lock the selected keyframe as a point on the tracking path. Click again to unlock.

Delete Key button Click to delete the selected point on the tracking path.

Source option box Select whether to track in Progressive (frame mode) or Interlaced (field mode).

By default, the Stabilizer works in Progressive (frame mode). Select Interlaced from the Source Option box
mode when working with interlaced images, or with images that display a lot of field jitter. In Interlaced
(field) mode, the Stabilizer sets two keyframes for every frame: one for the even field and one for the odd
field, and an asterisk appears in the image viewer's current frame display to indicate the second field for
each frame.

Fixed X button Enable to remove vertical jitter.

Fixed Y button Enable to remove horizontal jitter.

Reference X field Displays the position of the reference box along the X axis. Editable.

Reference Y field Displays the position of the reference box along the Y axis. Editable.

Reference Width field Displays the width of the reference box. Editable.

Reference Height field Displays the height of the reference box. Editable.

Fixed Reference button Enable to track the movement of the reference point specified in the reference
frame. Disable to update the reference point at each frame during tracking.

Normally, you use the Stabilizer with the Fixed Reference button enabled. Throughout the analysis, the
tracker box follows the movement of the reference point that you specified in the reference frame.

You may want to track a pattern that changes considerably from the first frame to the last frame in the clip.
For example, the pattern may be rotating or may change size or shape. In this case, disable the Fixed Reference
button. The reference point is then updated in each frame. In each frame of the analysis, the Stabilizer looks
for the reference point from the previous frame.

NOTE Unless you are in Gang mode, you must set the Fixed Reference button for each active tracker individually.

Tracker X field Displays the position of the tracker box along the X axis. Editable.

Use these options in the Stabilizer menu to determine whether to scale or shift a stabilized image, to track
in frame or field mode, and to fix the reference box.
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When a clip is stabilized, the image is shifted. You can choose any of the following from the Scale and Shift
Option box to fill or remove the area where the image has been shifted.

To:Select:

Wrap the image around to fill the area.Roll

Rescale both dimensions of the image independently to make it fit into the frame. Note that

this can change the aspect ratio.

Fill

Rescale the shortest edge of the image to fit into the frame and crop the longest edge. There

will not be a black border.

Crop Edges

Rescale the longest edge of the image to fit into the frame and fill the rest of the image with

a black border.

Letterbox

Use a colour to fill the area. Use the adjacent colour pot to pick the colour. You will lose texture

and will fill the rest of the image with the color you picked.

Shift

Tracker Y field Displays the position of the tracker box along the Y axis. Editable.

Tracker Width field Displays the width of the tracker box. Editable.

Tracker Height field Displays the height of the tracker box. Editable.

Import Track button Open the Import Stabilizer menu, where you to import a text file of saved tracking
data.

Export Track button Click to open the Export Stabilizer menu, where you to export a text file of saved
tracking data.

Shift X field Displays the difference between the position of the reference box (0,0) and the position of the
tracker box in the current frame along the X axis. Editable.

Shift Y field Displays the difference between the position of the reference box (0,0) and the position of the
tracker box in the current frame along the Y axis. Editable.

Import Shift button Click to open the Import Stabilizer menu to allow you to import a text file of saved
shift data.

Shift Copy button Click to copy the selected Shift channel (including the aspect ratio of the clip).

Export Shift button Click to open the Export Stabilizer menu to allow you to export a text file of saved
shift data.

Offset X field Displays the offset X axis value. Editable.

Offset Y field Displays the offset Y axis value. Editable.

Setup Menu

Pretracking button Enable to preview the motion path for a specified number of frames. Active when Path
is enabled.

Before analysing, you can use the Pretracking option to preview the motion path for a specified number of
frames. You can then adjust the tracker position, if necessary, to find the best reference point. The Pretracking
option applies only to the selected tracker, regardless of whether you selected Solo, Selected, or Gang in the
Tracker Selection box. If you move or resize a tracker with Pretracking enabled, the next frames are analysed.
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Pretracking field Displays the number of frames to pretrack. Editable.

Oversampling button Enable to stabilize using a high-quality subpixel shift algorithm. Disable to stabilize
using texture memory.

Use Oversampling to toggle high-quality subpixel image adjustment on and off:
■ When Oversampling is off, texture memory is used.

■ When Oversampling is on, a high-quality subpixel shift algorithm is used. The resulting image is sharp.

After you stabilize a clip with Oversampling on, rotoscope it in Paint to remove the border that appears at
the edges. Avoid using Action (or any other component that uses texture memory) to do this because you
will lose the benefits of Oversampling.

NOTE You cannot use the Oversampling and Crop Edges options together. If you select Crop Edges, texture
memory is used even if Oversampling is on.

Auto Pan button Enable to allow the part of the image that is selected to stay in the image window when
zoomed in.

Opacity field Displays the opacity of the reference image. Editable.

The reference image (the image where you placed the reference box) appears in transparency when you
select a keyframe. Adjust the opacity of the image to make it more or less transparent. When the opacity is
set to 0, the reference image does not appear. When the opacity is set to 100, the reference image is completely
opaque.

Zoom field Displays the magnification factor of the reference box when selected. Editable.

By default, the reference box turns into a magnifying glass when you select it. Increase or reduce the
magnification factor in the Zoom box.

Result:Zoom:

No zooming. The crosshair appears in the tracker box after you analyse the clip.0

No zooming and no crosshair.1

A magnification factor of 2, 3, 4, and 5, and a crosshair in the tracker box.2, 3, 4, 5

Path button Enable to display the tracking path.

The tracking path is the path that the reference point makes as it changes position from frame to frame. By
default, the tracking path appears in the image window. You can turn it off by disabling the Path button.

Colour Corrector Input button Enable to display any Colour Corrector settings on the clip.

Linetest button Enable to display the context view at a lower resolution.

Icons button Enable to display the tracker and reference boxes.

The tracker and reference boxes appear in the image window when a tracker is active. You can hide them
by disabling the Icons button. This is useful when working with many trackers.

Stereo
Use Stereo to process an anaglyph, interlaced or dual image clip containing one video track from either a
left and right eye mono clip, or an existing stereo track directly on the desktop.
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To access the Stereo menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ The Modular Keyer, then select a node from the Node bin.

This node accepts a left eye mono clip and a right eye mono clip, and outputs an anaglyph, interlaced or
dual image stereo clip. You can add a Stereo node to any part of the pipeline except to the Front and Matte
pipes of MBlend nodes and the Matte pipes CBLend nodes.

Stereo Menu Settings

General Settings

Stereo Mode box Select a stereo mode to display the appropriate rendering method options. Different
method settings appear based on the type selected.

To:Select:

Render a red/cyan clip.Anaglyph
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To:Select:

Render an interlaced RGB clip.Interlace

Render a clip containing adjacent images.Dual Image

Method box Depending on the selected Stereo Mode, you have different options for modifying the effect.

Anaglyph Settings

Anaglyph Method box Select a method for your anaglyph result. For example, select Dubois to reduce the
ghosting between the left and right eyes.

To:Select:

Customize the RGB left and right gain factor values. With this option, you can create
anaglyph results based on the 3D lenses that will be used.

NOTE This option is available in ConnectFXand the Modular Keyer.

Custom

Reduce ghosting between the left and right eyes.Dubois

Create an anaglyph result based on the RGB values.RGB

Remove the RGB values before creating an anaglyph result. With this option, you will
see just the stereo effect.

Mono

Interlaced Settings

Interlace Method box Select whether your interlace result outputs the left eye input as field 1 or field 2.

Dual Image Settings

Output the left eye and right eye so that they are adjacent to each other in the same clip, either in a left and
right or top and bottom orientation.
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Left and Right Custom Gain Factor Fields Displays the gain factor in the colour channel for the left eye
and right eye. Enabled when Custom is selected in the Method box.

NOTE This option is available in ConnectFXand the Modular Keyer.

Dual Image Method box Select whether your dual image result outputs the left eye and right eye so that
they are adjacent to each other in the same clip, either in a left and right or top and bottom orientation.

Red in Red Output field Displays the red gain factor in the red channel for the Left eye. Editable.

Green in Red Output field Displays the green gain factor in the red channel for the Left eye. Editable.

Blue in Red Output field Displays the blue gain factor in the red channel for the Left eye. Editable.

Red in Green Output field Displays the red gain factor in the green channel for the Left eye. Editable.

Green in Green Output field Displays the green gain factor in the green channel for the Left eye. Editable.

Blue in Green Output field Displays the blue gain factor in the green channel for the Left eye. Editable.

Red in Blue Output field Displays the red gain factor in the blue channel for the Left eye. Editable.

Green in Blue Output field Displays the green gain factor in the blue channel for the Left eye. Editable.

Blue in Blue Output field Displays the blue gain factor in the blue channel for the Left eye. Editable.

Red in Red Output field Displays the red gain factor in the red channel for the Right eye. Editable.

Green in Red Output field Displays the green gain factor in the red channel for the Right eye. Editable.

Blue in Red Output field Displays the blue gain factor in the red channel for the Right eye. Editable.

Red in Green Output field Displays the red gain factor in the green channel for the Right eye. Editable.

Green in Green Output field Displays the green gain factor in the green channel for the Right eye. Editable.

Blue in Green Output field Displays the blue gain factor in the green channel for the Right eye. Editable.

Red in Blue Output field Displays the red gain factor in the blue channel for the Right eye. Editable.

Green in Blue Output field Displays the green gain factor in the blue channel for the Right eye. Editable.

Blue in Blue Output field Displays the blue gain factor in the blue channel for the Right eye. Editable.

Stylize
Use Stylize on an image sequence to create a wide range of visual styles, including painting, printing and
sketching. Stylize allows you to build your look by stacking layers with different effects.
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Stylize includes a collection of 10 core effects that are stacked and blended together as layers. The core effects
fall into four major categories: canvas texture, patterns, colour fillings, and outlines. Each of the core effects
has its own settings, which display when an effect is selected:
■ Canvas

■ Dots

■ Hatch Pattern

■ Palette Reduction

■ Colour Smudge

■ Drawing

■ Selective Drawing

■ Sketched Outlines

■ Scribbled Outlines

■ Sharp Outlines

Since the possible combinations of core effects are endless, over 80 presets are available to help you get
started with Stylize. These presets can also help you learn how Stylize layer stacking works. The presets are
divided into a number of categories and are easily added to your scene.

To access the Stylize menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a front, back and matte clip, and outputs a result and an outmatte result.

Stylize Menu Settings

Using Stylize Presets

Use the Stylize presets to create a specific look or to create a starting point to build your effect. Presets are
available in 4 categories: Comic, Paint, Print, and Sketch.

Presets button Opens the Presets browser where you can select a preset.

TIP In the browser, switch to Proxies view (press P) to see a visual representation of the preset.

Presets dropdown list Select a preset from the dropdown list. Menu settings are changed to reflect the
chosen preset.

Setup and General Settings

Clamp Input box Select a clamping option for colour and luminance values on input in the 16-bit floating
point rendering pipeline.

Clamp Output box Select a clamping option for colour and luminance values on output in the 16-bit
floating point rendering pipeline.

Regen button Enable to dynamically refresh the image as settings are changed.
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Layer Table Settings

Use the Layer Table to organize the layers that make up your Stylize effect. The top layer in the Layer Table
has the highest priority in the overall effect. Selecting a preset populates the Layer Table with the necessary
layers and settings.

Visibility column Displays the visibility of each layer. Click the eye icon to change a layer from visible to
invisible or vice-versa.

Name column Displays the name of the layer. Click the Rename button to change the name of a selected
layer.

Effect column Displays the effect applied per layer. Use the scroll arrows to change the effect. Different
settings appear based on the effect chosen.

Blend column Displays the blend operation per layer. Use the scroll arrows to change the blend value.

Matte column Displays whether a matte is on, off, or inverted per layer. Use the scroll arrows to change the
value.

Transparency column Displays the transparency level per layer. Scroll to change the value, or click to
display the calculator.

Priority Up button Click to move the selected layer up in priority in the layer list.

Priority Down button Click to move the selected layer down in priority in the layer list.

Solo button Enable to hide all other layers except the selected layer. You can also turn specific layers on or
off using the eye icon on the left of each layer.

Seed field Displays the random seed variation value to use in the stylize effect. Editable.

Add button Click to add a new layer to the layer list.

Copy button Click to copy the existing layer to a new layer.

Delete button Click to delete the selected layer from the layer list.

Rename button Click to open the online keyboard to rename the selected layer in the layer list.

Reset button Click to reset all of the attributes associated with the selected layer and returns them to default
values.

Background colour pot Displays the background colour used in a blending operation. Click to change the
colour.

Canvas Effect Settings

These settings are available when a layer is selected in the Layer Table with Canvas as the effect.
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Pattern Type box Select a pattern type to apply to the image.

Transparency field Displays the percentage of transparency applied to the Canvas effect. Editable.

Position X field Displays the position of the pattern along the horizontal axis. Editable.

Position Y field Displays the position of the pattern along the vertical axis. Editable.

Scale X field Displays the change in size of the pattern along the horizontal axis. Editable.

Scale Y field Displays the change in size of the pattern along the vertical axis. Editable.

Proportional button Enable to change the scale fields proportionally.

Rotation field Displays the angle of rotation of the pattern along the Z-axis, from its centre point. Editable.

Highlights colour pot Displays the colour applied to the light areas of the Canvas effect. Click to change
the colour.

Shadows colour pot Displays the colour applied to the dark areas of the Canvas effect. Click to change the
colour.

Dots Effect Settings

These settings are available when a layer is selected in the Layer Table with Dots as the effect.

Effect colour pot Displays the colour applied to the effect. Click to change the colour.

Scale field Displays the change in size of the effect. Editable.

Angle field Displays the change in the angle applied to the effect. Editable.

Softness field Displays the change in softness applied to the effect. Editable.

Shape box Select the shape of the Dots effect.

Scale field Displays the size of the Dots shapes. Editable.

Angle field Displays the change in angle of the Dots shapes. Editable.

Ratio field Displays the change in ratio of the Dots shapes. Editable.
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Tolerance field Displays the tolerance level applied to the colour selection of the effect. Editable.

Colour Selection option box Select an option to apply a colour to the image.

Colour Selection colour pot Displays the colour applied to the image. Click to change the colour. Only
active if User Colour or User GrayScale is selected.

Blur field Displays the amount of blur applied to the input image before other effects are applied. Editable.

Hatch Pattern Effect Settings

These settings are available when a layer is selected in the Layer Table with Hatch Pattern as the effect.

Effect colour pot Displays the colour applied to the effect. Click to change the colour.

Scale field Displays the change in size of the effect. Editable.

Angle field Displays the change in the angle applied to the effect. Editable.

Softness field Displays the change in softness applied to the effect. Editable.

Threshold field Displays the amount of colour constraint applied to the shape. Editable.

Thickness field Displays the amount of thickness applied to the shape. Editable.

Variation field Displays the percentage of variance applied to the shape. Editable.

Tolerance field Displays the tolerance level applied to the colour selection of the effect. Editable.

Colour Selection option box Select an option to apply a colour to the image.

Colour Selection colour pot Displays the colour applied to the image. Click to change the colour. Only
active if User Colour or User GrayScale is selected.

Blur field Displays the amount of blur applied to the input image before other effects are applied. Editable.

Palette Reduction Effect Settings

These settings are available when a layer is selected in the Layer Table with Palette Reduction as the effect.
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Colours field Displays the number of colours applied to the Palette Reduction effect. Editable.

Palette box Select between Single Palette to display image stability by using a single colour palette as a
reference, and Dynamic Palette to display image transition by using a new colour palette at each frame.

Frame field Displays the frame selected when Single Palette is enabled in the Palette box. Editable.

Softness field Displays the amount of softness applied to the Palette Reduction effect. Editable.

Pattern Type box Select a pattern type to apply to the image.

Amount field Displays the amount of the selected warp pattern that is applied to the image. Editable.

Position X field Displays the position of the pattern along the horizontal axis. Editable.

Position Y field Displays the position of the pattern along the vertical axis. Editable.

Scale X field Displays the change in size of the pattern along the horizontal axis. Editable.

Scale Y field Displays the change in size of the pattern along the vertical axis. Editable.

Proportional button Enable to change the scale fields proportionally.

Rotation field Displays the angle of rotation of the pattern along the Z-axis, from its centre point. Editable.

Blur field Displays the amount of blur applied to the input image before other effects are applied. Editable.

Colour Smudge Effect Settings

These settings are available when a layer is selected in the Layer Table with Colour Smudge as the effect.

Amount field Displays the amount of Colour Smudge effect that is applied to the image. Editable.

Distortion field Displays the amount of distortion applied to the Colour Smudge effect. Editable.

Emboss colour pot Displays the colour applied to the embossing. Click to change the colour.

Amount field Displays the amount of embossing applied to the image. Editable.

Softness field Displays the amount of softness applied to the embossing. Editable.

Angle field Displays the angle applied to the embossing. Editable.

Anti-Aliasing Active button Enable to use anti-aliasing on the edges of the image.

Anti-Aliasing Samples box Select an option to determine the size of the samples. Available when anti-aliasing
is enabled.

Anti-Aliasing Softness field Displays the amount of softness applied to the anti-aliasing. Available when
anti-aliasing is enabled. Editable.

Drawing Effect Settings

These settings are available when a layer is selected in the Layer Table with Drawing as the effect.
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Transparency field Displays the percentage of transparency applied to the paint strokes. Editable.

Style Type box Select the style type of the paint strokes.

Density field Displays the amount of density applied to the paint strokes. Editable.

Length field Displays the length applied to the paint strokes. Editable.

Length Variation field Displays the amount of variance applied to the length of the paint strokes. Editable.

Thickness field Displays the amount of thickness applied to the paint strokes. Editable.

Thickness Variation field Displays the amount of variance applied to the thickness of the paint strokes.
Editable.

Paint Each Frame button Enable to apply a random variation in the length and thickness values.

Preserve Stroke Ratio button Enable to allow proportional values to be applied to the length and thickness
of paint strokes.

Orientation field Displays the orientation applied to the paint strokes. Editable.

Orientation Variation field Displays the amount of variance applied to the orientation of the paint strokes.
Editable.

Edges Orientation field Displays the percentage orientation applied to the edges of the paint strokes.
Editable.

Disorder field Displays the amount of random distribution applied to the paint strokes. Editable.

Blur field Displays the amount of blur applied to the input image before other effects are applied. Editable.

Opacity field Displays the amount of opacity applied to the input image before other effects are applied.
Editable.

Hue field Displays the amount of hue applied to the input image before other effects are applied. Editable.

Hue Variation field Displays the amount of variance applied to the hue. Editable.

Saturation field Displays the amount of saturation applied to the input image before other effects are
applied. Editable.

Saturation Variation field Displays the amount of variance applied to the saturation. Editable.

Luminance field Displays the amount of luminance applied to the input image before other effects are
applied. Editable.

Luminance Variation field Displays the amount of variance applied to the luminance. Editable.
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Selective Drawing Effect Settings

These settings are available when a layer is selected in the Layer Table with Selective Drawing as the effect.

NOTE Most of the settings in the Paint Strokes section are the same as for the Drawing effect. Selective Drawing
also has two extra settings.

Paint Strokes colour pot Displays the colour applied to the paint strokes. Click to change the colour.

Front Mix field Displays the amount of colour from the source image that is visible. Editable

Inclusion colour pot Displays the colour on which the paint strokes are created. Click to change the colour.

Inclusion Tolerance field Displays the percentage of tolerance applied to the selected colour. The higher
the tolerance, the more paint strokes are created. Editable.

Exclusion colour pot Displays the colour on which the paint strokes are eliminated. Click to change the
colour.

Exclusion Tolerance field Displays the percentage of tolerance applied to the selected colour. The higher
the tolerance, the more paint strokes are eliminated. Editable.

Global Colour box Switch between the use of colour selections or grayscale versions of these colour selections.

Global Length field Displays the percentage of length by which semi-transparent strokes are modified.
Editable.

Global Softness field Displays the percentage by which the range of transparency of semi-transparent strokes
is modified. Editable.

Global Thickness field Displays the percentage by which the range of thickness of semi-transparent strokes
is modified. Editable.

NOTE The settings in the Front Controls section are the same as for the Drawing effect.
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Sketched Outlines Effect Settings

These settings are available when a layer is selected in the Layer Table with Sketched Outlines as the effect.

Minimum Threshold field Displays the minimum amount of colour restraint applied to the outline edges.
Editable.

Maximum Threshold field Displays the maximum amount of colour restraint applied to the outline edges.
Editable.

Softness Width field Displays the amount of softness applied to the width of the edges. Editable.

Softness Gain field Displays the amount of softness applied to the gain of the edges. Editable.

Transparency field Displays the percentage of transparency applied to the outlines. Editable.

Outlines colour pot Displays the colour applied to the outlines. Click to change the colour.

Front Mix field Displays the percentage of colour from the source image that is visible. Editable.

Style Type box Select the style type of the outlines.

Density field Displays the amount of density applied to the outlines. Editable.

Paint Each Frame button Enable to apply a random variation in length and thickness values.

Length field Displays the length applied to the outlines. Editable.

Length Variation field Displays the variance applied to the length of the outlines.

Thickness field Displays the amount of thickness applied to the outlines. Editable.

Thickness Variation field Displays the variance applied to the thickness of the outlines.

Preserve Stroke Ratio button Enable to allow proportional values to be applied to the length and thickness
for the outlines.

Orientation field Displays the orientation applied to the outlines. Editable

Orientation Variation field Displays the variance applied to the orientation of the outlines.

Follow Edges field Displays the percentage by which the outlines follow their original position. Editable.

NOTE The settings in the Front Controls section are the same as for the Drawing effect.

Scribbled Outlines Effect Settings

The Edge Detect, Softness, and Front Controls settings are the same as for the Sketched Outline effect. Some
of the Outlines settings are similar also. The following Outlines settings are specific to the Scribbled Outlines
effect.
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Smallest Details field Displays the amount by which the smallest outlines will be filtered out. Editable.

Longest Outlines field Displays the amount by which the length of the longest outlines will be increased.
Editable.

Straight Lines field Displays the amount of the straightest outlines that are visible. Editable.

Pressure field Displays the variation in the pressure applied to the outlines. Varies with the style of the
outline. Editable.

Sharp Outlines Effect Settings

The Edge Detect, Softness, Outlines, and Front Controls settings are the same as for the Sketched Outline
effect. The Pattern Transform settings are the same as for the Canvas effect. The following Warp Pattern
settings are specific to the Sharp Outlines effect.

Pattern Type box Select a pattern type to apply to the image.

Amount field Displays the amount of warp applied to the image. Editable.

Text
Use Text to make text spin, dance, and change colour over time.

To access the Text menu, use:
■ Timeline, then use ConnectFX (See  Creating ConnectFX (page 292)).

■ Tools, then select from the menu.

This node accepts a background clip. If a background clip is not connected to the Text node, you can select
a resolution for the output of the Text node. Additionally, this node outputs a result and an outmatte.

NOTE The Prerender Text preference does not apply when you access Text from ConnectFX.

Text is compromised of layers, paragraphs, and characters. You can create effects such as a text roll of credits,
text crawls, bumpers, and a text that moves on a motion path. You can also use logo images in a text roll
so that the logo of a sponsor appears in the credit list.
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Text Menu Settings

General Settings

Preview button  Enable to preview the text effect.

Preview Options box This box is available when you access the Text Menu settings from the Timeline.Select
to enable Preview FX or Context, to preview the effect.

Setup button Displays the Text Setup menu.

See Setup and Processing Options (page 855).

(a) Setup button (b) Animation button (c) Attribute controls (d) Text Mode box

Attribute controls Changes the appearance of text by setting properties such as fill and shadow. See Creating
Text Effects (page 865).

Animation button Creates a text animation by setting different text properties at specific keyframes in a
clip.

See Animating Text (page 874).

Text Mode button  Select a text mode to select text, edit text in layers, modify text attributes, or enter text
strings.

Applies various text settings to layers, paragraphs, and characters. Use text modes to manipulate layers, add
text to a clip, or edit existing text in a clip. See Modifying Layer and Character Properties (page 865).

Result button  Select an option to set the view to either the composited text, the matte of the text, or the
original back clip.

Reset box  Select an option to reset the selected text layer, the layer axis, the roll/crawl, or the style templates.

Reset All  Click to reset the text tool to the default values set in Preferences.

Edit button Opens the Edit menu.

Resolution Presets box Select a resolution for the new clip. Select Custom to specify a non-standard resolution.

Frame Depth box Select the render/output frame depth of clips.
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Scan Mode box Select the scan mode of clips.

Width field Displays the custom width resolution of the clip. Editable.

Height field Displays the custom width resolution of the clip. Editable.

Aspect Ratio Presets box Select a standard frame aspect ratio. Select the Set to w:h option to set the clip to
use square pixels. Select Custom to define a custom frame aspect ratio in the Aspect Ratio field.

Aspect Ratio field Displays the custom render/output aspect ratio. Editable

Insert Settings

Axis button Opens the Axis menu to set properties for layers and characters.

Roll/Crawl button Open the Roll/Crawl menu to set text motion properties for vertical or horizontal text
scrolling.

See Creating Text Rolls and Text Crawls (page 871).

Styles button Opens the Styles menu to create preset text style formats.

See Defining Styles (page 880)

Tabulation button Open the Tabulation menu to set text tabs.

See Tabulating Text (page 870)

Spell Check button Open the Spell Check menu to check text for spelling errors.

See Spell Checking (page 871)

Keyboard button Opens the on-screen keyboard to enter text.

See Entering Text (page 861)

Fill button Enable to use fill on the text selection.

Sets fill colour, transparency, and softness. Set fill softness using the Soft field. To increase the softness, enter
a value close to the maximum of 100. To decrease the softness, enter a value close to the minimum of -100.
Enter 0 for no softness.

Fill colour pot Displays the colour of the fill. Editable.

Fill Transparency field Displays the transparency level of the fill. Editable.

Fill Softness field Displays the softness level of the fill. Editable.

Underline button Enable to underline the text selection.
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Underlines the characters using the associated colour, transparency, and width. Click the colour pot to
choose a colour from the colour picker. To set underline transparency, enter a percentage in the Transparency
field. To make the underline more opaque, enter a value close to the maximum of 100. To make the underline
more transparent, enter a value close to the minimum of 0. To set the outline width, enter a value in the
Width field.

Underline colour pot Displays the colour of the underline. Editable.

Underline Transparency field Displays the transparency level of the underline. Editable.

Underline Width field Displays the width of the underline. Editable.

Outline button Enable to outline the text selection.

Outlines the characters with a solid colour using the associated colour, transparency, and width. Click the
colour pot to choose a colour from the colour picker. To set outline transparency, enter a percentage in the
Transparency field. To make the outline more opaque, enter a value close to the maximum of 100. To make
the outline more transparent, enter a value close to the minimum of 0.

To set the outline width, enter a value in the Width field. Use anti-aliasing rendering options with outlined
text. These options are found in the Text Setup menu. See Setup and Processing Options (page 855).

Outline colour pot Displays the colour of the outline. Editable.

Outline Transparency field Displays the transparency level of the outline. Editable.

Outline Width field Displays the width of the outline. Editable.

Back button Enable to apply a solid colour background using the associated text layer colour and transparency
to the text selection.

Click the colour pot to choose a colour from the colour picker. To set back transparency, enter a percentage
in the Transparency field. To make the back more opaque, enter a value close to the maximum of 100. To
make the back more transparent, enter a value close to the minimum of 0.

Back colour pot Displays the colour of the background. Editable.

Back Transparency field Displays the transparency level of the background. Editable.

Shadow button Enable to apply a drop shadow to the text selection.

Applies a shadow to text characters using the associated colour, softness, transparency, and Pos X and Pos
Y fields. Click the colour pot to choose a colour from the colour picker. To set shadow transparency, enter
a percentage in the Transparency field. To make the shadow more opaque, enter a value close to the maximum
of 100. To make the shadow more transparent, enter a value close to the minimum of 0. To set shadow
softness, use the Soft field. To increase the softness, enter a value close to the maximum of 100. Enter 0 for
no softness.

To set the shadow position on the X-axis, enter a value in the X field. A positive value places the shadow to
the right and behind the text characters. A negative value places the shadow to the left and in front of the
text characters. To set the shadow position on the Y-axis, enter a value in the Y field. A positive value moves
the shadow up. A negative value moves the shadow down.

Shadow colour pot Displays the colour of the shadow. Editable.

Shadow Transparency field Displays the transparency level of the shadow. Editable.

Shadow Softness field Displays the softness level of the shadow. Editable.

Shadow X field Displays the shadow position along the X-axis.

Shadow Y field Displays the shadow position along the Y-axis.

Blur Shadow button Enable to apply a blur effect to a drop shadow created with the Shadow button.
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The type of blur applied depends on whether Box Blur or Gaussian Blur is selected in the Text Setup menu.
Choose a higher value for a greater shadow blur effect. Using Blur Shadow with animated text decreases
processing performance.

Blur Shadow field Displays the level of blur applied to the drop shadow. Editable.

Font Settings

Font field Displays the current font. Click to open the font browser to select a different font.

Font Reset button Resets to the default font.

Font Size field Displays the character size for the selected font. Editable.

Font Italic field Displays the angle of italicized text. Positive values make the characters slope to the right.
Negative values make them slope to the left.

Font Kerning field Displays the amount of spacing between characters. Positive values increase the spacing.
Negative values decrease the spacing.

Paragraph Settings

Justification box Select an alignment option for the paragraph.

Select Left, Right, Centre, or Justified.

Width field Displays the width of the layer. Editable.

Left Margin field Displays the amount of space in the left margin. Editable.

Leading field Displays the space between lines in the selected paragraph. Editable.

Indent field Displays the left indentation value for the first line in the paragraph. Editable.

Separation field Displays the space between the selected paragraph and the one above it. Editable.

Character Channels

Copy Attributes button Copies attribute settings from the selected text character.

Copy Transformations button Copies transformation settings from the selected text character.
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Copy All button Copies both attribute and transformation settings from the selected text character.

Paste button Pastes any copied text character channel information.

Text on Path

On Path button Enable to place the selected text on a motion path.

Closed button Enable to close the path by connecting the first and last vertices. Text continues around the
shape.

Offset field Displays the position of the text on the path. Animate the Offset value to make the text follow
the path for the duration of the clip.

Invert button Reverses the order of the vertices on the path so that the text follows the opposite side of the
path.

Text On Path Mode box Select an option to manipulate the selected path spline.

Clear button Resets the text path at the current frame. To reset the path for the entire duration of the clip,
click Reset Layer.

Axis Settings

NOTE The Axis settings are available when the Axis button is enabled in the Insert settings.

Axis menu buttons Select whether to display the Layer Axis menu or the Characters Axis menu.

Show Axis button Enable to display the axis in the image window. This button is only available when the
Character Axis menu button is selected.

Position X field Moves the layer or selected characters along the X-axis.By default, the value is 0 (for
characters). Increase the value to move right and decrease it to move left. Editable .

Y Position field Moves the layer or selected characters along the Y-axis.By default, the value is 0 (for
characters). Increase the value to move up and decrease it to move down. Editable .

Lock Position button Enable to lock the position of the text layer. You can lock text in either the Top/Left
or Centre position using the box beside this button.

Centre Axis button Moves the axis to the center point of the character. This button is only available when
the Character Axis menu button is selected.
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X Position Character Axis field Sets the X-axis for the selected characters. Set each letter in a word spinning
on its own axis in a different way. This button is only available when the Character Axis menu button is
selected.

Using the Axis Pos X field, you set each letter in a word spinning on its own axis in a different way.

Y Position Character Axis field Sets the Y-axis for the selected characters. Set each letter in a word spinning
on its own axis in a different way. This button is only available when the Character Axis menu button is
selected.

Using the Axis Pos Y field, you set each letter in a word spinning on its own axis in a different way.

X Scale field Scales the layer or selected characters along the X-axis. This value is a percentage, so entering
50 means 50 percent. Use a larger value to increase the scale along the X-axis. Use a negative value to create
a mirror image on the X-axis. Enter 0 to make a layer or selected characters disappear. The default is
100.Editable.

Y Scale field Scales the layer or selected characters along the Y-axis. This value is a percentage, so entering
50 means 50 percent. Use a larger value to increase the scale along the Y-axis. Use a negative value to create
a mirror image on the Y-axis. Enter 0 to make a layer or selected characters disappear. The default is
100.Editable.

Proportional Scale button Proportionally changes the Scale X and Y values.

X Shear field Shears or slants the layer or selected characters along the X-axis. Use a positive value to slant
right and a negative value to slant left. The maximum and minimum values are 60 and -60, respectively.
The default value is 0.

Y Shear field Shears or slants the layer or selected characters along the Y-axis. Use a positive value to slant
right and a negative value to slant left. The maximum and minimum values are 60 and -60, respectively.
The default value is 0.

Rotation field Rotates a layer around its axis or selected characters around their axis.Use a negative value
to rotate clockwise and a positive value to rotate counter-clockwise. The default is 0.Editable.

Roll/Crawl Settings

NOTE The Roll/Crawl settings are available when the Roll/Crawl button is enabled in the Insert settings.

Roll/Crawl Settings

New Layer button Creates a layer to contain a text roll or text crawl.

Roll button Enable to create text that scrolls vertically over an image.

Crawl button Enable to create text that scrolls horizontally across an image.
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Scrollbar

Scrollbar X field Displays the X position of the roll or crawl layer inside the crop box. The value changes
when you move the scrollbar at the right of the text layer for a roll or at the bottom of the layer for a crawl.
Editable.

Scrollbar Y field Displays the Y position of the roll or crawl layer inside the crop box. The value changes
when you move the scrollbar at the right of the text layer for a roll or at the bottom of the layer for a crawl.
Editable.

Fit Best Speed button Creates a broadcast quality text roll based on the number of frames in the clip and
the lines of text in the text roll. Enable this button to make corrections to a text roll without altering the
speed or duration of the clip.

For NTSC and PAL, broadcast quality is calibrated at four pixels per frame. This rate ensures no flicker in the
text roll.

Roll Speed button Select the speed of the text roll, in pixels per second.

Changes the speed of the text roll. For 1X, the speed rate is 120 p/s (pixels/second) in NTSC, and 100 p/s in
PAL. For 2X, it is 240 p/s in NTSC, and 200 p/s in PAL, and so on.

Lock Leading & Scroll button Enable to lock the leading of the paragraph text so that you can insert another
paragraph into the text roll. If the duration of the clip lengthens after you make modifications, click Fit Best
Speed to adjust the length.

Best Roll Duration field Displays the suggested duration for the text roll. The duration is calculated using
the start/end position of the roll and the currently selected speed. Non-editable.

Crop Box

Crop Box X field Displays the X position of the crop box inside the image window. The crop box determines
the X coordinates of the text roll or text crawl on the clip. Editable.

Crop Box Y field Displays the Y position of the crop box inside the image window. The crop box determines
the Y coordinates of the text roll or text crawl on the clip. Editable.

Width field Displays the width at which to crop the text within the text roll or crawl layer. Editable.

Height field Displays the height at which to crop the text within the text roll or crawl layer. Editable.

Styles Settings

NOTE The Styles settings are available when the Styles button is enabled in the Insert settings.

Apply Style 1 button Saves or applies Style 1.

Text | 1093



Apply Style 2 button Saves or applies Style 2.

Apply Style 3 button Saves or applies Style 3.

Apply Style 4 button Saves or applies Style 4.

Apply Style 5 button Saves or applies Style 5.

Apply Style 6 button Saves or applies Style 6.

Apply Style 7 button Saves or applies Style 7.

Apply Style 8 button Saves or applies Style 8.

Apply Style 9 button Saves or applies Style 9.

Load Style button Opens the file browser where you can select a saved style to load.

Save Style button Opens the file browser where you can save a style.

Style Mode box Select whether to work with all styles or one style.

Style Save Number box Select the number of the style to save. Available when One Style is selected from
the Style Mode box.

Style Name button Sets the name of a defined style.

Style Option box Select an option for creating styles. AutoStyle assigns styles from an existing layer.

Tabulation Settings

NOTE The Tabulation settings are available when the Tabulation button is enabled in the Insert settings.

Add button Adds a tab stop on the text layer ruler. By default, tab stops are set at every 100 pixels.

Delete button Removes the selected tab stop.

Previous button Selects the previous tab stop on the text ruler. Tab stops appear in yellow when selected.

Tab ID field Display the tab number in the current paragraph. When you click Next or Previous, the Tab
ID field changes, showing the number of selected tab stops. Editable.

Next button Selects the next tab stop on the text ruler. Tab stops appear in yellow when selected.

Position field Displays the exact tab stop position on the X-axis, in pixels. This value is set in pixels. Editable.

Ruler button Enable to display the tabulation ruler in the text layer.

Justification box Select the text alignment at the tab stop.
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Spell Check Settings

NOTE The Spell Check settings are available when the Spell Check button is enabled in the Insert settings.

Spell Check Settings

Language box Select the language for the spell checker.

Check All Layers button Runs the spell checker on the text layers. When the spell checker encounters a
misspelled word, it draws a red line through it.

Hide Spelling Errors button Enable to hide the red strike through the line that appears in each misspelled
word.

Custom Dictionary button Enable to use your custom dictionary with the spell checker. Disable this button
to check all spelling. Disable to check all spelling.

Error Navigation Settings

Previous button Navigates to the previous misspelled word.

Next button Navigates to the next misspelled word.

Add To Custom Dictionary button Adds a word that the spell checker has flagged to the custom dictionary.
The next time the spell checker encounters this word, it will be ignored.

Setup and Processing Options

Auto-Softness box Sets the auto-softness and software sampling level.

Auto-Softness mode is set by default and provides a softness equal to the display quality you see in the Text
node.

Anti-Aliasing Softness field Displays the softness value of the anti-aliasing sample. Editable.

PreRender button Enable to accelerate rendering on a static layer, such as a text roll (has no effect on text
layers with animation).

PreRender has no effect on text layers with animation.

Hardware Anti-aliasing Sample box Select a hardware anti-aliasing sampling level to accelerate edge
anti-aliasing with no performance penalty. Available values are dependent on graphics card and project
graphic bit depth.

The graphics hardware automatically renders the image at full speed with approximately the equivalent of
up to 32 samples of anti-aliasing (depending on your graphics card and project graphic bit depth). Hardware
anti-aliasing also gives anti-aliasing during normal interaction instead of only while rendering.

You can combine hardware anti-aliasing level with software anti-aliasing to obtain the desired level of image
quality. For example, with hardware anti-aliasing set to 4 samples, and with 4 samples of software anti-aliasing
selected, your results should be similar to selecting 16 samples of software anti-aliasing, but with a processing
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time much closer to that of 4 samples. You should experiment with different combinations to determine
what works best for you.

Motion Update button Enable to update animated text dynamically in the image area when you play the
clip.

Controls the playback of animated text. When enabled, animated text is updated dynamically in the image
area when you play the clip.

Play Lock button Enable to update the animation settings according to the frame or timebar position as
you move through the clip while keeping it locked at the current frame.

Controls the playback of frames and displays the playback of animated clips exclusively. When enabled, the
first frame is locked while you play the clip.

Back Clip button Enable to display the back clip in the scene.

If you entered Text with a back clip, you can disable it here.

Crop button Enable to create a custom-sized crop box to define an area in which to render text.

Use this box to define an area in which to render text. When working with a crop box, you view all text,
whether it is inside or outside the crop box. You can use the Left, Right, Bottom, and Top fields to set the
size of the crop box. You can also drag the vertices at the corners of the crop box in the image window.

Crop Border button Enable to display a coloured border representing the crop area.

You can change the colour by clicking the colour pot.

Crop Border colour pot Displays the colour of the crop border. Editable.

Top Crop field Displays the top boundary value for the crop box. Editable.

Left Crop field Displays the left boundary value for the crop box. Editable.

Bottom Crop field Displays the bottom boundary value for the crop box. Editable.

Right Crop field Displays the right boundary value for the crop box. Editable.

Wireframe colour pot Displays the colour of the text path. Editable.

See Animating Text on a Motion Path (page 877).
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Points colour pot Displays the colour of the vertices on a text path. Editable.

See Animating Text on a Motion Path (page 877).

Global/Layer Blur box Select whether to apply blurring globally or on a per layer basis.

Global Blur makes all shadows appear together, blurred with a single unique colour, on top of the background
of all layers. Layer Blur blurs each layer individually according to its priority—background, blurred shadow,
and fill.

When using Global Blur with prerendering, the layers are prerendered once and blurred on the front clip.
These layers must not have any animation—they are static. For Layer Blur, there are two possible cases:
■ All layers are static, without background. Only fill or shadow can be enabled for all layers—no blur. The

layers are prerendered once and blurred on the front clip.

■ Auto-Softness On, Progressive Rendering, or All Layers Static. Static layers (up to two) are prerendered
once and blurred on the front clip as other layers are rendered.

Shadow Blur box Select whether to use a smooth blur with rounded edges (Gaussian), or a rectangular,
rougher edged blur (Box).

Clear Undo Buffer button Resets the Undo entries.

Undo Levels field Displays the number of Undo levels available in the Undo/Redo lists. Editable.

Changes the levels of Undo available in the Undo/Redo lists. The maximum level of undo is 20.

Entering Text

Font Type box Select the type of font to display in the font browser list.

Font Preview window Previews the selected font. Click to enter text.

Exit Load Font button Exits the font browser.
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Modifying Layer and Character Properties

Layer Axis box Select an alignment option for the selected text layer.

To move the axis:Select:

To the upper-left corner of the text layer.Top/Left

To the centre point of the text layer.Centre

X Scale field Displays the scale of the text layer along the X axis. Editable.

This value is a percentage, so entering 50 means 50 percent. Use a larger value to increase the scale along
the X-axis. Use a negative value to create a mirror image on the X-axis. Enter 0 to make a layer or selected
characters disappear. The default is 100.

Y Scale field Displays the scale of the text layer along the Y axis. Editable.

This value is a percentage, so entering 50 means 50 percent. Use a larger value to increase the scale along
the Y-axis. Use a negative value to create a mirror image on the Y-axis. Enter 0 to make the layer or selected
characters disappear. The default is 100.

Proportional Scale button Enable to proportionally change the X Scale and Y Scale values.

X Shear field Displays the shear or slant value of the text layer along the X axis. Editable.

Use a positive value to slant right and a negative value to slant left. The maximum and minimum values
are 60 and -60, respectively. The default is 0.

Y Shear field Displays the shear or slant value of the text layer along the Y axis. Editable. Use a positive
value to shear up. A negative value near the minimum value -60 shears down. The maximum and minimum
values are 60 and -60, respectively. The default is 0.

Rotation field Displays a rotation value for a layer rotating around its axis. Editable.

Use a negative value to rotate clockwise and a positive value to rotate counter-clockwise. The default is 0.
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Animating Keyframes

You can build animations simply by editing the values of parameters in any effect editor or menu. When you animate a
parameter, you create an animation channel that you can use to control the values of the parameter over time.

To use auto key to build animations automatically in the editor for an effect or tool:

1 Enable Auto Key.

2 Go to the frame where you want to add the keyframe.

3 Change the value of the parameter. Enter a new value in the field using the calculator, or click and drag left or right
to change the value.

A keyframe is added to the animation channel for the parameter you edited.

NOTE When auto key is enabled, you create keyframes whenever you change the value for a parameter. You also change
the value of any parameter that you have already set.

To set keyframes manually in the editor for an effect or tool:

1 Disable Auto Key.

2 Go to the frame where you want to add the keyframe.

3 Change the value of the property. Enter a new value in the field using the calculator, or click and drag left or right
to change the value.

4 Right-click the field and select Set Keyframe (Current Value).

To delete keyframes:

1 Go to the frame that contains the keyframe you want to delete.

2 Right-click the parameter that contains the keyframe and select Delete Keyframe.

NOTE A yellow bar appears under values that are keyframed at the current frame.

To reset keyframe values:

1 Right-click the parameter and select one of the following options.

To:Select:

Reset the value of the keyframe to the original value.Reset (Default Value)
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To:Select:

Reset the value of the entire channel to the current value.Reset Channel (Current Value)

Reset the entire channel to the original value.Reset Channel (Default Value)

Keyframe Indicator Reference
A number of colours are used in numeric fields to indicate that keyframes are set for a parameter.

ExampleIndicator

An asterisk in a field indicates that a value has changed from the default, but a
keyframe is not set. Once a keyframe is set, the asterisk disappears.

A blue line under a numeric field indicates that one or more keyframes are present
on this channel, but not at the current frame.

A yellow line under a numeric field indicates that a keyframe is present on this
channel at this point in time.

A dotted yellow line under a numeric field indicates that this channel is linked to
another channel using an expression. In this case, the numeric value is also greyed
out, as the value can not be modified. The name of the linking channel is also
displayed as part of the tooltip.

Animating Keyframes in the Animation Channel Editor
The Animation Channel Editor offers more control over your animation than is offered when editing the
values of parameters in an effect or tool editor. Use the Animation Channel Editor to fine-tune changes
across all animation channels available for the effect or tool you are working on.

To display the Channel Editor:

1 Click Animation.
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The Animation Channel Editor is displayed in the bottom area of the window.

To display the Animation Channel Editor in a viewport:

1 Click the View box.

2 Select one of the following from the Animation menu:

To display:Select:

Animation curves.Channels

Animation channels as tracks. This view can help you visualize and align keyframes.Tracks

A table displaying keyframe values in text format.Info

Panning and Zooming in the Animation Channel Editor

To center the Animation Channel Editor on your work, click one of the following:

■ Frame: to center the display on the currently selected channel.

■ Frame All: to center the display on all the animation channels that have at least one keyframe set on
them.

NOTE These buttons are located at the bottom left corner of the Animation Channel Editor.

To pan the Animation Channel Editor:

1 From the Edit Mode box (below the Keyframe tab), select Pan.

2 Click and drag the cursor to pan the view.

To zoom the Animation Channel Editor:

1 From the Edit Mode box (below the Keyframe tab), select Rect Zoom.

2 Click and drag a rectangle on the area you want zoom.

NOTE You can zoom x and y independently. Use the Zoom command from the Edit Mode box. Click and drag
up or down to zoom the y axis. Click and drag left or right to zoom the x axis.
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Adding Keyframes to Channels in the Animation Channel Editor

To add keyframes automatically:

1 In the Animation Channel Editor, enable Auto Key.

2 Select the channel you want to add keyframes to.

3 Click the value next to the channel name to open the calculator.

4 Enter a value and click enter to close the calculator.

A keyframe is added to the channel you selected.

To set keyframes manually:

1 In the Animation Channel Editor, disable Auto Key.

2 Select the channel or channels you want to add keyframes to.

3 Drag the positioner to the frame where you want to set the keyframe.

4 Click Set Key.

The current values for the selected channels are set at the current frame.

TIP It can be useful to set keys across multiple channels using the Track Editor since this view focuses on
channels, and their composing keyframes, in time. To view the Track Editor, select Track from the Channel
View box.

To add keyframes at different locations on the animation channel:

1 From the Edit Mode box (just below the Keyframe tab), select Add Points.

2 Click the spot on the channel where you want to add the keyframe.

NOTE You can snap the keyframes you add to a frame (rather than in between frames). From the Curve
Functions box, select FrmSnap.

To insert a keyframe:

1 Select the channel or channels you want to add keyframes to.

2 Drag the positioner to the frame where you want to set the keyframe.
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3 Click Insert Key. The Insert Key button behaves differently depending on the current frame:
■ If the current frame is the last keyframe, a new keyframe is created <duration> number of frames

after the last keyframe (duration is the value in the Duration field). The current frame advances to
the new keyframe.

■ If the current frame is a keyframe other than the last keyframe, a new keyframe is created <duration>
number of frames after the present keyframe. Other keyframes are moved by the same duration
causing a ripple effect.

■ If the current frame is between keyframes, Insert acts the same as the Set button: a new keyframe
is created and the duration is unchanged.

Changing Keyframe Values in the Animation Channel Editor

You can change keyframe values in the Channel or Track View of the Animation Channel Editor.

To gesturally change keyframe values:

1 In the Animation Channel Editor, select the channel that includes the keyframes you want to change.

2 Click Frame to view the channel.

3 From the Edit Mode box (below the Keyframe tab), select Select.

4 Select the keyframes. To select multiple keyframes, press Ctrl+drag to create a rectangular selection.

5 Drag the keyframes to the new values. Press Alt to snap the frame value (vertical axis) to the nearest
integer. Press Ctrl+Option to snap to the nearest multiple of ten.

NOTE Enable Track Snap on the Filter tab to snap keyframes to frames (not in-between frames). Or, press Option+Z
to snap when Track Snap is disabled.

To set a specific value for a keyframe in the Animation Channel Editor:

1 Select the Channel that has the keyframe you want to change.

2 Set the positioner to the frame where the keyframe is located.

3 Click the value next to the channel name and enter a new value in the calculator. Or click the number
and drag to change its value gesturally.

Copying and Pasting Channels or Keyframes in the Animation Channel Ed-
itor

You can copy and paste animation curves or keyframes between channels.

You can copy and paste folders provided the folder to which you are pasting has the same number of channels
and folders as the folder you copied.

For example, in Action, you can copy the Scale folder from an axis and paste it into the Scale folder of
another axis because they have the same channels (X scale, Y scale, for example). Trying to copy and paste
the Camera folder to the Scale folder will not work because the two folders do not contain the same number
and kinds of channels.

NOTE If an expression is applied to the selected channel, the expression is copied instead.
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To copy and paste a selection of keyframes:

1 Select keyframes on a channel, and click Copy.

TIP Keyframes do not have to follow one another to be copied and pasted to another channel.

2 Drag the positioner to a new frame.

3 Select the channel and the frame where you want to paste the keyframes, then click Paste.

The keyframe values for the selected channels are pasted and set in the current frame.

To copy and paste a curve:

1 From the Channel View box in the Keyframe tab, select Channels. The Channel View box is to the left
of the Insert Key button.

2 Select the channel containing the animation curve.

TIP Select a folder to copy all the channels in a folder.

3 Click Copy.

4 Select the channel where you want to paste the copied curve.

5 Click Paste.

The channel values you copied are applied to the selected channel or folder.

Changing the Duration of an Animation in the Animation Channel Editor

You can change the duration of an animation by scaling its channel horizontally in the Channel Editor.
This allows you to change the number of frames it takes for an animation to play through, without having
to move each keyframe manually.

There are three ways to change the duration of an animation in the Animation Channel Editor:
■ Use the X Scale tool to scale the channel using any keyframe as the origin of the scale.

■ In the Tracks view, Drag the track handle to scales the track proportionally.

■ Using the Duration field.

When changing the length of channels, you may want to adjust the number of frames of the clip in the
Total Frames field. For example, if you shorten the length of all the clip's channels, you can then shorten
the clips' frames accordingly. Or, if you scale the channels longer than the duration of the clip, you can
then add frames to account for this.

To change the duration of an animation in the Channel View:

1 From the Edit Mode box, select X Scale.

2 Select the keyframes or channels you want to scale.

You may have to click Frame to view the curve.

3 Click the keyframe that will act as the centre of the X Scale. Drag left to decrease the value or drag
right to increase the value of the other keyframes along the X-axis, relative to the selected keyframe.
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(a) Original animation curve

(a) XScale used to compress curves

To scale a channel in the Track Editor:

1 From the Channel View box, select Tracks.

2 From the Edit Mode box, select Select.

3 Select the channels you want to scale.

4 Drag the last handle to the left to decrease the duration, or to the right to increase the duration.

NOTE To avoid adding keyframes between frames when scaling, press Option-Z while scaling. If you have
already scaled the track, Select Frame Snap from the Curve Functions box to snap keyframes in the selected
channel to the closest frame numbers.

The track scales as you drag the handle. All keyframes are repositioned proportionally in time.
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(a) Original animation track

(a) Dragging handle used to compress a track from 40 to 20 frames

TIP You can move the handle of a folder to scale all channels in the folder. For example, moving the handle
of the Scene folder (the top level folder) causes all the folders and channels in the hierarchy to be scaled by
the same amount.

To change the number of frames between the current and next keyframe:

1 Select a keyframe.

2 In the Duration field, which is next to the Insert Key button in the Animation Channel Editor, enter
a value for the number of frames between the selected keyframe and the next keyframe.

Changing the Values of Keyframes Proportionally in the Animation Channel
Editor

In the Animation Channel Editor, you can change the vertical scale of an animation curve or a selection of
keyframes and change keyframe values for a channel or a group of keyframes while maintaining each
keyframe's relative frame position.
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(a) Original animation curve

(a) YScale used to scale the curve based on a selected keyframe

To change the values of keyframes proportionally:

1 In the Animation Channel Editor, select a channel or group of keyframes.

You can select more than one channel or a group of keyframes from more than one animation curve.

2 From the Edit Mode box, select Y Scale.

3 Click the keyframe that will determine the centre of the Y Scale.

4 Drag up to increase the value or down to decrease the value of the other keyframes relative to the
selected keyframe.

YScale works differently if you select more than one curve. For the other selected curves, the number
of the frame that you select is verified in all animation curves. If the animation curve has a keyframe
at the selected frame, this keyframe is used as the centre of the Yscale. This keyframe then sets the
proportional scale calculation. If the animation curve does not have a keyframe at the selected frame,
the curve remains unscaled.

Offsetting Select Keyframes or Channels in the Animation Channel Editor

You can offset a curve or a group of keyframes on the horizontal or vertical axis.
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To offset a channel:

1 Select the channel or keyframes to offset.

2 From the Curve Functions box in the Keyframe tab, select Translate X to offset the channel horizontally
or Translate Y to offset vertically.

3 Enter a value in the Curve Value field.

A negative value offsets the channel or group of keyframes to the left (Translate X) or down (Translate
Y). A positive value offsets to the right (Translate X) or up (Translate Y). The value in the Curve Value
field produced by the drag returns to zero after release.

The selected channel or keyframes are offset. The coordinates of each selected keyframe, relative to
each other, remain unchanged. Translating along the Y-axis is only visible in the Animation Curve
window.

Simplifying the Number of Keyframes in the Animation Channel Editor

You can change the number of keyframes in your animation curve or in a group of keyframes. Using the
Simplify function, the peaks and valleys in the selection are analysed and keyframes are generated with a
duration between them as specified in the Curve Value field. A large value such as 20 or 30 decreases the
number of keyframes between peaks and valleys, whereas a small value such as 1 or 2 increases the number
of keyframes. The ideal simplify value varies between animation curves.

For example, the following figure shows an animation curve created using the Stabilizer. Simplify is applied
with a value of 20. In sections where the slope of the curve is fairly constant in one direction, keyframes are
removed between the peaks and valleys. You can adjust the simplified animation curve more easily because
there are fewer keyframes to modify.

(a) The Y curve before applying Simplify has a keyframe at each frame
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(a) The Y curve after applying Simplify with a simplification value of 20.

To simplify a channel or a group of keyframes:

1 Select a channel or group of keyframes.

2 From the Curve Functions box in the Keyframe tab, select Simplify.

3 In the Curve Value field, enter a simplification value.

Use a large number to simplify the curve or group of keyframes. Use a small number to increase the
number of keyframes. The value in the Curve Value field produced by the drag returns to zero after
release.

Baking Keyframes

You can transform a curve or a group of keyframes by using the Bake function. This can be useful if you
want to change an extrapolated cycle curve into a normal curve, with keyframes created along the cycle.
You can also use the Bake function to remove the dependence of a curve linked to another curve with an
expression.

To bake a cycled curve:

1 Select a curve that has a cycle extrapolation applied to it.

2 Set the current frame to the last frame that you want to be baked.

3 From the Curve Functions box in the Keyframe tab, select Bake.

4 In the Curve Value field, enter a bake value.

Use a large number to simplify the curve or group of keyframes. Use a small number to increase the
number of keyframes. The value in the Curve Value field returns to zero after you have finished baking.

Swapping Animation Curves

You can swap animation curves between two channels. Swap works in conjunction with Copy or Cut. You
can also swap single keyframes but not a group of keyframes.

To swap two channels:

1 Select the first channel to swap.

2 Click Cut or Copy.
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The selection is copied to the clipboard.

3 Select the second channel to swap.

4 From the Curve Functions box in the Keyframe tab, select Swap.

The selected channel is swapped with the channel in the clipboard.

5 Select the first channel and click Paste.

The two channels are swapped.

Flipping Channels and Keyframes

Select Negate in the Curve Functions box to flip a channel or a group of keyframes vertically. Select Reverse
to flip a channel or a group of keyframes horizontally. Typically, you reverse or flip keyframes so that you
can create symmetry with an animation. For example, use Reverse on an image that is warping from a sphere
to a flat plane so that it then goes from a flat plane back to a sphere again. Perform these functions in the
Animation Curve window.

To negate or reverse a channel or group of keyframes:

1 In the Animation Channel Editor, select a channel or group of keyframes.

2 From the Curve Functions box in the Keyframe tab, select Negate or Reverse.

The selection is flipped horizontally (negate) or vertically (reverse).

Removing Jitter from an Animation Curve

Select Jitter in the Curve Functions box to remove jitter from an animation curve or within a group of
keyframes. Use the Curve Value field to specify the Over value. As a general rule, start with a large Over
value over n frames to remove slow jitter, and a small Over value to remove fast jitter. The Jitter option is
typically used on shift data in the Stabilizer to remove jitter while keeping camera movement. See Removing
Jitter While Keeping Overall Motion (page 605).

To remove jitter:

1 Select a channel or group of keyframes.

2 In the Curve Functions box in the Keyframe tab, select Jitter.

3 In the Curve Value field, specify the Over value.

Applying an Average

Select Average in the Curve Functions box to remove jitter from a jittery animation track. While the Jitter
option is used for removing jitter caused by trackers in the Stabilizer, the Average option is used to remove
jitter from an animation track. Enter the number of keyframes used to calculate the average in the Curve
Value field.

You can change the timing of a motion path animation without changing the motion path spline by adding
a keyframe to the speed curve.

To average a channel:

1 Select a channel or group of keyframes.

2 In the Curve Functions box in the Keyframe tab, select Average.
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3 In the Curve Value field, specify a value.

The jitter is removed from the spline animation.

4 From the Edit Mode box, select Break.

5 Click a keyframe on the speed channel.

The keyframe breaks into two tangents.

(a) Keyframe tangents

6 From the Edit Mode box, select Move.

7 Adjust the tangents.

In this example, the speed curve makes the apple accelerate rapidly until it reaches frame 29, where it
stops and continues moving slowly.

You can also apply the preceding procedure to a group of keyframes.

Modifying Tangents to Reshape the Animation Curve

To modify the tangents in the Animation Channel Editor.

1 From the Tangents box, select Auto.

2 From the Interpolation box, select an interpolation type. Only animation curves that use Bézier,
Hermite, or Natural interpolation have keyframes with tangent handles.

3 From the Edit Mode box, select Select and move the tangent handles.

As you move the handles, the slope on each side of the keyframe is modified independently.

NOTE You must break tangent handles to move them independently. From the Edit Mode box, select Break
Tangents and click the tangents you want to break.

To reset tangents to their default:

1 From the Edit Mode box, select Auto Tangent.

2 Click the handle of the tangent you want to reset.
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Changing the Value of a Tangent Handle by a Specific Amount

You can modify the shape of an animation curve by rotating its keyframe tangent handles to control the
smoothness and speed of the animation.

To rotate a keyframe's tangent handles:

1 Select a channel or group of keyframes.

2 From the Curve Functions box in the Keyframe tab, select Tangent R to rotate each right tangent handle
or Tangent L to rotate each left handle.

NOTE Tangent R and Tangent L only work on curves and keyframes that use Bézier, Hermite, or Natural
interpolation. Select your option from the Interpolation box.

3 Enter a value in the Curve Value field.

A negative value rotates each tangent counter-clockwise. A positive value rotates each tangent clockwise.

The tangent handle first breaks into two and then the handles are rotated.

The following example shows the results of applying Tangent L with a rotation value of 36 to the
keyframes of an entire curve. No keyframes were broken before Tangent L was applied.

(a) The Hermite curve before applying Tangent L. Note that none of the keyframes are broken.

(a) The same Hermite curve after applying Tangent L of 36. A break is applied to all keyframes before the tangents
are rotated.
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Setting Display Preferences in the Animation Channel Editor

Use the options in the Filter tab to control the display preferences in the Animation Channel Editor. The
Animation Channel Editor display preferences can help you focus on the channels you are working on in
the editor when many channels are displayed.

You can go in and out of the same tool in one session, and your display preferences are remembered. But if
you restart, the your display preferences are not remembered. You must save and load your display preferences
manually to access them when you restart the application.

To set display preferences:

1 In the Animation Channel Editor, select the Filter tab.

2 Select the type of channels you want to appear in the filtered view, animated or selected.

To:Select:

Display channels that are animated.Animated

Display channels that are selected.Selected

3 Select how you want to expand or collapse channels that appear in the filtered view.

To:Select:

Expand animated or selected channels and collapse all others.Exp & Col

Expand animated and selected channels. All previously expanded channels remain
selected.

Expand Only

Not expand animated or selected channels.No Expand

4 Select how you want to display folders that contain channels in the filtered view.

To:Select:

Show only the animated or selected properties, for example, the X and Y values of an
axis. All other properties in the same parent folder are hidden. All other folders are also
hidden.

Hide All
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To:Select:

Show only the animated or selected channel, its parent folder, and all channels in the
same group, where a group includes all folders in the same parent folder. All other
parent folders and groups are hidden.

NOTE If multiple channels are animated or selected, all corresponding parent folders
and groups are shown.

Hide Group

Show all animated or selected channels.Show All

5 From the Auto Frame box, select an option for framing your view of the Animation Channel Editor.

If you select All, Animated or Selected, your view of the Animation Channel Editor changes as you
change your channel selection.

To frame:Select:

All channels. This option is the same behavior as clicking the Frame All button in the
Animation Channel Editor.

All

All animated channels.Animated

All selected channels. This option is the same behavior as clicking the Frame button
in the Animation Channel Editor.

Selected

No channels. This option enables the Frame and Frame All buttons in the Animation
controls.

None

6 Enable Track Snap to force key frames to snap to whole frame numbers as you drag them.

7 Enable Filter Tangent to display tangents only on selected channels. This can help you cleanup the
display.

To save display preferences:

1 Click the User tab.

2 Click Save Prefs.
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To load display preferences:

1 Open the Animation Channel Editor from the tool where you saved your display preferences in.

2 On the User tab, click Load Prefs.

3 Click the Filter tab. Display preferences you saved are now activated on the Filter tab.

Using Selection Sets to Control the Channels and Folders You Want
to Display

With a selection set, you can control the channels and folders you want to display in the Animation Channel
Editor.

Selection sets can be particularly helpful if you access the Animation Channel Editor from a complicated
ConnectFX schematic, where all the selected nodes are displayed in the editor. With a selection set you can
limit the number of channels or folders displayed to just those you are working on.

Selection sets are saved and available throughout a session. However, they are not saved between sessions.
This means that you do not have access to the selection sets you create after you restart the application.

To create a selection set:

1 Select the User tab in the Animation Channel Editor.

2 Enable Filter.

3 Type a name in the Selection Set Name field and press Enter.

The selection set is created and selected in the Selection Set box. Notice that the Define button is also
enabled and the channels and folders in the Animation Channel Editor are colored red.

4 Select the channels or folders you want to in your selection set. If you are displaying the ConnectFX
schematic, you can select the nodes that you want in your selection set.

Notice that channels and folders in Animation Channel Editor turn green as you make selections. This
helps you identify the channels and folders in the selection set.
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5 Do one of the following:
■ Click Use Sel to save the channels and folders you selected to a selection set.

■ Click Add Sel To, to add the selection to an existing selection set.

6 Disable Define.

To switch between selection sets:

1 Select the User tab.

2 Select a selection set from the Selection Set box.

To modify a selection set:

1 Select a selection set from the Selection Set box.

2 Enable Define.

3 Select the channels and folders you want to display in the selection set.

4 Click Add Sel To. The selection is added to the selection set and the selection set is saved.

5 Disable Define.

Generating Keyframes Based on Audio Analysis

In the Channel Editor, you can use an audio clip to automatically generate keyframes on any video or audio
channel based on the analysis of the audio.

To map keyframes based on audio analysis:

1 In the Channel Editor, select the Audio tab.

NOTE The Audio menu has a number of submenus with various settings. You may not need to use every
setting to analyse your audio clip. See the sections after this procedure for an explanation of each setting.

2 From the Media Source box, select whether you want to analyse the current audio clip (Clip) or import
an audio clip (File).
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If there is more than one audio clip associated with your choice (for example, Front, Back, or Matte),
you can choose which one to use in the Name box. If only one audio clip is available, the name of the
clip appears in a locked field.

If you select File, click Import to open the Import Audio browser, and select an audio file to import.

3 In the Channel hierarchy, select the channel or channels you want to link the audio to.

4 Use the settings in the Media submenu to prepare the audio track you want to use. See Audio Keyframe
Settings (page 1118).

5 From the Mapping submenu, enable Link To Channel.

The letter ‘a’ appears next to the channel in the Channel hierarchy, indicating that this channel is
linked to the audio.
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6 Use the settings in the Mapping submenu to determine how the audio track is mapped to the selected
channel. Keyframes are adjusted automatically as changes are made to the settings.

7 Use the settings in the Filtering submenu to filter the exact frequencies you want to analyse. Keyframes
are adjusted automatically as changes are made to the settings.

8 Disable Link To Channel or exit the module when you are satisfied with the analysis. The generated
keyframes are automatically baked to the animation curve.

You can use different audio tracking settings on different channels. Disable Link To Channel and select
a different channel in the hierarchy and restart the mapping process.

NOTE If you want to be able to tweak the settings, you can save the analysis settings in an audio tracker setup.

Audio Keyframe Settings

The animation controls Audio tab has a number of submenus with numerous settings to help you work with
your audio clips.

Common Settings

There are a few common settings found in the Audio submenus.

Play button Plays the audio media.

Stop button Stops the audio playback.

Reset box Available in the Media, Mapping, and Filtering submenus. In the Setup submenu, only Reset All
is available.Select whether to reset the current Audio submenu, or all of the Audio settings.
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Media Submenu

(a) Media Source box

Media Source box Select whether to analyse the current audio clip (audio attached to the front, back, or
matte clips, for example), or the imported audio file.

Import button Opens the import audio browser to load a file.

Clip Name box If multiple audio clips are available, select which clip to use as source media. If only one
audio clip is available, the name of the clip appears in a locked field.

W+ button Displays the selected media's waveform in the Channel Editor.

W- button Hides the waveform.

Track box Select which audio track to use as source media.

Slip field Displays the amount of frames to slip the media. Editable.

Handles field Displays the amount of handles (frames) to analyse before and after the current shot duration.
Editable.

For example, with a shot of 100 frames, if you enter 30 in this field, the total number of frames becomes
160 (30 frames before and 30 frames after the original 100 frames).

Mapping Submenu

(a) Audio Level Indicator (b) Tracking Mode box (c) Listening Mode box

Tracking Mode box Select whether to use an Amplitude or Transient tracking mode. In Amplitude tracking
mode, a keyframe is generated at each frame, following the envelope of the audio signal. In Transient tracking
mode, a keyframe is generated for each audio transient (sudden rise in amplitude), provided that the signal
rises above the specified threshold.
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Listening Mode box Choose between Pre Filter (audio as it was imported) and Post Filter (audio with any
changes made) monitoring when playing back audio media. Does not affect the analysis.

Link to Channel button Enable to map the tracked audio to the selected animation channel. An 'a' appears
in the channel list next to the name of the linked channel. Multiple channels can be selected simultaneously.

Channel Name field This locked field displays the name of the selected channel being linked to the tracked
audio. Multiple Channels is displayed if more than one channel is selected.

Min Value field Displays the minimum value at which keyframes can be set in the linked channel. Editable.

Max Value field Displays the maximum values at which keyframes can be set in the linked channel. Editable.

NOTE The minimum value can be higher than the maximum value to get an inverse mapping of the tracking
mode in the animation channel.

Attack field Displays the number of frames needed for the channel to reach the Max Value before a transient.
Available only in Transient tracking mode. Editable.

Release field Displays the number of frames needed for the channel to reach the Min Value after a transient.
Available only in Transient tracking mode. Editable.

Threshold field (Not shown). Displays the value at which a keyframe is generated each time the signal rises
above it. Available only in Transient tracking mode. Editable.

TIP Start with a high threshold, and lower it until all required peaks are detected.

Floor field Displays the minimum level of the audio media to be considered for the analysis (typically used
to remove analysis noise between audio transients). Available only in Amplitude tracking mode. Editable.

Inertia field Displays the rate at which the signal decreases after a transient. Editable.

In Transient tracking mode, the Release field can be increased to avoid the generation of several consecutive
keyframes when the transient is not clearly defined in the input signal. Conversely, if the Release field is set
to 0 ms, each transient rising above the threshold generates a keyframe, even if each occurs within a few
milliseconds of another.

Audio Level Indicator A visual representation of the audio level and the current Threshold or Floor value.

Audio Level Indicator A visual representation of the audio level and the current Threshold or Floor value.

Reset box Select Reset to reset the Mapping submenu settings only. Select Reset All to reset all of the Audio
tab settings.

NOTE Some of the settings in the Mapping submenu are repeated in the Filtering submenu so that you do not
to have to switch tabs to change the settings. The same settings are reflected in both submenus.
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Filtering Submenu

(a) Audio Level Indicator (b) Tracking Mode box (c) Frequency Graph (d) Listening Mode box

Frequency Graph A visual frequency representation of the audio signal being tracked. The audio display is
always Pre Filter.

Frequency Range Preset box Select a frequency range preset to determine the cutoff frequencies for Low
and High filters.

Low field Displays the lowest frequency of the input signal used in the analysis (also represented by a triangle
under the frequency graph). Use the slider or field to adjust. Editable.

High field Displays the highest frequency of the input signal used in the analysis (also represented by a
triangle under the frequency graph). Use the slider or field to adjust. Editable.

NOTE Some of the settings in the Filtering submenu are repeated in the Mapping submenu so that you do not
to have to switch tabs to change the settings. The same settings are reflected in both submenus.

Setup Submenu

Load button Click to load a saved audio mapping setup.

Save button Click to save an audio mapping setup.

Setup Name field This locked field displays the name of the loaded setup

Animation Menu Settings

The Animation menu has some common settings, and a number of settings specific to certain operations,
organized in submenus. For specific Audio submenu settings, see Audio Keyframe Settings (page 1118).
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Common Settings

Regen button Enable to automatically update the scene when an animation change is made.

Channel View box Select a view of Channels, Tracks, or Info to control and coordinate your animation.

Auto Select button Enable to select the channel automatically when you modify a channel value in the
field for an effect or tool.

Set Key button Sets the current values for the selected channels in the current frame (when Auto Key is
disabled).

Delete Key button Deletes the selected keyframes or curve.

Keep button Deletes all keyframes except the current keyframe.

Cut button Cuts the selected keyframes or curve.

Copy button Copies the selected keyframes or curve.

Paste button Pastes the selected keyframes or curve.

Link button Creates an expression by linking one channel to another.

Expressions button Applies an expression to one or more channels.

Animation Reset box Select to reset the selected channel or all channels.

Keyframe Submenu

Curve Functions box Select an operation to apply to your animation.

Curve Value field Displays the value for the selection in the Curve Functions box. Editable.

Insert Key button Inserts a keyframe. Its behaviour changes depending on where the keyframe is inserted.

Duration field Displays the number of frames between keyframes. Editable.

Absolute/Relative box Select whether the value in the Duration field is absolute or relative to the present
keyframe value.

Tangents box Select the behaviour of the keyframe tangents to help refine the shape of an animation curve
between keyframes.

Tangent BehaviourTangent Mode

Tangents are fixed in an horizontal position to prevent the curve

from over- or under-shooting keyframes. Moving a keyframe

Auto

higher or lower than its neighboring keyframes alters their tan-

gents so the curve remains as uniform as possible. The handles

of tangents set to Auto are empty circles.

Manually moving a keyframe's tangent voids this setting for

that tangent. It will now perform as a Fixed tangent.

Tangents are fixed in their current position so that moving a

keyframe does not alter its tangents nor those of its neighboring

keyframes.

The handles of tangents set manually are filled circles.

Fixed
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Tangent BehaviourTangent Mode

Legacy setting to ensure compatibility with previous versions

of a setup. Tangents are not locked like when using the Auto

Smooth

setting: they are affected by the movement of adjacent key-

frames. There are no other benefit from using this setting.

Interpolation box Select an interpolation type to define the shape of an animation curve between keyframes.

Extrapolation box Select an extrapolation type to define the shape of an animation curve before the first
keyframe and after the last keyframe of the curve.

User Submenu

Filter button Enable to create and name a selection set (the channels, folders, and folder elements that you
want to display as part of a set).

Selection Set box Select a user-defined selection set. Select <new user> to create a selection set.

Name field Enter a name for the selection set. Editable.

Define button Enable to display channels in red and green to indicate the channels contained in the current
user-defined selection set.

Delete button Removes the currently selected selection set from the Selection Set box.

Use Selection button Displays the current selection set in the Channel Editor and at the same time saves
the current selection set.

Add Selection To button Adds the current selection to the active selection set.

Load Filter Preferences button Loads the filter preferences last saved for the module.

Save Filter Preferences button Saves the current filter settings as preferences for the module.

Filter Submenu

Animated button Enable to display channels that have animation keyframes. Use in conjunction with the
Animated Expansion and Animated Show/Hide boxes to further control the content displayed.

Selected button Enable to display only channels that are selected in the Channel Editor. Use in conjunction
with the Selected Expansion and Selected Show/Hide boxes to further control the content displayed.

Animated Expansion box Select an expansion option for animated folders.

Selected Expansion box Select an expansion option for selected folders.

Animated Show/Hide box Select to display or hide animated folders.

Selected Show/Hide box Select to display or hide selected folders.

Auto Frame box Select an option to frame channels automatically. If None is selected, the Frame and Frame
All buttons are enabled.

Track Snap button Enable to force keyframes to snap to frames when dragging tracks by their left or right
handles.

Filter Tangents button Enable to display only the tangent handles of selected channels.
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Advanced Animation: About Expressions
Use expressions to apply animation dynamically to one or more channels. For example, use expressions to
easily simulate real-world forces such as gravity, momentum, and centrifugal force. Expressions save time
since you can animate one channel, and then refer other channels to the first channel so that the other
channels automatically behave in relation to the first one. You can use arithmetic operators, such as addition
and multiplication, as well as predefined functions to precisely control the behaviour of an animation.

Expressions are available through all modules that use the Channel Editor.

Working with Expressions in the Channel Editor

You can apply, modify and view expressions using the Channel Editor. You can use the copy and link
functionality to quickly apply basic expressions to multiple channels.

WARNING Expressions override interpolation modes and previously set keyframes for a selected channel.

To apply an expression to a channel:

1 In any module menu, click Animation.

The Animation controls appear.

(a) Channel View box (b)  Reset Channel button (c) Expressions button

2 From the Channel View box, select Info.

Channel information appears in a tabular grid for easier viewing of expressions and channel details.
From Info view, you can click the Expressions column heading to sort by expressions and view them
more easily.
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3 Select the channel to which you want to apply an expression.

4 In the Animation controls, click Expression.

The Expression field appears below the Channel Editor.

(a) Expression field

5 Enter an expression according to the guidelines described in Operator Reference (page 1131) and Function
Reference (page 1133) and press Enter.

The letter 'e' appears next to the channel in the channel hierarchy, indicating that this channel contains
an expression.

(a) Expression indicator

NOTE Entering an invalid expression will result in the message “Error: Expression: parse error” and the
entered expression will not be applied to the channel.

To modify an expression:

1 Click Animation to display the Animation controls.

2 In the channel hierarchy or Info view, select the expression that you want to edit.
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3 In the Animation controls, click Expression.

The Expression field appears below the Channel Editor.

4 Modify the expression in the field and press Enter.

The modified expression appears in the table.

TIP When you are in the Expression field, you can press Up one or more times to retrieve its previous contents.
This can be useful if you want to correct an invalid expression that you recently entered.

To remove an expression:

1 Click Animation to display the Animation controls.

2 In the channel hierarchy or Info view, select the channel with the expression that you want to remove.

3 Click Rst Chn to remove the expression.

The channel is reset.

Linking Channels

You can create an expression by linking the behaviour of one channel to another using Copy and Link. You
can link different types of channels together. For example, make the scaling of a layer affect the rotation of
another layer, or blur a layer by linking it to the position of an axis. Any change that occurs in the position
of the axis is reflected dynamically in the layer blur.

To create an expression by linking one channel to another:

1 Click Animation to display the Animation controls.

2 From the Channel View box, select Info.

(a) Channel View box (b) Link button (c) Copy button

TIP Enable the Hierarchy View button  to better view the channel hierarchy.

3 Select a source channel from which to link and click Copy.

For example, copy the x position of axis1 and link it to the x blur value of a layer.
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4 Select the destination channel and click Link.

The x blur value of layer1 is linked to the x position value of axis41, so as the position increases, so
does the blur. This is shown in the following illustration.

Copying Nodes with Expressions

When working in Action, Keyer or Garbage Masks, if you copy a branch in Schematic view, or append to a
setup by loading a second setup, any nodes with the same name as existing ones are renamed with unique
names. Likewise, if expressions are associated with those nodes, the expressions are replicated and the
associated channels are renamed to correspond with the new node names. This preserves the integrity of
the expression within the copied branch or appended setup.

If you copy a portion of a branch that has expressions associated with it, the expressions related to the copied
portion of the branch will be associated with the new copy. Expressions related to uncopied portions of the
branch will maintain their association with the original branch.

Cascading Expressions

You can copy a single expression to multiple channels that build on the result in the previous channel using
the SelectionOrder and CascadeChannel keywords. These keywords increment the channel number or name
as follows:
■ Each instance of SelectionOrder increments the channel number.

■ Each instance of CascadeChannel replaces the occurrence of the channel name with the name of the
preceding channel, relative to the order in which the channels are selected.

In general, experiment with the SelectionOrder and CascadeChannel keywords to determine which results
are optimal for your animation.

To apply cascading expressions using SelectionOrder:

1 Click Animation to display the Animation controls.

2 From the Channel View box, select Info.

3 Select multiple channels to which you want to apply the cascaded expression, in the desired order.

As you select each channel, the selection order is shown next to the channel name in Info view.

TIP To select a range of channels, click the first channel that you want to include in the range. Then click
the last channel to include in the range while holding Shift. To add to a range of files, hold Ctrl or the
stylus button while selecting the channels from the Channel Editor.
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4 Enter an expression that includes the keyword SelectionOrder.

Every instance of the keyword SelectionOrder will be substituted in your expression by a different
number for each channel, which corresponds to the order in which you selected them.

To animate four channels using SelectionOrder:

1 In Action, add four axes named axis1, axis2, axis3 and axis4.

2 Animate axis1.position by creating a few keyframes.

3 Select the channels axis2.position, axis3.position and axis4.position in this order.

4 Enter the following expression: eval(axis1.position, frame - 5 * SelectionOrder).

The following expressions are applied:

■ axis1.position: no expression

■ axis2.position: eval(axis1.position, frame - 5 * 1)

■ axis3.position: eval(axis1.position, frame - 5 * 2)

■ axis4.position: eval(axis1.position, frame - 5 * 3)

To apply cascading expressions using CascadeChannel:

1 Click Animation to display the Animation controls.

2 From the Channel View box, select Info.

3 Apply an expression to a base channel to which the other channels will relate.

4 Select multiple channels, starting with the base channel, to which you want to apply the cascaded
expression, in the desired order.

5 Enter an expression that includes the keyword CascadeChannel.

The base channel (the first channel selected) will remain unmodified. In the expressions for the other
selected channels, every instance of the keyword CascadeChannel will be substituted by the name of
the channel that preceded it, in the order in which you selected them.

To animate four axes using CascadeChannel:

1 In Action, add four axes named axis1, axis2, axis3 and axis4.

2 Animate axis1.position by creating a few keyframes.

3 Select, in this order, the channels axis1.position, axis2.position, axis3.position and axis4.position.

4 Enter the following expression: eval(CascadeChannel, frame - 5).

The following are applied:

■ axis1.position: no expression

■ axis2.position: eval(axis1.position, frame - 5)

■ axis3.position: eval(axis2.position, frame - 5)

■ axis4.position: eval(axis3.position, frame - 5)

NOTE This results in the same animation as the SelectionOrder example given above.
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Expression Content

An expression is composed of numeric values, constants, channel references, or combinations of these used
with arithmetic operators. Expressions are calculated from left to right, according to a specific order defined
in Operator Precedence (page 1132).

For example, the following expression contains channel references and multiplies the transparency value
of image1 by 2 to affect the transparency of image2 across all keyframes.

ExpressionChannel

image1.material.transparency* 2image2.material.transparency

Vectors

Certain channels such as Position, Rotation, Scale, and Shear are vector based since they represent 3D space
and include X-, Y-, and Z-axes. A vector contains three elements that represent the individual components
of the channel. Vectors are written using the convention (x, y, z) where x, y, and z represent separate scalar
values.

Expressions can either affect the components of a vector individually or collectively. For example, the
following expression sets the individual rotation for the x, y, and z axes to 30°, 45° and 90°, respectively.

ExpressionChannel

(30, 45, 90)axis1.rotation

The following expression sets the rotation for axis2 twice that of axis1, affecting the vector collectively.

ExpressionChannel

axis1.rotation* 2axis2.rotation

Functions

Smoke includes many predefined functions that can be used to perform calculations in an expression. You
pass function-specific values, called arguments, and they return another value back to the expression that
called it. A function call in an expression begins with the function name, followed by an opening parenthesis,
the arguments for the function separated by commas, and finally a closing parenthesis.

NOTE Function names are case-sensitive.

Arguments for functions can be either scalar values or vectors. When you use a function, make sure that
you pass it the correct type of parameter. See Function Reference (page 1133) for information on the arguments
and return values for each function.

You can nest function calls by using the return value of a function as one of the arguments of another
function. When a nested function is used as an argument, it must return a value that conforms to the type
and range that the argument requires.

You can define your own functions and use them in your expressions just as you would with any of the
predefined functions. See Defining Your Own Functions (page 1154).
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Examples

The following expression uses the noise function to create a random positioning effect for axis1.

ExpressionChannel

noise(frame)*5axis1.position.x

The following expression uses the eval function to make the position of axis2 the same as that of axis1, but
delayed by 10 frames.

ExpressionChannel

eval(axis1.position, frame - 10)axis2.position

The following expression uses the eval function to make the animation of axis3 the same as that of axis1,
but at half the speed.

ExpressionChannel

eval(axis1, frame / 2)axis3

Keywords and Constants

Use the keyword frame in an expression to get the value of the current frame number in your animation.
This allows you to create an animation by specifying how a value changes over a sequence of frames.

Use the constant PI instead of the literal numeric value of π (3.1416...).

NOTE Keywords and constant names are case-sensitive.

To display:Select:

3.1416...PI

Euler's number (2.7182818284...)e

Golden Ratio (1.6180339887...)phi

Speed of light in vacuum (299792458 m/sec)c

Standard free fall acceleration near the earth's surface (9.80665 m/sec^2)freefall

Elementary charge (1.602176487e-19 Coulomb)echarge

Simplified Expressions

A reference to another channel does not have to be fully qualified when it is at the same hierarchical level
as the channel to which the expression is being applied. For example, the following simplified expressions
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are valid when applied to the specified channel. The fully qualified versions of the expressions are also
provided.

Fully Qualified ExpressionSimplified ExpressionChannel

axis1.position.x + 50x + 50axis1.position.y

axis1.position / 2position / 2axis1.rotation

image1.material.specular * 3specular * 3image1.material.diffuse

References to other channels also work when referring to the siblings of any parent. For example, consider
the following structure.

You can apply the expression position.x to axis.rotation.x because position is a sibling of rotation, and
rotation is a parent of rotation.x.

Operator Reference

Operators specify a mathematical or logical calculation to be performed between various elements of an
expression.

Arithmetic Operators

Use the following arithmetic operators to perform basic mathematical operations.

DescriptionOperator

Addition+

Subtraction-

Multiplication*

Division/
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DescriptionOperator

Modulo (this is a binary operator)%

Vector where x, y, and z are scalar values(x, y, z)

Comparison Operators

Use the following operators to compare two values with each other. When two values are compared using
these operators, the result is 1 if the comparison is true and 0 if the comparison is false.

DescriptionOperator

Equal to==

Not equal to!=

Less than<

Less than or equal to<=

Greater than>

Greater than or equal to>=

Boolean AND&&

Boolean OR||

Boolean NOT!

Operator Precedence

When you combine several operators in a single expression, the operations are performed in the following
order.

DescriptionOperatorOrder

Boolean NOT!1

Negation (as in -1)-2

Multiplication, division, and modulus*, / and %3

Addition and subtraction+ and -4
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DescriptionOperatorOrder

Comparison< , <=, >, and >=5

Equivalence== and !=6

Boolean AND&&7

Boolean OR||8

When operators with the same precedence are encountered, operators are evaluated from left to right.
However, when part of a formula is enclosed in parentheses, it is evaluated first.

Function Reference

You can easily create very complex expressions by using the available functions. This function reference
provides detailed information about each function. Function arguments in square brackets are optional.
However, if you give a value to an optional argument, you must also give a value to every optional argument
before that one.

Animation Functions

Use the following functions to animate channels in a general way.

NOTE Arguments shown in square brackets are optional. For example, in the syntax of the align function, the
options [AxisToAlign] and [BankingAngle] are optional.

align

Returns a rotation vector such that a designated axis of an object is aligned with the direction of the object's
movement. You can also bank the rotation around the axis. The result should usually be assigned to a
rotation channel.

align(PosToFollow, [AxisToAlign], [BankingAngle])Syntax:

Arguments: ■ PosToFollow is the vector representing the channel to align on, typically an animated
position.

■ AxisToAlign is the vector representing the axis with which to align, by default the X-
axis (1,0,0).

■ BankingAngle is the angle in radians by which to rotate the result about the AxisToAlign
(performs banking). If the BankingAngle argument is specified, the AxisToAlign argument
must also be specified.

align(axis.position, (0,0,1), frame * PI / 8) returns a rotation vector that points the object's
Z-axis in the direction of its motion while the rest of the axis rotates along this axis.

Example:
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lookat

Returns a rotation vector based on an object's position that points it towards a second moving object. The
result should usually be assigned to a rotation channel.

lookat(TargetPos, ObserverPos, [AlignVector], [UpVector])Syntax:

Arguments: ■ TargetPos is the vector of an object's position channel that you want the rotation vector
to point towards.

■ ObserverPos is the vector of the position channel from which you are looking.

■ AlignVector is the vector of the direction that you want to have looking at the target,
by default the Z-axis (0,0,1).

■ UpVector is the vector of the direction that you want to be pointing upwards, by default
the Y-axis (0,1,0). The UpVector should be set to a different vector than the AlignVector.
If the UpVector argument is specified, the AlignVector argument must also be specified.

Examples: ■ lookat(followed_axis.position, follows_axis.position) returns the rotation vector required
so that follows_axis points its Z-axis towards followed_axis.

■ lookat(followed_axis.position, follows_axis.position, (0,1,0),(1,0,0)) returns the rotation
vector required so that follows_axis points its Y-axis towards followed_axis, with its X-
axis pointing upwards.

eval

Returns the value of a given expression at another point in time.

eval(Expression, FrameNumber)Syntax:

Arguments: ■ Expression is the expression to be evaluated. This can be any valid channel value.

■ FrameNumber is the frame to simulate when evaluating the given expression.

Examples: ■ eval(axis1.position.x, 5) returns the value of axis1.position.xat frame 5.

■ eval(axis1.position, frame - 10) returns the axis1.positionvector at 10 frames behind
the current frame.

■ eval(axis1, frame / 2) returns the entire axis1 channel at half the normal speed.

if

Returns one of two values based on the result of a conditional test. You can nest multiple functions inside
each other to handle multiple results.

if(Condition, TrueValue, FalseValue)Syntax:

Arguments: ■ Condition is any channel or expression. When comparison operators are used, a true
expression evaluates to 1 and a false expression evaluates to 0. See Comparison Oper-
ators (page 1132).

1134 | Chapter 23   Animating Keyframes



■ TrueValue is the value to be returned for any non-zero result.

■ FalseValue is the value to be returned if Condition evaluates to 0.

Examples: ■ if(axis.position.y >= 100, 5, -5) returns 5 when axis.position.yis greater than or equal
to 100, and -5 otherwise.

■ if(frame < 10 || frame >20, 100, 200) returns 100 when the current frame is less than
10 or above 20, and 200 otherwise.

■ if(axis.position.x, 6, 7) returns 6 when axis.position.x is something other than 0, and 7
when it is 0.

■ if(axis.position.x == 100 && axis.position.y != 200,8, 9) returns 8 when axis.position.x
is 100 and axis.position.y is not 200, and 9 otherwise.

■ The next four examples all equivalently return 5 when neither axis.position.x nor axis.po-
sition.y are greater than or equal to 0, and -5 otherwise.

if(!(axis.position.x =>0 || axis.position.y =>0), 5, -5)
if(!(axis.position.x =>0) && !(axis.position.y =>0), 5, -5)
if(axis.position.x < 0 && axis.position.y < 0, 5, -5)
if(axis.position.x < 0, if(axis.position.y < 0, 5, -5), -5)

ease

Returns a number from 0 to 1 representing a smooth S-curve transition between a given range of frames.
All frames before the start frame are assigned 0 and all frames after the end frame are assigned 1. A start
weight and end weight specify how the S-curve is formed.

ease(StartFrame, EndFrame, [StartWeight], [EndWeight])Syntax:

Arguments: ■ StartFrame and EndFrame are the frames at which the transition starts and ends respect-
ively.

■ StartWeight and EndWeight are numbers that specify how curvature is distributed at
the start and end of the curve respectively. To get an S-curve, their sum should be less
than 1, otherwise a square curve will result. In addition, if either of these two arguments
are specified, the other must also be specified.

Examples: ■ ease(10, 50) * 100 returns a standard S-curve from 0 to 100between frames 10 and 50.

■ 80 - ease(1, 40) * 20 returns a standard S-curve from 80 to60 between frames 1 and
40.

■ ease(1, 30, 0.2, 0.2) * 50 + 10 returns a tight S-curve from10 to 60 between frames 1
and 30.

■ ease(10, 80) * 150 yields the following curve:
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■ ease(10, 80, 0.2, 0.2) * 150 yields the following curve:

bell

Returns a set of values representing a bell (normal distribution) curve over time. You can specify the centre
frame number and height and width characteristics of the curve.

bell(CentreFrame, Height, Width)Syntax:

Arguments: ■ CentreFrame is the frame number at which the bell curve will reach its maximum height.

■ Height is the maximum height of the bell curve.

■ Width specifies the horizontal distribution of the curve.

Examples: ■ bell(10, 100, 3) returns a bell curve centred around frame10 with a maximum height
of 100 and a width distribution of 3.

■ bell(50, 150, 10) yields the following curve:

■ bell(50, 150, 20) yields the following curve:
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Slip Functions

Use the following functions to slip the starting frame of a clip backwards or forwards using the slip channel.
In effect, the displayed frame in a layer's clip will be the animation's current frame number plus the slip
value. For example, a slip value of -15 holds the clip at the first frame and repeats it 15 times before the clip
begins. In this way, you can create a freeze frame effect with one layer while animating another layer. A slip
value of 10 begins the clip at frame 11. See Modifying Surfaces (page 386).

NOTE Slip functions are actually implemented as user-defined functions in the functions file. See Defining Your
Own Functions (page 1154).

pingpong

Returns a slip value that makes a clip continuously cycle forwards and backwards. The result should usually
be assigned to the slip channel of a layer.

pingpong(length)Syntax:

Arguments: ■ length is the number of frames to display before starting to play backwards. This is
usually the length of the original clip.

Examples: ■ pingpong(10) returns a slip value that makes a clip continuously play in a forward and
backward cycle from frame 1 to frame 10.

■ pingpong(30) yields the following curve:
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repeat

Returns a slip value that makes a clip continuously repeat forwards. The result should usually be assigned
to the slip channel of a layer.

repeat(length)Syntax:

Arguments: ■ length is the number of frames to display before repeating from the beginning. This is
usually the length of the original clip.

Examples: ■ repeat(10) returns a slip value that makes a clip repeat forwards from frame 1 to frame
10.

■ repeat(30) yields the following curve:

repeatback

Returns a slip value that makes a clip continuously repeat backwards. The result should usually be assigned
to the slip channel of a layer.

repeatback(length)Syntax:

Arguments: ■ length is the number of frames from the beginning to display backwards before repeat-
ing. This is usually the length of the original clip.

Examples: ■ repeatback(10) returns a slip value that makes a clip repeat backwards from frame 10
to frame 1.

■ repeatback(30) yields the following curve:
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frametoslip

Returns a slip value that makes a clip display at a given timebar frame. If the given frame number is constant,
the resulting clips will freeze at that frame. The result should usually be assigned to the slip channel of a
layer.

frametoslip(TimebarFrame)Syntax:

Arguments: ■ TimebarFrame is the timebar frame at which to display the clip.

Examples: ■ frametoslip(10) returns a slip value that makes a clip freeze at frame 10.

■ frametoslip(frame / 2) returns a slip value that makes a clisplay at half the normal speed.

■ frametoslip(14) yields the following curve:

Simple Mathematical Functions

The following functions are useful for performing various simple mathematical calculations.

abs

Returns the absolute value of a given number. The absolute value is the positive value of any number.

abs(Number)Syntax:

Arguments: ■ Number is the number of which you want the absolute value.

Examples: ■ abs(3) returns 3.

■ abs(-3) returns 3.

sign

Returns the sign of a given number. The sign function returns 1 if the number is above or equal to zero, and
returns -1 if less than zero.

sign(Number)Syntax:
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Arguments: ■ Number is the number of which you want the sign.

Examples: ■ sign(5) returns 1.

■ sign(0) returns 1.

■ sign(-0.001) returns -1.

pow

Returns a number raised to the power of an exponent.

pow(Number,Power)Syntax:

Arguments: ■ Number is the base number to be raised.

■ Power is the exponent to which the base number is raised.

Examples: ■ pow(3, 2) returns 9.

■ pow(4, 3) returns 64.

■ pow(5, 0) returns 1.

■ pow(-2.5, 4) returns 39.0625.

sqrt

Returns the square root of a given number.

sqrt(Number)Syntax:

Arguments: ■ Number is the non-negative number of which you want the square root.

Examples: ■ sqrt(25) returns 5.

■ sqrt(abs(-25)) returns 5.

■ sqrt(0) returns 0.

max

Returns the larger of two given numbers.

max(Number1, Number2)Syntax:

Arguments: ■ Number1 and Number2 are numbers of which you want to find the maximum value.

Examples: ■ max(5.9, 8.1) returns 8.1.

■ max(-14, -32) returns -14.
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■ max(axis1.position.x, axis2.position.x) returns the larger of axis1.position.x or axis2.po-
sition.x.

min

Returns the smaller of two given numbers.

min(Number1, Number2)Syntax:

Arguments: ■ Number1 and Number2 are numbers of which you want to find the minimum value.

Examples: ■ min(5.9, 8.1) returns 5.9.

■ min(-14, -32) returns -32.

■ min(axis1.position.x, axis2.position.x) returns the smaller of axis1.position.x or axis2.po-
sition.x.

mod

Returns the integer remainder from dividing one number by another. This function is useful for repeating
an animation every given number of frames.

mod(Number, Divisor)Syntax:

Arguments: ■ Number is the number to divide.

■ Divisor is the number by which you want to divide Number.

Examples: ■ mod(8, 3) returns 2 because 8 divided by 3 is 2 with 2 as the remainder.

■ mod(-8, 3) returns -2.

■ mod(8, -3) returns 2.

■ mod(-8, -3) returns -2.

■ mod(7.5, 2.25) returns 0.75.

■ mod(frame, 20) * 5 yields the following curve:
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Random Number Functions

Use the following functions to create curves based on random values.

rand

Returns a random value between -1 and 1, based on the value used as an argument, called the seed. Using
the same seed in the rand function for multiple channels produces the exact same results. To create completely
random results, use the true rand function.

rand(Seed)Syntax:

Arguments: ■ Seed is the value used to generate the random return value. This is usually set to a
changing value such as the current frame number.

Examples: ■ rand(frame % 10) * 50 + 50 returns a set of random values between0 and 100 that re-
peats every 10 frames.

■ rand(frame) * 100 returns a random value between -100 and 100for every frame in the
animation. The following curve shows the result of this function:

truerand

Returns a truly random value between two given numbers. The sequence of returned values will constantly
change, never reproducing past results.

truerand(Low, High)Syntax:

Arguments: ■ Low and High are the upper and lower bounds, respectively, of the random number to
generate.

Example: ■ truerand(-5.5,10.8) returns a truly random value between -5.5and 10.8.

noise

Returns a random value between -1 and 1, based on a given vector. If the parameter varies smoothly, this
function will return a continuously changing value that also varies smoothly.

noise(Position)Syntax:
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Arguments: ■ Position is a vector used as a seed for the returned random value.

Examples: ■ noise(frame) * 5 returns a continuous random value between-5 and 5.

■ (noise(axis1.position) + 1) / 2 * 100 returns a continuous random value between 0 and
100.

■ noise(axis1.position) * 100 yields the following curve:

noise3

Returns a random vector for all elements in a vector between -1 and 1. If the parameter varies smoothly,
this function will return a vector of continuously changing values that also vary smoothly.

noise3(Position)Syntax:

Arguments: ■ Position is a vector used as a seed for the returned random vector.

Examples: ■ noise3(frame) * 5 returns a vector of continuous random values between -5 and 5.

■ (noise3(axis1.position) + 1) / 2 * 100 returns a vector of continuous random values
between 0 and 100.

■ noise3(axis1.position) * 100 returns the following three curves:
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fnoise

Returns a random value between -1 and 1, based on a given vector. If the parameter varies smoothly, this
function will return a continuously changing value that also varies smoothly to a fractal pattern. This
function is similar to the noise function, but it applies a fractal pattern to the result.

fnoise(Position)Syntax:

Arguments: ■ Position is a vector used as a seed for the returned random value.

Examples: ■ fnoise(frame) * 5 returns a continuous random value between-5 and 5.

■ (fnoise(axis1.position) + 1) / 2 * 100 returns a continuous random value between 0 and
100.

■ fnoise(axis1.position) * 100 yields the following curve:

turbulence

Returns a random value between -1 and 1, based on a given vector and with the ability to control the level
of smoothness for the resulting curve.

turbulence(Position, Level)Syntax:

Arguments: ■ Position is a vector used as a seed for the returned random value.

■ Level is a positive integer where the greater the value, the greater the jitter applied to
the resulting curve. If this argument is set to a value less than 1, the level will be treated
as if 1 were used. If it is set to a number with a fractional component, the number will
be rounded down to the nearest integer.

Examples: ■ turbulence(axis1.position, 1) * 100 yields the following curve:
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■ turbulence(axis1.position, 8) * 100 yields the following curve:

turbulence3

Returns a random vector for all elements in a vector between -1 and 1, along with the ability to control the
smoothness of the resulting curve. If the position parameter varies smoothly, this function will return a
vector of continuously changing values that also vary smoothly.

turbulence3(Position, Level)Syntax:

Arguments: ■ Position is a vector used as a seed for the returned random vector.

■ Level is a positive integer used to control the level of jitter of the resulting curve. If this
argument is set to a value less than 1, the level will be treated as if 1 were used. If it is
set to a number with a fractional component, the number will be rounded down to the
nearest integer.

Examples: ■ turbulence3(axis1.position, 1) * 100 returns the following three curves:

■ turbulence3(axis1.position, 8) * 100 returns the following three curves:
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Rounding Functions

The following functions are useful for performing various rounding calculations.

NOTE Although you can use these rounding functions as you would any other predefined function, they are
actually implemented as user-defined functions in the functions file provided with the Smoke installation. See
Defining Your Own Functions (page 1154).

round

Returns a number rounded to the nearest integer.

round(Number)Syntax:

Arguments: ■ Number is the number to round.

Examples: ■ round(2.8) returns 3.

■ round(-2.8) returns -3.

■ round(2.3) returns 2.

ceil

Rounds a number up to the next integer value regardless of its value.

ceil(Number)Syntax:

Arguments: ■ Number is the number to round up.

Examples: ■ ceil(2.8) returns 3.

■ ceil(-2.8) returns -2.

■ ceil(4) returns 4.
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floor

Rounds a number down to the nearest integer regardless of its value.

floor(Number)Syntax:

Arguments: ■ Number is the number to round down.

Examples: ■ floor(2.3) returns 2.

■ floor(-2.3) returns -3.

■ floor(4) returns 4.

trunc

Returns the integer value of a number by truncating its fractional part.

trunc(Number)Syntax:

Arguments: ■ Number is the number that you want to truncate.

Examples: ■ trunc(3.8) returns 3.

■ trunc(-3.8) returns -3.

■ trunc(PI) returns 3.

Trigonometric Functions

The following functions are useful for working with angles and performing various trigonometric calculations.

degrees

Converts angle units from radians into degrees.

degrees(Angle)Syntax:

Arguments: ■ Angle is the angle in radians that you want to convert.

Examples: ■ degrees(PI) returns 180.

■ degrees(PI/2) returns 90.
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radians

Converts angle units from degrees into radians.

radians(Angle)Syntax:

Arguments: ■ Angle is the angle in degrees that you want to convert.

Example: ■ radians(225) returns 3.927 (5*PI/4).

cos

Returns the cosine of a given angle.

cos(Angle)Syntax:

Arguments: ■ Angle is the angle in radians of which you want the cosine.

Examples: ■ cos(0) returns 1.

■ cos(PI / 3) returns 0.5.

■ cos(frame / 10) * 100 yields the following curve:

sin

Returns the sine of a given angle.

sin(Angle)Syntax:

Arguments: ■ Angle is the angle in radians of which you want the sine.

Examples: ■ sin(0) returns 0.

■ sin(PI / 6) returns 0.5.

■ sin(frame / 10) * 100 yields the following curve:
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tan

Returns the tangent of a given angle.

tan(Angle)Syntax:

Arguments: ■ Angle is the angle in radians of which you want the tangent.

Examples: ■ tan(0) returns 0.

■ tan(PI / 4) returns 1.

■ tan(PI / 3) returns 1.7321.

■ tan(frame / 10) * 50 yields the following curve:

acos

Returns the arccosine—the inverse function of the cosine—of a given number. The returned angle is given
in radians within the range 0 to PI.

acos(Number)Syntax:

Arguments: ■ Number is the cosine of the angle you want and must be between-1 and 1.

Examples: ■ acos(0.5) returns 1.0472 (PI/3 radians).

■ degrees(acos(0.5)) returns 60.
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asin

Returns the arcsine—the inverse function of the sine—of a given number. The returned angle is given in
radians within the range -PI/2 to PI/2.

asin(Number)Syntax:

Arguments: ■ Number is the sine of the angle you want and must be between-1 and 1.

Examples: ■ asin(0.5) returns 0.5236 (PI/6 radians).

■ degrees(asin(0.5)) returns 30.

atan

Returns the arctangent—the inverse function of the tangent— of a given number. The returned angle is
given in radians within the range -PI/2 to PI/2.

atan(Number)Syntax:

Arguments: ■ Number is the tangent of the angle you want.

Examples: ■ atan(1) returns 0.7854 (PI/4 radians).

■ degrees(atan(1)) returns 45.

atan2

Returns the arctangent of y/x, using the signs of both arguments to determine the quadrant of the return
value. The arctangent is the angle from the origin to the vector (x,y). The returned angle is given in radians
within the range -PI to PI.

atan2(x, y)Syntax:

Arguments: ■ x and y are the components of the vector to be used in the function.

Examples: ■ atan2(1, 1) returns 0.7854 (PI/4 radians).

■ atan2(-1, -1) returns -2.3562 (-3*PI/4 radians).

■ atan2(1, 0) returns 1.5708 (PI/2 radians).

■ degrees(atan2(1,1)) returns 45.

Vector Functions

Use the following functions for performing various vector-related operations.
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length

Returns the euclidean length (magnitude) of a given vector. The euclidian length is equivalent to the
expression sqrt(pow(Vector.x, 2) + pow(Vector.y, 2) + pow(Vector.z, 2)).

length(Vector)Syntax:

Arguments: ■ Vector is the vector of which you want the euclidean length.

Examples: ■ length((2, 0, 0)) returns 2.

■ length((1, 1, 0)) returns 1.4142.

■ length((-1, -1, -1)) returns 1.7321.

■ length(axis1.position - axis2.position) returns the distance between axis1 and axis2.

dot

Returns the scalar dot-product of two given vectors. The dot-product is the product of the lengths of two
vectors and the cosine of the angle between them. If the two vectors are at a right angle (90 degrees), their
dot-product is 0.

If the product of their lengths equals 1 and they point in opposite directions (180 degrees), their dot-product
is -1. The dot-product is equivalent to the expression V1.x * V2.x + V1.y * V2.y + V1.z * V2.z.

dot(V1, V2)Syntax:

Arguments: ■ V1 and V2 are the vectors of which you want the dot-product.

Examples: ■ dot((1, 1, 0), (0, 0, 1)) returns 0.

■ dot((2, 0, 0), (0.5, 0, 0)) returns 1.

■ dot((0, 2, 0), (0, -0.5, 0)) returns -1.

■ dot((2, 0, 1), (4, 5, 5)) returns 13.

cross

Returns the vector cross-product of two given vectors. The cross-product is the vector perpendicular to the
plane containing the two vectors. In effect, there will be a right angle between the returned vector and the
first given vector, as well as a right angle between the returned vector and the second given vector. The
length of the resulting vector is equal to the product of the two vectors and the sine of the angle between
them. The cross-product is equivalent to the vector (V1.y * V2.z - V1.z *V2.y, V1.z * V2.x - V1.x * V2.z, V1.x
* V2.y - V1.y * V2.x).

cross(V1, V2)Syntax:

Arguments: ■ V1 and V2 are the vectors of which you want the cross-product.

Examples: ■ cross((1, 0, 0), (0, 1, 0)) returns (0, 0, 1).
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■ cross((1, 1, 0), (0, 1, 1)) returns (1, -1, 1).

■ cross((2, 0, 0), (0, 0.5, 0)) returns (0, 0, 1).

Logarithmic Functions

Use the following functions for performing various logarithmic calculations.

log

Returns the natural logarithm of a given number. The log function is the inverse of the exp function.

log(Number)Syntax:

Arguments: ■ Number is the positive number of which you want the natural logarithm.

Examples: ■ log(1) returns 0.

■ log(2) returns 0.6931.

■ log(exp(5)) returns 5.

■ log(256) / log(2) returns 8.

■ log(frame / 20) * 50 yields the following curve:

log10

Returns the base-10 logarithm of a given number.

log10(Number)Syntax:

Arguments: ■ Number is the positive number of which you want the base-10logarithm.

Examples: ■ log10(1) returns 0.

■ log10(10) returns 1.

■ log10(100) returns 2.

1152 | Chapter 23   Animating Keyframes



log1p

Returns the natural logarithm of 1 plus a given number. The log1p function is the inverse of the expm1
function.

log1p(Number)Syntax:

Arguments: ■ Number is the positive number less 1 of which you want the natural logarithm.

Examples: ■ log(0) returns 0.

■ log(1) returns 0.6931.

■ log1p(expm1(5)) returns 5.

■ log1p(frame) returns the equivalent of log(1+frame).

■ log1p(frame / 20) * 50 yields the following curve:

exp

Returns the constant e (the base of the natural logarithm) raised to the power of a given number. The exp
function is the inverse of the log function.

exp(Number)Syntax:

Arguments: ■ Number is the exponent applied to the base e.

Examples: ■ exp(0) returns 1.

■ exp(1) returns 2.7182.

■ exp(2) returns 7.3890.

■ exp(log(5)) returns 5.

■ exp(frame / 20) * 5 yields the following curve:
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expm1

Returns the constant e (the base of the natural logarithm) raised to the power of a given number, minus 1.
The expm1 function is the inverse of the log1p function.

expm1(Number)Syntax:

Arguments: ■ Number is the exponent applied to the base e.

Examples: ■ expm1(0) returns 0.

■ expm1(1) returns 1.7182.

■ expm1(2) returns 6.3890.

■ expm1(log1p(5)) returns 5.

■ expm1(frame) returns the equivalent of exp(frame) - 1.

Defining Your Own Functions

Smoke allows you to define your own functions and use them like any other predefined function. By defining
functions in terms of existing functions, you can simplify the creation of complex expressions in your
animations.

NOTE You should have a good understanding of how to use functions in expressions before you define your own
functions.

The Functions File

There are two text files in which you can enter user-defined functions:
■ Project-specific file: /usr/discreet/project/<user_name>/expressions/userfun.expressions

■ Template file: /usr/discreet/<product_name>/expressions/userfun.expressions

To define a function for your current project, add it to the project-specific file. Modifying this file will affect
only that project and not any other existing or future projects.

If you decide that you want to use the function in future projects, copy it from the project-specific file to
the template file. When you create a project, the template file is copied to your project directory as the
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project-specific file for that new project. This functionality allows you to modify user-defined functions in
new projects without affecting the behaviour of your animations in older projects.

To edit the functions file:

1 Open a command window.

2 Use the mouse to position the cursor in the shell and type one of the following commands, depending
on which file you want to edit.

To:Enter:

Edit the project-specific file.nedit /usr/discreet/project/<user_name>/expressions/user-
fun.expressions

Edit the template file.nedit /usr/discreet/<product_name>/expressions/userfun.ex-
pressions

The functions file opens in a shell and you can edit it as you would any other text file.

Defining a Function

A function is composed of a function name, with the list of arguments, and the expression that forms its
definition. You start a function by its name, followed by an opening parenthesis, the arguments for the
function separated by commas, and finally a closing parenthesis. The following rules apply for function and
argument names:
■ The first character of a function name must be a letter, and subsequent characters can only contain letters

or numbers. For example, sin100 is a valid function name, although 100sin is not.

■ The first character of an argument must be a dollar sign ( $ ), the second character must be a letter, and
subsequent characters can only contain letters or numbers. For example, $arg1 is a valid argument name,
although $1 and arg3 are not.

■ Function names and arguments are case sensitive, meaning that lowercase and uppercase make a difference.

The function name and its definition are separated by a colon ( : ). The definition itself can be any valid
expression, except that channel names are not accepted since user-defined expressions are not related to
any particular setup. In the definition, the arguments can appear, complete with the dollar sign preceding
it. Finally, the definition must end with a semicolon (;) and it can span several lines.

NOTE Errors in the functions file will be reported when it is first read. This file is read every time that an unknown
function is used in an expression.

Comments

You can include comments in the functions file by starting the line with a number sign ( # ). The comments
extend through the end of the line on which they appear and are ignored by Smoke when the user-defined
functions file is interpreted. Comments are useful for describing the purpose of a function and adding any
notes you feel are pertinent. They can be introduced anywhere in the file, except for inside of function
definitions that span several lines.
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Sample Function Definitions

The following sample functions are found in the functions file that is installed with Smoke.
■ This function creates a sine curve for a given channel that oscillates between 0 and 100. The sin100

function takes one argument, named $arg1, that it uses in conjunction with the predefined sin function.
The return value for sin100 is the sine of $arg1 times 50, plus 50.

sin100($arg1) : sin($arg1)*50 + 50;

■ This function creates a sine curve based on the specified frequency and amplitude. The sinfreqamp
function takes three arguments, named $pos, $freq and $amp.

sinfreqamp($pos,$freq,$amp) : sin($pos*$freq)*$amp;

■ This function provides an approximation of the speed, or more precisely, the derivative (rate of change),
of a given channel. The speed function takes one argument, named $channelName.

speed($channelName) :eval($channelName,frame+0.1) -

eval($channelName,frame-0.1))/0.2;

NOTE For information on the other example functions in the functions file, see Slip Functions (page 1137) and
Rounding Functions (page 1146).

Sample Expression Setups

A few Action setups with sample expressions are provided in the directory
/usr/discreet/<product_name>/examples/action.

To load an Action setup from ConnectFX, select the Action node in the schematic, then click Node Prefs
and Load Node.

Animated Text

To see this example, load the example setup named expressions_text into Action. This example involves
multiple text objects that move along a path, with each letter following slightly behind the last.

1156 | Chapter 23   Animating Keyframes



Each letter's position and rotation are created through the expressions in the following folder. The letter 'o'
rotates its X-axis towards the direction of its movement. The align function is used to generate the rotation
vector.

Each preceding letter sets its position and rotation an increasing number of frames behind the letter 'o'. The
channel dummy_axis.position.x is used here to store a value determining the distance between each letter.
The eval function is used to determine the values of the o_axis.position and o_axis.rotation channels at
different points in time.

NOTE A series of expressions that differ only by a numeric value, such as in this example, can be entered quickly
using the SelectionOrder keyword. See Cascading Expressions (page 1127).

ExpressionChannel

align(o_axis.position)o_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 1)n2_axis.position

eval(o_axis.position, frame - dummy_axis.position.x * 2)r_axis.position

eval(o_axis.position, frame - dummy_axis.position.x * 3)e_axis.position

eval(o_axis.position, frame - dummy_axis.position.x * 4)f_axis.position

eval(o_axis.position, frame - dummy_axis.position.x * 5)n_axis.position

eval(o_axis.position, frame - dummy_axis.position.x * 6)i_axis.position
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ExpressionChannel

eval(o_axis.position, frame - dummy_axis.position.x * 1)n2_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 2)r_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 3)e_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 4)f_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 5)n_axis.rotation

eval(o_axis.position, frame - dummy_axis.position.x * 6)i_axis.rotation

Spinning Dagger

To see this example, load the setup named expressions_spinning_dagger into Action. This example features a
dagger moving in an arc. The dagger's Y-axis is aligned with the direction of its movement and the rest of
the dagger spins around its axis.
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The dagger's rotation is created through the dagger's rotation of its negative Y-axis towards the direction of
its movement and the rest of the dagger spins one full rotation around this same axis every 32 frames. The
align function is used to generate the rotation vector.

ExpressionChannel

align(dagger_axis.position, (0,-1,0), frame * 2 * PI / 32)dagger_axis.rotation

Dagger, Apple, and Cherry

To see this example, load the setup named expressions_dagger_apple_cherries into Action. This animation
points a dagger at either a moving apple or moving cherries, whichever is closer in position at the time.

The dagger's rotation is created by the dagger's position as the dagger points its negative Y-axis in the direction
of either the apple or the cherries, whichever happens to be closest. The length function is used to find the
distance between the dagger and the other objects, while the if function is used to determine which is the
shorter distance. The lookat function is used to generate the rotation vector.

ExpressionChannel

if(length(cherries_axis.position - dagger_axis.position) <length(apple_axis.position
- dagger_axis.position), lookat(cherries_axis.position, dagger_axis.position, (0,-1,0),
(1,0,1)), lookat(apple_axis.position, dagger_axis.position, (0,-1,0), (1,0,1)))

dagger_axis.rotation
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Dampened Pendulum

To see this example, load the setup named expressions_dampened_pendulum into Action. This examples
involves a pendulum (a ball attached to a rope) that swings freely back and forth under the force of gravity
until it comes to a stop.

The ball oscillates in a dampened harmonic motion that is created by animating the position of the ball and
the rotation of the rope. The ball's x position is defined as the sine of the swing angle between the rope and
centre axis, multiplied by the length of the rope. This angle is initially PI/2 and decreases logarithmically.
In addition, the ball oscillates with a period of 30 frames. The sin function is used to calculate the sine of
the swing angle and the exp function is used to create the logarithmic dampening effect. The cos function
is used to create the oscillation.

The ball's y position is defined as the negative cosine of the swing angle between the rope and centre axis,
multiplied by the length of the rope. This expression is formed similarly to that of the ball_axis.position.x
channel. The rope rotates such that its Y-axis is always pointing toward the centre of the ball. The lookat
function is used to generate the rotation vector.

ExpressionChannel

sin(PI / 2 / exp(frame / 100) * cos(frame * 2 * PI / 30)) *200ball_axis.position.x

-cos(PI / 2 / exp(frame / 100) * cos(frame * 2 * PI / 30))* 200ball_axis.position.y

lookat(ball_axis.position, rope_axis.position, (0,1,0), (0,0,1))rope_axis.rotation
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Colour Management

Colour management enables the desired colour values to be represented as accurately as possible throughout the finishing
process. It is different from colour correction in that its intention is not to change colours but instead to preserve the
perceived colour in different situations.

NOTE Colour management is performed with the LUT Editor and other controls that are labelled "LUT", but other operations
including colour transforms and gamma functions are supported in addition to look-up tables.

Colour Management Workflow
Colour management works by applying colour transforms and other operations at various stages of the
pipeline. Typically, you use colour management when:
■ Importing media. Images from different sources (such as digital cameras, scanned film, 3D renders, and

matte paintings) often use different colour spaces and encodings, and they should be converted to a
single working colour space.

■ Outputting media. Different output formats require different encodings depending on the medium and
expected viewing conditions.

You might also want to apply colour transforms to convert into and out of a specific colour space in order
to perform a particular operation. For example, operations like compositing or lens blur work best in a linear
colour space, while operations like tracking and edge detection work best in video or log colour space.

In addition, colour management is used to display images in Smoke to ensure that the colours on the monitor
and projector match what will be displayed on the final output as closely as possible. For example, if you
are working in the ACES colour space, you can apply the ACES_to_current-monitor transform.

Applying Colour Management to Clips
Use the LUT Editor to apply colour management to clips. This changes the underlying colour values of the
clips' pixels. You should do this when you want the changes to flow though the pipeline to the final output.
If you want to apply colour management to the display only, see Applying Colour Management to Displayed
Images (page 1178) instead.
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Accessing the LUT Editor

You can access the LUT Editor from ConnectFX, , from the Import menu and from the Export menu.

To access the LUT Editor from the Import menu, see Importing File-Based Media (page 39).

To access the LUT Editor from the Export menu, see Exporting Media to Files (page 40).

Accessing the LUT Editor in ConnectFX

You can use the LUT Editor from the LUT Editor, Read File, and the CFX Output node in ConnectFX to
import or create a LUT or colour transform.

To access the LUT Editor using the LUT Editor node:

1 Drag the LUT Editor node to the schematic.

2 Parent the output of another node to the front input socket of the LUT Editor node.

3 Select the LUT Editor node to view its menu.

To access the LUT Editor as an integrated part of clip input and output processes

1 Select the CFX Output node in ConnectFX or drag the Read Filenode to the schematic.

2 Set up the node so the LUT you create is applied to the clip that you want to convert:
■ If you selected the CFX output node in ConnectFX, double click the node to display the LUT Editor

menu.

■ If you dragged the Read File to the schematic, use the file browser to locate the clip that you want
to import.

3 Select the clip.

4 Select the RGB LUT or Matte LUT menu.

5 Enable Active to apply the current LUT settings to the front clip.
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NOTE Active is always enabled if the bit-depth needs to be changed.

The LUT Editor menu is displayed.

Specifying a Colour Management Operator

To apply colour management to a clip, you must first specify the type of operation to perform in the LUT
Editor (page 1161). You can:
■ Apply a preset LUT and then modify its values.

■ Choose an operator type. Depending on the type you choose, you can either import a baked operator
or modify its values.

Applying a Preset

1 Select an option from the Presets box in the LUT Editor.

2 Confirm that you want to replace the existing settings.

The Conversion LUT Type and the field values are all updated with preset conversion parameters. In
ConnectFX, a note is added with a description of the preset's usage.

3 If desired, modify the curve values as described in Modifying Basic Conversion LUT Curves (page 1166)
and Advanced Editing of the Conversion LUT Curve (page 1173).

TIP To make your own preset available, save a setup to the /lut/presets subfolder of the application home directory.
This does not work with 3D LUTs.

Choosing an Operator Type

1 Select an output bit-depth option from the Destination box in the LUT Editor.
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2 Select an option from the LUT Type box.

To:Select:

Apply a colour transform based on the Academy/ASC colour transform XML format, as
well as several other supported LUT and transform formats.

Colour Transform

Begin with a default curve for tone mapping.PhotoMap

Import a 3D LUT. Note that 3D LUTs are not available for floating-point values.3D LUT

Import a 1D LUT. Note that some 1D LUTs are intended for integer values and others
are intended for floating-point values.

1D LUT

Begin with a default curve for tone mapping.EXR Display

Begin with a default curve for modifying linear data.Gamma
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To:Select:

Begin with a default curve for converting linear or video data to logarithmic data.Lin to Log

Begin with a default curve for converting logarithmic data to linear or video data.Log to Lin

3 Do one of the following:
■ If you chose 1D LUT or 3D LUT, import a LUT operator.

■ If you chose Colour Transform, you can import an colour transform operator. Alternatively, you
can define a custom colour transform — see Building Custom Colour Transforms (page 1165).

■ If you chose any other option, you can modify the curve values as described in Modifying Basic
Conversion LUT Curves (page 1166) and Advanced Editing of the Conversion LUT Curve (page 1173).

Importing an Operator

1 Click Import.

The file browser appears.

2 Locate and select the file that you want to import. See Colour Management Files and Locations (page
1184).

When importing a colour transform, see Autodesk Colour Transform Types (page 1183) for a description
of the available categories.

You are returned to the LUT Editor. The LUT name appears in the field next to the Import button.

■ When you import a 1D LUT, the conversion curves appear in the LUT Editor. You can modify them
only with the Advanced settings.

■ When you import a colour transform, information about the transform and the operations it
contains appears in the LUT Editor.

Building Custom Colour Transforms

You can build a chain of colour transforms using the Custom mode of the LUT Editor (page 1161). The
transforms are applied in order from beginning to end. For example, you can build a colour transform that
first modifies the gamma and then changes the primaries.
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1 In the LUT Editor, set the LUT type box to Colour Transform.

2 Enable the Custom button.

3 Click Add to insert an empty row.

4 Click in the Type column and select a type:
■ Shared: The location for shared custom colour transforms (available to all applications that use

Autodesk Colour Management).

■ Project: The project transform folder (saved and archived with the project).

■ Autodesk: The default location for preset colour transforms supplied with the application. See
Autodesk Colour Transform Types (page 1183).

■ Import: Browse for colour transforms on your file system. You can select native .ctf format files,
as well as several other supported LUT and transform formats.

5 After you've selected a colour transform type, click in the Transform column and select a transform.

Information about the transform and the operations it contains appears in the LUT Editor.

6 To add more transforms to the end of the chain, repeat steps 3 to 5.

You can also:
■ Click in the Type or Transform columns again to change a transform in the chain.

■ Select a row and click Delete to remove a transform from the chain.

■ Use the Up or Down buttons to reorder the chain. Moving a transform up applies it earlier in the
chain, and moving it down applies it later.

■ Use the visibility icon to mute a transform in the chain.

TIP You can create subfolders in the Shared or Project locations to define custom colour transform types.

Modifying Basic Conversion LUT Curves

NOTE The procedures in this section apply only to Gamma, Lin to Log, and Log to Lin operators.
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Once you define a basic LUT type in the LUT Editor (page 1161), you can modify:
■ The reference white and reference black values

■ The highlights and shadows

■ The gamma of the conversion curve

■ The gamma of the incoming film negative

■ The degree to which the shoulder at the upper end of the conversion curve is softened

When you modify these values, the basic LUT curves are updated to reflect the changes. For all procedures,
you can monitor the R, G, and B channels independently while modifying the LUT.

To monitor the R, G, and B channels independently:

1 From the Edit Curve box, select Red, Green, or Blue to monitor the red, green, or blue channels
independently.

Modifying Reference White and Reference Black Values

The reference white and reference black values define the intensity levels at which incoming pixels are
considered white or black respectively. For example, selecting a logarithmic-to-linear basic conversion LUT
curve sets the reference white to 685 and the reference black to 95. (These have been shown to be good
values for Kodak™ film stock.) As a result, source pixels with values from 685 and 1023 will produce white
pixels, while those from 0 and 95 will be set to black.

Reference white and black are affected by the values assigned to highlights and shadows. White pixels are
mapped to the value set for highlights, while black pixels are mapped to the value set for shadows. See
Modifying Highlights and Shadows (page 1168).

To modify reference white or black values using the Ref White and Ref Black fields:

1 Do one of the following:
■ To set proportional R, G, and B values, enable Prop and then enter the value in one of the

(left-to-right) R, G, and B Ref White and Ref Black fields.

■ To set independent R, G, or B values, disable Prop and then enter the value in the corresponding
(left-to-right) R, G, or B Ref White and Ref Black fields.
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(a) Ref White/Black fields and Prop (Proportional) buttons

To modify reference white or black values using the LUT Editor graph:

1 Do one of the following:
■ To set proportional R, G, and B values, select All from the Edit Curve box, and then drag the vertical

reference white or reference black line left or right.

■ To set independent R, G, or B values, select Red, Green, or Blue from the Edit Curve box, and then
drag the vertical reference white or reference black line left or right.

(a) Highlight line (b) Reference White line (c) Edit Curve box

TIP If you already entered independent values and want to modify the R, G, and B values proportionally,
you must drag the reference white or reference black line that corresponds to the corresponding channel.
To view the selected R, G, or B luma values as a greyscale luma image in the Import Image menu, enable
the Exclusive button.

Modifying Highlights and Shadows

Highlight and shadow values define the maximum and minimum values permitted for each channel. All
values above the highlight are clamped down to it. Similarly, all values below the shadow are clamped up.
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To modify highlight and shadow values using the Highlights and Shadows fields:

1 Do one of the following:
■ To set proportional R, G, and B values, enable Prop and enter a value in one of the (left-to-right)

R, G, and B Highlights and Shadows fields.

■ To set independent R, G, or B values, disable Prop and enter the value in the corresponding
(left-to-right) R, G, or B Highlights and Shadows fields.

(a) Highlight/Shadow fields

To modify highlight or shadow values using the LUT Editor graph:

1 Do one of the following:
■ To set proportional R, G, and B values, select All from the Edit Curve box, and then drag the

horizontal highlight or shadow line up or down.

■ To set independent R, G, or B values, select Red, Green, or Blue from the Edit Curve box, and then
drag the horizontal highlight or shadow line up or down.

Modifying the Gamma of the Conversion Curve

Set the gamma correction value to correspond to the display gamma you set your system to use. You can
select a preset from the Gamma Correction box or enter a custom value.

To modify the gamma correction curve using the Gamma Correction fields:

1 Select an option from the Gamma Correction box.
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(a) Gamma Correction fields (b) Gamma Correction box

To:Select:

Set video gamma correction presets.Video Display

Enter custom gamma values.Custom

2 If you selected Custom, do one of the following:
■ To set proportional custom R, G, and B gamma correction values, enable Prop, and then enter the

value in one of the (left-to-right) R, G, and B Gamma Correction fields.

■ To set independent custom R, G, or B gamma correction values, disable Prop, and then enter the
value in the corresponding (left-to-right) R, G, or B Gamma Correction field.

To modify the gamma correction curve using the LUT Editor graph:

1 Do one of the following:
■ To modify the combined R, G, and B gamma correction curves proportionally, select All from the

Edit Curve box, and then drag the gamma correction curve left or right.

■ To set independent R, G, or B values, select Red, Green, or Blue from the Edit Curve box, and then
drag the gamma correction curve left or right.
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(a) Gamma correction curve

Modifying the Gamma of the Incoming Film Negative

The values in the Film Gamma fields affect the gamma correction curve inversely to the Gamma Correction
fields. This is because the gamma correction performed using these controls is based on the gamma of the
original film negative. Typically, the gamma of a film negative is 0.6. Only adjust this value if your film
negative is of a non-standard gamma. You should not have to modify this value by very much.

To modify the gamma correction curve using the Film Gamma fields:

1 Do one of the following:
■ To set proportional custom R, G, and B gamma correction values, enable Prop and then enter the

value in one of the (left-to-right) R, G, and B Film Gamma fields.

■ To set independent custom R, G, or B gamma correction values, disable Prop and then enter the
value in the corresponding (left-to-right) R, G, or B Film Gamma field.

(a) Film Gamma fields
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Adjusting the Softclip Values

You can soften the shoulder of the gamma correction curve by adjusting the Softclip values. When you
soften the shoulder of the conversion curve, you soften the transition of colours toward the reference white
value. This results in less harsh highlights in your clip.

To soften the shoulder of the gamma correction curve using the Softclip fields:

1 Do one of the following:
■ To set proportional custom R, G, and B gamma correction values, enable Prop, and then enter the

value in one of the (left-to-right) R, G, and B Softclip fields.

■ To set independent custom R, G, or B gamma correction values, disable Prop, and then enter the
value in the corresponding (left-to-right) R, G, or B Softclip field.

(a) Soft Clip fields

To soften the shoulder of the gamma correction curve using the LUT Editor graph:

1 Do one of the following:
■ To soften the shoulder of the combined R, G, and B gamma correction curves proportionally, select

All from the Edit Curve box, and then Shift-drag the gamma correction curve left or right.

■ To soften the shoulder of the R, G, or B curves separately, select Red, Green, or Blue from the Edit
Curve box, and then Shift-drag the gamma correction curve left or right.
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(a) Softened shoulder

Advanced Editing of the Conversion LUT Curve

NOTE The procedure in this section does not apply to colour transforms or 3D LUTs.

After you modify the basic conversion curves in the LUT Editor (page 1161), you may want to further refine
the final result. To do so, you can use advanced editing tools. With advanced editing, you modify additional
curves for the red, green, and blue channels to fine-tune the final conversion LUT and bring out or hide
detail in specific areas. These curves have editable points, adding flexibility in how they affect each channel
in the final conversion LUT.

You can modify the shape of each advanced editing curve using control points. Modifications you make to
these curves influence the curve of corresponding channels in the final conversion LUT. For example, you
can add points to the advanced editing curve for the red channel, and by dragging the points, affect the
slope of the red channel's final conversion LUT curve.

The modifications you make to the basic conversion LUT curves and the advanced editing curves are
independent. The final LUT that you generate, however, is a single curve (or set of R, G, and B curves) that
consists of basic LUT curves and adjustments you make with advanced editing curves.

To perform advanced editing of the conversion LUT curve:

1 In the LUT Editor, click Advanced.
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Additional advanced editing curves appear for the red, green, and blue channels. RGB curves use
blending to distinguish overlapping curves. For example, when all RGB curves overlap, a white curve
is produced, whereas green and blue overlapping curves produce a cyan curve.

(a) Red, blue and green overlapping advanced editing curves (b) Control point (c) Basic button (d) Final button
(e) Edit Curve box (f) Reset button

2 To adjust the R, G, and B curves more easily, select one of the channels from the Edit Curve box.

The corresponding channel's basic and advanced editing curves are displayed. The histogram only
displays values for the selected channel.
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(a) Color channel selected in Edit Curves box (b) Color channel's advanced editing curve

3 To modify the advanced editing curves, use the Tools box.

To:Select:

Add control points to an advanced editing curve. With Add selected, click either the
red, green, or blue advanced editing curve.

Add

Delete control points from an advanced editing curve. With Delete selected, click a
point on the red, green or blue advanced editing curve.

Delete

Move control points. With Move selected, drag the points, or press Command-drag
to select multiple points.

TIP  Since the advanced editing curves use B-spline interpolation, the control points
you manipulate will not necessarily rest on the curve itself. Points have a weighted in-
fluence on the curve depending on the position of the other points on the curve.

Move

Zoom in on the curves. With Zoom selected, drag over the curves right or left to zoom
in or out.

Zoom

Zoom in on a section of the curves. With Rect Zoom selected, drag a selection box to
zoom in on the area of the curves contained by the selection box.

Rect Zoom

Pan the curves. With Pan selected, drag over the curves to pan the curves in any direc-
tion.

Pan

Dragging control points of advanced editing curves affects the basic curves and the colour effect is
immediately reflected in the clip.

4 To view the basic and final conversion LUT curves, toggle the Basic LUT and Final LUT buttons.

5 To reset the advanced editing curves only, click Reset.
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Comparing Colour Values Using Colour Patches

NOTE The procedures in this section do not apply to 3D LUTs.

While using the LUT Editor (page 1161), you may want to sample image channel values in the source, result,
and reference clips to compare values of similar colours, or even corresponding pixels. The colour patches
appear to the right of the LUT Editor graph.

To sample colours in the LUT Editor accessed from the Import Image menu:

1 Click the Source or Result Colour patch.

The cursor changes to a colour picker.

2 Click the image.

Both source and result colours are sampled simultaneously. The RGB values for the selected pixel are
displayed, and the sampling boxes take on the corresponding colour.

3 To sample a set of reference values, click the Reference sampling box and use the colour picker to
sample the image.

The values are taken from either the result or reference image, depending on which clip display option
is currently selected.

To use colour patches in the LUT Editor menu in ConnectFX:

1 Click the Source or Result sampling box.
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The cursor changes to a colour picker.

2 Click the image.

Both source and result colours are sampled simultaneously. The RGB values for the selected pixel are
displayed, and the sampling boxes take on the corresponding colour.

Exporting LUTs and Colour Transforms

Exporting a LUT or colour transform from the LUT Editor (page 1161) is different from saving a setup:
■ PhotoMap, EXR Display, Gamma, Lin to Log, and Log to Lin are exported as baked 1D LUTs (.lut files).

When imported, you can modify their curves only with the Advanced settings.

■ A chain of colour transforms is exported as a single .ctf file that losslessly preserves each component
operation. When imported, you cannot modify it.

Exporting a LUT

1 Access the LUT Editor.

2 Click Export.

The file browser appears.

3 Type a file name for the LUT in the Export field.

4 If you want to generate an inverse LUT with the _inv suffix appended to the file name, make sure that
the Generate Inverse Lut option is active.

5 Click Export.

The LUT is exported to the specified location.

Exporting a Colour Transform

1 Access the LUT Editor.

2 Click Export.

The file browser appears.

3 Type a file name in the Export field. The .ctf extension is added automatically.

4 If desired, type a nickname for the colour transform in the Nickname field. The nickname is displayed
in the metadata panel of the LUT editor, and is also shown in the Viewer Colour Management pop-up
(in the lower left of image windows) when loaded in your LUT preferences.

5 If desired, type a description for the colour transform. The description is displayed in the metadata
panel of the LUT editor.

6 Select the destination location using the location shortcut under the EXIT Export LUT button:
■ Shared is a useful location for storing transforms that can be used by other Autodesk applications

on the same workstation that use Autodesk Colour Management.

■ Project (/usr/discreet/project/<project name>/synColor/transforms) is a useful location for storing
the transforms that are specific to the current project, for example, for archiving.
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■ Saving transforms to the Autodesk location is not recommended.

7 Click Export.

The colour transform is exported to the specified location.

Applying Colour Management to Displayed Images
When you apply colour management to displayed images, the colours on the monitor or projector are
affected but the underlying colour values of the clips' pixels are not changed. You should do this when you
want to preview images in different colour spaces. For example, if you are working in the ACES colour space,
then you can apply the ACES_to_current-monitor transform to display the images.

Configuring Smoke to Use LUTs and Colour Transforms for Display

Before you can apply colour management to displayed images, you must add the LUTs and colour transforms
that you want to use to your preferences. This makes them available for use in image windows.

Making 1D LUTs Available for Display

1 Click Autodesk Smoke > Preferences, and select LUT.

2 On the 1D LUT tab at the right, click in a slot.

3 Do one of the following:
■ Select Gamma in the LUT Type box, and set a value.

■ Select LUT File in the LUT Type box, then click Import and select a 1D LUT file.

Making 3D LUTs and Colour Transforms Available for Display

1 Click Autodesk Smoke > Preferences, and select LUT.

2 On the 3D LUT tab at the right, click in a slot.

3 Click Import and select a native 3D LUT (.3dl) or Colour Transform (.ctf) file. You can also select files
in several other supported LUT and transform formats.

Configuring the Colour Transform Aliases

Some colour transforms include references to one or more of several aliases. You can configure which colour
transforms are used in place of these aliases. This lets you change the value of the aliases while still using
the same colour transform files. For example, you can:
■ Use the same colour transforms for display on different computers with different monitors.

■ Change the default look applied by a colour transform without changing the transform file itself.

To set the colour transform aliases:

1 Click Autodesk Smoke > Preferences, and select LUT.

2 Set the transform to use for each of the following:
■ Broadcast Monitor Transform. This is the transform that gets used when another transform

includes a reference to the broadcastMonitor alias, as well as when another transform includes a
reference to the currentMonitor alias for images displayed on the broadcast monitor or projector.
Click Browse, select Autodesk at the lower left, and choose one of the tranforms in the display/

1178 | Chapter 24   Colour Management



folder that convert from CIE-XYZ to whatever is appropriate for your broadcast display, or use one
of your own transforms.

■ Graphics Monitor Transform. This is the transform that gets used when another transform
includes a reference to the graphicsMonitor alias, as well as when another transform includes a
reference to the currentMonitor alias for images displayed on the local monitor. Click Browse,
select Autodesk at the lower left, and choose one of the tranforms in the display/ folder that
convert from CIE-XYZ to whatever is appropriate for your local display, or use one of your own
transforms.

TIP Activate Sync with OS to automatically use the ICC profile set in your operating system's preferences.

■ Default Look Transform. This is the transform that gets used when another transform includes
a reference to the defaultLook alias. It should be set to the transform that you are using to re-create
the look used on set.

Applying 1D LUTs to the Monitor

Applying a Gamma or 1D LUT to the monitor affects all images displayed on the workstation in Smoke. Any
3D LUTs or colour transforms that are being used to display specific viewports become deactivated
automatically. The last-used 1D LUT is displayed at the bottom right of the Player or Viewport, and is
highlighted when the LUT is in use.

NOTE You can also apply a 1D LUT to the monitor from the LUT preferences.

Applying 1D LUTs to the Monitor Using the View Menu

1 Do one of the following:
■ From the Player, select Show Viewing Settings from the Options box.

■ From Src-Seq or Triptych, select Edit Viewing Settings from the Options box.

■ From any other view, such a ConnectFX effect, open the View menu.

2 Enable Use 1D LUT.

The 1D LUT displayed in the 1D LUT List box is applied to the display.

3 To change 1D LUTs, select an option from the list in the Monitor LUT List box.
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Applying 1D LUTs to the Monitor Using the Keyboard

To do:Press:

Apply the first 1D LUT defined in the 1D LUT list.Command+Shift+1

Apply the second through ninth 1D LUT defined in the 1D LUT
list.

Command+Shift+[2-9]

Apply the tenth 1D LUT defined in the 1D LUT list.Command+Shift+0

Toggle the last-used 1D LUT on and off.Command+Shift+~

Applying 3D LUTs and Colour Transforms to Viewports

You can apply 3D LUTs and colour transforms to individual viewports, and use different ones in different
viewports. Any 1D LUT that is being used on the monitor becomes deactivated automatically. The file name
of the last-used 3D LUT or colour transform is displayed at the bottom right of the viewport, and is highlighted
when in use.

The nicknames of the available colour transforms also appear on the Viewer Colour Management pop-up
menu, and can be used quickly apply a colour transform to the viewport.

NOTE 3D LUTs are assumed to require colour values in log space. Depending on your display mode, a linear-to-log
or video-to-log conversion is automatically applied.

NOTE 3D LUTs and color transforms are not applied to every view. For example, Sparks uses the basic Image Data
Type, while other views and modules such as Text, the MediaHub preview, desktop reels, and thumbnails have
no color management at all. If necessary, you can apply a 1D LUT to the whole interface to affect the colors
displayed in these views.

Applying Colour Transforms to a Viewport Using the Viewer Colour Management Pop-up Menu

1 Click on the Image Display pop-up menu in the bottom left of an image viewport.

2 Select a colour transform.

NOTE 3D LUTs are not available on the Image Display pop-up menu.
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Applying 3D LUTs and Colour Transforms to a Viewport Using the View Menu

1 Do one of the following:
■ From the Player, select Show Viewing Settings from the Options box.

■ From Src-Seq or Triptych, select Edit Viewing Settings from the Options box.

■ From any other view, such a ConnectFX effect, open the View menu.

2 If multiple image views are displayed, click in the one you want to affect.

3 Enable Use 3D LUT.

The 3D LUT or colour transform displayed in the 3D LUT List box is applied to the display.

4 To change the 3D LUT or colour transform, select an option from the list in the Monitor LUT List box.

5 If multiple image views are displayed, repeat steps 2 to 4 to affect other views.

Applying 3D LUTs and Colour Transforms to a Viewport Using the Keyboard

1 If multiple image views are displayed, click in the one you want to affect.

2 Press one of the following keys.

To apply:Press:

The first 3D LUT or colour transform defined in the 3D LUT & Colour
Transform list.

Option+Shift+1

The second through ninth 3D LUT or colour transform defined in the 3D
LUT & Colour Transform list.

Option+Shift+[2-9]

The tenth 3D LUT or colour transform defined in the 3D LUT & Colour
Transform list.

Option+Shift+0

Toggle the last-used 3D LUT or colour transform on and off.Option+Shift+~

Applying a 3D LUT or Colour Transform to the Projector or
Broadcast Monitor

You can apply a different 3D LUT or colour transform to the projector or broadcast monitor than the one
used for display on the workstation.

1 Click Autodesk Smoke > Preferences, and select Broadcast.
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2 Under Broadcast LUT, enable Use 3D LUT In Monitor.

3 To change the 3D LUT or colour transform, select an option from the list in the 3D LUT List box.

(a) 3D LUT List box

Modifying Exposure and Contrast with Display Transforms

If you apply a 1D or 3D LUT for display, then you can modify the exposure and contrast in the usual way.

However if you apply a colour transform to an image view or the broadcast monitor, then you cannot adjust
the exposure and contrast interactively. The exception is when there is a dynamic ExposureContrast operator
in the CTF file. In that case, the exposure and contrast values defined in the CTF file are not used. Instead,
the values set in the Image Display options are used.

Controlling the Look in Viewports

When some transforms are applied as viewing transforms in a viewport, you can toggle portions of the
transform on and off interactively. This can be helpful when working with looks.

Looks are basic colour grades that are created by a cinematographer to establish a visual mood for a scene
during principal photography. However, the look must not be baked into the raw footage or visual effects
because it is only the starting point for the final grading. Therefore, it is useful to be able to toggle the look
on and off during finishing.

The Look on/off switch is available when:
■ The current viewing transform in a viewport contains a reference to the Default Look Transform set in

LUT Preferences.

■ The current viewing transform is an ASC colour decision list (.cdl) file.

■ The current viewing transform is a custom Colour Transform (.ctf) file that contains one or more operators
with the LOOK_SWITCH dynamic parameter.

You can click directly on the Look switch at the bottom of the viewport to toggle the look on and off.
Alternatively, you can use the Enable Look Transform button in the Image Display Viewer settings.
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Setting Up the Default Look

1 In LUT Preferences, specify a transform as the Default Look Transform. You can select a transform file
in any supported format.

2 In LUT Preferences, add one or more viewing transforms that reference the default look to the 3D LUT
and Colour Transform list. The transforms that reference the default look include the following:
■ The transforms in the RRT+ODT directory of the Autodesk location are available for displaying

ACES material on various devices.

■ The ADX10_to_current-monitor and ADX16_to_current-monitor transforms in the film\ADX\
directory are available for displaying scanned film on the system or broadcast monitor.

NOTE The default_look transform in the misc\ directory simply applies the default look transform, and the
default_look-ACESproxy transform applies the default look transform in the ACESproxy color space that is
typically used on set (first converting from the ACES color space and then back again). These transforms are
not intended to be used directly as viewing transforms, but should be used as building blocks for creating
your own custom chain of transforms.

3 Display an image in a viewport, and apply a viewing transform.

The Look switch appears at the bottom of the viewport.

Autodesk Colour Transform Types
The colour transforms available in the Autodesk location are CTF files based on the Academy/ASC XML
colour transform format. They include several categories for different purposes.

DescriptionCategory

Various combinations of a reference rendering transform (RRT)
followed by an output device transform (ODT) designed for
output from the ACES colour space.

RRT+ODT

Converts between various integer and floating-point value
formats.

bit-depth

Converts from various digital-camera native formats to other
colour spaces such as ACES.

camera

Converts colours in a connection space to and from output
spaces appropriate for various display devices.

display

Converts scanned-film colour spaces to and from ACES.film

Applies or removes various common gamma values, including
those for sRGB and Rec709.

gamma

Converts colours in a connection space to and from spaces
that are commonly used for file input and output, such as
AdobeRGB and sRGB.

interchange

Various functions to clamp or adjust colour values.levels
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DescriptionCategory

Various transforms that may be useful for debugging or other
purposes.

misc

Converts between linear colour spaces that use different
primary colours.

primaries

Converts from scene-linear to video colour spaces.tone-map

Converts the white point of linear colour spaces.whitepoint

Colour Management Files and Locations
The colour management files consist of 1D LUTs, 3D LUTs, and colour transforms. You can use files created
in other applications as long as they are in a compatible format.

You can use the location shortcut button at the lower left of file browsers to switch between the standard
file locations.

You can use files located anywhere on your file system, but it is recommended to store your custom LUTs
and colour transforms in either the Project or Shared location.

1D LUTs

All 1D LUT files have the .lut extension. They are stored in the Project (/usr/discreet/project/<project
name>/lut) location.

3D LUTs

All standard 3D LUT files have the .3dl extension; encrypted 3D LUTs have the .e3d extension.

The 3D LUTs installed with Smoke are in the Lustre Colour
(/usr/discreet/Lustre_Color/lut/Lustre_Color_3DLUTs) location. Use the Project (/usr/discreet/project/<project
name>/lut) location to store 3D LUTs specific to a particular project.
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Colour Transforms

Colour transforms are based on the Academy/ASC XML colour transform format and have the .ctf extension.
They are stored in the following locations:
■ Shared (/Applications/Autodesk/Synergy/SynColor/Shared/transforms by default) is a useful location

for storing transforms that can be used by other applications that use Autodesk Colour Management.

■ Project (/usr/discreet/project/<project name>/synColor/transforms) is a useful location for storing the
transforms that are specific to the current project, for example, for archiving.

■ Autodesk (/Applications/Autodesk/Synergy/SynColor/<version>/transforms) contains the transforms
installed with Smoke. See Autodesk Colour Transform Types (page 1183).

Supported Colour Transform File Formats
In addition to the native .ctf format, applications that use Autodesk Color Management can read several
LUT and transform file formats.

Supported formats include:

.lut Autodesk legacy 1D LUT.

.3dl Autodesk legacy 3D LUT.

.cdl ASC color decision list.

ASC .cdl files are loaded as ASC_CDL operators. The style used by the colour transform operator is determined
by the SYNCOLOR_DEFAULT_CDL_STYLE environment variable. This can be one of the following values:
v1.2_Fwd, v1.2_Rev, noClampFwd, or noClampRev. If this environment variable is undefined, the default
is v1.2_Fwd. For more information about these styles, see ASC_CDL (page 1216).

When a .cdl file is applied to the display, a Look switch is added that allows you to toggle the transform on
and off.

.ccc ASC color correction collection.

The first CDL defined in the file is loaded as an ASC_CDL operator. The style is also determined by the
SYNCOLOR_DEFAULT_CDL_STYLE environment variable.

.csp Cinespace

.icc, .icm, .pf ICC monitor profile. The PCS-to-monitor-RGB transform defined in the profile is loaded.

.cube Iridas Cube

.itx Iridas itx

.look Iridas Look (no mask support)

.m3d, .mga Pandora

.spi1d Imageworks 1D LUT

.spi3d Imageworks 3D LUT

.spimtx Imageworks matrix

.vf Nuke

When imported, these formats are converted to native operators and can be exported as .ctf files.
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Autodesk CTF File Format Version 1.3
There are a wide variety of colour transform (also known as "LUT") formats used in the media and
entertainment industry. This creates workflow problems since you may receive a LUT which is not supported
by one or more of the applications you use. Furthermore, most of these LUT formats are based on out-dated
technology and lack the quality, flexibility, and metadata needed to meet today's requirements.

To address these problems, the technology committees of the Academy of Motion Picture Arts and Sciences
and the American Society of Cinematographers convened a group of experts to design a common transform
format that could become an industry standard.

Autodesk has chosen to adopt this format as the native format for our colour management technology and
we provide a large collection of transforms in this format with our applications (e.g., to support the Academy
Color Encoding System).

This guide provides information about the Academy/ASC format to help you author your own colour
transforms. In addition it defines several Autodesk-specific extensions which you may use when authoring
colour transforms solely for use in Autodesk applications. All Autodesk extensions are marked with the
version in which they were introduced or updated. All other elements and attributes are part of the original
Academy/ASC format.

Anatomy of a CTF File

The transform format allows the author to define an arbitrary chain of color operators (also called processing
nodes). The set of available operator types includes 1D LUTs, 3D LUTs, matrices, and others defined below.
The format is written in XML and is therefore human readable.

Here is an example:

<?xml version="1.0" encoding="UTF-8"?>
<ProcessList id="7401489a-9e4d-441d-a8b7-795739801f4e" name="ACES to HD"
version="1.2">

<Info>
<Copyright>Copyright 2013 Autodesk, Inc. All rights

reserved.</Copyright>
<Release>2013.3.pr27</Release>

</Info>
<Description>ACES Reference Rendering Transform + HD video Output Device

Transform</Description>
<Description>aces_dev version 0.1.1</Description>
<InputDescriptor>Academy Color Encoding Specification

(ACES)</InputDescriptor>
<OutputDescriptor>HD (Rec 709) video</OutputDescriptor>
<LUT1D halfDomain="true" inBitDepth="32f" outBitDepth="32f"

rawHalfs="true">
<Array dim="65536 1">

0
1
1

<!-- 65533 lines omitted -->

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
0.9259999990 0.0379999988 0.0359999985
0.1299999952 0.8000000119 0.0700000003
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-0.0350000001 -0.0350000001 1.0700000525
</Array>

</Matrix>
<LUT1D halfDomain="true" inBitDepth="32f" outBitDepth="32f"

rawHalfs="true">
<Array dim="65536 1">

0
0
0

<!-- 65533 lines omitted -->

</Array>
</LUT1D>
<LUT3D inBitDepth="32f" interpolation="tetrahedral" outBitDepth="32f">

<Array dim="48 48 48 3">
0.000669299 0.000704187 0.000766901
0.001848371 0.001297010 0.010368987
0.002599007 0.001144927 0.023227118

</Array>
</LUT3D>
<Gamma inBitDepth="32f" outBitDepth="32f" style="moncurveFwd">

<GammaParams gamma="2.600000000000000" offset="0.050000" />
</Gamma>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
3.2409698963 -1.5373831987 -0.4986107647
-0.9692436457 1.8759675026 0.0415550582
0.0556300804 -0.2039769590 1.0569715500

</Array>
</Matrix>
<Range inBitDepth="32f" outBitDepth="32f">

<minInValue> 0.0000</minInValue>
<maxInValue> 1.0000</maxInValue>
<minOutValue> 0.0000</minOutValue>
<maxOutValue> 1.0000</maxOutValue>

</Range>
<Gamma inBitDepth="32f" outBitDepth="12i" style="basicRev">

<GammaParams gamma="2.400000000000000" />
</Gamma>

</ProcessList>

CTF Syntax Summary

Here is a brief overview of the syntax of a CTF file.

In the list below, ? means "0 or 1 occurrence", * means "0 or more occurrences" , and + means "1 or more
occurrences". If not otherwise marked, a single occurence of an element is required.

ProcessList (page 1189) Attributes: id, name Contains:

Info (page 1190) ? Contains:

Copyright (page 1191) ?

Release (page 1192) ?

Description (page 1193) *

InputDescriptor (page 1194) ?
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OutputDescriptor (page 1194) ?

OperatorNode + This is a virtual element — replace it by one of the substitutions below (LUT1D, LUT3D,
etc.). Attributes: id, name, inBitDepth, outBitDepth, bypass Contains:

Description (page 1193) *

DynamicParameter (page 1223) ? (up to 3 for ExposureContrast) Attributes: param

Substitute each OperatorNode by any one of the following:

LUT1D (page 1196) Inherited attributes: id, name, inBitDepth, outBitDepth Attributes: interpolation,
halfDomain, rawHalfs Contains:

Array (page 1198) Attributes: dim

LUT3D (page 1199) Inherited attributes: id, name, inBitDepth, outBitDepth Attributes: interpolation Contains:

Array (page 1199) Attributes: dim

Matrix (page 1201) Inherited attributes: id, name, inBitDepth, outBitDepth Contains:

Array (page 1202) Attributes: dim

Range (page 1204) Inherited attributes: id, name, inBitDepth, outBitDepth Contains:

minInValue (page 1206) ?

maxInValue (page 1206) ?

minOutValue (page 1207) ?

maxOutValue (page 1207) ?

Gamma (page 1208) Inherited attributes: id, name, inBitDepth, outBitDepth Attributes: style Contains:

GammaParams (page 1210) Attributes: channel, gamma, offset

ExposureContrast (page 1211) Inherited attributes: id, name, inBitDepth, outBitDepth Contains:

ECParams (page 1212) Attributes: exposure, contrast, pivot

Log (page 1213) Inherited attributes: id, name, inBitDepth, outBitDepth Attributes: style Contains:

LogParams (page 1214) 1 or 3 Attributes: channel, gamma, refWhite, refBlack, highlight, shadow

ASC_CDL (page 1216) Inherited attributes: id, name, inBitDepth, outBitDepth Contains:

SOPNode (page 1217) Contains:

Slope (page 1218)

Offset (page 1219)

Power (page 1219)

SatNode (page 1220) Contains:

Saturation (page 1221)

Reference (page 1221) attributes: alias, path, basepath

XML Declaration

The XML declaration is optional but recommended. It indicates to the XML parser the version of XML and
character encoding used.

If it is present, the XML declaration must be the first line of the file.
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Example

<?xml version="1.0" encoding="UTF-8"?>

ProcessList

The ProcessList element is the root element of a CTF file. It must contain at least one operator element.

Contains

In order:
■ Info (page 1190). Optional, no more than one.

■ Description (page 1193). Optional, any number.

■ InputDescriptor (page 1194). Optional, no more than one.

■ OutputDescriptor (page 1194). Optional, no more than one.

■ At least one of LUT1D (page 1196), LUT3D (page 1199), Matrix (page 1201), Range (page 1204), Gamma (page
1208), ExposureContrast (page 1211), or Reference (page 1221) in any combination in the order in which they
are to be applied.

NOTE The inBitDepth attribute of each operator must match the outBitDepth attribute of the previous operator
in the chain. See Common Operator Attributes (page 1195).

Contained By

■ no parent

Attributes

id  A unique identifier (required).

name A nickname for the entire color transform (optional). This is used for display and selection in
applications that support Autodesk Color Management.

version Indicates the presence of Autodesk extensions to the Academy/ASC XML color transform format.
Files with a value higher than that supported by the application are rejected.

inverseOf The id attribute from another CTF file. It identities this transform as the inverse of the other one.
This information is useful to the color management system to detect the case where a transform and then
its inverse are applied, so the transform pair may be optimized out. It is an Autodesk extension to the
Academy/ASC XML color transform format.

Example

<ProcessList id="7214fa79-6c42-48b9-b164-3d0c5e543fe0" version="1.2">
<Description>F65 Raw integer code values to ACES (tungsten

illuminant).</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>Academy Color Encoding Specification

(ACES)</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
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</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.0110238791 -0.1362526119 0.1252287328
0.1011994481 0.9562196136 -0.0574190766
0.0600766540 -0.1010185331 1.0409418344

</Array>
</Matrix>

</ProcessList>

Metadata Elements

The metadata elements provide information about a color transformation that can be displayed in information
panels in applications.

Info

The Info element is a container for the Copyright and Release elements.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.2.

Contains

In any order:
■ Copyright (page 1191). Optional, no more than one.

■ Release (page 1192). Optional, no more than one.

Contained By

■ ProcessList (page 1189)

Attributes

None.

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc. All rights
reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with

Rec 709 primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
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11.798709869 11.798709869 11.798709869
</Array>

</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702

</Array>
</Matrix>

</ProcessList>

Copyright

The Copyright element is intended to contain a copyright notice covering the CTF file.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.2.

Contains

■ Text string. Use &gt; for >, &lt; for <, and &amp; for &.

Contained By

■ Info (page 1190)

Attributes

None.

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc.  All rights reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with

Rec 709 primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702
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</Array>
</Matrix>

</ProcessList>

Release

The Release element is intended to contain the version of the SynColor library corresponding to an
Autodesk-supplied CTF file.

It is an Autodesk extension to the Academy/ASC XML color transform format. You should not add this
element to color transforms that you author yourself.

Introduced

Version 1.2.

Contains

■ Text string. Use &gt; for >, &lt; for <, and &amp; for &.

Contained By

■ Info (page 1190)

Attributes

None.

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc. All rights
reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with

Rec 709 primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702

</Array>
</Matrix>

</ProcessList>
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Description

The Description element allows you to add information about the function or usage of a ProcessList or
operator element. It is displayed in the metadata panel of color transforms in products that support Autodesk
Color Management.

Contains

■ Text string. Use &gt; for >, &lt; for <, and &amp; for &.

Contained By

■ ProcessList (page 1189)

■ LUT1D (page 1196)

■ LUT3D (page 1199)

■ Matrix (page 1201)

■ Range (page 1204)

■ ExposureContrast (page 1211)

■ Gamma (page 1208)

■ Reference (page 1221)

Attributes

None.

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc. All rights
reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with Rec 709 

primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702

</Array>
</Matrix>

</ProcessList>

Autodesk CTF File Format Version 1.3 | 1193



InputDescriptor

The InputDescriptor element allows you to add a comment describing the intended input color space and
encoding for a color transform. It is does not affect the processing, but is displayed in the metadata panel
of color transforms in products that support Autodesk Color Management.

Contains

■ Text string. Use &gt; for >, &lt; for <, and &amp; for &.

Contained By

■ ProcessList (page 1189)

Attributes

None.

Example

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc. All rights
reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with

Rec 709 primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702

</Array>
</Matrix>

</ProcessList>

OutputDescriptor

The OutputDescriptor element allows you to add a comment describing the output color space and encoding
for a color transform. It is does not affect the processing, but is displayed in the metadata panel of color
transforms in products that support Autodesk Color Management.
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Contains

■ Text string. Use &gt; for >, &lt; for <, and &amp; for &.

Contained By

■ ProcessList (page 1189)

Attributes

None.

Example

Example

<ProcessList id="f8d905db-4ab8-4af6-8465-0db81f7e993c" version="1.2">
<Info>

<Copyright>Copyright 2012 Autodesk, Inc. All rights
reserved.</Copyright>

<Release>2013.1.pr20</Release>
</Info>
<Description>F65 Raw integer code values to scene-linear floats with

Rec 709 primaries.</Description>
<InputDescriptor>16-bit integer F65 Raw</InputDescriptor>
<OutputDescriptor>scene-linear Rec 709 primaries</OutputDescriptor>
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
1.8779151440 -0.7941687703 -0.0837463662
-0.1768069863 1.3509995937 -0.1741926372
-0.0262011271 -0.1484222561 1.1746233702

</Array>
</Matrix>

</ProcessList>

Operator Elements

The operator elements specify the operations to be applied to the color data. You can have as many as you
like in a ProcessList element, in the order in which they are to be applied.

NOTE The inBitDepth attribute of each operator must match the outBitDepth attribute of the previous operator
in the chain. See Common Operator Attributes (page 1195).

Common Operator Attributes

Several attributes are common to all of the color transform operator elements.

id A unique identifier for the element. Optional.
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name A friendly name for the element. Optional.

bypass Introduced in version 1.3. Specifies that the operator should not be applied during color processing.
Optional. If this attribute exists, its value must be "true". By using this attribute in combination with a
DynamicParameter (page 1223) element that has its param attribute set to "LOOK_SWITCH", you can define
operators that will never affect values rendered to file but that can still be toggled on and off for display.

inBitDepth The input color data type expected by the operator. Required.

outBitDepth The output color data type produced by the operator. Required.

NOTE The inBitDepth attribute of each operator must match the outBitDepth attribute of the previous operator
in the chain.

Supported Values for inBitDepth and outBitDepth

MeaningValue

8-bit integer"8i"

10-bit integer"10i"

12-bit integer"12i"

16-bit integer"16i"

16-bit floating point (half-float)"16f"

32-bit floating point (single precision)"32f"

About Bit Depth

The values specified for inBitDepth and outBitDepth attributes do not affect the quantization of color values.
All processing is performed using 32-bit floating-point values.

The inBitDepth and outBitDepth attributes affect only the format of the numbers used in the CTF file, such
as the values used in an Array, Matrix, or Range element. For example, if you find it convenient to specify
values as integers in the range [0, 1023] then you can use an inBitDepth of "10i". You can still specify
values outside this range, and those values will be used in the intermediate computations.

LUT1D

The LUT1D element specifies a 1D LUT to apply.

Contains

■ Description (page 1193). Optional, any number.

■ Array (LUT1D) (page 1198). Required, one only.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".
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NOTE The IndexMap element is not supported. The most efficient way to achieve the same result is to precede
the operator with another LUT1D element, or to combine both LUTs into a single one.

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

interpolation  Optional. The only currently supported value is "linear".

halfDomain Optional. If this attribute is present, its value must be "true". In this case, the input domain
is all possible 16-bit floating-point values, and there must be exactly 65536 entries in the Array element. For
example, the unsigned integer 15360 has the same bit-pattern (0011110000000000) as the half-float value
1.0, so the 15360th entry (zero-indexed) in the Array element is the output value corresponding to an input
value of 1.0.

rawHalfs Optional. If this attribute is present, its value must be "true". In this case, the values in the array
should be 16-bit floating point values expressed as unsigned 16-bit integers representing the equivalent bit
pattern. For example, to represent the value 1.0, you would enter the integer 15360 in the Array element
because it has the same bit-pattern. This allows you to specify the exact half-float values you want without
relying on conversion from decimal text strings.

Example

1D LUT

<ProcessList id="8a52d5fb-a903-4805-8bae-24f7553bfb70" version="1.2">
<LUT1D inBitDepth="10i" outBitDepth="32f">

<Array dim="1024 1">
-0.014279292
-0.014160193
-0.014040368
<!-- 1021 lines omitted -->

</Array>
</LUT1D>

</ProcessList>

3×1D LUT

<ProcessList id="a76dbe2e-e610-49a6-8c3b-5962375a8b4a" version="1.2">
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>

</ProcessList>
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Array (LUT1D)

The Array element specifies an array of values for a LUT or matrix. When it is contained by a LUT1D element,
the format of its contents is different than when it is contained by LUT3D or Matrix elements.

Contains

■ A series of numeric values specifying the output values of the LUT. The corresponding input values are
implied by the inBitDepth (page 1195) of the containing element. For integers, the first value corresponds
to an input of 0 and the last to an input of (2bitdepth – 1). For floating-point numbers, the first value
corresponds to an input of 0.0 and the last to an input of 1.0. Input values outside these domains are
clamped.

The intervals between the input values are uniform and depend on the number of entries. For example,
if there are 5 floating-point entries, they correspond to inputs of 0.0, 0.25, 0.5, 0.75, and 1.0.

For a 1D LUT, there is one value per entry which is used for all color channels. For a 3×1D LUT, there
are three values per entry specifying the separate R, G, and B output values.

Contained By

■ LUT1D (page 1196)

Attributes

dim  Two integers representing the dimensions of the array. The first value is the number of entries in the
contents of the Array element. The second value is number of values per entry: 1 for a single value applied
to all channels or 3 for for separate values applied to the R, G, and B channels respectively.

The dim attribute is required, and its value must match the number of entries actually present.

Example

1D LUT

<ProcessList id="8a52d5fb-a903-4805-8bae-24f7553bfb70" version="1.2">
<LUT1D inBitDepth="10i" outBitDepth="32f">

<Array dim="1024 1">
-0.014279292
-0.014160193
-0.014040368
<!-- 1021 values omitted -->

</Array>
</LUT1D>

</ProcessList>

3×1D LUT

<ProcessList id="a76dbe2e-e610-49a6-8c3b-5962375a8b4a" version="1.2">
<LUT1D inBitDepth="16i" outBitDepth="32f">

<Array dim="2 3">
-0.092903227 -0.092903227 -0.092903227
11.798709869 11.798709869 11.798709869

</Array>
</LUT1D>

</ProcessList>
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See Also

■ Array (LUT3D) (page 1199)

■ Array (Matrix) (page 1202)

LUT3D

The LUT3D element specifies a 3D LUT to apply.

Contains

■ Description (page 1193). Optional, any number.

■ Array (LUT3D) (page 1199). Required, one only.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

NOTE The IndexMap element is not supported. The most efficient way to achieve the same result is to precede
the operator with a LUT1D element.

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

interpolation  Supported values are "trilinear" and "tetrahedral".

This attribute is optional. If it is not specified, the default is "trilinear".

Example

<ProcessList id="b5b90615-573b-4959-a838-f35e0e588ac2" version="1.2">
<LUT3D inBitDepth="32f" interpolation="tetrahedral" outBitDepth="32f">

<Array dim="48 48 48 3">
0.000669299 0.000704187 0.000766901
0.001848371 0.001297010 0.010368987
0.002599007 0.001144927 0.023227118
<!-- 48*48*48-3 lines omitted -->

</Array>
</LUT3D>

</ProcessList>

Array (LUT3D)

The Array element specifies an array of values for a LUT or matrix. When it is contained by a LUT3D element,
the format of its contents is different than when it is contained by LUT1D or Matrix elements.
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Contains

■ A series of numeric values specifying the output values of the LUT. The corresponding input values are
implied by the inBitDepth (page 1195) of the containing element and the number of entries (uniform
distribution).

For a 3D LUT, each entry has three values specifying the separate R, G, and B output values. The entries
are in order from minimum to maximum with the index of the last column changing fastest and the
index of the first column changing slowest. For example, the order of entries for a 2×2×2 cube is:

BGREntry

0001

1002

0103

1104

0005

1006

0107

1108

Contained By

■ LUT3D (page 1199)

Attributes

dim  Four integers representing the dimensions of a 3D cube followed by followed by the number of
components per entry.

Only 3D LUTs with the same dimension in all three channels are supported, so the first three values must
be the same. The fourth value must be 3.

The dim attribute is required, and its value must match the number of entries actually present.

Example

<ProcessList id="b5b90615-573b-4959-a838-f35e0e588ac2" version="1.2">
<LUT3D inBitDepth="32f" interpolation="tetrahedral" outBitDepth="32f">

<Array dim="48 48 48 3">
0.000669299 0.000704187 0.000766901
0.001848371 0.001297010 0.010368987
0.002599007 0.001144927 0.023227118

<!-- 48*48*48-3 lines omitted -->

</Array>
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</LUT3D>
</ProcessList>

See Also

■ Array (LUT1D) (page 1198)

■ Array (Matrix) (page 1202)

Matrix

The Matrix element specifies a matrix for multiplying color values, and optionally applying an offset.

Contains

■ Description (page 1193). Optional, any number.

■ Array (Matrix) (page 1202). Required, one only.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

Example

3x3 Matrix

<ProcessList id="af6a6c73-aae9-4be6-8051-a796bc480b1c" version="1.2">
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
0.7841929793 0.0904410034 0.1253670007
0.0445200019 1.0391299725 -0.0836500004
0.0358299986 -0.3302420080 1.2944129705

</Array>
</Matrix>

</ProcessList>

4x4 Matrix

<ProcessList id="d6783d48-dd96-4c71-99af-f3be0cc9392e" version="1.2">
<Matrix inBitDepth="32f" outBitDepth="10i">

<Array dim="4 4 3">
499.99996948 0.00000000 0.00000000 94.99999237
0.00000000 499.99996948 0.00000000 94.99999237
0.00000000 0.00000000 499.99996948 94.99999237
0.00000000 0.00000000 0.00000000 1.00000000

</Array>
</Matrix>

</ProcessList>
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Array (Matrix)

The Array element specifies an array of values for a LUT or matrix. When it is contained by a Matrix element,
the format of its contents is different than when it is contained by LUT1D or LUT3D elements.

Updated

Version 1.3.

Contains

■ A series of numeric values specifying the elements of the matrix.

In a Matrix, the values specify the entries of the matrix which are serialized row by row from top to
bottom and from left to right. The scaling of the array values depends on the input and output bit-depths.
Color values are treated as column vectors for the purpose of multiplication.

The scaling of the array values depends on the input and output bit-depths. For example if the input
depth is 10i and the output depth is 12i, then a matrix containing entries of 4095/1023 along the main
diagonal and entries of 0 everywhere else is the identity transform.

3×3 Matrix Multiplication

3×4 Matrix Multiplication
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4×4 Matrix Multiplication

4×5 Matrix Multiplication

Contained By

■ Matrix (page 1201)

Attributes

dim Specifies the size of the matrix and the number of channels to operate on.

MeaningValue

A 3×3 matrix operating on RGB values."3 3 3"

A 3×4 matrix operating on RGB values.

Introduced in version 1.3.

"3 4 3"

A 4×4 matrix operating on RGBA values.

Introduced in version 1.3.

"4 4 4"
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MeaningValue

A 4×5 matrix operating on RGBA values.

Introduced in version 1.3.

"4 5 4"

A 4×4 matrix operating on RGB values. If you use this option,

the bottom row of the matrix should be [0 0 0 1].

This option is valid only if the version attribute of the Process-

List element is "1.2". For versions 1.3 and later, use "3 4 3"

instead.

"4 4 3"

Example

3x3 Matrix Operating on RGB Values

<ProcessList id="af6a6c73-aae9-4be6-8051-a796bc480b1c" version="1.2">
<Matrix inBitDepth="32f" outBitDepth="32f">

<Array dim="3 3 3">
0.7841929793 0.0904410034 0.1253670007
0.0445200019 1.0391299725 -0.0836500004
0.0358299986 -0.3302420080 1.2944129705

</Array>
</Matrix>

</ProcessList>

3x4 Matrix Operating on RGB Values

<ProcessList id="53d366de-e200-476f-b3fd-ed1ca7044197" version="1.3">
<Matrix inBitDepth="32f" outBitDepth="10i">

<Array dim="3 4 3">
499.99996948 0.00000000 0.00000000 94.99999237
0.00000000 499.99996948 0.00000000 94.99999237
0.00000000 0.00000000 499.99996948 94.99999237

</Array>
</Matrix>

</ProcessList>

See Also

■ Array (LUT1D) (page 1198)

■ Array (LUT3D) (page 1199)

Range

The Range element maps the input domain to the output range by scaling and offsetting values.

If a minInValue is present, then minOutValue must also be present and the result is clamped at the low end.
Similarly, if maxInValue is present, then maxOutValue must also be present and the result is clamped at the
high end. If none of minInValue, minOutValue, maxInValue, or maxOutValue are present, then the Range
operator performs only bit-depth conversion.

The scaling of minInValue and maxInValue depends on the input bit-depth, and the scaling of minOutValue
and maxOutValue depends the output bit-depth.
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If both minimum and maximum values are specified, then the formula for Range is:

If only minimum values are specified, the formula is:

If only maximum values are specified, the formula is:

Where:

Contains

■ Description (page 1193). Optional, any number.

■ minInValue (page 1206). Optional, no more than one.

■ minOutValue (page 1207). Optional, no more than one.

■ maxInValue (page 1206). Optional, no more than one.

■ maxOutValue (page 1207). Optional, no more than one.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

Example

<ProcessList id="7f5b1560-fec4-4603-aa8d-c55bf5e22280" version="1.2">
<Description>10-bit full range to SMPTE (legal) range.</Description>
<InputDescriptor>generic RGB</InputDescriptor>
<OutputDescriptor>generic RGB</OutputDescriptor>
<Range inBitDepth="10i" outBitDepth="10i">

<minInValue> 0.0000</minInValue>
<maxInValue>1023.0000</maxInValue>
<minOutValue> 64.0000</minOutValue>
<maxOutValue>940.0000</maxOutValue>

</Range>
</ProcessList>
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minInValue

The minValue element specifies the minimum input value for a Range element.

Contains

■ A single numeric value used for all channels.

Contained By

■ Range (page 1204)

Attributes

None.

Example

<ProcessList id="7f5b1560-fec4-4603-aa8d-c55bf5e22280" version="1.2">
<Description>10-bit full range to SMPTE (legal) range.</Description>
<InputDescriptor>generic RGB</InputDescriptor>
<OutputDescriptor>generic RGB</OutputDescriptor>
<Range inBitDepth="10i" outBitDepth="10i">

<minInValue>  0.0000</minInValue>
<maxInValue>1023.0000</maxInValue>
<minOutValue> 64.0000</minOutValue>
<maxOutValue>940.0000</maxOutValue>

</Range>
</ProcessList>

maxInValue

The maxInValue element specifies the maximum input value for a Range element.

Contains

■ A single numeric value used for all channels.

Contained By

■ Range (page 1204)

Attributes

None.

Example

<ProcessList id="7f5b1560-fec4-4603-aa8d-c55bf5e22280" version="1.2">
<Description>10-bit full range to SMPTE (legal) range.</Description>
<InputDescriptor>generic RGB</InputDescriptor>
<OutputDescriptor>generic RGB</OutputDescriptor>
<Range inBitDepth="10i" outBitDepth="10i">

<minInValue> 0.0000</minInValue>
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<maxInValue>1023.0000</maxInValue>
<minOutValue> 64.0000</minOutValue>
<maxOutValue>940.0000</maxOutValue>

</Range>
</ProcessList>

minOutValue

The minOutValue element specifies the minimum output value for a Range element.

Contains

■ A single numeric value used for all channels.

Contained By

■ Range (page 1204)

Attributes

None.

Example

<ProcessList id="7f5b1560-fec4-4603-aa8d-c55bf5e22280" version="1.2">
<Description>10-bit full range to SMPTE (legal) range.</Description>
<InputDescriptor>generic RGB</InputDescriptor>
<OutputDescriptor>generic RGB</OutputDescriptor>
<Range inBitDepth="10i" outBitDepth="10i">

<minInValue> 0.0000</minInValue>
<maxInValue>1023.0000</maxInValue>
<minOutValue> 64.0000</minOutValue>
<maxOutValue>940.0000</maxOutValue>

</Range>
</ProcessList>

maxOutValue

The maxOutValue element specifies the maximum output value for a Range element.

Contains

■ A single numeric value used for all channels.

Contained By

■ Range (page 1204)

Attributes

None.
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Example

<ProcessList id="7f5b1560-fec4-4603-aa8d-c55bf5e22280" version="1.2">
<Description>10-bit full range to SMPTE (legal) range.</Description>
<InputDescriptor>generic RGB</InputDescriptor>
<OutputDescriptor>generic RGB</OutputDescriptor>
<Range inBitDepth="10i" outBitDepth="10i">

<minInValue> 0.0000</minInValue>
<maxInValue>1023.0000</maxInValue>
<minOutValue> 64.0000</minOutValue>
<maxOutValue>940.0000</maxOutValue>

</Range>
</ProcessList>

Gamma

The Gamma element applies a gamma correction to color values.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.2.

Contains

■ Description (page 1193). Optional, any number.

■ GammaParams (page 1210). Required, maximum three total.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

style Specifies the type of power law curve. Required.

NOTE The following equations assume that the input and output bit-depths are floating-point. For integers, the
values are normalized to [0.0, 1.0]. In other words, the gamma and offset values stored in the CTF file do not
depend on the input and output bit depths.

MeaningValue

Applies the power law with the gamma value specified in the GammaParams element. The GammaParams

element must not have an offset attribute.

"basicFwd"
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MeaningValue

Applies the power law with the inverse of gamma value. The GammaParams element must not have an

offset attribute.

"basicRev"

Applies a function that has a linear segment near the origin (black) and a power-law segment at higher values.

At the junction, the curve is continuous in noth value and tangent. This type of curve is used in the Rec.

709, sRGB, and CIE L* equations.

The GammaParams element must have an offset attribute.

"moncurve-

Fwd"

Applies a function that has a linear segment near the origin (black) and an inverse power-law segment at

higher values. The GammaParams element must have an offset attribute.

"mon-

curveRev"

Example

Without Offset

<ProcessList id="9e999646-3e76-4374-814c-e4c46c6438de" version="1.2">
</Matrix>
<Gamma inBitDepth="32f" outBitDepth="12i" style="basicRev">

<GammaParams gamma="2.400000000000000" />
</Gamma>

</ProcessList>

With Offset

<ProcessList id="1b86aac2-1fdb-4dd8-bc6b-54f3551b9bd4" version="1.2">
<Gamma inBitDepth="32f" outBitDepth="32f" style="moncurveFwd">

<GammaParams gamma="2.600000000000000" offset="0.050000" />
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</Gamma>
</ProcessList>

GammaParams

The GammaParams element defines the gamma value and optional offset for a Gamma element.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.2.

Contains

No content.

Contained By

■ Gamma (page 1208)

Attributes

channel The color channel to apply gamma correction to. Possible values are "R", "G", and "B". Optional.

If this attribute is not specified, the gamma correction is applied to all channels.

gamma  The power value to use. Valid values range from 0.1 to 10.0 inclusive. Required.

offset The offset to use. Valid values range from 10–6 to 0.9 inclusive. Optional.

If it is used, the Gamma element's style attribute should be set to "moncurveFwd" or "moncurveRev".
Othewise, the style attribuute should be "basicFwd" or "basicRev".

Example

Without Offset

<ProcessList id="9e999646-3e76-4374-814c-e4c46c6438de" version="1.2">
</Matrix>
<Gamma inBitDepth="32f" outBitDepth="12i" style="basicRev">

<GammaParams gamma="2.400000000000000" />
</Gamma>

</ProcessList>

With Offset

<ProcessList id="1b86aac2-1fdb-4dd8-bc6b-54f3551b9bd4" version="1.2">
<Gamma inBitDepth="32f" outBitDepth="32f" style="moncurveFwd">

<GammaParams gamma="2.600000000000000" offset="0.050000" />
</Gamma>

</ProcessList>

Separate Channels

<ProcessList id="id">
<Gamma inBitDepth="32f" outBitDepth="10i" style="basicRev">
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<GammaParams channel="R" gamma="2.4" />
        <GammaParams channel="G" gamma="2.35" />
        <GammaParams channel="B" gamma="2.2" />

</Gamma>
</ProcessList>

ExposureContrast

The ExposureContrast element simulates adjusting the exposure of an image, and also modifies the contrast
between light and dark colors.

It is an Autodesk extension to the Academy/ASC XML color transform format.

If a color transform is used for display, then depending on the application users can still adjust the exposure
and contrast interactively as long as the CTF file contains at least one ExposureContrast element with
DynamicParameter sub-elements. In this case, the corresponding parameter values defined in the ECParams
sub-element are ignored for display only, and instead the values set in the application are applied at each
point in the transform chain that an ExposureContrast element with DynamicParameter sub-elements
occurs.

Introduced

Version 1.2.

Contains

■ Description (page 1193). Optional, any number.

■ ECParams (page 1212). Required, one only.

■ DynamicParameter (page 1223). Optional, up to 3. Each param attribute must be set to a different value.

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

style  Declares the input data type. Required.

NOTE The following equations assume that the input and output bit-depths are floating-point. For integers, the
values are normalized to [0.0, 1.0]. In other words, the exposure offset, contrast level, and pivot values stored in
the CTF file do not depend on the input and output bit depths.

MeaningValue

"linear"

"video"
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MeaningValue

"log"

Example

<ProcessList id="561c5aba-8709-477c-8211-7ec4a6fe8820">
<ExposureContrast inBitDepth="16f" outBitDepth="32f" style="linear">

<ECParams exposure="0.65" contrast="1.2" pivot="1" />
<DynamicParameter param="EXPOSURE" />
<DynamicParameter param="CONTRAST" />

</ExposureContrast>
</ProcessList>

ECParams

The ECParams element specifies the parameters for an ExposureContrast element.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.2.

Contains

No content.

Contained By

■ ExposureContrast (page 1211)

Attributes

exposure A single decimal value representing the exposure offset in stops. A value of 0.0 corresponds to no
exposure offset. Required.

contrast A single decimal value representing the contrast level. A value of 1.0 corresponds to no contrast
adjustment. Required.

pivot A single decimal value representing the color value used as a pivot for adjusting contrast. A value of
0.18 will pivot around mid-gray. Required.

Example

<ProcessList id="561c5aba-8709-477c-8211-7ec4a6fe8820">
<ExposureContrast inBitDepth="16f" outBitDepth="32f" style="linear">

<ECParams exposure="0.65" contrast="1.2" pivot="1" />
<DynamicParameter param="EXPOSURE" />
<DynamicParameter param="CONTRAST" />

</ExposureContrast>
</ProcessList>
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Log

The Log operator applies a logarithmic or anti-logarithmic function to convert between linear and Cineon-style
encodings.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

■ Description (page 1193). Optional, any number.

■ LogParams (page 1214). Required if the style attribute is "logToLin" or "linToLog". There should be one
occurence for values applied to all RGB channels, or three occurences for different values applied to R,
G, and B separately.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

style  Specifies the formula to use for the conversion. Required.

NOTE The following equations assume that the input and output bit-depths are floating-point. For integers, the
values are normalized to [0.0, 1.0]. In other words, the gamma, reference white, reference black, highlight, and
shadow values stored in the CTF file do not depend on the input and output bit depths.

In the following equations:

MeaningValue

"log10"

"log2"
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MeaningValue

"antiLog10"

"antiLog2"

"logToLin"

"linToLog"

Example

All Channels

<ProcessList id="19510ea6-69a0-4d3d-bc75-d0b36d458f62" name="Log op 1"
version="1.3">

<Log inBitDepth="16f" outBitDepth="12i" style="linToLog">
<LogParams gamma="0.6" refWhite="685" refBlack="95" highlight="1.0"

shadow="0.0005"/>
</Log>

</ProcessList>

Separate Channels

<ProcessList id="19510ea6-69a0-4d3d-bc75-d0b36d458f62" name="Log op 1"
version="1.3">

<Log inBitDepth="16f" outBitDepth="12i" style="linToLog">
<LogParams channel="R" gamma="0.5" refWhite="685" refBlack="95"

highlight="1.0" shadow="0.0005"/>
<LogParams channel="G" gamma="0.6" refWhite="685" refBlack="95"

highlight="1.0" shadow="0.0005"/>
<LogParams channel="B" gamma="0.65" refWhite="685" refBlack="95"

highlight="1.0" shadow="0.0005"/>
</Log>

</ProcessList>

LogParams

The LogParams element defines the parameter values used by a Log element.

It is an Autodesk extension to the Academy/ASC XML color transform format.
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Introduced

Version 1.3.

Contains

No content.

Contained By

Log (page 1213)

Attributes

channel Specifies the channel to apply the parameter values to. Possible values are "R", "G", and "B".

Optional. If it is omitted, the values are applied to each of the RGB channles.

gamma Combined film and video gamma (contrast in log space). A typical value is 0.6.

refWhite Value in log space that maps to highlight in linear space. Specified on a 10-bit scale (e.g. 685 is
typical).

refBlack Value in log space that maps to shadow in linear space. Specified on a 10-bit scale (e.g. 95 is typical).

highlight Value in linear space that maps to refWhite in log space. Specified on a floating-point scale (e.g.
1.0 is typical). Note that log values above refWhite are not clamped and will map to values above highlight
in linear space.

shadow Value in linear space that maps to refBlack in log space. Specified on a floating-point scale (e.g. 0.0
is typical). Note that log values below refBlack are not clamped and will map to values below shadow in
linear space (possibly even negative).

Example

All Channels

<ProcessList id="19510ea6-69a0-4d3d-bc75-d0b36d458f62" name="Log op 1"
version="1.3">

<Log inBitDepth="16f" outBitDepth="12i" style="linToLog">
<LogParams gamma="0.6" refWhite="685" refBlack="95" highlight="1.0" 

shadow="0.0005"/>
</Log>

</ProcessList>

Separate Channels

<ProcessList id="19510ea6-69a0-4d3d-bc75-d0b36d458f62" name="Log op 1"
version="1.3">

<Log inBitDepth="16f" outBitDepth="12i" style="linToLog">
<LogParams channel="R" gamma="0.5" refWhite="685" refBlack="95" 

highlight="1.0" shadow="0.0005"/>
        <LogParams channel="G" gamma="0.6" refWhite="685" refBlack="95" 
highlight="1.0" shadow="0.0005"/>
        <LogParams channel="B" gamma="0.65" refWhite="685" refBlack="95" 
highlight="1.0" shadow="0.0005"/>

</Log>
</ProcessList>
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ASC_CDL

The ASC_CDL operator represents a color transform in the American Society of Cinematographers' Color
Decision List format (*.ccc or *.cdl).

An ASC CDL transform consists of a slope-offset-power (SOP) function applied individually to each of the
RGB channels, followed by a saturation function applied equally to all channels.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

■ Description (page 1193). Optional, any number.

■ SOPNode (page 1217). Optional, no more than one. If absent, no slope-offset-power function is applied.

■ SatNode (page 1220). Optional, no more than one. If absent, no saturation function is applied.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

■ ProcessList (page 1189)

Attributes

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

style Determines the formula applied by the operator.

NOTE The equations assume that the input and output bit-depths are floating-point. For integers, the values are
normalized to [0.0, 1.0]. In other words, the slope, offset, power, and saturation values stored in the CTF file do
not depend on the input and output bit depths.

NOTE The luma weights assume that the image uses the primaries specified by Rec. 709 (for example, HD and
sRGB).

MeaningValue

"v1.2_Fwd"

The inverse of "v1.2_Fwd"."v1.2_Rev"

The same as "v1.2_Fwd", but without the two clamp functions. If"noClampFwd"
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MeaningValue

then no power function is applied.

The inverse of "noClampFwd"."noClampRev"

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

SOPNode

The SOPNode element defines the slope-offset-power function of an ASC CDL color transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

■ Slope (page 1218). Optional, no more than one. If absent, the default is 1.0 for all channels, that is, no gain
is applied.

■ Offset (page 1219). Optional, no more than one. If absent, the default is 0.0 for all channels, that is, no
offset is applied.

■ Power (page 1219). Optional, no more than one. If absent, the default is 1.0 for all channels, that is, no
gamma is applied.

Contained By

■ ASC_CDL (page 1216)

Attributes

None.
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Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

Slope

The Offset element contains the RGB slope values of the slope-offset-power function of an ASC CDL color
transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

Three decimal values representing the R, G, and B slope (gain) values.

Contained By

■ SOPNode (page 1217)

Attributes

None.

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000  1.000000  0.900000</Slope>
<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>
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Offset

The Offset element contains the RGB offset values of the slope-offset-power function of an ASC CDL color
transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

Three decimal values representing the R, G, and B offset values.

Contained By

■ SOPNode (page 1217)

Attributes

None.

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
<Offset>-0.030000  -0.020000  0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

Power

The Offset element contains the RGB power values of the slope-offset-power function of an ASC CDL color
transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

Three decimal values representing the R, G, and B power (gamma) values.
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Contained By

■ SOPNode (page 1217)

Attributes

None.

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000  1.000000  1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

SatNode

The SatNode element defines the saturation function of an ASC CDL color transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

■ Saturation (page 1221). Required, one only.

Contained By

■ ASC_CDL (page 1216)

Attributes

None.

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
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<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

Saturation

The Saturation element defines the value used by the saturation function of an ASC CDL color transform.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Introduced

Version 1.3.

Contains

A single decimal value applied to all color channels.

Contained By

■ SatNode (page 1220)

Attributes

None.

Example

<ProcessList version="1.3" id="7b42c76a-8c7a-4142-8b6e-1c467084075a">
<ASC_CDL id="cc01234" inBitDepth="16f" outBitDepth="16f" style="v1.2_Fwd">

<Description>scene 1 exterior look</Description>
<SOPNode>

<Slope>1.000000 1.000000 0.900000</Slope>
<Offset>-0.030000 -0.020000 0.000000</Offset>
<Power>1.2500000 1.000000 1.000000</Power>

</SOPNode>
<SatNode>

<Saturation>1.700000</Saturation>
</SatNode>

</ASC_CDL>
</ProcessList>

Reference

The Reference element refers to another CTF file by path or by alias. The external file is imported into the
corresponding location of the ProcessList.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Autodesk CTF File Format Version 1.3 | 1221



Introduced

Version 1.2.

Contains

■ Description (page 1193). Optional, any number.

■ DynamicParameter (page 1223). Optional, no more than one. The param attribute must be set to
"DEFAULT_LOOK".

Contained By

■ ProcessList (page 1189)

Attributes

It is necessary to specify either a path or an alias attribute, but not both.

id, name, bypass, inBitDepth, outBitDepth See Common Operator Attributes (page 1195).

Note that the values specified here override the values in the external file.

alias A short name for the path and file name of another CTF file. The alias must be defined in a Ref (page
1228) element in the SynColor configuration file (page 1224). By default, the following aliases are available, and
can be changed from the user interface of some applications that support Autodesk Color Management:
■ The "graphicsMonitor" alias should refer to the appropriate transform for display on the workstation

monitor.

■ The "broadcastMonitor" alias should refer to the appropriate transform for display on the broadcast
monitor.

■ The "currentMonitor" alias gets resolved to either the value of the "graphicsMonitor" alias or the
value of the "broadcastMonitor" alias depending on where an image is displayed.

■ The "defaultLook" alias should refer to the transform that re-creates the look used on set.

You can create additional aliases as desired.

path The path and file name of another CTF file. The path is relative to basePath if that attribute is defined;
otherwise, the path is absolute.

basePath  The base location for a relative path.

MeaningValue

The installation location of the color transforms supplied with

Autodesk applications. The exact path is resolved based on

Autodesk

the version of Autodesk Color Management used by the run-

ning application.

The shared location for custom color transforms for any ap-

plication that uses Autodesk Color Management. The location

Shared

is set in the SharedHome (page 1226) of the SynColor configur-

ation file (page 1224).
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Example

<ProcessList id="561c5aba-8709-477c-8211-7ec4a6fe8820">
<Reference basePath="Autodesk" inBitDepth="32f" outBitDepth="32f"

path="RRT+ODT/ACES_to_CIE-XYZ_v0.1.1.ctf" />
<Reference alias="graphicsMonitor" inBitDepth="32f" outBitDepth="8i" />

<Reference inBitDepth="8i" outBitDepth="8i" path="lut1d_example.xml"
basePath="Shared" />

<Reference inBitDepth="8i" outBitDepth="8i" path="/zeus/toto/toto.xml"
/>
</ProcessList>

DynamicParameter

The DynamicParameter element signals to a compatible application that a parameter is dynamic. If the
transform is used for display, the parameter value defined in the CTF file is ignored and the value set in the
application is used instead.

It is an Autodesk extension to the Academy/ASC XML color transform format.

Updated

Version 1.3.

Contains

No content.

Contained By

■ Any operator element (LOOK_SWITCH)

■ ExposureContrast (page 1211) (EXPOSURE, CONTRAST).

Attributes

param  Specifies the parameter that will be overridden by the application when the CTF file is applied to
the display.

MeaningValue

Allows the exposure value to be overridden when the transform is used for display in applications that support

this ability.

This value can be used only when the DynamicParameter element is a child of an ExposureContrast (page

1211) element.

"EXPOSURE"

Allows the contrast value to be overridden when the transform is used for display in applications that support

this ability.

This value can be used only when the DynamicParameter element is a child of an ExposureContrast (page

1211) element.

"CONTRAST"
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MeaningValue

Allows the operator's effect to be toggled on and off when the transform is used for display in applications

that support this ability.

This can be used in conjunction with the bypass (page 1195) attribute of the parent element to create operators

that will never affect values rendered to file but that can still be toggled on and off for display.

"LOOK_SWITCH"

Introduced in version 1.3.

Example

<ProcessList id="561c5aba-8709-477c-8211-7ec4a6fe8820">
<ExposureContrast inBitDepth="16f" outBitDepth="16f" style="linear">

<ECParams contrast="1.0000" exposure="0.0000" pivot="0.1800" />
<DynamicParameter param="EXPOSURE" /><DynamicParameter 

param="CONTRAST" />
</ExposureContrast>
<Reference basePath="Autodesk" inBitDepth="16f" outBitDepth="16f"

path="misc/default_look-ACESproxy.ctf" bypass="true">
<DynamicParameter param="LOOK_SWITCH" />

</Reference>
<Reference basePath="Autodesk" inBitDepth="16f" outBitDepth="16f"

path="RRT+ODT/ACES_to_CIE-XYZ_v0.1.1.ctf" />
<Reference alias="currentMonitor" inBitDepth="16f" outBitDepth="10i" />

<</ProcessList>

Comments

You can include standard XML comments in CTF files.

However if you want the information to appear in the metadata panel of Autodesk applications, you can
use Description (page 1193) elements instead of comments.

XML comments begin with:

<!--

and end with:

-->

Comments cannot appear inside tags (between < and >). In addition, comments cannot be nested.

SynColor Configuration File
The SynColor configuration file is an XML file that controls how Autodesk Color Management works for
all applications on the same workstation.

Some applications might read this file only on start-up. You may need to restart the application after
modifying this file.

On Linux, the file path and name is /opt/Autodesk/Synergy/SynColor/<version>/synColorConfig.xml.

On Mac OS X, the file path and name is
/Applications/Autodesk/Synergy/SynColor/<version>/synColorConfig.xml.
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Anatomy of the SynColor Configuration File

This section shows a sample of a SynColor configuration file.

<?xml (page 1188) version="1.0" encoding="UTF-8"?>
<SynColorConfig (page 1225) version="1.0">

<SharedHome (page 1226)
dir="/opt/Autodesk/Synergy/SynColor/Shared/transforms"/>

<ReferenceTable (page 1227)>
<Ref (page 1228) alias="broadcastMonitor"

path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>

<Ref alias="graphicsMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/Eizo/CIE-XYZ_to_CG245W.ctf"
/>
</ReferenceTable>

</SynColorConfig>

SynColorConfig

The SynColorConfig element is the root element of the SynColor configuration file.

Contains

In any order:
■ SharedHome (page 1226). Required, one only.

■ ReferenceTable (page 1227). Required, one only.

Contained By

■ no parent

Attributes

version  The version of the SynColor configuration file format.

Example

<?xml version="1.0" encoding="UTF-8"?>
<SynColorConfig version="1.0">

<SharedHome dir="/opt/Autodesk/Synergy/SynColor/Shared/transforms"/>
<ReferenceTable>

<Ref alias="broadcastMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>

<Ref alias="graphicsMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/Eizo/CIE-XYZ_to_CG245W.ctf"
/>
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</ReferenceTable>
</SynColorConfig>

AutoConfigure

The AutoConfigure element determines whether certain options get automatically configured when you
start an application that supports Autodesk Color Management.

Currently this works only for Autodesk Smoke on Mac OS X.

Contains

■ No content.

Contained By

■ SynColorConfig (page 1225)

Attributes

graphicsMonitor Uses the ICC profile set in your operating system's preferences as the graphicsMonitor
alias.

Example

<?xml version="1.0" encoding="UTF-8"?>
<SynColorConfig version="1.0">

<AutoConfigure graphicsMonitor="true" />
<SharedHome dir="/Applications/Autodesk/Synergy/SynColor/Shared/transforms"

/>
<ReferenceTable>

<Ref alias="broadcastMonitor"
path="/Applications/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/Applications/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>

<Ref alias="graphicsMonitor"
path="/Library/ColorSync/Profiles/Displays/Color
LCD-00000610-0000-9CCF-0000-0000042733C0.icc" />

</ReferenceTable>
</SynColorConfig>

SharedHome

The SharedHome element specifies the location of the Shared directory. This is a useful location for storing
your own custom transforms that can be used by other applications that use Autodesk Colour Management
installed on the same computer.

Some applications allow you to set this value in their preferences.

Contains

■ No content.
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Contained By

■ SynColorConfig (page 1225)

Attributes

dir  Full path to the shared directory. This can be on the local or a remote computer.

Example

<?xml version="1.0" encoding="UTF-8"?>
<SynColorConfig version="1.0">

<SharedHome dir="/opt/Autodesk/Synergy/SynColor/Shared/transforms"/>
<ReferenceTable>

<Ref alias="broadcastMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>

<Ref alias="graphicsMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/Eizo/CIE-XYZ_to_CG245W.ctf"
/>
</ReferenceTable>

</SynColorConfig>

ReferenceTable

The ReferenceTable element is a container for Ref elements defining aliases, or short names for CTF files.

Contains

■ Ref (page 1228). Optional, any number.

However, if there are no Ref elements to define the following aliases, then some Autodesk-supplied
transforms will not work:
■ The graphicsMonitor alias should set to the appropriate transform for display on the workstation

monitor.

■ The broadcastMonitor alias should set to the appropriate transform for display on the broadcast
monitor.

■ The defaultLook alias should be set to the transform that you are using to re-create the look used
on set.

Users can define additional aliases for other transform files as they wish.

Contained By

■ SynColorConfig (page 1225)

Attributes

None.
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Example

<?xml version="1.0" encoding="UTF-8"?>
<SynColorConfig version="1.0">

<SharedHome dir="/opt/Autodesk/Synergy/SynColor/Shared/transforms"/>
<ReferenceTable>

<Ref alias="broadcastMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>

<Ref alias="graphicsMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/Eizo/CIE-XYZ_to_CG245W.ctf"
/>

</ReferenceTable>
</SynColorConfig>

Ref

The Ref element defines an alias for a CTF file so that it can be easily referenced in other CTF files.

Some applications allow users to set certain aliases, like graphicsMonitor, in their preferences.

When an alias is changed, references that use it might not get updated until the application is restarted.

Contains

■ No content.

Contained By

■ ReferenceTable (page 1227)

Attributes

alias  A unique name for the alias. Required.

path The path and file name of the corresponding CTF file. Required.

basePath  A base path that is prefixed to the path attribute value to fully resolve the file or location. Optional.

If this attribute is used, then the path attribute is interpreted as relative to the base path. Otherwise, the
path attribute is interpreted as an absolute path.

Example

<?xml version="1.0" encoding="UTF-8"?>
<SynColorConfig version="1.0">

<SharedHome dir="/opt/Autodesk/Synergy/SynColor/Shared/transforms"/>
<ReferenceTable>

<Ref alias="broadcastMonitor"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/display/broadcast/CIE-XYZ_to_HD-video.ctf"
/>

<Ref alias="defaultLook"
path="/opt/Autodesk/Synergy/SynColor/2013.3/transforms/misc/identity.ctf"
/>
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<Ref alias="graphicsMonitor" 
path="/opt/Autodesk/Synergy/SynColor/2013.1/transforms/display/Eizo/CIE-XYZ_to_CG245W.ctf"/>

</ReferenceTable>
</SynColorConfig>
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Artist Control Surfaces

Avid Artist Transport Control Surface Layout

NOTE To use the Avid ➤  Artist Transport, the EUCON utility must be running before launching Smoke on Mac.

Use the Avid Artist Transport to navigate the clips in the timeline, as well as to mark the clips and the
timeline. Use the numeric keypad just like you would a regular keypad.

The Artist Transport has two main components, the wheel and its buttons, and the soft keys, all of which
can be reassigned using the EUCON utility.

Wheel Controls

There are two sets of wheel controls. Switch between the sets using the Shift key on the Artist Transport.

Standard mapping

25
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Alternate mapping accessed using the Shift key.

Soft Keys Controls

There are two sets of Soft Keys. Switch between sets using the Shift key on the Artist Transport.

Standard mapping

Alternate mapping accessed using the Shift key.
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Avid Artist Color Control Surface Layout

NOTE To use the Avid ➤  Artist Color, the EUCON utility must be running before launching Smoke on Mac.

Use the Avid Artist Color with Smoke on Mac with to navigate or control the timeline, softFXs, or control
editors such as the Colour Corrector or the Colour Warper.

Timeline Navigation and TimelineFX

Use the Artist Color to jog, zoom, and navigate timelines and clips.

You can also access timelineFX using the Artist Color. Video timelineFX are available when a video segment
is selected. Audio timelineFX are available when an audio segment is selected.

The displays located at the top of the Artist Color only display six timelineFX at a time. Use the Page buttons
to display additional timelineFX.

To display additional timelineFX:

1 Use the Page buttons and navigate the available timelineFX.

(a) Page buttons

To enable a softFX:

1 Enable the NAV and Shift keys on the Artist Color.

2 Lightly touch the softFX’s corresponding Soft Knob.

To mute a softFX:

1 Enable the NAV and Shift keys on the Artist Color.

2 Lightly touch the softFX’s corresponding Soft Knob.

To delete a softFX:

1 Enable the NAV and Shift keys on the Artist Color.

2 Press the softFX’s corresponding Soft Knob.

To edit a softFX from the EditDesk:

1 Enable the NAV key on the Artist Color.

2 Lightly touch the softFX’s corresponding Soft Knob.

3 Disable the NAV key on the Artist Color, and then edit the softFX.
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To enter a softFX’s editor:

1 Enable the NAV key on the Artist Color.

2 Press the softFX’s Soft Knob.

Main Timeline navigation controls

Alternate timeline navigation controls accessed using the Shift key.

Use the CG to cut and the associated PG buttons to paste timelineFX form one selected segment to another
selected segment. Only the active softFX is copied. Shift key + CG key to clear out the stored softFX.

To cut and paste timelineFX between segments:

1 Select the timeline segment with the softFX to copy.

2 Press one of the Copy Grade keys, identified as CG1 through CG4.

3 Select the timeline to which you want to apply the copied softFX.

4 Press the matching Paste Grade key to paste the softFX, such as PG1 for a softFX stored in CG1.
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Source/Record Player Navigation

In the Source/Record Player, use the Artist Color to jog each Player. Use it mark footage from the Source
player, and then insert it into the Record player.

Triptych Player Navigation

When in the Triptych Player, use the Artist Color to jog each panel using one of the assigned trackwheels.

Colour Corrector

From the Colour Warper editor, click Bank1 to access the Colour Corrector editor.
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Colour Warper

From the Colour Corrector editor, click Bank2 to access the Colour Warper editor.

Use the Page buttons to display additional options in the six OLED viewers located at the top of the Artist
Color control surface.

(a) Page buttons
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Main Colour Warper controls

Alternate Colour Warper controls accessed using the Shift key.
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Smoke Keyboard Shortcuts

Following is a selection of the Smoke keyboard shortcuts based on the FCP 7 keyboard shortcut set.

You can also find keyboard shortcuts by Searching the Keyboard Shortcut Catalogue (page 1247).
Navigation

Smoke FCP 7 Keyboard ShortcutFunction

Shift - 1MediaHub

Shift - 2Conform

Shift - 3Timeline

Shift - 4Tools

Viewing Panel

Smoke FCP 7 Keyboard ShortcutFunction

Option - ~ (tilde)Thumbnail View

Option - 1Standard Player

Ctrl - EStandard Player Audio Desk

Option - 2Source/Sequence Player

Option - 3Triptych Player

Ctrl - ESCFull Screen Player

Option - 4Trim View

Workspace

Smoke FCP 7 Keyboard ShortcutFunction

1 - Up ArrowRight Side
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Smoke FCP 7 Keyboard ShortcutFunction

1 - Down ArrowTall

1 - Right ArrowDetails

1 - Left ArrowHidden

Timeline Navigation

Smoke FCP 7 Keyboard ShortcutFunction

Down ArrowNext Transition (Current Track)

Ctrl - Down ArrowNext Transition (All Versions/Tracks)

Up ArrowPrevious Transition (Current Track)

Ctrl - Up ArrowPrevious Transition (All Versions/Tracks)

Home (Fn - Left Arrow on keyboards without Home button)Go to Clip Start

End (Fn - Right Arrow on keyboards without End button)Go to Clip End

Shift - IGo to In Mark

Shift - OGo to Out Mark

Shift - Down ArrowNext Cue Mark

Shift - Up ArrowPrev Cue Mark

Command - Down ArrowNext Timeline FX (Current Track)

Command - Up ArrowPrevious Timeline FX (Current Track)

Command - +Zoom In

Command - - (minus)Zoom Out

Shift - ZFit Timeline to Contents

Shift - Alt - ZFit Timeline to Selection

Editing

Smoke FCP 7 Keyboard ShortcutFunction

Ctrl - VCut (Current Version/Track)

Ctrl - Shift - VCut (All Versions/Tracks)
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Smoke FCP 7 Keyboard ShortcutFunction

Shift - VCut Around Selection (Current Version/Track)

Option - Shift - VCut Around Selection (All Versions/Tracks)

Option - Ctrl - VRemove Cut (Match Frame Edit)

Shift - Command - TAdd Dissolve (All Versions/Tracks)

Command - TAdd Dissolve (Current Version/Track)

IMark In

OMark Out

XMark In/Out (Current Shot)

Shift - XSelect Between In-Out (Current Track)

Ctrl - XSelect Between In-Out (Current Version)

Shift - Ctrl - XSelect Between In-Out (All Versions)

Option - IClear In

Option - OClear Out

Option - XClear In-Out

MAdd Cue Mark

Option - MClear Cue Mark

F9Insert

F10Overwrite

F11Replace

Shift - RRipple

Option - F11Ripple Replace

Ctrl - F11Replace Media

ATimeline Select Mode

RTimeline Trim Mode

ETrim to Positioner
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Smoke FCP 7 Keyboard ShortcutFunction

Ctrl - ITrim To In Mark

Ctrl - OTrim To Out Mark

. (period)Trim 1 Frame Forward

, (comma)Trim 1 Frame Backward

Shift - . (period)Trim <n> Frames Forward

Shift - , (comma)Trim <n> Frames Backward

SSlip Shot

Shift - SSlide Keyframes

Shift - DSlide Cuts

DSlide

NSnap

ShiftInvert Snap during manipulation

OptionInvert Link during manipulation

OptionInvert Ripple during manipulation

Command - USub Clip

Ctrl - Shift - TABNew Version

Shift - TABNew Video Track

Shift - QNew Audio Track

Effects View Shortcuts

Smoke FCP 7 Keyboard ShortcutFunction

F1Front View

F2Back View

F3Matte View

F4Result View

Ctrl - ESCCFX Schematic View
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Smoke FCP 7 Keyboard ShortcutFunction

ESCSchematic View (All other tools with schematics)

Option - 11-Up View

Option - 22-Up View

Ctrl - CommandPan

Ctrl - AltZoom

Option - KPrevious Keyframe

Shift - KNext Keyframe

Action Shortcuts

Smoke FCP 7 Keyboard ShortcutFunction

Shift - SSelect

Shift - AAdd

Shift - DDelete Mode

Shift - WMimic Link

Shift - W - dragSchematic Autolink Mimic

Ctrl - NAdd Action Media Input

Option - Ctrl - clickReset Media Layer

Shift - drag"Kissing" Nodes

Option - Shift - dragReverse "Kiss"

Ctrl - Option - NToggle Navigator

Option - dragNavigator Pan

Animation Shortcuts

Smoke FCP 7 Keyboard ShortcutFunction

Ctrl - clickContext Menu (field)

Shift - clickAdd Channel to Selection
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Smoke FCP 7 Keyboard ShortcutFunction

Option - Shift - clickReset Channel (keep current value)

Playback Controls

Smoke FCP 7 Keyboard ShortcutFunction

SpacebarPlay-Stop

LPlay Forward

LPlay Forward Increase Speed

Shift - LPlay Forward Decrease Speed

KStop Playback

JPlay Backward

JPlay Backward Increase Speed

Shift - JPlay Backward Decrease Speed

General Shortcuts

Smoke FCP 7 Keyboard ShortcutFunction

Option - HKeyboard Shortcut dialog box

Command - , (comma)Preferences dialog box

Ctrl - WDisplay Tooltip

Command - QExit

Command - ZUndo

Command - RRedo

Ctrl - F1Help

NOTE When you press a keyboard shortcut, a white keyboard appears in the lower-right corner of the screen. If a keyboard
shortcut becomes stuck at any time, the white keyboard remains until you unstick the keyboard shortcut by pressing it. Click
the white keyboard to display the name of the problematic keyboard shortcut in the message bar.

Determining a Button's Current Keyboard Shortcut
You can determine the keyboard shortcut assigned to a button from anywhere within Smoke.
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To determine the keyboard shortcut for a button:

1 If auto display of tooltips is enabled in the Preferences, hover over the button for which you want to
determine the assigned keyboard shortcut. If you have disabled the auto display of tooltips, press and
hold Ctrl+W and hover over the button.

If a keyboard shortcut exists for the button, it is displayed in the tooltip.

(a) Current keyboard shortcut message

Accessing the Keyboard Shortcut Editor
Use the Keyboard Shortcut Editor to view, modify, and create keyboard shortcuts.

To access the Keyboard Shortcut editor:

1 From the Autodesk Smoke menu, select Keyboard Shortcuts.

(a) Keyboard Shortcut Catalogue (b) Keyboard Shortcut Manager (c) Search Field (d) Keystroke Editor
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Keyboard Shortcut Catalogue

A catalogue of keyboard shortcuts is maintained for every user. If the user profile was created in the default
home directory, the catalogue is found in /usr/discreet/user/editing/<user_name>/keyboard shortcut. If the user
profile was created elsewhere, the catalogue is found in <user home directory>/keyboard shortcut. The keyboard
shortcuts in the keyboard shortcut catalogue are stored in the following formats:
■ default.<component>.butt.keyboard shortcut

■ default.<component>.func.keyboard shortcut

■ factory.<component>.butt.keyboard shortcut

■ factory.<component>.func.keyboard shortcut

Means:Where:

The module containing the keyboard shortcut.<component>

The keystroke that is currently in use.default

The Autodesk factory default.factory

A button keyboard shortcut.butt

A non-button function keyboard shortcut.func

User-modified keyboard shortcuts are stored in a separate file: default.<component>.butt.keyboard shortcut.user.
This file is loaded after the system keyboard shortcut file, default.<component>.butt.keyboard shortcut. Entries
in the user-modified keyboard shortcut file replace the system keyboard shortcut entries, with the exception
of cloned keyboard shortcuts, which are duplicated.

Selecting Your Keyboard Type

In the Keyboard Shortcut Editor you can select the type of keyboard you are using to take advantage of extra
keys on certain keyboards.

You have the choice of the following keyboards:

When you select your keyboard, the onscreen keyboard is changed to reflect your choice, and entries in the
Keyboard Shortcut Catalogue are updated accordingly.

NOTE If a keyboard shortcut is set on a key not available for the keyboard selected, the Keyboard Shortcut Catalogue
displays the entry in black.
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Searching the Keyboard Shortcut Catalogue
You can search the Keyboard Shortcut catalogue to find keyboard shortcuts whose description match your
search criteria.

To search the Keyboard Shortcuts catalogue:

1 In the Search field, enter the characters you want to search for.

2 Click Search.

The catalogue is searched and the keyboard shortcuts whose description match your search criteria are
highlighted.

3 If more than one keyboard shortcut is highlighted, use the previous and next buttons located next to
the Search field to move through the list of search results.

Changing Keyboard Shortcuts
The Keyboard Shortcut catalogue shows all keyboard shortcuts for your product. Keyboard shortcuts appear
in yellow text or in white text in the list:
■ Yellow text: identifies shortcuts that are used everywhere in your product.

■ White text: identifies keyboard shortcuts that are specific to the area you are in.

To edit a keyboard shortcut:

1 From the area where you want to use the new keyboard shortcut, open the Keyboard Shortcut Editor.

2 Select the keyboard shortcut in the Keyboard Shortcut catalogue.

The keystroke sequence and its description appear in the Keystroke Editor fields. If you select a
map-to-button keyboard shortcut, the word “Yes” appears in the Map-to-Button field.

3 Click Clear in the Keyboard Shortcut Manager area to clear the existing keystroke sequence.

4 Enter the new keystroke sequence by clicking keys in the Keystroke Editor or by pressing keys on your
computer's keyboard.

5 Click Set in the Keyboard Shortcut Manager area.

6 Click Save to save the changes to the current user's Keyboard Shortcut catalogue.

The edited keyboard shortcut is marked in the catalogue with a “Y” to show that it is user-modified.

NOTE If you enter a keystroke sequence that is already in use, an error message is displayed.
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Cloning Keyboard Shortcuts

You can use Clone to map multiple keystroke sequences to a single button, field, or function using the
regular system keyboard. This feature does not provide macro functionality.

To clone a button, field, or function:

1 Select a button, field, or function in the Keyboard Shortcut catalogue.

2 Click Clone in the Keyboard Shortcut Manager area to create a second entry for this button, field, or
function.

A “Y” appears in the Keyboard Shortcut catalogue indicating that the cloned keyboard shortcut is
user-modified.

3 Activate a control or enter a keystroke sequence on the system keyboard).

NOTE You must enter a keystroke sequence that is not in use. Otherwise, an error message appears.

4 Click Set in the Keyboard Shortcut Manager area of the Keyboard Shortcut Editor.

5 Click Save to save the changes to the current user catalogue.

Editing Local Keyboard Shortcuts

Almost every module has its own catalogue of keyboard shortcuts. The keyboard shortcuts listed in white
are local keyboard shortcuts, and can be customized to suit your needs without affecting other modules.
Modified keyboard shortcuts are saved as a user preference.

To edit a local keyboard shortcut:

1 In the module where you want to use the new keyboard shortcuts, access the Keyboard Shortcut Editor
(Alt+Ctrl+F8).

2 Select the keyboard shortcut in the Keyboard Shortcut catalogue.

The keystroke sequence and its description appear in the Keystroke Editor fields. If you select a
map-to-button keyboard shortcut, the word “Yes” appears in the Map-to-Button field.

3 Click Clear in the Keyboard Shortcut Manager area to clear the existing keystroke sequence.

4 Enter the new keystroke sequence by clicking keys in the Keystroke Editor or by pressing keys on your
computer's keyboard.

5 Click Set in the Keyboard Shortcut Manager area.

6 Click Save to save the changes to the current user's Keyboard Shortcut catalogue.

The edited keyboard shortcut is marked in the catalogue with a “Y” to show that it is user-modified.

NOTE If you enter a keystroke sequence that is already in use, an error message is displayed.
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Editing Global and Shared Keyboard Shortcuts

You can edit global and shared keyboard shortcuts wherever the Keyboard Shortcut Editor is available. When
you access the Keyboard Shortcut Editor through the Preferences menu, click Global or Shared to view all
current global or shared keyboard shortcuts, respectively. In this menu, the names of these keys appear in
yellow.

In other modules, the global and shared keyboard shortcuts appear in yellow in the Keyboard Shortcut
catalogue. When changing a global or shared keyboard shortcut, you are warned that the change will affect
all modules, and are asked to confirm the action.

Mapping a Button to a Keyboard Shortcuts
You can create new map-to-button keyboard shortcut. New keyboard shortcuts are saved as a user preference.

To map a button to a keyboard shortcut:

1 With the Keyboard Shortcut Editor open, click the menu button for which you want to create the
keyboard shortcut.

NOTE If the button you want to click is hidden by the Keyboard Shortcut Editor, click the Hide Panel button.

If the menu button you selected is a map-to-button keyboard shortcut, Yes appears in the Map to
Button field, and the name of the menu button appears in the Description field.

2 Enter the new keystroke sequence by clicking keys in the Keystroke Editor, your computer's keyboard,
or the keys on your pen tablet. The new keystroke appears in the Keystroke field.

3 If the menu button is a field, you can set a default value type and increment in the Value Type box
and Increment field.

4 If the menu button is an option box, you can enable Cycle Pop-up to allow your new keyboard shortcut
to cycle through the options each time it is pressed.

5 Click Set.

6 Click Save to save the changes to the current user's Keyboard Shortcut catalogue.
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Keyboard Shortcut Editor Menu Settings
Keyboard Shortcut Manager Area

Clear button Clears the contents of the Keystroke field in the Keystroke Editor before you enter a new
keystroke sequence.

Set button Sets the contents of the Keystroke field.

Reset button Resets the current local keyboard shortcuts to their default settings.

Reload button Reloads the current catalogue of keyboard shortcuts. This is useful if you made a change but
have not yet saved it, and you wish to discard the change.

Save button Saves the current keyboard shortcuts to the Keyboard Shortcut Catalogue of the current user.

Reset All button Resets all keyboard shortcuts to their default settings.

Reload All button Reloads all keyboard shortcuts from the Keyboard Shortcut Catalogue of the current user.

Save All button Saves all keyboard shortcuts to the Keyboard Shortcut Catalogue of the current user.

Hide Panel button Hides the Keyboard Shortcut Editor panel when you want to select a menu button hidden
by the panel. The panel reappears when you select a menu button. Alternatively, click in an open area to
return to the Keyboard Shortcut Editor panel without selecting anything.

NOTE This button is only available when accessing the Keyboard Shortcut Editor from a module.

Clone button Assigns a regular keyboard keystroke sequence to a single button, field, or function.

Keystroke Editor Section

Keystroke field Displays the keystroke sequence. Click keys in the Keystroke Editor or the keyboard to enter
a new sequence.

Description field Displays the name of the selected menu button. Non-editable.
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Map to Button field Displays whether the selected keyboard shortcut is a map-to-button hot key (a keystroke
sequence that is mapped to a button or a field on the current menu). Non-editable.

Value Type box Select a value type for the selected menu button.

Integer Increment field Displays the integer increment for the selected value type. Editable.

Float Increment field Displays the float increment for the selected value type. Editable.

Cycle Pop-up button Enable to allow the new keyboard shortcut to cycle through options for the selected
box.

Search Section

Search field Displays the search criteria for the Hot Key Catalogue. Editable.

Search button Performs a search based on the characters in the Search field.

Previous button Selects the previous highlighted item in the search results.

Next button Selects the next highlighted item in the search results.

Miscellaneous Settings

User field Displays the current user that hot keys are saved for. Non-editable.

Keyboard Type box Select the type of keyboard being used to take advantage of extra keys on certain
keyboards. See Selecting Your Keyboard Type (page 1246).

Close button Click to close the Keyboard Shortcut Editor, and return to your previous view.
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Setting Smoke Preferences

Customize your working environment using preferences.

To open the Preferences dialog box:

1 Select Autodesk Smoke > Preferences.

2 Select the category of preferences you want to modify. The dialog box opens to the tab with the category of preferences
you selected.

Audio Preferences
Player

Monitor Sync box Indicates which monitor will have audio sync when you play back a clip (the broadcast
monitor or the high-resolution monitor).

Broadcast Delay field Displays the number of frames (-30.00 to 30.00) to delay the audio signal when
syncing to the broadcast monitor. Editable.

Hi-Res Delay field Displays the number of frames (-30.00 to 30.00) to delay the audio signal when syncing
to the graphics monitor. Editable.

Auto Fade field Displays the amount of time (0 to 10 ms) that a fade is added to the start and end of each
audio segment. Use this setting to avoid audible clicks between audio sources. Editable.

Meters

Meter Range field Displays the overall scale for the fader meters. Editable.

Meter Green field Displays the green meter range. Editable.

Meter Yellow field Displays the yellow meter range. Editable.

Meter Step field Displays the step value for the meters. Enter a lower value to view a more detailed meter.

Meter Units box Select whether the meters display digital or analog units.

Tone

Audio Tone box Select the default audio tone.
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Reference Level field Displays the reference level for custom audio tones. Editable.

Tracks

Consider Audio Head/Tail button Enable to include audio that extends before or after video when exporting
movie files.

Supported Playback Tracks field Displays the number of playback tracks supported by your sound card.
Non-editable.

Supported I/O Tracks field Displays the number of I/O tracks supported by your sound card. Non-editable.

Supported Audio Monitoring Field Displays the audio monitoring option supported by your sound card.
Non-editable.

Outputs

Output Source field Displays all current outputs. Non-editable.

Output Sampling Rate field Displays the current output sampling rate. Non-editable.

Backburner Preferences
Backburner Manager box The hostname of the Backburner Manager system that handles background jobs
submitted by the workstation.

Backburner Group box Specifies a server group (a preset group of render nodes) used to process jobs
submitted by the application. By default, Backburner Manager assigns a job to all available render nodes
capable of processing it. If you have a dedicated group of render nodes for processing jobs, set the value to
the name of the render node group. See the Backburner User Guide for information on creating groups.

Burn Job Type box Configure according to the GPU capabilities of the nodes in your background processing
network.
■ Software: none of the nodes in your background processing network is equipped with a GPU. The

application will not send jobs that require a GPU to the background processing network, but only jobs
that can be processed in software mode (using OSMesa) by the render nodes.

■ GPU Burn: all the nodes in your background processing network are GPU-enabled. The application will
send all jobs to the GPU-equipped nodes in the background processing network, even if some jobs do
not specifically require a GPU node. The GPU-equipped render nodes will render jobs that require a GPU,
as well as OSMesa jobs. If your background processing network also contains nodes without a GPU, and
this setting is used, all jobs are sent only to GPU-equipped render nodes, and the nodes without a GPU
are never used.

Burn Priority field Sets the priority for renderings jobs, from 1 (highest priority) to 100 (lowest).

Wire Priority field Sets the priority for transfers from and to this workstation, from 1 (highest priority) to
100 (lowest).

Store Priority field Sets the priority for caching imported media on this workstation, from 1 (highest priority)
to 100 (lowest).

Burn Export field Sets the priority for exporting clips from this workstation, from 1 (highest priority) to
100 (lowest).

NOTE Regarding the different priorities, be careful when setting new values or you might end up with a system
trying to transfer frames before they are rendered.
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Broadcast Monitor Preferences
Broadcast Monitor Preferences

Broadcast Selection box Select what you want to preview on your broadcast monitor (can be changed
on-the-fly).

Broadcast Monitor box Select the output device used by the broadcast monitor, or turn it off.

Always Send Grab Area button Enable to display Player or viewport output, including times when neither
is in use. Active when the Screen Grab option is selected.

Scale Clip to Fit Monitor button Enable to resize the clip to fit the broadcast monitor. Active when the
Show Selected Item option is selected.

Use Ratio button Enable to maintain the original proportions of the clip. Disable to use the monitor ratio.
Active when the Show Selected Item option is selected.

Broadcast Multiview Preferences

Viewport Monitoring button Enable to send to the broadcast monitor the content of the viewport displaying
the "Monitor" symbol. Disable to use the broadcast monitor as an additional viewport; then use the Broadcast
Monitor toolbar to control the broadcast monitor as you would any other viewport.

Hide Broadcast Toolbar button Enable to hide the Broadcast Monitor toolbar. By default, the toolbar is
displayed in the top-right corner of the graphics monitor. Spacebar+Click to move the Broadcast Monitor
toolbar.

Image Data Type Preferences

Image Data Type box Select the type of image data you are displaying in the broadcast monitor. Your
selection determines the type of transformation that is applied to the clip to modify the contrast. It is disabled
if the Follow button is enabled.

Bypass button Enable to deactivate the image data type display settings in the broadcast monitor.

Broadcast LUT Preferences

Use 3D LUT in Monitor button Enable to apply a 3D LUT from the 3D LUT list to the broadcast monitor.

3D LUT List box Displays the list of 3D LUTs that you imported in the LUT menu.

Broadcast Overlay Preferences

Broadcast Overlay box Select the overlays displayed on the broadcast monitor. "Off" for no letterbox or
reference overlay, "Letterbox" for aspect ratio and letterbox guides, "All" for letterbox and all reference overlay
elements.

Broadcast Stereo

Broadcast Stereo box Displays the current stereoscopic display option.
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General Preferences
Project Information

Project Framerate field Displays the framerate that corresponds with the current project's default resolution.
Non-editable.

Incoming Sync

Incoming Sync field Displays the timing of the sync received by the workstation. Non-editable.

Timecode

Display Dual Timecodes button Enable to display both 29.97 and 23.97 fps timecode on the timeline and
in the Player. This allows you to monitor which transitions will fall on jitter frames when 2:3 insertion is
applied.

Dual TC: 23.97->29.97 fps NDF/DF box Select whether to view the 29.97 fps timecode in the Dual Timecode
display as either drop frame or non-drop frame.

Drop Frame Reference Timecode field Displays the point at which the 29.97 fps material is in sync with
the 23.97 fps material. Editable.

Drop Frame Bump Mode box Select a translation mode for invalid calculator entries.

Player

Source Time Mode box Select to display the timecode, keycode, or frame number of the source clip in the
Player.

Auto-Toggle Player button Enable to open the Player automatically when you press the keyboard shortcuts
for playback.

Display Sequence Viewer button Enable to display the currently selected sequence as a thumbnail with a
red border in the Thumbnail view. When disabled, the selected sequence does not appear Thumbnail view.

Jog / Shuttle on Drag button Enable to shuttle a clip in the Player when jogging. The further from the
center of the clip that the cursor is placed and dragged, the faster the shuttling.

Auto-Toggle Trim View button Enable to automatically display the Trim View when double-clicking a
timeline cut, or when double-clicking a timeline segment with Slip or Slide mode selected.

Untitled Clip Name

Untitled Clip Name box Select an option to rename untitled clips to make it easier to distinguish multiple
Untitled clips.

Rendered Clip Name

Rendered Clip Name box Select whether to add an acronym indicating the area of the software your clip
was rendered from as a prefix or suffix to a rendered clip name, if a setup name does not already exist for
the clip.

Stereo Naming

Left Eye field Displays the token used to identify left eye media in a stereo clip split or exported. Editable.

Right Eye field Displays the token used to identify right eye media in a stereo clip split or exported. Editable.
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Animation

Default Interpolation box Select the default interpolation type for the channel editor.

Default Extrapolation box Select the default extrapolation type for the channel editor.

Audio Gain Animation

Default Audio Interpolation box Select the default audio interpolation type for the channel editor.

Autosave

Soft Save field Displays the time delay for a soft autosave. A small red icon appears indicating a two-second
delay before a soft autosave occurs (allowing for a cancellation with any movement in the application).
Editable.

Hard Save field Displays the time delay for a hard autosave. A hard autosave occurs at the specified time
regardless of user intervention. Editable.

Tools Save field Displays the time delay for an autosave when you are using a tool that you accessed from
the Tools tab. Editable.

Help Location

Help Location button Displays the location of the product help. By default, the product help is available
online. You must have an internet connection to view it. You can download and install the help locally
from the Autodesk website.

Browse Help button Opens a browser window. Select the folder that contains the help that you downloaded
from the Autodesk website.

Reset Help button Resets the help location to the default.

Help Location field Displays the location of the help.

Setups

Scale Setups button Enable to scale setups when loading that were created in a resolution different from
that of the current project.

Image Data Type

Image Data Type box Select a default image type setting.

Undo

Clear Buffer button Removes clips from the undo buffer and frees up disk space on the framestore

Undo Level field Displays how many levels of information are saved to the undo buffer. Editable.

Clip Select

Ignore Scan Format button Enable to disregard scan mode mismatches.

Background Tasks

Update field Displays a value, in seconds, for the wait time to update the Backburner Queue. Editable.
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Shared Libraries

Shared Libraries Refresh Rate field Displays the frequence at which the application refreshes the contents
of Shared Libraries. Editable.

Shared Libraries Lock Timeout field Displays how long an inactive shared folder remains available for
writing. Editable.

Input Devices Preferences
Pointer

Tablet Model field Displays the model of the currently installed tablet. Non-editable.

Pointer Reset button Returns all pointer preferences to their default values.

Threshold Test button Assesses the sensitivity of the pen interactively. Press the pen on the button and a
sliding grey bar in the message bar displays the response to the amount of pressure applied.

Pressure Threshold field Displays the amount of pressure that you want to apply when using the pen. Use
a higher value to decrease the sensitivity of the pen (more pressure required).

Use Mouse Cursor button When using a tablet, enable to use mouse cursors instead of tablet cursors.

Trackball Pressure button Enable to allow the trackballs to respond to changes in the pressure applied
when using a stylus.

Tablet Margins

Proportional Margins button Enable to change the four margin controls proportionally.

Top Margin Control field Displays a percentage value to adjust the top boundary of the active area on the
tablet. Editable.

Bottom Margin Control field Displays a percentage value to adjust the bottom boundary of the active area
on the tablet. Editable.

Left Margin Control field Displays a percentage value to adjust the left boundary of the active area on the
tablet. Editable.

Right Margin Control field Displays a percentage value to adjust the right boundary of the active area on
the tablet. Editable.

LUT Preferences
1D LUT/3D LUT and Colour Transform list Displays the list of imported 1D LUTs or 3D LUTs and Colour
Transforms in separate tabs. See Making 1D LUTs Available for Display (page 1178) and Making 3D LUTs and
Colour Transforms Available for Display (page 1178).

LUT Type box Select whether you want to define a gamma function or import a ID LUT file in the highlighted
row and assign the corresponding keyboard shortcut.

Import button Opens the Import LUT browser. Navigate to the 1D LUT file to import, and select it to load
it into the list. This button is available when the LUT Type box is set to LUT File.

Value field Displays the gamma value. This field is available when the LUT Type box is set to Gamma.

Select button Apply the highlighted gamma or 1D LUT to all displayed images. See Applying 1D LUTs to
the Monitor (page 1179).
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Import button Opens the Import LUT browser. Navigate to the 3D LUT or Colour Transform file to import,
and select it to load it to the 3D LUT and Colour Transform list.

Reset button Removes the highlighted item from the list.

Reset All button Removes all LUTs and Colour Transforms from the current list.

Shared Directory Displays the file path to the shared colour transforms directory. This is a useful location
for storing custom transforms that can be used by other applications that use Autodesk Colour Management.

Browse Browse to select a different shared directory for color transforms. The path you select is used by all
compatible applications on the same workstation.

Default Reset the shared directory to its installation default.

Broadcast Monitor Transform  Specifies the colour transform that is used when the broadcastMonitor alias
is referenced inside another transform. See Configuring the Colour Transform Aliases (page 1178).

Default Reset the Broadcast Monitor Transform to its installation default.

Browse Browse to select a different colour transform for the broadcastMonitor alias.

Graphics Monitor Transform  Specifies the colour transform that is used when the graphicsMonitor alias
is referenced inside another transform. See Configuring the Colour Transform Aliases (page 1178).

Sync with OS Automatically uses the ICC profile specified in your computer's preferences as the value of
the graphicsMonitor alias.

Browse Browse to select a different colour transform for the graphicsMonitor alias.

Default Look Transform  Specifies the colour transform that is used when the defaultLook alias is referenced
inside another transform. See Configuring the Colour Transform Aliases (page 1178).

Clear Sets the value of the defaultLook alias to the identity transform, which has no effect on colour values.

Browse Browse to select a different colour transform for the defaultLook alias.

Storage Preferences
Space Calculation

Space Calculation options Choose to display all available frames in the message bar, all available and
purgeable frames in the message bar, or to purge frames before making a space calculation.

Volume Statistics button Lists the number of frames, proxies, and audio sources stored in the clip libraries,
and main work area of each project.

Video Framestore Estimate button Displays the estimated amount of space left on the video framestore.

Framestore

Test Disks button Displays the number of frames read per second; the number of seconds required to read
a single frame; and the amount of data, in megabytes, read per second.

Support Preferences
Upload Config Info Only button Click to upload only configuration information to Autodesk Customer
Support. Use only if instructed by Autodesk Customer Support.
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Upload Config Info and Logs button Click to upload pertinent configuration information and system logs
to Autodesk Customer Support. Use only if instructed by Autodesk Customer Support.

Max Logged Days field Displays the number of logged days of information to be uploaded to Autodesk
Customer Support. Editable.

Case ID field Enter the Case ID number given to you by Autodesk Customer Support so that it is included
in the uploaded information.

Timeline Preferences
Editing

Default Timecode field Displays the default start timecode value for new items overwritten or inserted into
a timeline sequence. Editable.

Merge Tracks Mode box Select how a timeline will be flattened when merging tracks.

To merge tracks by:Select:

Hard committing all soft transitions. Cut points between elements are preserved; clip

handles are not.

Simple Track Merge

Hard committing soft transitions but creating separate elements with clip handles for

each.

Complex Track Merge

Preserving editable soft transitions and clip handles.Committed Track Merge

Auto Timewarp button Enable to specify the behaviour of four-point replace and overwrite edits, when
they involve a different number of frames between the in and out points on the source and sequence clips.

Framerate Converter button Enable to format the source clip to the correct destination framerate by applying
a video timewarp to the source clip.

Snap Includes Marks button Enable to snap to timeline marks.

Snap With Positioner button Enable to snap segments to the positioner.

Display Phantom Marks button Enable to turn on phantom marks on the timeline and source clip. Phantom
marks indicate the result of a 4-point edit regardless of whether you have marks set.

Containers

Uncontain options box Select whether new tracks and versions are added or overwritten when a container
segment is uncontained.

Contain Timewarped Edits button Enable to preserve the edits in a fit-to-fill four-point edit. The incoming
clip is contained and a timewarp is applied to the container instead of the clip.

Segment Display

Handles box Select an option for displaying heads and tails on segments in the timeline.
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Navigation

Frame Positioner box Select whether to snap the timeline positioner frame-to-frame, or on a sub-frame
basis (one-tenth of a frame).

Autoscroll field Displays the speed at which the timeline scrolls. Editable.

Scroll During Playback button Enable to scroll the timeline during playback, keeping the frame positioner
visible.

Scroll Past First Frame button Enable to allow the positioner to move before frame one.

Transitions

Dissolve Duration field Drag left or right, or enter a value to set the default duration for dissolves.

Transition Alignment box Sets the default alignment for dissolves, wipes, axis, and custom transitions.

Curve Type box Select Bezier or linear as the default curve type for dissolves.

Default Wipe button Opens the file browser, where you select the default wipe type to be used when creating
wipe transitions and timeline effects.

Default Wipe field Displays a SMPTE wipe number to be used as the default wipe for wipe transitions and
timeline effects. Editable.

Rendering

Timeline Effects Render Mode box Select the render mode when a Timeline FX is added to a clip.

Timewarp Render Mode box Select the default rendering mode for timewarps created in the timeline.

Transitions Render Mode box Select a default rendering mode for transitions created in the timeline.

Cache Preview Effects button Enable to cache frames rendered in the timeline.

Auto Rendering button Enable to background render automatically when you enter the Axis, Wipe, Colour
Corrector, or Sparks Editor.

Timeline Effects Rendering box Select whether to render an entire track first, then the next track (Track
Based Render), or to render all tracks frame-by-frame (Frame Based Render).

Timeline FX / ConnectFX Preferences
ConnectFX

Interactive Max field Displays the number of seconds that the system uses to attempt a render when
previewing the effect. Editable.

Add Axis On Matte Output button Enable to have an Axis timeline effect automatically added to the
timeline when a matte is output from the output node to the timeline.

Always Load Nodes button Enable to automatically load all FX nodes into memory when a setup is loaded.
Disable to load nodes when entering an FX level.

Clear Rendered Memory button Enable to automatically clear an FX node (and all nodes in setups nested
within the clip) from memory when its output is rendered.

ConnectFX Mode

Head Media option box Select how to interpret missing information before a clip.
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Gap Media option box Select how to interpret missing information during a clip.

Tail Media option box Select how to interpret missing information after a clip.

ConnectFX Automatic Nodes Copy

Automatic Nodes Copy box Select whether FX nodes are never copied into memory, always copied, copied
when there is an Action node in the setup, or copied in a partially rendered setup.

Timeline Timewarp

Interpolation Option box Select an interpolation option for your interlaced timewarp.

Use Last Speed button Enable to apply the last timewarp speed to future timewarps.

Timewarp Speed Display box Select whether timewarp speed is displayed as a percentage (%) or in frames
per second (fps).

Timewarp Sample Option box Select whether the speed of the timewarp is set in relation to the speed at
the beginning, middle, or end of the timing curve for each frame or field. You can also change the Timewarp
Sample option in the Timewarp Editor to override this selection.

Timeline Resize

Fit Method box Select a fit option for clips that must be resized when they are added to the timeline because
their resolution is different from the project.

Resize Quality box Select a sampling algorithm for clips that must be resized when they are added to the
timeline.

Keep Aspect button Enable to maintain the aspect ratio of clips that are resized when you add the to the
timeline.

Timeline Text

Text Anti-aliasing box Select an anti-aliasing softness rate for text.

Default Font field Opens the font browser. Select a default font and click Load.

Timeline Blend

Timeline Blend box Select the type of blend that is applied by default when you add a blend timeline effect.

Timeline Colour Correct

Default Menu box Select whether the Colour Corrector or Colour Warper is the default menu displayed
when you access the Colour Corrector through a timeline effect.

Viewport Settings

Default Viewport box Select whether to use a 1-Up or 2-Up view as the default ConnectFX view. You can
also change the viewport layout from within ConnectFX.
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User Interface Preferences
Colour

Background field Displays the background brightness value. Editable

Brightness field Displays the brightness of interface elements such as buttons and fields. Editable.

Contrast field Displays the contrast of interface elements such as buttons and fields. Editable.

On-Screen Widgets

On-screen Keyboard button Enable to have the on-screen keyboard appear when you enter text in a field.

Calculator Placement box Select where the calculator appears when you click in a numeric field.

Display

Clip Information box Select to display frames or timecodes in frame marking controls, the timebar, segments,
and the fields below the timeline.

Drag Transparency field Displays the transparency level of clips while dragging. Editable.

Auto Key Button Look

Auto Key look box Select whether to apply a Classic (grey) or Coloured (yellow) look to the Auto Key button.

Thumbnail View

Snap to Grid button Enable to snap thumbnails to a grid. The grid becomes visible when this button is
enabled.

Grid Size field Enter a value in pixels for the size of the boxes that make the grid.

Thumbnail Height field Enter a default value in pixels for the height of thumbnails displayed in the
Thumbnail view. All new thumbnails are generated at this height. Existing ones are unchanged.

Tooltips

Auto Display button Enable to automatically display tooltips. If disabled, you can still display tooltips for
selected buttons using the keyboard shortcut Ctrl+W.

Hover field Displays the amount of time you must position the mouse over the object before the tooltip
displays (in seconds). Editable.

Duration field Displays the amount of time that the tooltip is visible (in seconds). Editable.

Gestural Workflow

Swipe Bars button Click to enable swipe bars that you can use to switch views in different areas of your
product.

Layout Selection Overlay button Click to enable the menu overlay in the Timeline view. You can use the
menu overlay to change what is displayed in the Timeline view.
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Gateway Clip Description

The Gateway .clip is an XML structured file that describes at least the following information.
■ Physical location of files, and additional metadata information, such as timecode and keycode

■ Clip versions

NOTE This documents to use notation as close as possible to DTD definitions.
■ xml-element?: zero or one instance of xml-element;

■ xml-element+: at least one instance of xml-element;

■ xml-element*: any number of instances of xml-element;

■ #cdata: a placeholder for data described in the xml-element description, usually a string of any valid characters;

clip
The <clip> element defines the top-level data structure. The minimum elements required to create a valid
<clip> are:
■ <tracks>

■ <versions>

Attribute is...Al-
lowed
Values

Data TypeDescriptionAttribute

Requiredclipcharacter dataThe data type of the element.type

Required3integerVersion of the xml element.version

28
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Attribute is...Al-
lowed
Values

Data TypeDescriptionAttribute

ImpliedanyIDOptional unique identifier. When used, uid must
be a unique ID within the .clip file.

uid

Children

handler?, name (page 1270)?, sourceName?, startTimeCode?, duration (page 1268)?, editRate?, dropMode (page 1267)?, userData
(page 1276)?, comment (page 1266)?, tracks (page 1276), versions (page 1278)

comment
The <comment> contains an unparsed string. Use it to store comments.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedstringcharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

#cdata

Found in

<clip> (page 1265), <feed> (page 1268), <track> (page 1275), <version> (page 1277)

creationDate
The <creationDate> contains an unparsed string. Use it to store the creation date of the version.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedstringcharacter dataThe data type of the element.type

1266 | Chapter 28   Gateway Clip Description



Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Implied3unsigned integerVersion of the xml element.version

Children

#cdata

Found in...

<version> (page 1277)

denominator
The <denominator> must be an unsigned integer. It expresses, together with the <numerator> element, a
frame rate.

The <denominator> element has no attributes.

Children

#cdata

Found in...

<rate> (page 1272), <sampleRate> (page 1273)

dropMode
The drop frame mode of the media.

The <dropMode> element has no attributes.

Allowed values for <dropMode>:

■ DF: drop-frame media

■ NDF: non drop-frame media

Children

#cdata

Found in...

<clip> (page 1265), <duration> (page 1268), <track> (page 1275)
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duration
The <duration> element is the number of samples that make up the media. It is a is a 64-bit integer. A
<duration> without a sibling <path> element is the defines the parent <span> as a gap.

The <duration> element has no attributes.

Children

#cdata

Found in...

<span> (page 1273)

duration
The duration and framerate of the media.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

timecharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

rate (page 1272)?, nbTicks (page 1270), dropMode (page 1267)

Found in...

<clip> (page 1265), <track> (page 1275)

feed
The <feed> element allows you to manage and reference different qualities and resolutions for the same
reference media.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedfeedcharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element. Do not use, unless
mixing and matching differing xml schema ver-
sions, which should not be done.

version
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Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

any unique (within
<feeds>)

IDIdentifies the version of the feed. In a <track>
element, no two <feed> elements can have the
same vuid.
<feed> elements in different <track> elements
can share the same vuid.

vuid

Re-
quired

any unique (within
.clip)

IDUniquely identifies the feed within the .clip file.
Duplicate uid in a .clip are not allowed. We re-
commend that you use a GUID, but any unique
identifier will do.

uid

Children

handler?,storageFormat (page 1274)?,sampleRate (page 1273)?,startTimecode?,startOffset?,userData (page 1276)?,comment (page
1266)?,spans (page 1274)

Found in...

<feeds> (page 1269)

feeds
The <feeds> element contains the different <feed> elements. In a Gateway .clip, each <feed> can be
conceptualized as a version of the media.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedfeedscharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Re-
quired

vuid  of a child
<feed>

IDREFMust match the vuid attribute of one of the
children <feed>. currentVersion indicates
the active <feed>, or current version the client
application should use.

currentVersion

Children

feed (page 1268)+

Found in...

<track> (page 1275)
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name
The <name> element should be interpreted by the client application as the name of the parent element.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedstringcharacter dataThe data type of the xml element.type

Implied3unsigned integerVersion of the xml element.version

Child Element

#cdata

Found in...

<clip> (page 1265), <track> (page 1275), <version> (page 1277)

Example
Flame displays <name> (with <clip> as immediate parent) in Batch as the clip name in the Batch setup. But
<name> as child of <track> is used as the name of the channel.

nbTicks
The nbTicks element is the number of samples that make up the media. It is a is a 64-bit integer.

This number divided by the value of the <rate> element defines the duration of the media.

The nbTicks element has no attributes.

Children

#cdata

Found in...

<duration> (page 1268)

numerator
The <numerator> element must be an insigned integer. It expresses, when divided by the <denominator>
element, a frame rate.
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The <numerator> element has no attributes.

Children

#cdata

Found in...

rate (page 1272), sampleRate (page 1273)

path
The <path> element is the path to the media. The path can be relative or absolute. You can also use range
brackets for file sequences.

/dir/clip.mp4
/dir/fileSequence/dpxSequence.[0-99].dpx

NOTE Regarding files sequence and padding in the <path> element: The Gateway reconstructs a sequence as
indicated by brackets. dpxSequence.[1-99].dpx indicates to the Gateway there are 99 dpx files named
dpxSequence.1.dpx to dpxSequence.99.dpx. It can also manage padding. dpxSequence.[001-099].dpx is read
as a sequence of 99 files named dpxSequence.001.dpx to dpxSequence.099.dpx.

In a Smoke and Flame context, use the subFeedId attribute to pair up paths and create stereo spans.

<path subFeedId="Left">/dir/stereoClip.Left.[0-99].dpx</path>
<path subFeedId="Right">/dir/stereoClip.Right.[0-99].dpx</path>

The actual use and interpretation of the subFeedId attribute is left to the client application.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedpathcharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Impliedanycharacter dataUse this attribute to further identify the type of
feed. In a Smoke or Flame context, you create
stereo pairs by using the "Left" and "Right" values.

subFeedId

Children

#cdata

Found in...

<span> (page 1273), <paths> (page 1272)
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paths
The <paths> element contains all the <path> elements which contain the different paths to the media.

<span>
<paths>

<path>path_1_of_2</path>
<path>path_2_of_2</path>

</paths>
<span>

If there is only one child <path> element, <paths> does not have to be used.

<span>
<path>singlePath</path>

</span>

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedpathscharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

path (page 1271)+

Found in...

<span> (page 1273)

rate
Frame rate of the media. If no frame rate is specified, it is up to the application to decide on the frame rate
to use.

Use numerator/denominator elements to express as a fraction frame rates that use decimals; this provides
more precision. The following expresses a frame rate of 23.976 fps.

<rate type="time">
<numerator>24000</numerator>
<denominator>1001</denominator>
</rate>

To express frame rates that use integers, use the short-hand notation without child-elements but only a
single integer.

<rate type="time">25</rate>

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedratecharacter dataThe data type of the element.type

1272 | Chapter 28   Gateway Clip Description



Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Implied3unsigned integerVersion of the xml element.version

Children

(numerator (page 1270), denominator (page 1267)) | #cdata

NOTE #cdata must be an unsigned integer.

sampleRate
The <sampleRate> element describes the frames per second rate of the media described by the <feed> element.
If no frame rate is specified, it is up to the application to decide on the frame rate to use.

Use numerator/denominator elements to express as a fraction frame rates using decimals. Use an integer for
other cases. The following expresses a frame rate of 23.976 fps.

<sampleRate type="time">
<numerator>24000</numerator>
<denominator>1001</denominator>

</sampleRate>

To express a frame rate using an unsigned integer, use the short-hand notation without child-elements but
only a single integer.

<sampleRate type="time">25</sampleRate>

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

ratecharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

(numerator (page 1270),denominator (page 1267)) | #cdata

span
The <span> element contains media that make up all or parts of the <feed>. A <span> element describes its
duration and the path to the physical media files. A <feed> made up of multiple <span> elements means
that multiple media files/sequences make up that one <feed>. The order in which each <span> element is
listed is the order in which they are read to rebuild the sequence.

All media referenced in a <span> must have homogeneous properties (same codec, compression, format,
length, rate...). To mix types of media in a .clip, use different <track> elements.
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A <span> with a <duration> but no <path> is the definition of a gap.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedspancharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

duration (page 1268),(paths (page 1272)|path (page 1271))?,userData (page 1276)?

Found in...

<spans> (page 1274)

spans
The <spans> element contains all the <span> elements that make up the <feed>.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedspanscharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

span (page 1273)+

Found in...

<feed> (page 1268)

storageFormat
The <storageFormat> element explicitly describes the format of the media referenced. This element is
populated by the Gateway and does not need to be populated at the creation of the .clip file.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

formatcharacter dataThe data type of the element.type
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Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Implied3unsigned integerVersion of the xml element.version

Children

type,channelsDepth,channelsEncoding,channelsEndianess,height,nbChannels,pixelLayout,pixelRatio,RowOrdering,width

Found in...

<feed> (page 1268)

track
The <tack> elements contains all the information that make up a track in a Gateway clip.

Examples of tracks in a Gateway .clip context:
■ A layer in a Photoshop file;

■ A video, or one of multiple audio tracks in a QuickTime file;

■ One of multiple render passes contained in a multi-channel OpenEXR file.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedtrackcharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Re-
quired

anyIDUnique identifier of the track element. This value
must be unique within the .clip file.

uid

Children

trackType (page 1276), extendedType?, handler?, sourceName?, startTimecode?, dropMode (page 1267)?, duration (page 1268)?,
name (page 1270)?, editRate?, userData (page 1266)?, comment (page 1266)?, feeds (page 1269)

Found in...

<tracks> (page 1276)
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tracks
The container for all the track elements making up the current .clip file.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedtrackscharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

track (page 1275)+

Found in...

<clip> (page 1265)

trackType
The type of media described in the track element. <trackType> must match the type of media later referenced
by the feeds elements.

The <trackType> element has no attributes.

Allowed values for <trackType>:

■ video

■ audio

Children

#cdata

Found in...

<track> (page 1275)

userData
<userData> is dictionary object that stores client-defined elements, passed directly to the client application
by the Gateway.

Here is an simple example of a <userData> structure used to store the name and version of the source
application that created the .clip.

<userData type="dict">
<appName type="string">Flame</appName>
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<appVersion type="int16">2012</appVersion>
</userData>

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

dictcharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Children

#undefined

No children elements are defined for the <userData> element since its data structure is undefined; each child
element created by the client must define its data type using the type attribute. The allowed data types are
listed below.

Defined ValuesData Type

int, int8, int16, int32, int64Integer (bound or unbound)

uint, uint8, uint16, uint32, uint64Unsigned integer (bound or unbound)

float, doubleFloating point

boolBoolean

stringString

Found in...

<clip> (page 1265), <feed> (page 1268), <span> (page 1273), <version> (page 1277)

version
The <version> element contains metadata for a clip version, and lists an existing version using its uid
attribute.

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedversioncharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version
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Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Re-
quired

Any vuid defined
in a <feed>.
Each uid must be
unique across

IDREFDefines which <feed> of each <track> to use,
based on matching vuid.

uid

<version> ele-
ments.

Children

name (page 1270)?,comment (page 1266)?,creationDate (page 1266)?,userData (page 1276)?

Found in...

<versions> (page 1278)

versions
The <versions> element lists two things: the available versions of a clip, and the version currently in use.

Different versions of a track are described by different <feed> elements each identified with a unique vuid
attribute. In a Gateway clip XML, a specific version of a clip is defined as all the <feed> elements sharing
the same vuid attribute accross different <track> elements.

The <version> element describes and lists the available versions, while the currentVersion attribute defines
which <version> element is the current one. The client application that reads the .clip is not required to
currentVersion; it only serves as a flag put there by the creator.

Consider the following, simplified example.

<tracks>
<track uid="track1">
<feeds>
<feed vuid="v1" uid="t1f1"/>
<feed vuid="v3" uid="t1f2"/> <!-- version 3 of the track, version 2 was never

created -->
</feeds>
</track>
<track uid="track2">
<feeds>
<feed vuid="v1" uid="t2f1"/>
<feed vuid="v2" uid="t2f2"/>
<feed vuid="v3" uid="t2f3"/>
</feeds>
</track>
</tracks>

And you have the following <versions> structure.

<versions currentVersion="v2">
<version uid="v1"/>
<version uid="v2"/>
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<version uid="v3"/>
</versions>

You now have a clip that can display the following:
■ Version 1: track1 using feed t1f1 and track2 using t2f1;

■ Version 2: track2 using t2f2 only(there is no vuid in track1 matching "v2");

■ Version 3: track1 using feed t1f3 and track2 using t2f3;

And in this example, the client application should display the version 2 of the clip because currentVersion=
2 .

Attrib-
ute is...

Allowed ValuesData TypeDescriptionAttribute

Impliedversionscharacter dataThe data type of the element.type

Implied3unsigned integerVersion of the xml element.version

Impliedany existing one
uid from an en-

IDREFDefines the current version of the clip, as set by
the client application that created the file. The
client application is expected to view this version
as the most up-to-date.
If not defined, the Gateway considers the last
<version> element defined in the file as the
current version.

currentVersion

closed <ver-
sion> element.

Children

version (page 1277)+

Found in...

<clip> (page 1265)

Creating a Simple Gateway Clip
A simple Gateway clip contains one video track. It has no versioning and no setup information; it is the
simplest case, and is a nice, practical, exercise.

Solution

Use the simplest form of .clip you can create: one video track, no audio. The following is the minimal
structure required to to have a valid Gateway clip.

<?xml version="1.0" encoding="UTF-8"?>
<clip type="clip" version=3>

<tracks>
<track uid="client-defined unique identifier">

<trackType>video</trackType>
<feeds currentVersion="the <feed> vuid">
<feed vuid="client defined" uid="client-defined unique identifier">
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<spans>
<span>

<duration>number of samples in the media
sequence</duration>

<path>path the media sequence</path>
</span>

</spans>
</feed>

</feeds>
</track>

</tracks>
<versions currentVersion="one of the <version> uid">

<version uid="the currentVersion of <feeds>"/>
</versions

</clip>

NOTE Regarding files sequence and padding in the <path> element: The Gateway reconstructs a sequence as
indicated by brackets. dpxSequence.[1-99].dpx indicates to the Gateway there are 99 dpx files named
dpxSequence.1.dpx to dpxSequence.99.dpx. It can also manage padding. dpxSequence.[001-099].dpx is read
as a sequence of 99 files named dpxSequence.001.dpx to dpxSequence.099.dpx.

Example and Discussion

Here is a commented .clip file. It does contain additional elements than the bare minimum, so as to play
nicely with Smoke, Flame, or Lustre applications.

<?xml version="1.0" encoding="UTF-8"?>
<clip type="clip" version=3>

<name type="string">NoVersionNoSetup</name>
<tracks>

<track uid="1b22da75-33e5-4dbe-80d0-7ed680a8b2b7">
<trackType>video</trackType>
<duration type="time">

<rate type="rate">
<numerator>30000</numerator>
<denominator>1001</denominator>

</rate>
<nbTicks>26</nbTicks>
<dropMode>NDF</dropMode>

</duration>
<name type="string">ClipNoVersionNoSetup</name>
<feeds currentVersion="0">

<feed vuid="0" uid="track1Feed1">
<spans>

<span>
<duration>26</duration>
<path>/var/tmp/UltimateFlick.[001-026].dpx</path>

</span>
</spans>

</feed>
</feeds>

</track>
</tracks>
<versions currentVersion="0">

<version uid="0">
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<creationDate>2010/12/14 11:54:06</creationDate>
</version>

</versions>
</clip>

NOTE If you compare this to the .clip structure described before, you will notice the use of user-defined elements
such as <userData>. Both are optional. For example, Flame uses the following child of <clip>:

<userData type="dict">
<appName type="string">Flame</appName>
<appVersion type="string">2012</appVersion>

</userData>

This is used by Flame to determine the software and version used to create the .clip. But the Gateway ignores
all <userData>: it is up to the client application to determine what to do with it.

Comments

<clip type="clip" version=3>

The <clip> element has two required attributes, with fixed values: type="clip" and version=3.

<name type="string">NoVersionNoSetup</name>

<name> is optional, but the client application uses it as the name of the clip. Note here that type="string"
is mandatory so that the Gateway knows how to pass it to the client application.

<track uid="1b22da75-33e5-4dbe-80d0-7ed680a8b2b7">

Since this example has only one video track (or layer), there is only one <track> element.

The uid used here is a UUID, but it can be something as simple as "1", as long as it is unique accross <track>
elements.

<trackType>video</trackType>

video is one of two allowed values in the <trackType> context, the other being audio. You must have a
defined <trackType> for each <track>.

<duration type="time">
<rate type="rate">

<numerator>30000</numerator>
<denominator>1001</denominator>

</rate>
<nbTicks>26</nbTicks>
<dropMode>NDF</dropMode>

</duration>

<duration> defines the duration of the track, using the formula <rate>/<nbTicks>.

The <rate> element used here is the best definition of the 29.97 fps frame rate. This avoids rounding errors.
Of course, if the frame rate is an integer such as 24 fps, use the simplified structure <rate>24</rate>.

And since 29.97 fps can be drop frame or non-drop frame, we have to define <dropMode>.

<name type="string">ClipNoVersionNoSetup</name>

Again, <name> is optional here, but Flame uses it as the name of the track.

<feeds currentVersion="0">

currentVersion refers to the vuid of the enclosed <feed>.

<feed vuid="0" uid="track1Feed1">
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A feed forms a version of a track, identified with by its vuid.

As shown here (track1Feed1), a <feed uid=> can be any sort of value, as long as it is unique across all the
<feed> elements.

<spans>

The <spans> element exists because you can have multiple spans. Such is the case with media cartridges that
split clips into 2GB files.

<span>
<duration>26</duration>
<path>/var/tmp/UltimateFlick.[001-026].dpx</path>

</span>

Because we have 26 dpx files, and because we want to use them all, <duration> is set at 26. To use less of it,
we can specify a lower value.

When linking to streaming media, <duration> becomes the number of samples to use.

<versions currentVersion="0">
<version uid="0">

<creationDate>2010/12/14 11:54:06</creationDate>
</version>
</versions>

</clip>

Every .clip has at least one version, defined using a <version> element. currentVersion refers to an existing
uid from a <version>. The uid must be an existing vuid.

<creationDate> is not parsed by the Gateway, only passed to the client application.
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.R3D in Final Cut Pro 77

2D Histogram 887
2D Histogram menu settings 887
2D Histogram node 887
2D luma histogram, in Colour Warper 699
2D Transform 888

2D Transform menu settings 890
2D Transform node 888
2D vectorscope, in Colour Warper 696
3D cameras, in Action

importing 540
3D models

3ds Max import, in Action 454
Alembic import, in Action 454
FBX, link 460
importing, in Action 454
modifying, in Action 461
specular highlights, in Action 466
transparency, in Action 465

3D path
creating, in Action 508
look-at, in Action 512

3D text
adding presets 467
bevelling, in Action 488
creating, in Action 467

3D tracker
manual tracking in Action 596
Stabilizer, setting manual trackers 596

3D vectorscope, in Colour Warper 696
3ds Max

cameras, in Action 519
models, importing 454

A

aaf 80, 164
About Sparks 1065
Accessing the Axis Keyer 284
Accessing the Wipe Schematic 264
Action

See also 3D models, 3D text, 3D tracker, media, source
nodes, surfaces

adaptive degradation options 352
axes 378
axis planes 381
bicubic surfaces 392
bilinear surfaces 392

blending curves per surface 397
blending surfaces 394
blooming 450
blurring clips 373
camera clipping planes 518, 537
camera, stereo 528
cameras, adding 514
cast shadows 433
creating branches in schematic 349
cropping clips 374
diffuse mapping 502
displacement mapping 497
drop shadows 405
flipping normals 430
grouping media 409
in ConnectFX 316
len flares 437
lights 422
Magnet Curve Editor 402
material node 496
Media list 370
menus, accessing 344
models, importing 454
Modular Keyer, accessing 377
motion blur 525
node bin 338
OpenEXR support 338
outputs 364
Perspective Grid 417
Photoshop files, importing 363
Priority Editor 407
processing options 352
rays 448
reflection mapping 506
replacing front or matte clips 546
schematic, using 343
selective lighting 424
setup options 352
setups, loading 362
slipping clips 376
source nodes 544
specular highlights 427, 466
stabilizing 383
stereo camera 528
stereo footage 412
stereo objects 412
stereoscopy 412
surfaces 385
textures 495
tracking 383
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wireframe 429
Z-buffer for shadows 407
Z-buffer setting 409

Adding Axis Timeline FX 283
Adding Axis Timeline Transition 272
Adding Colour Correct Timeline FX 281
Adding Compression Timeline FX 285
Adding Delay Send Timeline FX 287
Adding Dissolve Timeline Transition 262
Adding EQ Timeline FX 285
Adding Fade Timeline Transition 273
Adding Gain Timeline FX 286
Adding Gate Timeline FX 284
Adding Matte Containers 284
Adding Modulation Send Timeline FX 287
Adding Resize Timeline FX 280
Adding Reverb Send Timeline FX 286
Adding Sparks Timeline FX 282, 283
Adding Text Timeline FX 280
Adding Timeline FX to Gaps 277
Adding Timeline transitions 262
Adding Timewarp Timeline FX 279
Adding Wipe Timeline FX 283
Adding Wipe Timeline Transitions 263
Adjusitng Preset SMPTE and Custom Wipes 264
adjusting aspect ratio, viewing aspect ratio, aspect ratio,

broadcast monitor 215
Adjustment Segment

in ConnectFX 292
adobe 165
advanced gradient

defined 621
pickers, using with 649
removing, in Tracer 650
softness borders 646
Tracer 646

Alembic
models, importing 454

aligned edit 228
animating

garbage masks 636
garbage masks with tracking 641
in Keyer 583
keyframes 1099
Paint strokes 798
shapes 826
text 874
Tracer 653

animation
Animation Channel Editor 1100
Channel Editor 1100
creating filters 1115
expressions, creating 1124
keyframe indicators 1100
linking audio 1116
linking channels with expressions 1126
previewing in Paint 762
using selection sets 1115

Animation Channel Editor
adding keyframes 1102

display preferences 1113
panning, zooming 1101
using 1100

animation curves
copying,keyframes

copying 1103
flipping channels 1110
mattes, deleting in Colour Warper 712
moving 1107
tangents 1111
timing 1104

append edit 228
archaic archive 198
archive 196, 197
archive configuration 199
archive selection 197
archive, best practice 201
archive, delete 206
archive, erase 206
archive, HTML 202
archive, other locations 201
archive, supplementing 201
archive, TOC 202
archive, troubleshooting 199
archives 195

browsing 202
deleting TOCs 204
legacy 205
old 205
recovering 204
restoring previous versions 205

archiving folders 197
Array element

contained by LUT1D 1198
contained by LUT3D 1199
contained by Matrix 1202

ASC_CDL element 1216
ASCII table of contents, recovering 204
Asian character sets 863
assemble mode

blacking tapes 178
outputting using 178

audio
generating keyframes 1116
patching, in EDLs 157
preferences 1253

Audio Mixer 257
Audio Preferences 1253
Auto Edit after Add 806
Auto Matte 895
Auto Matte menu settings 895
Auto Matte node 895
Auto Point 823
Auto Stabilize 896
Auto Stabilize menu settings 897
Auto Stablize node 896, 897
AutoConfigure element 1226
AutoPaint 793

playing recorded strokes 798
Random mode 795
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recording brush strokes 796
tracking 797
User mode 796
using graphics 825
Wipe mode 794

Average 900, 901
Average menu settings 901
Average node 900
avid 80, 164
axes, in Action 378

B

back up system, to 201
back up, to 195
backup 195
baking keyframes 1109
banking, 3D path in Action 513
Bezier curves, for polygons 823
bicubic surfaces, in Action 392
bilinear surfaces, in Action 392
blacking VTR tapes 178
Blend & Comp 901, 903
Blend & Comp Menu settings 903
Blend & Comp Node 901
blending 750

surfaces, in Action 394
blending curves

per surface, in Action 397
blooming

adding, in Action 450
Blur 905, 906
Blur medium 778
Blur menu settings 906
Blur node 905
blurring

in Colour Warper 712
brush attributes 770

Direction 739, 772, 775
Jitter 739, 771
modes 774
Opacity 737, 770
Pressure 738, 771, 775
Rate 737, 770
Roll 740, 773
Size 737, 770
using reference images 774

Brush Spacing preference 775
brushes

See also special effects media
attributes, setting in Paint node 737
custom 844
selecting 765
setups, saving and loading 843
strokes, applying 742
types 765, 806

Bump Displace 911
Bump Displace menu settings 911
Bump Displace node 911

Burn-In Letterbox 913, 914
Burn-In Letterbox menu settings 914
Burn-In Letterbox node 913
Burn-In Timecode 914, 915
Burn-In Timecode menu settings 915
Burn-In Timecode node 914

C

cameras, in Action
adding 514
clipping planes 518, 537
exporting 519
importing 519
modifying 524, 543
stereoscopic 528

canvas
clearing strokes 752
rotating 754
wiping 753

capturing
frame grab 167
live video signals 181
single frames 167
YUV material 190

cascading 3D text, in Action 490
cast shadows

adding, in Action 433
catalogues, keyboard shortcuts 1246
catastrophic system failure 201
Channel Editor

accessing 1100
analysing audio 1116
linking channels with expressions 1126
selection sets 1115
tangents 1111

checkerboard 39
chroma

modifying, in Colour Warper 725
chroma key, green screen, Modular Keyer 553
Clamp 916

Clamp node 916
Clamp menu settings 916
clamping

colours, in Colour Warper 693, 922
clearing

canvas 752
strokes, sources 734

clip I/O
See also clips, capturing, outputting
configuring hardware 166
generating proxies at capture 167
HD formats, supported 182
input using VTRs 167
monitoring video 179
naming clips and tapes for 171
outputting to a VTR 173
software initialization configuration file 166
using VTR, general workflow 166
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clip, sharing 126
clip, transfer 126
clip, wire 126
clips

See also clip I/O
ganging in Source Area 36
inserting on timeline 226
locking duration 757
overwriting on timeline 227
replacing on timeline 228
unlocking duration 757

Clone medium 779
cloning, in Paint node 747
CMX 138
collaboration 125, 126
color transform file format 1186
coloucolocolour transforms

r transforms
exposure and contrast 1182

colour balance
adjusting, in Colour Corrector 684

colour casts, in Colour Warper 725
Colour Correct 917
Colour Correct menu settings 917
colour correcting

clamping, in Colour Warper 693, 922
colour balance, adjusting 684
colour values, remapping 691
contrast, adjusting 683
contrast, decreasing 689
contrast, in Colour Warper 717
contrast, increasing 688
deleting, in Colour Warper 712
desaturation, in Colour Warper 718
gamma, adjusting 682
highlights 678
hue, adjusting 679
imbalances, in Colour Warper 713
in Action 376
in Colour Warper 700
in Paint 850
inverting mattes, in Colour Warper 703
luma ranges, defining 689
matching colours 676
matching, in Colour Warper 723
midtones 678
offsets, adjusting 682
pivot, adjusting 680
removing colours, in Colour Warper 714
resetting in Colour Warper 704
sampling colours 674
sampling, in Colour Warper 705
saturation, adjusting 679
shadows 678
spills, removing in Colour Warper 727
suppressing colours 683
suppressing colours, in Colour Warper 716

Colour Corrector
accessing from Action 376
accessing from other modules, tools 664

background brightness, changing 669
clips, viewing 668
colour curves 691
colour patches 674
crop box 669
cutouts 839
gain 682
histogram 686
input levels 688
menu, hiding 664
output levels 689
overlay user interface 665
processing 692
resetting 672
RGB channels, rewiring 680
setup options 668
setups and preferences, saving 673

Colour Curves 920, 921
Colour Curves menu settings 921
Colour Curves node 920
colour management 1161

about 1161
applying to broadcast monitor or projector 1181
applying to clips 1161
applying to display 1178
supported file formats 1185

Colour Matching on the Timeline 281
colour models

selecting to key with in Keyer 567
colour palette

colour gradient 762
in Paint 760
mixing colours 761

colour space conversion, enabling on clip I/O 192
colour spill

removing, in Colour Warper 727
colour transforms

applying 1163
applying to display 1178
building custom 1165
controlling the look 1182
exporting 1177
file locations 1184
graphicsMonitor alias 1178
types 1183

Colour Warper
about 692, 921
accessing 694, 922
colour correcting 700
reference clips, viewing 696
resetting colour corrections 703
subsetups 729
undo levels 705
viewports, displaying 696
working environment 695

Coloured Frame 927
Coloured Frame menu settings 927
Coloured Frame node 927
Combine 928, 929
Combine menu settings 928
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Combine node 928, 929
comments 1224
compare offline, compare online 211
compositing

with Action 337
Compound 928
Compound node 928
configuration file

SynColor 1224
conform 59, 80, 136, 137, 138, 165
Connect FX

adding to sequence 292
ConnectFX

about 291
node bins 332

Constant shape, for garbage masks 624
containers

creating on timeline 243
contrast

adjusting in Colour Corrector 683
adjusting in Colour Warper 717
adjusting, pivot in Colour Corrector 680
decreasing, in Colour Corrector 689
displayed images 215
gamma, in Colour Warper 719
increasing, in Colour Corrector 688
saturation, in Colour Warper 718
with color transforms 1182

Controlling a Mask's Effect 268
copying

objects in Paint 814
Copying Moving Removing Timeline Transitons 262
Copying Timeline FX 278
Copyright element 1191
crawls, text 871
Create CFX clip 321
Creating a Mask 266
Creating a Text Matte Key 281
Creating Customized Wipes with Masks 266
Creating Your Own Matchbox Effects 1027
crop box

creating in Colour Corrector 669
using, in Colour Warper 701

cropping
in Action 374

CTF file
example 1186

CTF file format 1186
custom brushes, in Paint node 746
customizing 91
cutouts

adding drop shadows 836
animating 840
blending 838
colour correcting 839
drop shadows 839
embossing 837
extruding 838
FrameCut 834
GeoCut 835

Keep Cut On 833
PolyCut 834
RectCut 834

cuts
creating 245

D

Damage 929, 930
Damage menu settings 930
Damage node 929
Deal 955, 956
Deal menu settings 956
Deal node 955
definition 195
Deform 956, 957
Deform menu settings 957
Deform node 956
Degrain 961, 962
Degrain menu settings 961, 962
Deinterlace 962, 963
Deinterlace menu settings 963
Deinterlace node 962
Delaunay tessellation 492
deleting

source nodes 733
Denoise 963, 964
Denoise menu settings 964
Denoise node 963
Depth of Field 967, 968
Depth of Field menu settings 968
Depth of Field node 967
Description element 1193
Difference Matte 973
Difference Matte menu settings 973
Difference Matte node 973
diffuse maps, in Action 502
Direction brush attribute 739, 772, 775
discrete archive 197
displacement maps, in Action 497
displaying, sources as overlays 737
dissolves

in EDLs 160
DLT 197
double-speed tape 172
Drag medium 780
drawing. See painting
drop shadows

adding to cutouts 836
in Action 405

DynamicParameter element 1223

E

ECParams element 1212
Edge Detect 974, 975
Edge Detect menu settings 975
Edge Detect node 974
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editing
EDLs 139
keycode in EDLs 161
timecodes in EDLs 161
timewarps in EDLs 163
tracks in EDL 159
transitions in EDLs 160

editing import settings 91
edits

insert 226
overwrite 227
replace 228

EDL 138
EDLs

assembly options 141
audio patching 157
display options 153
editing 139
editing comments 150
editing events 149
editing options 153
editing titles 150
editing transitions 151
importing options 139
keycode 161
marking events for capture 151
other options 152
preferences, importing 144
search events 146
tape name, editing 157
timecode 161
timewarps, editing 163
tracks, editing 159
transitions, editing 160
Undo list 154
view 156
wipes 160

Effects and Tools reference 887
event list 136
events list 137
export 40
export, default 48
exposure

displayed images 215
with colour transforms 1182

ExposureContrast element 1211
expressions

applying 1124
CascadeChannel keyword 1128
frame keyword 1130
functions 1129, 1133
linking channels 1126
modifying 1125
operators 1131
overview 1124
samples 1156
SelectionOrder keyword 1127
setups 1156
user-defined functions 1154
vectors 1129

extracting
elements from an edit sequence 247

F

FBX
cameras, in Action 519
importing 457
materials 464
textures 464

FBX cameras, in Action
exporting 540

fcp 59
Field Merge 978

Field Merge menu settings 979
Field Merge node 978
file archive, to restore 196
fill objects, drawing 811
filling areas, in Paint 789
Filter 979
Filter menu settings 979
Filter node 979
filtering

Animation Channel Editor 1113
filters

in graphics 819
in Paint 776

final cut pro 165
Final Cut Pro 59
fit to fill edit 228
Flip 981
Flip menu settings 981
Flip node 981
flipbook, previewing animation in Paint 762
FontMapping keyword 863
fonts

in Text module 882
Format options 276
format preset, default 48
frame capture 167
frame grab 167
FrameCut command 834
functions, in expressions 1129

G

gain
adjusting in Colour Corrector 682
adjusting luminance of key in Keyer 574

gamma
adjusting in Colour Corrector 682
adjusting, in Colour Warper 719
applying 1163

Gamma element 1208
GammaParams element 1210
ganging clips 36
gaps

on timeline 244
Gaps 276
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Garbage Mask
Garbage Mask menu settings 982
GMask node 981

garbage masks
animating 636
animating in Tracer 653
animating with tracking 641
defined 621
drawing 627
drawing order 632
interlaced rendering 644
loading and saving setups 657
motion blur, applying 643
moving 633
opacity 624
order they are drawn 632
ROI (Region of Interest), using with multiple garbage

masks 645
rotating 633
scaling 633
schematic, viewing 632
setups, preset 659
setups, raw 659
softness 624
softness, with advanced gradient 647
straight edges 634
tangent handles, moving 634
tangent handles, selecting 633
Tracer 646
turning on and off 624
vertices, activating 639
vertices, adding 639
vertices, adjusting number drawn freehand 631
vertices, deactivating 639
vertices, deleting 641
vertices, moving 634
vertices, removing 639
vertices, selecting 633

Gateway clip
modifying 1265

Gaussian blur
applying, in Colour Warper 712
in Action 373

general preferences 1256
Generate Composite

in ConnectFX 292
GeoCut command 835
geometry

importing in Action 454
painting with 766

Glow 986
Glow menu settings 986
Glow node 986
GLU tessellation 492
gradient

advanced, applying to garbage masks 646
animating in Paint 828

Gradient 993, 994
gradient mattes, creating in Paint 803
Gradient menu settings 994

Gradient node 993
graphics, in Paint

adding 805
anamorphic geometry 817
animating 826
animating gradients 828
Auto Point 823
Bezier curves 823
blending 838
brush tools 806
buffer, recalling from 830
buffer, storing to 830
changing order for objects 815
deleting objects 814
drawing objects 806
drop shadows 839
editing objects 814, 821
embossing 837
extruding 838
fill tool 811
gradients 819, 828
hiding objects 815
hiding vertices 817
increasing speed 817
menu 805
moving objects 821
object attributes 817
outlining objects 817, 818
resizing objects 821
resolution, setting for objects 815
rotating objects 821
rubber banding 811
saving 829
selecting objects 813
shape animation 826
shapes 822
solid and soft edge objects 817, 818
tacking 830
text object 812
transforming objects 821
using AutoPaint with 825
wireframe 815, 817
wireframe options 816

grids and guides
displaying the proper aspect ratio 124
in Paint 759

H

HDCAM 199
HDCAM SR

capture 172
output 179

hiding strokes 735
highlights

colour correcting, in Colour Corrector 678
matching, in Colour Warper 724
modifying, in Colour Warper 713
removing colour, in Colour Warper 714
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histogram
in Colour Corrector 686
luma, viewing in Colour Warper 699

hue
adjusting, in Colour Corrector 679
cube, in Colour Warper 712
shifting in Keyer 580
shifts, in Colour Warper 725

I

image window
displaying the proper aspect ratio 124
multiple views 221
reference area 219

images
applying colours and filters 787
applying random paint strokes 795

import 39, 59, 80, 91
import history, to modify 125
import options, to modify 125
import, history 125
importing

FBX 457
subtitle XML 128

importing tips 39
Impressionist medium 781
individual files 197
Info element 1190
ingest 39
Input Clip menu 167
InputDescriptor element 1194
insert edits 226
Interface overview 15
Interlace 1001
Interlace menu settings 1001
Interlace node 1001
interlaced video

garbage masks, rendering 644
interpolation

expressions 1124
introduction 195
inverting mattes 802

J

jitter
in Stabilizer, removing 605
removing from animation curve 1110

Jitter brush attribute 739, 771

K

kerning text 867
keyboard

using in Text 864
keyboard shortcut

determining for buttons 1244

keyboard shortcuts 1239
catalogues 1246
changing 1247
creating 1249
displaying errors 1244
Keyboard Shortcut Editor 1245
keyboard type 1246

keycode
editing in EDLs 161

Keyer
accessing from Action 376
garbage masks, using with 621
luminance curve, adjusting 574
Matte Edge controls 576
solid colour background, using 583

Keyer Channel 1001, 1002
Keyer Channel menu settings 1002
Keyer Channel node 1001
Keyer HLS 1002, 1003
Keyer HLS menu settings 1003
Keyer HLS node 1002
Keyer Luma 1004, 1005
Keyer Luma menu setting 1005
Keyer Luma node 1004
Keyer RGB 1005, 1006
Keyer RGB menu settings 1006
Keyer RGB node 1005
Keyer RGBCMYL 1007, 1008
Keyer RGBCMYL menu settings 1008
Keyer RGBCMYL node 1007
Keyer YUV 1010, 1011
Keyer YUV menu settings 1011
Keyer YUV node 1010
keyframes

animating 1099
averaging 1110
baking 1109
changing values 1103
copying 1104
keyframe indicators 1100

keying
animating in Keyer 583
colour models, selecting in Keyer 567
edges of key, adjusting in Keyer 555
grey areas, removing from key in Keyer 574
hue, shifting in Keyer 580
in Action 376
workflow in Master Keyer 555

keywords
FontMapping 863

L

layer order, of garbage masks 624
lens flares

adding presets 439
adding, in Action 437

lift
adjusting luminance of key 574
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lifting elements from an edit sequence 247
lights

adding, in Action 422
flipping normals, in Action 430
selective lighting, in Action 424
specular highlights, in Action 427

limiting strokes 736
linear data

converting to log 1163
live video signals, inputting and outputting 181
location, OTOC 203
locking

clips duration 757
sources 736

log data
converting to linear 1163

Log element 1213
Logic Op 1012, 1013
Logic Op menu settings 1013
Logic Op node 1012
logos

loading into Text module 869
LogParams element 1214
long-term storage 195
look

with colour transforms 1182
look-at

3D path in Action 512
axis in Action 381

luma
adjusting after colour correction 726
adjusting ranges 712
adjusting, in Colour Warper 719
defining ranges, in Colour Corrector 689
viewing with 2D luma histogram 699

luminance
mattes, values for 804

lustre, interoperability 125
LUT Editor 1013, 1014, 1161

accessing 1162
comparing colours 1176

LUT Editor menu settings 1014
LUT Editor node 1013
LUT1D element 1196
LUT3D element 1199
LUTs

advanced editing 1173
applying 1163
applying to broadcast monitor or projector 1181
applying to display 1178
basic modification 1166
controlling the look 1182
exporting 1177
file locations 1184
preferences 1258

M

Magnet Curve Editor, in Action 402

Map Convert 1019, 1020
Map Convert menu settings 1020
Map Convert node 1019
masks

See also garbage masks
Master Keyer 1022, 1024

See also mattes, keying, Keyer, patches
steps for creating and refining a key 555

Master Keyer menu settings 1024
Master Keyer node 1022
Matchbox 1025, 1026
Matchbox menu settings 1026
Matchbox node 1025
matching

colours, in Colour Corrector 676
colours, in Colour Warper 723

material node 464
material node, in Action 496
materials 464
Matrix element 1201
Matte Curves 1029, 1030
Matte Curves menu setting 1030
Matte Curves node 1029
Matte Edge 1030, 1031
Matte Edge menu settings 1031
Matte Edge node 1030
mattes

Auto Matte in Paint 804
changing colour 801
creating 802
creating gradients 803
deleting from animation curve, in Colour

Warper 712
deleting, in Colour Warper 712
enabling 800
garbage masks, removing parts 621
generating for selective colour correction 707
generating in Master Keyer 556
inverting 802
inverting, in Colour Warper 703
limiting strokes with matte 744
limiting strokes with source matte 736
loading 802
luminance values 804
resetting, in Paint 803
saving 802
transparency 801
using 800
viewing 800

maxInValue element 1206
maxOutValue element 1207
media

See also special effects media
grouping, in Action 409
loading, in Action 370
slipping, in Action 376

media composer 164
Medial Axis tessellation 494
midtones

colour correcting, in Colour Corrector 678
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defining range, in Colour Warper 715
removing colour, in Colour Warper 714

minInValue element 1206
minOutValue element 1207
Modifying a Mask's Shape 267
Modifying Timeline FX 277
Modular Keyer

accessing from Action 377
monitoring during clip I/O 179
Mono 1035, 1036
Mono menu settings 1036
Mono node 1035
Motif 1036, 1038
Motif menu settings 1038
Motif node 1036
Motion Analysis 1040, 1041
Motion Analysis menu settings 1041
Motion Analysis node 1040
motion blur

garbage masks, applying 643
garbage masks, applying to stationary 644
in Action 525

Motion Blur 1041, 1042
Motion Blur menu settings 1042
Motion Blur node 1041
motion paths

creating with text 877
mouse

using in Paint 758
multi-camera edits

ganging to view clips 36
multi-part archive 200
multi-volume 200
multiple views in tools 221
Muting and Deleting Timeline FX 279
MUX 1044
MUX menu settings 1044
MUX node 1044

N

Node bins
in Action 338

nodes
custom, creating 333

O

Object Group node 457
Offset element 1219
offsets

adjusting, in Colour Corrector 682
animating, in Stabilizer 611

offsetting
cloned sources 747
sources in Paint node 750

Opacity brush attribute 737, 770
opacity of garbage masks, controlling 624

OpenEXR
in Action 338

Optics 1045, 1046
Optics Creating Glow Effects 1046
Optics menu settings 1046
Optics node 1045
OTOC 202
OTOC, definition 203
OTOC, location 203
output 40
OutputDescriptor element 1194
outputting

assemble mode 178
live video signals 181
multiple clips 177
single clips 176
YUV material, using a VTR 190

overlay
user interface in Colour Corrector 665

overlay edits 227
overwrite edits 227

P

Paint
See also graphics, in Paint
about 756
animating Paint strokes 798
Auto Matte command 804
AutoPaint 793
brush attributes 770
brush setups 843
colour correcting the clips 850
colour palette 760
copying graphics 814
creating a matte 802
custom brushes 844
filling an area with colour 789
filters 776
full-resolution film images 763
library 841
loading a matte 802
media. See special effects media, brush attributes
previewing animation 762
recording brush strokes 796
reference image overlay 754
reference images 774
revealing the back image 782
Roll command 766
saving a matte 802
saving and restoring images 764
selecting brushes 765
selecting colours 760
setups 841
tracking with AutoPaint 797
using a matte 800
Wipe command 787, 794

Paint node
brush attributes, setting 737
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canvas, clearing strokes 752
canvas, wiping 753
cloning 747
custom brushes, using 746
saving setups 756
sources, clearing strokes 734
sources, deleting a node 733
sources, displaying reference image overlays 737
sources, locking 736
sources, removing 733
sources, revealing 749
strokes, applying 742
strokes, blending with current image 750
strokes, clearing 734
strokes, hiding 735
strokes, limiting with matte 744
strokes, limiting with source matte 736

painting
circles with geometry 768
circles with object tool 809
ellipses 808
full-resolution film images 763
in Paint node 742
limiting strokes with matte 744
limiting strokes with source matte 736
lines 766, 807
on the canvas 764
rectangles 767, 807
squares 807
triangles 808
triangles with geometry 768
with geometry 766

patching
on timeline 240

perferences
user interface 1263

Perspective Grid, in Action 417
Photoshop files

importing, in Action 363
pickers

advanced gradient, using with 649
animating 654
assigning to vertices 651
defined 622, 648
interpolation between keyframes 655
selecting 634

Pixel Spread 1050, 1051
Pixel Spread menu settings 1051
Pixel Spread node 1050
Player

aspect ratio, displaying 124
polygons, drawing 809
Potential Matches 136
Power element 1219
Pre-processing options 276
preferences

audio 1253
general 1256
LUTs 1258
support 1259

tablet 1258
timeline 1260

Preferences 1253
premiere 165
prepend edit 228
preset 91
Pressure brush attribute 738, 771

mode 775
Priority Editor, in Action 407
priority, garbage masks

drawing order 632
order 624

processing
in Colour Corrector 692

ProcessList element 1189
proxies

generating at clip capture 167
outputting in Action 352
quality box 168

Pulldown 1054, 1055
Pulldown menu settings 1055
Pulldown node 1054

Q

Quick Composite 1055, 1056
Quick Composite menu settings 1056
Quick Composite node 1055

R

Range element 1204
Rate brush attribute 737, 770
rays

adding, in Action 448
recovering archives 204
Recursive Clone medium 782
Recursive Ops 1056, 1057
Recursive Ops menu settings 1057
Recursive Ops node 1056
RED files 77
Ref element 1228
reference area

displaying 219
loading clip into 220

reference clip
viewing, in Colour Warper 696

Reference element 1221
ReferenceTable element 1227
reflection maps, in Action 506
Regrain 1060, 1061
Regrain menu settings 1061
Regrain node 1060
Release element 1192
relink 136, 137
remote project 126
Render passes, in Action 364
replace edits 228
replace media edit 228
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resetting
in Colour Corrector 672

Resize 1062
Resize menu settings 1062
Resize node 1062
restoring

archives 205
restricting strokes 736
Reveal medium 782
revealing, sources in Paint node 749
RGB channels

adjusting, in Colour Warper 719
ripple replace edit 228
rmd in Final Cut Pro 77
ROI (Region of Interest), using with multiple garbage

masks 645
Roll brush attribute 740, 773
roll edit

on timeline 231
rolls, text 871
rotating the canvas 754
rotoscoping 636, 758

S

Safe Title
in Text 868

sampling
adjusting in the Tracer 654
colours, in Colour Corrector 674

SatNode element 1220
saturation

adjusting, in Colour Corrector 679
correcting colour suppression, in Colour

Warper 727
in Colour Warper 718
matching, in Colour Warper 724

Saturation element 1221
saving

setups in Paint node 756
schematic

creating branches, in Action 349
garbage mask, viewing 632
in Action 343
selecting nodes 314

Searching
on the timeline 241

segment 200
segmented archive 200
selection sets, in Channel Editor 1115
selectives

creating, in Colour Warper 707
resetting, in Colour Warper 712

sequence 59, 80
setups

Action, loading 362
brushes 843
garbage masks 657
Paint 841

saving in Paint node 756
Shade medium 786
shadow cast

adding, in Action 434
shadows

See also softness
colour correcting, in Colour Corrector 678
matching, in Colour Warper 724
modifying, in Colour Warper 713
removing colour, in Colour Warper 714

shape animation 826
Shape channel, used for garbage mask animation 636
shapes, in Graphics (Paint) 822
share 125
Shared Folders 126
SharedHome element 1226
sharing, clips 126
single file 197
Size brush attribute 737, 770
sliding

on timeline 231
Sliding Timeline FX Keyframes 278
slipping

clips, in Action 376
on timeline 231

Slope element 1218
Smear medium 783
SMPTE Bars

setting for 2D vectorscope 696
snapping

keyframes 1103
softness

in Colour Warper 707
refining garbage masks 646
softness range, defined in Keyer 566

softness border 646
gradient in Tracer, removing 650
separating from mask border 650

software initialization configuration file
configuring VTRs 166

SOPNode element 1217
source 137
Source Area

ganging clips 36
source nodes in Action

anti-aliasing 549
cameras 550
creating 545
motion blur 549
replacing front or mattes 546

sources in Paint node
about 732
adding 733
blending with current image 750
cloning 747
displaying overlays 737
limiting strokes 736
locking 736
removing 733
revealing 749
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wiping 753
Sparks 1065, 1067
special effects media

Blur 778
Clone 779
Drag 780
Impressionist 781
in graphics 819
Recursive Clone 782
Reveal 782
Shade 786
Smear 783
Stamp 784
Warp 785
Wash 786

specular highlights, on 3D models 466
spell checking 871
splice. See cuts
splice-in edits 226
splines

3D path, in Action 509
split archive 200
Stabilizer

correcting errors 611
gang option 594
importing and exporting data 619
jitter, removing 605
offsets 610
reference point, selecting 590
setting trackers for 3D tracking 596
shift channels 619
shift values 588, 1069
smoothing camera motion 607
tracker and reference boxes 590
tracker box 612
tracker, selecting 591

Stamp medium 784
Stereo 1074, 1075
Stereo menu settings 1075
Stereo node 1074
stereo tape

capture 172
output 179

stereoscopy
capture from tape 172
in Action 412
output to tape 179
stereo camera 528
stereo footage in Action 412
stereo objects 412

strict matching 136
strokes in Paint node

applying 742
blending with current image 750
clearing 734
clearing canvas 752
hiding 735
limiting with source matte 736

strokes in Paint Node
limiting with matte 744

Stylize 1077, 1078
Stylize menu settings 1078
Stylize node 1077
subsetups in Colour Warper

comparing 730
naming 729
replacing 730
saving and loading 730
storing and retrieving 729

Subtitle XML
about 128
importing 128
sample code 134
syntax 130
text setup files 128

support preferences 1259
suppressing

colours, in Colour Corrector 683
surfaces in Action

adding 385
bicubic 392
bilinear 392
changing order 407

symphony 164
SynColor configuration file 1224
SynColorConfig element 1225

T

tab stops, setting in Text 870
table of contents

deleting 204
using to recover an archive 204

tablet preferences 1258
tangent handles

automatic adjustment 635
breaking and reconnecting in garbage masks 634
moving, in garbage masks 634
removing in garbage masks 634
scaling in garbage masks 634
selecting, in garbage masks 633

tangents
modifying 1111

tape device 197
Text 1086, 1087

accessing 854
adding text to a clip 860
animating 874
Asian character sets 863
copying character channels 868
creating text layers 860
fonts, Asian 863
fonts, using 882
formatting in Text module 865
grouping layers 869
in Paint 812
loading files 859
loading logos 869
modifying layer properties 865
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on-screen keyboard 864
resizing 868
safe title 868
saving files 858
setup files 128
spell checking 871
tab stops 870
text columns 870
text motion paths, creating 877
text rolls and crawls 871
text styles, defining 880

Text menu settings 1087
Text node 1086
text objects, in Paint 812
texture maps, using in FBX 464
textures

applying in Action 495
timecode

editing in EDLs 161
timeline

containers, creating 243
cue marks, adding 243
cuts, creating 245
gaps 244
patching 240
preferences 1260
segment marks, adding 243

Timeline
searching 241

timeline effects preferences 1261
timeline elements

extracting 247
lifting 247
swapping 246

Timeline FX 275
timeline preferences 1260
Timeline transitions 261
timewarps

in EDLs 163
timing

animation curves 1104
tolerance

in Colour Warper 707
Tools bin, customizing 329
Tracer

advanced gradient mode 646
animating 653
animating pickers 654
defined 622
matte, fine-tuning 652
pickers, defined 648
pulling keys 646
troubleshooting 656
when to use 646

track
adding to timeline 239
deleting 239
moving 239
resizing 239

tracking
animating garbage masks 641
animating selected vertices on garbage masks 642
in Paint 797

Tracking with Masks 270
tracks

on timeline 238
transforming

garbage masks 633
objects in Paint 821
text 874

transitions
in EDLs 160

triangles, painting 768
trimming

on timeline 231
troubleshoot 138

U

UI overview 15
UMID 59, 80
unlocking clip duration, in Paint 757
user interface

preferences 1263
user interface preferences 1263
Using a Sparks Plug-in 1065
Using Sparks in ConnectFX 1067

V

vectors, in expressions 1129
vectorscope, in Colour Warper 696
version

adding to timeline 239
versions

on timeline 238
vertices in garbage masks

activating and deactivating 639
adding and removing 639
adjusting number drawn freehand 631
animating 637
applying tracking data 642
deleting 641
moving 634
selecting 633
setting keyframing options 638

video
See also clip I/O

viewports, displaying 221
VTR

See also clip I/O
inputting clips 167
outputting clips 173
transport controls 185

VTR archive 198
vtr configuration 199
VTR Output module 173
vtr-based archive 199
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W

Warp medium 785
warping

colours, in Colour Warper 726
Wash medium 786
what is 195
What's New, new features 1
Wipe command

in AutoPaint 794
in Paint 787

wipes
in EDLs 160
masks, creating 660
masks, drawing options 660

wiping 753
wire 125, 126
wireframe

converting, in Action 429
display options 816
in garbage masks 627

wiring clips 126

X

xml 165
XML

modifying Gateway clips 1265
subtitle 128

XML declaration 1188

Y

YUV material, inputting and outputting 190

Z

Z-buffer
setting in Action 409

zooming
in Paint 763
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